## Contents

**Preface**

---

### 1 Introduction to Simphony

**EMC Basics**

1-1

---

### 2 Getting Started

---

### 3 Enterprise

**Inheritance and Overrides**

3-2

**Distribution**

3-3

- Configuring Distribution Privileges
- Distributing Properties and Revenue Centers
- Distributing Records
- Distribution Based on Source, Destination, and Selected Options

3-4

3-6

3-7

**Configuring Permissions for the EMC**

3-8

---

### 4 Cloning Simphony Database Configurations

**Extracting Data from the Source Environment**

4-1

**Uploading Data to the Target Environment**

4-1

---

### 5 Log File Management

**Modifying the Default Log Archive Purge Settings for Application Services**

5-2

**Enabling Log Archiving for Workstations**

5-2

---

### 6 Properties

**Adding a Property**

6-1

**Adding a Revenue Center**

6-2
Revenue Center Groups 6-3
Configuring a Revenue Center Group 6-3

7 Zones

Creating Zones 7-7

8 POS Workstations

Workstation Tasks 8-1
Adding a Workstation 8-2
Configuring Workstation Transaction Settings 8-5
Setting Offline Transaction Posting Time 8-6
Configuring Workstation Security 8-6
Changing the Appearance of Workstations 8-8
Configuring the Magnetic Stripe Reader on the Oracle MICROS Tablet 720 8-8
Configuring the Barcode Scanner on the Oracle MICROS Tablet 720 8-8
Allowing Employees to Install and Authenticate POS Clients and Service Hosts 8-9
Using the Simphony POS Client and Mobile Solution Application on One Device 8-9
Configuring the Close Application Button 8-10
POS Clients Running Android Mobile Operating System 8-10
Android Functionality Support 8-11
Android Network Requirements 8-11
Android Payments 8-12
Workaround for Android Lollipop 5.0.2 and 5.1 8-13
Configuring the Android Device as a Workstation 8-13
Configuring an Android Workstation 8-14
Viewing and Editing Simphony Android Files 8-14
Wireless Signal Strength Threshold 8-15
Configuring Wireless Signal Strength Control Permissions 8-16
Configuring the Wireless Signal Strength Threshold for Tablet Devices 8-16

9 Language Settings and Translation

Language Translation Configuration Tasks 9-2
Configuring Translation Privileges 9-3
Configuring Languages 9-4
Configuring Workstation Translations 9-5
Configuring the EMC Translation Files 9-6
Configuring POS Core and Payment Translations 9-8
Translating Menu Item Records 9-9
EMC Record Translation 9-9
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translating Touchscreen Buttons</td>
<td>9-10</td>
</tr>
<tr>
<td>Setting Languages for the Property</td>
<td>9-11</td>
</tr>
<tr>
<td>Setting the Default Language for Employees</td>
<td>9-12</td>
</tr>
<tr>
<td>Setting the Default Language for a Workstation</td>
<td>9-12</td>
</tr>
<tr>
<td>Configuring Screen Language Buttons</td>
<td>9-13</td>
</tr>
<tr>
<td>Multiple Languages on Guest Checks and Customer Receipts</td>
<td>9-14</td>
</tr>
<tr>
<td>Printing a Secondary Language on Guest Checks and Customer Receipts</td>
<td>9-14</td>
</tr>
<tr>
<td>Configuring Right to Left Reading Languages</td>
<td>9-15</td>
</tr>
<tr>
<td>Creating a Print Language List Button</td>
<td>9-16</td>
</tr>
<tr>
<td>Creating Print Language Buttons</td>
<td>9-16</td>
</tr>
<tr>
<td>Copying Translations from One Language to Another</td>
<td>9-17</td>
</tr>
<tr>
<td>Exporting a Translation File</td>
<td>9-17</td>
</tr>
<tr>
<td><strong>10 Employees and Privileges</strong></td>
<td></td>
</tr>
<tr>
<td>Creating Employee Roles</td>
<td>10-1</td>
</tr>
<tr>
<td>Creating Employee Classes</td>
<td>10-3</td>
</tr>
<tr>
<td>Adding an Employee</td>
<td>10-4</td>
</tr>
<tr>
<td>Deleting an Employee</td>
<td>10-5</td>
</tr>
<tr>
<td>Changing Employee Information</td>
<td>10-6</td>
</tr>
<tr>
<td>Configuring Employee Shifts</td>
<td>10-8</td>
</tr>
<tr>
<td>Configuring Employee Breaks</td>
<td>10-11</td>
</tr>
<tr>
<td>Clock-In and Clock-Out Cycles</td>
<td>10-11</td>
</tr>
<tr>
<td>Setting Clock-In and Clock-Out Cycles</td>
<td>10-12</td>
</tr>
<tr>
<td>Job Codes</td>
<td>10-13</td>
</tr>
<tr>
<td>Configuring Job Codes</td>
<td>10-13</td>
</tr>
<tr>
<td>Declaring Tips</td>
<td>10-14</td>
</tr>
<tr>
<td>Configuring Tip Tracking and Reporting</td>
<td>10-15</td>
</tr>
<tr>
<td>Configuring Tip Track Buttons</td>
<td>10-16</td>
</tr>
<tr>
<td><strong>11 Payments and Currency</strong></td>
<td></td>
</tr>
<tr>
<td>Types of Payment</td>
<td>11-3</td>
</tr>
<tr>
<td>Configuring Currency</td>
<td>11-3</td>
</tr>
<tr>
<td>Configuring Base Currency and Alternate Currency</td>
<td>11-4</td>
</tr>
<tr>
<td>Configuring Currency Conversions</td>
<td>11-5</td>
</tr>
<tr>
<td>Configuring the Cash Tender</td>
<td>11-6</td>
</tr>
<tr>
<td>Adding Payment Keys to the Transaction Page</td>
<td>11-8</td>
</tr>
<tr>
<td>Credit Card Tokenization</td>
<td>11-9</td>
</tr>
<tr>
<td>Loadable Payment Card Configuration Tasks</td>
<td>11-10</td>
</tr>
<tr>
<td>Loadable Payment Configuration Prerequisites</td>
<td>11-11</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Universal Transaction Gateway for Shift4</td>
<td>11-12</td>
</tr>
<tr>
<td>Communication Methods for Fusebox Payment Card Driver</td>
<td>11-13</td>
</tr>
<tr>
<td>stunnel Installation Methods</td>
<td>11-14</td>
</tr>
<tr>
<td>Installing stunnel at a Single Host Location</td>
<td>11-14</td>
</tr>
<tr>
<td>Installing stunnel Through Simphony as a CAL Package</td>
<td>11-15</td>
</tr>
<tr>
<td>Configuring the CAPMS Payment Card Driver</td>
<td>11-15</td>
</tr>
<tr>
<td>Configuring the CAPMS Payment Module</td>
<td>11-17</td>
</tr>
<tr>
<td>Configuring the Dollars on the Net Payment Card Driver</td>
<td>11-19</td>
</tr>
<tr>
<td>Configuring the Dollars on the Net Payment Module</td>
<td>11-20</td>
</tr>
<tr>
<td>Configuring the Fusebox Payment Card Driver</td>
<td>11-22</td>
</tr>
<tr>
<td>Configuring the Fusebox Payment Module</td>
<td>11-24</td>
</tr>
<tr>
<td>Configuring the VisaD Payment Card Driver</td>
<td>11-26</td>
</tr>
<tr>
<td>Configuring the VisaD Payment Module</td>
<td>11-28</td>
</tr>
<tr>
<td>Configuring the Loadable Payment Card Device</td>
<td>11-29</td>
</tr>
<tr>
<td>Creating Loadable Payment Card Buttons</td>
<td>11-30</td>
</tr>
<tr>
<td>The Oracle Payment Interface (OPI)</td>
<td>11-31</td>
</tr>
<tr>
<td>OPI Architecture</td>
<td>11-31</td>
</tr>
<tr>
<td>Configuring the OPI Driver</td>
<td>11-34</td>
</tr>
<tr>
<td>Configuring the OPI Payment Module</td>
<td>11-34</td>
</tr>
<tr>
<td>Configuring the Default Payment Tender for OPI</td>
<td>11-35</td>
</tr>
<tr>
<td>Updating Credit Card Preambles for OPI</td>
<td>11-35</td>
</tr>
<tr>
<td>Configuring the OPI and SPI to Settle Transactions Automatically</td>
<td>11-36</td>
</tr>
<tr>
<td>Configuring the OPI and SPI to Settle Transactions Manually</td>
<td>11-37</td>
</tr>
<tr>
<td>Credit Card Preambles for OPI</td>
<td>11-37</td>
</tr>
<tr>
<td>The Simphony Payment Interface (SPI)</td>
<td>11-39</td>
</tr>
<tr>
<td>SPI Architecture</td>
<td>11-40</td>
</tr>
<tr>
<td>Payment Driver vs. Workstation Settings</td>
<td>11-46</td>
</tr>
<tr>
<td>OPI Users</td>
<td>11-46</td>
</tr>
<tr>
<td>Pay@Table</td>
<td>11-47</td>
</tr>
<tr>
<td>Check Sharing</td>
<td>11-47</td>
</tr>
<tr>
<td>Configuring the SPI Payment Driver</td>
<td>11-47</td>
</tr>
<tr>
<td>Configuring Mail Order Telephone Order (MOTO)</td>
<td>11-49</td>
</tr>
<tr>
<td>Third-Party Credit Card Driver Package Distribution</td>
<td>11-50</td>
</tr>
<tr>
<td>Copying Third-Party Payment Driver Files</td>
<td>11-50</td>
</tr>
<tr>
<td>Manually Installing Credit Card Certificates on Workstations</td>
<td>11-51</td>
</tr>
<tr>
<td>Credit Card Batching</td>
<td>11-54</td>
</tr>
<tr>
<td>Creating a Credit Card Batch</td>
<td>11-55</td>
</tr>
<tr>
<td>Editing a Credit Card Batch</td>
<td>11-55</td>
</tr>
<tr>
<td>Settling a Credit Card Batch</td>
<td>11-56</td>
</tr>
<tr>
<td>Pay@Table</td>
<td>11-56</td>
</tr>
<tr>
<td>Configuring a Credit Card Tender</td>
<td>11-57</td>
</tr>
<tr>
<td>Chapter</td>
<td>Topic</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>13</td>
<td><strong>Discounts</strong></td>
</tr>
<tr>
<td></td>
<td>Manual Discounts</td>
</tr>
<tr>
<td></td>
<td>Automatic Discounts</td>
</tr>
<tr>
<td></td>
<td>Automatic Discount Rules</td>
</tr>
<tr>
<td></td>
<td>Awarding Algorithms</td>
</tr>
<tr>
<td></td>
<td>Discount Award Types</td>
</tr>
<tr>
<td></td>
<td>Discount Exclusivity</td>
</tr>
<tr>
<td></td>
<td>Simple Exclusivity</td>
</tr>
<tr>
<td></td>
<td>Group Exclusivity</td>
</tr>
<tr>
<td></td>
<td>Menu Item Groups</td>
</tr>
<tr>
<td></td>
<td>Configuring Menu Item Groups</td>
</tr>
<tr>
<td></td>
<td>Configuring Discount Privileges</td>
</tr>
<tr>
<td></td>
<td>Configuring Discounts</td>
</tr>
<tr>
<td></td>
<td>Configuring Effectivity Groups</td>
</tr>
<tr>
<td></td>
<td>Automatic Discounts with Decimal Quantity Menu Items</td>
</tr>
<tr>
<td></td>
<td>Amount Off Examples</td>
</tr>
<tr>
<td></td>
<td>Amount Substitution Examples</td>
</tr>
<tr>
<td></td>
<td>Configuring Decimal Quantity Menu Items</td>
</tr>
<tr>
<td></td>
<td>Configuring an Item Price Substitution Discount</td>
</tr>
<tr>
<td></td>
<td>Configuring a Quantity Threshold Discount</td>
</tr>
<tr>
<td></td>
<td>Configuring a Total Price Threshold Discount</td>
</tr>
<tr>
<td></td>
<td>Configuring a Combination Pricing Discount</td>
</tr>
<tr>
<td></td>
<td>Configuring a Sales Price Discount</td>
</tr>
<tr>
<td></td>
<td>Discounts With Condiments</td>
</tr>
<tr>
<td></td>
<td>Configuring Condiments as Discount Triggers</td>
</tr>
<tr>
<td></td>
<td>Configuring Discounts for Parent Menu Items in a Menu Item Class</td>
</tr>
<tr>
<td></td>
<td>Configuring a Condiment as the Discount Award</td>
</tr>
<tr>
<td></td>
<td>Creating the Discount Button</td>
</tr>
<tr>
<td>14</td>
<td><strong>Service Charges</strong></td>
</tr>
<tr>
<td></td>
<td>Configuring Service Charges</td>
</tr>
<tr>
<td></td>
<td>Creating Service Charge Buttons</td>
</tr>
<tr>
<td></td>
<td>Menu Item Fees</td>
</tr>
<tr>
<td></td>
<td>Configuring Menu Item Fees</td>
</tr>
<tr>
<td>15</td>
<td><strong>Menu Items</strong></td>
</tr>
<tr>
<td></td>
<td>Configuring Menu Items</td>
</tr>
<tr>
<td></td>
<td>Adding and Disabling Menu Items</td>
</tr>
<tr>
<td></td>
<td>Configuring Employee Privileges to Edit Menu Item Definitions and Prices</td>
</tr>
<tr>
<td>Chapter</td>
<td>Title</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>15-5</td>
<td>Configuring Employee Privileges for Menu Item Availability Adjustments</td>
</tr>
<tr>
<td>15-5</td>
<td>Configuring Menu Item Availability for Multiple Definitions at the Workstation</td>
</tr>
<tr>
<td>15-6</td>
<td>Adding the Menu Item Availability Key to the Transaction Page</td>
</tr>
<tr>
<td>15-6</td>
<td>Adding Menu Item Keys to the Transaction Page</td>
</tr>
<tr>
<td>15-7</td>
<td>Adding the Edit Menu Item Key to the Transaction Page</td>
</tr>
<tr>
<td>15-7</td>
<td>Repeatable Menu Items</td>
</tr>
<tr>
<td>15-8</td>
<td>Configuring Menu Items to be Repeatable</td>
</tr>
<tr>
<td>15-8</td>
<td>Configuring a Repeat Round Button</td>
</tr>
<tr>
<td>15-9</td>
<td>Menu Item Distribution</td>
</tr>
<tr>
<td>15-9</td>
<td>Distributing Menu Items</td>
</tr>
<tr>
<td>15-10</td>
<td>Searching and Filtering Menu Items</td>
</tr>
<tr>
<td>16-1</td>
<td>Categorizing Menu Items into Groups</td>
</tr>
<tr>
<td>16-1</td>
<td>Configuring Major Groups</td>
</tr>
<tr>
<td>16-1</td>
<td>Configuring Family Groups</td>
</tr>
<tr>
<td>17-1</td>
<td>Menu Item Master Records</td>
</tr>
<tr>
<td>17-1</td>
<td>Configuring Master Records for Menu Items</td>
</tr>
<tr>
<td>18-1</td>
<td>Menu Item Search and Report</td>
</tr>
<tr>
<td>18-1</td>
<td>Generating the Module Reference Report</td>
</tr>
<tr>
<td>19-1</td>
<td>Menu Item Classes</td>
</tr>
<tr>
<td>19-1</td>
<td>Configuring Menu Item Classes</td>
</tr>
<tr>
<td>19-8</td>
<td>Print Groups</td>
</tr>
<tr>
<td>19-9</td>
<td>Configuring Print Groups for Menu Item Classes</td>
</tr>
<tr>
<td>20-2</td>
<td>Menu Item Definitions</td>
</tr>
<tr>
<td>20-2</td>
<td>Adding Menu Item Definition Records to Multiple Menu Item Masters</td>
</tr>
<tr>
<td>20-3</td>
<td>Adding Menu Item Definition Records to a Single Menu Item Master</td>
</tr>
<tr>
<td>20-4</td>
<td>Configuring Menu Item Definitions</td>
</tr>
<tr>
<td>20-6</td>
<td>Allowing Users to Override Restricted Menu Item Ranges</td>
</tr>
<tr>
<td>21-2</td>
<td>Menu Item Prices</td>
</tr>
<tr>
<td>21-2</td>
<td>Configuring Menu Item Prices</td>
</tr>
<tr>
<td>Chapter</td>
<td>Title</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>22</td>
<td>Menu Levels</td>
</tr>
<tr>
<td>Setting Main, Sub, and Custom Menu Levels</td>
<td>22-3</td>
</tr>
<tr>
<td>Setting the Default Main and Sub Levels for Serving Periods</td>
<td>22-4</td>
</tr>
<tr>
<td>Configuring Auto Menu Levels</td>
<td>22-4</td>
</tr>
<tr>
<td>Setting the Default Menu Levels for a Revenue Center</td>
<td>22-5</td>
</tr>
<tr>
<td>Configuring Active Menu Levels for Menu Item Definitions and Prices</td>
<td>22-5</td>
</tr>
<tr>
<td>23</td>
<td>Sales Itemizers</td>
</tr>
<tr>
<td>Configuring Sales Itemizers</td>
<td>23-1</td>
</tr>
<tr>
<td>24</td>
<td>Screen Look Up (SLU)</td>
</tr>
<tr>
<td>Configuring Screen Look Ups for Menu Items</td>
<td>24-1</td>
</tr>
<tr>
<td>Configuring Screen Look Ups for Discounts</td>
<td>24-3</td>
</tr>
<tr>
<td>Configuring Screen Look Ups for Service Charges</td>
<td>24-3</td>
</tr>
<tr>
<td>Configuring Menu Item Screen Look Ups by Family Group</td>
<td>24-4</td>
</tr>
<tr>
<td>Configuring Menu Item Screen Look Ups by Major Group</td>
<td>24-4</td>
</tr>
<tr>
<td>Configuring Screen Look Ups for Custom Reports</td>
<td>24-5</td>
</tr>
<tr>
<td>Configuring Screen Look Ups for Open Checks</td>
<td>24-5</td>
</tr>
<tr>
<td>25</td>
<td>Number Look Up (NLU)</td>
</tr>
<tr>
<td>Configuring Number Look Ups for Discounts</td>
<td>25-1</td>
</tr>
<tr>
<td>Configuring Number Look Ups for Service Charges</td>
<td>25-2</td>
</tr>
<tr>
<td>Configuring Number Look Ups for Tender/Media Records</td>
<td>25-2</td>
</tr>
<tr>
<td>Configuring Number Look Ups for Main and Sub Levels</td>
<td>25-3</td>
</tr>
<tr>
<td>Configuring Number Lookups for Menu Items</td>
<td>25-3</td>
</tr>
<tr>
<td>Configuring NLU Groups</td>
<td>25-4</td>
</tr>
<tr>
<td>26</td>
<td>Weighed Menu Items</td>
</tr>
<tr>
<td>Configuring a Weighed Menu Item</td>
<td>26-1</td>
</tr>
<tr>
<td>Setting the Tare Weight for a Menu Item</td>
<td>26-2</td>
</tr>
<tr>
<td>27</td>
<td>Menu Item Waste</td>
</tr>
<tr>
<td>Allowing Employees to Begin Waste Checks and Run Waste Reports</td>
<td>27-2</td>
</tr>
<tr>
<td>Configuring Waste Reasons</td>
<td>27-2</td>
</tr>
</tbody>
</table>
Enabling Team Service 31-29
Configuring Team Service Privileges 31-29
Configuring Revenue Centers to Delete Service Teams at the Start of Day 31-30
Adding Team Service Buttons 31-30
Closed Guest Check Operations 31-31
Configuring Closed Check Settings 31-32
Allowing Employees to Adjust Closed Checks 31-33
Allowing Employees to Reopen and Edit a Closed Check 31-34
Allowing Employees to Reprint Closed Checks 31-35
Allowing Employees to Manually Replay Checks Through the Workstation 31-36
Check Add/Transfer 31-36
Allowing Employees to Add or Transfer Checks 31-36
Configuring the Add/Transfer Revenue Centers 31-37
Configuring Add/Transfer Buttons 31-37
Seat Filtering and Memo Checks 31-38
Configuring Memo Check Printing 31-41
Configuring Service Charges for Seat Filtering 31-42
Configuring Seat Filter Management Buttons 31-43

32 Workstation Touchscreen Pages

Page Design 32-1
Assigning Default Touchscreen Pages 32-2
Configuring Function Keys 32-2
Configuring Macros 32-3

33 Rental Deposits

Configuring Deposits as a Menu Item 33-1
Configuring Deposits as a Service Charge 33-2
Configuring Rental Deposit Buttons 33-2

34 Resetting Daily Totals

Start of Day 34-1
Start of Day Business Rules 34-2
Start of Day with Offline Workstations or Server 34-2
Configuring Start of Day 34-3
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>35</td>
<td>Updating POS Client Configuration</td>
</tr>
<tr>
<td></td>
<td>Setting the Database Update Frequency</td>
</tr>
<tr>
<td>36</td>
<td>Clearing Totals</td>
</tr>
<tr>
<td></td>
<td>Running the Clear Totals Operation</td>
</tr>
<tr>
<td>37</td>
<td>Check and Posting Service (CAPS)</td>
</tr>
<tr>
<td></td>
<td>CAPS Configuration Methods</td>
</tr>
<tr>
<td></td>
<td>CAPS Supported Software and Hardware</td>
</tr>
<tr>
<td></td>
<td>CAPS Configuration Tool</td>
</tr>
<tr>
<td></td>
<td>Prerequisite Products for CAPS</td>
</tr>
<tr>
<td></td>
<td>Tasks to Set Up CAPS as a Web Service on Microsoft Internet Information Services (IIS)</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS on Microsoft IIS with Oracle Database on Enterprise Server</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS Access</td>
</tr>
<tr>
<td></td>
<td>Configuring the Service Host for CAPS in EMC</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS with an Oracle Database</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS on Microsoft IIS</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS on Microsoft IIS with Oracle Database on Remote Service Host</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS Access</td>
</tr>
<tr>
<td></td>
<td>Configuring the Service Host for CAPS in EMC</td>
</tr>
<tr>
<td></td>
<td>Preparing the Server to Configure CAPS</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS with an Oracle Database</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS on Microsoft IIS</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS on Microsoft IIS with SQL Server Database on Enterprise Server</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS Access</td>
</tr>
<tr>
<td></td>
<td>Configuring the Service Host for CAPS in EMC</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS with a Microsoft SQL Server Database</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS on Microsoft IIS</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS on Microsoft IIS with SQL Server Database on Remote Service Host</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS Access</td>
</tr>
<tr>
<td></td>
<td>Configuring the Service Host for CAPS in EMC</td>
</tr>
<tr>
<td></td>
<td>Preparing the Server to Configure CAPS</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS with a Microsoft SQL Server Database</td>
</tr>
<tr>
<td></td>
<td>Configuring CAPS on Microsoft IIS</td>
</tr>
<tr>
<td></td>
<td>Upgrading Microsoft IIS CAPS</td>
</tr>
<tr>
<td></td>
<td>Upgrading Microsoft IIS CAPS on Enterprise Server</td>
</tr>
<tr>
<td></td>
<td>Upgrading Microsoft IIS CAPS on Remote Service Host</td>
</tr>
</tbody>
</table>

**Oracle**
Configuring CAPS as a Windows Service with an Oracle Database 37-17
  Configuring CAPS Access 37-18
  Configuring the Service Host for CAPS in EMC 37-18
  Preparing the Server to Configure CAPS 37-19
  Configuring CAPS with an Oracle Database 37-20
  Copying the Database Settings 37-20
  Starting the CAPS Service 37-21
Configuring CAPS as a Windows Service with a Microsoft SQL Database 37-21
  Configuring the Service Host for CAPS in EMC 37-21
  Preparing the Server to Configure CAPS 37-22
  Starting the CAPS Service 37-22
Optional CAPS Configuration Tasks 37-22
  CAL Installation Prerequisites for a Workstation without the POS Interface (CAPS Only Workstation) 37-23
    Configuring the Deployment Schedule to Install CAL on a Workstation without the POS Interface 37-23
    Installing CAL on a Workstation without the POS Interface 37-23
  Configuring the Show Database Provider Button 37-27
  Encrypting Database Credentials 37-27
  Verifying CAPS Installation 37-28
  Configuring IIS Application Pool Settings 37-28
    Configuring Recycle Settings for the IIS Application Pool 37-28
    Restarting Microsoft IIS CAPS 37-29

Printers

  Print Controller 38-1
  Roll Printer 38-2
  Slip Printer 38-3
  Internet Protocol (IP) Printer 38-3
  Bluetooth Printer 38-3
  Printer Groups 38-4
  Configuring a Printer 38-4
  Creating, Editing, and Removing Printer Groups 38-8
  Configuring the Change Default Printer Destination Button 38-9
  Configuring a Printer Order Device 38-9
  Secondary Printing 38-12
  Configuring Secondary Printing 38-13
  Printer DIP and Memory Switch Settings 38-14
    Epson Printer Setup for IDN Module 38-14
    Printer DIP Switch/Memory Switch Setting when using UB-IDN (IDN02) Interface 38-16
39 Logo Printing

Uploading a Logo to Simphony 39-1
Assigning a Logo to Guest Checks and Customer Receipts 39-2

40 Configuring Pre-Production Chits to Output to Remote Printers (Release 18.2.3 only)

Configuring Print Classes for Pre-Production Chits (Release 18.2.3 only) 40-1
Configuring Tender/Media - Service Total Records for Pre-Production Chits (Release 18.2.3 only) 40-2
Configuring Menu Item Classes for Pre-Production Chits (Release 18.2.3 only) 40-2
Configuring a Page Design Button for Pre-Production Chits (Release 18.2.3 only) 40-3
Example of a Pre-Production Chit (Release 18.2.3 only) 40-4

41 Peripheral Devices

Cash Drawer Assignment and Unassignment 41-2
Configuring a Cash Drawer 41-3
Coin Dispenser 41-5
Configuring a Coin Dispenser 41-6
Magnetic Stripe Reader 41-6
Installing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices 41-7
Configuring a Magnetic Stripe Reader 41-7
Testing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices 41-8
Barcode Reader Setup Methods 41-9
Configuring a Barcode Reader Using the Barcodes Module Method 41-10
Configuring a Barcode Reader Using the Number Lookup (NLU) Method 41-11
Configuring the 1D/2D Imager Scanner 41-12
Fingerprint Scanning 41-12
Configuring the Biometrics CAL Package Deployment 41-13
Configuring Employee Privileges for the Fingerprint Reader 41-14
Configuring the Touchscreen Home or Sign In Page to Assign Employee Personal Identification Number (PIN) 41-14
### Configuring the Workstation Employee Fingerprint Sign In Options
- Scanning a Fingerprint 41-16
- Configuring a Scale 41-17
- Sales Recording Module (SRM) 41-18
- Enabling SRM for a Property 41-18
- Configuring SRM Payment Types for Tenders 41-18
- Enabling SRM for Printers 41-19
- Configuring the Quebec SRM Control Button 41-20
- Allowing Employees to Enable and Disable SRM from the Workstation 41-20

### Reporting
- Allowing Employees to Run Reports 42-1
- List of Workstation PMC Reports 42-1
- Configuring Employee Privileges for Oracle Hospitality Reporting and Analytics 42-4
- Configuring the Log Files for Oracle Hospitality Reporting and Analytics 42-4
- Viewing Move History Logs 42-5
- Configuring Data Retention Limits 42-6

### Auditing
- Using the Audit Trail 43-1
- Using Audit This Record 43-3

### Importing and Exporting Data
- Configuring the Import/Export Service Privileges 44-1
- Configuring the Import/Export Service 44-2
- Configuring Task Schedules for Export Reliability 44-3
- Increasing the Import File Size 44-3
- Import/Export Service Components 44-4

### Loyalty and Gift Card Interfaces and Drivers
- Loyalty and Stored Value Configuration Prerequisites 45-2
- Loyalty Configuration Tasks 45-3
- Configuring Loyalty and Stored Value Privileges 45-3
- Setting Loyalty Options 45-7
- Configuring the Loyalty Driver 45-8
- Configuring the Loyalty Module 45-9
- Stored Value Configuration Tasks 45-11
- Setting Stored Value Options 45-11
<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>45-12</td>
</tr>
<tr>
<td>45-14</td>
</tr>
<tr>
<td>45-15</td>
</tr>
<tr>
<td>45-18</td>
</tr>
<tr>
<td>45-19</td>
</tr>
</tbody>
</table>

### Events

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>46-1</td>
</tr>
<tr>
<td>46-3</td>
</tr>
<tr>
<td>46-4</td>
</tr>
<tr>
<td>46-5</td>
</tr>
<tr>
<td>46-6</td>
</tr>
<tr>
<td>46-7</td>
</tr>
<tr>
<td>46-8</td>
</tr>
<tr>
<td>46-9</td>
</tr>
<tr>
<td>46-10</td>
</tr>
<tr>
<td>46-11</td>
</tr>
<tr>
<td>46-12</td>
</tr>
<tr>
<td>46-14</td>
</tr>
<tr>
<td>46-15</td>
</tr>
<tr>
<td>46-16</td>
</tr>
</tbody>
</table>

### Dining Room Tables and Seating

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>47-2</td>
</tr>
<tr>
<td>47-3</td>
</tr>
<tr>
<td>47-4</td>
</tr>
<tr>
<td>47-5</td>
</tr>
<tr>
<td>47-6</td>
</tr>
<tr>
<td>47-7</td>
</tr>
<tr>
<td>47-7</td>
</tr>
<tr>
<td>47-7</td>
</tr>
<tr>
<td>47-8</td>
</tr>
<tr>
<td>47-10</td>
</tr>
<tr>
<td>47-11</td>
</tr>
<tr>
<td>47-12</td>
</tr>
<tr>
<td>47-13</td>
</tr>
<tr>
<td>47-13</td>
</tr>
<tr>
<td>47-13</td>
</tr>
<tr>
<td>47-14</td>
</tr>
</tbody>
</table>
Configuring the Service Total Tender for Table Management 47-14
Enhanced Dining Tables 47-14
Setting Dining Table Classes 47-15
Setting Enhanced Dining Table Attributes 47-16
Configuring Enhanced Dining Tables 47-16
Setting Table Decorator Images 47-18
Configuring Server and Table Availability 47-19
Setting Table Management Options 47-20
Configuring Table Suggestion Factors 47-22
Table Management Alerts 47-23
Configuring Alerts 47-24
Table Management Sections 47-24
Configuring Sections 47-24
Creating the Touchscreen Reservation List 47-25
Creating the Touchscreen Wait List 47-27
Touchscreen Page Table Management Tasks 47-30
Host Command Area 47-30
Configuring the Host Command Area 47-31
Dining Table Status 47-31
Configuring the Dining Table Status 47-32
Employee Lines 47-33
Configuring Employee Lines 47-33
Section Layout 47-34
Creating a Section Layout 47-35
Creating Enhanced Dining Tables 47-35
Setting Table Management Functions in Check Detail 47-36
Creating the Employee Section Assignment Report Button 47-36
Configuring Table Cancellation Reasons 47-37
Setting Reservation Timing Parameters 47-37
Setting Wait List Timing Parameters 47-38
Reservation Periods 47-39
Configuring Effectivity 47-40
Configuring Acceptance Limits 47-41
Configuring Occupancy Limits 47-41
Configuring Seating Limits 47-42
Configuring Target Turn Times 47-43
Table Management Configuration Levels 47-44
Reservation Configuration Levels 47-45
Wait List Configuration Levels 47-46
<table>
<thead>
<tr>
<th>Enterprise Cash Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Data Retention Limits</td>
</tr>
<tr>
<td>Specifying Ad Hoc Reports</td>
</tr>
<tr>
<td>Configuring ECM Privileges and Permissions</td>
</tr>
<tr>
<td>Allowing Users to View Blind Totals</td>
</tr>
<tr>
<td>Allowing Assigned Receptacle Access and Counts</td>
</tr>
<tr>
<td>Configuring Accounting Methods for Users</td>
</tr>
<tr>
<td>Allowing Users to Override Employee Class Options</td>
</tr>
<tr>
<td>Tracking Tender Transaction Items</td>
</tr>
<tr>
<td>Tracking Service Charge Transactions</td>
</tr>
<tr>
<td>Tracking Discount Transactions</td>
</tr>
<tr>
<td>Creating, Editing, and Deleting Cash Management Reasons</td>
</tr>
<tr>
<td>Cash Management Classes</td>
</tr>
<tr>
<td>Adding Transaction Items</td>
</tr>
<tr>
<td>Adding Counting Units</td>
</tr>
<tr>
<td>Cash Pull Threshold Set</td>
</tr>
<tr>
<td>Creating, Editing, and Deleting a Cash Pull Threshold Set</td>
</tr>
<tr>
<td>Cash Count Threshold Set</td>
</tr>
<tr>
<td>Creating, Editing, and Deleting a Cash Count Threshold Set</td>
</tr>
<tr>
<td>PAR Level Set</td>
</tr>
<tr>
<td>Creating, Editing, and Deleting a PAR Level Set</td>
</tr>
<tr>
<td>Count Sheet</td>
</tr>
<tr>
<td>Creating, Editing, and Deleting a Count Sheet</td>
</tr>
<tr>
<td>Creating, Editing, and Deleting an Account</td>
</tr>
<tr>
<td>Creating, Editing, and Deleting a Vendor</td>
</tr>
<tr>
<td>Creating and Editing a Template</td>
</tr>
<tr>
<td>Creating, Editing, and Deactivating Receptacles</td>
</tr>
<tr>
<td>Setting Cash Management Parameters</td>
</tr>
<tr>
<td>Creating Cash Management Touchscreens and Dashboard</td>
</tr>
<tr>
<td>Configuring a Smart Key on a Workstation</td>
</tr>
<tr>
<td>Configuring a Till Through Extensibility</td>
</tr>
<tr>
<td>Configuring a Bank Deposit Reference Through Extensibility</td>
</tr>
<tr>
<td>ECM Reporting</td>
</tr>
<tr>
<td>Enabling Reports in Enterprise Back Office</td>
</tr>
<tr>
<td>ECM Enterprise Information in Reporting and Analytics Reports</td>
</tr>
<tr>
<td>ECM Property Reports</td>
</tr>
<tr>
<td>ECM Workstation Hardware</td>
</tr>
<tr>
<td>ECM Configuration Levels</td>
</tr>
</tbody>
</table>
## Engagement Cloud Service

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Requirements and Supported Devices</td>
<td>49-2</td>
</tr>
<tr>
<td>Security Precautions</td>
<td>49-2</td>
</tr>
<tr>
<td>Assigning Privileges for Engagement Administrative Users</td>
<td>49-3</td>
</tr>
<tr>
<td>Language Translation Tasks</td>
<td>49-4</td>
</tr>
<tr>
<td>Adding a New Language to Hub and Welcome Pages</td>
<td>49-4</td>
</tr>
<tr>
<td>Adding a Language to the EMCWeb File</td>
<td>49-4</td>
</tr>
<tr>
<td>Adding a Language File to the Engagement Configuration Application Server</td>
<td>49-5</td>
</tr>
<tr>
<td>Setting Multiple Languages</td>
<td>49-6</td>
</tr>
<tr>
<td>Engagement Manager Procedures</td>
<td>49-6</td>
</tr>
<tr>
<td>Adding Engagement Manager Procedure Tiles to the Hub Page</td>
<td>49-7</td>
</tr>
<tr>
<td>Editing the Check Header and Trailer</td>
<td>49-8</td>
</tr>
<tr>
<td>Editing Bulk Menu Item Prices</td>
<td>49-8</td>
</tr>
<tr>
<td>Adding an Employee From a Template</td>
<td>49-9</td>
</tr>
<tr>
<td>Deactivating an Employee</td>
<td>49-10</td>
</tr>
<tr>
<td>Adding a New Menu Item Using an Existing Menu Item as a Template</td>
<td>49-11</td>
</tr>
<tr>
<td>Adding Images to Menu Items</td>
<td>49-12</td>
</tr>
<tr>
<td>Adding or Changing an Employee’s Profile Image</td>
<td>49-12</td>
</tr>
<tr>
<td>Creating Pages for Engagement Users</td>
<td>49-13</td>
</tr>
<tr>
<td>Modifying Pages for Engagement Users</td>
<td>49-14</td>
</tr>
<tr>
<td>Assigning Logos and Colors to Pages</td>
<td>49-14</td>
</tr>
<tr>
<td>Assigning Default Welcome and Hub Pages</td>
<td>49-14</td>
</tr>
<tr>
<td>Widgets</td>
<td>49-15</td>
</tr>
<tr>
<td>The IP Camera Widget</td>
<td>49-16</td>
</tr>
<tr>
<td>Adding and Moving Widgets</td>
<td>49-17</td>
</tr>
<tr>
<td>Creating Tiles (Adding Widgets to a Page)</td>
<td>49-17</td>
</tr>
<tr>
<td>Adding Command Buttons</td>
<td>49-20</td>
</tr>
<tr>
<td>Configuring Widget Timing Values</td>
<td>49-20</td>
</tr>
<tr>
<td>List of Widgets</td>
<td>49-21</td>
</tr>
<tr>
<td>Viewing the Maximum Data Limit for Hosted Engagement Server</td>
<td>49-24</td>
</tr>
</tbody>
</table>

## Extension Applications

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Extension Application Privileges</td>
<td>50-1</td>
</tr>
<tr>
<td>Enabling Extension Applications</td>
<td>50-1</td>
</tr>
</tbody>
</table>

## Transaction Services

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring the Transaction Services Workstation Client</td>
<td>51-1</td>
</tr>
<tr>
<td>Configuring the Transaction Services Default Employee</td>
<td>51-2</td>
</tr>
<tr>
<td>Order Information Service</td>
<td>51-3</td>
</tr>
</tbody>
</table>
Activating the Extension Application for Order Information Service 51-3
Configuring Touchscreen Order Information Service Buttons 51-3
Order Information Service Functions and Extensibility Arguments 51-5

52 Cruise Ship Time Zone and Business Day Settings

Changing the Time Zone 52-1
Start of Business Day 52-2
Configuring Start of Day 52-2
Workstation Control Privileges 52-3
Configuring Workstation Control Privileges 52-4

53 Interfaces with Simphony

Configuring the OPERA PMS Enhanced Interface 53-1
Inserting the Extension Application Files for OPERA 53-14
Configuring OPERA Content Information 53-17
Content Text Settings for the OPERA PMS 53-18
Configuring the OPERA PMS Interface 53-20
Enabling the OPERA PMS Interface for a Revenue Center 53-22
Adding the Tender/Media Data Extension for OPERA 53-23
Configuring the Tender Media for OPERA 53-24
Configuring the Room Charge Buttons for the OPERA PMS 53-26
Updating the SIM OPERA Interface to a Newer Version 53-28

54 Accessibility

Enabling High Contrast Visibility Settings 54-1
Navigating the Home Page Using Keystrokes 54-1
Keyboard Shortcuts 54-2

55 Simphony Documentation Videos
Preface

Oracle Hospitality Simphony is a cloud-based Point-of-Sale (POS) solution that provides business management capabilities using a single tool with vast integration capabilities to property management systems, paperless kitchen display systems, credit card interfaces, and reporting applications.

Purpose

This Configuration Guide provides instructions to set up Simphony release 18.2.

Audience

This document is intended for system administrators of Oracle Hospitality Simphony release 18.2.

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

• Product version and program/module name
• Functional and technical description of the problem (include business impact)
• Detailed step-by-step instructions to re-create
• Exact error message received and any associated log files
• Screen shots of each step you take

Documentation

Product documentation is available on the Oracle Help Center at https://docs.oracle.com/en/industries/food-beverage/.

Simphony eLearning

The Simphony Learning Subscription provides additional product knowledge through interactive training, guided video tours, and helpful knowledge checks. After exploring the documentation library, use your Oracle Single Sign On to check out the Simphony learning opportunities at Hospitality Learning Subscriptions.

Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Description of Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>December 2018</td>
<td>Initial publication</td>
</tr>
<tr>
<td>Date</td>
<td>Description of Change</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>January 2019</td>
<td>Updated Configuring SRM Payment Types for Tenders (Step 6) in Chapter 39: Peripheral Devices.</td>
</tr>
<tr>
<td></td>
<td>Updated the following sections in Chapter 8: Language Settings and Translation:</td>
</tr>
<tr>
<td></td>
<td>• Setting Languages for the Property</td>
</tr>
<tr>
<td></td>
<td>• Setting the Default Language for Employees</td>
</tr>
<tr>
<td></td>
<td>• Setting the Default Language for a Workstation</td>
</tr>
<tr>
<td></td>
<td>Updated Logo Printing details in Chapter 38</td>
</tr>
<tr>
<td></td>
<td>Added DIP and Memory switch settings to Chapter 37: Printers</td>
</tr>
<tr>
<td></td>
<td>Updated Configuring CAPS on Microsoft IIS with Oracle Database on Enterprise Server in Chapter 36: CAPS</td>
</tr>
<tr>
<td>February 2019</td>
<td>Updated Configuring the SPI Payment Driver in Chapter 10: Payments and Currency by adding the Enable Quick Chip field and description to Step 4.</td>
</tr>
<tr>
<td>April 2019</td>
<td>• Updated Chapter 10: Payments and Currency, specifically The Oracle Payment Interface (OPI)</td>
</tr>
<tr>
<td></td>
<td>• Updated Chapter 42: Importing and Exporting Data, specifically Configuring the Import/Export Service Privileges</td>
</tr>
<tr>
<td></td>
<td>• Updated Chapter 46: Enterprise Cash Management</td>
</tr>
<tr>
<td></td>
<td>• Removed step from Configuring Decimal Quantity Menu Items in Chapter 12: Discounts</td>
</tr>
<tr>
<td>May 2019</td>
<td>Updated Adding a Workstation in Chapter 7: POS Workstations by adding Step 10 about editing the system’s license count.</td>
</tr>
<tr>
<td>September 2019</td>
<td>Updated the following sections in Chapter 7: POS Workstations:</td>
</tr>
<tr>
<td></td>
<td>• POS Clients Running Android Mobile Operating System</td>
</tr>
<tr>
<td></td>
<td>• Removed Android Devices and Versions as this information is included in the Oracle Food and Beverage Compatibility Matrix</td>
</tr>
<tr>
<td></td>
<td>• Configuring an Android Workstation</td>
</tr>
<tr>
<td></td>
<td>• Removed Installing the Simphony Service Host on an Android Device as this information appears in the Oracle Hospitality Simphony Client Deployment Guide</td>
</tr>
<tr>
<td></td>
<td>Added missing devices in Chapter 47: Engagement Cloud Service</td>
</tr>
<tr>
<td>Date</td>
<td>Description of Change</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>October 2019</td>
<td>• Updated Chapter 4: Cloning Simphony Database Configurations.</td>
</tr>
<tr>
<td></td>
<td>• Updated Fingerprint Scanning in Chapter 40: Peripheral Devices.</td>
</tr>
<tr>
<td></td>
<td>• Added Chapter 52: Interfaces with Simphony.</td>
</tr>
<tr>
<td></td>
<td>• Added SPI data flow and related information to Payments and Currency chapter.</td>
</tr>
<tr>
<td>December 2019</td>
<td>• Updated Configuring the Menu Item Tax Class Override in Chapter 12: Taxes.</td>
</tr>
<tr>
<td></td>
<td>• Updated Configuring Menu Item Definitions in Chapter 20: Menu Item Definitions.</td>
</tr>
<tr>
<td></td>
<td>• Updated Configuring Screen Look Ups for Open Checks in Chapter 24: Screen Look Up (SLU).</td>
</tr>
<tr>
<td></td>
<td>• Updated Chapter 39: Logo Printing (for the 18.2.3 release).</td>
</tr>
<tr>
<td></td>
<td>• Added Chapter 40: Configuring Pre-Production Chits to Output to Remote Printers (Release 18.2.3 only).</td>
</tr>
<tr>
<td></td>
<td>• Updated Creating Loyalty and Stored Value Buttons in Chapter 44: Loyalty and Gift Card Interfaces and Drivers.</td>
</tr>
<tr>
<td></td>
<td>• Updated Chapter 31: Guest Checks, specifically the Configuring Guest Check Numbers topic.</td>
</tr>
<tr>
<td>January 2020</td>
<td>• Updated Fingerprint Scanning in Chapter 40: Peripheral Devices to include information on how the system processes fingerprint data.</td>
</tr>
<tr>
<td></td>
<td>• Updated Chapter 8: POS Workstations (updated the Android Payments topic to include OPI/SPI as supported drivers).</td>
</tr>
<tr>
<td>February 2020</td>
<td>• Updated Chapter 4: Uploading Data to the Target Environment</td>
</tr>
</tbody>
</table>
Introduction to Simphony

Oracle Hospitality Simphony is an Enterprise-class Point-of-Sale (POS) software product. Simphony can be hosted in the Oracle Cloud Hosting Center, self-hosted at multiple properties or at a customer’s data center. Simphony can support multiple or single property configurations.

Administrators can configure Simphony using the Enterprise Management Console (EMC) tool. This application allows you to set up the Enterprise, properties, revenue centers, and zones from a PC that has access to the central server.

Simphony interacts with the following devices and solutions:

• Peripheral Devices, such as cash drawers, magnetic stripe readers, and barcode readers
• Printers and Order Devices, such as a Kitchen Display System (KDS)
• Credit Card Drivers
• Loyalty and Gift Card Interfaces and Drivers
• Oracle Hospitality Reporting and Analytics
• Oracle Hospitality OPERA 5 Hotel Property Systems
• EMC Basics

EMC Basics

This section describes the basic functions in EMC. For information about accessing the EMC after a fresh installation or upgrade, see the Oracle Hospitality Simphony Post-Installation or Upgrade Guide, specifically the EMC Access Security chapter.

EMC Configuration Hierarchy

The Simphony EMC has three areas that allow you to choose where to define certain definitions and records in the EMC’s hierarchy tree. In EMC, modules are configured (in order from highest to lowest) on the enterprise, property, or revenue center levels. See Enterprise for more information on EMC levels.

An employee’s assigned role determines whether users have full or partial access to specific modules on certain levels. See Employees and Privileges for more information on employee roles

EMC Home Page

When you log in, EMC defaults to the Home Page. The Home Page shows a navigation tree in the Locations pane based on the EMC levels. Modules appear to the right of the Locations pane and filters based on the location you select from the navigation tree.

You can use the filters below the Locations pane to easily search for properties, revenue centers, and zones within a large enterprise.
Figure 1-1  EMC Home Page Filters

- **Filter**: Enter the name of a property, revenue center or zone to filter the navigation tree.
- **Coll**: Click to collapse the navigation tree. If the navigation tree is collapsed when filtering, the search returns the top most level. For example, when you search for a revenue center, the navigation tree shows the property to which it belongs.
- **Exp**: Click to expand the navigation tree.
- **Show all zones**: Select to show zones in the navigation tree and to include zones in your search.
- **#**: Select to show the object number in front of properties, revenue centers, and zones in the navigation tree.

EMC remembers each users state at the time of exit. Therefore, the next time you log in, the EMC Home Page defaults to the location that was last viewed by you when EMC was closed.

**Table View and Form View**

Table view and form view are two views used to show information within modules.

Most modules open to table view, which is a grid view showing all records sorted by object number. Typically, the first two columns are the object number and name of the record. Table view is generally used when making bulk changes. When a record is changed, table view highlights the record in yellow.

Form view shows the same content that is available in table view, but for a single record. Sometimes, depending on the data, form view shows more information than table view. For example, the Employee Roles module, which contains only object number and name in table view, contains several configurable tabs in form view. Form view includes a navigation bar that shows the object number and name of each record available, making record-to-record navigation easier. To navigate to a specific record, simply select the record within the navigation bar and the corresponding form view tabs populate with the selected record's information.

Three methods are available for switching between table view and form view:
- Click the **Toggle Table/Form View** icon on the EMC toolbar.
- While in table view, double-click the Object Number column to open form view.
- While in form view, double-click the object number/name in the navigation bar to open table view.
Module Record Filters

By default, most modules in EMC show all of the available records when opened. You can remove unwanted records from view using the filters available in table view. The filters appear above the table and is set to Show All Records.

Figure 1-2   EMC Filter Section in Table View

When records are filtered,

• Form view shows only the records that appear in table view. While in form view, the navigation buttons (next, previous, first, and last) change to only the records that appear in table view.
• The Option Bit Comparison Dialog shows only the records that appear in table view.

The Menu Item Maintenance module provides additional filters for streamlining the records. See Searching and Filtering Menu Items for more information.

Sorting Records

In EMC, you can sort records presented in tables by one of the columns. By default, records are sorted by object number. To sort by another column, click the column header.

EMC Toolbar

EMC uses common controls that are familiar to most users. For example, the top of the screen includes a menu bar with the standard File, Edit, and View options. Additionally, a number of navigational icons are available on the toolbar.

The following table describes the icons on the EMC toolbar. You can also access the functions performed by these icons within the menu bar.

<table>
<thead>
<tr>
<th>Toolbar Icon</th>
<th>Name</th>
<th>Function</th>
<th>Available in Table View?</th>
<th>Available in Form View?</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Refresh</td>
<td>Performs a refresh of the data in the current module.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>🗑️</td>
<td>Close</td>
<td>Closes the currently active module.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>🗑️</td>
<td>Close All</td>
<td>Closes all open modules.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table 1-1 (Cont.) EMC Toolbar Icons

<table>
<thead>
<tr>
<th>Toolbar Icon</th>
<th>Name</th>
<th>Function</th>
<th>Available in Table View?</th>
<th>Available in Form View?</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Location Selector](141x673 to 158x686)</td>
<td>Location Selector</td>
<td>Opens the current module in another property or revenue center. This icon is enabled only if you open a module from the property or revenue center level.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>![Language Translation](141x686 to 158x692)</td>
<td>Language Translation</td>
<td>Opens the EMC Record Translation dialog. This icon is enabled only when the current GUI control is a translatable text field.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>![Print](141x692 to 158x702)</td>
<td>Print</td>
<td>Opens a dialog that allows you to print records from table view.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>![Save](141x702 to 158x707)</td>
<td>Save</td>
<td>Saves changes to records in the currently active module. This icon is enabled only when changes have are made to the current module. When you insert a new record to a module, Simphony automatically saves that record. To invoke this icon, you must make initial entries or modify an existing record entry.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>![Save All](141x707 to 158x712)</td>
<td>Save All</td>
<td>Saves changes to records in all open modules. This icon is enabled only when any open module has its records change.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>![Insert](141x712 to 158x717)</td>
<td>Insert</td>
<td>Adds a new record to the module. This icon is enabled only when the current module supports the Insert functionality and only when the logged-in user has Employee Role permissions to add new records to the module.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>![Delete](141x717 to 158x722)</td>
<td>Delete</td>
<td>Deletes records. This icon is enabled only when the current module supports the Delete functionality, and only when the logged-in user has Employee Role permissions to delete records from the module.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>![Distribute](141x722 to 158x727)</td>
<td>Distribute</td>
<td>Distributes records. This icon is enabled only when the EMC user is associated with an Enterprise Role with the option Distribute enabled, and only when the current module supports distribution.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>![Copy Record(s)](141x727 to 158x732)</td>
<td>Copy Record(s)</td>
<td>Copies records while in table view.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Toolbar Icon</td>
<td>Name</td>
<td>Function</td>
<td>Available in Table View?</td>
<td>Available in Form View?</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td></td>
<td>Undo/Redo</td>
<td>Performs the undo/reload function. You cannot undo the addition or deletion of a record. EMC uses a record-level undo, where all changes to a single record are undone. You cannot undo a previous change because the flow and layout of EMC make this an impractical option. The standard Ctrl+Z functionality does exist to undo changes to a text field. In Employee Maintenance and Menu Item Maintenance, undo is available through the right-click menu only.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Paste Record(s)</td>
<td>Pastes records while in table view.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Toggle Table/ Form View</td>
<td>Switches the current module between table view and form view.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>First Record</td>
<td>Navigates to the first record in the module.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Previous Record</td>
<td>Navigates to the previous visible record in the module.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Next Record</td>
<td>Navigate to the next record.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Last Record</td>
<td>Navigates to the last record in the module.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Go To</td>
<td>Opens a dialog that allows you to type an object number and navigate to the specified record.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Find</td>
<td>Opens a dialog that allow you to find a record based on text comparison in any column.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Go To Previous</td>
<td>In some modules, go to links are provided to quickly open other modules. For example, the Job Codes module includes a go to link to open the Employee Classes module. After clicking a go to link, this icon is enabled. When clicked, it closes the module that you were navigated to (for example, Employee Classes) and returns you to the module from which the link was pressed (for example, Job Code).</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Navigation Bar</td>
<td>Switches the visibility of the navigation bar in form view.</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
This chapter provides a high-level overview of Simphony configuration.

**Table 2-1   Getting Started**

<table>
<thead>
<tr>
<th>I Want To</th>
<th>Go To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure the business start of day</td>
<td>Resetting Daily Totals</td>
</tr>
<tr>
<td>Add properties</td>
<td>Adding a Property</td>
</tr>
<tr>
<td>Configure languages</td>
<td>Adding a Language</td>
</tr>
<tr>
<td>Configure currencies</td>
<td>Payment and Currency</td>
</tr>
<tr>
<td>Add revenue centers</td>
<td>Adding a Revenue Center</td>
</tr>
<tr>
<td>Add employees</td>
<td>Employees and Privileges</td>
</tr>
<tr>
<td>Add menu items</td>
<td>Menu Items</td>
</tr>
<tr>
<td>Add condiments to menu items</td>
<td>Condiments</td>
</tr>
<tr>
<td>Create combo meals</td>
<td>Combo and Fixed Price Meals</td>
</tr>
<tr>
<td>Configure menu levels</td>
<td>Menu Levels</td>
</tr>
<tr>
<td>Configure service charges</td>
<td>Service Charges</td>
</tr>
<tr>
<td>Configure taxes</td>
<td>Taxes</td>
</tr>
<tr>
<td>Configure discounts</td>
<td>Discounts</td>
</tr>
<tr>
<td>Configure guest checks and receipts</td>
<td>Guest Checks</td>
</tr>
<tr>
<td>Add workstations</td>
<td>POS Workstations</td>
</tr>
<tr>
<td>Configure workstation touchscreens</td>
<td>Workstation Touchscreen Pages</td>
</tr>
<tr>
<td>Configure Kitchen Display Systems</td>
<td>Oracle Hospitality Simphony KDS Configuration and User Guide</td>
</tr>
<tr>
<td>Configure printers</td>
<td>Printers</td>
</tr>
<tr>
<td>Configure cash drawers, coin dispenses, barcode scanners, and other peripheral devices</td>
<td>Peripheral Devices</td>
</tr>
</tbody>
</table>
The term Enterprise refers to the company's business operations managed by Simphony. Simphony supports multiple properties, and administrators can configure each property individually. Simphony allows these properties to report centrally to a single database.

Configuration flexibility accommodates differences between properties and revenue centers. In an Enterprise, the EMC configuration hierarchy is important to the administrator. Some module components are configured at the Enterprise and are then used in various properties and revenue centers.

The EMC level refers to the location where an EMC module is configured. In the EMC, you can configure modules for the Enterprise, property, revenue center, and zone levels based on the information you are configuring. For example, employee roles are set at the Enterprise level because typically a company keeps privileges the same throughout the Enterprise (for example, all bartenders have the same privileges). Tax rates are set at the property level because a property in Chicago uses different tax rates than a property in Dallas. Order devices are set at the revenue center level for a particular restaurant.

The following figure depicts the Enterprise with two properties. One property has two revenue centers (they might be a restaurant and bar), while the other property has one revenue center.

**Figure 3-1  Enterprise Hierarchy Organization Levels**

- Inheritance and Overrides
- Distribution
- Configuring Permissions for the EMC
- Inheritance and Overrides
Inheritance and Overrides

When configuration elements that are the same throughout an Enterprise, inheritance allows you to configure the elements once and use them throughout the properties and revenue centers. When an operation differs at the property or revenue center levels, override allows you to break away from the ancestry.

When you configure a module at the Enterprise level, the property and revenue center levels inherit the module settings. If you want the property or revenue center to have a different configuration than the Enterprise level, you can override the inheritance at the property and revenue center levels. For example, you can configure menu items at the Enterprise level, and override the menu items for a property by changing the configuration at the property level.

Some EMC modules show the Zone/Location or Tab and Inheritance Type columns. The Zone/Location column shows the zone or the location (Enterprise, property, or revenue center) of each record. The Inheritance Type column indicates the type of inheritance for each record:

- **Defined Here, No Override**: This status indicates the record is defined in the location of the module that is open. The record does not override another record. It is possible that another record overrides this record. (EMC is not aware of records below the current location.)
- **Inherited**: This status indicates the record is defined in another location, and it is inherited in the current module and location.
- **Defined Here, Overriding**: This status indicates the record is defined in the location of the module that is open. The record overrides another record from a higher location.

Additionally, in Menu Item Maintenance, the Override Indicator column shows visual markers denoting the overriding level hierarchy (where an item is configured) for definitions on the Enterprise:

- Up arrow (↑): Indicates that there is a definition above the current level in the hierarchy.
- Down arrow (↓): Indicates that it is overridden below in the hierarchy.
- Plus sign (+): Indicates that there is a definition at another unit, which can be a peer to the current level or a different zone, which is not above or below the current unit in the hierarchy.

You need to change a record from the location in which it is inherited. If the change only applies to a particular location (such as the Bar revenue center), you can override the record. You cannot edit an inherited record from a child hierarchy. When overrides exist for a record, the lowest record location applies.

The Override Indicator column is calculated only when the **Map Menu Item Override** option is set on the search panel.

- **Enterprise**
Distribution

Distribution is an EMC function that enables you to copy records between properties and revenue centers. You can configure records once within the EMC and distribute the records throughout the enterprise to multiple properties and revenue centers without having to create a record multiple times.

Remote Distribution

Remote distribution enables you to distribute data between two different Simphony systems. Remote distribution is database independent; therefore, you can distribute from a Microsoft SQL database into an Oracle Database and conversely, from an Oracle Database into a Microsoft SQL database. Remote distribution is specifically designed for the following two scenarios:

- Moving data from a testing system into a production system. This allows testing in a pre-production environment before moving to production.
- Distributing a new revenue center into the production system.

The Importance of Object Numbers

When records are distributed from one location to another, the object number stays the same. Therefore, it is important to configure properties and revenue centers consistently. For example, if object number 11 is Room Charge in one property, it must be Room Charge in all properties. Consider the following sample serving period configuration in revenue center 4:

- Object Number: 1
- Default Transaction Page: 41

When distributing this record to revenue center 8, it is created with the object number 1, and there are two possibilities for the default transaction page:

- If transaction page object number 41 exists in revenue center 8, the serving period's default screen is set to 41.
- If transaction page object number 41 does not exist in revenue center 8, the default screen is set to 0. This is the standard functionality for all types of distributed records. If the referencing object number does not exist, the value is set to 0.

Related Topics

- Configuring Distribution Privileges
- Distributing Properties and Revenue Centers
- Distributing Records
- Distribution Based on Source, Destination, and Selected Options

Related Topics

- Configuring Distribution Privileges
- Distributing Properties and Revenue Centers
- Distributing Records
Configuring Distribution Privileges

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Double-click the role type, click the Actions tab, and then select the appropriate privileges:

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Allows the Employee to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribute</td>
<td>Use the EMC Distribute function.</td>
</tr>
<tr>
<td>Remote Distribute Out</td>
<td>Move data from one revenue center to another revenue center or from one property to another property between two different Simphony systems. Select this option to allow employees associated with this role to remote distribute from this Simphony system out to another Simphony system. Employees need login credentials with permissions on the receiving Simphony system to Remote Distribute In.</td>
</tr>
<tr>
<td>Remote Distribute In</td>
<td>Move data from one revenue center to another revenue center or from one property to another property between two different Simphony systems. Select this option to allow employees associated with this role to remote distribute from another Simphony system into this Simphony system. Employees need Remote Distribute Out permissions on the other system to distribute in.</td>
</tr>
</tbody>
</table>

3. Click Save.

• Distributing Properties and Revenue Centers
• Distributing Records

Related Topics
• Distribution
• Distribution Based on Source, Destination, and Selected Options

Distributing Properties and Revenue Centers

1. To distribute a property:
   a. Select the Enterprise, click Setup, and then click Properties.
   b. Select the source property record.
2. To distribute a revenue center:
   a. Select the property, click Setup, and then click RVC Configuration.
   b. Select the source revenue center record.
3. To distribute within the same Symphony system, in the EMC toolbar, click **Edit**, and then click **Distribute**.

4. To remotely distribute between Symphony systems:
   a. In the EMC toolbar, click **Edit**, and then click **Remote Distribute**.
   b. Enter or select the **Server** or the IP address of the destination Symphony system.
   c. Enter the user credentials for the destination system in the **User** and **Password** fields respectively, and then click **OK** to log on to the system.

5. From the Destination pane, select the destination properties or revenue centers.

6. From the Modules To Copy pane, select the modules to distribute.

7. Select the appropriate options:

   The following table lists the distribution options and indicates whether the options are applicable for property distribution or revenue center distribution. See **Distribution Based on Source, Destination, and Selected Options** for more information on how Symphony distributes records based on the source record, destination record, and the configuration of options **Distribute inherited records** and **If destination record is inherited, create override**.

### Table 3-2 Property and Revenue Center Distribution Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Property</th>
<th>RVC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Clone</td>
<td>Select this option to copy IP addresses of workstations and KDS displays and to distribute all revenue centers and create new revenue centers. Selecting this option also enables the <strong>Distribute RVCs</strong> and <strong>Copy IP Addresses</strong> options.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Distribute RVCs</td>
<td>Select this option to distribute revenue centers, including all modules, in addition to distributing the selected modules for the property, if revenue centers exist in both properties. Existing records are overwritten and new records are created. Selecting <strong>Create Clone</strong> automatically enables this option.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Create RVCs</td>
<td>If remote distributing, select this option to create revenue centers in the destination properties, if they do not exist. This option only becomes active when you select <strong>Distribute RVC</strong>.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Copy IP Addresses</td>
<td>Select this option to copy IP addresses of the source record to the destination record. This option applies only to modules where the records include an IP address (for example, workstations and KDS displays). Selecting <strong>Create Clone</strong> automatically enables this option.</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
Table 3-2 (Cont.) Property and Revenue Center Distribution Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Property</th>
<th>RVC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribute inherited records</td>
<td>Select to distribute all records (defined and inherited) to the destination property. Deselect to distribute only records defined at the source property.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>If destination record is inherited, create override</td>
<td>Select to override inherited definition records in the destination property. Deselect to keep inherited records unchanged.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Distribute Data Extension if they Exist</td>
<td>Select to distribute any existing data extension values. The source and destination data extension property record must match</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

8. Click **OK**.

- **Configuring Distribution Privileges**
- **Distributing Records**

**Related Topics**
- **Distribution**
- **Distribution Based on Source, Destination, and Selected Options**

**Distributing Records**

This procedure is applicable for most modules in the EMC. Some modules, such as Menu Item Maintenance, contain module-specific distribution dialog boxes. See **Distributing Menu Items** for more information.

1. Navigate to the module that you want to distribute.

2. To distribute records within the same Simphony system, in the EMC toolbar, click **Edit**, and then click **Distribute**.

3. To remotely distribute records between Simphony systems:
   a. In the EMC toolbar, click **Edit**, and then click **Remote Distribute**.
   b. Enter or select the **Server** or the IP address of the destination Simphony system.
   c. Enter the user credentials for the destination system in the **User** and **Password** fields respectively, and then click **OK** to log on to the system.

4. From the Record Selection pane, select the records to distribute:
   - **All Records**: Select to copy all records from the source to the destination.
   - **Selected Records**: Select to distribute only the selected records.
   - **Specify Records**: Select to enter a list or range of records to distribute, and then enter the record numbers or ranges in the text box below separated by a comma. For example, 3-7, 9-20, 21-30.

5. From the Options pane, select the appropriate options:
See Distribution Based on Source, Destination, and Selected Options for more information on how Simphony distributes records based on the source record, destination record, and the configuration of options Distribute inherited records and If destination record is inherited, create override.

- **Overwrite records if they exist**: Select to overwrite existing records in the destination location. If the destination record is inherited, it is not overwritten.

- **Create records if they do not exist**: Select to create new records in the destination location.

- **Distribute inherited records**: Select to distribute all records (defined and inherited) to the destination property. Deselect to distribute only records defined at the source property. This option only appears if the module supports inheritance and override.

- **If destination record is inherited, create override**: Select to override inherited definition records in the destination property. Deselect to keep inherited records unchanged. This option only appears if the module supports inheritance and override.

- **Distribute Data Extension if they Exist**: Select to distribute any existing data extension values. The source and destination data extension property record must match.

6. From the Destination pane, select one or more destinations for the records.

7. Click **OK**.

Once distribution completes, a Distribution Report appears showing all records that were created, overwritten, and any errors encountered. You can save this report by clicking **Save to Disk**.

- **Configuring Distribution Privileges**
- **Distributing Properties and Revenue Centers**

**Related Topics**
- **Distribution**
- **Distribution Based on Source, Destination, and Selected Options**

**Distribution Based on Source, Destination, and Selected Options**

The following table describes how records are distributed based on the source record, destination record, and the selected distribution options.

**Table 3-3  Distribution Based on Source, Destination, And Selected Options**

<table>
<thead>
<tr>
<th>Record Source Type</th>
<th>Record Destination Type</th>
<th>Option Distribute Inherited Records</th>
<th>Option If Destination Record is Inherited, Create Override</th>
<th>Destination Record Created?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inherited</td>
<td>Inherited</td>
<td>Selected</td>
<td>Selected</td>
<td>Yes</td>
</tr>
<tr>
<td>Inherited</td>
<td>Inherited</td>
<td>Selected</td>
<td>Deselected</td>
<td>No</td>
</tr>
<tr>
<td>Inherited</td>
<td>Inherited</td>
<td>Deselected</td>
<td>Selected</td>
<td>No</td>
</tr>
<tr>
<td>Inherited</td>
<td>Inherited</td>
<td>Deselected</td>
<td>Deselected</td>
<td>No</td>
</tr>
</tbody>
</table>
Table 3-3  (Cont.) Distribution Based on Source, Destination, And Selected Options

<table>
<thead>
<tr>
<th>Record Source Type</th>
<th>Record Destination Type</th>
<th>Option Distribute Inherited Records</th>
<th>Option If Destination Record is Inherited, Create Override</th>
<th>Destination Record Created?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inherited</td>
<td>Defined</td>
<td>Selected</td>
<td>N/A</td>
<td>Yes</td>
</tr>
<tr>
<td>Inherited</td>
<td>Defined</td>
<td>Deselected</td>
<td>N/A</td>
<td>No</td>
</tr>
<tr>
<td>Defined</td>
<td>Inherited</td>
<td>Selected</td>
<td>Selected</td>
<td>Yes</td>
</tr>
<tr>
<td>Defined</td>
<td>Inherited</td>
<td>Selected</td>
<td>Deselected</td>
<td>No</td>
</tr>
<tr>
<td>Defined</td>
<td>Inherited</td>
<td>Deselected</td>
<td>Selected</td>
<td>Yes</td>
</tr>
<tr>
<td>Defined</td>
<td>Defined</td>
<td>Selected</td>
<td>Deselected</td>
<td>No</td>
</tr>
<tr>
<td>Defined</td>
<td>Defined</td>
<td>Deselected</td>
<td>N/A</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Related Topics

• Distribution
• Configuring Distribution Privileges
• Distributing Properties and Revenue Centers
• Distributing Records

Configuring Permissions for the EMC

You can set user permissions for the EMC modules. The privileges define the actions which users linked to the role can perform throughout EMC.

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Double-click the record of the role for which to set user permissions (for example, administrator, manager or server).
3. Click the EMC Modules tab.
4. Select the appropriate module permission options for the user role. You can grant user permissions for the following module actions:
   • View: Open and view a module. If you allow a user to Edit, Add, or Delete, you must also grant View access (otherwise the user cannot open the module).
   • Edit: Update fields or records within a module.
   • Add: Add records to a module.
   • Delete: Delete records from a module.
   • Add Override: Override records within a module.
   • Allow Duplicate Obj#: Add menu item records where existing records with the same number exist elsewhere in the Enterprise.
   • Allow Duplicate Name: Add records where existing records with the same name exist elsewhere in the Enterprise.
To grant access for all module actions, select **All Modules** from the Global Access section for each action. The **All Modules** option allows you to easily configure all permissions for the user for every module without individually selecting each option. Selecting **All Modules** also allows the user to access new modules that become available in future Simphony versions. Oracle Hospitality recommends granting **All Modules** permission for an administrator role.

5. Click the **Actions** tab.

6. Select the appropriate action permissions for the role.

To grant access to perform all actions, select **All Actions** from the Global Access section. Selecting **All Actions** also allows the user to perform new actions that become available in future Simphony versions. Oracle Hospitality recommends granting **All Actions** permission for an administrator type of role.

7. Click **Save**.

**Related Topics**

- **Enterprise**
- **Inheritance and Overrides**
Cloning Simphony Database Configurations

Starting with Simphony 18.2.2, you can clone an existing Simphony database configuration to quickly set up a new database. Cloning a database configuration consists of extracting data from a source environment and then uploading that data to the new target environment. To clone a database configuration, you need the EMC login credentials for the source environment and EMC credentials for the target environment.

- Extracting Data from the Source Environment
- Uploading Data to the Target Environment

Extracting Data from the Source Environment

1. Log in to the source environment.
2. Click **Clone Config** on the toolbar.
3. Click **Create Configuration Export File**.
4. In the Extract and Download window, click **Download Link** to download the data ZIP file.
5. Log out of the clone configuration tool.

Uploading Data to the Target Environment

1. Log in to the new target environment.
2. Click **Clone Config** on the toolbar.
3. Drag and drop the data ZIP file to the Import Configuration window or click the link to upload the file. Do not unzip the data ZIP file first.
4. Click **Import Configuration File**.
5. After the upload is complete, verify the configuration settings in the new environment.

   If the upload fails, review the error messages returned by the clone tool, and then try the upload again.

   If configuration data exists in the target environment, the clone tool detects the data during the upload. To overwrite the existing data with the data you are uploading, click **Erase Data & Proceed**.
5

Log File Management

Built-in log archiving capabilities are included with Simphony version 2.8 and later. Rather than deleting the oldest log file when a log reaches its maximum size, Simphony compresses the oldest log file up to two percent of its original size and then stores it in an AutoArchive folder, which is located in the same directory as the original logs. This reduces the disk space consumed by the log files and allows you to keep the files for a longer period of time. For example, if the maximum file size for a single log file is 1 MB and the total amount of disk space (log size) that can be used by all log files is 10 MB or 10 logs, when the application generates the eleventh log, it compresses the oldest log file and moves it to the AutoArchive folder.

Simphony names the archived files after the log files and includes the date and time of compression. You can easily search the log files for a particular date. For example, if the log file is Log_PePPER_172.txt, the archived file is Log_Pepper_172.DateOfCreation_TimeOfCreation.zip.

Simphony purges archived log files only when one of the following configured thresholds is met:

<table>
<thead>
<tr>
<th>Purge Threshold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LogArchiver.MinDiskUsedPercent</td>
<td>This threshold defines the free disk space threshold. When the free disk space falls below the configured percentage, Simphony purges the archived files. The minimum disk space is set to 10% by default.</td>
</tr>
<tr>
<td>LogArchiver.MaxDiskUsedMB</td>
<td>This threshold defines the maximum size for the archived files. When the total size of all the archives exceeds the configured amount, Simphony purges the archived files. The size is set to 100 MB by default.</td>
</tr>
<tr>
<td>LogArchiver.DaysToKeep</td>
<td>This threshold defines the number of days to keep the archived logs before purging. The number of days to keep is set to 21 days by default.</td>
</tr>
</tbody>
</table>

The ArchiveHistory.txt file, which resides in the original log directory, tracks log archiving operations. When this file reaches 20 KB, Simphony renames it to ArchiveHistory.previous.txt. Simphony retains only one ArchiveHistory.previous.txt file at a time.

Log archiving is active by default for application servers and services, while it is deactivated by default for workstation services due to the constrained disk space of workstations.

- Modifying the Default Log Archive Purge Settings for Application Services
- Enabling Log Archiving for Workstations
Modifying the Default Log Archive Purge Settings for Application Services

To modify the default archive purge settings, you need to add entries to four application service configuration files. The following table lists the configuration files for the application services and their locations:

<table>
<thead>
<tr>
<th>Application Service</th>
<th>Configuration File Name</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>EGateway Service</td>
<td>Web.config</td>
<td>[Drive Letter]:\MICROS\Simphony2\EGatewayService</td>
</tr>
<tr>
<td>Data Transfer Service (DTS)</td>
<td>DataTransfeService.exe.config</td>
<td>[Drive Letter]:\MICROS\Simphony2\DataTransfeService</td>
</tr>
<tr>
<td>Direct Posting Service (DPS)</td>
<td>DirectPostingService.exe.config</td>
<td>[Drive Letter]:\MICROS\Simphony2\DirectPostingService</td>
</tr>
<tr>
<td>Sequencer Service</td>
<td>SequencerService.exe.config</td>
<td>[Drive Letter]:\MICROS\Simphony2\SequencerService</td>
</tr>
</tbody>
</table>

1. Browse to the file location and open the configuration file.
2. Add the following entries:
   - To turn off log archiving, add `<add key="LogArchiver.Enabled" value="false" />`.
   - To change the free disk space threshold, add `<add key="LogArchiver.MinDiskUsed-Percent" value="MinDiskUsedPercent" />`.
   - To change the maximum size for the archived files, add `<add key="LogArchiver.MaxDiskUsedMB" value="MaxDiskUsedMB" />`.
   - To change the number of days to keep the archived logs, add `<add key="LogArchiver.DaysToKeep" value="DaystoKeep" />`.
3. Repeat Steps 1 and 2 for each configuration file listed in the table.

Enabling Log Archiving for Workstations

1. Browse to the [Drive Letter]:\MICROS\webserver\wwwroot\EGateway folder and open the Web.config file.
2. Add the following entries to the Web.config file:
   - `<add key="LogArchiver.Enabled" value="true" />`
   - `<add key="LogArchiver.MinDiskUsedPercent" value="MinDiskUsedPercent" />`
   - `<add key="LogArchiver.MaxDiskUsedMB" value="MaxDiskUsedMB" />`
   - `<add key="LogArchiver.DaysToKeep" value="DaystoKeep" />`
3. Save the changes.
• Modifying the Default Log Archive Purge Settings for Application Services
Properties

A property is a place of business. A property can have one or more revenue centers within a confined geographic location. For example, a hotel property can have three revenue centers (restaurant, bar, and gift shop), and a shopping mall can have several restaurant revenue centers. Both properties can belong to the same Simphony Enterprise, but each property has separate sales figures, tax information, and other configuration specific to the location.

• Adding a Property
• Adding a Revenue Center
• Revenue Center Groups
• Configuring a Revenue Center Group

Adding a Property

Video

1. Select the Enterprise level, click Setup, and then click Properties.

2. Click the Insert icon ( ) on the toolbar.

3. In the Add Property dialog, enter the Property Number and Property Name.

4. Select 2 - Extensible Clients and Architecture from the Simphony Platform drop-down list.

5. Select the Time Zone for the property location.

6. Select the location configured in the reporting database from the Report Location drop-down list. The Oracle Hospitality Reporting and Analytics database determines the locations that appear in the list.
   a. To add a new location, click the New button, and then enter the appropriate information. An administrator must then add the information to the Reporting and Analytics property list in order to run reports.
   b. To change an existing location, click the Edit button, and then enter the appropriate information.

7. (Optional) To copy information from a property template, in the Source Property section, select Copy from source property. The hierarchy panel and Modules To Copy fields become active.
   a. In the hierarchy panel, select the property to use as the source property.
   b. In the Modules to Copy section, select the modules you want to copy from the source property. To automatically select all modules, click the Select All Modules link.
   c. (Optional) To copy the Internet Protocol (IP) addresses of workstations and kitchen display system (KDS) displays, and to create new revenue centers,
select **Create Clone**. Selecting this option essentially selects the next two options (described in Steps 7-d and 7-e).

d. (Optional) To create new revenue centers for the property based on the existing revenue centers in the template property, select **Create RVCs**.

e. (Optional) To copy the IP addresses of workstations and KDS displays from the source property to the destination property, select **Copy IP Addresses**. Use this option when properties are segmented on their own networks and IP address conflicts do not occur.

f. (Optional) To distribute all records (defined and inherited) from the source property to the destination property, select **Distribute inherited records**. Deselect this option to distribute only records defined at the source property to the destination property.

g. (Optional) To create an override record in the destination property when an inherited definition exists, select **If destination record is inherited, create override**.

h. (Optional) To distribute data extension values, select **Distribute Data Extensions if they exist**.

8. Click **OK** to copy the records from the source template property to the new property.

9. Click **Save**.

10. To delete a property:
   a. Close all open checks and transactions.
   b. Delete all associated revenue centers.
   c. Delete the property.

---

### Adding a Revenue Center

**Video**

1. Select the property, click **Setup**, and then click **RVC Configuration**.

2. Insert a record.

3. From the Add Revenue Center dialog, enter the **RVC Number** and the **RVC Name**.

4. (Optional) To copy information from an existing revenue center, select **Copy from source Revenue Center** from the Source Revenue Center section. The hierarchy panel and **Modules To Copy** fields become active.
   a. From the hierarchy panel, select the revenue center to use as the source revenue center.
   b. From the Modules to Copy section, select the modules you want to copy from the source revenue center. To automatically select all modules, click the **Select All Modules** link.
   c. (Optional) Select **Distribute inherited records** to distribute all records (defined and inherited) from the source revenue center to the new revenue center. Deselect this option to distribute only records defined at the source revenue center to the new revenue center.
d. (Optional) Select If destination record is inherited, create override to create an override record in the new revenue center when an inherited definition exists.

e. (Optional) Select Distribute Data Extensions if they exist to distribute data extension values if they exist.

5. Click OK to copy the records from the source template revenue center to the new revenue center.

6. From the RVC Configuration module table view, select the following options as applicable for the new revenue center:
   - LDS Active: Select this option if the revenue center uses a Liquor Dispensing System (LDS), which is a third-party system used for pouring and tracking liquor and beverages, as well as mixed drinks.
   - KDS Controller: Select the KDS Controller to control the kitchen display system (KDS) order devices in the revenue center.

7. Click Save.

Revenue Center Groups

You can create a revenue center group for use when a property hosts an event that occurs in multiple revenue centers. For example, a baseball game takes place in every revenue center at a stadium. When you create the event, you can associate it with the revenue center group rather than selecting each revenue center individually.

Revenue center groups are also useful when multiple revenue centers use the same kitchen or bar to prepare menu items. You can set a Menu Item Availability record for a revenue center group.

Configuring a Revenue Center Group

1. Select the property, click Setup, and then click Revenue Center Groups.

2. Insert a new record or select an existing record, and then double-click the record to open it.

3. Select the revenue centers to include in the revenue center group.

4. Click Save.
Zones

Zones are custom hierarchies within the Enterprise. You can use zones to group similar aspects of an Enterprise together to manage configuration tasks with minimum effort and to eliminate duplicate configuration. For example, you can categorize:

- Taxes by country, state, county, and city
- Prices by region, tier, and property
- Menu item maintenance by item groups (food, beverage, retail), price tiers, and stores

Zones assist in managing definitions and records in a more streamlined manner. Simphony’s Inheritance and Override feature enables you to configure definition records on the Enterprise level, and they are inherited throughout the system. If there are unique circumstances where a particular definition must be different from an inherited record, you can override that record at the zone, property, or revenue center level. Inheritance and Override contains more information.

For example, you can create a country zone for the Enterprise, create sub-zones (child zones) for each country, and then create or override the records from the relevant level as illustrated in the following figure. This figure shows a sample zone hierarchy for a single record group, where the existence of records is denoted in blue and inheritance is denoted in gray.
A single revenue center or property can belong to multiple zones, and a single zone can contain an unlimited number of sub-zones. Zones with meaningful names provide a clear overview of the structure. Configuring zones effectively:

- Allows privileged users to view and navigate the entire Enterprise from within the EMC in a more logical manner
- Creates a big picture that shows which locations might be affected by potential changes or updates
- Saves time with definition handling and updates throughout the system
- Controls definition distribution to POS clients

**Record Priority within Multiple Zone Configurations**

If a property or revenue center exists in multiple zones, Simphony uses the definition record which is closest to the hierarchy when determining which record to use for a specific object number. For example, in the following figure, the Enterprise depicted has two separate zone hierarchies. The Country zone has two sub-zones: United States and Canada. The second zone, Concepts, also has two sub-zones: Restaurants and Retail. Both zone hierarchies have revenue centers in common.
Imagine that a discount record is defined in the Enterprise, and the four sub-zones (United States, Canada, Restaurants, and Retail) override this discount record, which is then inherited by their properties and revenue centers respectively. The existence of the record is denoted in blue and inheritance is denoted in gray.

Figure 7-2  Sample Configuration of a Single Record Definition
Because the revenue centers are closer to the definition record in the Concepts zone (RVC 1-1 is only one level away from Restaurants while it is two levels away from United States), the Concepts zone record wins.

Consider the following sample configuration for multiple discount records:

Figure 7-3  Sample Configuration of Multiple Record Definitions

Given the configuration in the above image, Simphony uses the following discount records for Property 1:

- Record 1 defined in Property 1
- Record 2 defined in the United States zone
- Record 3 defined in the United States zone
- Record 4 defined in the Enterprise
- Record 5 defined in Property 1

Record Collisions

Record collisions occur when a property or revenue center has two competing winning records that are the same number of levels away from the hierarchy. For example, in the following figure, RVC 4-2 is one level away from Property 4 and Retails, both of which have overriding record definitions.
While EMC prevents you from manually creating a competing record, such situations can arise when moving revenue centers and zones, or when using the Import/Export Service. In such instances, EMC detects the error and prevents you from opening the module corresponding to the definition record until the conflict is resolved.
Example Configuration Scenarios

You can use zones to organize the Enterprise in multiple ways. Here are a few examples:

- **Example 1:** Region zones are useful for many applications, from global considerations such as alphanumeric keyboards and currencies to tax or labor laws. These zones are usable repeatedly in multiple trees.

  ![Sample Zone Configuration for Regions](image)

  **Figure 7-5** Sample Zone Configuration for Regions

- **Example 2:** Enterprises that have different concepts (Dine-In, Take-Out) between properties or revenue centers can manage their differences through zones. Similarly, zones are useful for configuring brands. Hotel chains that have certain concessions in various or all properties can configure them as zones and place the appropriate revenue centers into the Brand Zones to inherit the relevant records.
Figure 7-6  Sample Zone Configuration for Brands

Reporting and Analytics Posting

Reporting and Analytics is zone independent. Transactions post to the actual location where the transaction originated. For example, if a menu item definition record originated in the Retail zone, it posts under the revenue center that inherited the record from the zone at the time of the transaction. If you create an overriding record later in the same revenue center and another transaction is posted for the same menu item, Reporting and Analytics shows as if the price change was made for the same menu item.

Creating Zones

Creating Zones

1. Select the Enterprise, click Setup, and then click Zone Configuration.

2. In the Zone Configuration pane on the left, right-click Enterprise, and then select the appropriate option:
   - Add Zone: Select to create only a single zone.
   - Add Multiple Zones: Select to create more than one zone simultaneously.
3. In the Add Zones to Enterprise dialog, enter the **Name** and **Object Number** for each zone, and then click **OK**.

Enter a meaningful name, such as a description of what modules are defined in the zone, to provide a clear overview of the structure.

4. To apply enforcement rules to the zone to prevent record collisions and unwanted updates:
   
a. From the Zone Configuration pane, select a zone, and then click **Edit Selected Note**.
   
b. Select the appropriate **Zone Type**:
      
      • **0 - None**: Select if the zone has no restrictions.
      
      • **1 - Properties and RVCs**: Select if the zone can only contain properties and their revenue centers.
      
      • **2 - RVCs Only**: Select if the zone can only contain revenue centers.

   c. Select the appropriate enforcement rules. The following table describes the enforcement rule options and indicates the zone types for which each option is available.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Non</th>
<th>Properties and RVCs</th>
<th>RVCs Only</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Enforce Unique Properties within this Zone</td>
<td>Select to prevent properties from existing more than once in the zone and all child zones.</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>2 - Enforce Unique RVCs within this Zone</td>
<td>Select to prevent revenue centers from existing more than once in the zone and all child zones.</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>3 - Modules Available in this Zone are not available in Child Zones.</td>
<td>Select to prevent child zones from inheriting the modules from the zone.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>4 - All RVCs must be from the same Property</td>
<td>Select to enforce all revenue centers within the zone to belong to the same property.</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>5 - Sort the selected zone alphabetically</td>
<td>Select to sort a zone in alphabetical order.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

d. To make all EMC modules configurable in the zone, select **All Modules**.

e. To select the EMC modules that are configurable in the zone, deselect **All Modules**, and then select the modules that are accessible from the EMC module list.

   Modules that are available in one location are also available in the children of that location, unless you configure otherwise.

f. Click **OK**.

5. To add properties to a zone:
   
a. From the Zone Configuration pane, right-click the zone, and then click **Add Properties**.
b. From the Add Property dialog, select the properties to add, and then click OK.

6. To add revenue centers to a zone:
   a. From the Zone Configuration pane, right-click the zone, and then click Add Revenue Centers.
   b. From the Add RVC dialog, select the property to which the revenue centers belong, and then select the revenue centers from the list.
   c. Click OK.

7. To apply enforcement rules to the properties or revenue centers in the zone:
   a. From the Zone Configuration pane, select a property or revenue center, and then click Edit Selected Node.
   b. Select the appropriate enforcement rules and configurable EMC modules. Refer to the Zone Enforcement Rule Options table in Step 4 for more information on the enforcement rules.

8. Click OK.

Related Topics
• Zones
POS Workstations

A workstation is a device used by managers, servers, bartenders, hosts, and cashiers at a property to perform various functions, such as creating guest checks, adding menu items, applying discounts and service charges, and paying a check. Examples of POS workstations include the Oracle MICROS Workstation 6 Series and the Workstation 5a.

- Workstation Tasks
- Adding a Workstation
- Configuring Workstation Transaction Settings
- Setting Offline Transaction Posting Time
- Configuring Workstation Security
- Changing the Appearance of Workstations
- Configuring the Magnetic Stripe Reader on the Oracle MICROS Tablet 720
- Configuring the Barcode Scanner on the Oracle MICROS Tablet 720
- Allowing Employees to Install and Authenticate POS Clients and Service Hosts
- Using the Simphony POS Client and Mobile Solution Application on One Device
- Configuring the Close Application Button
- POS Clients Running Android Mobile Operating System
- Android Functionality Support
- Android Network Requirements
- Android Payments
- Workaround for Android Lollipop 5.0.2 and 5.1
- Configuring the Android Device as a Workstation
- Configuring an Android Workstation
- Viewing and Editing Simphony Android Files
- Wireless Signal Strength Threshold
- Configuring Wireless Signal Strength Control Permissions
- Configuring the Wireless Signal Strength Threshold for Tablet Devices

Workstation Tasks

Adding a workstation consists of completing the following tasks:

- Adding a workstation
- Configuring workstation transaction settings
- Setting offline transaction posting time
• Configuring workstation security
• (Optional) Configuring an Android mobile device as a workstation

Related Topics
• Adding a Workstation
• Configuring Workstation Transaction Settings
• Setting Offline Transaction Posting Time
• Configuring Workstation Security
• Allowing Employees to Install and Authenticate POS Clients and Service Hosts
• POS Clients Running Android Mobile Operating System
• Android Functionality Support
• Android Network Requirements
• Android Payments

Related Topics
• Workaround for Android Lollipop 5.0.2 and 5.1
• Configuring the Android Device as a Workstation
• Configuring an Android Workstation
• Viewing and Editing Simphony Android Files

Adding a Workstation

1. Select the property, click Setup, and then click Workstations.
2. Insert a record for the workstation, enter the name, and then click OK.
3. Double-click the new workstation record.
4. On the General tab, enter information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select the type of workstation from the drop-down list:</td>
</tr>
<tr>
<td></td>
<td>• 1 - Mobile MICROS: Mobile devices</td>
</tr>
<tr>
<td></td>
<td>• 2 - Workstation Client: Workstations, virtual machines, and Android tablets</td>
</tr>
<tr>
<td></td>
<td>Select this option for the Oracle MICROS Workstation 6 Series and the Oracle MICROS Tablet 700 Series.</td>
</tr>
<tr>
<td></td>
<td>• 3 - POSAPI Client: Simphony Transaction Services or Pay@Table</td>
</tr>
<tr>
<td></td>
<td>• 6 - MICROS Tablet Client: Oracle MICROS Tablet E-Series</td>
</tr>
<tr>
<td></td>
<td>Select this option for the Oracle MICROS Tablet E-Series 11-inch.</td>
</tr>
</tbody>
</table>
Table 8-1  (Cont.) General Workstation Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Select the default language of the workstation. This is the language that appears on the workstation’s Sign On screen. If an employee has a different default language set, the employee sees their default language after signing in to the workstation.</td>
</tr>
<tr>
<td>Resolution Cols</td>
<td>Enter the number of Resolution Columns for the workstation’s display. The default value is 0 (zero).</td>
</tr>
<tr>
<td>Resolution Rows</td>
<td>Enter the number of Resolution Rows for the workstation’s display. The default value is 0 (zero).</td>
</tr>
<tr>
<td>Log Verbosity</td>
<td>Select the logging verbosity for the workstation. Select 0 (zero) for minimal logging. Higher log verbosity provides more information in the log file, which may be helpful in troubleshooting issues.</td>
</tr>
<tr>
<td>(Optional) Workstation Class</td>
<td>Select a Workstation Class to allow similar workstations to be grouped together and to share certain page configuration settings.</td>
</tr>
<tr>
<td>Database Update Frequency</td>
<td>Enter the number of seconds for the workstation to receive changes. The default value is 1800 seconds (30 minutes). The value in this field overrides the Property Parameter’s Database Update Frequency setting.</td>
</tr>
<tr>
<td>Check Inactivity Timeout</td>
<td>Enter the number of seconds before the workstation shows the message (Do you need more time?), prompting the workstation operator to cancel the transaction. When you enter 0 (zero), the message does not appear.</td>
</tr>
<tr>
<td>Check Inactivity Dialog</td>
<td>Enter the number of seconds that the workstation shows the Inactivity dialog before automatically cancelling the transaction. This field is unavailable when you set the Check Inactivity Timeout value to 0 (zero).</td>
</tr>
<tr>
<td>Report Timeout</td>
<td>Enter the number of seconds the workstation waits for a response before showing a communication failure notice.</td>
</tr>
<tr>
<td>Address / Host Name</td>
<td>Enter the IP address or host name of the Oracle Hospitality Simphony Service Host where the workstation application runs.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>Enter the subnet mask of the Service Host where the workstation application runs.</td>
</tr>
<tr>
<td>Default Gateway</td>
<td>Enter the default gateway of the Service Host where the workstation application runs.</td>
</tr>
<tr>
<td>Is Connectionless</td>
<td>Select this option to have the Service Host open and close a new connection for each web service call. This prevents the workstation from reaching the maximum number of web connections allowed, although the connection becomes slightly slower.</td>
</tr>
</tbody>
</table>
Table 8-1  (Cont.) General Workstation Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is Windows Service</td>
<td>Select this option to allow the Service Host to start as a Windows service. The Service Host service starts on Microsoft Windows startup with other Microsoft Windows services. The POS client starts only when the workstation operator signs on to the operating system. If you select this option, you need to change the ports of the services being run (for example, Check and Posting Service (CAPS) and Oracle Hospitality Simphony Kitchen Display System (KDS) Controller) in addition to the POS client. Use the EMC modules to change the ports. If a non-POS client is required to run on the Service Host, it must run on a different port than the workstation port. You can also set the Service Host to run as a Microsoft Windows service from the Service Host module (rather than from the Workstations module). If you set this option in the Service Host module, you do not need to change the ports of the services being run as the device is not intended to run the POS client.</td>
</tr>
</tbody>
</table>

5. Click the Printers tab.  
6. Click the Select link next to each printer type that you need to configure, select the printer, and then click OK.  
7. Click the Revenue Centers tab.  
8. Select the revenue centers for the workstation. You must select at least one revenue center.  
9. Click Save.  
10. When adding or removing workstations, you need to edit the system’s license count using the following steps:  
   a. Select the Enterprise level, click Setup, and then click Enterprise Parameters.  
   b. Click the License Configuration tab.  
   c. Click Configure adjacent to Workstations Client License Count.  
   d. To add a license count (for the first time), select I would like to set the license count to X, making the new license count X.  
   e. To append licenses to an existing license count, select I would like to add X to the current license count, making the new license count Y.  
   f. Enter the number of client licenses purchased.  
   g. (Optional) Enter additional details regarding the purchased license in Enter Reference Information for the License Count Change, and then click OK.  
   h. Repeat Steps 10-c through 10-g for Transaction Service Client License Count, and KDS Client License Count.  
   i. Click Save, and then click Yes to agree to the license.  
   j. To perform a side by side comparison of the number of purchased licenses against the number of configured clients, click View adjacent to the Properties, Revenue Centers, Concessions Terminals, Workstation Client License Count,
Configuring Workstation Transaction Settings

1. Select the property, click Setup, and then click Workstations.
2. Double-click the workstation record to open it.
3. Click the Transactions tab, and then enter information in the following fields:

   **Table 8-2 Workstation Transaction Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Check Number</td>
<td>Enter the minimum guest check number to use:</td>
</tr>
<tr>
<td></td>
<td>• When the workstation is in offline mode</td>
</tr>
<tr>
<td></td>
<td>• When the workstation is used in revenue centers without the RVC Parameters option Use Revenue</td>
</tr>
<tr>
<td></td>
<td>Center Check Numbers. In these revenue centers, each workstation determines its own check</td>
</tr>
<tr>
<td></td>
<td>number range.</td>
</tr>
<tr>
<td>Maximum Check Number</td>
<td>Enter the maximum guest check number to use:</td>
</tr>
<tr>
<td></td>
<td>• When the workstation is in offline mode</td>
</tr>
<tr>
<td></td>
<td>• When the workstation is used in revenue centers without the RVC Parameters option Use Revenue</td>
</tr>
<tr>
<td></td>
<td>Center Check Numbers. In these revenue centers, each workstation determines its own check</td>
</tr>
<tr>
<td></td>
<td>number range.</td>
</tr>
<tr>
<td>(Optional) Default Order Type</td>
<td>Select the default active order type for the workstation (for example, Dine In, Take Out, or Drive Thru).</td>
</tr>
<tr>
<td>Barcode Format Set</td>
<td>Select the barcode format for the workstation to read barcodes of various lengths.</td>
</tr>
<tr>
<td>Cashier Link</td>
<td>Select the cashier record to link to the workstation. This provides a link to tracking totals for Tender/Media information.</td>
</tr>
<tr>
<td></td>
<td>This field is available only when you select 8 - On = Link Cashier Totals to WS; OFF = Link to Operator from the Workstations module (Options tab, and then the Offline/Misc subtab).</td>
</tr>
</tbody>
</table>
### Table 8-2  (Cont.) Workstation Transaction Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merchant Group</td>
<td>Select the merchant group for the workstation, or select <strong>0 - Use RVC Setting</strong> to use the settings from the revenue center in which the transaction occurs. If multiple revenue centers exist, each revenue center may route payment information to a different bank. These banks can be grouped into merchant groups.</td>
</tr>
<tr>
<td>Thai Tax Rd Number</td>
<td>If applicable, enter the number to print on Thai Tax trailers.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

- **Adding a Workstation**
- **Setting Offline Transaction Posting Time**
- **Configuring Workstation Security**
- **Allowing Employees to Install and Authenticate POS Clients and Service Hosts**

**Related Topics**
- **Workstation Tasks**

---

### Setting Offline Transaction Posting Time

When a property or its workstations are unable to communicate with the database for an extended period of time, transactions do not post. You can determine whether offline transactions post using the current time or the transaction time once communication resumes.

1. Select the property, click **Setup**, and then click **Property Parameters**.

2. Click the **Options** tab.

3. To allow offline checks to post to the database (when communication with the Check and Posting server is re-established) with the actual time of the transaction, select **6 - Post Offline Transactions with Actual Transaction Time**. Deselect this option to allow offline checks to post with the time that the check is uploaded into the database.

4. Click **Save**.

- **Adding a Workstation**
- **Configuring Workstation Transaction Settings**
- **Configuring Workstation Security**
- **Allowing Employees to Install and Authenticate POS Clients and Service Hosts**

**Related Topics**
- **Workstation Tasks**

---

### Configuring Workstation Security

1. Select the property, click **Setup**, and then click **Workstations**.
2. Double-click the workstation record to open it.
3. Click the **Options** tab, and then click the **Display/Security** subtab.
4. Select the appropriate options:

<table>
<thead>
<tr>
<th><strong>Table 8-3 Workstation Security Options</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Security Option</strong></td>
</tr>
<tr>
<td>---------------------</td>
</tr>
<tr>
<td>Mag Card Entry Required for Employee ID</td>
</tr>
<tr>
<td>Disable Employee Auto Sign Out</td>
</tr>
<tr>
<td>Use Alternate ID for Sign-in</td>
</tr>
<tr>
<td>Fingerprint Scan Required for Employee ID</td>
</tr>
<tr>
<td>Employee ID or Fingerprint Scan Required for Employee ID</td>
</tr>
<tr>
<td>Employee ID and Fingerprint Scan Required for Employee ID</td>
</tr>
<tr>
<td>Mag Card or Fingerprint Scan Required for Employee ID</td>
</tr>
<tr>
<td>Mag Card and Fingerprint Scan Required for Employee ID</td>
</tr>
</tbody>
</table>
5. Click **Save**.

- **Adding a Workstation**
- **Configuring Workstation Transaction Settings**
- **Setting Offline Transaction Posting Time**
- **Allowing Employees to Install and Authenticate POS Clients and Service Hosts**

**Related Topics**
- **Workstation Tasks**

### Changing the Appearance of Workstations

1. Select the Enterprise, property, or zone, click **Configuration**, and then click **Theme Assignment**.

2. Change the following settings:
   - **Default Theme**: Select the default theme for the workstations.
   - **Default Palette**: If you selected **Edge** as the Default Theme, select the color palette for the theme.

3. Click **Save**.

### Configuring the Magnetic Stripe Reader on the Oracle MICROS Tablet 720

The Oracle MICROS Tablet 720 comes with a built-in OPOS Mag Stripe Reader (MSR).

1. In EMC, select **Property**, **Setup**, **Hardware/Interfaces**, **Workstations**, and then **Devices**.

2. In the **Peripheral Device Configuration** section, click **Add**.

3. For **Select Peripheral Device Type**, select **OPOS Mag Stripe Reader**.

4. For **Configuration**, enter `IDTECH_SECUREMAG_USBHID`.

5. Click **OK**, and then **Save**.

The Oracle MICROS Tablet 720 Setup Guide contains more information on setting up and using the Tablet 720.

### Configuring the Barcode Scanner on the Oracle MICROS Tablet 720

The Oracle MICROS Tablet 720 comes with a built-in OPOS Barcode Scanner.

1. In EMC, select **Property**, **Setup**, **Hardware/Interfaces**, **Workstations**, and then **Devices**.

2. In the **Peripheral Device Configuration** section, click **Add**.
3. For **Select Peripheral Device Type**, select **OPOS Barcode Reader**.
4. For **Configuration**, enter **Honeywell**.
5. Click **OK**, and then **Save**.

The *Oracle MICROS Tablet 720 Setup Guide* contains more information on setting up and using the Tablet 720.

- Configuring the Magnetic Stripe Reader on the Oracle MICROS Tablet 720

### Allowing Employees to Install and Authenticate POS Clients and Service Hosts

Beginning with Simphony version 2.9.1 and later, you must allow administrator employees to download software, install, and authenticate clients and service hosts using CAL version 139. After granting this privilege, employees can use their credentials to configure POS clients. In addition, the User Security Credentials configured in the Property Parameters module become inactive.

1. Select the Enterprise, click **Configuration**, and then click **Roles**.
2. Double-click an employee role.
3. Click the **Operations** tab, click the **Miscellaneous** subtab, and then select **10065 - Download Software, Install and Authenticate Clients and Service Hosts Using CAL**.
4. Click **Save**.

- Adding a Workstation
- Configuring Workstation Transaction Settings
- Setting Offline Transaction Posting Time
- Configuring Workstation Security

### Related Topics
- Workstation Tasks

### Using the Simphony POS Client and Mobile Solution Application on One Device

Your organization can run Mobile Solution 18.1 (used with Oracle Hospitality Inventory Management and Oracle Hospitality Materials Control) on a Simphony tablet device. To share applications on the device, you need to configure a button (using the Page Design module in the EMC) that closes the Simphony POS client on the device. (Minimizing Simphony does not release the scanner.)

After configuring the **Close Application** function button:

- When the device is powered on, the Simphony POS client starts automatically.
- The workstation operator must click the **Close Application** button to stop the Simphony POS client.
- The workstation operator must manually start the Mobile Solution application.
• After using Mobile Solution, the workstation operator must stop it.
• The workstation operator must manually start the Simphony POS client.

Related Topics
• Configuring the Close Application Button

Configuring the Close Application Button

To configure a button that closes Simphony on the workstation:

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Open the page on which to place the close application button.
3. On the Edit tab, select the page area in which to define the button.
4. Click Button to add a button.
5. From the Type drop-down list, select Function.
6. Click the black arrow beneath the Type drop-down list.
7. In the Name field, enter close, select Close Application in the Results section, and then click OK.
8. On the General subtab, click the Generate Legend link.
9. Position and size the button on the page. Use the Style arrow to change the color.
10. Click Save.

Related Topics
• Using the Simphony POS Client and Mobile Solution Application on One Device

POS Clients Running Android Mobile Operating System

You can run Simphony version 2.7 and later on devices running the Android mobile operating system. The Simphony POS client operates in a similar way on an Android mobile device and a Microsoft Windows device. You can configure the POS client using the EMC.

Oracle recommends using one revenue center per Android device, and a maximum of 10,000 menu item definitions.

The UI is the same on all devices and workstations. Android devices have special requirements to consider, including deployment method, configuration requirements, and the procurement process.

The Oracle Hospitality Compatibility Matrix contains more information about supported POS Client Operating Systems.

• Workstation Tasks
• Android Functionality Support
• Android Network Requirements
• Android Payments
Related Topics

- Workaround for Android Lollipop 5.0.2 and 5.1
- Configuring the Android Device as a Workstation
- Configuring an Android Workstation
- Viewing and Editing Simphony Android Files

Android Functionality Support

Note the following functionality limitations when using Simphony on an Android device:

- Simphony does not support remote access to the Android desktop for certified support applications (for example, Bomgar, Remote Desktop Protocol (RDP), and so on).
- Android devices only operate the Simphony POS client application and cannot host shared services that other devices might access.
- Android devices do not support the Check and Posting Service (CAPS). Therefore, the property must use at least one device with a Microsoft operating system in addition to the Android device. Oracle Hospitality recommends that this device be an Oracle MICROS Workstation 5a (POSReady) or Oracle MICROS PC Workstation 2015.

- Workstation Tasks
- POS Clients Running Android Mobile Operating System
- Android Network Requirements
- Android Payments

Related Topics

- Workaround for Android Lollipop 5.0.2 and 5.1
- Configuring the Android Device as a Workstation
- Configuring an Android Workstation
- Viewing and Editing Simphony Android Files

Android Network Requirements

Android devices are connected wirelessly to Simphony using an 802.11x network. Therefore, it is vital that the property have a high quality wireless network. Spotty Wi-Fi coverage causes application performance issues with check sharing and posting, as well as bouncing between online and offline states with the services on property (for example, check and posting, printing and kitchen display) and the Enterprise, which impacts the ability to receive database updates.

You must configure the Android device to use a wireless local area network (WLAN) with connectivity to the (local area network) LAN used by the Check and Posting Service and other Simphony POS clients with which they might share checks. Simphony does not support the use of a 3G or 4G connection through a telecommunications provider back to these local devices.

Oracle Hospitality recommends that you configure Android devices to use a static Internet Protocol (IP) address. Simphony does not support the use of Dynamic Host
Configuration Protocol (DHCP) assigned addresses unless you define a DHCP reservation.

- Workstation Tasks
- POS Clients Running Android Mobile Operating System
- Android Functionality Support
- Android Payments

Related Topics
- Workaround for Android Lollipop 5.0.2 and 5.1
- Configuring the Android Device as a Workstation
- Configuring an Android Workstation
- Viewing and Editing Simphony Android Files

Android Payments

The Android clients support credit card processing and other forms of electronic payments.

Simphony installs several credit card payment drivers with the application. The following drivers are supported with the Android mobile operating system:

- CAPMS
- Elavon Fusebox
- mCreditDebit
- Shift4 Dollars On The Net
- VisaD
- OPI/SPI

The loadable Stored Value and Loyalty modules support Android clients, and are used with Oracle Hospitality Gift and Loyalty and with FreedomPay. The Xprocessor Extension Application, which is used for third party gift cards such as Givex, does not support Android devices.

- Workstation Tasks
- POS Clients Running Android Mobile Operating System
- Android Functionality Support
- Android Network Requirements

Related Topics
- Workaround for Android Lollipop 5.0.2 and 5.1
- Configuring the Android Device as a Workstation
- Configuring an Android Workstation
- Viewing and Editing Simphony Android Files
Workaround for Android Lollipop 5.0.2 and 5.1

Devices running the Android version Lollipop (5.0.2 and 5.1) mobile operating system do not render the WebView drop-down lists properly. To resolve this issue, update the Android WebView Component.

1. Open the Play Store app on the Android device.
2. Search for, and then select the **Android System WebView** app by Google.
3. Tap **Update**.

- Configuring the Android Device as a Workstation
- Configuring an Android Workstation
- Viewing and Editing Simphony Android Files

**Related Topics**
- Workstation Tasks
- POS Clients Running Android Mobile Operating System
- Android Functionality Support
- Android Network Requirements
- Android Payments

Configuring the Android Device as a Workstation

Perform the following steps before installing Simphony software.

1. Configure the Android device to be a member of the POS network using a static Internet Protocol (IP) address.
2. Install antivirus software on the device.
3. Turn off Trusted Sources on the device. See the manufacturer instructions for details.
4. If you are using a Bluetooth printer, pair it with the device. See the manufacturer instructions for details.

- Workaround for Android Lollipop 5.0.2 and 5.1
- Configuring an Android Workstation
- Viewing and Editing Simphony Android Files

**Related Topics**
- Workstation Tasks
- POS Clients Running Android Mobile Operating System
- Android Functionality Support
- Android Network Requirements
- Android Payments
Configuring an Android Workstation

1. (Optional) If you are using a Bluetooth printer with the Android device, set the printer from the Printers module. Configuring a Printer contains more information about setting up the printer.

2. Select the property, click Setup, and then click Workstations.

3. Insert a new workstation record.

4. Double-click the record to open it in form view.

5. Enter information in the workstation configuration fields, and set the Type as 2 - Workstation Client.
   If you are configuring a Motorola MC40 device, set the Type as 1 - Mobile.

6. Enter the Internet Protocol (IP) address or host name of the Service Host where the workstation application runs in the Address/Host Name field.

7. Click the Options tab, and then click the Display/Security subtab.

8. Select 39 - Floating Tablet.

9. (Optional) If you are using a Bluetooth printer, click the Printers tab, and then select the printer.

10. Click the Revenue Centers tab, and then assign the device to a revenue center.

11. Click Save.

12. To install the Simphony Service Host on an Android Device, see the Oracle Hospitality Simphony Client Deployment Guide.

   - Workaround for Android Lollipop 5.0.2 and 5.1
   - Configuring the Android Device as a Workstation
   - Viewing and Editing Simphony Android Files

Related Topics

- Workstation Tasks
- POS Clients Running Android Mobile Operating System
- Android Functionality Support
- Android Network Requirements
- Android Payments

Viewing and Editing Simphony Android Files

After installing Simphony on an Android device, you can use the Configuration Management Tool to view and edit certain files.

1. Launch the Simphony application on the Android device.

2. After the application loads, perform the following task on the Android device: On event (left swipe + right swipe + left swipe + tap + tap).

3. Enter the code based on the six-digit number shown at the top, and then tap Sign In. The Management Tool Home screen appears.
4. The following table lists the options and actions you can perform.

Table 8-4 Simphony Android Files

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View web.config.txt</td>
<td>Tap to view and edit the web.config.txt file</td>
</tr>
<tr>
<td>View config32.web</td>
<td>Tap to view and edit the config32.web file</td>
</tr>
<tr>
<td>View Log</td>
<td>Tap to view the EGateway Log</td>
</tr>
<tr>
<td>View LogZone</td>
<td>Tap to view the LogZone_LoadHandlers.txt file, which is not editable</td>
</tr>
<tr>
<td>Ping Server</td>
<td>Tap to view the Server Name or IP Address</td>
</tr>
<tr>
<td>Delete DataStore</td>
<td>Tap to delete the DataStore database file and restart the application</td>
</tr>
<tr>
<td>Copy DataStore</td>
<td>Tap to copy the DataStore database file within the device</td>
</tr>
</tbody>
</table>

- Workaround for Android Lollipop 5.0.2 and 5.1
- Configuring the Android Device as a Workstation
- Configuring an Android Workstation

Related Topics

- Workstation Tasks
- POS Clients Running Android Mobile Operating System
- Android Functionality Support
- Android Network Requirements
- Android Payments

Wireless Signal Strength Threshold

Wireless devices occasionally behave unpredictably or inconsistently due to weak wireless signal strength or a flickering network, leaving the device in a state that is not consistently online or offline. To handle unstable network environments, you can configure the wireless network signal strength at which devices automatically go offline. Configure the wireless signal strength threshold for workstations that use a wireless network (tablet devices running the Microsoft Windows and Android mobile operating systems). Some devices may have both cable and wireless network connections; when docked, the device can use both network types. Disable this wireless signal strength feature when docking a device with a cable (wired) network.

You can define the wireless threshold settings from the following EMC modules:

- **Property Parameters**: The values are set at the property.
- **Workstations**: The workstation inherits the values from the property, unless overridden here.

Related Topics

- Configuring Wireless Signal Strength Control Permissions
- Configuring the Wireless Signal Strength Threshold for Tablet Devices
Configuring Wireless Signal Strength Control Permissions

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.
2. Double-click the role type record (for example, administrator, manager or server).
3. Click the **Actions** tab, and then click the **Hardware** subtab.
4. Select the **Wireless Monitor** option.
5. Click **Save**.

**Related Topics**
- Configuring the Wireless Signal Strength Threshold for Tablet Devices

Configuring the Wireless Signal Strength Threshold for Tablet Devices

1. Perform one of the following, depending on which level you want to configure or override:
   - To configure at the property level, select the property, click **Setup**, and then click **Property Parameters**.
   - To override at the workstation, select the property, click **Setup**, and then click **Workstations**.
2. On the **General** tab, in the Wireless Signal Strength Control section, enter information in the following fields:
   - **Offline Threshold**: Enter a number between 0 and 99 to represent the signal strength percentage at which devices go offline. Devices will go offline when the signal strength is at or below this percentage value. For example, if the **Offline Threshold** is set to 90 (90%), and the device's current signal is 89%, the device will go offline. When the signal is detected above 90%, the device reconnects online.
   - **Reconnect Threshold**: Enter a number between 0 and 99 to represent the signal strength percentage at which devices recover online after being in an offline state. Devices will go online when the signal strength is at or above this percentage value. For example, if the **Reconnect Threshold** is set to 80, and the device's signal strength is 85%, the device will go online.

These values appear in a status bar on the POS client workstation.
3. Click **Save**.

**Related Topics**
- Configuring Wireless Signal Strength Control Permissions

*Related Topics*
- Wireless Signal Strength Threshold
Simphony allows you to translate the user interface to the local language and to maintain translation files for the EMC. You can configure up to four languages to appear on workstations, guest checks, and customer receipts. When a new language is configured for a property, all POS workstation clients must receive the new database updates and must restart prior to the changes becoming active. When the Translation CAL package is loaded, the POS workstation clients, including the CAPS workstation, need to be restarted upon receiving the language translation files.

Simphony upgrades earlier versions of translation files to later versions, and translates all languages defined in the system. You cannot translate core translation files as they are managed internally.

Configuring languages allows strings that have been translated to be presented to the user based on their language setting. You must manually translate menu items, touchscreen buttons, and user-defined strings in the EMC.

Adding Languages contains a list of all supported languages in Simphony.

- Language Translation Configuration Tasks
- Configuring Translation Privileges
- Configuring Languages
- Configuring Workstation Translations
- Configuring the EMC Translation Files
- Configuring POS Core and Payment Translations
- Translating Menu Item Records
- EMC Record Translation
- Translating Touchscreen Buttons
- Setting Languages for the Property
- Setting the Default Language for Employees
- Setting the Default Language for a Workstation
- Configuring Screen Language Buttons
- Multiple Languages on Guest Checks and Customer Receipts
- Copying Translations from One Language to Another
- Exporting a Translation File
- Language Translation Configuration Tasks
- EMC Record Translation

Related Topics
- Configuring Translation Privileges
- Configuring Languages
Language Translation Configuration Tasks

Configuring language translation in Simphony consists of completing the following tasks:

Table 9-1  Overview of Configuring Languages

<table>
<thead>
<tr>
<th>Task</th>
<th>Go To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the Translation Privileges</td>
<td>Configuring Translation Privileges</td>
</tr>
<tr>
<td>Create an Enterprise language entry</td>
<td>Adding a Language</td>
</tr>
<tr>
<td>Load translation file</td>
<td>• Loading Workstation Translations</td>
</tr>
<tr>
<td></td>
<td>• Setting Languages in the EMC</td>
</tr>
<tr>
<td></td>
<td>• Loading POS Core and Payment Translations</td>
</tr>
<tr>
<td>Translate definition data</td>
<td>• Translating Menu Item Records</td>
</tr>
<tr>
<td></td>
<td>• Translating EMC Records</td>
</tr>
<tr>
<td></td>
<td>• Translating Touchscreen Buttons</td>
</tr>
<tr>
<td>Set languages for the property</td>
<td>Setting Languages for the Property</td>
</tr>
<tr>
<td>Assign languages to employees</td>
<td>Associating Languages to Employees</td>
</tr>
<tr>
<td>Set the default language for a workstation</td>
<td>Setting the Default Language for a Workstation</td>
</tr>
<tr>
<td>(Optional) Configure Simphony to print a secondary language on guest checks and customer receipts</td>
<td>Multiple Languages on Guest Checks and Customer Receipts</td>
</tr>
<tr>
<td>(Optional) Create touchscreen button to switch between languages on workstations</td>
<td>Configuring Screen Language Buttons</td>
</tr>
</tbody>
</table>

- Language Settings and Translation
- EMC Record Translation

Related Topics
- Configuring Translation Privileges
- Configuring Languages
Configuring Translation Privileges

To enable privileges so that users can modify, import, or configure translations, perform the following steps:

1. Select the Enterprise, click **Configuration**, and then click **Roles**.
2. Double-click the role type, click the **Actions** tab, and then select the appropriate privileges:

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Allows the Employee to...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMC Text Translations</td>
<td>Import and modify the EMC related text files</td>
<td>Property expert</td>
</tr>
<tr>
<td>Workstation Text</td>
<td>Import and modify workstation related text files</td>
<td>Property expert</td>
</tr>
<tr>
<td>Translations</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. Click **Save**.

Related Topics

- Configuring Languages
- Configuring Workstation Translations
- Configuring the EMC Translation Files
- Configuring POS Core and Payment Translations
- Translating Menu Item Records
- Translating Touchscreen Buttons
- Setting Languages for the Property
- Setting the Default Language for a Workstation
- Configuring Screen Language Buttons
- Copying Translations from One Language to Another
- Exporting a Translation File
 language as described in this procedure changes the user interface message language on workstations, and in the EMC for text labels, options, help text, and error messages. You must manually change the language for EMC records, menu items, and touchscreen buttons.

1. Select the Enterprise, click Setup, and then click Languages.
2. Insert a record and enter a name (for example, Spanish).
3. Double-click the record to open it.
4. On the General tab, select the language from the Keyboard Type drop-down list.
5. On the Printing tab, set the following options (if needed):
   - **Print Custom Numerals**: Select this option to print numerals defined in the Custom Numerals field on the General tab.
   - **Asian Characters**: Select this option for languages such as Chinese, Japanese, Thai, and Korean where characters are picture-based. When you select this option, characters print double-wide to make them more readable. The order device printer also prints the characters double-wide to maximize readability.
   - **Mapping Font**: By default, this option is set to Amap. Select Vmap for Thai.
6. Click the Miscellaneous tab.
7. Select the language from the Locale String drop-down list. The following table lists all supported languages in Symphony.

### Table 9-3  Supported Language Settings

<table>
<thead>
<tr>
<th>Language</th>
<th>Locale String</th>
<th>Local ID</th>
<th>Language Culture</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arabic</td>
<td>Arabic-SaudiArabia</td>
<td>Arabic (Saudi Arabia)</td>
<td>ar-SA</td>
</tr>
<tr>
<td>Chinese (Simplified)</td>
<td>chinese-simplified</td>
<td>Chinese (People's Republic of China)</td>
<td>zh-CHS</td>
</tr>
<tr>
<td>Chinese (Traditional)</td>
<td>chinese-traditional</td>
<td>Chinese (Taiwan)</td>
<td>zh-CHT</td>
</tr>
<tr>
<td>Danish</td>
<td>danish</td>
<td>Danish (Denmark)</td>
<td>da-DK</td>
</tr>
<tr>
<td>Dutch</td>
<td>dutch</td>
<td>Dutch (Netherlands)</td>
<td>nl-NL</td>
</tr>
<tr>
<td>English</td>
<td>english-us</td>
<td>English (United States)</td>
<td>en-US</td>
</tr>
<tr>
<td>Finnish</td>
<td>finnish</td>
<td>Finnish (Finland)</td>
<td>fi-FI</td>
</tr>
<tr>
<td>French</td>
<td>french</td>
<td>France (France)</td>
<td>fr-FR</td>
</tr>
<tr>
<td>German</td>
<td>german</td>
<td>German (Germany)</td>
<td>de-DE</td>
</tr>
<tr>
<td>Italian</td>
<td>italian</td>
<td>Italian (Italy)</td>
<td>it-IT</td>
</tr>
<tr>
<td>Japanese</td>
<td>japanese</td>
<td>Japanese (Japan)</td>
<td>ja-JP</td>
</tr>
<tr>
<td>Korean</td>
<td>korean</td>
<td>Korean (Korea)</td>
<td>ko-KR</td>
</tr>
<tr>
<td>Norwegian</td>
<td>norwegian</td>
<td>Norwegian (Norway)</td>
<td>nb-NO</td>
</tr>
</tbody>
</table>
Table 9-3  (Cont.) Supported Language Settings

<table>
<thead>
<tr>
<th>Language</th>
<th>Locale String</th>
<th>Local ID</th>
<th>Language Culture</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portuguese (Brazil)</td>
<td>portuguese</td>
<td>pt-BR</td>
<td>Portuguese (Brazil)</td>
</tr>
<tr>
<td>Portuguese (Portugal)</td>
<td>portuguese</td>
<td>pt-PT</td>
<td>Portuguese (Portugal)</td>
</tr>
<tr>
<td>Russian</td>
<td>russian</td>
<td>ru-RU</td>
<td>Russian (Russia)</td>
</tr>
<tr>
<td>Spanish</td>
<td>spanish</td>
<td>es-ES</td>
<td>Spanish (Spain)</td>
</tr>
<tr>
<td>Swedish</td>
<td>swedish</td>
<td>sv-SE</td>
<td>Swedish (Sweden)</td>
</tr>
<tr>
<td>Thai</td>
<td>chinese</td>
<td>th-TH</td>
<td>Thai (Thailand)</td>
</tr>
<tr>
<td>Turkish</td>
<td>turkish</td>
<td>tr-TR</td>
<td>Turkish (Turkey)</td>
</tr>
</tbody>
</table>


8. Select the **Local ID** from the drop-down list, and then enter the **Language Culture** corresponding to the language.

9. Click **Save**.

10. To configure translated text files for the workstation, see **Configuring Workstation Translation Files**.

11. To configure translated text files for the EMC, see **Configuring the EMC Translation Files**

   - Configuring Translation Privileges
   - Configuring Workstation Translations
   - Configuring the EMC Translation Files
   - Configuring POS Core and Payment Translations
   - Translating Menu Item Records
   - Translating Touchscreen Buttons
   - Setting Languages for the Property
   - Setting the Default Language for a Workstation
   - Configuring Screen Language Buttons
   - Copying Translations from One Language to Another
   - Exporting a Translation File

**Related Topics**

- Language Settings and Translation
- Language Translation Configuration Tasks
- EMC Record Translation

**Configuring Workstation Translations**

When printing multiple languages on order devices, menu item names print in object number order of the languages configured in the Property Parameters module.
To configure translated text files for workstations:

1. Select the Enterprise, click Setup, and then click Languages.
2. Double-click the appropriate language record to open it, and then click the Text Files tab.
3. Click the Add link, and then select 1 - OPS Text from the File Type drop-down list.
4. Click the Edit link, and then click the Import from a file link.
5. Browse to the [Drive Letter]:\MICROS\Simphony2\Tools \Translations folder, and then select the Ops text file corresponding to your language.
   For example, select OpsText_es.xml to translate to Spanish.
6. Click Open, and then click OK.
7. Click Save.

- Configuring Translation Privileges
- Configuring Languages
- Configuring the EMC Translation Files
- Configuring POS Core and Payment Translations
- Translating Menu Item Records
- Translating Touchscreen Buttons
- Setting Languages for the Property
- Setting the Default Language for a Workstation
- Configuring Screen Language Buttons
- Copying Translations from One Language to Another
- Exporting a Translation File

Related Topics

- Language Settings and Translation
- Language Translation Configuration Tasks
- EMC Record Translation

Configuring the EMC Translation Files

When you add a new language or after the Simphony Cloud Service has been upgraded, you need to import the translation files for each local language you want to use or that you have configured.

To configure translated text files for the EMC:

1. Select the Enterprise, click Setup, and then click Languages.
2. Double-click the language record to open it.
3. Click the Translation tab.
4. To access a standard translation file:
a. In the **Type** drop-down list, select **EMC Text**.
b. Click **Import Standard Translation**.
c. In the **Select translation** field, select the EMC Text file corresponding to the standard language, and then click **OK**.
   
   For example, select `EMCText_de.xml` for German.
   
   If you do not import a standard translation file, the system will use the default English (`EMCText.xml`). The default English text file does not appear in the list.
d. The Import Summary Report shows the number of fields that were successfully imported from the application server. Click the **Exit** button.
   
   The translated fields are listed in the Text Elements section of the Translation tab.

5. To manually import a translation file for each language used:
   a. In the **Type** drop-down list, select **EMC Text**.
   b. Click **Import from a File**.
   c. Browse to the `[Drive Letter]`:\MICROS\Simphony2\EmcClient folder, select the language translation text file, and then click **Open**.
   d. Click **Yes** in the Translation dialog to proceed.
   e. The Import Summary Report shows the number of fields that were successfully imported from the application server. Click the **Exit** button.
      
      The translated fields are listed in the Text Elements section of the Translation tab.

6. Click **Save**.

   • Configuring Translation Privileges
   • Configuring Languages
   • Configuring Workstation Translations
   • Configuring POS Core and Payment Translations
   • Translating Menu Item Records
   • Translating Touchscreen Buttons
   • Setting Languages for the Property
   • Setting the Default Language for a Workstation
   • Configuring Screen Language Buttons
   • Copying Translations from One Language to Another
   • Exporting a Translation File

Related Topics

• Language Settings and Translation
• Language Translation Configuration Tasks
• EMC Record Translation
Configuring POS Core and Payment Translations

In addition to configuring translated files for POS client workstations and the EMC, you also need to configure the translated text for the following files:

- POS Core Text
- MICROS Payment Cash
- MICROS Payment Credit/Debit
- MICROS Payment Demo Credit/Debit (MICROS.Payment.MCreditDebit)
- Any Custom file that you want to apply

To configure translated files for these files:

1. Select the Enterprise, click Setup, and then click Languages.
2. Double-click the appropriate language record to open it.
3. Click the Translation tab, select the appropriate text Type to be translated (for example, POS Core Text), and then click Import from a File.
4. Browse to the [Drive Letter]:\MICROS\Simphony2\Tools\Translation folder, and then select the desired text file corresponding to your language.
   For example, select PosCoreText_es.xml to translate to Spanish.
5. Click Open, and then click OK.
6. Repeat Steps 3 through 5 for each Payment module.
7. Click Save.

Related Topics

- Configuring Translation Privileges
- Configuring Languages
- Configuring Workstation Translations
- Configuring the EMC Translation Files
- Translating Menu Item Records
- Translating Touchscreen Buttons
- Setting Languages for the Property
- Setting the Default Language for a Workstation
- Configuring Screen Language Buttons
- Copying Translations from One Language to Another
- Exporting a Translation File
Translating Menu Item Records

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.

2. Use the filters to search for the items to translate, and then click Search.

3. To translate menu item master records, enter the translated text in the relevant language column on the Master Records tab.
   For example, to translate master records to Spanish, enter the translated text in the Name - Spanish column. Master records show a separate column for each language configured in the Enterprise.

4. To translate menu item definitions, click the Definition Records tab, and then enter the translated text in the relevant language column.
   Definition records show two extra columns per language, First - [Language Name] and Second - [Language Name], to allow translations for the first name and second name of each definition.

5. Click Save.

   • Configuring Translation Privileges
   • Configuring Languages
   • Configuring Workstation Translations
   • Configuring the EMC Translation Files
   • Configuring POS Core and Payment Translations
   • Translating Touchscreen Buttons
   • Setting Languages for the Property
   • Setting the Default Language for a Workstation
   • Configuring Screen Language Buttons
   • Copying Translations from One Language to Another
   • Exporting a Translation File

Related Topics

   • Language Settings and Translation
   • Language Translation Configuration Tasks
   • EMC Record Translation

EMC Record Translation

In the EMC, you can translate the name of any record into multiple languages using the Text Translation dialog. This dialog is invoked by the Language Translation icon ( ) on the toolbar (or using the shortcut key F8). The Language Translation icon only becomes active when a translatable text field or a translatable table view cell is active in the module. This icon is dimmed if:

   • Only one language exists in the Enterprise
You do not have Edit access for the selected module

Translated text saves when the record itself is saved. Therefore, if you perform an undo operation on a record, record translations are also reverted.

- Language Settings and Translation
- Language Translation Configuration Tasks

Related Topics
- Configuring Translation Privileges
- Configuring Languages
- Configuring Workstation Translations
- Configuring the EMC Translation Files
- Configuring POS Core and Payment Translations
- Translating Menu Item Records
- Translating Touchscreen Buttons
- Setting Languages for the Property
- Setting the Default Language for a Workstation
- Configuring Screen Language Buttons
- Copying Translations from One Language to Another
- Exporting a Translation File

Translating Touchscreen Buttons

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

2. Open the page to translate, and then on the Edit tab, click the Translate current item legend icon.

3. In the Edit Content Area Translated Text dialog, enter the translation for each button in the relevant language column.

   The dialog shows a separate column for each language assigned to the current property in Property Parameters. Each row in the grid represents a single touchscreen button.

4. Click Save.
Setting Languages for the Property

You can specify four languages that are available to be used in the property. Workstation operators can then switch between the four different languages on the fly, independent from the employee language settings. For example, if an employee has a different language assigned that what is configured for the property, the workstation operator will be prompted to select any of the available languages of the property upon first signing in to the workstation.

After configuring languages for a property, all POS workstation clients must receive the new database updates and must be restarted prior to the changes becoming active.

To configure the screen languages for the property:

1. Select the property, click **Setup**, and then click **Property Parameters**.
2. On the **General** tab, select the default language from the **Language 1** drop-down list.
3. (Optional) From the **Language 2** through **Language 4** drop-down lists, select the secondary languages.
4. Click **Save**.

Related Topics

- Language Settings and Translation
- Language Translation Configuration Tasks
- EMC Record Translation
Setting the Default Language for Employees

You can configure the default language for employees, which appears on the following:

- POS Operations UI for the logged in workstation operator
- Workstation messages and prompts not configurable in the EMC
- PMC labels and ad hoc reports

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Employee Maintenance**.
2. Double-click an employee record to open it, change the default **Language** of the employee, and then click **Save**.
3. Repeat Step 2 for all employees.

Setting the Default Language for a Workstation

You can configure the language that appears on the POS UI Sign-In page.

Employees with a different language configured see their default language after signing in to the workstation.

The CAPS workstation requires the translation files, so the ad hoc reports for the workstation operator who is signed in show the report in the his or her assigned language.

1. Select the property, click **Setup**, and then click **Workstations**.
2. Double-click a workstation record to open it.
3. On the **General** tab, select the **Language** to appear on the workstation device, and then click **Save**.
4. Repeat Steps 2 and 3 for all workstations.
Configuring Screen Language Buttons

If more than one language is configured, you can create touchscreen buttons to allow workstation operators to switch between the languages.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

2. Open the Front of House page on which to place the language buttons, and then on the Edit tab, select the page area in which to define the buttons.

3. Click Button, and then on the General subtab, select Function from the Type drop-down list.

4. Click the black arrow directly beneath the Type drop-down list, and then select Multi Language from the Type pane.

5. To allow workstation operators to select the preferred language from a list, select Screen Language List, and then click OK.

6. To configure separate touchscreen buttons for each language configured for the property, select Screen Language 1, and then click OK.

   Screen Language 1 shows the descriptors for the default language.

7. Enter a Legend for the button, and then position and size the button on the page.

8. If you are creating separate buttons for each language, repeat Steps 3 through 7 and configure buttons for the following:
   - Screen Language 2: Shows the descriptors for the second language defined in the system.
   - Screen Language 3: Shows the descriptors for the third language defined in the system.
   - Screen Language 4: Shows the descriptors for the fourth language defined in the system.

9. Click Save.

Related Topics

- Language Settings and Translation
- Language Translation Configuration Tasks
- EMC Record Translation

Chapter 9
Configuring Screen Language Buttons

9-13
Multiple Languages on Guest Checks and Customer Receipts

You can show guest check detail and print a customer receipt showing both primary and secondary languages configured for the property. For example, English and Arabic can appear on the guest check detail area of the POS client and print on the customer receipt. When configured, all areas of the check show both languages, except the check number, table number and employee name and number. These fields print in the primary language.

Simphony version 2.7 and later supports printing custom numerals on a customer receipt (not in the check detail area of the POS client). For example, Arabic digits can print on the customer receipt rather than Latin digits.

Printing a Secondary Language on Guest Checks and Customer Receipts

To configure Simphony to print menu items in an alternate language beneath the default language on guest checks and customer receipts:

1. Select the property, click Setup, and then click Property Parameters.
2. On the General tab, select a language from the Select Secondary Print Language drop-down list. Select 0 - None to print only the default language.
3. Click Save.
4. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Format Parameters.
5. Click the Options tab.
6. Select **52 - Print Secondary Language on Guest Checks/Customer Receipt**.

7. Click **Save**.

- **Configuring Right to Left Reading Languages**
- **Creating a Print Language List Button**
- **Creating Print Language Buttons**

**Related Topics**

- **Multiple Languages on Guest Checks and Customer Receipts**

---

**Configuring Right to Left Reading Languages**

To show guest check detail and print customer receipts and guest checks in the right to left orientation configured for a language, set the following:

- Enterprise Language
- Workstation Language
- Secondary Print Language

1. Select the Enterprise level, click **Setup**, and then click **Languages**.

2. Double-click the language record to open it.

3. To show the check detail area and customer receipt on the POS client and print in right-to-left orientation, select **Right-To-Left**.

4. To print Hebrew characters in the correct order, select **Reverse Word**.

5. Click **Save**.

6. Select the property, click **Setup**, and then click **Workstations**.

7. From the **Language** drop-down list, select the language to appear on the workstation.

   You can override the default language on the workstation for specific employees using the Employee Maintenance module. Employees with a different language configured in Employee Maintenance see that language after signing on to the workstation.

8. Click **Save**.

9. Select the property, click **Setup**, and then click **Property Parameters**.

10. From the **Language 1** and **Language 2** drop-down lists, select the primary and secondary languages.

11. From the **Select Secondary Print Language** drop-down list, select the language.

   To print only the default language, select **0 - None**. When printing multiple languages, the application prints item names in the order configured for the property.

12. Click **Save**.

13. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Format Parameters**.

14. Click the **Options** tab, and then select **52 - Print Secondary Language on Guest Checks/Customer Receipt**.
15. Click **Save**.

- **Printing a Secondary Language on Guest Checks and Customer Receipts**
- **Creating a Print Language List Button**
- **Creating Print Language Buttons**

**Related Topics**
- **Multiple Languages on Guest Checks and Customer Receipts**

### Creating a Print Language List Button

When printing multiple languages, you can have each workstation operator select the language from a list in the POS client using the Print Language List button.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Add a button to the appropriate screen with the function **Print Language List**.

3. Click **Save**.

- **Printing a Secondary Language on Guest Checks and Customer Receipts**
- **Configuring Right to Left Reading Languages**
- **Creating Print Language Buttons**

**Related Topics**
- **Multiple Languages on Guest Checks and Customer Receipts**
- **Workstation Touchscreen Pages**

### Creating Print Language Buttons

The Print Language function allows the workstation operator to select a specific language. For example, if the secondary language is Arabic, the Print Language 2 button prints the customer receipt in Arabic. Follow these steps to create one or more Print Language buttons.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Add a button to the appropriate screen with the function **Print Language 2**. Depending on the number of languages, you can create other Print Language buttons (for example, **Print Language 3** and **Print Language 4**).

3. Click **Save**.

- **Printing a Secondary Language on Guest Checks and Customer Receipts**
- **Configuring Right to Left Reading Languages**
- **Creating a Print Language List Button**

**Related Topics**
- **Multiple Languages on Guest Checks and Customer Receipts**
- **Workstation Touchscreen Pages**
Copying Translations from One Language to Another

1. Select the Enterprise, click **Setup**, and then click **Languages**.
2. Double-click the appropriate language record to open it, and then click the **Translations** tab.
3. To copy all translations from another language, click **Copy All Translations**, select the language from which to copy, and then click **OK**.
4. To copy the translations for selected elements:
   a. From the Text Element section, select the relevant records, and then click **Copy Selected Translations**.
   b. Select the language from which to copy, and then click **OK**.
5. Click **Save**.

Related Topics

- Configuring Translation Privileges
- Configuring Languages
- Configuring Workstation Translations
- Configuring the EMC Translation Files
- Configuring POS Core and Payment Translations
- Translating Menu Item Records
- Translating Touchscreen Buttons
- Setting Languages for the Property
- Setting the Default Language for a Workstation
- Configuring Screen Language Buttons
- Exporting a Translation File

Exporting a Translation File

After you modify a language file, you can export it and then import it into another system.

1. Select the Enterprise, click **Setup**, and then click **Languages**.
2. Double-click the appropriate language record to open it, and then click the **Translations** tab.
3. Click **Export to a File**, and then browse to the desired local directory and save the file.

The default file name appends the language to the end. For example, if the language is French, the exported default file name is **OPSText_French**.
• Configuring Translation Privileges
• Configuring Languages
• Configuring Workstation Translations
• Configuring the EMC Translation Files
• Configuring POS Core and Payment Translations
• Translating Menu Item Records
• Translating Touchscreen Buttons
• Setting Languages for the Property
• Setting the Default Language for a Workstation
• Configuring Screen Language Buttons
• Copying Translations from One Language to Another

Related Topics
• Language Settings and Translation
• Language Translation Configuration Tasks
• EMC Record Translation
Employees and Privileges

If you are using Oracle Hospitality Labor Management, you need to add employees using Labor Management. The *Oracle Hospitality Labor Management Cloud Service Feature Reference Manual*, located at the Oracle Help Center, contains information about adding employees in Labor Management. The initial employee information is sent from Labor Management to Simphony. To change the role for an existing employee, use the Simphony EMC.

In Simphony, privileges determine the activities an employee can perform, the EMC modules available to the employee, and the types of transactions the employee can process. You can configure privileges by the job role (for example, host, server, bartender, cashier, manager).

- Creating Employee Roles
- Creating Employee Classes
- Adding an Employee
- Deleting an Employee
- Changing Employee Information
- Configuring Employee Shifts
- Configuring Employee Breaks
- Clock-In and Clock-Out Cycles
- Setting Clock-In and Clock-Out Cycles
- Job Codes
- Configuring Job Codes
- Declaring Tips
- Configuring Tip Tracking and Reporting
- Configuring Tip Track Buttons

Creating Employee Roles

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.
2. Insert a record for the type of role (for example, host, bartender, server, manager, or administrator), and then click **OK**.
3. Double-click the role type.
4. On the **General** tab, select the role security from the **Level** drop-down list.

Level 0 (zero) has greater privileges than level 9. The value in this field prevents EMC users from creating employee records with greater privileges than the administrator is granted. The following table describes typical levels for various
types of roles. Gaps appear to allow flexibility for other types of roles that are not listed.

**Table 10-1  Role Security Levels**

<table>
<thead>
<tr>
<th>Level</th>
<th>Type of Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>System Administrator</td>
</tr>
<tr>
<td>1</td>
<td>Enterprise Level Administrator</td>
</tr>
<tr>
<td>2</td>
<td>Property Level Administrator</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Property Floor Manager</td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Bartender, Cashier, Server</td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
</tbody>
</table>

5. Click the **EMC Modules** tab.

6. For each EMC module listed in the File column, select one or more of the following privileges:
   - **View**: Selecting this option grants access to view a module. You must select **View** so that employees in the role can open the module.
   - **Edit**: Selecting this option allows employees in the role to update fields or records within a module.
   - **Add**: Selecting this option allows employees in the role to add records to a module.
   - **Delete**: Selecting this option allows employees in the role to delete records from a module.
   - **Add Override**: Selecting this option allows employees in the role to override records in a module.
   - **Allow Duplicate Obj#**: Selecting this option allows employees in the role to add menu item records where existing records with the same number exist elsewhere in the Enterprise.
   - **Allow Duplicate Name**: Selecting this option allows employees in the role to add records where existing records with the same name exist elsewhere in the Enterprise.
   - To easily configure a role to View, Edit, Add, Delete, or Add Override for every module without individually selecting each option, right-click a column heading and select **Set All**.

7. Click the **Actions** tab.

8. Select **Enable** for the appropriate EMC tasks listed in the Action column.
   To activate a role for every module without individually selecting each option, right-click the **Enable** heading, and then select **Set All**.

9. Click **Save**.
Creating Employee Classes

Video

You can set collective options for a group of similar employee roles using an Employee Class. Each employee must belong to an Employee Class to perform workstation operations.

1. Select the property, click **Configuration**, and then click **Employee Classes**.
2. Insert a record for a group of employees (for example, server, bartender, or host), and then double-click the record to open it.
3. On the **General** tab, set information for the fields as described in the following table:

**Table 10-2  Employee Class Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#Hours/Day Before OT</td>
<td>Enter the number of regular hours that employees in the Employee Class can work in a single day before being paid at the overtime rate.</td>
</tr>
<tr>
<td>#Hours/Period Before OT</td>
<td>Enter the number of regular hours that employees in the Employee Class can work in a single pay period before being paid at the overtime rate.</td>
</tr>
<tr>
<td>ISL Options</td>
<td>Select the <strong>ISL Employee Options</strong> to allow employees in the Employee Class to execute Interface Script Language (ISL) scripts. ISL is the Oracle Hospitality proprietary interpreted language used to create small programs called scripts. The ISL options act like a transaction privilege level in an ISL script. ISL scripts can be written to include variables that check for the presence of these privileges for the employee who is running the script. If the employee is not a member of an Employee Class that has the necessary ISL employee option set, the script does not execute, and a privilege prompt appears.</td>
</tr>
<tr>
<td>Default Trans TS</td>
<td>Select the default touchscreen that appears when members of the Employee Class sign on to a workstation.</td>
</tr>
</tbody>
</table>
Table 10-2  (Cont.) Employee Class Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MMH Default Trans TS</td>
<td>Select the default touchscreen that appears when members of the Employee Class sign on to a Mobile MICROS device.</td>
</tr>
<tr>
<td>Pickup/Add/Xfer SLU Style</td>
<td>Select a touchscreen style that workstation operators can use when adding and transferring checks with the Add/Transfer Check Screen Lookup (SLU) function key.</td>
</tr>
<tr>
<td>View Screen/Style Names for RVC</td>
<td>Select this option to view the screen names and styles set in the revenue centers.</td>
</tr>
</tbody>
</table>

4. Click the Operator Options tab.

5. For each revenue center listed, from the Operator Type drop-down list, select the guest check printing method for workstation operators assigned to the Employee Class.
   • By Round: Select this option to print a guest check at the end of each service round, showing only the changes posted to the service round.
   • On Demand: Select this option to print a buffered guest check after performing a Service Total or tender set to print an on demand check.
   • Temp On Demand: Select this option to print a guest check on demand (in a by round manner).
   • Special By Round: Select this option to print a guest check on demand for all rounds except the first round of a check. The first round always prints. Subsequent service rounds print if the Service Total is set to print an on demand check.

6. For each revenue center listed, select the appropriate Options for workstation operators assigned to the Employee Class, and then click OK.

Using a Server Employee Class as an example, you can require all servers in a revenue center to enter the number of guests when beginning new checks and to enter table numbers.

7. Click Save.
   • Creating Employee Roles
   • Adding an Employee
   • Deleting an Employee
   • Changing Employee Information
   • Configuring Employee Shifts
   • Configuring Employee Breaks

Adding an Employee

Video

You must have the Enterprise level permission Add Employees to add an employee record from a template.
1. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Employee Maintenance**.
2. Click the Insert Record icon from the toolbar. The Add Employees dialog appears.
3. From the **Select a task to perform** drop-down list, select **Add Employee Record from Template**.
   Using a template simplifies the process of adding employees.
4. Click the **Select** link next to the **Employee To Copy** field.
5. From the Select Employee dialog, select a template employee record, and then click **OK**.
6. Enter employee information in the following fields, and then click **OK**.
   - **First and Last Name**
   - (Optional) **Check Name**: Enter the employee name to appear on guest checks (for example, Sally S).
   - (Optional) **ID**: Enter the employee identification number.
   - **Record Number**: The next available record number appears by default.
   - **Property # and Name**: The property where the employee works.
   - **RVC # and Name**: The revenue center (RVC) where the employee works.
7. Click **Yes** on the Add Employee? confirmation prompt.
8. To add another employee, click **Yes** on the prompt, and then repeat Steps 6 and 7. When you are finished adding employees, click **No**.

   - **Creating Employee Roles**
   - **Creating Employee Classes**
   - **Deleting an Employee**
   - **Changing Employee Information**
   - **Configuring Employee Shifts**
   - **Configuring Employee Breaks**

### Deleting an Employee

**Video**

You must have the Enterprise level permission called Delete Employees to remove an employee record.

1. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Employee Maintenance**.
2. Search for the employee record.
3. Right-click the employee record, and then select **Delete**.
4. From the Delete Employee Records dialog, click **Yes** to confirm.
5. To view a list of all deleted employees in the search area, select **View Deleted Employees**, and then click **Search**.
6. To reactivate a deleted employee, right-click the employee record, select **Reactivate**, and then click **Yes** to confirm.

7. If you are an administrator and want to permanently delete an employee, right-click the employee record, select **Permanently Delete**, and then click **Yes** on the prompts to confirm.

   You cannot permanently delete an employee who is not marked as Deleted and who has associated sales or timecard records in the Oracle Hospitality Reporting and Analytics database. Employees are mapped between the Simphony and Reporting and Analytics databases using the object number from the EMC. Consider the following example:

   - Employee 12345, Ted Davis, has $500 in sales
   - Employee 12345 is deleted from the database
   - If the EMC allowed this employee to be permanently deleted, a new employee, Mary Smith, could be added at employee record 12345 and the new employee would essentially start with $500 in sales

   Thus, the two-step employee deletion process preserves the object number between the two databases. Because of this potential scenario, object numbers are not reusable. If employee 12345 is marked as Is Deleted in the database, you cannot create a new employee record using number 12345.

8. Click **Save**.

   - Creating Employee Roles
   - Creating Employee Classes
   - Adding an Employee
   - Changing Employee Information
   - Configuring Employee Shifts
   - Configuring Employee Breaks

**Changing Employee Information**

You must have the Enterprise level permission Edit Employees to change an employee record.

1. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Employee Maintenance**.

2. Search for the employee record using the **Search Criteria** fields to limit the results, and then click **Search**. Depending on the hierarchy level at which you opened the Employee Maintenance module (Enterprise, property, or revenue center), the resulting list of employee records appears in one of the following tabs located near the lower area of the screen:

   - Employee Records – Enterprise level
   - Property Employee Records – Property level
   - Operator Records – Revenue Center level

3. Make changes in either table view or form view. To make changes in form view, double-click the object number of the employee record.
4. Change any of the information in the active fields. The following tables list the types of information you can change for each hierarchy level.

### Table 10-3  Employee Records Information

<table>
<thead>
<tr>
<th>Subtab</th>
<th>Type of Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Allows you to change basic information about the employee, including name, language, identification numbers, level, group, email address, and EMC login credentials.</td>
</tr>
<tr>
<td>Roles</td>
<td>Allows you to change the employee's role.</td>
</tr>
<tr>
<td>Reporting</td>
<td>Allows you to change the employee's log in credentials for Oracle Hospitality Reporting and Analytics.</td>
</tr>
<tr>
<td>References</td>
<td>Shows the locations where the employee is being referenced (excluding workstations).</td>
</tr>
</tbody>
</table>

### Table 10-4  Property Employee Records Information

<table>
<thead>
<tr>
<th>Subtab</th>
<th>Type of Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>The General subtab allows you to change basic information about the employee, including name, employee class, revenue center, check name, email address, and clock-in options.</td>
</tr>
<tr>
<td>Job Codes</td>
<td>The Job Codes subtab shows the job code assigned to the employee in the property. You can change the Regular and Overtime Pay Rates for each job code.</td>
</tr>
<tr>
<td>Operators</td>
<td>The Operators sub tab shows each revenue center in the property where the employee has an operator record. You can change the Cash Drawer, Table Count, TMS Color, and Server Efficiency. You can also select whether to use the Employee Class options or set options at the operator level.</td>
</tr>
</tbody>
</table>

### Table 10-5  Operator Records Information

<table>
<thead>
<tr>
<th>Subtab</th>
<th>Type of Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>The General subtab allows you to change basic information about the employee, including name, employee class, revenue center, and clock-in options.</td>
</tr>
<tr>
<td>Job Codes</td>
<td>The Job Codes subtab shows the job code assigned to the employee in the property. You can change the Regular and Overtime Pay Rates for each job code.</td>
</tr>
</tbody>
</table>
The Operations subtab shows each revenue center in the property where the employee has an operator record. You can change the Cash Drawer, Table Count, TMS Color, and Server Efficiency. You can also select whether to use the Employee Class options or set options at the operator level.

5. Click Save.

- Creating Employee Roles
- Creating Employee Classes
- Adding an Employee
- Deleting an Employee
- Configuring Employee Shifts
- Configuring Employee Breaks

### Configuring Employee Shifts

A shift is the period of time that an employee is scheduled to work. Employees can volunteer or are scheduled to work more than one shift. Simphony provides the ability to post employee or cashier totals to shifts to account for the multiple shifts worked during a single business day.

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Control Parameters.
2. Click the Options tab, and then select the appropriate shift options.

### Table 10-6  Shift Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>49 - Enable Shift Tracking</td>
<td>Select this option to activate shift reporting, segregating employee, employee tip, and cashier financial totals by shift. Deselect this option to accumulate employee, employee tip, and cashier totals in a single total set. When you deselect this option, the subsequent shift-related options are dimmed.</td>
</tr>
<tr>
<td>50 - Increment Cashier Shift when Clocking Out</td>
<td>Select this option to increment the shift for the cashier associated with the employee clocking out (except when clocking out on break). Deselect this option to have the shift for the cashier associated with the employee remain the same.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>51 - Increment Cashier Shift when Clocking In</td>
<td>Select this option to increment the shift for the cashier associated with the employee locking in (except when returning from break). Deselect this option to have the shift for the cashier associated with the employee remain the same.</td>
</tr>
<tr>
<td>52 - Increment Cashier Shift when Changing Job</td>
<td>Select this option to increment the shift for the cashier associated with the employee when they clock in with a different job. This clock in occurs automatically when the employee signs on to a workstation with a different revenue center than the job in which they are currently clocked in. Deselect this option to have the shift for the cashier associated with the employee remain the same during this clock in cycle.</td>
</tr>
<tr>
<td>53 - Increment Cashier Shift when Changing Revenue Center</td>
<td>Select this option to increment the shift for the cashier associated with the employee when signing on to a different revenue center. Deselect this option to have the shift for the cashier associated with the employee remain the same when signing on to a different revenue center.</td>
</tr>
<tr>
<td>54 - Prompt before incrementing Cashier Shift</td>
<td>Select this option to prompt the employee to increment the shift for the cashier associated with the employee when the shift is set to increment upon clocking in or out, changing jobs, or changing revenue centers. Deselect this option so that no prompting occurs when the cashier shift is set to increment through one of those methods.</td>
</tr>
<tr>
<td>55 - Prompt to Increment Cashier Shift after Shift Report</td>
<td>Select this option to prompt the workstation operator to increment the cashier shift when a Cashier Shift Report is generated with a shift scope. Deselect this option so that no prompting occurs and the cashier shift does not increment.</td>
</tr>
<tr>
<td>56 - Increment Employee Shift when Clocking Out</td>
<td>Select this option to increment the shift for the employee upon clocking out (except on break). Deselect this option to have the shift for the employee remain the same.</td>
</tr>
<tr>
<td>57 – Increment Employee Shift when Clocking In</td>
<td>Select this option to increment the shift for the employee upon clocking in (except when returning from break). Deselect this option to have the shift for the employee remain the same.</td>
</tr>
</tbody>
</table>
Table 10-6  (Cont.) Shift Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>58 - Increment Employee Shift when Changing Job</td>
<td>Select this option to increment the shift for the employee when clocking in with a different job. This clock in occurs automatically when the employee signs on to a workstation with a different revenue center than the job in which they are currently clocked in. Deselect this option to have the shift for the employee remain the same during this clock in cycle.</td>
</tr>
<tr>
<td>59 - Increment Employee Shift when Changing Revenue Center</td>
<td>Select this option to increment the employee shift when signing in to a different revenue center. Deselect this option to have the employee shift remain the same when signing in to a different revenue center.</td>
</tr>
<tr>
<td>60 - Prompt to Increment Employee Shift after Shift Report</td>
<td>Select this option to prompt the workstation operator to increment the employee shift when an Employee Shift Report is generated with a shift scope. Deselect this option to set no prompting and leave the employee shift the same.</td>
</tr>
<tr>
<td>61 - Prompt before incrementing Employee Shift</td>
<td>Select this option to prompt the workstation operator to increment the employee shift when the shift is set to increment upon clocking in or out, changing jobs, or changing revenue centers. Deselect this option to set no prompting when the employee shift is set to increment through one of those methods.</td>
</tr>
</tbody>
</table>

3. Click Save.
4. Select the revenue center, click Setup, and then click RVC Parameters.
5. Click the Calendar tab.
6. From the Shift Incrementing Options section, select the following options if you do not want Employee or Cashier Financial Shifts to reset with the start of business day:
   - Do not reset Employee Financial Shifts with the start of each business day
   - Do not reset Cashier Financial Shifts with the start of each business day
7. Click Save.
   - Creating Employee Roles
   - Creating Employee Classes
   - Adding an Employee
   - Deleting an Employee
   - Changing Employee Information
   - Configuring Employee Breaks
Configuring Employee Breaks

A break is a rest period for hourly workers, such as a lunch break. Breaks can be either paid or unpaid and you can set time limits for breaks. Some jurisdictions legislate break length requirements for minor employees.

1. Select the property, click Setup, and then click Property Parameters.
2. Click the Timekeeping tab, and then enter values in the following fields:
   - **Minor Unpaid Break Minimum Length**: If applicable, enter the minimum number of minutes allowed for unpaid breaks taken by a minor employee.
   - **Minor Unpaid Break Maximum Length**: If applicable, enter the maximum number of minutes allowed for unpaid breaks taken by a minor employee.
   - **Minor Paid Break Minimum Length**: If applicable, enter the minimum number of minutes allowed for paid breaks taken by a minor employee.
   - **Minor Paid Break Maximum Length**: If applicable, enter the maximum number of minutes allowed for paid breaks taken by a minor employee.
   - **Regular Unpaid Break Minimum Length**: Enter the minimum number of minutes allowed for an unpaid break taken by a regular employee.
   - **Regular Unpaid Break Maximum Length**: Enter the maximum number of minutes allowed for an unpaid break taken by a regular employee.
   - **Regular Paid Break Minimum Length**: Enter the minimum number of minutes allowed for a paid break taken by a regular employee.
   - **Regular Paid Break Maximum Length**: Enter the maximum number of minutes allowed for a paid break taken by a regular employee.
3. Click Save.

Clock-In and Clock-Out Cycles

A clock-in cycle for a workstation operator includes one clock in and the subsequent clock out. Clock-in cycles are sequentially numbered from the start of the current payroll period to the current date on employee time cards and labor detail reports. If breaks are not in use, a cycle is the equivalent of a work shift.

A clock-in cycle includes the day, date, and time of the entry and the Job Code under which the employee clocks in.

**Related Topics**

- Setting Clock-In and Clock-Out Cycles
Setting Clock-In and Clock-Out Cycles

1. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Employee Maintenance**.

2. Search for the property employee record.

3. Select the **Employee Records** tab near the lower part of the screen, and then double-click the object number of the appropriate record.

4. If the **ID** field is blank, enter the employee identification number.

5. Click the **Search/Table View** tab.

6. Click the **Property Employee Records** tab near the lower part of the screen, and then double-click the object number of the appropriate record.

7. Click the **Job Codes** tab and add a job code for the role if it does not exist.

   Employees who clock in require a job code. Employees without a job code assigned typically do not need to clock in (such as tax exempt employees). If an employee has more than one job code assigned (for example, bartender and server), the workstation prompts the employee to select a job code when clocking in.

8. Click **Save**.

9. Select the Enterprise level, click **Configuration**, and then click **Roles**.

10. Select the role type, click the **Operations** tab, and then click the **Timekeeping** subtab.

11. From the Job Rate Options section, select the appropriate **Clock in at Rate** options for employees associated with the role. Each rate number refers to a pay rate that is assigned for the employee record.

12. Select the appropriate general timekeeping options as described in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Allow the Employee to Perform or Authorize...</th>
</tr>
</thead>
<tbody>
<tr>
<td>13 - Authorize/Perform Reprint of Time Card</td>
<td>Reprinting a time card using the Reprint Time Card key, and to authorize non-privileged employees to do so</td>
</tr>
<tr>
<td>20009 - Authorize Clock In / Authorize Clock In/Out for the Wrong Location</td>
<td>Other employees to clock in Setting this option also allows users to clock in or out for the wrong location</td>
</tr>
<tr>
<td>20010 - Authorize/Perform Clock In/Out Outside Schedule or Scheduled Breaks</td>
<td>Clocking in or out at times that conflict with the assignment in the Time Clock Schedule module</td>
</tr>
<tr>
<td>20011 - ON = Minor Employees; OFF = Regular Employees</td>
<td>Designating employees associated with the role as minors</td>
</tr>
<tr>
<td>20012 - Authorize/Perform Clock Out with Open Checks</td>
<td>Clocking out at the end of a shift with open guest checks, and to authorize other employees to do so</td>
</tr>
</tbody>
</table>
Table 10-7  (Cont.) Employee Timekeeping Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Allow the Employee to Perform or Authorize...</th>
</tr>
</thead>
<tbody>
<tr>
<td>20013 - Authorize Changing Revenue Center at Clock In</td>
<td>Changing the revenue center assignment of other employees who are clocking in</td>
</tr>
<tr>
<td>20014 - Change Revenue Center at Clock In Future</td>
<td>Changing the revenue center assignment when clocking in</td>
</tr>
<tr>
<td>20015 - Authorize/Perform Clock Out in the Future</td>
<td>Clocking out at a time ahead of the application time</td>
</tr>
</tbody>
</table>

13. Click **Save**.

**Related Topics**

- Clock-In and Clock-Out Cycles

**Job Codes**

A Job Code identifies a category of labor group (for example, Server, Bartender, Cashier, Manager) for timekeeping. Job codes:

- Link hourly employees to specific pay rates upon clock in
- Group labor hours and costs into job categories on reports

**Related Topics**

- Configuring Job Codes

**Configuring Job Codes**

1. Select the property, click **Configuration**, and then click **Job Codes**.

2. Insert a new job code record with the appropriate name (for example, Server, Bartender, or Manager), and then double-click it to open.

3. Select the **Employee Role** from the drop-down list to associate with the job code.
   
   If you select **0 - None**, the employee receives privileges based on the roles set in the Employee Maintenance module.
   
   This setting is ideal for an employee who has two job codes (for example, Server and Bartender). The privileges associated with this employee role are active for the duration of the clock-in cycle.

4. Select the **Employee Class** from the drop-down list.
   
   If you select **0 - None**, the employee uses the Employee Class set in the Employee Maintenance module.
   
   The employee is assigned to this employee class for the duration of the clock-in cycle.

5. Select the **Revenue Center** in which the job code is available.
   
   To make the job code available in all revenue centers, select **0 - None**.

6. Enter the **Report Group** for the job code.
The labor reports sort and calculate subtotals by the Report Group. If you set the Report Group to 0 (zero), the job code does not appear on job code reports.

7. Select the appropriate options as described in the following table:

**Table 10-8  Job Code Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Prompt for Direct Tips before Clocking Out</td>
<td>Select this option to prompt employees who are clocked in under the job code to declare the amount of direct tips received (tips given directly from the customer to the employee) when clocking out.</td>
</tr>
<tr>
<td>2 - Prompt for Indirect Tips before Clocking Out</td>
<td>Select this option to prompt employees who are clocked in under the job code to declare the amount of indirect tips received (tips given from one employee to another) when clocking out.</td>
</tr>
<tr>
<td>3 - Cannot Clock Out with Open Checks</td>
<td>Select this option to prevent employees clocked in under the job code from clocking out while they have open guest checks. You can override this setting for employees that have the Clock Out with Open Checks privilege.</td>
</tr>
<tr>
<td>4 - Use Scheduled Time if Employee Clocks in Early</td>
<td>Select this option to use the employee’s scheduled clock-in time for labor calculations if the employee clocks in earlier than scheduled.</td>
</tr>
<tr>
<td>5 - Prompt for Clock In Revenue Center</td>
<td>Select this option to allow employees to select the revenue center when clocking in.</td>
</tr>
</tbody>
</table>

8. Click **Save**.

**Related Topics**
- Job Codes

---

**Declaring Tips**

Tip declaration is a generic term that applies to direct tips and indirect tips.

Tip Track is a Simphony feature that involves declaration of indirect tips. Servers can use Tip Track to:
- Share tips with other employees
- Edit tip-outs
- Claim tips from other employees

Managers can use Tip Track to:
- Grant tip-out privileges
- Generate tip-out transaction reports

**Related Topics**
- Configuring Tip Tracking and Reporting
- Configuring Tip Track Buttons
Configuring Tip Tracking and Reporting

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.
2. Select the type of role (for example, server or bartender).
3. Click the **Operations** tab, and then select the appropriate options as described in the following table:

   **Table 10-9  Tip Tracking and Reporting Privileges**

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to...</th>
<th>Recommended Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>65</td>
<td>Authorize/Use the [Direct Tips] and [Indirect Tips] Keys</td>
<td>Use the Direct Tips and Indirect Tips function keys to declare cash tips received, and to authorize others to do so</td>
<td>Server</td>
</tr>
<tr>
<td>66</td>
<td>Authorize/Use the [Direct Tips] and [Indirect Tips] Keys for Another Employee</td>
<td>Use the Direct Tips and Indirect Tips keys to declare cash tips received by another employee, and to authorize others to do so</td>
<td>Manager</td>
</tr>
<tr>
<td>187</td>
<td>Authorize/Perform the Pay Tip Out To Others Keys</td>
<td>Give cash tips to others, and to authorize non-privilege employees to do so</td>
<td>Server</td>
</tr>
<tr>
<td>188</td>
<td>Claim Tips From Other Employee</td>
<td>Receive a tip from another employee</td>
<td>Server</td>
</tr>
<tr>
<td>189</td>
<td>Authorize/Perform Edit Of Any Tip Outs</td>
<td>Edit cash tips given to other employees, and to authorize non-privilege employees to do so</td>
<td>Manager</td>
</tr>
<tr>
<td>195</td>
<td>Allow Edit of My Tip Out</td>
<td>Edit tip outs</td>
<td>Server</td>
</tr>
<tr>
<td>31010</td>
<td>Run Employee Tip Report</td>
<td>Run the Employee Tip Report</td>
<td>Manager</td>
</tr>
<tr>
<td>31045</td>
<td>Run Employee Tip Track Report</td>
<td>Run the Employee Tip Track Report</td>
<td>Manager</td>
</tr>
</tbody>
</table>

4. Click **Save**.
5. Select the revenue center, click **Setup**, and then click **RVC Parameters**.
6. Click the **Options** tab.
7. To print a validation receipt when a tip-out or tip edit operation occurs, select **7 - Validate Employee Direct/Indirect Tips Declared Transactions**.
8. Assign a validation printer at the property level:
a. Select the property, click **Setup**, and then click **Workstations**.
b. Click the **Printers** tab.
c. Select a **Validation Printer**, and then click **OK**.
d. Click **Save**.

- Configuring Tip Track Buttons

**Related Topics**
- Declaring Tips

### Configuring Tip Track Buttons

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.
2. Open the page on which to place tip track buttons.
3. On the **Edit** tab, select the page area in which to define the tip track functions.
4. Click **Button**.
5. On the **General** subtab, enter the button name **Tip Track Tip Out** in the **Legend** field.
6. Select **Function** from the **Type** drop-down list.
7. Click the black arrow directly beneath the **Type** drop-down list, select **Tips** from the **Type** section, select **Tip Track Tip Out** from the Results section, and then click **OK**.
8. Repeat Steps 3 through 7 to create the following buttons:
   - **Tip Track Edit My Tips**
   - **Tip Track Edit**
9. Click **Save**.

- Configuring Tip Tracking and Reporting

**Related Topics**
- Declaring Tips
Payments and Currency

Guests pay guest checks with various types of payments or tenders, ranging from paper to plastic to digital.

- Types of Payment
- Configuring Currency
- Configuring Base Currency and Alternate Currency
- Configuring Currency Conversions
- Configuring the Cash Tender
- Adding Payment Keys to the Transaction Page
- Credit Card Tokenization
- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites
- Universal Transaction Gateway for Shift4
- Communication Methods for Fusebox Payment Card Driver
- stunnel Installation Methods
- Installing stunnel at a Single Host Location
- Installing stunnel Through Simphony as a CAL Package
- Configuring the CAPMS Payment Card Driver
- Configuring the CAPMS Payment Module
- Configuring the Dollars on the Net Payment Card Driver
- Configuring the Dollars on the Net Payment Module
- Configuring the Fusebox Payment Card Driver
- Configuring the Fusebox Payment Module
- Configuring the VisaD Payment Card Driver
- Configuring the VisaD Payment Module
- Configuring the Loadable Payment Card Device
- Creating Loadable Payment Card Buttons
- The Oracle Payment Interface (OPI)
- OPI Architecture
- Configuring the OPI Driver
- Configuring the OPI Payment Module
- Configuring the Default Payment Tender for OPI
- Updating Credit Card Preambles for OPI
• Configuring the OPI and SPI to Settle Transactions Automatically
• Configuring the OPI and SPI to Settle Transactions Manually
• Credit Card Preambles for OPI
• The Simphony Payment Interface (SPI)
• SPI Architecture
• Payment Driver vs. Workstation Settings
• OPI Users
• Pay@Table
• Check Sharing
• Configuring the SPI Payment Driver
• Configuring Mail Order Telephone Order (MOTO)
• Third-Party Credit Card Driver Package Distribution
• Copying Third-Party Payment Driver Files
• Manually Installing Credit Card Certificates on Workstations
• Credit Card Batching
• Creating a Credit Card Batch
• Editing a Credit Card Batch
• Settling a Credit Card Batch
• Pay@Table
• Configuring a Credit Card Tender
• Credit Card Preamble
• Configuring Standard Credit Card Preambles
• List of Standard Credit Card Preambles for the U.S.
• Configuring Manual Entry of Credit Card Numbers
• Configuring Credit Card Authorization to Print Merchant Vouchers and Customer Receipts
• Configuring Credit Card Voucher Headers and Trailers
• Configuring the Room Charge Tender
• Configuring the OPERA PMS Payment Driver
• Configuring the MICROS Standard Credit Card Payment Module
• Configuring the Loadable PMS Payment Module
• Configuring the Demo Payment
• Creating Pay@Table Buttons
• Configuring Email Receipts
• Autosequence Events
• Configuring Autosequence Events
• Configuring the Autosequence Event Schedule
Types of Payment

Payments reduce the balance of the guest check, and can include the types listed in the following table:

### Table 11-1  Payment Types

<table>
<thead>
<tr>
<th>Payment Type</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash</td>
<td>Configuring the Cash Tender</td>
</tr>
<tr>
<td>Credit Cards</td>
<td>Loadable Payment Card Configuration Tasks</td>
</tr>
<tr>
<td>Gift Cards</td>
<td>Stored Value Configuration Tasks</td>
</tr>
<tr>
<td>Pay at the Table</td>
<td>Pay at the Table</td>
</tr>
<tr>
<td>Hotel Room Charge</td>
<td>Configuring the Room Tender</td>
</tr>
</tbody>
</table>

- Credit Card Tokenization

**Related Topics**

- Configuring Currency
- Configuring Base Currency and Alternate Currency
- Configuring Currency Conversions
- Configuring the Cash Tender
- Adding Payment Keys to the Transaction Page

## Configuring Currency

You can configure the types of currencies in circulation for exchange at workstations (for example US Dollars, Canadian Dollars, Euros, Pounds Sterling, Pesos, or Yen).

1. Select the Enterprise, property, or zone, click **Setup**, and then click **Currency**.
2. Insert a record, enter the name (for example, US Dollars), and then click **OK**.
3. Double-click the record to open it.
4. Enter the **Abbreviation** for the currency (for example, USD).
5. Enter the **Symbol** for the currency record (for example, $).
6. Select the **Number of Digits** from the drop-down list. This is the number of digits after the decimal point that the currency allows.
7. Enter the **Smallest Bill Amount** for the currency (for example, 1).
8. Select **1 - On = Print Symbol After Total; Off = Print Symbol Before Total** to print the currency’s symbol after the amount due on guest checks and customer receipts. Deselect this option to print the currency’s symbol before the amount due.
9. Select **5 - Use Thousands Separator Character** to use the thousands separator (comma as in the example 1,000) when numbers are printed.
10. Click **Save**.
11. Repeat Steps 2 through 10 for each currency payment allowed.

- Configuring Base Currency and Alternate Currency
- Configuring Currency Conversions
- Configuring the Cash Tender
- Adding Payment Keys to the Transaction Page

Related Topics
- Types of Payment
- Credit Card Tokenization

Configuring Base Currency and Alternate Currency

1. Select the Enterprise, property, or zone, click Setup, and then click Currency Parameters.

2. Select the Base Currency from the drop-down list. This is the primary currency for the location.

   Oracle recommends setting the base currency once during initial configuration of a property, prior to opening guest checks. When you change the base currency after opening checks, the EMC prompts you for verification twice.

3. (Optional) Select the Alternate Currency from the drop-down list.

   This is the other currency used at the location. For example, a property located near Niagara Falls might set US Dollars as the base currency and accept Canadian Dollars as the alternate currency.

4. To use rounding, select 4 - Round Currency. Selecting this option activates the subsequent options. Select the appropriate options to round the amount due:
   - 5 - ON = Round to Nearest 0; OFF = Round to Nearest 5: Select this option to round currency amounts to the nearest 0 (for example, 163.336 rounds to 163.340). Deselect this option to round currency amounts to the nearest 5 (for example, 163.336 rounds to 163.335).
   - 6 - ON = Round to Second-Least Significant Digit; OFF = Round to Least Significant Digit: Select this option to round currency amounts based on the second least significant digit (for example, in 100.45, the second least significant digit is 4). Deselect this option to round currency amounts based on the least significant digit (for example, in 100.45, the least significant digit is 5).

5. Click Save.

6. Select the Enterprise, property or zone, click Setup, and then click Currency Availability.

7. If you selected the Enterprise level, for each record, select the non-base currency (foreign or alternate currency) for conversion in the Currency field.

8. Select the appropriate alternate currency options:
   - 2 - Issue Change In Other Currency: Select this option to issue change from a currency conversion in the currency. Deselect this option to issue change only in the base currency.
   - 3 - Prompt For Issuing Change: Select this option to ask the workstation operator with a Yes/No prompt whether change is required in the alternate
currency. Deselect this option to issue change only in the base currency without prompting.

- Select options 4, 5, and 6 as appropriate for the alternate currency. These options are described in Step 4.

9. Click Save.

- Configuring Currency
- Configuring Currency Conversions
- Configuring the Cash Tender
- Adding Payment Keys to the Transaction Page

Related Topics
- Types of Payment
- Credit Card Tokenization

Configuring Currency Conversions

You can configure the manner in which one currency rate converts to another currency rate. Typically, currency conversion rates are set at the Enterprise level, and each property receives the same conversion. If one location has a slightly different conversion rate for the same two currencies, you can set the currency conversion at the zone (for example, a Euro-to-US Dollar conversion might be standard for the Enterprise level, while an airport property has a different rate).

1. Select the Enterprise, property or zone, click Setup, and then click Currency Conversions.


3. Click the ellipsis point (...) button from the Currency column, select the currency, and then click OK.

   This field, divided by the Rate, determines the number of Conversion Currency records.

4. Click the ellipsis point (...) button from the Conversion Currency column, select the conversion currency, and then click OK. You must select a different currency than the selection in the Currency field. That is, the Currency and Conversion Currency fields cannot contain the same values.

   This field, multiplied by the Rate, determines the number of Currency records.

5. Enter the conversion Rate.

   The Rate determines how Simphony calculates the Currency and Conversion Currency. The Conversion and Conversion Reverse fields calculate automatically to show additional information about the record.

6. Click Save.
Configuring the Cash Tender

You must configure a cash tender to allow guests to pay the check with cash.

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **Payments**.
2. Insert a record, enter **Cash** as the name, and then click **OK**.
3. Double-click the record to open it.
4. On the **General** tab, click the **Import from a file** link.
5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select **Micros.Payment.Cash.dll**, and then click **Open**.
6. Click the **Configuration** tab, and then click the **Module Configuration** subtab.
7. Enter information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Enter MicrosCashPaymentModule.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the payment driver (for example, MICROS Cash Payment Module).</td>
</tr>
<tr>
<td>Do Not Batch</td>
<td>Select <strong>False</strong>.</td>
</tr>
<tr>
<td>Run As Service</td>
<td>Select either <strong>True</strong> or <strong>False</strong> to indicate whether to run the MICROS Cash Payment Module as a Service Host service. Select <strong>False</strong> to run the cash module directly on the POS client.</td>
</tr>
<tr>
<td>Show Change Due Dialog</td>
<td>Select <strong>True</strong> to show the Change Due dialog on the POS client.</td>
</tr>
</tbody>
</table>
8. Click **Save**.
9. Select the Enterprise or property, click **Configuration**, and then click **Tender/Media**.
10. Insert a record, name it **Cash**, and then click **OK**.
11. Double-click the **Cash** record to open it.
12. On the **General** tab, select **1 - Payment** from the **Key Type** drop-down list.
13. Click the **Options** tab, and then click the **Printing Options** subtab.
14. Select **8 - Print Customer Receipt** and **21 - Print Summary Totals**.
15. Select the **Ops Behavior** subtab, and then select the appropriate options as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>

---

**Adding Payment Keys to the Transaction Page**

**Related Topics**

- Types of Payment
- Credit Card Tokenization
### Table 11-3  Amount Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 - Amount Required</td>
<td>Select this option to require an amount when using the cash tender. If the workstation operator presses the cash tender button at the POS client without entering an amount, the POS client prompts to enter the tender amount. If you deselect option 2 and select option 3, the tender is used for 0.00, unless the workstation operator enters an amount before pressing the tender key.</td>
</tr>
<tr>
<td>3 - Assume Paid in Full</td>
<td>Select this option to record the exact amount due as the entry. You must also deselect option 2. If you deselect both options 2 and 3, the system records 0.00 as the entry.</td>
</tr>
<tr>
<td>4 - Use with Currency Conversion</td>
<td>Select this option to post payment amounts entered through a currency key to the cash payment key.</td>
</tr>
<tr>
<td>37 - Partial Tender Not Allowed</td>
<td>Select this option to prevent the cash tender from being used to partially tender a transaction.</td>
</tr>
<tr>
<td>53 - Round Tender to Next Highest Dollar</td>
<td>Select this option to round the cash tender up to the next highest whole number dollar amount. Options 53, 3, and 56 work together; to enable option 53, you must also select options 3 and 56. In addition, option 2 must be deselected. In this scenario, the Change Due will always be 0.00 and the rounding value will show the difference. In Page Design, you must configure the Payment Type as Cash:Cash and the Function as Default in the Payment Configuration dialog when configuring the Cash payment tender button. Partial tenders are allowed when Amount Options 3, 53, and 56 are enabled, when the Payment Type is Cash:Cash and the Function is # (DollarUp) in the Payment Configuration dialog when configuring the payment tender button in Page Design. Partial Tenders are not allowed when option 37 is enabled. (The message “Tender must be made in full” will appear when option 37 is enabled). Adding Payment Keys to the Transaction Page contains more information.</td>
</tr>
<tr>
<td>56 - Round Change Due</td>
<td>Select this option to accept payments for the exact amount and to round change due. Selecting option 56 overrides option 87.</td>
</tr>
<tr>
<td>87 - Rounded Payments and Change</td>
<td>Select this option to round change due resulting from an overtender.</td>
</tr>
</tbody>
</table>
### Table 11-3  (Cont.) Amount Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>88 - Round Payments and Change To the Nearest 0</td>
<td>Select this option to round the payment total or change due to the nearest 0 or 10.</td>
</tr>
<tr>
<td></td>
<td>You must also select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• 56</td>
</tr>
<tr>
<td></td>
<td>• 87</td>
</tr>
<tr>
<td></td>
<td>If you select option 88, the least significant decimal digit is rounded to 0 or 10. Deselect option 88 to round the least significant decimal digit to 0 or 5.</td>
</tr>
<tr>
<td></td>
<td>Tender/Media Amount Options 53 and 88 are mutually exclusive; you cannot select both.</td>
</tr>
<tr>
<td>96 - Round To Second Least Significant Digit</td>
<td>Select this option to round the payment total or change due to the nearest .50 or 1.00.</td>
</tr>
<tr>
<td></td>
<td>You must also select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• 56</td>
</tr>
<tr>
<td></td>
<td>• 87</td>
</tr>
<tr>
<td></td>
<td>If you select option 88, the payment total and change due are rounded to the nearest 0. With option 96 enabled, it is rounded to the nearest .00.</td>
</tr>
<tr>
<td></td>
<td>If you deselect option 88, the payment total and change due are rounded to the nearest 0 or 5. With option 96 enabled, it is rounded to the nearest .00 or .50.</td>
</tr>
<tr>
<td>97 - Round Change Due Down</td>
<td>Select this option to round change due down when the unrounded change is exactly half of the rounding number. For example if the payment given is .25 greater than the amount due, and rounding is to the nearest .50, the change due will be 0 instead of .50.</td>
</tr>
<tr>
<td></td>
<td>Select option 97 to round the change due down. Deselect option 97 to round the change due up.</td>
</tr>
</tbody>
</table>

16. Click **Save**.

- Configuring Currency
- Configuring Base Currency and Alternate Currency
- Configuring Currency Conversions
- Adding Payment Keys to the Transaction Page

**Related Topics**

- Types of Payment
- Credit Card Tokenization

### Adding Payment Keys to the Transaction Page

You can create payment keys for each type of payment tender (for example, Cash, Auth, Auth and Pay, Final Authorization, and Split Tender).

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.
2. Open the Front of House page (typically the Transaction page) on which to place the payment buttons.

3. On the Edit tab, select the page area in which to define the payment buttons.

4. Click Button to add a button.

5. On the General subtab, enter the button name in the Legend field.

6. From the Type drop-down list, select Payment Tenders.

7. Click the black arrow beneath the Type drop-down list.

8. Select the tender payment type, and then click OK.

9. From the Payment Configuration dialog, select the Payment Type, and then click OK.

10. Position and size the button on the page. Use the Style arrow to change the color.

11. Click Save.

- Configuring Currency
- Configuring Base Currency and Alternate Currency
- Configuring Currency Conversions
- Configuring the Cash Tender

Related Topics
- Types of Payment
- Credit Card Tokenization

**Credit Card Tokenization**

Credit card tokenization helps to protect merchants from credit card theft. Tokenization technology replaces the customer's credit card number with a different identifier to uniquely distinguish the customer's credit card during settlement of a transaction. This technology eliminates the need to store credit card numbers on persistent media on the merchant's site. All sensitive information that is stored for credit card processing is kept off site.

Encryption technology is used to store customer credit card data. While the encryption technology is secure, it requires ongoing maintenance tasks to maintain the security. Managing this technology can be cumbersome for merchants. Many smaller merchants do not typically employ Management Information System (MIS) staff to monitor networks and security infrastructure. Larger Enterprise clients can incur large auditing charges to verify that each property is compliant with Payment Card Industry Data Security Standards (PCI DSS).

In a typical restaurant payment scenario, a server picks up a guest check with the credit card to be used for payment. The server swipes the credit card on the Point-of-Sale (POS) application and the credit authorization with the credit card number is sent to the credit card payment processor. The payment processor returns a valid authorization code and, along with the payment, a token is also returned to identify the credit card during the transaction's settlement. Any record of the original card number, expiration date, and track data is erased from memory. When the voucher prints, all that remains is the last four digits of the original credit card number and a token that identifies the card to the payment processor for future operations.
Consider the same transaction, but with the network connection to the credit card processor offline. In this case, the server must manually authorize the credit card and the credit card payment processor cannot provide a token. The credit card data must be stored until a token can be acquired by the POS system (usually at transaction settlement time). At that point the sensitive credit card information is purged from the application.

Table 11-4  Loadable Credit Card Tokenization

<table>
<thead>
<tr>
<th>Loadable Credit Card Driver</th>
<th>Requires Tokenization?</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAPMS</td>
<td>Optional</td>
</tr>
<tr>
<td>Dollars on the Net by Shift4</td>
<td>Yes</td>
</tr>
<tr>
<td>Fusebox by Elavon</td>
<td>Optional (Elavon sets tokenization)</td>
</tr>
<tr>
<td>VisaD</td>
<td>No</td>
</tr>
</tbody>
</table>

• Types of Payment

Related Topics

• Configuring Currency
• Configuring Base Currency and Alternate Currency
• Configuring Currency Conversions
• Configuring the Cash Tender
• Adding Payment Keys to the Transaction Page

Loadable Payment Card Configuration Tasks

Loadable payment drivers (including TVS and TV2G) do not support the use of Transaction Services POS API clients.

Setting up a loadable payment driver consists of completing the tasks listed in the following table:

Table 11-5  Loadable Payment Card Configuration Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Readying configuration prerequisites</td>
<td>Configuration Prerequisites</td>
</tr>
<tr>
<td>(If applicable) Vendor installing third-party gateway application or communication method</td>
<td>• Universal Transaction Gateway (required for Dollars on the Net by Shift4)</td>
</tr>
<tr>
<td></td>
<td>• Communication Methods for Fusebox Payment Card Driver</td>
</tr>
<tr>
<td>Configuring the loadable payment driver</td>
<td>Configuring the Payment Card Driver:</td>
</tr>
<tr>
<td></td>
<td>• CAPMS</td>
</tr>
<tr>
<td></td>
<td>• Dollars on the Net</td>
</tr>
<tr>
<td></td>
<td>• Fusebox</td>
</tr>
<tr>
<td></td>
<td>• VisaD</td>
</tr>
<tr>
<td>Configuring the payment device</td>
<td>Configuring the Loadable Payment Device</td>
</tr>
</tbody>
</table>


Table 11-5  (Cont.) Loadable Payment Card Configuration Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring the loadable payment card module</td>
<td>Configuring the Payment Card Module:</td>
</tr>
<tr>
<td></td>
<td>• CAPMS</td>
</tr>
<tr>
<td></td>
<td>• Dollars on the Net</td>
</tr>
<tr>
<td></td>
<td>• Fusebox</td>
</tr>
<tr>
<td></td>
<td>• VisaD</td>
</tr>
<tr>
<td>Creating loadable payment card buttons</td>
<td>Creating Loadable Payment Card Buttons</td>
</tr>
<tr>
<td>(Optional) Setting automatic event tasks</td>
<td>Autosequence Events</td>
</tr>
<tr>
<td>(If applicable) Distributing a third-party payment card driver package</td>
<td>Distributing a Third-Party Credit Card Driver Package</td>
</tr>
</tbody>
</table>

• Universal Transaction Gateway for Shift4
• Loadable Payment Configuration Prerequisites

Related Topics
• Configuring the Dollars on the Net Payment Card Driver
• Configuring the Dollars on the Net Payment Module
• Communication Methods for Fusebox Payment Card Driver
• stunnel Installation Methods
• Loadable Payment Configuration Prerequisites

Related Topics
• Installing stunnel at a Single Host Location
• Installing stunnel Through Simphony as a CAL Package
• Configuring the Fusebox Payment Card Driver
• Configuring the Fusebox Payment Module

Related Topics
• Configuring the CAPMS Payment Card Driver
• Configuring the CAPMS Payment Module

Related Topics
• Configuring the VisaD Payment Card Driver
• Configuring the VisaD Payment Module

Loadable Payment Configuration Prerequisites

Before configuring the loadable payment card driver and module, perform the following actions:
• Install Simphony version 2.6 or later at the property.
• Obtain access to the EMC within Simphony.
• Ensure that you have the Value Added Reseller (VAR) sheet from a CAPMS payment processing vendor representative. The VAR sheet contains the property information, such as the Bank Identification Number, Merchant Number, Store Number, and Terminal Number.

• (If Applicable) Implement custom payment or device drivers. Distributing a Third-Party Credit Card Driver Package contains more information.

• Universal Transaction Gateway for Shift4
  • Loadable Payment Card Configuration Tasks

Related Topics
• Configuring the Dollars on the Net Payment Card Driver
• Configuring the Dollars on the Net Payment Module
• Communication Methods for Fusebox Payment Card Driver
• stunnel Installation Methods
• Loadable Payment Card Configuration Tasks

Related Topics
• Installing stunnel at a Single Host Location
• Installing stunnel Through Simphony as a CAL Package
• Configuring the Fusebox Payment Card Driver
• Configuring the Fusebox Payment Module

Related Topics
• Configuring the CAPMS Payment Card Driver
• Configuring the CAPMS Payment Module

Related Topics
• Configuring the VisaD Payment Card Driver
• Configuring the VisaD Payment Module

Universal Transaction Gateway for Shift4

The Universal Transaction Gateway (UTG) is necessary for communication between Simphony and Dollars on the Net by Shift4. Obtain the Internet Protocol (IP) address of each computer that processes credit card transactions, and provide this list to the Shift4 representative. A Shift4 representative must install the UTG:

• On only one machine at a property. (Do not install UTG on each workstation.)

• Before you can configure the Shift4 loadable payment card driver in Simphony

A Shift4 representative must also install and configure one instance of the UTG at the Oracle Hospitality Hosting Center to support all batching activity. Depending on the transaction volume, you can implement additional UTGs in the Hosting Center to handle the required daily transactions.

UTG does not run on the Microsoft Windows CE operating system.

• Loadable Payment Card Configuration Tasks
Communication Methods for Fusebox Payment Card Driver

You can implement one of the following communication methods to process credit cards with the Fusebox payment card driver:

- Fusebox solution through stunnel
- ProtoBase Hosted Solution through Virtual Private Network (VPN)

For premise-based implementations, a single VPN can accommodate both authorization and settlement traffic.

Fusebox stunnel

The Fusebox application (Next Generation Hosted Solutions from Elavon) uses the stunnel application as a secure TCP connection between the property and the Elavon Hosting Center. This secure connection allows credit card authorizations and communication between the Oracle Hospitality Hosting Center and the Elavon Hosting Center for settlements. stunnel is a small application that uses a certificate to establish an SSL connection. You can implement stunnel through a Simphony CAL package. stunnel Installation Methods contains instructions about implementing stunnel.

ProtoBase Hosted Solution

If you use the legacy ProtoBase application, you need to use the ProtoBase Hosted Solution VPN communication method. When you use the ProtoBase Hosted Solution to communicate, establish at least two VPNs.

- Set the first VPN between the property and the ProtoBase Hosting Center. Install and configure a VPN appliance to establish the connection. This connection is used to process credit card authorizations. Contact an Elavon representative for details about this implementation.
- The second VPN appliance resides at the Oracle Hospitality Hosting Center and is used to process all settlements (batching) for the property. If multiple properties exist within an Enterprise organization, you can use a single VPN connection. Contact an Elavon representative for details about this implementation.

- stunnel Installation Methods
- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites

Related Topics

- Installing stunnel at a Single Host Location
- Installing stunnel Through Simphony as a CAL Package
- Configuring the Fusebox Payment Card Driver
- Configuring the Fusebox Payment Module
stunnel Installation Methods

Simphony uses the stunnel application to communicate with the Elavon Hosting Center. You can install stunnel on one computer (single host location) at the Enterprise level, or on individual workstations at the property to allow individual connectivity to Fusebox by Elavon. You must install stunnel at the Oracle Hospitality Hosting Center to perform all batching activities.

Single Host Location

Use this method for Oracle Hospitality Hosting Center installations or for properties that want to perform all payment card activity from a single computer. Installing stunnel at a Single Host Location contains instructions for this method.

CAL Package to Each Workstation

Use this method for properties that want to have stunnel installed on each workstation and perform payment card activity from multiple workstations. Installing stunnel Through Simphony as a CAL Package contains instructions for this method.

- Communication Methods for Fusebox Payment Card Driver
- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites

Related Topics

- Installing stunnel at a Single Host Location
- Installing stunnel Through Simphony as a CAL Package
- Configuring the Fusebox Payment Card Driver
- Configuring the Fusebox Payment Module

Installing stunnel at a Single Host Location

Obtain the Simphony version 2.6 or later installation media to perform the instructions in this section.

1. From the root of the Simphony installation media, browse to \Install \Simphony2\Tools\FuseboxSTunnel.

2. Double-click stunnel.exe. stunnel automatically installs the files under Program Files, Fusebox, stunnel. stunnel installs as a service and is set to automatically start.

- Installing stunnel Through Simphony as a CAL Package
- Configuring the Fusebox Payment Card Driver
- Configuring the Fusebox Payment Module

Related Topics

- Communication Methods for Fusebox Payment Card Driver
- stunnel Installation Methods
Installing stunnel Through Simphony as a CAL Package

1. Select the Enterprise level, click Setup, and then click CAL Packages.
2. Select Fusebox STunnel from the navigation tree.
3. Click the Deployment Schedules tab.
4. Click Add Deployment.
5. Select 1 - Property/Enterprise from the Deployment Type drop-down list.
6. Select the property in the Property field.
7. Select 0 - Install from the Action to Take drop-down list.
8. Click Save.

Configuring the CAPMS Payment Card Driver

1. Select the Enterprise, property, or revenue center, click Setup, and then click Payment Drivers.
2. Insert a record and enter CAPMS as the name.
3. Double-click the record to open it.
4. On the General tab, click the Import from a file link.
5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select CAPMSPayment.dll, and then click Open.
6. Click the Configuration tab.
7. From the Assembly/Class section, enter information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the payment driver (for example, CAPMS Payment Driver).</td>
</tr>
</tbody>
</table>
Table 11-6  (Cont.) Assembly/Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Enter the name of the third-party driver development company. This value appears in the <strong>Driver</strong> drop-down list.</td>
</tr>
<tr>
<td>Driver ID</td>
<td>Enter <strong>CAPMS</strong>.</td>
</tr>
</tbody>
</table>

8. From the Common Driver Properties section, enter 1 in the following fields:
   - **Bank Identification Number**
   - **Batch Number**
   - **Merchant Number**
   - **Store Number**
   - **Terminal Number**

   The values in these fields cannot be 0 (zero) or blank.

9. From the Transport Service Properties section, enter information in the following fields:

Table 11-7  Transport Service Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batching Host</td>
<td>Enter the IP address of the machine where the vendor gateway application is installed at the Hosting or Enterprise level. Refer to the third-party driver development company for the appropriate value.</td>
</tr>
<tr>
<td>Batching Host Port</td>
<td>Refer to the third-party driver development company for the appropriate value.</td>
</tr>
<tr>
<td>Host Timeout</td>
<td>Enter the timeout value in seconds. Setting the value to 0 (zero) equals no timeout. Do not leave this field blank.</td>
</tr>
</tbody>
</table>

10. From the CAPMS Driver Properties section, enter information in the following fields:

Table 11-8  CAPMS Driver Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable RFID</td>
<td>Select <strong>False</strong>.</td>
</tr>
<tr>
<td>Enable Shift4 Messaging</td>
<td>Select <strong>True</strong>. Use tokenized messaging. Select <strong>False</strong> to use standard non-tokenized messages. This setting is based on the vendor configuration.</td>
</tr>
<tr>
<td>Enable Tokenization</td>
<td>Select <strong>True</strong> to use tokenized messaging. Select <strong>False</strong> to use standard non-tokenized messages. This setting is based on the vendor configuration.</td>
</tr>
<tr>
<td>Interface Name</td>
<td>Refer to the third-party driver development company for the appropriate value.</td>
</tr>
<tr>
<td>Message Version</td>
<td>Refer to the third-party driver development company for the appropriate value.</td>
</tr>
</tbody>
</table>
Table 11-8  (Cont.) CAPMS Driver Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Non-Tokenized Authorization Reversal Method | If you set **Enable Tokenization** to **False**, select one of the following standard messaging options:  
• **Expire**: Do nothing with the authorization reversal request.  
• **Send**: Send the authorization reversal request.  
• **ZeroSale**: Send $0.00 sale as the authorization reversal request.  |
| Send Issue Number                    | Select **False**.                                                                                                                                                                                           |
| Send Start Date                      | Select **False**.                                                                                                                                                                                           |

11. Click **Save**.

• **Configuring the CAPMS Payment Module**

**Related Topics**

• **Loadable Payment Card Configuration Tasks**

• **Loadable Payment Configuration Prerequisites**

**Configuring the CAPMS Payment Module**

1. Select the Enterprise level, click **Setup**, and then click **Payments**.
2. Insert a record, and then enter **Credit Card** as the name. If a Credit Card payment record exists, skip this step.
3. Double-click the record to open it.
4. On the **General** tab, click the **Import from a file** link.
5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select **Micros.Payment.LoadableCreditCardModule.dll**, and then click **Open**.
6. Select **CAPMS** from the **Driver** drop-down list.
7. Select the appropriate device from the **Device** drop-down list.
   • Select **Internal** for Oracle Hospitality devices.
   • Select the third-party device if the property is using a custom device driver.
8. Click the **Configuration** tab.
9. From the Common Properties section, enter information in the following fields:

Table 11-9  Common Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Manual Authorization Credit Card</td>
<td>Select <strong>True</strong> for processors using the CAPMS driver. This field indicates whether manual authorization of credit cards is allowed.</td>
</tr>
<tr>
<td>Allow Partial Settlement On Batch</td>
<td>Select <strong>False</strong> for processors using the CAPMS driver.</td>
</tr>
</tbody>
</table>
Table 11-9  (Cont.) Common Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do Not Batch</td>
<td>Select False for processors using the CAPMS driver. This field indicates whether batch creation and settlement occurs within Simphony.</td>
</tr>
<tr>
<td>Encrypt Data</td>
<td>Select True for processors using the CAPMS driver.</td>
</tr>
<tr>
<td>Manual Card Data Entry Retries</td>
<td>Enter the number of times a workstation operator can attempt to manually enter a card number. Oracle recommends entering 5. The minimum value is 1.</td>
</tr>
<tr>
<td>Offline Authorizations</td>
<td>Enter the number of offline card authorizations allowed before the application attempts to re-establish online communication.</td>
</tr>
<tr>
<td>Prompt for Manual Card Data Entry</td>
<td>Select True for processors using the CAPMS driver. This field indicates whether workstation operators can manually enter a card number.</td>
</tr>
<tr>
<td>Retry Authorization Reversals On Batch</td>
<td>Select False for processors using the CAPMS driver.</td>
</tr>
<tr>
<td>Run As Service</td>
<td>Select False for processors using the CAPMS driver.</td>
</tr>
</tbody>
</table>

10. Click Save.

11. (Optional) To configure CAPMS payment driver settings that are unique to the property or revenue center:
   a. Select the property or revenue center, click Setup, and then click Payment Drivers.
   b. Double-click the CAPMS record to open it.
   c. On the General tab, click the Override this record link, and then click Yes.
   d. Click the Configuration tab.
   e. If the property or revenue center values differ from those set at the Enterprise level in the Common Driver Properties section, enter property information in the fields.

   Ensure that you have the VAR sheet from a CAPMS payment processing vendor representative. The VAR sheet contains the property information, such as the Bank Identification Number, Merchant Number, Store Number, and Terminal Number.
   f. If the property or revenue center values differ from those set at the Enterprise level in the Transport Service Properties section, enter property information in the fields.

12. Click Save.

- Configuring the CAPMS Payment Card Driver
Configuring the Dollars on the Net Payment Card Driver

1. Select the Enterprise, property, or revenue center, click Setup, and then click Payment Drivers.

2. Insert a record, enter DOTN as the name, and then click OK.

3. Double-click the record to open it.

4. On the General tab, click the Import from a file link.

5. Browse to [Drive Letter]\MICROS\Simphony2\EgatewayService\handlers, select DOTNPayment.dll, and then click Open.

6. Click the Configuration tab.

7. From the Assembly/Class section, enter information in the following fields:

   **Table 11-10 Assembly/Class Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the payment driver (for example, Dollars on the Net Payment Driver).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name of the third-party driver development company (for example, Shift4). This value appears in the Driver drop-down list.</td>
</tr>
<tr>
<td>Driver ID</td>
<td>Enter DOTN.</td>
</tr>
</tbody>
</table>

8. From the Common Driver Properties section, enter 1 in the following fields:
   - Bank Identification Number
   - Batch Number
   - Merchant Number
   - Store Number
   - Terminal Number

   The values in these fields cannot be 0 (zero) or blank.

9. From the Transport Service Properties section, enter information in the following fields:

   **Table 11-11 Transport Service Properties Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batching Host</td>
<td>Enter the IP address of the machine where the Universal Transaction Gateway (UTG) application is installed at the Hosting or Enterprise level. Refer to the third party driver development company for the appropriate value.</td>
</tr>
</tbody>
</table>
Table 11-11  (Cont.) Transport Service Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batching Host Port</td>
<td>Enter <strong>17476</strong>. Contact Shift4 to use a different port.</td>
</tr>
<tr>
<td>Host Timeout</td>
<td>Enter the timeout value in seconds. Setting the value to 0 (zero) equals no timeout. Do not leave this field blank.</td>
</tr>
<tr>
<td>Primary Host</td>
<td>Enter the IP address of the machine at the property that runs the UTG application. If you enter <strong>0.0.0.0</strong>, the actual IP address of the workstation at the property is required when you set the override.</td>
</tr>
<tr>
<td>Primary Host Port</td>
<td>Enter <strong>17476</strong>. Contact Shift4 to use a different port.</td>
</tr>
</tbody>
</table>

10. From the Shift4 Driver Properties section, enter **MICROS_SIMP2** in the **VendorID** field.

   This is the Interface Identifier that Shift4 uses to recognize the interface sending the message.

11. Click **Save**.

   • **Configuring the Dollars on the Net Payment Module**

   **Related Topics**
   • **Universal Transaction Gateway for Shift4**
   • **Loadable Payment Card Configuration Tasks**
   • **Loadable Payment Configuration Prerequisites**

---

**Configuring the Dollars on the Net Payment Module**

1. Select the Enterprise level, click **Setup**, and then click **Payments**.

2. Insert a record, enter **Credit Card** as the name, and then click **OK**. If a Credit Card payment record exists, skip this step.

3. Double-click the record to open it.

4. On the **General** tab, click the **Import from a file** link.

5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select **Micros.Payment.LoadableCreditCardModule.dll**, and then click **Open**.

6. Select **DOTN** from the **Driver** drop-down list.

7. Select the appropriate device from the **Device** drop-down list.
   • Select **Internal** for Oracle Hospitality devices.
   • Select the third-party device if the property is using a custom device driver.

8. Click the **Configuration** tab.

9. From the Common Properties section, enter information in the following fields:
### Table 11-12  Common Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Manual Authorization Credit Card</td>
<td>Select <strong>True</strong> for processors using the Shift4 driver. This field indicates whether manual authorization of credit cards is allowed.</td>
</tr>
<tr>
<td>Allow Partial Settlement On Batch</td>
<td>Select <strong>True</strong> for processors using Dollars on the Net by Shift4.</td>
</tr>
<tr>
<td>Do Not Batch</td>
<td>Select <strong>False</strong> for processors using the Shift4 driver. This field indicates whether batch creation and settlement occurs within Simphony.</td>
</tr>
<tr>
<td>Encrypt Data</td>
<td>Select <strong>True</strong> for processors using the Shift4 driver.</td>
</tr>
<tr>
<td>Manual Card Data Entry Retries</td>
<td>Enter the number of times a workstation operator can attempt to manually enter a card number. Oracle recommends entering <strong>5</strong>. The minimum value is <strong>1</strong>.</td>
</tr>
<tr>
<td>Offline Authorizations</td>
<td>Enter the number of offline card authorizations allowed before the application attempts to re-establish online communication.</td>
</tr>
<tr>
<td>Prompt for Manual Card Data Entry</td>
<td>Select <strong>True</strong> for processors using the Shift4 driver. This field indicates whether workstation operators can manually enter a card number.</td>
</tr>
<tr>
<td>Retry Authorization Reversals On Batch</td>
<td>Select <strong>False</strong> for processors using the Shift4 driver.</td>
</tr>
<tr>
<td>Run As Service</td>
<td>Select <strong>False</strong> for processors using the Shift4 driver.</td>
</tr>
</tbody>
</table>

10. Click **Save**.

11. Select the property, click **Setup**, and then click **Payment Drivers**.

12. Double-click the **DOTN** record to open it.

13. On the **General** tab, click the **Override this record** link, and then click **Yes**.

14. Click the **Configuration** tab.

15. If the property or revenue center values differ from those set at the Enterprise level in the Common Driver Properties section, enter property information in the fields. For example, Shift4 assigns a Merchant ID Number for the property, and you can enter it here.

16. From the Transport Service Properties section **Batching Host** field, enter the IP address of the computer where the UTG application is installed at the Hosting Center.

17. In the **Primary Host** field, enter the IP address of the computer with the UTG application installed at the property.

18. From the Shift4 Driver Properties section, enter information in the following fields:
Table 11-13  Shift4 Driver Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APIPassword</td>
<td>Enter the password that Shift4 assigns, which is unique to the property and pairs with the APISerialNumber.</td>
</tr>
<tr>
<td>APISerialNumber</td>
<td>Enter the password that Shift4 assigns, which is unique to the property and pairs with the APISerialNumber.</td>
</tr>
<tr>
<td>ZipCode</td>
<td>Enter the postal code of the property assigned by Shift4.</td>
</tr>
</tbody>
</table>

19. Click **Save**.

- Configuring the Dollars on the Net Payment Card Driver

Related Topics
- Universal Transaction Gateway for Shift4
- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites

### Configuring the Fusebox Payment Card Driver

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **Payment Drivers**.
2. Insert a record, enter **Fusebox** as the name, and then click **OK**.
3. Double-click the record to open it.
4. On the **General** tab, click the **Import from a file** link.
5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select **FuseboxPayment.dll**, and then click **Open**.
6. Click the **Configuration** tab.
7. From the Assembly/Class section, enter information in the following fields:

Table 11-14  Assembly/Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the payment driver (for example, Fusebox Payment Driver).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name of the third-party driver development company (for example, Elavon). This value appears in the <strong>Driver</strong> drop-down list.</td>
</tr>
<tr>
<td>Driver ID</td>
<td>Enter <strong>FB</strong>.</td>
</tr>
</tbody>
</table>

8. From the Common Driver Properties section, enter **1** in the following fields:
- **Bank Identification Number**
- **Batch Number**
- **Merchant Number**
9. From the Transport Service Properties section, enter information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batching Host</td>
<td>If you are using the Fusebox solution, enter the IP address of the machine where the stunnel application is installed.</td>
</tr>
<tr>
<td></td>
<td>If you are using ProtoBase, enter the IP address of the ProtoBase Hosted Solution provided by the Elavon representative for settlement transactions.</td>
</tr>
<tr>
<td>Batching Host Port</td>
<td>Enter 10001 for Fusebox.</td>
</tr>
<tr>
<td></td>
<td>Contact the Elavon representative for the ProtoBase Hosted Solution port number for settlement transactions.</td>
</tr>
<tr>
<td>Host Timeout</td>
<td>Enter the timeout value in seconds. Setting the value to 0 (zero) equals no timeout. Do not leave this field blank.</td>
</tr>
<tr>
<td>Primary Host</td>
<td>Enter the IP address of the machine that runs the stunnel application.</td>
</tr>
<tr>
<td></td>
<td>• If stunnel is installed per workstation, enter 127.0.0.1.</td>
</tr>
<tr>
<td></td>
<td>• If stunnel is installed on a single workstation at the property, leave this field blank.</td>
</tr>
<tr>
<td></td>
<td>• If the property is using ProtoBase, enter the IP address of the ProtoBase Hosted Solution provided by the Elavon representative for authorizations.</td>
</tr>
<tr>
<td>Primary Host Port</td>
<td>Enter 10001 for Fusebox.</td>
</tr>
<tr>
<td></td>
<td>Contact the Elavon representative for the ProtoBase Hosted Solution port number for authorizations.</td>
</tr>
</tbody>
</table>

10. From the Elavon Driver Properties section, enter information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chain Code</td>
<td>Enter the six-character alphanumeric code assigned by Elavon, which is used for key management in gateway environments. The <strong>Chain Code</strong> is used with Fusebox, but not with ProtoBase.</td>
</tr>
</tbody>
</table>
Table 11-16  (Cont.) Elavon Driver Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LocationName</td>
<td>If Elavon supplied a Location Name or Source IP Address to pass from the POS client, enter it here. This value passes on every transaction and can be the location name or Fusebox workstation. You can leave this field blank. The LocationName is used with Fusebox, but not with ProtoBase.</td>
</tr>
<tr>
<td>TerminationID</td>
<td>Enter the terminal code assigned by Elavon for the property to use with credit cards.</td>
</tr>
<tr>
<td>TransactionInquiryRetryDelayTimeOutMS</td>
<td>Enter the amount of time Simphony waits before sending the request when a failure occurs. After a communication failure with Fusebox, Simphony sends an inquiry to Fusebox to discover the cause of failure. Oracle recommends entering 5000.</td>
</tr>
</tbody>
</table>

11. Click Save.

- Installing stunnel at a Single Host Location
- Installing stunnel Through Simphony as a CAL Package
- Configuring the Fusebox Payment Module

Related Topics

- Communication Methods for Fusebox Payment Card Driver
- stunnel Installation Methods
- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites

Configuring the Fusebox Payment Module

1. Select the Enterprise level, click Setup, and then click Payments.
2. Insert a record, enter Credit Card as the name, and then click OK. If a Credit Card payment record exists, skip this step.
3. Double-click the record to open it.
4. On the General tab, click the Import from a file link.
5. Browse to [Drive Letter]:\MICROS\Simphony2\GatewayService\handlers, select Micros.Payment.LoadableCreditCardModule.dll, and then click Open.
6. Select Fusebox from the Driver drop-down list.
7. Select the appropriate device from the Device drop-down list.
   - Select Internal for Oracle Hospitality devices.
   - Select the third-party device if the property is using a custom device driver.
8. Click the Configuration tab.
9. From the Common Properties section, enter information in the following fields:
Table 11-17 Common Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Manual Authorization Credit Card</td>
<td>Select <strong>True</strong> for processors using the Fusebox driver. This field indicates whether manual authorization of credit cards is allowed.</td>
</tr>
<tr>
<td>Allow Partial Settlement On Batch</td>
<td>Select <strong>False</strong> for processors using the Fusebox driver.</td>
</tr>
<tr>
<td>Do Not Batch</td>
<td>Select <strong>False</strong> for processors using the Fusebox driver. This field indicates whether batch creation and settlement occurs within Simphony.</td>
</tr>
<tr>
<td>Encrypt Data</td>
<td>Select <strong>True</strong> for processors using the Fusebox driver.</td>
</tr>
<tr>
<td>Manual Card Data Entry Retries</td>
<td>Enter the number of times a workstation operator can attempt to manually enter a card number. Oracle recommends entering <strong>5</strong>. The minimum value is <strong>1</strong>.</td>
</tr>
<tr>
<td>Offline Authorizations</td>
<td>Enter the number of offline card authorizations allowed before the application attempts to re-establish online communication.</td>
</tr>
<tr>
<td>Prompt for Manual Card Data Entry</td>
<td>Select <strong>True</strong> for processors using the Fusebox driver.</td>
</tr>
<tr>
<td>Retry Authorization Reversals On Batch</td>
<td>Select <strong>False</strong> for processors using the Fusebox driver.</td>
</tr>
<tr>
<td>Run As Service</td>
<td>Select <strong>False</strong> for processors using the Fusebox driver.</td>
</tr>
</tbody>
</table>

10. Click **Save**.

11. (Optional) To configure Fusebox payment driver settings that are unique to the property or revenue center:
   a. Select the property or revenue center, click **Setup**, and then click **Payment Drivers**.
   b. Double-click the **Fusebox** record to open it.
   c. On the **General** tab, click the **Override this record** link, and then click **Yes**.
   d. Click the **Configuration** tab.
   e. If stunnel is installed on a single workstation at the property, enter the **Primary Host** in the Transport Service Properties section. This is the IP address of the machine that houses stunnel for Fusebox, or the IP address for authorizations to the ProtoBase Hosted Solution.
   f. From the Elavon Driver Properties section, enter information in the following fields:
## Table 11-18 Elavon Driver Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chain Code</td>
<td>Enter the six-character alphanumeric code assigned by Elavon, which is used for key management in gateway environments. The <strong>Chain Code</strong> is used with Fusebox, but not with ProtoBase.</td>
</tr>
<tr>
<td>LocationName</td>
<td>If Elavon supplied a Location Name or Source IP Address to pass from the POS client, enter it here. This value passes on every transaction and can be the location name or Fusebox workstation. You can leave this field blank. The <strong>LocationName</strong> is used with Fusebox, but not with ProtoBase.</td>
</tr>
<tr>
<td>TerminationID</td>
<td>Enter the Terminal Code assigned by Elavon for the property to use with credit cards.</td>
</tr>
<tr>
<td>TransactionInquiryRetryDelayTimeoutMS</td>
<td>Enter the amount of time Simphony waits before sending the request when a failure occurs. After a communication failure with Fusebox, Simphony sends an inquiry to Fusebox to discover the cause of failure. Oracle recommends entering <strong>5000</strong>.</td>
</tr>
</tbody>
</table>

### g. Click **Save**.

- Installing stunnel at a Single Host Location
- Installing stunnel Through Simphony as a CAL Package
- Configuring the Fusebox Payment Card Driver

### Related Topics

- Communication Methods for Fusebox Payment Card Driver
- stunnel Installation Methods
- Loadable Payment Card Configuration Tasks
- Loadable Payment Configuration Prerequisites

### Configuring the VisaD Payment Card Driver

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **Payment Drivers**.
2. Insert a record, enter **VisaD** as the name, and then click **OK**.
3. Double-click the record to open it.
4. On the **General** tab, click the **Import from a file** link.
5. Browse to `[Drive Letter]\MICROS\Symphony2\EgatewayService\handlers`, select **VisaDPayment.dll**, and then click **Open**.
6. Click the **Configuration** tab.
7. From the Assembly/Class section, enter information in the following fields:
Table 11-19  Assembly/Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the payment driver (for example, VisaD Payment Driver).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name of the third-party driver development company (for example, Merchant Link). This value appears in the Driver drop-down list.</td>
</tr>
<tr>
<td>Driver ID</td>
<td>Enter <strong>VISAD</strong>.</td>
</tr>
</tbody>
</table>

8. From the Common Driver Properties section, enter **1** in the following fields:

- **Bank Identification Number**
- **Batch Number**
- **Merchant Number**
- **Store Number**
- **Terminal Number**

The values in these fields cannot be **0** (zero) or blank.

9. From the Transport Service Properties section, enter information in the following fields:

Table 11-20  Transport Service Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Timeout</td>
<td>Enter the timeout value in seconds. Setting the value to <strong>0</strong> (zero) equals a 30-second timeout. Do not leave this field blank. Oracle recommends entering <strong>60</strong>. This field applies only to Win32 devices. You cannot change the timeout from the default setting of <strong>100</strong> seconds on WinCE devices.</td>
</tr>
<tr>
<td>Primary Host</td>
<td>Enter the URL of the payment provider application. For Merchant Link, enter <strong>g1.merchantlink.com</strong>.</td>
</tr>
<tr>
<td>Primary Host Port</td>
<td>Enter the port number used for the Primary Host. For Merchant Link, enter <strong>443</strong>.</td>
</tr>
<tr>
<td>Request URI</td>
<td>If applicable, enter the Uniform Resource Identifier (URI) for the payment provider. For Merchant Link, enter <strong>/Micros/process_transaction.cgi</strong>.</td>
</tr>
<tr>
<td>Secondary Host</td>
<td>Enter the URL of the payment provider application. For Merchant Link, enter <strong>g2.merchantlink.com</strong>.</td>
</tr>
<tr>
<td>Secondary Host Port</td>
<td>Enter the port number used for the Secondary Host. For Merchant Link, enter <strong>443</strong>.</td>
</tr>
</tbody>
</table>

10. From the VisaD Driver Properties section, enter **9999** in the **Max Batch Records** field.

11. Click **Save**.

- **Configuring the VisaD Payment Module**
Configuring the VisaD Payment Module

1. Select the Enterprise level, click **Setup**, and then click **Payments**.
2. Insert a record, enter **Credit Card** as the name, and then click **OK**. If a Credit Card payment record exists, skip this step.
3. Double-click the record to open it.
4. On the **General** tab, click the **Import from a file** link.
5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select **Micros.Payment.LoadableCreditCardModule.dll**, and then click **Open**.
6. Select **VisaD** from the **Driver** drop-down list.
7. Select the appropriate device from the **Device** drop-down list.
   - Select **Internal** for Oracle Hospitality devices.
   - Select the third-party device if the property is using a custom device driver.
8. Click the **Configuration** tab.
9. From the Common Properties section, enter information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Manual Authorization Credit Card</td>
<td>Select <strong>True</strong> for processors using the VisaD driver. This field indicates whether manual authorization of credit cards is allowed.</td>
</tr>
<tr>
<td>Allow Partial Settlement On Batch</td>
<td>Select <strong>False</strong> for processors using the VisaD driver.</td>
</tr>
<tr>
<td>Do Not Batch</td>
<td>Select <strong>False</strong> for processors using the VisaD driver. This field indicates whether batch creation and settlement occurs within Simphony.</td>
</tr>
<tr>
<td>Encrypt Data</td>
<td>Select <strong>True</strong> for processors using the VisaD driver.</td>
</tr>
<tr>
<td>Manual Card Data Entry Retries</td>
<td>Enter the number of times a workstation operator can attempt to manually enter a card number. Oracle recommends entering <strong>5</strong>. The minimum value is <strong>1</strong>.</td>
</tr>
<tr>
<td>Offline Authorizations</td>
<td>Enter the number of offline card authorizations allowed before the application attempts to re-establish online communication.</td>
</tr>
<tr>
<td>Prompt for Manual Card Data Entry</td>
<td>Select <strong>True</strong> for processors using the VisaD driver. This field indicates whether workstation operators can manually enter a card number.</td>
</tr>
</tbody>
</table>
### Table 11-21  (Cont.) Common Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry Authorization Reversals On Batch</td>
<td>Select <strong>False</strong> for processors using the VisaD driver.</td>
</tr>
<tr>
<td>Run As Service</td>
<td>Select <strong>False</strong> for processors using the VisaD driver.</td>
</tr>
</tbody>
</table>

10. Click **Save**.

11. (Optional) If you need to configure VisaD payment driver settings that are unique to the property or revenue center:
   a. Select the property or revenue center, click **Setup**, and then click **Payment Drivers**.
   b. Double-click the **VisaD** record to open it.
   c. On the **General** tab, click the **Override this record** link, and then click **Yes**.
   d. Click the **Configuration** tab.
   e. If the property or revenue center values differ from those set at the Enterprise level in the Transport Service Properties section, enter property information in the fields:
      Ensure that you have the VAR sheet from a VisaD payment processing vendor representative. The VAR sheet contains the property information, such as the Agent Bank Number, Industry Type, Merchant Category, and Time Zone.
   f. From the VisaD Driver Properties section, enter values in all fields based on the VAR sheet information.
   g. Click **Save**.

- **Configuring the VisaD Payment Card Driver**

**Related Topics**
- **Loadable Payment Card Configuration Tasks**
- **Loadable Payment Configuration Prerequisites**

### Configuring the Loadable Payment Card Device

The payment module generally uses payment devices containing internal drivers (for example, magnetic stripe reader (MSR) or radio-frequency identification (RFID)) that are compatible with Simphony and accept payment card information. If this is the case, skip the instructions in this section.

If the payment module uses a physical input device containing a custom driver that is not supported with Simphony, you must configure the third-party device driver to allow communications between the device and Simphony.

1. Select the Enterprise level, click **Setup**, and then click **Payment Device**.
2. Insert a record, enter the device name, and then click **OK**.
3. Double-click the record to open it.
4. On the **General** tab, click the **Import from a file** link.
5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select [ThirdPartyProvider].dll, and then click Open.

6. Click the Configuration tab.

7. From the Assembly/Class section, enter information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description of the device driver (for example, Magtek).</td>
</tr>
<tr>
<td>Driver ID</td>
<td>Enter a value that matches the device (for example, Magtek350M).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name of the third-party device (for example, Magtek). This value appears in the Device drop-down list.</td>
</tr>
</tbody>
</table>

8. Click Save.

Creating Loadable Payment Card Buttons

Oracle recommends that you create payment card buttons on a page for the loadable payment card functions.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

2. Open the page on which to place loadable payment card buttons.

3. On the Edit tab, select the page area in which to define the loadable payment card functions (typically the payment area).

4. Click Payments.

5. On the General subtab, select Payment Tenders from the Type drop-down list.

6. Click the black arrow beneath the Type drop-down list.

7. From the Select Tender/Media Payment dialog, select the payment tender, and then click OK.

   Select None to use all types of credit cards.

8. From the Payment Configuration dialog, select CreditDebit:Loadable from the Payment Type drop-down list.

9. Select the appropriate function key from the Functions drop-down list, and then click OK:

   • CreditAuthOnly: This function sends a request to the cardholder’s bank to authorize available funds and place a hold on those funds for sale. The account is not charged. This function is used in Table Service to obtain authorization of payment.

   • CreditAuthAndPay: This function authorizes funds available and completes the sale. This function is used in Quick Service to apply payment and close a check.

   • InitialAuthorization: This function sends a request to the cardholder’s bank to authorize available funds and place a hold on those funds for sale.
account is not charged. This function is used in Table Service to obtain authorization of payment for a large party or with bar tabs where additional charges may be incurred.

• **ManualAuthorization**: When connection to the credit card processor is unavailable, this function allows the workstation operator to manually enter the authorization code (obtained by phoning the credit card processor).

10. Position and size the button on the page. Use the Style arrow to change the color.
11. In the **Legend** field, enter the button name.
12. Repeat Steps 7 through 11 for each type of payment tender.
13. Click **Save**.

### The Oracle Payment Interface (OPI)

The Oracle Payment Interface (OPI) simplifies credit card payment configuration by enabling Simphony to communicate with payment service providers (PSPs) that provide credit card processing using a single payment driver.

In addition, the OPI:

• Enhances security by not handling or storing card holder or sensitive authentication data in Simphony or OPI. PSPs process card data and provide a token to Simphony.
• Eliminates credit card batch processing in Simphony by automating end-of-day settlement for credit card transactions through the OPI.

**Related Topics**

• Configuring the OPI Driver
• Configuring the OPI Payment Module
• Configuring the Default Payment Tender for OPI
• Updating Credit Card Preambles for OPI
• Configuring the OPI and SPI to Settle Transactions Automatically
• Configuring the OPI and SPI to Settle Transactions Manually
• Credit Card Preambles for OPI

### OPI Architecture

In the Simphony implementation, an OPI server is installed on-premise and processes payment requests between the Simphony POS clients and the PSP. The PSP provides the PIN Entry Devices (PEDs) that read and process credit card data, and then communicate with the PSP Host on the Cloud. The PEDs can be connected directly to the POS clients (usually via serial, USB, or Bluetooth connection) or they can be network devices.

OPI supports two modes:

• Terminal Mode
• Middleware Mode
In Terminal mode, the OPI Datastore database contains a table with a one-to-one mapping of POS client to PED. A payment request from a POS client is directed to the correct PED. In Middleware mode, the PSP provides an application, called middleware, that handles the mapping of a POS client to a PED. The OPI server directs all payment requests to the middleware application, which then routes the request to the appropriate PED. In either mode, neither the OPI server nor Simphony come in contact with credit card data. Sensitive data is handled strictly between the PED or middleware and the PSP Host. OPI receives and stores tokens and voucher printing instructions from the PSP, and passes the voucher data to Simphony, leaving Simphony and the OPI server out of PA-DSS scope.

Figure 11-1  Terminal Mode Architecture
Figure 11-2  Middleware Mode Architecture

Related Topics
- Configuring the OPI Driver
- Configuring the OPI Payment Module
- Configuring the Default Payment Tender for OPI
- Updating Credit Card Preambles for OPI
- Configuring the OPI and SPI to Settle Transactions Automatically
- Configuring the OPI and SPI to Settle Transactions Manually
- Credit Card Preambles for OPI
Configuring the OPI Driver

If the property sends transactions to multiple Merchant IDs, create the OPI driver record in the property with the Merchant ID that is used by a majority of the revenue centers, and then override the driver records of the revenue centers that route transactions to other Merchant IDs.

1. Select the Enterprise, property, or revenue center, click Setup, and then click Payment Drivers.
2. Insert a new Payment Driver record named OPI, and then double-click the record to open it.
3. On the General tab, select 3 - DLL or 26 - Secure DLL Configuration as the Content Type, click Import from a file, browse to [Drive Letter]:\MICROS \Simphony2\EgatewayService\handlers\OPIPayment.dll, and then click Open.
4. On the Configurations subtab, enter information in the following fields:
   - Display Name: Enter a display name for the driver (for example, OPI).
   - Merchant Number: Enter the Merchant ID.
   - Primary Host: Enter the URL for the OPI gateway.
   - Host Timeout: Enter the timeout value in seconds. The default timeout value is 180 seconds.
   - Pass Phrase: Enter a passphrase for authentication.
5. Click Save.

Related Topics

- The Oracle Payment Interface (OPI)
- OPI Architecture
- Credit Card Preambles for OPI

Configuring the OPI Payment Module

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Payments.
2. Insert a new record for the OPI, and then double-click to open it.
3. Click Import from a file, browse to [Drive letter]\MICROS \Simphony2\EgatewayService\handlers\Micros.Payment.LoadableCreditCardModule.dll, and then click Open.
4. Select the OPI Driver from the drop-down list.
5. Select the Device from the drop-down list.
6. Select 3 - DLL from the Content Type drop-down list.
7. On the Configuration subtab, modify the settings as required. Obtain the configuration information from the credit card processor.
To enable **Incremental Authorizations**, select **True**. By default, **Incremental Authorizations** is disabled (**False**). You must use the native Oracle Payment Interface (OPI) payment drivers and the payment service provider must support Incremental Authorizations.

8. Click **Save**.

**Related Topics**
- The Oracle Payment Interface (OPI)
- OPI Architecture
- Credit Card Preambles for OPI

### Configuring the Default Payment Tender for OPI

1. Create a credit card tender for the OPI. See [Configuring a Credit Card Tender](#) for instructions.
   
   Give the tender a general name such as **OPIDefault**.

2. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then **click Tender Parameters**.

3. On the Configuration tab, select the credit card tender that you created for the OPI as the **Default Payment Card Tender**.

4. Click **Save**.

5. Create a button for the default OPI tender. See [Creating Loadable Payment Card Buttons](#) for instructions.

**Related Topics**
- The Oracle Payment Interface (OPI)
- OPI Architecture
- Credit Card Preambles for OPI

### Updating Credit Card Preambles for OPI

1. Click the Enterprise or property, click **Configuration**, and then click **Tender/Media**.

2. Double-click a credit card tender type to open it, click the **Options** tab, and then click the **Credit Card Options** subtab.

3. In the Preambles section, if standard credit card preambles are defined, select the preamble records, and then click **Delete**.
   
   You must delete all preexisting standard credit card preambles.

4. Click **Add**, and then configure the **Start** preamble and the **Length** based on the card payment type.
   
   See [Credit Card Preambles for OPI](#) for a list of preambles for commonly used card types.

5. Click **Save**.

6. Repeat Steps 2 through 5 for other credit card payment types.
Related Topics

- The Oracle Payment Interface (OPI)
- OPI Architecture
- Credit Card Preambles for OPI

Configuring the OPI and SPI to Settle Transactions Automatically

You can configure the OPI or SPI settlement to run automatically at a recurring day and time. The settlement occurs at the Coordinated Universal Time (UTC) standard. Here are a few configuration examples:

Workstation Time Zone: Eastern
Recurrence Time: 15:00

**Configuration 1 (There is no conversion to UTC in this case)**

- Time Zone: 0 - Local Time Zone
- Time Settlement Occurs: 15:00

Any event with a Time Zone is converted to UTC. This is best illustrated with Configuration 2.

**Configuration 2**

- Time Zone: 35 - Eastern Time Zone (UTC - 5) (Daylight Savings Time is active)
- UTC Time Settlement Will Occur: 19:00

**Configuration 3**

- Time Zone: 260 - Brisbane (UTC + 10)
- UTC Time Settlement Will Occur: 05:00 Tomorrow

1. Select the Enterprise or property, click **Configuration**, and then click **Task Schedules**.
2. Insert a new record for the OPI or SPI EOD, and then double-click the record to open it.
3. On the General tab, in the **Service Type** drop-down list, select **8- Check and Posting**, and then select **5 - EOD Settlement** as the **Task Type**.
4. In the **Schedule Type** drop-down list, select **4 - Recurring - Daily**, and then select **Enabled** in the Duration section.
5. Select the **Start date**, and then click **No end date**.
6. Click the **Recurrence** tab.
7. To set the SOD settlement:
   a. In the Daily Frequency section, select **Occurs once at**.
   b. Schedule the EOD settlement to execute at the same time SOD runs on the property.
8. To set the EOD settlement:
a. In the Daily section, enter 1 in the Every xx day(s) field.

b. In the Daily Frequency section, select Occurs every and schedule the EOD batch settlement time to execute.

9. Click Save.

Related Topics

• The Oracle Payment Interface (OPI)
• OPI Architecture
• Credit Card Preambles for OPI

Configuring the OPI and SPI to Settle Transactions Manually

If credit card settlement fails, you can enable workstation operators to manually perform the EOD OPI or SPI settlement through the workstation.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

2. Double-click the transaction page on which you want the button to appear on the workstation, and insert a new button.

3. On the General tab, select Payment Tenders as the Type, click the right arrow directly beneath the Type drop-down list, select the 0–None payment record, and then click OK.

4. On the Payment Configuration dialog, select CreditDebit:Loadable from the Payment Type drop-down list.

5. In the Argument drop-down list, select CreditDebit:Loadable ManualEODSettlement, and then click OK.

6. Enter a Legend for the button (for example, OPI EOD or SPI EOD), and then click Save.

Related Topics

• The Oracle Payment Interface (OPI)
• OPI Architecture
• Credit Card Preambles for OPI

Credit Card Preambles for OPI

The following table lists the credit card preambles for OPI.

<table>
<thead>
<tr>
<th>Card Type</th>
<th>Start</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visa</td>
<td>0*</td>
<td>1</td>
</tr>
<tr>
<td>Visa PIN Credit</td>
<td>12*</td>
<td>2</td>
</tr>
<tr>
<td>Visa Electron</td>
<td>17*</td>
<td>2</td>
</tr>
<tr>
<td>Card Type</td>
<td>Start</td>
<td>Length</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------</td>
<td>--------</td>
</tr>
<tr>
<td>Visa Debit</td>
<td>18*</td>
<td>2</td>
</tr>
<tr>
<td>VPAY</td>
<td>20*</td>
<td>2</td>
</tr>
<tr>
<td>MasterCard</td>
<td>1*</td>
<td>1</td>
</tr>
<tr>
<td>MasterC Debit</td>
<td>24*</td>
<td>2</td>
</tr>
<tr>
<td>MasterCard PIN Credit</td>
<td>13*</td>
<td>2</td>
</tr>
<tr>
<td>American Express</td>
<td>2*</td>
<td>1</td>
</tr>
<tr>
<td>Discover</td>
<td>26*</td>
<td>2</td>
</tr>
<tr>
<td>Diners</td>
<td>3*</td>
<td>1</td>
</tr>
<tr>
<td>JCB</td>
<td>4*</td>
<td>1</td>
</tr>
<tr>
<td>SVC</td>
<td>7*</td>
<td>1</td>
</tr>
<tr>
<td>Maestro</td>
<td>19*</td>
<td>2</td>
</tr>
<tr>
<td>Gift Card</td>
<td>8*</td>
<td>1</td>
</tr>
<tr>
<td>Points</td>
<td>9*</td>
<td>1</td>
</tr>
<tr>
<td>CUP</td>
<td>10*</td>
<td>2</td>
</tr>
<tr>
<td>CUP Debit</td>
<td>14*</td>
<td>2</td>
</tr>
<tr>
<td>Debit</td>
<td>11*</td>
<td>2</td>
</tr>
<tr>
<td>Interac</td>
<td>15*</td>
<td>2</td>
</tr>
<tr>
<td>UKDM/Switch</td>
<td>16</td>
<td>1</td>
</tr>
<tr>
<td>VPAY</td>
<td>20*</td>
<td>2</td>
</tr>
<tr>
<td>Alliance</td>
<td>21*</td>
<td>2</td>
</tr>
<tr>
<td>ecChip</td>
<td>22*</td>
<td>2</td>
</tr>
<tr>
<td>GiroCard</td>
<td>23*</td>
<td>2</td>
</tr>
<tr>
<td>Bank Card</td>
<td>25*</td>
<td>2</td>
</tr>
<tr>
<td>PayPal</td>
<td>27*</td>
<td>2</td>
</tr>
</tbody>
</table>

**Related Topics**

- The Oracle Payment Interface (OPI)
- OPI Architecture
- Configuring the OPI Driver
- Configuring the OPI Payment Module
- Configuring the Default Payment Tender for OPI
- Updating Credit Card Preambles for OPI
- Configuring the OPI and SPI to Settle Transactions Automatically
- Configuring the OPI and SPI to Settle Transactions Manually
The Simphony Payment Interface (SPI)

The SPI is the new, resilient version of the OPI. It is part of the Simphony client application and formats the individual messages for the PSP (terminal or middleware) and processes the responses for the client directly. This eliminates the need for the OPI server and avoids traffic over the LAN on POS clients that have a PIN Entry Device (PED) attached.

The following links provide more information on Simphony/SPI:

SPI Architecture: https://docs.oracle.com/cd/F10429_01/doc.182/f10213/c_payments_spi_architecture.htm#SIMCG-SPIArchitecture-DA81B9D8

OPI Architecture: https://docs.oracle.com/cd/F10429_01/doc.182/f10213/c_payments_opi_architecture.htm#SIMCG-OPIArchitecture-D2CB9A39

OPI Information in the Simphony Configuration Guide: https://docs.oracle.com/cd/F10429_01/doc.182/f10213/c_payments_opi.htm#SIMCG-TheOraclePaymentInterfaceOPI-10678CB4

SPI Information in the Simphony Configuration Guide: https://docs.oracle.com/cd/F10429_01/doc.182/f10213/c_payments_spi.htm#SIMCG-TheSimphonyPaymentInterfaceSPI-DA817CDC

Data Flow Process

1. User initiates payment functionality, such as authorization or finalization in Ops.
2. SPI establishes a secure outbound connection with a Pin Entry Device (PED) or middleware. 
3. SPI submits required transaction data (check information, amount).
4. PED prompts patron to swipe/dip/tap card, may prompt for tip/PIN.
5. PED processes payment by submitting CC data and payment request to PSP host.
6. PSP host responds with approval and returns token data back to PED.
7. PED/middleware returns response message to SPI through connection established in step 2. Response message includes token, transaction references and print data. Transaction data is stored in check detail.
8. Communication logs (communication in steps 3 and 7) are stored on each client. 

Steps 4-6 are the only area where credit card data is being handled. Steps 4-6 are outside of Simphony and the sole responsibility of the PSP. Encryption of data and communication channels vary by PSP and should be considered when choosing a PSP.

The following figure shows an architecture diagram:
The following figure shows a sample response received by SPI:

```xml
<TransactionResponse>
  <SequenceNo>002279</SequenceNo>
  <RespCode>00</RespCode>
  <RespText>APPROVAL</RespText>
  <AuthCode>200154</AuthCode>
  <RNN>0000000235</RNN>
  <OfflineFlag>N</OfflineFlag>
  <MerchantId>12456789012345</MerchantId>
  <TerminalId>1234567890</TerminalId>
  <PrintData>Demo Res/MICORS Demo Restaurant 888 Test Ave., Columbia, MD
  Merchant Copy# MerchInt ID: 1234567890123456 Terminal ID: 1234567890123456 Card No:
  XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX Expiry Date: 07/2015
  MasterCard# Type: MasterCard# Trans Type: Sale# Trans Time: 12/05/2015 00:00:00 00:00:00 # Total
  Base Amount: USD50.00 # Tip Amount: USD50.00 # TOTAL: USD50.00 # Approved:
  Signature: Demo Res/MICORS Demo Restaurant 888 Test Ave., Columbia, MD
  Customer Copy# MerchInt ID: 1234567890123456 Terminal ID: 1234567890123456 Card No:
  XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX Expiry Date: 07/2015
  MasterCard# Type: MasterCard# Trans Type: Sale# Trans Time: 12/05/2015 00:00:00 00:00:00 # Total
  Base Amount: USD50.00 # Tip Amount: USD50.00 # TOTAL: USD50.00 # Approved:
  Signature: Demo Res/MICORS Demo Restaurant 888 Test Ave., Columbia, MD
</TransactionResponse>
```

Related Topics

- Configuring the SPI Payment Driver
- Configuring Mail Order Telephone Order (MOTO)

**SPI Architecture**

With the exception of Pay@Table, there is no longer a need for the OPI server. The business logic and communication layer that with the OPI are handled by the OPI server are included in the SPI, which is a component of the Simphony client.
application. If a POS client has a PED attached, it is possible to be completely independent of the LAN for payment processing.

The SPI can be deployed using one of the following connection methods: Terminal mode or Middleware mode. Talk to your PSP to identify the mode(s) which are available and best suited to your environment.

Terminal Mode

POS Clients With Attached PEDs

In the ideal scenario, Simphony POS clients (typically Win32 or Win64) are each attached to a PED. This setup eliminates the need for a LAN connection.

Figure 11-3  POS Clients With Attached PEDs

The process for a credit card transaction follows these steps (as illustrated in the following figure):
1. POS Operations sends a payment request to the PED, addressing it as localhost:port.

2. The PED communicates with the PSP Host and returns the token and voucher printing instructions to POS Operations.

3. The token and other transaction details are saved in the Datastore on the POS client.

This scenario is independent of both the LAN and the OPI server.

**POS Clients Without Attached PEDs**

POS clients, such as tablets and Android devices, may not have PED devices directly attached. However, PSPs offer network-capable PEDs that can be used.
Figure 11-5  POS Clients Without Attached PEDs

The process for a credit card transaction follows these steps (as illustrated in the following figure):

Figure 11-6  Terminal Mode Architecture Without Attached PED
1. POS Operations sends a payment request to the PED over the network, addressing it with its IP address:port.

2. The PED communicates with the PSP Host and returns the token and voucher printing instructions to POS Operations.

3. The token and other transaction details are saved in the Datastore on the POS client.

This scenario depends on a LAN connection and is vulnerable to network failure to the PED, but does not require an OPI server.

Middleware Mode

**POS Clients With or Without Attached PEDs**

The PSP provides an application, called middleware, which handles the mapping of a POS client to a PED.

The process for a credit card transaction follows these steps (as illustrated in the following figure):
1. POS Operations sends a payment request to the IP address where the middleware application is configured.

2. The middleware application passes the request to the appropriate PED.

3. The PED communicates with the PSP Host and returns the token and voucher printing instructions to POS Operations.

4. The token and other transaction details are saved in the Datastore on the POS client.

This scenario depends on a LAN connection and is vulnerable to network failure to the PED, but does not require an OPI server.

**Related Topics**
- Configuring the SPI Payment Driver
• Configuring Mail Order Telephone Order (MOTO)

Payment Driver vs. Workstation Settings

You must configure SPI as a payment driver. You can configure the SPI driver at the Enterprise, zone, property, and revenue center levels in the Payment Drivers module, and you can override the SPI configuration to set client specific values at the workstation level in the Workstations module. Workstation settings override Payment Driver settings in case of conflict. If workstation settings are present, but the driver is not SPI, workstation settings are ignored.

One example where workstation device settings are required when a property or revenue center has a mix of Windows clients that have PEDs directly attached, and Android clients that are paired with network PEDs in Terminal mode:

• For the Windows clients, entering http://localhost:port in the Primary Host of the Payment Driver module is sufficient as each PED communicates with the client on the local host IP address.

• For the Android clients, it is necessary to enter each PED’s IP address individually. An SPI device is added for each Android client, and the only setting entered is the paired PED’s actual URL. When the Android client attempts to process a credit card transaction, the device setting URL will override the Payment Driver setting, and it will communicate with its own paired PED. If this environment is a middleware mode, this configuration is not necessary. In that case, the URL in the Payment Driver points to the middleware host, which in turn looks up the paired PED for the requesting client, and passes the request on.

SPI supports TLS 1.2 with two-way authentication, where server and client exchange certificates. The PSP is responsible for issuing certificates. Another scenario in which workstation devices have to be used for each client is HTTPS with two-way authentication when client certificates are to be issued for each client individually. In that case, the Payment Driver settings reflect the security settings as HTTPS with Certificate Validation, and the Server Certificate’s public key file will be loaded. For each client, a workstation SPI device is created, and the client’s certificate with password is loaded.

Related Topics
• Configuring the SPI Payment Driver
• Configuring Mail Order Telephone Order (MOTO)

OPI Users

If you are currently using the Oracle Payment Interface (OPI), you will not experience changes as the system can run SPI and OPI together at the same property. OPI transaction data remains in the OPI database. If an Enterprise is currently using OPI, you can create an override record at a property or revenue center to configure it to use SPI, while other properties or revenue centers remain on OPI. Only a few settings that were configured on the OPI server are now configured in EMC. If required, client-specific settings (such as the PED’s IP address or client certificates) can be set at each workstation by configuring an SPI device.

The OPI and SPI use the same OPIPayment.dll file.
Related Topics

• Configuring the SPI Payment Driver
• Configuring Mail Order Telephone Order (MOTO)

Pay@Table

Pay@Table is supported by both OPI and SPI. Pay@Table devices continue to connect to the OPI server and use Transaction Services to close the check. The architecture and configuration remains the same. These devices are supported with a LAN connection, but not during LAN failure. If the LAN connection is not available, Pay@Table devices are dependent on the OPI server.

Related Topics

• Configuring the SPI Payment Driver
• Configuring Mail Order Telephone Order (MOTO)

Check Sharing

The SPI supports check sharing if this feature is also supported by the primary service provider.

Related Topics

• Configuring the SPI Payment Driver
• Configuring Mail Order Telephone Order (MOTO)

Configuring the SPI Payment Driver

To add the SPI driver for the first time, or to update an existing property, revenue center, or zone from OPI to using SPI:

1. Select the Enterprise, property, or revenue center, click Setup, and then click Payment Drivers.
   
   If multiple properties exist and you are configuring one property or revenue center to use SPI, select the property or revenue center that will use SPI.

2. Insert a new Payment Driver record named SPI, and then double-click the record to open it.

3. On the General tab, select 26 - Secure DLL Configuration as the Content Type, click Import from a file, browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers\OPIPayment.dll, and then click Open.

4. On the Configuration subtab, enter information in the following fields:

   Table 11-24  Configuration Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the driver (for example, SPI).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter a display name for the driver (for example, SPI).</td>
</tr>
</tbody>
</table>
### Table 11-24  (Cont.) Configuration Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency Code</td>
<td>Enter or verify the existing ISO numeric three-digit currency code for the country. <em>(This value can only be set when SPI Interface = True.)</em></td>
</tr>
<tr>
<td>Enable Quick Chip</td>
<td>Set the value to True when using the quick chip feature. <em>(This value can only be set when SPI Interface = True.)</em> Ensure that your PSP supports quick chip before you enable this feature. Quick chip lets the guest swipe or dip a credit card at the beginning of a fast transaction while the workstation operator enters the menu items. The system must allow fast transactions by enabling option 15 - Allow Fast Transactions in the RVC Parameters module.</td>
</tr>
<tr>
<td>Merchant Number</td>
<td>Enter the Merchant ID.</td>
</tr>
<tr>
<td>Host Timeout</td>
<td>Enter the timeout value in seconds. This is the amount of time that the host waits for a response from the PSP. The default timeout value is 180 seconds.</td>
</tr>
<tr>
<td>Pass Phrase</td>
<td>Leave this field blank for SPI.</td>
</tr>
<tr>
<td>Primary Host</td>
<td>Enter the URL for the PSP endpoint. For example, in Terminal Mode this is <a href="http://PEDIPAddress:Port">http://PEDIPAddress:Port</a>. In Middleware Mode, this is <a href="http://MiddlewareIPAddress:Port">http://MiddlewareIPAddress:Port</a>. If the IP address for each PED is different (network/wireless PEDs in Terminal mode), you need to create workstation devices to enter each POS client's PED's IP address individually. If the Security Settings use HTTPS, ensure that the Primary Host field shows https. This is based on the Security settings below.</td>
</tr>
<tr>
<td>SPI Interface</td>
<td>Set the value to True when using the SPI driver. This is helpful in preparation for an upgrade or switch from OPI to SPI, when you have a property with many POS clients that each require a certificate. While the property is still operating on OPI and the payment driver remains set to SPI Interface = False, each client SPI device can be created and certificates loaded. As long as the payment driver is not set to SPI, the device record is ignored. When the property is ready to switch to SPI, you simply need to set the SPI Interface to True.</td>
</tr>
<tr>
<td>Validate XML Message Against Schema</td>
<td>To validate the format of existing messages that are sent to the PSP against the schema, set the value to True. <em>(This value can only be set when SPI Interface = True.)</em></td>
</tr>
</tbody>
</table>
### Table 11-24  (Cont.) Configuration Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security</td>
<td>You can load the certificate into the payment driver or the workstation device, depending on the communication method and connection between the POS client and the PED. The certificates are installed on the POS clients as part of the DBSync process.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Security Settings</strong>: Select the appropriate option:</td>
</tr>
<tr>
<td></td>
<td>– Use Http Only</td>
</tr>
<tr>
<td></td>
<td>– Use Https with No Certificate Validation</td>
</tr>
<tr>
<td></td>
<td>– Use Https with Certificate Validation (one- or two-way authentication)</td>
</tr>
<tr>
<td></td>
<td>* For one-way authentication, the PSP provides the private key for the server certificates, which must be distributed to all POS clients.</td>
</tr>
<tr>
<td></td>
<td>* For two-way authentication, the client certificates with passwords are also issued by the PSP for each Simphony POS client.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Load Server Certificate</strong>: Click the ellipsis button, select the server certificate, and then click Open.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Load Client Certificate</strong>: Click the ellipsis button, select the client certificate, enter the password when prompted, and then click Open.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Delete Certificates</strong>: To delete a certificate, select Do Not Delete, Delete All Certificates, Delete Server Certificate, or Delete Client Certificate. Confirm with Yes or No.</td>
</tr>
<tr>
<td></td>
<td>The Oracle Hospitality Symphony Security Guide contains more information about the certificates.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Related Topics**

- The Simphony Payment Interface (SPI)
- SPI Architecture
- Payment Driver vs. Workstation Settings
- OPI Users
- Pay@Table
- Check Sharing

### Configuring Mail Order Telephone Order (MOTO)

You need to create the MOTO button on a page, allowing workstation operators to use the MOTO feature with SPI.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.
2. Double-click the transaction page on which you want the MOTO button to appear on the workstation, and insert a new button.
3. On the General tab, select Payment Tenders as the Type, click the right arrow directly beneath the Type drop-down list, select the 0 - None payment record, and then click OK.

4. On the Payment Configuration dialog, select CreditDebit:Loadable from the Payment Type drop-down list.

5. In the Function drop-down list, select CreditAuthAndPay.

6. In the Argument field, enter MOTO, and then click OK.

7. Enter a Legend for the button (for example, MOTO), and then click Save.

Related Topics
• The Simphony Payment Interface (SPI)
• SPI Architecture
• Payment Driver vs. Workstation Settings
• OPI Users
• Pay@Table
• Check Sharing

Third-Party Credit Card Driver Package Distribution

Custom third-party credit card payment device drivers do not automatically install along with the Simphony EMC installation. Consequently, the configuration for the third-party drivers is not available from the EMC. Complete the following tasks to distribute third-party payment device drivers:

• Manually copy the third-party payment .DLL files to the installation directories on the Application Server where Server EMC or Remote EMC is installed. Copying Third-Party Payment Driver Files contains instructions to copy the files to the appropriate directories.

• Create a CAL Package from the EMC for the Third-Party Payment Card Driver Distribution. The Oracle Hospitality Simphony Client Deployment Guide contains information about creating and uploading the CAL package.

Related Topics
• Copying Third-Party Payment Driver Files
• Manually Installing Credit Card Certificates on Workstations

Copying Third-Party Payment Driver Files

1. After you receive the CreditDriverPackage.zip from the third-party vendor, extract it.

2. Copy the CreditCardDrivers2.0 folder from the \CreditDriverPackage\CE directory and place it in the following folders on the Application Server:
   • \MICROS\Simphony2\EgatewayService\CAL\WS5A\Packages
   • \MICROS\Simphony2\EgatewayService\CAL\WS5\Packages

3. Copy the CreditCardDrivers2.0 folder from the \CreditDriverPackage\WIN32 directory and place it in the following folder on the Application Server:
4. Open the CreditCardDrivers2.0 folder in the \MICROS\Simphony2\EgatewayService\CAL\Win32\Packages directory and copy all of the files to the following directories on the Application Server, with the exception of the Setup.dat file. Do not copy the Setup.dat file to these directories.
   - \MICROS\Simphony2\EgatewayService\handlers
   - \MICROS\Simphony\EgatewayService\Download\EMCClient

5. Copy the third-party payment DLL files to the appropriate installation directory on the Application Server where Server EMC or Remote EMC is installed.
   - Server EMC: Copy custom .dll files to \MICROS\Simphony2\EgatewayService\handlers
   - Remote EMC: Copy custom .dll files to \MICROS\EMC\EMCClient

Related Topics
- Third-Party Credit Card Driver Package Distribution

Manually Installing Credit Card Certificates on Workstations

Perform these steps on the POS client workstation running Microsoft Windows 10. Upon completion, the Merchant Link credit card certificate is ready for use on the POS client workstation.

1. Open the Run window from the desktop.
2. In the Open field, enter \mmc, and then click OK.
3. From the Console window, click File, and then select Add/Remove Snap-in.
4. From the Add or Remove Snap-ins window, select Certificates, and then click the Add button.
5. From the Certificates Snap-In dialog, select Computer Account, and then click Next.
6. From the Select Computer dialog, select Local Computer, and then click Finish.
7. Verify that the Add Snap-ins window shows the Certificates snap-in on the right, and then click OK.
8. From the Console window, expand **Certificates (Local Computer)**, and then expand the **Personal** folder.
9. Right-click the **Certificates** folder directly under the Personal folder, select **All Tasks**, and then click **Import**.

10. From the Certificate Import Wizard dialog, verify that the **Store Location** is set to **Local Machine**, and then click **Next**.

11. From the File To Import page, click **Browse**, navigate to the file location where the certificate resides, and then click **Next**. Merchant Link sends a certificate in the .P12 format.

   If your certificate does not appear in the file location, change the **File Type** drop-down list to **All Files**.

12. From the Private key protection page, enter the **Password** provided by Merchant Link that corresponds to the certificate being installed, and then click **Next**. Leave the Import Options at the default settings.

13. From the Certificate Store page, select **Automatically select the certificate store based on the type of certificate**, and then click **Next**.

14. From the Console window verify that the certificate is added to the Personal Store.

   Refresh the page if the certificate does not appear. The Issued To column shows your company name.

15. Expand the Certificates folders to **Trusted Root Certification Authorities** and then **Certificates**. This store includes a Merchant Link Certificate Authority certificate.

**Figure 11-10**  Console Root Trusted Root Certificates
16. Close the MMC Console window.

When closing the window, you are prompted to save the Console. If you save the Console window, you can make modifications to certificates without using the Add / Remove Snap-In windows.


The tool may be included in the credit card driver files distributed by Merchant Link. Older releases of this tool were in the .exe format. Newer releases of the tool are in .msi format.

a. Open a command prompt window as Administrator.

b. Navigate to the location where you saved the WinHttpCertCfg tool, and execute one of the following commands:

```
winhttpcertcfg.exe -g -a users -c "LOCAL_MACHINE\MY" -s "-insert unique customer cert info here-
```

```
winhttpcertcfg.msi -g -a users -c "LOCAL_MACHINE\MY" -s "-insert unique customer cert info here-
```

c. Replace the insert unique customer cert info here with the customer certificate information found in the Personal certificate store (for example, www.your_company_name.com).

**Figure 11-11   Command Prompt**

![Command Prompt](image)

Related Topics

- Third-Party Credit Card Driver Package Distribution

**Credit Card Batching**

Credit card batches are typically created and settled automatically using a PC Autosequence during the Start of Day (SOD) process. You can manually create, edit, and settle credit card batches from the EMC in special situations, such as:

- When the property wants to batch multiple times per day, at various times
Related Topics

• Creating a Credit Card Batch
• Editing a Credit Card Batch
• Settling a Credit Card Batch

Creating a Credit Card Batch

1. Select a property, click Tasks, and then click Create Batch.
2. (Optional) Enter information about the batch you are creating in the Comment field.
3. To create a batch for yesterday’s totals and all dates prior to yesterday, select Yesterday.
4. To create a batch only for today’s totals up to the current time, select Current Totals.
5. To create a batch for the entire property, select All from the Revenue Centers section.
6. To create a batch for the totals of a revenue center, select Selected, and then select a revenue center from the list.
7. To revert the changes that you made and use the default selections, click Default.
8. Click Create.

• Creating a Credit Card Batch
• Settling a Credit Card Batch

Related Topics

• Credit Card Batching

Editing a Credit Card Batch

1. Select a property, click Tasks, and then click Edit Batch.
2. Click Select adjacent to the Batch field, select a batch, and then click Select.
3. To refine the search results, use the Employee, Revenue Center, Card Holder, and Check Number filters.
   The card holder name is often encrypted on the card and is not stored in the Transaction database. Therefore, it is not always possible to use this as a search parameter.
4. Click Search.
5. Click Edit near the relevant credit card record.
6. Make the changes, and then click Save.

• Creating a Credit Card Batch
• Settling a Credit Card Batch
Settling a Credit Card Batch

1. Select a property, click **Tasks**, and then click **Transfer Batch**.
2. Click **Select**, select one or more batches to transfer, and then click **Transfer**.

Related Topics
- Credit Card Batching

Pay@Table

This section describes the brief process in which a guest can pay a check using a tablet device, and an overview for setting up Simphony’s Pay at the Table (Pay@Table) features.

Guests can use Pay@Table on the following handheld devices:
- Oracle MICROS Table E-Series
- Zebra MC40 (formerly the Motorola MC40) mobile device running on the Android mobile operating system and configured with either an integrated or external magnetic card reader.

After a dining room guest or hotel guest places an order, a server or room service staff member presents a tablet device containing the check to the guest, who can:
- View the check
- Add a tip or change the tip value
- Select a different language
- Share payment among several guests
- Charge menu items to a credit card or room account
- Swipe a credit card, or enter a room number and guest last name
- Sign the check with electronic signature after card authorization
- Enter a valid email address and receive a receipt electronically through email

When a guest charges payment to a room account, Simphony posts the total payment to the OPERA property management system (PMS). The front desk manager can view the payment and signature from Pay@Table in:
- Oracle Hospitality Reporting and Analytics using the Check Query and Audit and Analysis portlets
- Oracle Hospitality Simphony Reports

Sales executives can demonstrate Pay@Table features to clients without using a magnetic card or card reader.
Check images, including captured electronic signatures, are available through the Oracle Hospitality Reporting and Analytics Check Query and Audit and Analysis portlets.

Complete the following tasks to set up the Pay@Table feature.

- Configure the Tenders
- Configure the Payment Drivers
- Configure the Payment Modules
- Create Pay at the Table Buttons for the POS Client
- Configure Email Receipts
- Configure Languages

Related Topics

- Configuring a Credit Card Tender
- Configuring Credit Card Voucher Headers and Trailers
- Configuring the Room Charge Tender
- Configuring the OPERA PMS Payment Driver
- Configuring the MICROS Standard Credit Card Payment Module
- Configuring the Loadable PMS Payment Module
- Configuring the Demo Payment
- Creating Pay@Table Buttons
- Configuring Email Receipts

### Configuring a Credit Card Tender

1. Select the Enterprise or property, click **Configuration**, and then click **Tender/Media**.
2. Insert a record and name it based on the credit card company (for example, Visa or MasterCard).
3. Double-click the credit card record to open it.
4. On the **General** tab, select **1 - Payment** from the **Key Type** drop-down list.
5. Click the **Options** tab, and then click the **Printing Options** subtab.
6. Select **8 - Print Customer Receipt** and **21 - Print Summary Totals**.
7. Click the **Ops Behavior** subtab.
8. Select **3 - Assume Paid in Full**.
9. Click **Save**.

- Configuring Credit Card Voucher Headers and Trailers
- Configuring the Room Charge Tender
- Configuring the OPERA PMS Payment Driver
- Configuring the MICROS Standard Credit Card Payment Module
Configuring the Loadable PMS Payment Module

Configuring the Demo Payment

Creating Pay@Table Buttons

Configuring Email Receipts

Related Topics

• Pay@Table

Credit Card Preamble

A credit card preamble—sometimes called a credit card prefix, issuer identification number (IIN), or bank identification number (BIN)—is a digit or series of digits at the beginning of a credit card number that identifies the type of card or company that issued the card.

Adhere to the following rules for governing a valid credit card preamble:

• The Start and End preambles must end with an asterisk (*) (for example, 304*).
• The number of digits in the Start and End fields must be the same.
• The number of digits in the Start and End fields cannot exceed the Length defined.
• The value of the End field must be greater than the value of the Start field.

Related Topics

• Configuring Standard Credit Card Preambles
• List of Standard Credit Card Preambles for the U.S.

Configuring Standard Credit Card Preambles

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Double-click a credit card tender to open it, click the Options tab, and then click the Credit Card Options subtab.

3. In the Preambles section, click Add, and then enter the Start, End, and Length for the preamble.

   If the preamble record defines a range such as 3050 to 3090, the Start field represents the begin range, which is 3050*, and the End field represents the end range, which is 3090*.

   See List of Standard Preambles for the U.S for a list of standard credit card preamble ranges for different card types.

4. To add another preamble for the card, Repeat Step 3.

5. Click Save.

Related Topics

• Credit Card Preamble
• List of Standard Credit Card Preambles for the U.S.
List of Standard Credit Card Preambles for the U.S.

The values listed in the following table apply to all US sites. Additional types are accepted in other countries. Contact the local processor for the specific list. Preambles also change as card providers are bought out (for instance, Discover purchased Diner's Club) and should be updated regularly.

Table 11-25    List of Standard U.S. Credit Card Preambles

<table>
<thead>
<tr>
<th>Card Type</th>
<th>Start</th>
<th>End</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visa</td>
<td>40000000*</td>
<td>49999999*</td>
<td>16</td>
</tr>
<tr>
<td>MasterCard</td>
<td>51000000*</td>
<td>55999999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>222100*</td>
<td>272099*</td>
<td>16</td>
</tr>
<tr>
<td>American Express</td>
<td>34000000*</td>
<td>34999999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>37000000*</td>
<td>37999999*</td>
<td>15</td>
</tr>
<tr>
<td>Diners Club</td>
<td>36000000*</td>
<td>36999999*</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>38000000*</td>
<td>39999999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>30000000*</td>
<td>30599999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>30950000*</td>
<td>30959999*</td>
<td>16</td>
</tr>
<tr>
<td>JCB</td>
<td>35280000*</td>
<td>35899999*</td>
<td>16</td>
</tr>
<tr>
<td>Discover</td>
<td>60110000*</td>
<td>60110999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>60112000*</td>
<td>60114999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>60117400*</td>
<td>60117499*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>60117700*</td>
<td>60117999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>60118600*</td>
<td>60119999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>64400000*</td>
<td>65999999*</td>
<td>16</td>
</tr>
<tr>
<td>Discover (CUP)</td>
<td>62212600*</td>
<td>62292599*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>62400000*</td>
<td>62699999*</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>62820000*</td>
<td>62889999*</td>
<td>16</td>
</tr>
</tbody>
</table>

Related Topics

- Credit Card Preamble
- Configuring Standard Credit Card Preambles

Configuring Manual Entry of Credit Card Numbers

You can enable or disable manual entry of credit card numbers for employees. This feature is supported only with the VisaD payment driver and with third party payment drivers that support it.

1. Select the Enterprise, click Configuration, and then click Roles.
2. Double-click the role type, click the Operations tab, and then click the Miscellaneous subtab.
3. To enable employees with the role to manually enter credit card numbers at the POS client without requiring authorization, select 85 - Authorize/Allow Manual
Entry of Credit Card Numbers. Deselect this option if manual entry of credit card numbers is allowed for employees with the role, but requires authorization.

4. Click **Save**.

Configuring Credit Card Authorization to Print Merchant Vouchers and Customer Receipts

You can configure the printing of credit card vouchers when workstation operators press the **Credit Card Authorization** function key on the POS client. Complete the steps below to allow the following items to print:

- Merchant voucher (for cardholder signature)
- Customer receipt

Confirm the cardholder signature verification with your Payment Service Processor (PSP) before configuring Quick Service Limits. Cardholder signature verification prompts are forced by the PSP, and may appear for every transaction, even if the property is configured to not print merchant vouchers below a certain amount. This could leave a property in a situation where no signature is present, but the workstation operator is prompted to verify it.

1. Select the Enterprise or property, click **Configuration**, and then click **Tender/Media**.

2. Click the **Printing Options** tab, and then select the following options:
   - 8 - Print Customer Receipt
   - 54 - Print 2 Guest Checks/Receipts

3. Click **Save**.

4. Repeat Steps 1 through 3 for each credit card tender record.

If multiple properties exist and each property has different credit card tenders (not inherited from the Enterprise), you will need to configure the printing options separately for each property.

5. Select the revenue center, click **Setup**, and then click **RVC Parameters**.

6. Click the **CA/EDC** tab (Credit Card Authorization/Electronic Draft Capture), and then select **7 - Print Two Credit Card Vouchers**.

7. Click **Save**.

Configuring Credit Card Voucher Headers and Trailers

Credit card headers and trailers are leading and trailing lines that print on credit card vouchers.

1. Select the Enterprise or revenue center, click **Descriptors**, and then click either **Credit Card Headers** or **Credit Card Trailers**.

2. In the Text column, enter the text to appear on the header or trailer in the rows.

3. To insert a logo for the header or trailer, select a check box from the **Use Logo** column, and then select a logo using the ellipsis point (...) button in the **Logo** column.
Configuring the Room Charge Tender

Configure a room charge tender for guests to charge meals to a hotel room using Oracle Hospitality OPERA.

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.
2. Insert a record and name it PATT Room Charge.
3. Double-click the PATT Room Charge record to open it.
4. On the General tab, select 1 - Payment from the Key Type drop-down list.
5. Click the Options tab, and then click the Interface Options subtab.
7. Click Save.

Related Topics
- Pay@Table
Configuring the OPERA PMS Payment Driver

To configure the Oracle Hospitality OPERA 5 Hotel Property Systems payment driver:

1. Select the Enterprise, property, or revenue center, click Setup, and then click Payment Drivers.
2. Insert a record, enter OPERA PMS Driver as the name, and then click OK.
3. Double-click the record to open it.
4. On the General tab, click the Import from a file link.
5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select OperaWSPayment.dll, and then click Open.
6. Click the Configuration tab.
7. From the Assembly/Class section, enter information in the following fields:

   Table 11-26   Assembly/Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the payment driver (for example, PMS posting driver for OPERA).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name of the PMS driver (for example, OPERAPMS). This value appears in the Driver drop-down list.</td>
</tr>
<tr>
<td>Driver ID</td>
<td>Enter OPERAPMS.</td>
</tr>
</tbody>
</table>

8. From the Opera Interface Properties section, enter information in the following fields:

   Table 11-27   Opera Interface Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection String</td>
<td>Enter jdbc / operaoperads.</td>
</tr>
<tr>
<td>Interface ID</td>
<td>Enter the OPERA interface ID.</td>
</tr>
<tr>
<td>Opera Tender Number</td>
<td>Enter the Tender/Media object number mapped for the Room Charge.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Posting Format</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Encoded</strong>: Select to post to OPERA with encoded format in the XML request. The Encoded format is used for backward compatibility. Use this format with OPERA version 5.0.04.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Literal or Empty (by default)</strong>: Select to post to OPERA with plain text format. The room charge will post to OPERA with Literal format in the XML request. Use this format with OPERA version 5.0.05.</td>
</tr>
<tr>
<td>Resort</td>
<td>Enter the name of the property using OPERA.</td>
</tr>
</tbody>
</table>
Table 11-27  (Cont.) Opera Interface Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UserName</td>
<td>Enter the user name.</td>
</tr>
<tr>
<td>Web Service</td>
<td>Enter the URL of the OPERA Web Service.</td>
</tr>
</tbody>
</table>

9. Click **Save**.

- Configuring a Credit Card Tender
- Configuring Credit Card Voucher Headers and Trailers
- Configuring the Room Charge Tender
- Configuring the MICROS Standard Credit Card Payment Module
- Configuring the Loadable PMS Payment Module
- Configuring the Demo Payment
- Creating Pay@Table Buttons
- Configuring Email Receipts

**Related Topics**

- Pay@Table

---

### Configuring the MICROS Standard Credit Card Payment Module

1. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Payments**.
2. Insert a record and name it based on the payment driver you are using (for example, MCreditDebit).
3. Double-click the record to open it.
4. Select **3 - DLL** from the **Content Type** drop-down list.
5. Click the **Import from a file** link.
6. Browse to `[Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers\Micros.Payment.MCreditDebit.dll`, and then click **Open**.
7. Click the **Configuration** subtab.
8. From the Assembly/Class section, enter information in the following fields:

**Table 11-28  Assembly/Class Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Enter a description for the payment driver (for example, MicrosCreditDebitPaymentModuleStandard).</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the payment driver (for example, Micros Standard Credit/Debit Payment Driver).</td>
</tr>
</tbody>
</table>
9. From the Common Properties section, enter information in the following fields:

**Table 11-29  Common Properties Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Manual Authorization Credit Card</td>
<td>Select True for processors using the MICROS standard credit and debit payment driver. This field indicates whether manual authorization of credit cards is allowed.</td>
</tr>
<tr>
<td>Allow Partial Settlement On Batch</td>
<td>Select False for processors using the MICROS standard credit and debit payment driver.</td>
</tr>
<tr>
<td>Bank Identification Number</td>
<td>Enter the six-digit bank identification number provided by the bank or processor.</td>
</tr>
<tr>
<td>Batch Number</td>
<td>Enter a value between 1 and 9999 to indicate the next sequence number. The number increments by one each time a new batch is created, and resets to 1 after reaching 9999. The bank or processor assigns the value for this field and uses it to detect duplicate batches.</td>
</tr>
<tr>
<td>Do Not Batch</td>
<td>Select False for processors using the MICROS standard credit and debit payment driver. This field indicates whether batch creation and settlement occurs within Simphony.</td>
</tr>
<tr>
<td>Encrypt Data</td>
<td>Select True for processors using the MICROS standard credit and debit payment module.</td>
</tr>
<tr>
<td>Host Timeout</td>
<td>Enter the timeout value in seconds. Setting the value to 0 (zero) equals a 30-second timeout. Do not leave this field blank. Oracle recommends entering 60. This field applies only to Win32 devices. You cannot change the timeout from the default setting of 100 seconds on WinCE devices.</td>
</tr>
<tr>
<td>Merchant Number</td>
<td>Enter the merchant number provided by the bank or processor.</td>
</tr>
<tr>
<td>Offline Authorizations</td>
<td>Enter the number of offline card authorizations allowed before the application attempts to re-establish online communication.</td>
</tr>
<tr>
<td>Primary Host</td>
<td>Enter the URL of the payment provider application. For example, this field should include something.receiving-url.com. For Merchant Link, enter g1.merchantlink.com.</td>
</tr>
<tr>
<td>Primary Host Port</td>
<td>Enter the port number used for the Primary Host. For Merchant Link, enter 443.</td>
</tr>
<tr>
<td>Prompt for Manual Card Data Entry</td>
<td>Select True for processors using the VisaD driver. This field indicates whether workstation operators can manually enter a card number.</td>
</tr>
<tr>
<td>Retry Authorization Reversals On Batch</td>
<td>Select False for processors using the MICROS standard credit and debit payment module.</td>
</tr>
<tr>
<td>Run As Service</td>
<td>Select False for processors using the MICROS standard credit and debit payment module.</td>
</tr>
</tbody>
</table>
### Table 11-29  (Cont.) Common Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Store Number</td>
<td>Enter the 4-digit store identification number used to identify the merchant store. The bank or processor assigns the value for this field.</td>
</tr>
<tr>
<td>Terminal Number</td>
<td>Enter the workstation number at the merchant store.</td>
</tr>
<tr>
<td>Manual Card Data Entry Retries</td>
<td>Enter the number of times a workstation operator can attempt to manually enter a card number. Oracle Hospitality recommends entering 5. The minimum value is 1.</td>
</tr>
<tr>
<td>VisaQ Compatibility</td>
<td>Select <strong>False</strong> for processors using the MICROS standard credit and debit payment driver.</td>
</tr>
</tbody>
</table>

**10.** If you are using the VisaD driver, enter information in the VisaD Driver Specific section fields:

### Table 11-30  VisaD Driver Specific Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Bank Number</td>
<td>Enter a six-digit number that identifies the Agent Bank Number. This value identifies the agent of the acquirer which signed the merchant. The acquirer provides this value to the merchant.</td>
</tr>
<tr>
<td>Agent Chain Number</td>
<td>Enter a six-digit number that identifies the Agent Chain Number. This value identifies a specific chain of an agent organization. The merchant’s bank or processor provides this number.</td>
</tr>
<tr>
<td>City Code</td>
<td>Enter the city code that identifies the merchant’s location. Within the United States, enter the five or nine-digit postal code of the merchant’s address. In other countries, the bank or processor assigns the code.</td>
</tr>
<tr>
<td>Country Code</td>
<td>Select the country that identifies where the merchant is located. The bank or processor assigns the value for this field. The United States country code is 840.</td>
</tr>
<tr>
<td>Currency Code</td>
<td>Select the currency that the merchant uses. The bank or processor assigns the value for this field. The United States currency code is 840.</td>
</tr>
<tr>
<td>Enable Card Level Results</td>
<td>Select <strong>True</strong> to have the VisaD driver retrieve card-level results during authorization and return the data at settlement.</td>
</tr>
<tr>
<td>Enable POS Data Code</td>
<td>Select <strong>True</strong> to have the VisaD driver report the POS Data Code at authorization and settlement.</td>
</tr>
<tr>
<td>Include Exp Date And Extra Mag Card Data</td>
<td>Select <strong>True</strong> to include the expiration date and modified magnetic stripe reader data during settlement.</td>
</tr>
<tr>
<td>Industry Type</td>
<td>Select a value to identify the industry type to the merchant. The bank or processor assigns the value for this field.</td>
</tr>
</tbody>
</table>
### Table 11-30 (Cont.) VisaD Driver Specific Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language Indicator</td>
<td>Enter the language in which Authorization Response messages should be returned to the workstation for display and printing. The bank or processor assigns the value for this field.</td>
</tr>
<tr>
<td>Max Batch Records</td>
<td>Enter the maximum number of records that can be transferred in one batch (for example, 9999). Some banks and driver types can support only a specific number of records during credit card settlement. When you enter 0 (zero), all records are processed in the same batch.</td>
</tr>
<tr>
<td>Merchant Category</td>
<td>Enter the four-digit number assigned by the bank or processor to identify the merchant type.</td>
</tr>
<tr>
<td>Merchant Location</td>
<td>Enter the merchant location or city name provided by the bank or processor. For auditing purposes, the Merchant Location should correspond to the location or city that prints on a credit card voucher.</td>
</tr>
<tr>
<td>Merchant Name</td>
<td>Enter the merchant’s name. For auditing purposes, the Merchant Name should correspond to the name that prints on a credit card voucher.</td>
</tr>
<tr>
<td>Merchant State</td>
<td>Enter the merchant’s state or province code provided by the bank or processor. For auditing purposes, the Merchant State should correspond to the state or province code that prints on a credit card voucher.</td>
</tr>
<tr>
<td>Request URI</td>
<td>If applicable, enter the uniform resource identifier (URI) to use when sending VisaD messages to the processor. For Merchant Link, enter /Micros/process_transaction.cgi.</td>
</tr>
<tr>
<td>Secondary Host</td>
<td>Enter the URL of the secondary host. For example, this field should include something.receiving-url.com. For MerchantLink, enter g2.merchantlink.com.</td>
</tr>
<tr>
<td>Secondary Host Port</td>
<td>Enter the port number used for the Secondary Host. For Merchant Link, enter 443.</td>
</tr>
<tr>
<td>Send RFID Data</td>
<td>Select True to add RFID-related fields to the message. Some processors require this information to authorize and settle RFID transactions.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Select the code used to calculate the local time within the VisaNet Authorization System. The bank or processor assigns the value for this field.</td>
</tr>
</tbody>
</table>

11. Click Save.

- Configuring a Credit Card Tender
- Configuring Credit Card Voucher Headers and Trailers
- Configuring the Room Charge Tender
- Configuring the OPERA PMS Payment Driver
- Configuring the Loadable PMS Payment Module
- Configuring the Demo Payment
Configuring the Loadable PMS Payment Module

Configure a property management system (PMS) payment module for guests to charge meals to a hotel room using Oracle Hospitality OPERA version 5.0.04.01 and later.

1. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Payments**.
2. Insert a record and name it **LoadablePMS**.
3. Double-click the LoadablePMS record to open it.
4. Click the **Import from a file** link.
5. Browse to \\[Drive Letter\\]:\MICROS\Simphony2\EgatewayService\handlers\Micros.Payment.LoadablePmsModule.dll, and then click **Open**.
6. Click the **Configuration** subtab.
7. Select the **Module Functions** section.
8. Enter the **Configuration Number** for the Room Charge tender record.
9. Select **Payment** as the **Configuration Type**.
10. Click **Save**.

Related Topics
- Configuring a Credit Card Tender
- Configuring Credit Card Voucher Headers and Trailers
- Configuring the Room Charge Tender
- Configuring the OPERA PMS Payment Driver
- Configuring the MICROS Standard Credit Card Payment Module
- Configuring the Demo Payment
- Creating Pay@Table Buttons
- Configuring Email Receipts

Configuring the Demo Payment

Sales executives can use demo mode to demonstrate Pay@Table features to customers without needing a magnetic card or reader.

1. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Payments**.
2. Insert a record for demo payments (for example, Demo).
3. Double-click the record to open it.

4. Select 3 - DLL from the **Content Type** drop-down list.

5. Click the **Import from a file** link.

6. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers \Micros.Payment.CreditDebit.dll, and then click **Open**.

7. Click **Save**.

8. Create Pay@Table buttons. See Creating Pay@Table Buttons for more information.

- Configuring a Credit Card Tender
- Configuring Credit Card Voucher Headers and Trailers
- Configuring the Room Charge Tender
- Configuring the OPERA PMS Payment Driver
- Configuring the MICROS Standard Credit Card Payment Module
- Configuring the Loadable PMS Payment Module
- Creating Pay@Table Buttons
- Configuring Email Receipts

**Related Topics**
- Pay@Table

**Creating Pay@Table Buttons**

Depending on the property's Pay@Table payment methods, you need to create the following buttons for the POS client page:

- **PATT Credit Card**: Create this button if the property allows credit card payments with Pay@Table.
- **PATT Room Charge**: Create this button if the property allows room charges with Pay@Table.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Open the page on which to place Pay@Table buttons.

3. On the **Edit** tab, select the page area in which to define the Pay@Table functions (typically the payment area).

4. Click **Button**.

5. On the **General** subtab, enter the button name in the **Legend** field.

6. Select **Function** from the **Type** drop-down list.

7. Click the black arrow directly beneath the **Type** drop-down list, and then select **Pay at the Table**.

8. Highlight the Pay@Table button.

9. Click the **Pay at the Table Config** button.
10. (Optional) Select **Enable Tip Screen**, and then enter the **Default Tip Percent** value. The tip percentage appears to the guest. To hide the tip screen from guests, deselect **Enable Tip Screen**.

11. (Optional) Select **Enable Share Payment**, and then enter the **Default Share Payment** group sizes (for example, 2, 3, 4). This is the default number of people that can share the payment. (If a different number of people want to share payment, the guest can enter the number.) Deselect **Enable Share Payment** to prevent guests from sharing the check payment.

12. (Optional) To use Pay@Table in demonstration mode, select **Demo Payment**. This allows sales executives to demonstrate Pay@Table features to clients without needing a magnetic card or reader. Deselect **Demo Payment** to use Pay@Table live at a property.

13. In the Select Payment Type area, select the payment type (for example, Credit Card or OPERA) from the **Payment Type** drop-down list.

14. Click the **Edit Command** link in the Command column.

15. From the Payment Configuration dialog, select the appropriate payment method from the **Type** drop-down list.

16. Click **Edit...**, and then enter the appropriate **Command**. The following table lists the Types and associated Commands.

**Table 11-31 Pay@Table Payment Methods**

<table>
<thead>
<tr>
<th>Type</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credit Card</td>
<td>CreditDebit:MCreditDebit: MICROS standard credit and debit drivers for credit card charges</td>
</tr>
<tr>
<td>Credit Card Other</td>
<td>CreditDebit:Loadable: Loadable credit and debit drivers for credit card charges</td>
</tr>
<tr>
<td>Opera</td>
<td>Other1:LoadablePms: Loadable property management system driver for room charges</td>
</tr>
</tbody>
</table>

17. If the payment type is a credit card, select **CreditAuthAndPay** from the **Functions** drop-down list, and then click **OK**.

18. Position and size the button on the page. Use the Style arrow to change the color.

19. Click **Save**.

20. Repeat Steps 1 through 19 for each Pay@Table button.

- Configuring a Credit Card Tender
- Configuring Credit Card Voucher Headers and Trailers
- Configuring the Room Charge Tender
- Configuring the OPERA PMS Payment Driver
- Configuring the MICROS Standard Credit Card Payment Module
- Configuring the Loadable PMS Payment Module
- Configuring the Demo Payment
- Configuring Email Receipts
Configuring Email Receipts

1. Select the property, click Setup, and then click Property Parameters.
2. On the General tab, click the Primary SMTP Server subtab.
3. Enter information in the fields as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Enter the email server or service to use. Click Select to choose from the SMTP Server list of commonly used mail servers (for example, Outlook, Gmail, or Yahoo).</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port number for the SMTP email server. A default port of 587 works for most SMTP servers.</td>
</tr>
<tr>
<td>SSL</td>
<td>Select this option to require secure Internet communication.</td>
</tr>
<tr>
<td>User Name</td>
<td>Enter the user name of the email address that will send receipts.</td>
</tr>
<tr>
<td>Password, Confirm Password</td>
<td>Enter the password associated with the email user name.</td>
</tr>
<tr>
<td>Source Email</td>
<td>Enter the full email address to appear as the sender in the emailed receipt. Depending on the SMTP server, this may not create a copy of emails sent.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter the business name or sender name to appear along with the email in the sender field. Depending on the SMTP server, this value may or may not appear in the sent email (for example, Username = jsmith Name = John could appear as: John<a href="mailto:jsmith@oracle.com">jsmith@oracle.com</a>).</td>
</tr>
<tr>
<td>BCC List</td>
<td>Enter the email addresses to receive a blind carbon copy of the email receipt that is sent to the guest. Oracle recommends that you list the source email in the BCC field so you can resend copies of email receipts later if necessary.</td>
</tr>
</tbody>
</table>

4. Click the Send Test Email button to send a test email receipt message to the source email address. A confirmation appears after the email is successfully sent.
5. Click the Backup SMTP Server subtab.
6. Configure the Backup SMTP Server with the same settings as the Primary SMTP Server or an alternate server from which to send emails in the event the primary server becomes unavailable.
7. Click the **Text Formatting** subtab, and then enter information in the following fields:
   - **Email Subject**: Enter text in rich text format to appear as the subject line of email receipts.
   - **Email Body**: Enter text in rich text format to appear as the body of email receipts. You must include @@Check in the body in order to send a copy of the receipt.

8. Click the **HTML Formatting** subtab, and then enter information in the following fields:
   - **Email Subject**: Enter text in HTML format as the subject line of email receipts.
   - **Email Body**: Enter text in HTML format as the body of email receipts. You must include @@Check in the body in order to send a copy of the receipt.

9. Select the **Send Html Email** check box to dim the Text Formatting tab and send only the HTML format. Deselect this option to dim the HTML Formatting tab and send only the text formatted email.

10. Click **Save**.

### Related Topics
- Configuring a Credit Card Tender
- Configuring Credit Card Voucher Headers and Trailers
- Configuring the Room Charge Tender
- Configuring the OPERA PMS Payment Driver
- Configuring the MICROS Standard Credit Card Payment Module
- Configuring the Loadable PMS Payment Module
- Configuring the Demo Payment
- Creating Pay@Table Buttons

### Autosequence Events

You can set up automatic event tasks, such as running Start of Day (SOD) and nightly credit card batching, using the PC Autosequence feature. After you create an automatic event, you can schedule it to run repeatedly at specific frequencies or time intervals.

To set up an automatic event, you must configure the Autosequence Event and the Autosequence Event Schedule.

### Related Topics
- Configuring Autosequence Events
- Configuring the Autosequence Event Schedule
Configuring Autosequence Events

1. Select the Enterprise level, click **Configuration**, and then click **PC Autosequences**.
2. Insert a record for the autosequence event (for example, Nightly Batch). If the autosequence event record exists, skip this step.
3. Double-click the record to open it.
4. On the **General** tab, select each **Property** to include in the autosequence event run.
5. **(Optional)** Select the employee group that is allowed to run the autosequence event from the **Privilege Group** drop-down list.
6. **(Optional)** To restrict execution of the autosequence event, click the **Add** link from the Parameters section, and then add optional parameters.
7. Click the **Steps** tab.
8. Beneath the Steps section, click the **Add** link to add the first step of the autosequence event.
9. From the Step Parameters section, select the **Step Type** from the drop-down list.
10. Repeat Steps 9 and 10 to add each step required to run the autosequence event.
11. Select the outcome for each step:
    - **Step on Success**: Select the step number to occur next if a step succeeds. For example, after Step 1 runs successfully, proceed to Step 2.
    - **Step on Failure**: Select the step number to occur next if a step fails. For example, if Step 1 fails, do no proceed with any steps.
12. Click **Save**.

- **Configuring the Autosequence Event Schedule**

**Related Topics**
- **Autosequence Events**

Configuring the Autosequence Event Schedule

1. Select the Enterprise level, click **Configuration**, and then click **PC Autosequence Schedules**.
2. Insert a record for the autosequence schedule (for example, Nightly Batch). If the autosequence schedule record exists, skip this step.
3. Double-click the record to open it.
4. On the **General** tab, enter information in the following fields:
### Table 11-33 General Settings Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autosequence</td>
<td>Select the autosequence event from the drop-down list.</td>
</tr>
<tr>
<td>Server Name</td>
<td>Enter the name of the server located at the Enterprise level or Hosting Center.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Select the time zone of the Enterprise level or Hosting Center.</td>
</tr>
<tr>
<td>Schedule Type</td>
<td>Select the frequency for the autosequence event.</td>
</tr>
<tr>
<td>Duration</td>
<td>Select <strong>Enabled</strong> for the autosequence event to run. Select the <strong>Start</strong> and <strong>End dates</strong> for the autosequence event.</td>
</tr>
</tbody>
</table>

5. Click the **Recurrence** tab.

6. From the **Daily** section, enter the number of days for the autosequence event to reoccur. For example, to run the event daily, set this value to **Every 1 day(s)**.

7. From the **Daily Frequency** section, set the time or times for the autosequence event to run.

8. Click **Save**.

- **Configuring Autosequence Events**

**Related Topics**

- **Autosequence Events**
Taxes

A tax is a sum of money imposed by a government, levied upon prepared food and beverages sold in a restaurant. The following table explains the Simphony methods of taxation:

Table 12-1  Tax Methods

<table>
<thead>
<tr>
<th>Tax Method</th>
<th>Description</th>
</tr>
</thead>
</table>
| Value Added Tax (VAT)       | A VAT is a form of sales tax used in some countries. VAT is an inclusive tax, which means the tax is included in the menu item price. The global tax type can be set as European or United States. A VAT is calculated differently, depending on the global setting. In Europe, only inclusive type tax is calculated. In the United States, inclusive type tax and add-on type tax can be used at the same time. VAT inclusive taxes are broken out from sales totals on financial related reports (for example, Revenue Center Financial Report or System Financial Report), with the inclusive tax reflected in the Tax Collected totals field. If your property uses VAT, the following Reporting and Analytics templates can be applied for the Open/Closed Check reports:
  • EAME_MMRevCtrOpenChecks_VAT
  • EAME_MMRevCtrClosedChecks_VAT |
| U.S. Inclusive Tax          | U.S. inclusive tax uses the item price and a percent value to calculate the tax amount. The tax is then included in the price of each menu item not added to the bill. For example, if the tax rate is 5% and the item price is $5.00, the inclusive tax method calculates by the formula: $5.00/(1+5%) = $4.76. The total cost for the customer remains $5.00, but the net sales price is $4.76 and the tax is $0.24. If U.S. inclusive tax is used, only one inclusive tax rate can be applied to a menu item. U.S. inclusive taxes do not appear on the Open Check Report in Reporting and Analytics, and do not print on Open/Closed Check reports. Additionally, inclusive taxes are broken out from net sales totals on financial related reports (for example, Revenue Center Financial Report or System Financial Report), with the inclusive tax reflected in the Tax Collected totals field. |
| Add-on Tax                  | Add-on tax uses the item price to calculate tax, which is then added to the bill. For example, if the tax rate is 5% and the item is $5.00, the application calculates 5% of $5.00, posting $0.25 tax to the check and making the total due of $5.25. |
Table 12-1  (Cont.) Tax Methods

<table>
<thead>
<tr>
<th>Tax Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakpoint or Threshold Tax</td>
<td>Breakpoints establish the points at which an increase of one cent in sales increases tax by one cent. For example, a breakpoint tax might be one percent for sales from zero to twenty cents and then two percent from twenty-one to forty cents. Twenty cents would be the breakpoint for this tax.</td>
</tr>
</tbody>
</table>

- Tax Rates and Tax Classes
- Configuring Tax Rates and Classes
- Tax Parameters
- Configuring Tax Parameters
- Tax Labels
- Configuring Tax Labels
- Serving Periods
- Configuring a Serving Period
- Order Types
- Configuring Order Types
- Configuring Order Types as Subtotal Keys
- Configuring Touchscreen Buttons for Order Types
- Printing Tax Rate Per Item
- Configuring Tax Rates Per Item to Print on Guest Check, Customer Receipt and Journal
- Configuring Workstation Number and Transaction Number to Print on Guest Check, Customer Receipt, and Journal
- Surcharges
- Configuring Surcharges
- Configuring the Menu Item Tax Class Override

Tax Rates and Tax Classes

Simphony uses tax rates and tax classes to assign taxes to menu items, discounts, and service charges.

A tax rate is the percentage at which taxes are paid to a government. In some jurisdictions, multiple tax rates apply. Usually these tax rates must be calculated separately for accounting purposes (allowing each jurisdictional government to collect the appropriate tax amount).

A tax class is a collection of tax rates. Tax classes determine the tax rates that apply to menu items and service charges, and which tax rates can be reduced by discounts. Consider the following example: 2% City Tax Rate + 4% State Tax Rate = 6% Sales Tax (tax class which contains two tax rates). In this example, both the city and state tax
rates are active for the Sales tax class. The total sales tax is 6%. By grouping multiple tax rates into a single tax class, you can view a record named Sales Tax.

You can associate a tax class with the following types of records:

- **Menu Item Class**: All menu item definitions in the menu item class are taxed using the tax class.
- **Discount**: When you assign a tax class to a discount, the taxes linked to the tax class are recalculated when the discount is applied using the reduced taxable sales value.
- **Service Charge**: Some types of service charges are taxed, such as banquet and room service transactions.

For server convenience, bars often use inclusive taxes. In some properties with multiple revenue centers, it is common that a bar revenue center uses inclusive taxes while a restaurant revenue center uses add-on taxes, even though both revenue centers serve the same items. In this scenario, the configuration of a Liquor tax class might be:

- Inclusive tax rate – 5%
- Add-on tax rate – 5%

Using this scenario, you can set either order types or serving periods to have the appropriate tax rates in the revenue centers. The following table shows an example configuration using Order Types:

### Table 12-2  Example of Inclusive Tax with Multiple Revenue Centers

<table>
<thead>
<tr>
<th>Revenue Center</th>
<th>Order Type Tax Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar</td>
<td>• Inclusive tax rate enabled</td>
</tr>
<tr>
<td></td>
<td>• Add-on tax rate disabled</td>
</tr>
<tr>
<td>Restaurant</td>
<td>• Inclusive tax rate disabled</td>
</tr>
<tr>
<td></td>
<td>• Add-on tax rate enabled</td>
</tr>
</tbody>
</table>

Related Topics

- [Configuring Tax Rates and Classes](#)

### Configuring Tax Rates and Classes

1. Select the Enterprise, property, or zone, click **Setup**, and then click **Tax Rates**.
2. Locate the appropriate tax rate. There are 64 active tax rates.
3. Select the tax rate type from the **Type** drop-down list. The following table describes the tax types:

### Table 12-3  Tax Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - Disabled Tax Rate</td>
<td>Select this option if the tax rate is not used.</td>
</tr>
<tr>
<td>1 - Add On, Breakpoint</td>
<td>Select this option to calculate the add-on tax using the Breakpoint method.</td>
</tr>
</tbody>
</table>
Table 12-3  (Cont.) Tax Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 - Add On, Percentage</td>
<td>Select this option to calculate the add-on tax using the tax percentage rate.</td>
</tr>
<tr>
<td>3 - Included, Percentage</td>
<td>Select this option to calculate the inclusive tax using the tax percentage rate to determine what portion of the sales price is the tax. The inclusive tax applies differently depending on the global VAT (European or United States). Because the tax is included in the price, the tax is backed out of gross sales on reports.</td>
</tr>
<tr>
<td>4 - Surcharge</td>
<td>Select this option to calculate surcharges for items.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

5. Select the Enterprise, property, or zone, click **Setup**, and then click **Tax Classes**.

6. Insert a tax class record with the appropriate name (for example, Soda Tax, Liquor Tax, or Surcharge).

7. From the **Taxes Enabled** field, select the applicable tax rates, and then click **OK**. The tax rates you select are active for the tax class.

8. Click **Save**.

**Related Topics**
- **Tax Rates and Tax Classes**

**Tax Parameters**

The Tax Parameters module enables you to configure options related to taxes. You can configure the Tax Parameters module at the property, zone, or revenue center levels. **Configuring Tax Parameters** contains more information.

The following tables list all tax parameter options.

**Table 12-4  Tax Parameters International Options**

<table>
<thead>
<tr>
<th>International Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 – ON = Apply Tax as Add-On; OFF = Apply Tax as VAT</td>
<td>Select this option to treat taxes as add-on. Deselect this option to treat taxes as a value added tax (VAT). If you enable VAT, all tax rates in use must be type <strong>Included, Percentage</strong>.</td>
</tr>
</tbody>
</table>
### Table 12-4 (Cont.) Tax Parameters International Options

<table>
<thead>
<tr>
<th>International Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 - Print Tax Itemizers</td>
<td>Select this option to print tax itemizers on guest checks and receipts. An itemizer is considered a bucket that holds the sale amount of all items taxed at a specific rate. At the end of a transaction, the tax is applied to the subtotal of all items in the bucket. Menu Item Classes are linked to Tax Classes, which in turn, are linked to Tax Rates 1-64. When you link to a tax rate, you are creating an itemizer bucket for that item. You must enable this option for Philippine tax.</td>
</tr>
<tr>
<td>4 - Enable Canadian GST</td>
<td>Select this option to enable Canadian Goods and Services Tax (GST).</td>
</tr>
<tr>
<td>6 - Enable Thailand Tax Printing</td>
<td>Select this option to enable Thai tax options.</td>
</tr>
<tr>
<td>13 - Truncate Inclusive Taxes</td>
<td>This option applies to all inclusive tax calculations. It determines whether the inclusive tax amount that is calculated is rounded or truncated. For example, if a currency has two decimal places and the tax calculated is 12.005, the rounded tax is 12.01, but the truncated tax is 12.00.</td>
</tr>
<tr>
<td>14 - Print Item Inclusive Tax Total</td>
<td>If the check contains items with inclusive taxes, this option enables the total inclusive tax to print on the guest check. The line prints according to Tax Parameters option 4 - Print Inclusive Tax Totals when 0.00. The inclusive tax amount is the sum of the inclusive taxes for each item on the check. You must also select Tender/Media Printing Options 21 - Print Summary Totals and 24 - Print Inclusive Tax or VAT Lines on Check or Receipt for the inclusive tax totals to print.</td>
</tr>
<tr>
<td>15 - Print Check Inclusive Tax Total</td>
<td>If the check contains items with inclusive taxes, this option enables the total inclusive tax to print on the guest check. The line prints according to Tax Parameters option 4 - Print Inclusive Tax Totals when 0.00. The inclusive tax amount is calculated on the total sales for each tax rate. You must also select Tender/Media Printing Options 21 - Print Summary Totals and 24 - Print Inclusive Tax or VAT Lines on Check or Receipt for the inclusive tax totals to print.</td>
</tr>
<tr>
<td>16 - Print Tax Rate per item</td>
<td>Select to print the applied tax rates for each menu item on guest checks, customer receipts, and the journal.</td>
</tr>
<tr>
<td>17 - Enable Tax Labels</td>
<td>Select to consolidate tax reporting information based on the defined Tax Labels configured under Tax Rates.</td>
</tr>
</tbody>
</table>
Table 12-5  Tax Parameters Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Do Not Include Tax in Totals on Tip Reports</td>
<td>Select this option to prevent a transaction's calculated tax amount from posting to the gross receipts and charged receipts totals on tip reports.</td>
</tr>
<tr>
<td>2 - Require a Reference Entry with Tax Exemptions</td>
<td>Select this option to require workstation operators to enter a reference entry when using an exempt tax function key.</td>
</tr>
<tr>
<td>3 - Print Inclusive Tax Lines Before Summary Totals</td>
<td>Select this option to print inclusive tax total before summary totals on guest checks and customer receipts.</td>
</tr>
<tr>
<td>4 - Print Inclusive Tax Totals when 0.00</td>
<td>Select this option to print inclusive totals on guest checks and customer receipts even if the calculated tax due is 0.00.</td>
</tr>
<tr>
<td>5 - Print Consolidated VAT Line on Checks and Customer Receipts</td>
<td>Select this option to print a consolidated VAT line. If you use this option in conjunction with individual VAT line printing, the consolidated line prints last.</td>
</tr>
<tr>
<td>6 - Print VAT Net Totals on Guest Checks and Customer Receipts</td>
<td>Select this option to print a VAT Net Totals line on guest checks and customer receipts.</td>
</tr>
<tr>
<td>7 - Print Tax Exempt Voucher</td>
<td>Select this option to print a voucher when any tax is exempted. The voucher prints when a tax exempt function key or a tender exempts tax. The voucher prints at the validation printer designated for the workstation. Deselect this option to suppress printing of a tax exempt voucher.</td>
</tr>
<tr>
<td>8 - Post Taxable Sales When the Tax Rate is Zero</td>
<td>Select this option to have taxable sales post to the TAX_DAILY_TOTAL table in Reporting and Analytics when the tax rate is set to 0.00%. The taxable amounts can be used for reporting even though there are no applied taxes. Deselect this option so that taxable sales do NOT post to Reporting and Analytics when the tax rate is set to 0.00%.</td>
</tr>
</tbody>
</table>

Related Topics

- Configuring Tax Parameters

Configuring Tax Parameters

**Tax Parameters** contains a list of all tax parameter options.

1. Select the property, zone, or revenue center, click the **Setup** tab, and then click **Tax Parameters**.
2. Click the **International Options** tab, enable the appropriate options, and then click **Save**.
3. Click the **Options** tab, enable the appropriate options, and then click **Save**.
4. To set printing lines for the appropriate tax rates, select the **VAT Options**, and then click **Save**.

**Related Topics**
- **Tax Parameters**

### Tax Labels

Setting tax labels allows you to perform the following actions:
- Define up to two tax labels and associate each of them with a specific tax rate
- Associate multiple tax rates with the same tax labels
- Associate a blank tax label with tax exempt items (considered non-value-added tax (VAT))

**Related Topics**
- **Configuring Tax Labels**

### Configuring Tax Labels

1. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Tax Parameters**.
2. Click the **International Options** tab.
3. Select **17 - Enable Tax Labels**.
4. Click the **Options** tab.
5. To post items with a 0% tax rate, select **8 - Post Taxable Sales when Tax Rate is Zero**.
6. Click **Save**.

**Related Topics**
- **Tax Labels**

### Serving Periods

A serving period is a time period during the business day in one revenue center. The following examples illustrate serving periods:
- Breakfast (5:00 a.m. to 11:00 a.m.)
- Lunch (11:00 a.m. to 5:00 p.m.)
- Dinner (5:00 p.m. to 10:00 p.m.)

You can run sales reports for serving periods, include the active serving period in interface posting messages, and use serving periods to determine the default transaction screen.

**Related Topics**
- **Configuring a Serving Period**
Configuring a Serving Period

1. Select the revenue center, click **Configuration**, and then click **Serving Periods**.
2. Insert a record and enter the serving period name.
   The name is used in Serving Period Reports and is also available as an indicator on the POS client.
3. Select the serving period **Start Time** and the **End Time**. If the serving period lasts all day, use the same start and end times.
4. In the **Table Count** field, enter the number of tables available during the serving period.
5. Select the days of the week when the serving period is active.
6. (Optional) Select the **Default Transaction Touchscreen** to use when the serving period is active.
7. If you are using the Mobile MICROS workstation, select the **MMH Default Transaction Touchscreen** to use when the serving period is active.
8. (Optional) Select the **Default Main Level** to use when the serving period is active.
   **Menu Levels** contains more information about Menu Level Hierarchy.
9. Select the **Default Sub Level** to use when the serving period is active.
10. Click the **Taxes** tab.
11. Select the tax rates to use when the serving period is active.
12. Click **Save**.

**Related Topics**
- Serving Periods

Order Types

An order type is a sales category, such as Dine In or Take Out. You can set up to eight order types for each location. Order types control active tax rates for a transaction and help to reduce theft in fast transaction environments. You can specify order types at three different levels of a transaction, as described in the following table: Transaction, Check, and Menu Item.

**Table 12-6  Order Types**

<table>
<thead>
<tr>
<th>Order Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Order Type</td>
<td>This is the order type of the current round. If the workstation operator changes the transaction order type, the order type of all menu items in the current round changes to the selected order type while the order type of the check remains unaffected. A reference entry with the name of the changed order type appears at the top of the menu items.</td>
</tr>
</tbody>
</table>
Table 12-6  (Cont.) Order Types

<table>
<thead>
<tr>
<th>Order Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Order Type</td>
<td>The check order type appears in the check detail header. If you select <strong>16 - Post to Check Order Type</strong> from the RVC Parameters module Posting options, menu item sales post to the check order type.</td>
</tr>
<tr>
<td>Menu Item Order Type</td>
<td>This is the order type of the menu item and also affects the condiments of the menu item. The workstation operator can change the order type of an entire combo meal or selected items in a combo meal. A reference entry appears with the name of the order type beneath the menu item to which the change was made. If the workstation operator consolidates menu items, changing the menu item order type affects all consolidated items. When the workstation operator changes a condiment order type, it applies to the parent menu item.</td>
</tr>
</tbody>
</table>

Order Type Subtotal Security Option

In a fast transaction environment, you can increase security and reduce theft by restricting the workstation operators' ability to perform voids and cancel transactions, while still allowing operators to perform legitimate error corrections. Simphony allows you to suppress the check total on the workstation until the workstation operator presses an order type key that functions as a subtotal. The following table describes the type of theft that can be prevented using the subtotal security.

Table 12-7  Subtotal Restriction Scenarios

<table>
<thead>
<tr>
<th>No Order Type Subtotal Keys</th>
<th>Using Order Type Subtotal Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Workstation operator begins transaction.</td>
<td>• Workstation operator begins transaction.</td>
</tr>
<tr>
<td>• Customer orders hamburger and soda.</td>
<td>• Customer orders hamburger and soda.</td>
</tr>
<tr>
<td>• Workstation operator sees the total as $4.78 and requests the payment amount from the customer.</td>
<td>• Workstation operator does not see the total amount due, and must press one of the <strong>Order Type</strong> function keys to view the subtotal.</td>
</tr>
<tr>
<td>• The customer gives $4.78 in cash.</td>
<td>• The customer gives $4.78 in cash.</td>
</tr>
<tr>
<td>• Workstation operator pockets the cash and voids the items or cancels the transaction.</td>
<td>• Workstation operator cannot void items or cancel the transaction after pressing the <strong>Order Type</strong> key. After pressing the <strong>Order Type</strong> key, the items ordered are considered previous-round items for voiding purposes. Typically, only managers can perform previous-round voids.</td>
</tr>
</tbody>
</table>

If the workstation operator adds another menu item after pressing the **Order Type** key, the Summary Totals are hidden until an Order Type is declared again. The workstation operator can perform error corrections on items that were ordered since the Order Type key was pressed, but cannot perform error corrections on items before the Order Type declaration.
Related Topics

- Configuring Order Types
- Configuring Order Types as Subtotal Keys
- Configuring Touchscreen Buttons for Order Types

Configuring Order Types

1. Select the Enterprise, property, or zone, click **Descriptors**, and then click **Order Types**.

2. In the **Text** field, enter an order type for each record (for example, Dine In, Take Out, Drive Thru).

3. Click **Save**.

4. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Order Type Parameters**.

5. For each order type record, select the appropriate options as described in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Print on Customer Receipt and Guest Check</td>
<td>Select this option to print the order type name on customer receipts and guest checks.</td>
</tr>
<tr>
<td>2 - Print on Order Printer</td>
<td>Select this option to print the order type name on order printers.</td>
</tr>
<tr>
<td>4 - Do Not Post Transactions to Tip Report Totals</td>
<td>Select this option to exclude sales for the order type from Tip Report Totals.</td>
</tr>
<tr>
<td>5 - Perform Auto Combo Recognition</td>
<td>Select this option to have workstations automatically perform auto combo recognition when the workstation operator changes the workstation to the order type.</td>
</tr>
<tr>
<td>6 - Transaction Cancel Default</td>
<td>Select this option when starting orders without an order type. When a workstation operator begins a transaction and cancels it before selecting an order type, the POS client requires the workstation operator to associate the check with an order type for posting purposes. The POS client finds the first order type that has this option selected and uses it. Deselect this option to have the POS client use the first order type record in the list to associate with the check.</td>
</tr>
<tr>
<td>8 - Enable Routing Order by Order Type</td>
<td>Select this option to control order routing by the order type. The workstation order devices must be set for all possibilities and use this as an override to disable order devices.</td>
</tr>
<tr>
<td>9 - KDS Allow Item Print on Item All Prep Done</td>
<td>See Printing Runner Chits by Order Type in the <em>Oracle Hospitality Simphony KDS Configuration and User Guide</em> for more information.</td>
</tr>
</tbody>
</table>
Table 12-8  (Cont.) Order Type Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 - Suppress Dining Course</td>
<td>See Suppressing Dining Courses from Orders in the Oracle Hospitality Symphony KDS Configuration and User Guide for more information.</td>
</tr>
</tbody>
</table>

6. Click the ellipsis point (...) button in the Tax Mask column, select the tax rates for the order type, and then click OK.

7. Select Active for each order type that you want to activate.

8. Click Save.

9. Select the revenue center, click Setup, and then click RVC Parameters.

10. (Optional) Select the Default Order Type from the drop-down list. This is the order type that is active when a workstation operator begins a check.

11. Click Save.

12. To override the default order type setting for a workstation:
   a. Select the property, click Setup, and then click Workstations.
   b. Click the Transactions tab.
   c. Select the Default Order Type from the drop-down list.
   d. Click Save.

- Configuring Order Types as Subtotal Keys
- Configuring Touchscreen Buttons for Order Types

Related Topics
- Order Types

### Configuring Order Types as Subtotal Keys

You can allow the Order Type keys in the revenue center to act as Subtotal keys. After pressing the Order Type key, the items ordered are considered previous-round items for voiding purposes. This is a security option to prevent fast transaction operators from voiding items after viewing the check subtotal.

1. Select the Enterprise, property, or revenue center, click Setup, and then click Control Parameters.

2. Click the Options tab.

3. If you do not want summary totals (subtotal, tax, amount due, and change due) to appear on the workstation until the workstation operator presses an Order Type key, select 8 - Display Summary Totals Only After Order Type Declared.

4. Click Save.

- Configuring Order Types
- Configuring Touchscreen Buttons for Order Types
Configuring Touchscreen Buttons for Order Types

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Open the page on which to place the order type buttons, and then on the Edit tab, select the page area in which to define the buttons.
3. Click Button.
4. To configure a menu item order type button:
   a. On the General subtab, select Menu Item Order Type from the Type drop-down list
   b. Click the black arrow directly beneath the Type drop-down list, select an order type from the list, and then click OK.
5. To configure a transaction order type button:
   a. On the General subtab, select Transaction Order Type from the Type drop-down list
   b. Click the black arrow directly beneath the Type drop-down list, select an order type from the list, and then click OK.
6. To configure a check order type button:
   a. On the General subtab, select Order Type from the Type drop-down list
   b. Click the black arrow directly beneath the Type drop-down list, select an order type from the list, and then click OK.
7. Enter a Legend for the button, and then position and size the button on the page.
8. Click Save.
9. Repeat Steps 3 through 8 to configure more order type buttons.

Printing Tax Rate Per Item

You can configure a menu item's tax rate to print on guest checks and customer receipts, and in the journal. The following diagram illustrates a sample customer receipt printed with the tax rates for each menu item, workstation number and transaction number.
Figure 12-1    Sample Guest Check with Tax Rates

<table>
<thead>
<tr>
<th>workstation number</th>
<th>transaction number</th>
<th>tax rates</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Related Topics

• Configuring Tax Rates Per Item to Print on Guest Check, Customer Receipt and Journal

• Configuring Workstation Number and Transaction Number to Print on Guest Check, Customer Receipt, and Journal

Configuring Tax Rates Per Item to Print on Guest Check, Customer Receipt and Journal

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Tax Parameters.

2. Click the International Options tab.

3. Select 16 - Print Tax Rate per item to print tax rates associated with the menu item class on the guest checks and customer receipts. Deselect this option if you do not want the tax rates to print on the guest check, customer receipt, or journal.

   For example, the line item for a Grilled Cheese Sandwich on the printed check appears as follows:

   1 Grilled Cheese 5.99  T2  T4

   The guest check and customer receipt indicate the tax rate applied to each item. The T2 and T4 shown after the item’s price indicate that tax rates 2 and 4 were applied to a Grilled Cheese.

4. Click Save.

• Configuring Workstation Number and Transaction Number to Print on Guest Check, Customer Receipt, and Journal

Related Topics

• Printing Tax Rate Per Item
Configuring Workstation Number and Transaction Number to Print on Guest Check, Customer Receipt, and Journal

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Format Parameters.
2. Click the Options tab.
3. Select the appropriate workstation and transaction options.
   • 54 - Print Workstation Number: Select this option to print the workstation number on the header of guest checks and customer receipts, and in the journal.
   • 55 - Print Transaction Number: Select this option to print the transaction number on the header of guest checks and customer receipts, and in the journal. The journal header does not contain the legacy transaction number (labeled TRN).
4. Click Save.

- Configuring Tax Rates Per Item to Print on Guest Check, Customer Receipt and Journal

Related Topics
- Printing Tax Rate Per Item

Surcharges

A surcharge is an extra fee applied to a guest check total to cover various restaurant costs. For example, a restaurant might charge a fee to cover the cost of credit card payment processing. Many restaurants impose a surcharge for parties of more than six or eight people. Some cities charge a sugar tax for beverages that contain added sugar, such as carbonated soft drinks, sports drinks, and energy drinks.

Related Topics
- Configuring Surcharges

Configuring Surcharges

1. Create a surcharge tax rate:
   a. Select the Enterprise, property, or zone, click Setup, and then click Tax Rates.
   b. Insert a record and name it for the surcharge.
   c. Select the 4 - Surcharge tax rate type from the Type drop-down list.
   d. Click Save.
2. Create a surcharge tax class:
   a. Select the Enterprise, property, or zone, click Setup, and then click Tax Classes.
b. Insert a tax class record and name it for the surcharge.

c. From the Taxes Enabled field, select the surcharge tax rate, and then click OK.

d. Click Save.

3. Configure the Tax Mask:
   a. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Order Type Parameters.
   b. Click the ellipsis point (...) button in the Tax Mask column, select the surcharge tax rate for the order type, and then click OK.
   c. Ensure that Active is enabled for the order type with the surcharge tax rate.
   d. Click Save.

4. Configure the serving period for the tax rate:
   a. Select the revenue center, click Configuration, and then click Serving Periods.
   b. Insert a record and enter the serving period name, or select an existing serving period.
   c. On the Taxes tab, select the surcharge tax rate
   d. Click Save.

5. Change the Menu Item Class to the surcharge tax class:
   a. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Classes.
   b. Double-click the menu item class.
   c. On the General tab, select the surcharge tax class from the Tax Class drop-down list.
   d. Click Save.

6. Configure the surcharge for the Menu Item Definition record:
   a. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.
   b. Double-click the menu item master record corresponding to the definition to open it.
   c. Click the General tab, and then enter the surcharge for the menu item in the Surcharge field.
   d. Click Save.

Related Topics
- Surcharges

Configuring the Menu Item Tax Class Override

1. Select the Enterprise, property, or zone, click Configuration, and then click Menu Item Groups.
2. Insert a record and name it for the tax class override.
3. Double-click the record to open it.

4. Select **2 - Tax Override** from the **Group Type** drop-down list in the Group Type Configuration section.

5. Enter the **Threshold Quantity**.
   - The base tax class setting is applied if the quantity of an ordered menu item is below the designated threshold value.
   - You can use the Menu Item Definition **Quantity** field to contribute (or add to) to the Menu Item Group module’s Threshold Quantity value. Once the Threshold Quantity setting has been reached or exceeded, the previous base tax class setting is overridden by the tax class assigned to the Menu Item Group record. See Configuring Menu Item Definitions for more information.
   - For **Add-on taxes**, the overall price of an item changes when the threshold is met or exceeded.
   - For **Inclusive taxes**, only the tax rate changes when the threshold is met or exceeded.

6. From the **Tax Class Override** drop-down list, select the desired tax class override.
   You can use the lookup function for tax class override, which opens the Tax Classes module.
   **Tax Rates and Tax Classes** contains more information.

7. You must add all menu items to a specific Menu Item Group to which you want to apply a tax class override. In the **Include** section, click **Add** to assign menu items (or range of items) that you want to be able to apply to this particular tax class override.

8. Select information for the fields described in the following table:

   **Table 12-9 Include Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td><strong>Select 4 - By Menu Item.</strong> This the only option that is applicable as an included item for tax class override. An error message appears if you select family group or major group.</td>
</tr>
<tr>
<td>Start #</td>
<td>Click in this field, and then enter the start item.</td>
</tr>
<tr>
<td>End #</td>
<td>Do not enter anything in this field.</td>
</tr>
<tr>
<td>See Items and Select</td>
<td>Click the link, select the item or item range in the See Items and Select dialog, and then click OK.</td>
</tr>
<tr>
<td>Range</td>
<td>Items selected in <strong>See Items and Select</strong> appear in this field.</td>
</tr>
</tbody>
</table>

9. If a menu item or menu item range was entered in error or is no longer needed, select the row, and then click **Delete**.

10. Repeat Steps 7 through 9 as needed.

11. Click **Save**.
Discounts

You can activate a discount using the methods described in the following table:

Table 13-1  Discount Methods

<table>
<thead>
<tr>
<th>Discount Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual</td>
<td>A workstation operator manually applies a discount to a check by pressing a discount key. This is a traditional discount method.</td>
</tr>
<tr>
<td>Automatic</td>
<td>Simphony applies an automatic discount when a transaction meets certain criteria. As a workstation operator adds menu items to the guest check, Simphony detects items that trigger a discount, and then applies the discount to the check.</td>
</tr>
<tr>
<td>Coupon</td>
<td>A coupon is an automatic discount with one difference: the workstation operator must first apply the discount (coupon) to the guest check.</td>
</tr>
<tr>
<td></td>
<td>Coupon discounts do not require trigger menu items on the transaction when entering the coupon. The coupon discounts the check if trigger menu items are added before or after the coupon is entered. The coupon is applied only when the menu items are ordered and it is not excluded by the presence of a better deal.</td>
</tr>
<tr>
<td>Combination Pricing</td>
<td>A combination pricing discount charges a single price for multiple items when they appear on a check at the same time. Restaurants use this type of discount in combo meal scenarios such as Burger, Fries, and Soda are $3.25. Configuring a Combination Pricing Discount contains instructions to set up combination pricing discounts.</td>
</tr>
</tbody>
</table>

- Manual Discounts
- Automatic Discounts
- Automatic Discount Rules
- Awarding Algorithms
- Discount Award Types
- Discount Exclusivity
- Simple Exclusivity
- Group Exclusivity
- Menu Item Groups
- Configuring Menu Item Groups
- Configuring Discount Privileges
- Configuring Discounts
Manual Discounts

Workstation operators can manually apply a discount to a transaction. You can configure manual discounts as:

- Subtotal discounts
- Item discounts

Subtotal Discounts

All discounts are subtotal discounts by default. That is, the discount applies to all items on a check that belongs to a menu item group or itemizer group affected by the discount. Subtotal discounts are item discounts that apply to multiple items. The amount of a subtotal discount is allotted to all items to which the discount applies. For example, a $3.00 discount that applies to two items will discount each item by $1.50. Workstation operators can add a subtotal discount any time during the transaction, and the subtotal discount is applied to all trigger items that are already on the check. New items added after applying the discount are not discounted.

Item Discounts

An item discount applies to only one item. Item discounts apply to any menu item that belongs to a Menu Item Class with option 7 - Item Discounts May Be Applied to these Menu Items set. Discount Itemizers and Menu Item Groups are not applicable for item discounts. Workstation operators must add an item discount immediately after adding the menu item to discount.

Automatic Discounts

The workstation automatically applies discounts to a guest check based on conditions within the transaction and without workstation operator interaction. For example, a
property may run a promotional sale: buy one DVD and receive one CD for free. In this situation, whenever both a CD and a DVD appear on a single transaction, a 100% discount applies to the CD. There are several automatic discount types. This scenario is just one example of an automatic discount configuration.

Automatic discounts and coupon discounts use the following Menu Item Groups to determine which items receive a discount:

- **Trigger Menu Item Group**: Trigger menu items are the menu items that trigger a discount award. A Trigger Menu Item Group contains at least one item that initiates a discount. For example, in a Buy a DVD, get a CD example, the DVD is in the Trigger Menu Item Group. When a workstation operator adds the minimum quantity of items (1) from this menu item group (DVD), items from the Award Menu Item Group are discounted based on the award configuration for the discount.

- **Award Menu Item Group**: The Award Menu Item Group is the Menu Item Group to be used as the award group. An Award Menu Item Group contains at least one item to receive a discount. For example, in the Buy a DVD, get a CD example, the CD is in the Award Menu Item Group. When a workstation operator adds the minimum quantity of items from the Trigger Menu Item Group, items from this Award Menu Item Group are discounted based on the award configuration for the discount. As another example, in a Buy-One-Get-One scenario, such as Buy one DVD and get one CD for 50% off, set the Award Menu Item Group to CDs and the Percent Off to 50.

A menu item can be in both the trigger and award groups.

Symphony uses several other factors to determine the automatic discount amount:

- **Automatic Discount Rules**
- **Awarding Algorithms**
- **Discount Award Types**
- **Discount Exclusivity**

- **Automatic Discount Rules**
- **Awarding Algorithms**
- **Discount Award Types**
- **Discount Exclusivity**
- **Simple Exclusivity**
- **Group Exclusivity**

**Related Topics**

- **Configuring Discount Privileges**
- **Configuring Discounts**
- **Creating the Discount Button**
- **Automatic Discounts with Decimal Quantity Menu Items**
- **Amount Off Examples**
- **Amount Substitution Examples**

**Related Topics**

- **Configuring Decimal Quantity Menu Items**
Automatic Discount Rules

Various algorithms (known as Automatic Discount Rules) determine how Simphony calculates a discount. The following table explains the Automatic Discount Rules:

Table 13-2   Automatic Discount Rules

<table>
<thead>
<tr>
<th>Automatic Discount Rule</th>
<th>Description</th>
</tr>
</thead>
</table>
| Item Price Substitution         | The discount is applied when the Minimum Quantity has been satisfied. If the Minimum Quantity is not met, the normal item price applies. When the Minimum Quantity is set to 1, the Max Count is equal to the number of items awarded. When the Minimum Quantity is set to a value greater than 1, the Max Count field applies to groups of awarded menu items. When set, the Max Count field affects which items get the reward. A value of 0 indicates that the discount applies to an unlimited number of items. This discount rule is used in scenarios such as:  
  • All Beverages are half-price on Tuesday  
  • If you order three or more hamburgers, they are 20% off  
  • Candy bars are 10% off  
  • Candy bars are 50 cents off  
  • Candy bars are $1 each  
  The Item Price Substitution discount rule is more complex than the Sales Price rule. |
| Quantity Threshold              | Use a Quantity Threshold discount when the number of items added triggers a discount, and the awarded items are different than the trigger items. The discount is applied when the Minimum Quantity has been satisfied. When the workstation operator adds the configured number of items from the Trigger Menu Item Group, the discount award is applied. For example, to configure a scenario where every three shirts purchased awards a free tie, set the Minimum Quantity value to 3, the Trigger Menu Item Group as the Shirt group, the Award Menu Item Group as the Tie group, and the Award Count to 1. This discount rule can be used for Buy-One-Get-One scenarios, such as Buy one DVD and get one CD for 50% off, or Buy two entrees and a dessert is free. |
Table 13-2 (Cont.) Automatic Discount Rules

<table>
<thead>
<tr>
<th>Automatic Discount Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Price Threshold</td>
<td>Use a Total Price Threshold discount when the total price of items triggers a discount. This discount is similar in operation to Quantity Threshold, except that Total Price Threshold looks at the total price of the trigger items rather than the quantity of items on the transaction. This discount rule is used for scenarios such as 15% off all purchases of $200 or more.</td>
</tr>
<tr>
<td>Combination Pricing</td>
<td>Use a Combination Pricing discount to include each combo item to apply the discount. Workstation operators must add at least two of an item before a discount can be applied. This discount rule is used for combination meals, such as when a hamburger, fries, and soda are applied on one check, charge $4.00.</td>
</tr>
<tr>
<td>Sales Price</td>
<td>This discount rule is similar to Item Price Substitution, but it is easier to configure. Sales Price discounts have no Minimum Quantity or Max Count associated, always apply before another discount, and cannot be replaced by a better deal. Use this discount rule for All hamburgers are $2.00 on Wednesdays, without configuring Minimum Quantity of trigger items or Max Count per check.</td>
</tr>
</tbody>
</table>

Related Topics
• Automatic Discounts
• Awarding Algorithms
• Discount Award Types
• Discount Exclusivity
• Simple Exclusivity
• Group Exclusivity

Awarding Algorithms

The better deal always wins with automatic discounts. For example, if you set both Buy One DVD Get One CD For Free and Buy One DVD Get One Car For Free, the application discounts the price of the car to $0.00 because this is a better deal than receiving a CD for $0.00.

When using automatic discounts, Simphony detects the presence of discountable menu items on a transaction, and then performs algorithms to determine which
discounts are applied and which items receive a discount. The following two types of algorithms determine the discount:

Table 13-3  Awarding Algorithms

<table>
<thead>
<tr>
<th>Awarding Algorithm</th>
<th>Description</th>
</tr>
</thead>
</table>
| Best Deal for Customer    | If two discounts can be applied to a check and one yields a higher discounted amount, that discount is said to give the best deal. If two discounts can be applied to a check, and the order in which they are applied yields a different amount, the ordering which gives the customer the highest discount is said to give the best deal. Each automatic discount type provides the best deal for the customer, which means that the workstation scans all menu items and determines the largest discount to apply. In this example, a common best deal scenario is described as follows:  

  • A combo discount is configured so any Pants-and-Shirt purchase is $30.  
  • If a customer orders a $25 pair of pants and a $20 shirt, the discount is $15:  
      – $25 for a pair of pants, $20 for a shirt = $45  
      – The combination price is $30, so the discount is $15.  
  • If the customer then orders a $25 shirt, the discount recalculates:  
      – $25 for a pair of pants, $25 for a shirt = $50  
      – The combination price is $30, so the discount is $20.  

In this example, the higher-priced shirt is discounted, so the customer receives a total discount of $20 instead of just $15. This is the calculation for all automatic discounts and you cannot configure it (except for Quantity Threshold Discounts). By default, the POS client considers all menu items on the check and all discounts that can apply, and creates the largest discount possible for the customer. |
| Best Deal for Merchant    | You can configure Quantity Threshold Discounts to provide the best deal for the merchant, which means that the customer receives the lowest possible discount. Some jurisdictions require this configuration. |
Consider this discount: Buy one entree and get a second (of equal or lesser value) for 50% off. The examples show the different calculations of the discount based on the best deal configuration.

- In Example 1, the Filet is the most expensive item, so it is the trigger. The Chicken Dinner is more expensive than the Spaghetti, so it is discounted by 50%. The total discount is $7.50.
- In Example 2, the Filet is the most expensive item, so it is the trigger. The Spaghetti is the least expensive entree, so it is discounted by 50%. The total discount is $5.00.

**Discount Award Types**

An award type identifies the discount that customers receive. The following table describes the three discount award types in Simphony.

---

**Figure 13-1   Examples of Best Deals for Merchant and Customer**

- Ex 1: Best for Customer --
  - Filet: 20.00
  - Chicken Dinner: 15.00
  - Spaghetti: 10.00
  - Discount: -7.50

- Ex 2: Best for Merchant --
  - Filet: 20.00
  - Chicken Dinner: 15.00
  - Spaghetti: 10.00
  - Discount: -5.00

---

**Automatic Discounts**

**Automatic Discount Rules**

**Discount Award Types**

**Discount Exclusivity**

**Simple Exclusivity**

**Group Exclusivity**

**Related Topics**

- Configuring Discount Privileges
- Configuring Discounts
- Creating the Discount Button
Table 13-4  Award Types

<table>
<thead>
<tr>
<th>Award Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent Off</td>
<td>This award type is used when all menu items in the Trigger Menu Item Group (Item Price Substitution discounts) or in the Award Menu Item Group (Threshold discounts) are to receive a percent discount. You can use the Percent Off award type for discounts such as All sodas are 50% off on Tuesdays or Get 15% off all shirts for purchases of $80 or more. Simphony calculates this type of award as a percent of the sales total. For example, if the item is $10.00 and the discount is 20%, the discount amount is $2.00. The amount owed is reduced to $8.00.</td>
</tr>
<tr>
<td>Amount Off</td>
<td>This award type is used when all items in the Trigger Menu Item Group (Item Price Substitution discounts) or in the Award Menu Item Group (Threshold discounts) are to receive a flat amount discount. You can use the Amount Off award type for discounts such as All sodas are $1.00 off on Tuesdays or Save $25 on shirts for purchases of $150 or more on pants. Simphony calculates this type of award as a fraction of the sales total. The discount awarded cannot be greater than the Amount Off value. The Amount Off is subtracted from the item’s price. For example, if the item is $10.00 and the Amount Off is $3.00, the discount amount is $3.00. The amount owed is $7.00. Items are not discounted below 0.00; if an item’s price is $5.00 and the Amount Off is set to $9.00, the amount owed is $0.00. Amount Off Examples contains more complex examples of the Amount Off award type.</td>
</tr>
<tr>
<td>Amount Substitution</td>
<td>This award type is used when all items in the Trigger Menu Item Group (Item Price Substitution discounts) or in the Award Menu Item Group (Threshold discounts) are to be charged a fixed amount. You can use the Amount Substitution award for discounts such as All sodas are $2.00 on Tuesdays or Buy $80 of shirts and receive up to 3 pairs of pants for $15.00 each. The amount is substituted for the original price of the item. For example, if the item is $10.00 and the amount substitution is $5.99, the discounted item’s price is $5.99. Calculations do not change with whole numbers. For decimal values, Simphony calculates what percent of the parent item the original substitution price was, and applies that percent discount to the new decimal quantity. Amount Substitution contains more complex examples of the Amount Substitution award type.</td>
</tr>
</tbody>
</table>

- Automatic Discounts
- Automatic Discount Rules
- Awarding Algorithms
Discount Exclusivity

Exclusivity stops all discounts from applying to a check at once. Discount exclusivity controls how multiple discounts interact with each other. You can configure discounts to be exclusive to the following:

- Per transaction
- Per menu item
- Based on workstation operator-defined groups

In short, discount exclusivity stops discounts from applying multiple times to the same items.

Discount exclusivity applies in these situations:

- A senior citizen discount coupon cannot be used at the same time as a 25% off all items discount.
- A Buy One Get One Free discount cannot be applied to a transaction that also has a Buy $100, Get 25% Off Discount.
- The customer's 10% coupon cannot be applied to items that receive the Happy Hour discount.

You can configure two types of discount exclusivity: simple exclusivity and group exclusivity. Simple exclusivity is easier to use and configure. Group exclusivity yields greater flexibility, but at the price of complexity. Simple Exclusivity and Group Exclusivity contain more information about these types of discount exclusivity.

Automatic discounts always recalculate after the workstation operator adds or removes an item from a guest check. Because of this, automatic discounts are always applied after manual discounts. Consider the following example:

- The revenue center is configured with automatic discounts enabled in the RVC Parameters module.
- One automatic discount is active: all food is 10% off.
- A manual discount is configured, and it allows the 10% off all food discount to be on the check at the same time as the manual discount.
- The operator orders $20 of food.
- The automatic discount applies on the check for $2.

If the workstation operator then adds a manual discount for $5.00 off, the discount changes:
• All automatic discounts are removed (this occurs internally on the workstation but is listed here to explain the logic)
• The check's total is $15.00 ($20.00 minus the $5.00 manual discount)
• The 10% automatic discount is applied for $1.50, taking the check's total to $13.50

Because of the scenario described here, it is not possible to get a better deal when combining automatic and manual discounts. Either the discounts can both be on the check (as in this example) or the manual discount is not allowed (if the automatic discount is exclusive to the manual discount). Thus, to use manual discounts and automatic discounts in the same environment, configure the discounts that would normally be manual as automatic coupon discounts, which follow the best deal rules of the Discount Engine. See Understanding Awarding Algorithms for more information.

Configuring Discounts contains more information about setting the **Simple Item Exclusivity** and **Simple Transaction Exclusivity** options.

- Automatic Discounts
- Automatic Discount Rules
- Awarding Algorithms
- Discount Award Types
- Simple Exclusivity
- Group Exclusivity

**Related Topics**
- Configuring Discount Privileges
- Configuring Discounts
- Creating the Discount Button

## Simple Exclusivity

The following three discount options apply to simple exclusivity in the Discounts module:

### Table 13-5  Simple Exclusivity Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9 - Simple Item Exclusivity</td>
<td>When you select this option, only this discount can be applied to a menu item. This prevents individual items from being discounted more than once. Deselecting this option causes the Exclusivity Group settings to determine how this discount interacts with other discounts. If other discounts that are better deals can apply to the item or transaction, the better deal discounts apply.</td>
</tr>
<tr>
<td>23 - Simple Transaction Exclusivity</td>
<td>When you select this option, only this discount can be applied to a single check. This prevents the check from being discounted more than once. Deselecting this option causes the Exclusivity Group settings to determine how this discount interacts with other discounts. If other discounts that are better deals can apply to the item or transaction, the better deal discounts apply.</td>
</tr>
</tbody>
</table>
Table 13-5  (Cont.) Simple Exclusivity Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>24 - Discount is Final</td>
<td>When you select this option, no additional discounts can be applied to the transaction after this discount posts. (This option works in automatic discount transactions only.)</td>
</tr>
</tbody>
</table>

- Automatic Discounts
- Automatic Discount Rules
- Awarding Algorithms
- Discount Award Types
- Discount Exclusivity
- Group Exclusivity

Related Topics
- Configuring Discount Privileges
- Configuring Discounts
- Creating the Discount Button

Group Exclusivity

Group exclusivity lets you configure the manner in which discounts interact. When two discounts are exclusive to each other, it means that only one discount applies. This exclusiveness can apply either per transaction or per menu item:

- If two discounts are transaction exclusive to each other, only one can be applied to the same transaction. The discount that provides the best deal is applied to the check.
- If two discounts are item exclusive to each other, only one can be applied to a specific menu item. Two discounts that are item exclusive can both be present on a transaction, but only applied to different menu items. Again, the discount that provides the best deal is applied to the item.

Table 13-6  Transaction Exclusivity

<table>
<thead>
<tr>
<th>Discount</th>
<th>In Exclusivity Group 1</th>
<th>In Exclusivity Group 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>B</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>C</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>D</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Given the configuration shown in the Transaction Exclusivity table, the following occurs:

- Discounts A and B cannot appear on the same transaction because they both belong to the first group.
• Discounts A and C cannot appear on the same transaction because they both belong to the second group.
• Discounts B and C can appear on the same transaction because they do not belong to the same groups.
• Discount D can appear on any transaction with A, B, and C because it does not belong to any group.

The Transaction Exclusivity example shows a configuration with only two groups. The combinations become more complex (yet more flexible) when using all 32 groups in the property.

<table>
<thead>
<tr>
<th>Discount</th>
<th>In Exclusivity Group 1</th>
<th>Menu Items Affected by Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Yes</td>
<td>x, y</td>
</tr>
<tr>
<td>B</td>
<td>Yes</td>
<td>x</td>
</tr>
<tr>
<td>C</td>
<td>No</td>
<td>y</td>
</tr>
</tbody>
</table>

Given the configuration shown in the Item Exclusivity table, the following occurs:
• Menu Item x is discounted by A or B, but not both. Discounts A and B are exclusive to each other.
• Menu Item y is discounted by A and C. These discounts are not exclusive to each other, so they may both discount the same items.

Related Topics
• Automatic Discounts
• Automatic Discount Rules
• Awarding Algorithms
• Discount Award Types
• Discount Exclusivity
• Simple Exclusivity

Menu Item Groups

Each record in a menu item group specifies the menu items it represents. Within the Menu Item Group module, you can assign menu items based on major groups, family groups, or by menu item object number or range. Each menu item group can have a combination of major groups, family groups, and so on. You can configure menu item groups to include and exclude major groups, family groups, and so on.

Examples of menu item groups are:
• All menu items in major group Liquor
• All menu items in major group Liquor, but not Bottles of Wine in family group 6
• All menu items in family groups Cold Appetizers, Warm Appetizers, and Soups
• All menu items with object numbers in the range 4000-4999, 14000-14999, and major group Non-liquor
• All menu items with object numbers in the range 5000-10000, except those in 6500-6600

Related Topics
• Configuring Menu Item Groups
• Categorizing Menu Items into Groups

Related Topics
• Configuring Major Groups
• Categorizing Menu Items into Groups

Related Topics
• Configuring Family Groups

Configuring Menu Item Groups

1. Select the Enterprise, property, or zone, click Configuration, and then click Menu Item Groups.
2. Insert a menu item group record, and then double-click it to open.
3. Click Add near one of the following areas:
   • Include: You can add the menu item groups to include in the discount here
   • Exclude: You can add the menu item groups to exclude from the discount here

4. Select information for the fields described in the following table:

Table 13-8  Include and Exclude Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select the grouping to include or exclude:</td>
</tr>
<tr>
<td></td>
<td>• 0 - None</td>
</tr>
<tr>
<td></td>
<td>• 1 - All</td>
</tr>
<tr>
<td></td>
<td>• 2 - By Major Group</td>
</tr>
<tr>
<td></td>
<td>• 3 - By Family Group</td>
</tr>
<tr>
<td></td>
<td>• 4 - By Menu Item</td>
</tr>
<tr>
<td>Start #</td>
<td>Click in this field, and then select the start item.</td>
</tr>
<tr>
<td>End #</td>
<td>Do not enter anything in this field.</td>
</tr>
<tr>
<td>See Items and Select</td>
<td>Click the link and then select the menu items to be the trigger. This item appears in the End # field.</td>
</tr>
<tr>
<td>Range</td>
<td>The items you selected in the See Items and Select dialog appear in this field.</td>
</tr>
</tbody>
</table>
Table 13-8  (Cont.) Include and Exclude Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Override Price Amount/Percentage (Include only)</td>
<td>If you want a discount to apply to menu items differently, use this field. For example, you can set discounts for Sweet Potato Fries to 15% and Pub Fries to 20%. To use this field with automatic discounts, you must select the Use Price in MI Group Detail option from the Discounts module Auto subtab. You can set amount off, percent off, or amount substitution, based on the discount configuration. For example, enter 10.00 to indicate 10% off (not 0.10). The Use Price in MI Group Detail option does not function with combination pricing discounts.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

Related Topics

- Menu Item Groups
- Categorizing Menu Items into Groups

Configuring Discount Privileges

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.

2. Select the role type, click the **Operations** tab, and then click the **Voids/Returns** subtab.

3. Select the following options to allow employees to void discounts in a previous round and on closed checks:
   - **27 - Authorize/Perform Void of Discounts from a Previous Round**
   - **70 - Authorize/Perform Void of Discounts on Closed Checks**

4. Click the **Transactions** subtab.

5. Select the options that apply to discounts:
   - **20 - Post Discounts to Checks Belonging to Another Operator**
   - **52 - Authorize/Perform Posting of Discounts in Priv Group 1**
   - **53 - Authorize/Perform Posting of Discounts in Priv Group 2**
   - **54 - Authorize/Perform Posting of Discounts in Priv Group 3**
   - **98 - Authorize/Perform Employee Meal Discount Override for Non-Scheduled Employees**
   - **282 - Authorize/Perform Minimum Amount Threshold Override**

6. Click **Save**.

Related Topics

- Configuring Discounts
- Creating the Discount Button

- Automatic Discounts
- Automatic Discount Rules
Configuring Discounts

1. Select the Enterprise, property, or zone, click **Configuration**, and then click **Discounts**.

2. Insert a record for a discount or double-click a record to select it.

3. On the **General** tab, select the type of discount from the **Activation Type** drop-down list:
   - **0** - Manual (Manually entered and applied)
   - **1** - Automatic (Automatically applied, operator cannot enter)
   - **2** - Coupon (Automatically applied, operator must enter)

4. (Optional) Enter the minimum menu item subtotal required on a check to apply the discount in the **Min Amount** field.

5. To configure a manual discount, enter the following information. Otherwise, skip this step.
   a. To use a percent discount, enter the percentage in the **Percent** field.
   b. If configuring an open-priced discount, enter the maximum amount allowed for the discount in the **Max Amount** field.
   c. If configuring a preset amount discount, enter the amount of the discount in the **Amount** field.
      
      This field works with options **7 - Limit Discount to Value in Amount Field** and **8 - If No Amount is Entered, Use the Full Discountable Amount**.
   d. From the **Trigger MI Group** drop-down list, select the menu item group that triggers the discount.
      
      This is an alternative and preferred method to using discount itemizers. The discount applies to only those qualifying menu items based on the selected Trigger MI Group, Trigger Condiment Group, and other discount configurations.

6. To make the discount available to the workstation operator, select **Enabled**. You can turn off temporary discounts by deselecting **Enabled**.

7. Select the **Tax Class** to use for the discount.

8. Select a **Privilege Group** to restrict the discount to only employees who are linked to the same privilege group. Set the **Privilege Group** to **0** to allow all employees to use the discount.

9. Select the method to determine how condiment menu items are discounted from the **Condiment Discountability** drop-down list.
If you select **0 - Use MI Class Option**, the discounts only apply to parent items unless you enable the Menu Item Class option **55 - Discounts Apply to Priced Condiments**.

10. Select the **Report Group** to associate with the discount.

Report groups are subcategories that allow reports to show similar discounts grouped together. You can set report groups from the Report Groups module, in the Reporting section of the Property tab.

11. Select the appropriate options for the discount. The following table describes the options and indicates the Activation Types (Manual, Automatic, Coupon) that are available for each option.

### Table 13-9 Discount Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Manual</th>
<th>Automatic</th>
<th>Coupon</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - ON = Open; OFF = Preset</td>
<td>Select this option to make the discount open. The workstation prompts the workstation operator to enter the amount or percentage. Deselect this option to use a preset amount or preset percentage for the discount.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>2 - ON = Amount; OFF = Percentage</td>
<td>Select this option to make the discount an amount. Deselect this option to make the discount a percentage.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>3 - This is an Item Discount</td>
<td>Select this option to calculate the discount based on the price of the last menu item entered. Deselect this option to calculate the discount based on the discountable transaction subtotal. For automatic discounts, this option controls the discount sorting and consolidation on a check. When set, each item in the Menu Item Award Group shows the discounted amount on customer receipts and on the POS client. When deselected, all items in the Menu Item Award Group show a combined discounted amount as one entry.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>4 - Employee Meal</td>
<td>Select this option to set the discount as an Employee Discount. The POS client prompts the workstation operator to enter the employee number or ID of the employee receiving the discount.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>5 - Reference Entry Required</td>
<td>Select this option to require the workstation operator to enter a name or number when using the discount.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>6 - Validation Required</td>
<td>Select this option to print a validation chit when the discount is applied.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table 13-9  (Cont.) Discount Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Manual</th>
<th>Automatic</th>
<th>Coupon</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 - Limit Discount to Value in Amount Field</td>
<td>Select this option to limit the amount of a discount. Enter an amount in the <strong>Max Amount</strong> field, which represents the highest discount possible when setting this option.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
| 8 - If No Amount is Entered, Use the Full Discountable Amount | Select this option to control the open amount discount calculation if the workstation operator does not enter an amount before pressing the Discount button. In short, this option allows you to set a discount as:  
  • A 100% discount (if the workstation operator does not enter an amount before selecting the Discount button)  
  • An open amount discount (if the workstation operator enters an amount before selecting the Discount button)  
You must select option 2 - **ON = Amount; OFF = Percentage** to activate this option. | Yes    | No        | No      |
<p>| 9 - Simple Item Exclusivity                   | Select this option to apply the discount to only one menu item. This setting imposes a limit of one discount per item and prevents individual items from receiving a discount more than once. Deselect this option to have the Exclusivity tab settings determine how the discount interacts with other discounts. | Yes    | Yes       | Yes    |
| 10 - Tender Required (Only for Subtotal Discounts) | Select this option to require workstation operators to tender the transaction after applying a subtotal discount. You must also deselect option 3 - <strong>This is an Item Discount.</strong>                                                                 | Yes    | No        | No      |
| 11 - Affects Auto Service Charge (Only Subtotal Discounts) | Select this option to apply the discount to Menu Item Itemizers that allow Auto Service Charges. This results in an adjusted Auto Service Charge value based on the Itemizers discounted. Deselect to keep the Auto Service Charge unchanged. | Yes    | No        | No      |
| 14 - Do Not Allow Subtotal Discount While Seat Filter is Active | Select this option to disallow subtotal discounts while seat filtering is active. Deselect for item discounts or when not using seat handling.                                                                                     | Yes    | No        | No      |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Manual</th>
<th>Automatic</th>
<th>Coupon</th>
</tr>
</thead>
<tbody>
<tr>
<td>23 - Simple Transaction Exclusivity</td>
<td>Select this option to have the discount apply to a single transaction. This setting prevents the transaction from receiving a discount more than once.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>24 - Discount is Final</td>
<td>Select this option to prevent workstation operators from applying additional discounts to the transaction after the discount is posted.</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>25 - Discount Combo Meal Group Items</td>
<td>Select this option to discount combo group menu items when the <strong>Allow Discounts</strong> option is set for the combo group.</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>28 - Apply to Returned or Direct-Voided Menu Items</td>
<td>Select this option to allow the discount to be applied to returned and voided items.</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>29 - Menu item to use check open time</td>
<td>Select this option to have a menu item use the check’s open time (instead of using the current time) to determine effectivity of the discount.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>30 - Selected menu item to include parent menu item in discount</td>
<td>Select this option to include a parent menu item in the discount when the workstation operator selects a child menu item for the discount.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>31 - Net Automatic Service Charge Itemizer</td>
<td>Select this option to post the net value of the menu item to the Automatic Service Charge Itemizer, reducing the Automatic Service Charge after the discount is applied.</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>32 - Limit Discount value to value of Discountable Item</td>
<td>Select this option to limit the discountable amount to the item or award when the Amount Off exceeds the item or award. For example, if the Amount Off is $5.00 and the item or award is $4.00, the discount is limited to $4.00.</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>33 - Cash Management Transaction Item</td>
<td>Select this option to include the discount in Enterprise Cash Management (ECM) tracking and reports.</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

12. Click the **RVC Type** tab.

13. Select the revenue centers that can have the discount available.
14. Click the **Menu Levels** tab.

15. In the **Menu Level Configuration** section, select the **Active On Main Levels** and **Active On Sub Levels** on which the discount is active.

16. In the Main Level Popup and Sub Level Popup sections, select **Transaction Default** to return the transaction to the default Main Level or Sub Level after the discount is pressed, select **0 - Stay Down** to keep the current transaction levels, or select one of the levels 1-8 to become active. Deselect **Transaction Default** to make the other levels active for selection.

17. (Optional) If you are using NLUs or SLUs, click the **NLU/SLU** tab.

18. (Optional) Enter the unique **NLU** number for the discount (0 to 255).

19. (Optional) Select a screen lookup key for the discount from the **SLU** drop-down list.

   The SLU is configured by selecting the Enterprise or property, clicking **Descriptors**, and then clicking **Discounts**.

20. (Optional) From the **MMH SLU** drop-down list, select a Mobile MICROS screen lookup key for the discount.

21. (Optional) From the **Icon** drop-down list, select an icon to assign to the discount key.

22. Click the **Effectivity** tab.

23. Select the dates, days, and times for the discount to be in effect.

24. To configure manual discount printing output, click the **Output** tab, and then select the order devices that will show the discount. Otherwise, skip this step.

   Automatic Discounts and Coupons are excluded from Order Device output.

25. Click the **Effectivity Groups** tab.

   Effectivity groups allow you to configure and package promotions so that the menu items and their discounts are only available for a fixed period of time. If effectivity groups do not exist, you must create one or more in the Effectivity Groups module. **Configuring Effectivity Groups** contains more information.

26. Click the **Add Effectivity Record** link.

27. Click the **Select** link adjacent to **Effectivity Group**, select the effectivity group, and then click **OK** twice. The new effectivity record shows the discount name, Effectivity Status (for example, Active or Future), Date Start, and Date End.

28. Click **Save**.

29. To set an automatic discount to apply to a revenue center:
   a. Select the revenue center, click **Setup**, and then click **RVC Parameters**.
   b. Click the **Options** tab.
   c. Select **48 - Enable Automatic Discounts by Default**. If you do not select this option, workstation operators must activate automatic discounts per transaction using one of the following function keys:
      - **655 - Auto Discount Toggle**: Switch the automatic discounts for the transaction
      - **656 - Auto Discount Apply**: Apply all discounts possible
      - **657 - Auto Discount Remove**: Remove all discounts from the transaction
Examples of the types of discounts that are available with this option include:

- All appetizers are 25% off
- All domestic beers are $3.00 during Happy Hour
- Buy an appetizer, get another one for 50% off
- Buy an entrée, get $2.00 off a dessert

d. Click **Save**.

30. To configure an Item Price Substitution Discount, see Configuring an Item Price Substitution Discount.

31. To configure a Quantity Threshold Discount, see Configuring a Quantity Threshold Discount.

32. To configure a Total Price Threshold Discount, see Configuring a Total Price Threshold Discount.

33. To configure a Combination Pricing Discount, see Configuring a Combination Pricing Discount.

34. To configure a Sales Price Discount, see Configuring a Sales Price Discount.

- Configuring Discount Privileges
- Creating the Discount Button

**Related Topics**

- Automatic Discounts
- Automatic Discount Rules
- Awarding Algorithms
- Discount Award Types
- Discount Exclusivity
- Simple Exclusivity
- Group Exclusivity

**Configuring Effectivity Groups**

You can assign discounts, menu item prices, and reservation periods to an effectivity group. Effectivity groups let you configure and package promotions and reservation times. For example, you can make menu items or discounts available for a fixed period of time.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Effectivity Groups**.

2. Insert a record for the effectivity group, enter a descriptive name, and then click **OK**.

3. Double-click the record to open it.

4. Click the **Add** link, and then select the **Start Time** and the **End Time** from the calendar.

5. Click **Save**.
After creating the Effectivity Group, you need to associate the Effectivity Group with one of the following types of records to make it active:

- Tender/Media
- Menu Item Price
- Discount
- Combo Group Detail Price
- Service Charge
- Tax
- Page Content Area

You can make the association in the record type. For example, to associate a Tender/Media record with the Effectivity Group, click the Tender/Media module, and then click the Effectivity tab.

Automatic Discounts with Decimal Quantity Menu Items

Simphony ignores decimal quantity menu items with automatic discounts and applies the discount for the closest whole number. For example:

- 1 Cherry Pie = $20.00
- 1.5 Cherry Pies = $30.00
- If you add a menu item to the check with a quantity less than 1, Simphony does not apply the automatic discount.
- If you add a menu item to the check with a discount and then split the check, the discount no longer applies to either check.

The following automatic discount rules ignore decimal quantities when ordering:

- Quantity Threshold
- Combination Pricing

The discount engine ignores menu items added with a quantity less than 1 (for example .5 cup of yogurt). Understanding Automatic Discount Rules contains more information about Quantity Threshold and Combination Pricing.

Amount Off Examples contains examples of the Amount Off award type.

Amount Substitution contains examples of the Amount Substitution award type.

Automatic Discounts
Amount Off Examples
Amount Substitution Examples

Related Topics
Configuring Decimal Quantity Menu Items
Configuring an Item Price Substitution Discount
Configuring a Quantity Threshold Discount
Configuring a Total Price Threshold Discount
Amount Off Examples

This section provides examples of the Amount Off discount award type.

Example 1: Whole Number Quantity Item

- 1 Salad: $10.00
- Amount Off: $2.00
- Award Percent = Amount Off ($2.00) / Item Base Price ($10.00) = .20
- Discount = Discountable Total ($10.00) x Award Percent (.20) = $2.00
Because the Discountable Total is greater than or equal to the base price, the customer receives the Amount Off.

Example 2: Decimal Number Quantity Item

- .5 Salad: $5.00
- Amount Off: $2.00
- Award Percent = Amount Off ($2.00) / Item Base Price ($10.00) = .20
- Discount = Discountable Total ($5.00) x Award Percent (.20) = $1.00
When the Discountable Total is less than the base price, the customer receives the discount based on the Award Percent calculation.

Example 3: Decimal Number Quantity Item with Condiment

- .5 Salad: $5.00
- 1 Chicken: $5.00
- Discountable Total = $10.00
- Discount = Discountable Total ($10.00) x Award Percent (.20) = $2.00
Because the Discountable Total is greater than or equal to the base price, the customer receives the Amount Off.
# Amount Substitution Examples

This section provides examples of the Amount Substitution discount award type.

### Example 4: Whole Number Quantity Item
- 1 Salad: $10.00
- Amount Substitution: $9.00 (discounted $1.00)
- Award Percent = Amount Substitution ($9.00) / Item Base Price ($10.00) = .90
- Discount = ($10.00) - Amount Substitution ($9.00) = $1.00

When dealing with whole number quantity menu items, the customer always pays the Amount Substitution. If the customer orders items totaling $100, they pay only $9.00.

### Example 5: Decimal Number Quantity Item
- .5 Salad: $5.00
- Amount Substitution: $9.00 (discounted $1.00 from parent item base price)
- Award Percent = Amount Substitution ($9.00) / Item Base Price ($10.00) = .90
- Discount = (Current Sales Total – (Current Sales x Award Percent) = $5.00 – ($5.00 x .90) = $5.00 – $4.50 = $.50

### Example 6: Decimal Number Quantity Item, More Condiments Than Parent Items
- The Award Percent for Amount Substitution is based on the parent item base price, not the total price of each item plus condiments.
- The Discount Calculation only applies when the menu item plus condiments are less than the base price amount of the parent item.

<table>
<thead>
<tr>
<th>Order Number</th>
<th>Items</th>
<th>Price</th>
<th>Award Percent</th>
<th>Discount Calculation</th>
<th>Discount Amount</th>
<th>Customer Pays</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 Salad</td>
<td>$10.00</td>
<td>($9.00) / (10.00) = .90</td>
<td>($25.00 - $9.00)</td>
<td>$16.00</td>
<td>$9.00</td>
</tr>
<tr>
<td></td>
<td>1 Chicken</td>
<td>$5.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 Steak</td>
<td>$5.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 Steak</td>
<td>$5.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(This extra condiment is added to the first menu item.)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1 Salad</td>
<td>$10.00</td>
<td>($9.00) / (10.00) = .90</td>
<td>($25.00 - $9.00)</td>
<td>$11.00</td>
<td>$9.00</td>
</tr>
<tr>
<td></td>
<td>1 Chicken</td>
<td>$5.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 Steak</td>
<td>$5.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1 Salad</td>
<td>$10.00</td>
<td>($9.00) / (10.00) = .90</td>
<td>($17.50 - $9.00)</td>
<td>$8.50</td>
<td>$9.00</td>
</tr>
<tr>
<td></td>
<td>1 Chicken</td>
<td>$2.50</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 Steak</td>
<td>$5.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Order Number</td>
<td>Items</td>
<td>Price</td>
<td>Award Percent</td>
<td>Discount Calculation</td>
<td>Discount Amount</td>
<td>Customer Pays</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------</td>
<td>-------</td>
<td>---------------</td>
<td>----------------------</td>
<td>-----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>4</td>
<td>.5 Salad</td>
<td>$5.00</td>
<td>($9.00) /</td>
<td>($10.00) – $9.00</td>
<td>$1.00</td>
<td>$9.00</td>
</tr>
<tr>
<td></td>
<td>1 Steak</td>
<td>$5.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Automatic Discounts
- Automatic Discounts with Decimal Quantity Menu Items
- Amount Off Examples

Related Topics
- Configuring Decimal Quantity Menu Items
- Configuring an Item Price Substitution Discount
- Configuring a Quantity Threshold Discount
- Configuring a Total Price Threshold Discount
- Configuring a Combination Pricing Discount
- Configuring a Sales Price Discount

Configuring Decimal Quantity Menu Items

1. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Menu Item Classes**.
2. Double-click the menu item class record to open it.
3. (Optional) On the **General** tab, select **2 - Decimal/fraction allowed, round sales count up** from the **Count Entry** drop-down list.
4. Click **Save**.

Related Topics
- Automatic Discounts
- Automatic Discounts with Decimal Quantity Menu Items
- Amount Off Examples
- Amount Substitution Examples

Configuring an Item Price Substitution Discount

1. Select the Enterprise, property, or zone, click **Configuration**, and then click **Discounts**.
2. Double-click an automatic discount record to open it.
3. On the **Auto** tab, select **1 - Item Price Substitution** from the **Automatic (Automatically applied, operator cannot enter)** drop-down list.
4. (Optional) Enter a **Priority** for the discount.

Priority determines the order in which discounts are calculated. By default, this field is blank (0) for all discounts, meaning that discounts are calculated at the...
same time. If you enter a priority, the workstation calculates all discounts in priority 1, then in priority 2, and so on. Priority zero (0) discounts are calculated last. The priority field allows Simphony to calculate discounts more efficiently.

5. In the Trigger section, configure a trigger to invoke the discount:
   - **Trigger MI Group**: Select the menu item groups that will trigger the discount award.
   - **Trigger Condiment Group**: Select the condiment menu item groups to use as the trigger for the discount, if any. For example, if customers can get a bagel for $0.50 when they add cream cheese to any bagel, cream cheese is the trigger condiment and bagel is the trigger menu item for the $0.50 discount.
   - **Minimum Quantity**: Enter the number of items that customers must order from the corresponding trigger menu group before applying the discount award.

6. In the Awards section, configure the discount amount:
   - **Percentage Off**: If this is a percent discount, enter the percentage to discount from each item in the Trigger MI Group.
   - **Amount Off**: If this is an amount discount, enter the amount to discount from each item in the Trigger MI Group.
   - **Amount Substitution**: If this is an amount substitution discount, enter the price to charge for each item in the Trigger MI Group.
   - **Max Count**: Enter the maximum number of discounts that can be applied to a single check when option **23 - Simple Transaction Exclusivity** is enabled for this discount. If set to zero (0), the maximum count is unlimited.

   For example, if the discount is $5.00 off every appetizer with a limit of 3 appetizers per check, set this field to 3. Then, if seven appetizers are ordered, the three most expensive appetizers are discounted while the other four appetizers are charged the regular price.

7. If you configured a Percent Off discount, click the **General** tab, and then enter the maximum amount allowed for the discount in the **Max Amount** field.

8. Click **Save**.

**Related Topics**
- Automatic Discounts
- Automatic Discounts with Decimal Quantity Menu Items
- Amount Off Examples
- Amount Substitution Examples

**Configuring a Quantity Threshold Discount**

1. Select the Enterprise, property, or zone, click **Configuration**, and then click **Discounts**.
2. Double-click an automatic discount record to open it.
3. Click the **Auto** tab, and then select **2 - Quantity Threshold** from the **Automatic (Automatically applied, operator cannot enter)** drop-down list.
4. Select the appropriate **Awarding Algorithm**.
• **1 - Best Deal for Customer**: Select to apply the best possible deal (highest discount amount) to the check. Oracle recommends using this setting unless specific business needs are required at the property.

• **2 - Best Deal for Merchant**: Select to apply the smallest discount amount to the check. This option is intended for properties with specific needs and configurations.

5. (Optional) Enter a **Priority** for the discount.

   Priority determines the order in which discounts are calculated. By default, this field is blank (0) for all discounts, meaning that discounts are calculated at the same time. If you enter a priority, the workstation calculates all discounts in priority 1, then in priority 2, and so on. Priority zero (0) discounts are calculated last. The priority field allows Simphony to calculate discounts more efficiently.

6. Enter the maximum number of times the coupon discount can be entered on a check in the **Max Count Per Check** field.

7. To use promotion prices that appear in the Menu Item Groups module for the discounted menu item, select **Use Price in MI Group Detail**.

8. In the Trigger section, configure up to eight unique triggers to invoke the discount. You must configure the triggers in sequential order.

   • **Trigger MI Group**: Select the menu item groups that will trigger the discount award.

   • **Trigger Condiment Group**: Select the condiment menu item groups to use as the trigger for the discount, if any. For example, if customers can get a bagel for $0.50 when they add cream cheese to any bagel, cream cheese is the trigger condiment and bagel is the trigger menu item for the $0.50 discount.

   • **Quantity**: Enter the number of items that customers must order from the corresponding trigger menu group before applying the discount award.

   • **Minimum Quantity**: Enter the number of items that customers must order from the corresponding trigger menu group before applying the discount award.

9. In the Awards section, configure up to eight rewards for the discount:

   • **Award MI Group**: Select the menu item groups to use as the award group when the minimum quantity of items from the Trigger MI Group is ordered.

   • **Award Type**: Select the discount type.

   • **Percentage Off**: If this is a percent discount, enter the percentage to discount from each item in the Award MI Group.

   • **Amount Off**: If this is an amount discount, enter the amount to discount from each item in the Award MI Group.

   • **Amount Substitution**: If this is an amount substitution discount, enter the price to charge for each item in the Award MI Group.

   • **Award Count**: Enter the number of award items that are allowed once the Trigger MI Group’s Minimum quantity is reached. For example, if this is a Buy Three Coffees and Get Two Donuts at 50% off discount, set this field to 2.

   • **Max Count**: Enter the maximum number of award items that can be discounted on a single check. If set to zero (0), the maximum count is unlimited.
• **Allow award of higher priced item**: Select to allow a discount to be applied when the trigger item price is lower than the award item price.

10. If you configured a Percent Off discount, click the **General** tab, and then enter the maximum amount allowed for the discount in the **Max Amount** field.

11. Click **Save**.

**Related Topics**

- Automatic Discounts
- Automatic Discounts with Decimal Quantity Menu Items
- Amount Off Examples
- Amount Substitution Examples

### Configuring a Total Price Threshold Discount

1. Select the Enterprise, property, or zone, click **Configuration**, and then click **Discounts**.

2. Double-click an automatic discount record to open it.

3. Click the **Auto** tab, and then select **3 - Total Price Threshold** from the **Automatic (Automatically applied, operator cannot enter)** drop-down list.

4. (Optional) Enter a **Priority** for the discount.

   Priority determines the order in which discounts are calculated. By default, this field is blank (0) for all discounts, meaning that discounts are calculated at the same time. If you enter a priority, the workstation calculates all discounts in priority 1, then in priority 2, and so on. Priority zero (0) discounts are calculated last. The priority field allows Simphony to calculate discounts more efficiently.

5. To use promotion prices that appear in the Menu Item Groups module for the discounted menu item, select **Use Price in MI Group Detail**.

6. In the **Trigger** section, configure up to eight unique triggers to invoke the discount. You must configure the triggers in sequential order.

   - **Trigger MI Group**: Select the menu item groups that will trigger the discount award. When the total amount of all items on a check exceeds the amount configured for the trigger group, the discount will be applied to all items in the Award Menu Item Group.

   - **Trigger Condiment Group**: Select the condiment menu item groups to use as the trigger for the discount, if any. For example, If customers can get a bagel for $0.50 when they add cream cheese to any bagel, cream cheese is the trigger condiment and bagel is the trigger menu item for the $0.50 discount.

   - **Total**: Enter the total amount of corresponding trigger menu item group items customers must order before applying the discount (that is, to activate the Award Menu Item Group). For example, if you are giving 15% off all shirts for a purchase of $80 or more, enter 80.00 in this field.

7. In the **Awards** section, configure up to eight rewards for the discount:

   - **Award MI Group**: Select the menu item groups to use as the award group when the total amount of all items on a check exceeds the Total configured for the Trigger MI Group.

   - **Award Type**: Select the discount type.
• **Percentage Off**: If this is a percent discount, enter the percentage to discount from each item in the Award MI Group.

• **Amount Off**: If this is an amount discount, enter the amount to discount from each item in the Award MI Group.

• **Amount Substitution**: If this is an amount substitution discount, enter the price to charge for each item in the Award MI Group.

• **Max Count**: Enter the maximum number of award items that can be discounted on a single check. If set to zero (0), the maximum count is unlimited.

8. If you configured a Percent Off discount, click the **General** tab, and then enter the maximum amount allowed for the discount in the **Max Amount** field.

9. Click **Save**.

**Related Topics**
- Automatic Discounts
- Automatic Discounts with Decimal Quantity Menu Items
- Amount Off Examples
- Amount Substitution Examples

### Configuring a Combination Pricing Discount

1. Select the Enterprise, property, or zone, click **Configuration**, and then click **Discounts**.

2. Double-click an automatic discount record to open it.

3. On the **Auto** tab, select **4 - Combination Pricing** from the **Automatic (Automatically applied, operator cannot enter)** drop-down list.

4. (Optional) Enter a **Priority** for the discount.

   Priority determines the order in which discounts are calculated. By default, this field is blank (0) for all discounts, meaning that discounts are calculated at the same time. If you enter a priority, the workstation calculates all discounts in priority 1, then in priority 2, and so on. Priority zero (0) discounts are calculated last. The priority field allows Simphony to calculate discounts more efficiently.

5. If you are configuring an automatic coupon discount with combination pricing, enter the maximum number of times the coupon discount can be entered on a check in the **Max Count Per Check** field. Enter a value of 0 to allow the discount to be added an unlimited amount of times to the same check.

   This field is active only for automatic discounts with the **Activation Type** of **2 - Coupon (Automatically applied, operator must enter)**.

6. In the Trigger section, select up to eight unique **Trigger MI Groups** that invoke the discount. You must configure the triggers in sequential order.

7. Enter the price to charge for this combo meal in the **Amount Substitution** field.

8. Enter the maximum number of combo meals that customers can order per check in the **Max Count** field.

   In general, the **Max Count** field is set to 0 to allow an unlimited amount of combo meals on a single check.
9. Click Save.

Related Topics

- Automatic Discounts
- Automatic Discounts with Decimal Quantity Menu Items
- Amount Off Examples
- Amount Substitution Examples

Configuring a Sales Price Discount

1. Select the Enterprise, property, or zone, click Configuration, and then click Discounts.

2. Double-click an automatic discount record to open it.

3. On the Auto tab, select 5- Sales Price from the Automatic (Automatically applied, operator cannot enter) drop-down list.

4. Select the menu item groups that will trigger the discount from the Trigger MI Group drop-down list, and then select the condiment menu item groups to use as the trigger for the discount, if any from the Trigger Condiment Group drop-down list.

   For example, if customers can get a bagel for $0.50 when they add cream cheese to any bagel, cream cheese is the trigger condiment and bagel is the trigger menu item for the $0.50 discount.

5. Select discount type, and then enter the discount amount:
   - Percentage Off: If this is a percent discount, enter the percentage to discount from each item in the menu group.
   - Amount Off: If this is an amount discount, enter the amount to discount from each item in the menu group.
   - Amount Substitution: If this is an amount substitution discount, enter the price to charge for each item in the menu group.

6. If you configured a Percent Off discount, click the General tab, and then enter the maximum amount allowed for the discount in the Max Amount field.

7. Click Save.

Related Topics

- Automatic Discounts
- Automatic Discounts with Decimal Quantity Menu Items
- Amount Off Examples
- Amount Substitution Examples

Discounts With Condiments

You can apply manual, automatic, and coupon discounts to a check when a condiment item is present on the check. A workstation operator can manually apply a discount by selecting the condiment item. For example, configure a bagel to be a parent menu item and configure the condiment, such as cream cheese, to trigger a 5% discount. As
a result, when the workstation operator enters the customer order for a bagel with cream cheese, the system applies the discount after the workstation operator selects cream cheese.

Place condiments in trigger menu item groups to have Simphony apply automatic and coupon discounts.

Complete the following tasks to apply discounts when condiments are present:

- Specify the condiment to be the trigger
- Set the discount to apply to the parent menu item, condiment, or both
- Set up the discount for a condiment
- Create a discount button to appear on the workstation page

**Related Topics**
- Configuring Condiments as Discount Triggers
- Configuring Discounts for Parent Menu Items in a Menu Item Class
- Configuring a Condiment as the Discount Award
- Creating the Discount Button

### Configuring Condiments as Discount Triggers

1. Select the Enterprise, property, or zone, click **Configuration**, and then click **Menu Item Groups**.
2. Create a menu item group record and then double-click it to open.
3. Click **Add** near the Include area.
4. Select information for the fields described in the following table:

**Table 13-10 Include Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select 4 - By Menu Item.</td>
</tr>
<tr>
<td>Start #</td>
<td>Click in this field, and select the start number.</td>
</tr>
<tr>
<td>End #</td>
<td>Click in this field, but do not enter a value.</td>
</tr>
<tr>
<td>See Items and Select</td>
<td>Click the link and then select the condiment to act as the discount trigger. This condiment appears in the End # field.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Related Topics**
- Configuring Discounts for Parent Menu Items in a Menu Item Class
- Configuring a Condiment as the Discount Award
- Creating the Discount Button
Configuring Discounts for Parent Menu Items in a Menu Item Class

1. Select the Enterprise, property, or zone, click Configuration, and then click Menu Item Classes.
2. Double-click a menu item class record.
3. Click the Options tab.
4. To allow both parent and condiment items to receive the discount, select 55 - Discounts Apply to Priced Condiments (parent items only). Deselect option 55 to have only the parent item receive the discount.
5. To apply discounts to parent items in this class and to all priced condiments associated with the items, select 56 - Discounts Apply to Fixed Meal Courses (for parent items only). Deselect option 56 to prevent automatic discounts from being applied to Fixed Price Meal courses.
6. Click Save.

- Configuring Condiments as Discount Triggers
- Configuring a Condiment as the Discount Award
- Creating the Discount Button

Related Topics
- Discounts With Condiments

Configuring a Condiment as the Discount Award

1. Select the Enterprise, property, or zone, click Configuration, and then click Discounts.
2. Create the discount record and then double-click it.
3. On the General tab, enter the fields as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activation Type</td>
<td>Select the type of discount:</td>
</tr>
<tr>
<td>Percent</td>
<td>Enter the discount percentage to use a percent discount.</td>
</tr>
<tr>
<td>Max Amount</td>
<td>Enter the maximum amount allowed for the discount to use an amount discount.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Select this option to make the discount available to the workstation operator.</td>
</tr>
</tbody>
</table>

(If you configure a temporary discount, you can quickly turn it off.)
### Table 13-11  (Cont.) Discount Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condiment Discountability</td>
<td>Select the discount method for condiment menu items:</td>
</tr>
<tr>
<td></td>
<td>• 0 - <strong>Use MI Class Option</strong>: You must also select Menu Item Class option 55 - Discounts Apply to Priced Condiments (parent items only).</td>
</tr>
<tr>
<td></td>
<td>• 1 - <strong>Parent Items Only</strong>: Selecting this option applies the discount only to the parent menu item.</td>
</tr>
<tr>
<td></td>
<td>• 2 - <strong>Condiment Items Only</strong>: Selecting this option applies the discount to the trigger condiment and to all condiments associated with the check.</td>
</tr>
<tr>
<td></td>
<td>• 3 - <strong>Parent and Highlighted Condiment Items</strong>: This option is available only for manual discounts.</td>
</tr>
<tr>
<td></td>
<td>• 4 - <strong>Parent and All Condiment Items</strong>: Selecting this option applies the discount to the parent menu item and to all condiments associated with the check.</td>
</tr>
<tr>
<td>Trigger MI Group</td>
<td>Select the menu item group to trigger the discount award.</td>
</tr>
<tr>
<td></td>
<td>When a workstation operator adds the minimum quantity of items from this menu item group, the items are discounted based on the award configuration for this discount.</td>
</tr>
<tr>
<td></td>
<td>When you select 0 - <strong>Use Discount Itemizers</strong>, the only options available for the Trigger Condiment Group are 0 - <strong>None</strong> and all available condiment groups previously created.</td>
</tr>
<tr>
<td>Trigger Condiment Group</td>
<td>Select the Condiment Menu Item Group to use as the trigger for the discount.</td>
</tr>
<tr>
<td></td>
<td>This field is dimmed when the Trigger MI Group is set to 0 - <strong>Use Discount Itemizers</strong>.</td>
</tr>
<tr>
<td></td>
<td>This is an alternative method to using discount itemizers.</td>
</tr>
<tr>
<td></td>
<td>The discount applies to only qualifying menu items based on the selected <strong>Trigger MI Group</strong>, <strong>Trigger Condiment Group</strong>, and other discount configuration.</td>
</tr>
<tr>
<td>Options</td>
<td>Select 25 - <strong>Discount Combo Meal Group Items</strong> to discount combo group menu items. You must also select option 1 - <strong>Allow Discounts</strong> from the Combo Meal Groups module.</td>
</tr>
</tbody>
</table>

4. On the **Effectivity** tab, select the days on which the application applies the discount.

5. On the **RVC Type** tab, select the revenue centers that can use this discount.

6. On the **Menu Levels** tab, in the **Menu Level Configuration** section, select all options for **Active On Main Levels** and **Active On Sub Levels**.

7. On the **Output** tab, select the following options:
   - **Print on Customer Receipt**
   - **Print on Journal**
   - **Print on Guest Check**

8. Click **Save**.

   • Configuring Condiments as Discount Triggers
Creating the Discount Button

1. Select the Enterprise, property, or zone, click Configuration, and then click Page Design.
2. Open the page on which to place the discount button.
3. Click the Edit tab, and then select the page area in which to define the button.
4. Click Button, and then on the General subtab, select Discount from the Type drop-down list.
5. Click the black arrow directly beneath the Type drop-down list, select the discount, and then click OK.
6. Enter a Legend for the button, position and size the button on the page, and then click Save.
Service Charges

A service charge is the amount added to a sales transaction for a service rendered and is posted to one of the following parties:

- The person or people providing the service (for example, a server or bartender, or a team of servers)
- The House or the establishment providing the service

You can configure the following types of service charges:

- Service changes that report as Tips on employee tip reports
- Service changes that report as Service Charges on employee tip reports
- Service changes that are paid to the House
- Non-revenue service charges
- Gift certificates sold
- Configuring Service Charges
- Creating Service Charge Buttons
- Menu Item Fees
- Configuring Menu Item Fees

Related Topics

- Configuring Service Charges
- Creating Service Charge Buttons
- Menu Item Fees
- Configuring Menu Item Fees

Configuring Service Charges

1. Select the Enterprise, property, or zone, click Configuration, and then click Service Charges.
2. Insert the service charge record, and then double-click it.
3. On the General Settings tab, enter information in the fields as described in the following table:
### Table 14-1  General Settings Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent</td>
<td>Enter the service charge percentage. This field becomes available only when you deselect option 2 - ON = Amount; OFF = Percentage.</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter the service charge amount. This field becomes available only when you select option 2 - ON = Amount; OFF = Percentage.</td>
</tr>
<tr>
<td>Tips Paid Tender/Media</td>
<td>To link a tender to the service charge, select the Tender/Media from the drop-down list.</td>
</tr>
<tr>
<td>HALO</td>
<td>Enter the High Amount Lock Out (HALO) value for the service charge. This setting limits the amount workstation operators can enter for the service charge. To exceed this limit, the workstation operator must have the Authorize/Perform Over HALO Amounts on Service Charge Keys option set for the employee role. When you set the value to 0, there is no HALO for the service charge. This field does not apply to automatic service charges.</td>
</tr>
<tr>
<td>Tax Class</td>
<td>To apply a tax class to the service charge, select a Tax Class from the drop-down list.</td>
</tr>
<tr>
<td>Privilege Group</td>
<td>Select a Privilege Group to restrict use of this service charge to employees who are linked to the same privilege group. You can set the field to 0 to allow all employees to use the service charge.</td>
</tr>
<tr>
<td>Percent to Tips Paid</td>
<td>Enter the percentage of a charged tip that posts to the Tips Paid Tender/Media.</td>
</tr>
<tr>
<td>Report Group</td>
<td>Select the report group to which this service charge record belongs. Report groups are subcategories that allow reports to show similar service charges grouped and subtotaled together. You can configure report groups from the Report Groups module, in the Reporting section of the Property tab.</td>
</tr>
</tbody>
</table>

4. Select the Service Charge options as described in the following table:

### Table 14-2  Service Charge Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - ON = Open; OFF = Preset</td>
<td>Select this option to make the service charge an open service charge, prompting the workstation operator for the amount or percentage. Deselect this option to use a preset amount or preset percentage for the service charge.</td>
</tr>
<tr>
<td>2 - ON = Amount; OFF = Percentage</td>
<td>Select this option to make the service charge an amount service charge. Deselect this option to make the service charge a percentage service charge.</td>
</tr>
</tbody>
</table>
Table 14-2 (Cont.) Service Charge Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 - Post to Charged Tips Total on Tip Reports</td>
<td>Select this option to post the service charge to the Direct Charged Tips total. This option records charged tips that employees receive directly from customers. If you select this option, workstation operators who use it must also enter a charge payment using a tender with Tender/Media option Post to Charged Receipts on Tip Reports set. Select either 3 - Post to Charged Tips Total on Tip Reports or 11 - Do Not Post to Gross Receipts, but not both. Select either 3 - Post to Charged Tips Total on Tip Reports or 4 - Post to Service Charges Total on Tip Reports, but not both.</td>
</tr>
<tr>
<td>4 - Post to Service Charges Total on Tip Reports</td>
<td>Select this option to post the service charge to the Service Charges total, but not the Total Tips or the Gross F&amp;B Receipts total. Deselect this option to post the service charge to the Gross Food and Beverage Receipts, but not to the Service Charges total. The Service Charges total on tip reports meets the reporting requirements of United States IRS Form 8027, which states that this total should equal all tips that are paid to the employee as wages, and are less than 10% of the transaction total. Select either 3 - Post to Charged Tips Total on Tip Reports or 4 - Post to Service Charges Total on Tip Reports, but not both.</td>
</tr>
<tr>
<td>5 - Reference Entry Required</td>
<td>Select this option to require the workstation operator to enter an alphanumeric reference entry when using the service charge.</td>
</tr>
<tr>
<td>6 - Validation Required</td>
<td>Select this option to print a validation chit when the workstation operator uses the service charge.</td>
</tr>
<tr>
<td>7 - Non-Revenue Service Charge (No Post to Sales)</td>
<td>Select this option to create a service charge that does not post to Simphony sales totals. (A tracking group total can track this amount if necessary.) This option is often used to create a service charge for gift certificate sales as the customer can pay for the gift certificate with a credit card. When you select this option, you must configure the service charge as an amount service charge. A non-revenue service charge cannot post to a check that contains menu items. If a cashier link is required for tendering, a cashier link is also required for posting a non-revenue service charge. When using this option, deselect options 3 and 4.</td>
</tr>
<tr>
<td>8 - Taiwanese Paid Out</td>
<td>Select this option to create a service charge that is used to record the repayment of cash from a Taiwanese paid out.</td>
</tr>
<tr>
<td>9 - Reset Itemizer(s)</td>
<td>Select this option to reset service charge itemizers. When set, service charges can only apply once to menu items that post to the same service charge itemizers. Deselecting this option allows multiple service charges to apply to the same service charge itemizers.</td>
</tr>
</tbody>
</table>
Table 14-2  (Cont.) Service Charge Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 - Service Charge Adds to Guest Count</td>
<td>Select this option to increment the transaction’s guest count by one every time the service charge applies to the transaction. This option is often used for non-revenue service charges that apply as cover charges. Selecting the RVC Parameter option 8 - Use Number of Seats for Guest Count overrides the setting of this option. When the workstation operator presses the Number of Guests key during a transaction, the guest count no longer increments when the service charge applies to the transaction. The workstation operator must maintain the guest count manually from that point.</td>
</tr>
<tr>
<td>11 - Do Not Post to Gross Receipts</td>
<td>Select this option to prevent checks with this service charge from posting to gross F&amp;B receipts on tip reports. This is intended for service charges that meet the United States Internal Revenue Service’s definition of non-allocable receipts (as defined in the IRS Instructions for Form 8027). Deselecting this option allows the service charge to post to gross F&amp;B receipts on the tip reports. Select either 3 - Post to Charged Tips Total on Tip Reports or 11 - Do Not Post to Gross Receipts, but not both.</td>
</tr>
<tr>
<td>12 - Item is Shareable</td>
<td>Select this option to share the item between two or more seats or two or more checks when using TouchEdit or TouchSplit.</td>
</tr>
<tr>
<td>13 - Cash Tips</td>
<td>Select this option to add the Direct Cash Tips total on the tip reports. Selecting option 3 - Post to Charged Tips Total on Tip Reports or 4 - Post to Service Charges Total on Tip Reports overrides this option. This option is used in a cashier environment where the guest leaves the table and pays the check directly with a cashier. When paying the bill, the guest indicates to the cashier to give the change to the server. After receiving payment, the cashier can post a value to a Cash Tip Service Charge. This Cash Tip Service Charge posts to the employee’s Direct Cash Tips total on the Employee Tip Report.</td>
</tr>
<tr>
<td>14 - Service Charge Used For Stored Value Transactions</td>
<td>Select this option if the service charge is used for stored value transactions.</td>
</tr>
<tr>
<td>15 - Mask Account Number</td>
<td>Use this option for service charges with reference entries. Select this option to mask the account number (often a gift card number or other reference entry) on guest checks and customer receipts. Deselect this option to keep the text un-masked.</td>
</tr>
<tr>
<td>16 - Encrypt Service Charge Reference Entry</td>
<td>Use this option for service charges with reference entries. Select this option to encrypt the reference entry that is associated with the service charge. Deselect this option to post the unencrypted reference entry information to the relational database.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>17 - Use Floor Amount (Automatic Service Charges Only)</td>
<td>Select this option to require a minimum value for the automatic service charge. Then enter the minimum floor amount in the Amount field, which is only active for percentage service charges when you select option 17. This option only applies to the service charge in revenue centers where it is used as an automatic service charge.</td>
</tr>
<tr>
<td>18 - Gift Certificate Sold</td>
<td>Select this option to create a service charge that can be paid without posting to sales totals. (A tracking group total can track the amount if necessary.) This option is similar to 7 - Non-Revenue Service Charge, except that menu items can be present on the check in addition to the service charge. When you select this option, you must configure the service charge as an amount. If a tender requires a cashier link, posting a non-revenue service charge also requires a cashier link. Selecting this option dims option 7.</td>
</tr>
<tr>
<td>21 - Post To Till Totals</td>
<td>Select this option if you are using Enterprise Cash Management (ECM) and the server must be assigned to a till when applying the service charge. Deselect this option if the ECM accounting method is set to Server Banking.</td>
</tr>
<tr>
<td>22 - Add to Checks Begun/Paid Count if Non-Revenue</td>
<td>This option applies to the service charge if it is configured as non-revenue (option 7 is set). Selecting this option increases the checks begun or paid count on reports when the non-revenue service charge applies to a transaction. Deselecting this option results in no change to the checks begun or paid count.</td>
</tr>
<tr>
<td>23 - Rental Deposit</td>
<td>Select this option to use the service charge as a rental deposit. Rental deposits work with the deposit handling feature and are necessary to apply a deposit to a check. Service charges with this option set may be non-revenue service charges. However, unlike traditional non-revenue service charges, a check may contain more than one rental deposit service charge.</td>
</tr>
<tr>
<td>26 - Configure as Banquet Tip</td>
<td>Select this option to include the amount of the service charge transaction in the Tip Summary Total of the banquet check.</td>
</tr>
<tr>
<td>27 - Configure as Banquet Fee</td>
<td>Select this option to include the amount of the service charge transaction in the Fees Summary Total based upon the selected service charge on the banquet check.</td>
</tr>
<tr>
<td>28 - Cash Management Transaction Item</td>
<td>Select this option to include the service charge in Cash Management tracking and reporting.</td>
</tr>
<tr>
<td>30 - Prorate Service Charges to Menu Items</td>
<td>Select this option to prorate the service charge based on the value of the menu items. This overrides the requirement for the minimum guest count for a memo check, if the minimum guest count requirement is met for the entire check.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

- **Creating Service Charge Buttons**
Creating Service Charge Buttons

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Open the page (typically the Transaction page) on which to place the Service Charge buttons.
3. On the Edit tab, select the page area in which to define the Service Charge buttons.
4. Click Button to add a button, and then on the General subtab, select Service Charge from the Type drop-down list.
5. Click the black arrow directly beneath the Type drop-down list, select the service charge, and then click OK.
6. Enter a Legend for the button.
7. Position and size the button on the page. Use the Style arrow to change the color.
8. Click Save.

Menu Item Fees

You can apply one or more menu item service charge fees (for example, a bottle deposit and a recycling fee), which are combined as a service charge group, to a menu item. When the workstation operator adds a menu item (for example, bottled soda) that is associated with a service charge group, Simphony adds the menu item fees to the guest check under the service charge group. Auditors can track the revenue from specific menu item fees, such as a recycling fee.

Configuring Menu Item Fees

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Service Charge Groups.
2. Insert a new service charge group or double-click the existing service charge group record.
3. Add or remove service charges to be included with this service charge group using the Add and Delete links.
4. Click Save.
5. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Classes.

6. Double-click the menu item class record.

7. On the General tab, select the Service Charge Group from the drop-down list to apply to the menu item class record.

8. Click Save.

9. Select the Enterprise level, click Configuration, and then click Roles.

10. Select the role, click the Operations tab, and then click the Voids/Returns subtab.

11. Select Authorize/Perform Void of Fees.

12. Click Save.

13. Select the Enterprise, property, or revenue center, click Configuration, and then click Page Design.

14. Add the Display/Hide Menu Item Fees function key. Workstation operators use the Display/Hide Menu Item Fees function key to show or hide menu item fees on the workstation.

15. Click Save.

Related Topics

• Service Charges
• Menu Item Fees
A menu item is the foundation of transactions. Anything ordered is a menu item. In restaurants, food and drinks are menu items. In retail stores, shirts and hats are also considered menu items. Therefore, any item being sold is a menu item.

Oracle recommends configuring menu items in the following order:

- Configuring Menu Items
- Adding and Disabling Menu Items
- Configuring Employee Privileges to Edit Menu Item Definitions and Prices
- Configuring Employee Privileges for Menu Item Availability Adjustments
- Configuring Menu Item Availability for Multiple Definitions at the Workstation
- Adding the Menu Item Availability Key to the Transaction Page
- Adding Menu Item Keys to the Transaction Page
- Adding the Edit Menu Item Key to the Transaction Page
- Repeatable Menu Items
- Configuring Menu Items to be Repeatable
- Configuring a Repeat Round Button
- Menu Item Distribution
- Distributing Menu Items
• Searching and Filtering Menu Items

Configuring Menu Items

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click **Menu Item Classes**.

2. Double-click a menu item class.

3. To allow the main level of the transaction to change to another level when a workstation operator orders a menu item from this class, select a new **Main Level Popup**.

4. To allow the sub level of the transaction to change to another level when a workstation operator orders a menu item from this class, select a new **Sub Level Popup**.

5. To allow the transaction to return to the default main level after a workstation operator orders a menu item from this class, select **Main Level Default**.

6. To allow the transaction to return to the default sub level after a workstation operator orders a menu item from this class, select **Sub Level Default**.

7. Click the **Options** tab, and then select the appropriate options:

Table 15-1  Menu Item Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 - ON = Use Sub Level Pricing; OFF = Use Main Level Pricing</td>
<td>Select this option for an item with multiple price definitions, to have the workstation use sub level pricing for the menu item class.</td>
</tr>
<tr>
<td>26 - Keep Main Level With Repeat Rounds</td>
<td>Select this option to have the items in the class use the same main menu level that was in effect during the most recent service round when ordered using the Repeat Round touchscreen button.</td>
</tr>
<tr>
<td>27 - Keep Sub Level With Repeat Rounds</td>
<td>Select this option to have the items in the class use the same sub menu level that was in effect during the most recent service round when ordered using the Repeat Round touchscreen button.</td>
</tr>
<tr>
<td>28 - Print Main Level Prefix and Suffix</td>
<td>Select this option to show the main menu level prefixes or suffixes on the check detail area and print on guest checks and order receipts.</td>
</tr>
</tbody>
</table>
### Table 15-1  (Cont.) Menu Item Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>29 - Print Sub Level Prefix and Suffix</td>
<td>Select this option to show the sub menu level prefixes or suffixes on the check detail area and print on guest checks and customer receipts. Prefixes and suffixes are often used to show the size of a menu item (for example, small or large soda). It is recommended to enable this option so customers understand why different charges are applied to the same menu item. For example, a Large Soda is $2.50, and a Small Soda is $1.50. When this option is deselected, the guest check or order receipt shows two entries for Soda: one Soda for $2.50 and another Soda for $1.50. If prefixes are printing, the customer understands that the Lrg Soda is $2.50 and the Sm Soda is $1.50.</td>
</tr>
<tr>
<td>52 - Prompt to begin another item if this item is incomplete</td>
<td>Select this option to prompt workstation operators to move to the next item before completing a menu item order. To use option 52, you must deselect option 51 - Item must be complete before beginning another item. Option 52 is not used with required condiments.</td>
</tr>
<tr>
<td>69 - Prompt to lookup menu item definition based on current menu levels (Repeat Rounds)</td>
<td>Select this option to prompt workstation operators to run a menu item definition lookup based on the current active menu levels when a repeatable menu item is unavailable. You must also select options 26 - Keep Main Level With Repeat Rounds and 27 - Keep Sub Level With Repeat Rounds.</td>
</tr>
</tbody>
</table>

8. Click **Save**.

- Adding and Disabling Menu Items
- Adding Menu Item Keys to the Transaction Page

**Related Topics**
- Menu Levels

---

**Adding and Disabling Menu Items**

Adding a menu item is a different process than adding records in other EMC modules. You can add master records, definition records, and price records at the same time for the Enterprise from the Menu Item Maintenance module. These instructions explain how to add menu item master records with definition and price records. For information about adding masters, definitions, and prices individually, see the appropriate section:

- Configuring Master Records for Menu Items
- Configuring Menu Item Definitions
• Configuring Menu Item Prices

1. To add menu items from the EMC, select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Item Maintenance**.

2. Insert a record.

3. If you opened Menu Item Maintenance at the revenue center level, from the **Select a task to perform** drop-down list, select **Add Master Record from Template**.

4. Click **Select** adjacent to the **Master to Copy** field, and then select a template record.

5. Enter the **Name** of the new menu item.

6. Enter the **Record Number** of the item. By default, this field shows the next available record number after the selected record to copy.

7. If you selected **Add Master Record from Template**, select **Copy Menu Item Names** to copy all existing primary and foreign names, including Long Descriptors, from the original menu item to the new menu item.

8. If the menu item is priced the same for the entire Enterprise or property, select **Use the same price for all records**, and then enter the price in the text box next to the option.

9. If the menu item has more than one definition and price, select **Configure Prices Individually**, enter the price for the first definition in the **Price** column, and then click **OK** to add the menu item.

10. To add another menu item, click **Yes** when prompted, and repeat Steps 4 through 9.

11. When you have finished adding items, click **No**.

12. Click **Save**.

13. To disable a menu item, select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Item Maintenance**.

14. Double-click the menu item to disable.

15. Click the **General** tab, and then deselect all main and sub levels from the Menu Level Availability section.

16. Click **Save**.

• Configuring Menu Items

• Adding Menu Item Keys to the Transaction Page

Configuring Employee Privileges to Edit Menu Item Definitions and Prices

In the EMC, you must grant employees permission to edit menu item definitions and prices. The permissions enable workstation operators to change menu item definitions and prices at the property level from the workstation using the Edit Menu Item function key. The *Oracle Hospitality Simphony Manager User Guide* contains more information on Adjusting Menu Item Definitions.
Users cannot edit a menu item that is defined at the Enterprise or zone levels; users with the appropriate privileges can edit a menu item that is defined at the property level.

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Select the role type, click the Operations tab, and then click the PMC Procedures sub-tab.
3. Select options 30020 - View Menu Items to enable employees to access menu items from the workstation, 30021 - Edit Menu Item Definitions to enable employees to edit menu item definitions from the workstation, and 30022 - Edit Menu Item Prices to enable employees to edit menu item prices from the workstation.
4. Click the PMC General/Reports sub-tab.
5. Select 30001 - Run PMC to allow employees associated with the role to launch the PMC on the workstation using Function Key 300, Launch PMC.
6. Click Save.

• Adding the Edit Menu Item Key to the Transaction Page

Configuring Employee Privileges for Menu Item Availability Adjustments

In the EMC, you must grant employees permission to adjust the availability of menu items. The permission enables workstation operators to change menu item availability at the workstation using the Menu Item Availability function key. The Oracle Hospitality Simphony Manager User Guide contains more information on Adjusting Menu Item Availability.

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Select the role type, click the Operations tab, and then click the PMC Procedures sub-tab.
3. Select options 30020 - View Menu Items to enable employees to access menu items from the workstation, and 30023 - Change Menu Item Availability to enable employees associated with the role to adjust the availability of menu items from the workstation.
4. Click the PMC General/Reports sub-tab.
5. Select 30001 - Run PMC to allow employees associated with the role to launch the PMC on the workstation using Function Key 300, Launch PMC.
6. Click Save.

Configuring Menu Item Availability for Multiple Definitions at the Workstation

By default, the Menu Item Availability function key only allows workstation operators to adjust the availability of the first menu item definition. To allow workstation operators to edit all definitions of an item from the workstation:

• Adding the Edit Menu Item Key to the Transaction Page
1. Select the revenue center, click **Setup**, and then click **RVC Parameters**.

2. Click the **Options** tab, and then select **66 - Manage Menu Item Availability/Out of Item for each Menu Item Definition**.

3. Click **Save**.

Adding the Menu Item Availability Key to the Transaction Page

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Open the page (typically the Transaction page) on which to place the menu item availability function key.

3. On the **Edit** tab, select the page area in which to define the menu item availability function key.

4. Click **Button**.

5. On the **General** subtab, enter the key name in the **Legend** field.

6. From the **Type** drop-down list, select **Function**.

7. Click the black arrow beneath the **Type** drop-down list.

8. Select **Menu Item** in the Filter list, select **Menu Item Availability** in the Results list, and then click **OK**.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. Click **Save**.

Adding Menu Item Keys to the Transaction Page

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Open the page (typically the Transaction page) on which to place the menu item buttons.

3. On the **Edit** tab, select the page area in which to define the menu item buttons.

4. Click **Button** to add a button.

5. On the **General** subtab, enter the button name in the **Legend** field.

6. From the **Type** drop-down list, select **Menu Item**.

7. Click the black arrow beneath the **Type** drop-down list.

8. Select the menu item, and then click **OK**.

9. From the **Menu Item Display Name** drop-down list, select the appearance for the menu item name.

10. Position and size the button on the page. Use the Style arrow to change the color.

11. Click **Save**.

12. Repeat Steps 4 through 11 to create keys for each menu item.
Adding the Edit Menu Item Key to the Transaction Page

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Open the page (typically the Transaction page) on which to place the menu item buttons.
3. On the Edit tab, select the page area in which to define the menu item buttons.
4. Click Button.
5. On the General subtab, enter the button name in the Legend field.
6. From the Type drop-down list, select Menu Item.
7. Click the black arrow beneath the Type drop-down list.
8. Select Menu Item in the Filter list, select Edit Menu Item in the Results list, and then click OK.
9. Position and size the button on the page. Use the Style arrow to change the color.
10. Click Save.

Repeatable Menu Items

Repeat Round allows workstation operators to order several items (typically beverages or fixed price meal items) from the previous round of a guest check to the current round using a single button. Repeat Round is used when customers re-order the same menu items for another round. For example, a group of 10 people at the bar ordered 10 beverages. After drinking the beverages, they ordered another round. Rather than entering all 10 drinks again, the bartender presses the Repeat Round function key to quickly re-enter the beverage order.

If a menu item is set to check for availability, the Repeat Round function inquires and updates this status. If the availability of an item is exceeded, the entire Repeat Round process stops.

The following menu item types are not repeatable:
- Weighed menu items
- Combo meals
- Voided and returned menu items
- Menu items that are programmed to allow a decimal amount entry

Related Topics
- Configuring Menu Items to be Repeatable
- Configuring a Repeat Round Button
Configuring Menu Items to be Repeatable

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Classes.
2. Double-click a menu item class record to open it.
3. Click the Options tab, and then configure the following settings:
   - **25 - Use with Repeat Round Key**: Select if menu items in this class can be reposted on guest checks using the Repeat Round key. For an item to be repeatable, you must make all associated condiments repeatable. Else, the parent menu item does not repeat when the Repeat Round key is used.
   - **26 - Keep Main Level With Repeat Rounds**: Select for items in this class to use the same Main Menu Level that was in effect during the most recent service round when ordered using the Repeat Round key. Deselect to use current menu levels. For example, you can use a Main Level with Happy Hour prices, where Happy Hour ends at 7:00 pm. In this example, if you keep the Main Level, you will have an Extended Happy Hour.
   - **27 - Keep Sub Level With Repeat Round**: Select for items in this class to use the same Sub Menu Level that was in effect during the most recent service round when ordered using the Repeat Round key. Deselect to use current menu levels. You can use a Sub Level for menu item sizing. If a pitcher of draft beer is ordered and service totaled, the Repeat Round key repeats the pitcher if this option is selected, but repeats only a pint of draft beer if deselected.
   - **69 - Prompt to lookup menu item definition based on current menu levels (Repeat Rounds)**: Select to prompt the workstation operator to look up a menu item definition based on the current menu levels when a repeatable menu item is unavailable. You must also select options 26 - Keep Main Level With Repeat Rounds and 27 - Keep Sub Level With Repeat Rounds.
4. Click Save.

Related Topics
- Repeatable Menu Items

Configuring a Repeat Round Button

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Open the page on which to place the Repeat Round button.
3. Click the Edit tab, and then select the page area in which to define the button.
4. Click Button, and then on the General subtab, select Function from the Type drop-down list.
5. Click the black arrow directly beneath the Type drop-down list, select Transaction from the Type pane, and then select Repeat Round.
6. Enter a Legend for the button (for example, Repeat Round), position and size the button on the page, and then click Save.
Menu Item Distribution

Menu Item Distribution is the method of distributing menu item records in the Menu Item Maintenance module. Because the Menu Item Maintenance module allows the configuration of multiple record types (Menu Item Masters, Menu Item Definitions, and Menu Item Prices), the Menu Item Distribution dialog differs from the dialogs that appear in other modules.

Distributing Menu Items

1. Select the Enterprise, property, revenue center, or zone, click the Configuration tab, and then click Menu Item Maintenance.
2. To distribute a specific set of records, use the filters to search for the items to distribute, and then select the records.
3. Click Edit on the EMC toolbar, and then select Distribute.
4. From the Destination pane, select the locations to which to distribute.
5. From the Record Type pane, select the attributes to distribute:
   - Masters: Select to distribute menu item masters.
   - Definitions: Select to distribute menu item definitions.
   - Prices: Select to distribute menu item prices.
6. From the Record Selection pane, select the records to distribute:
   - All Records: Select to copy all records from the source to the destination revenue center or property.
   - Selected Records: Select to distribute only the selected records. When distributing definitions and prices, all records for the object number are distributed. For example, if you choose to distribute definition number 1000, sequence #3, all definitions for number 1000 are distributed, not only sequence #3.
   - Specify Records: Select to enter a list or range of records to distribute, and then enter the record numbers in the text box below.
7. From the Options pane, select the appropriate options:
   - Overwrite records if they exist: Select to overwrite existing records in the destination location. If the destination record is inherited, it is not overwritten.
   - Create records if they do not exist: Select to create new records in the destination location.
   - Distribute inherited records: Select to distribute all records (defined and inherited) to the destination property. Deselect to distribute only records defined at the source property.
If destination record is inherited, create override: Select to override inherited definition records in the destination property. Deselect to keep inherited records unchanged.

Distribute Data Extensions if they exist: Select to distribute data extension values, if existing. The source and destination data extension property records must match. Deselect to prevent data extension values from distributing.

Create Masters for Definitions: Select to create new Menu Item Master records for distributed Menu Item Definition records in the destination location, if they do not currently exist. This option is only available when Definitions are being distributed without Master records. It is recommended to select this option if distributing menu items between revenue centers in different properties.

8. Click OK.

Once distribution completes, a Distribution Report appears showing all records that were created, overwritten, and any errors encountered. You can save this report by clicking Save to Disk.

Related Topics
• Menu Item Distribution

Searching and Filtering Menu Items

The Menu Item Maintenance module allows you to search for menu items. Typically several thousand menu item records are likely to exist. Searching and filtering allows you to work with only the desired menu item records. By default, no items appear in table view.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.

2. To view all records, click Search without entering search criteria.

Depending on the number of menu items, this step may take several minutes.

3. To view specific menu item records, enter information in the relevant search fields, and then click Search:

• Record Type: Select the type of record to find (Menu Item Master, Menu Item Definition, or Menu Item Price). When both a Menu Item Master and a revenue center are selected, Simphony returns only master records with definitions in the selected revenue center.

• Name Search: Enter the menu item name (partial or full) to search. Only records containing the text in the name field for the specified language are returned. Menu Item Definition and Price searches will look for the text in either the Name 1 or Name 2 fields. Entering Shrimp Cocktail returns the specific record; a family group search on Appetizers returns results more quickly.

• Major Group: Enter a major group number or a range of major group numbers to include in the search.

• Family Group: Enter a family group number or a range of family group numbers to include in the search.
• **Master Group**: Enter a menu item master group number or a range of master group numbers to include in the search.

• **Object Number or Range**: Enter an object number or range of object numbers to include in the search.

• **Show Master w/Defs Only**: Select to show only menu item master records that contain one or more definitions for this zone or property. Deselect to show all menu item master records for this level or above.

• **Map Menu Item Overrides**: Select to show the Menu Item Override indicator, which allows you to see other locations in the Enterprise where the item is configured. Deselect to exclude the Menu Item Override indicator. As the system needs to check the entire enterprise for the menu item, the search results will take longer to generate. Therefore, set this option only when there is a specific need to see this information.

• **Class**: Enter a menu item class or range of menu item classes to include in the search when querying menu item definitions or menu item prices.

• **SLU**: Enter a SLU or range of SLUs to include in the search when querying menu item definitions or menu item prices.

• **Sales Itemizer**: Enter a sales itemizer or range of sales itemizers to include in the search when querying menu item definitions or menu item prices.

Related Topics

• **Menu Item Distribution**
Categorizing Menu Items into Groups

Both major groups and family groups categorize menu items and sales. Every menu item belongs to a major group and to a family group.

A major group is a basic category of a menu item, such as Food or Liquor. For example, you can configure major groups to represent revenue centers so that an accountant can see sales figures for a tenant.

A family group is a category of menu items.

• Configuring Major Groups
• Configuring Family Groups

Related Topics
• Configuring Menu Item Groups
• Menu Item Groups

Related Topics
• Configuring Major Groups
• Menu Item Groups

Related Topics
• Configuring Family Groups

Configuring Major Groups

1. Select the Enterprise, property, or zone, click Configuration, and then click Major Groups.

2. Insert a new record, and then enter a name for the major group (for example, Food).

3. Enter a number other than 0 (zero) in the Report Group field.
   For example, you can enter 1 for the Food major group and enter 2 for the Liquor major group. When you enter 0 (zero), the menu item does not appear on the Menu Item Report.

4. Click Save.

Related Topics
• Categorizing Menu Items into Groups
• Menu Item Groups

Configuring Family Groups

1. Select the Enterprise, property, or zone, click Configuration, and then click Family Groups.
2. Insert a new record, and then enter a name for the family group (for example, Appetizers).

3. Enter a number other than 0 (zero) in the Report Group field.
   For example, you can enter 1 for all family groups associated with Food and enter 2 for all family groups associated with Liquor. When you enter 0 (zero), the menu item does not appear on the Menu Item Report.

4. (Optional) Select the Parent Major Group to which the new family group belongs.

5. Click Save.

Related Topics

• Categorizing Menu Items into Groups
• Menu Item Groups
Menu Item Master Records

A menu item master record is configured at the Enterprise level and is inherited by all properties. This record resides at the top of the menu item hierarchy, and its primary purpose is to appear in reports. A menu item master:

- Does not appear on workstation touchscreens
- Does not have a price

A menu item can have only one menu item master per property (for example, one Shrimp Cocktail master record exists).

- Configuring Master Records for Menu Items

Related Topics
- Configuring Master Records for Menu Items

Configuring Master Records for Menu Items

You can add master records for menu items, along with menu item definitions and prices, using a template record. If you are creating a new property and there are no template records to use, at first you can add only a menu item master record, and then add menu item definition and price records later.

If a menu item name includes the special characters, $#$, they are replaced with the object number of the record being created. For example, if the name is My Record $#$, and is being inserted into object number 4, the new record is created as My Record 4.

1. Select the Enterprise level, click Configuration, and then click Menu Item Maintenance.
2. Click Insert on the toolbar.
3. To add a master record using a template:
   a. From the Select a task to perform drop-down list, select Add Master Record from Template, and then select the menu item to use as the template from Master to Copy.
   b. Enter the Name of the new menu item, select the Report Master, and then enter the Record Number for the menu item master record.
   c. To copy all menu item names from the original menu item template, select Copy Menu Item Name.
   d. To modify the prices of each menu item definition, select Configure Prices Individually, and then enter the price for each definition in the table.

This is the default setting. This option is used for menu items that do not use the same price in every revenue center. That is, multiple price records exist in a single revenue center for a single definition. If the Price Level field in the table is blank, the record has no price (it is probably a condiment), and no price will be created.
To define a single price for all menu item definitions, select **Use same price for all records**, and then enter the price in the adjacent field.

This option is used for menu items that are priced the same system-wide. It creates a menu item with the same price for every definition and price record. If the Price Level field in the table is blank, the record has no price (it is probably a condiment), and no price will be created. You can modify the price of a definition at any time.

4. To add a master record without a template:
   a. From the **Select a task to perform** drop-down list, select **Add Master Record Without a Template**, and then enter the **Name** of the new menu item.
   b. Select a **Major Group** and a **Family Group** for the menu item.
   c. Enter a **Report Group** number between 1 and 99 for the menu item.

   Menu Item Reports sort and list subtotals by **Report Group**. When the **Report Group** number is 0 (zero), the menu item does not show on Menu Item Reports.

   d. Select the appropriate value for the object number:
      - To insert the menu item in the next available position, select **Next Available Position**.
      - To define the record number or range for the new menu item record or records, select **Record Number Or Range**, and then enter the record numbers or ranges.
      - To insert the menu item at the next available record number after the currently selected record, select **After currently selected record**. For example, if you have record #50 selected and records 51 through 53 also exist, the new menu item is created in record #54.

5. Click **OK**.

6. (Optional) Select the **Master Group** for the Menu Item Master record.

   A Menu Item Master Group is a collection of Menu Item Masters. The group is used for conversational ordering to allow the menu item master to be switched based on levels or other conditions.

7. Double-click the new master record to open it.

8. Click the **Production Item** tab, click **Add** and then, configure the following settings:
   - **Production Item Name**: Select the name of the production item. You can add more than one distinct production item.
   - **Production Item Count**: Enter the number of portions required to complete the menu item. The count must be between 1000.00 and 0.00. For example, a hamburger would require a single hamburger patty, while a double-cheeseburger would require 2 patties. You can enter half, quarter, and so on.

9. Click **Save**.

**Related Topics**

- **Menu Item Master Records**
Menu Item Search and Report

To prevent the addition of unnecessary menu item records, privileged users can run the Module Reference Report to search and review the system for existing menu item names or record numbers (or range of record numbers). This report shows the location of items and overrides throughout the Enterprise. The report appears in two views: tree view and text view.

- Generating the Module Reference Report

Generating the Module Reference Report

1. Select the Enterprise level, click the Tasks tab, and then click Module Reference Report.

2. Select the appropriate Report Type:
   - By Name: Select to search for menu items by name.
   - By Number: Select to search for menu items by record number.

3. Click Select Items for Report, select the menu item names or numbers to include in the search, and then click OK.

   Select multiple menu items by pressing the CTRL or SHIFT key while selecting an item. You can select a maximum of 50 items at a time.

4. Click Run Report by Name or Run Report by Number to generate the report.

5. To print the report, click the Text View tab, and then click Print.

6. To save the report as a text file, click the Text View tab, click Save as Text File, and then enter the file name and browse to the location to save the file.
Menu Item Classes

A menu item class consists of a set of options that apply to similar menu items in a revenue center. A menu item class specifies information, including:

- The tax class associated with the menu items
- The two types of menu items: Regular and Condiments
- Active menu levels after ordering an item from the class
- The order devices to which the items output

You can configure similar menu items into a class rather than individually setting each menu item’s order device output or condiment settings. For example, the menu items Cola, Diet Cola, and Root Beer all share the following characteristics:

- Receive the same tax rates
- Do not require condiments
- Output to the same order device

Therefore, you can create one menu item class called Soda and make all soda menu items a part of this class.

Configuring Menu Item Classes

For information about configuring menu item classes for condiments and fixed price meals, see Creating Menu Item Classes for Condiment Groups.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Classes.
2. Insert a new record, and then enter a name for the new menu item class.
3. Double-click the new menu item class.
4. On the General tab, configure the appropriate settings:
### Table 19-1  General Menu Item Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Class</td>
<td>Select the tax class to apply to the menu item class. To leave the tax class blank, select 0 - None.&lt;br&gt;&lt;br&gt;See <a href="#">Tax Rates and Tax Classes</a> for more information about tax classes.</td>
</tr>
<tr>
<td>Main Level Popup</td>
<td>Select the Main Level of the transaction that becomes active after ordering a menu item from the menu item class.</td>
</tr>
<tr>
<td>Sub Level Popup</td>
<td>Select the Sub Level of the transaction that becomes active after ordering a menu item from the menu item class.</td>
</tr>
<tr>
<td>Privilege Group</td>
<td>Select a Privilege Group number to restrict the use of menu items in the menu item class to employees who are linked to the same Privilege Group. To enable all employees to order items in the menu item class, select 0 (zero).</td>
</tr>
<tr>
<td>Sales Itemizer</td>
<td>Select the Sales Itemizer that is associated with this Menu Item Class. The Sales Itemizer is often used for interface (Property Management System) purposes, or to replace the Subtotal on printed guest checks and customer receipts. You can either see the Subtotal, or Food, Liquor, Beer, and Wine.</td>
</tr>
<tr>
<td>Discount Itemizer</td>
<td>Select the discount itemizer to determine which discounts can apply to specific menu items.</td>
</tr>
<tr>
<td>Srv Chrg Itemizer</td>
<td>Select the Service Charge Itemizer that is associated with this Menu Item Class. The Service Charge Itemizer is used to determine which Service Charges can be applied to specific menu items. Note that the automatic service charge is unaffected by this setting; only Menu Item Class Option 12 - Add to Automatic Service Charge Itemizer affects the Automatic Service Charge posting.</td>
</tr>
</tbody>
</table>
### Table 19-1 (Cont.) General Menu Item Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HALO</td>
<td>Enter the High Amount Lock Out (HALO) value for menu items in this Menu Item Class. This field represents the total dollar amount of the items that are being ordered, and it is often used for Open Priced menu items. For example, if this field is set to 50, the operator is prompted to confirm items in this class if they exceed 50.00. Note that the entered value must contain all zeroes except for the first digit. Valid values are: 2, 20, 200, 2000. Invalid values are 45, 450, 405. HALO is also often used for preset priced menu items to safeguard against erroneous entry. For example, the price of Coffee is $1.00. A workstation operator could post 1 Coffee, 5 Coffees or 10 Coffees if someone is getting coffee for their entire office. It is unlikely that someone would order 100 Coffees ($100). It is likely that someone ordering 10 Coffees inadvertently presses an extra 0 when entering the quantity.</td>
</tr>
</tbody>
</table>
| Pricing Calculation | Select the calculation method to use for pricing menu items in the class.  
  • To base the price on the amount entered, select **0 - Based on entered count**  
  • To base the price on the rounded up count, select **1 - Based on sales count when sales rounded up.** |
| Count Display | Select the manner in which the amount appears for a decimal item on the workstation and printers.  
  • **0 - Show entered amount**  
  • **1 - Show sales count amount with entered count as reference**  
  The count for an item can be entered as a decimal. There are two counts kept for an item; the entered amount, and the sales count. The sales count is always the entered amount if the entered amount is a whole number. If the entered amount is not a whole number then the sales count is the entered amount, only rounded up. For example, if a user enters 1.5, then the entered amount is 1.5 and the sales count is 2. This field determines whether the entered amount or the sales count appears on workstations and printers. |
| Count Entry | Select the manner in which workstation operators can enter the sales count of an item in the class. |
### Table 19-1  (Cont.) General Menu Item Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Group</td>
<td>Enter the Print Group (1-99). The sorting mechanism uses this value for receipt printing, check detail, and order output devices. When the items are set to use groups for sorting, the items appear from lowest group number to highest.</td>
</tr>
<tr>
<td>Print Class</td>
<td>Select the print class for the menu item class. If the Condiment Prefix Type is set to anything except 0 - Not a Prefix, prefix condiments follow the same print class setting chosen for the condiment with which they are associated.</td>
</tr>
<tr>
<td>KDS Highlight Scheme</td>
<td>Select the KDS Highlight Scheme color to display menu items on the KDS.</td>
</tr>
<tr>
<td>Condiment Prefix Type</td>
<td>Select the prefix type associated with the condiment type.</td>
</tr>
<tr>
<td>Next Page/Panel</td>
<td>Select a Page or Panel that the order screen switches to after a menu item associated with this class is ordered. • <strong>Page</strong>: From the drop-down list, select the next screen to which the workstation user is directed. • <strong>Panel</strong>: If you select a tabbed template, this area specifies which tab to navigate to after pressing the button. To use the Next Page functionality in the Menu Item Classes module, Oracle recommends that you configure a Sales SLU screen in the Page Design module, and then select this newly created SLU page from the Page drop-down list and <strong>Save</strong>. Ensure that menu items are assigned the proper SLU from the Menu Item Definition record; this allows workstation operators to add the menu item from the SLU page. To enable a hard-coded menu item key to navigate to another page, configure the Next Page/Panel fields for the actual menu item key in the Page Design module.</td>
</tr>
<tr>
<td>Maximum Refill Count</td>
<td>Enter the maximum number of refills allowed (up to 99).</td>
</tr>
<tr>
<td>Refill Descriptor</td>
<td>Enter the optional label to identify refill items when printed on order chits (up to 12 characters).</td>
</tr>
<tr>
<td>Service Charge Group</td>
<td>Select the Service Charge Group to apply to this Menu Item Class. Select 0 - None for no service charge.</td>
</tr>
</tbody>
</table>

5. Click the **Options** tab, and then select the appropriate options.
### Table 19-2  Menu Item Class Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - ON = Open-Priced Menu Items; OFF = Preset Menu Items</td>
<td>Select this option to require workstation operators to enter a price when adding a menu item in the class. Deselect this option if you are using preset prices.</td>
</tr>
<tr>
<td>3 - Negative Priced Menu Items</td>
<td>Select this option to have menu items in this class post a negative price. This option causes a minus sign (-) to appear before the price.</td>
</tr>
<tr>
<td>4 - Increment Seat Number With Sale of these Menu Items</td>
<td>Select this option to increase the seat number each time a workstation operator adds a menu item in the class. This feature is not available when seat filtering is active.</td>
</tr>
<tr>
<td>5 - Reference Entry Required</td>
<td>Select this option to require workstation operators to enter a reference entry when adding menu items in the class. The text that is entered outputs to order devices, checks, receipts, and journals.</td>
</tr>
<tr>
<td>6 - Validation Required</td>
<td>Select this option to print a validation chit at the validation printer designated in the Workstation module.</td>
</tr>
<tr>
<td>7 - Item Discounts May Be Applied to these Menu Items</td>
<td>Select this option to allow menu items in the class to be discounted with an item discount (manual discount only).</td>
</tr>
<tr>
<td>8 - Allow Menu Items in this Class to be Non-Priced</td>
<td>Select this option to allow menu items in the class to be non-priced. When selected, priced menu items in this class post a sales and count total when ordered, and appear on reports; non-priced items do not post a sales count and do not appear on reports. Priced menu items do not require an entry on the Menu Item Price form.</td>
</tr>
<tr>
<td>10 - ON = Use Sub Level Pricing; OFF = Use Main Level Pricing</td>
<td>Select this option to apply Sub Level pricing to menu items assigned to the menu item class.</td>
</tr>
<tr>
<td>11 - Add to Guest Count</td>
<td>Select this option to increase the guest count each time a workstation operator adds menu items that are assigned to the class. When this option is selected and the Guest Count field is set to 0, Simphony increments the guest count in the transaction by one. If a workstation operator uses the <strong>Number of Guests</strong> function key during a transaction, the guest count no longer increments when menu items in the class are added to the check. Revenue Center Parameters option 8 - Use Number of Seats for Guest Count overrides this option.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>12 - Add to Automatic Service Charge Itemizer</td>
<td>Select this option to add sales of the menu items in this class to the Automatic Service Charge itemizer. Automatic service charges apply to all menu items associated with Menu Item Classes where this option is enabled.</td>
</tr>
<tr>
<td>13 - Print Price on Order Chit</td>
<td>Select this option to print the menu item price on order devices. This option is typically used with open-priced menu items. Order Devices option <em>Wrap Condiments</em> overrides this option.</td>
</tr>
<tr>
<td>14 - Do Not Put in Transaction Detail</td>
<td>Select this option to prevent zero-priced or non-priced menu items in the class from printing, appearing, or posting.</td>
</tr>
<tr>
<td>17 - Print Name 1 and Name 2 on Checks</td>
<td>Select this option to print the First Name and the Second Name (from the Menu Item's Definition record) of all menu items associated with the class on guest checks. For example, with wine menu items, the First Name shows the name of the wine, while the Second Name shows the Bin Number and the type of wine.</td>
</tr>
<tr>
<td>18 - Print Name 2 on Order Output instead of Name 1</td>
<td>Select this option to print the Second Name, if defined, of menu items associated with this class on order devices. If a Second Name is not defined, the First Name is used. Order Devices option <strong>11 - Print Both Menu Item Names</strong> overrides this option.</td>
</tr>
<tr>
<td>19 - Use Name 2 on Touchscreens instead of Name 1</td>
<td>Select this option to show the Second Name, if defined, of menu items in this class on touchscreen keys. If a Second Name is not defined, the First Name is used. This applies to names shown on Menu Item and Condiment SLU’s, but not to Direct Access keys.</td>
</tr>
<tr>
<td>24 - LDS Items (International LDS Only)</td>
<td>Select this option if all menu items in this class can be ordered using an International Liquor Dispensing System (ILDS). Deselect if using a North American Dispensing System (NALDS).</td>
</tr>
<tr>
<td>33 - Do Not Download to MobileMICROS</td>
<td>Select this option to prevent items assigned this menu item class from downloading to Mobile clients. This option decreases the database size loaded onto Mobile clients, which may have tighter restrictions on memory and drive-space than regular workstation clients.</td>
</tr>
<tr>
<td>38 - Item is Shareable</td>
<td>Select this option to allow menu items in the class to be shared between two or more seats, or two or more checks.</td>
</tr>
</tbody>
</table>
### Table 19-2 (Cont.) Menu Item Class Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>39 - Retail Item</td>
<td>Select this option to designate all menu items in this class as retail items. Retail items do not post to Gross Food and Beverage receipts.</td>
</tr>
<tr>
<td>41 - Consolidate Menu Items with Condiments on Order Output</td>
<td>Select this option to consolidate parent menu items on Order Device Output, and then to print each condiment with its seat number to which the condiment applies. (The Order Device option, Print Seat Numbers with Individual Items must be enabled). For example, if this option is enabled, and an operator orders Chicken Wings with condiments ‘Extra’ and ‘Sauce’ on Seat 1, and Chicken Wings with condiments ‘Without’ and ‘Bleu Cheese’ on Seat 2, then the Order Device Output shows the following: Seat 1,2: Chicken Wings S1 Extra S1 Sauce S2 Without S2 Bleu Cheese</td>
</tr>
<tr>
<td>43 - Include in CRM/TMS Check Detail Status Update</td>
<td>Select this option to indicate whether a menu item associated with this class is sent to TMS with the check detail status message.</td>
</tr>
<tr>
<td>45 - Use KDS/Dining Course Number</td>
<td>Select this option to use KDS/Dining Coursing with the menu item class.</td>
</tr>
<tr>
<td>62 - Count Menu Item</td>
<td>Select this option to allow the menu item count to appear on the KDS or at the bottom of the requisition chit from a local or remote printer. To use the Count menu item feature with a KDS, assign a KDS Chit Layout Style containing a menu item count element (for example, #301 - Chit-Std-DOM ). You must also select the Order Devices KDS option 11 - Display Menu Item Count for the order device. To be counted, you must send a menu item to at least one KDS Display. This feature informs the expediter or bagger of how many items go into the bag for carry-out or quick service orders.</td>
</tr>
<tr>
<td>66 - Print Name 3 on Order Output instead of Name 1</td>
<td>Select this option to print the menu item definition’s Third Name, if defined, on order devices for all menu items in this class. If a Third Name is not defined, the First Name is used. Menu Item Classes option 18 - Print Name 2 on Order Output instead of Name 1 and Order Devices option 11 - Print Both Menu Item Names overrides this option.</td>
</tr>
</tbody>
</table>
### Table 19-2 (Cont.) Menu Item Class Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>68 - Print Name 3 on Checks</td>
<td>Select this option to print the menu item definition's Third Name, if defined, on guest checks for menu items in this class. 17 - Print Name 1 and Name 2 on Checks overrides this option.</td>
</tr>
<tr>
<td>70 - Use Name 2 on OCB instead of Name 1</td>
<td>Select this option to show the menu item definition's Second Name, if defined, on an Order Confirmation Board (OCB). If a Second Name is not defined, the First Name is used.</td>
</tr>
<tr>
<td>74 - Prevent Menu Items from Being Held</td>
<td>Select this option to prevent menu items belonging to this menu item class from being held.</td>
</tr>
<tr>
<td>75 - KDS Sort Priority Above Normal</td>
<td>See Prioritizing Menu Item Classes on KDS Displays in the Oracle Hospitality Simphony KDS Configuration and User Guide for more information.</td>
</tr>
<tr>
<td>76 - Post Sales Count To KDS Reports</td>
<td>Select this option to add the menu item count to the Menu Item Count totals on KDS reports.</td>
</tr>
<tr>
<td>77 - Only allow condiments with an active price record</td>
<td>Select this option to have condiment items with an active effectivity price record appear in SLUs. When the effectivity record is expired or has a future date, the condiments are not available in SLUs. You must also disable option 8 - Allow Menu Items in this Class to be Non-Priced.</td>
</tr>
</tbody>
</table>

6. Click Save.

**Related Topics**

- Menu Item Classes

**Print Groups**

Print groups are user-defined values used to sort menu items. Print groups control sorting on various types of print jobs including order chits, guest checks, and customer receipts; however, it is most commonly used for order device output. You can use print groups to:

- Sort by preparation time (items that take longer are sorted first)
- Sort by meal course (appetizers before entrees)
- Sort specific condiments last
- Change the print group of parent menu items
Print groups are programmed for a menu item class; new menu item class records are created with a default value of 1.

Related Topics

• Configuring Print Groups for Menu Item Classes

Configuring Print Groups for Menu Item Classes

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Classes.

2. Double-click a menu item class to open it.

3. On the General tab, select a Print Group for the class.
   When the items are set to use print groups for sorting, the items appear from lowest group number to highest.

4. Click Save.

Related Topics

• Print Groups
Menu Item Definitions

Menu item definitions define the menu items available within the revenue center, including:

- Screen look up (SLU) on which the menu item appears
- Menu item class to which it belongs
- Menu levels where the item is active
- Name of the item that appears on guest checks, customer receipts, order receipts, and journals

Menu item definitions are the records that customers can order. Menu item definitions appear on touchscreens and print on order chits, guest checks, and customer receipts. A menu item can have up to 64 menu item definitions in a revenue center for a single menu item master. The following figure shows the relationship between the menu item master and menu item definitions.

When customers order menu items (configured as menu item definitions), the sale count of the menu item master increases. This is the purpose of the menu item master record. Only one instance of the item needs to exist in a property, but multiple menu item definitions allow this master record to behave differently.

You can create new definitions based on an existing menu item or without using an item. You can add menu item definitions to existing menu item master records from both table and form view.

- Adding Menu Item Definition Records to Multiple Menu Item Masters
- Adding Menu Item Definition Records to a Single Menu Item Master
- Configuring Menu Item Definitions
- Allowing Users to Override Restricted Menu Item Ranges

Related Topics

- Adding Menu Item Definition Records to Multiple Menu Item Masters
- Adding Menu Item Definition Records to a Single Menu Item Master
Adding Menu Item Definition Records to Multiple Menu Item Masters

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Item Maintenance**.

2. Click **Insert**.

3. From the **Select a task to perform** drop-down list, select **Add Definition to Masters**.
   
   The drop-down list shows valid choices based on your location within the application and your privilege levels.

4. To add definitions to a menu item master record, select the menu item master record from the master record list.

5. To add definitions to multiple menu item master records, select one of the following from the **Range Type** drop-down list:
   
   a. **Record Number or Range**: Select this option if the menu item master records to receive the definitions are not in sequential order, and then enter individual record numbers or ranges (for example, 3, 5, 6-12).
   
   b. **Select Range**: Select this option if the menu item master records to receive the definitions are in sequential order, and then select the begin and end items.

6. Select one of the following methods to create the new definitions:
   
   - **Use Template**: Select this option to use an existing definition record as a template for creating the new definitions, and then select the menu item definition record to use as the template from the **Template Definition** field.
   
   - **Menu Item Class**: Select the menu item class, and then click **OK** to create new definitions from scratch (without a template).

7. Select the definitions to create for the master records from the **Definitions to Add** list.
   
   Up to 64 definitions can exist for one master record in one zone. Simphony ignores requests to create a definition sequence for a master, if it already exists.

8. If you are using a template and you want the new definitions to inherit price records, from the **Insert Price Records** drop-down list, select **Inherit Prices from Template**.

9. To add new price records for the new menu item definitions:
   
   a. From the **Insert Price Records** drop-down list, select **Specify Prices**.
   
   b. Select the **Number of Price Records** to create for the definitions.
   
   c. Enter the **Price** for the definitions.
      
      Typically, you use **Specify Prices** when the new definitions each have only one price record.

10. Click **OK** to confirm.

• Adding Menu Item Definition Records to a Single Menu Item Master
• Configuring Menu Item Definitions
• Allowing Users to Override Restricted Menu Item Ranges

Related Topics
• Menu Item Definitions

Adding Menu Item Definition Records to a Single Menu Item Master

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.

2. Double-click a master record to open it.

3. Click the Insert icon on the toolbar.

4. From the Select a task to perform drop-down list, select Add Definition Records to this Master.

   The Master field shows the Menu Item Master to receive the new definition records.

5. From the Definitions to Add list, select the number of definitions to created for the master.

   Up to 64 definitions can exist for one master record. Simphony ignores requests to create definitions greater than sequence number 64.

6. If the master record already has definitions configured, select an existing menu item definition to use as a template for the new definition record from the Use Template drop-down list.

7. To add price records when creating the definition:
   a. Select Insert Price Records.
   b. If you are not using a definition template, select the Number of Price Records to create for the definition, and then enter the default Price for the new price records.

      If using a definition template, Simphony copies the price records from the template record.

8. Click OK to confirm.


• Adding Menu Item Definition Records to Multiple Menu Item Masters
• Configuring Menu Item Definitions
• Allowing Users to Override Restricted Menu Item Ranges

Related Topics
• Menu Item Definitions
Configuring Menu Item Definitions

The Major and Family Groups assigned to the corresponding Master are shown here for reference and are generally used for filtering purposes.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.

2. Double-click the menu item master record corresponding to the definition to open it.

3. Click the General tab, and then configure information for the fields described in the following table:

Table 20-1 Menu Item Definition Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Def Sequence #</td>
<td>If more than one definition exists for this item, select the Menu Item (MI) Definition number to change to another definition of this item. For example, a Vodka menu item can have two definitions: one appears on a SLU and prompts for a modifier; and another as the item that is prompted for, for instance, if a Martini requires the type of Vodka. The definition sequence number is the number of the definition in the revenue center for the master record. Up to 64 definitions can exist in one revenue center for a single Menu Item Master record.</td>
</tr>
<tr>
<td>(Optional) First Name</td>
<td>Enter the name for the MI Definition, which appears on the workstation, KDS Displays, guest checks, customer receipts, and order device output.</td>
</tr>
<tr>
<td>(Optional) Second Name</td>
<td>Enter an alternate second name for the menu item to use on touchscreen keys or order device output depending on Menu Item Classes options 18 - Print Name 2 on Order Output instead of Name 1 and 19 - Use Name 2 on Touchscreens instead of Name 1. Leave this field blank to use the First Name by default. The output to order device printers appears double wide, showing fewer characters than single wide output. Oracle recommends enabling option 18 - Print Name 2 on Order Output instead of Name 1, because only 12 characters print to order devices, but 16 are allowed as the Definition Name. Second Name is sometimes used when the kitchen staff does not use the native language. This field is also used when Order Devices option 11 - Print Both Menu Item Names is set for a wine order device. This allows the First Name of the wine, while the Second Name represents the Bin number and type of wine.</td>
</tr>
<tr>
<td>(Optional) Third Name</td>
<td>Enter the third name for a definition to use for search operations with the Order Menu Item By Name 3 function key.</td>
</tr>
</tbody>
</table>
Table 20-1  (Cont.) Menu Item Definition Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Optional) Long Descriptor</td>
<td>Enter the descriptor to print on guest checks and receipts, below the menu item and price.</td>
</tr>
<tr>
<td>Menu Item Class</td>
<td>Select the Menu Item Class to assign to this definition.</td>
</tr>
<tr>
<td>Print Class Override</td>
<td>Select the Print Class for the menu item definition to override its menu item class setting. Select option 0 to use the menu item class setting.</td>
</tr>
<tr>
<td>KDS Prep Time Minutes Seconds Negative</td>
<td>Enter the time it takes to prepare the menu item, in Minutes or Seconds. If the item has a negative prep time (for example, a condiment that changes the item's prep time), select the Negative check box.</td>
</tr>
<tr>
<td>SLU through SLU 8</td>
<td>Select the relevant SLU numbers.</td>
</tr>
<tr>
<td>SLU Sort Priority</td>
<td>If you are using SLUs, enter a SLU sort priority number (between 1-99) for the menu item. Use this field when Touchscreen Style option Sort Screen Using Menu Item Sort Priorities is set. When configured, menu items with Sort Priority 1 appear on the screen first, followed by menu items with Sort priority 2, and so on up to Sort Priority 99, and then finally Sort Priority 0 items.</td>
</tr>
<tr>
<td>(Optional) NLU Group</td>
<td>Select the number of the NLU Group to assign to this menu item.</td>
</tr>
<tr>
<td>(Optional) NLU Number</td>
<td>Enter a unique NLU number for the menu item. Up to 12 digits are allowed.</td>
</tr>
<tr>
<td>Main Level</td>
<td>Select the Main Levels on which the definition is active (for example, you can use this field for menu item sizes, such as Small, Medium and Large, or for serving periods, such as Happy Hour). Click All to make the definition active on all Main Levels. Click None to deselect all Main Levels.</td>
</tr>
<tr>
<td>Sub Level</td>
<td>Select the Sub Levels on which the definition is active. Click All to make the definition active on all Sub Levels. Click None to deselect all Sub Levels.</td>
</tr>
<tr>
<td>Prefix Level Override</td>
<td>Select to allow the condiment prefix to override the price level of the item it modifies. You must select 65 - Support Enhanced Prefix Mode (Parent Only) in the Menu Item Class module.</td>
</tr>
<tr>
<td>(Optional) Surcharge</td>
<td>Enter the surcharge for the menu item, if 4 - Surcharge is enabled in the Tax Rates module.</td>
</tr>
<tr>
<td>Tare Weight</td>
<td>Enter the weight of the empty package for an item that is sold by weight (for example, the weight of the salad container at a salad bar, where salad is sold by weight). The Tare Weight should not be more accurate than your scale can measure, so that the application does not round. For kilograms this is to the thousandth 0.000, for pounds the hundredth 0.00, and for ounces the tenth 0.0.</td>
</tr>
</tbody>
</table>
Table 20-1   (Cont.) Menu Item Definition Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest Count</td>
<td>Enter the guest count for the menu item to increment the check guest count when added. For example, if a catering order consists of 2 Catering Appetizer Platters, each representing 10 guests as defined here, the guest count on the check is 20. You must select 11 - Add to Guest Count in the Menu Item Class module. This value does not affect the guest count when 8 - Use Number of Seats for Guest Count is set in the Revenue Center Parameters module. If the workstation operator presses the Number of Guests key during a transaction, the guest count no longer increments when menu items are added to the check.</td>
</tr>
<tr>
<td>(Optional) Quantity</td>
<td>For some menu items, you might want to assign a quantity (greater than one) to a single MI Definition record. For example, you could have one MI Definition record for ½ Dozen Donuts (whose assigned Quantity setting is 6). The default value of the Quantity field is one (1). The Quantity field is accessible from a MI Definition record and then switching to Table view. The MI Definition Quantity field also links to and enhances the Menu Item Tax Class Override feature. Configuring the Menu Item Tax Class Override contains more information about menu item tax class overriding.</td>
</tr>
</tbody>
</table>

4. Click Save.

- Adding Menu Item Definition Records to Multiple Menu Item Masters
- Adding Menu Item Definition Records to a Single Menu Item Master
- Allowing Users to Override Restricted Menu Item Ranges

Related Topics
- Menu Item Definitions

Allowing Users to Override Restricted Menu Item Ranges

You can allow users to add, edit, and delete menu item master records, definitions, and prices for menu item object numbers that are set as restricted in the Properties module.

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Double-click an employee role.
3. Click the EMC Modules tab.
4. From the Menu Items section, select the Edit privilege option for Menu Item Master Restriction.
5. Click Save.
• Adding Menu Item Definition Records to Multiple Menu Item Masters
• Adding Menu Item Definition Records to a Single Menu Item Master
• Configuring Menu Item Definitions

Related Topics
• Menu Item Definitions
Menu Item Prices

A menu item price is the amount charged for the sale of a menu item. In Simphony, menu item prices are configured per menu item definition. Typically a menu item definition has one price. However, in some cases a definition has multiple prices (for example, separate prices for a small, medium, and large soda), or no price (common for condiments).

When multiple prices are active for the current Main or Sub Level, the workstation searches the prices assigned to the definition starting with price sequence number 1, then price sequence number 2, and so on. The workstation adds the first price that meets the active level to the check. For example, based on the configuration described in the following table, the item price is $8.00 when ordered on menu level 7, and $4.00 when ordered at any other level. The workstation’s logic is:

- The current level of the transaction is level 5.
- Price number 1 for the item is active on level 7. Continue to the next price.
- Price number 2 for the item is active on level 0. This represents any level. The item is $4.00.

<table>
<thead>
<tr>
<th>Price Sequence Number</th>
<th>Price</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>8.00</td>
<td>7 - Double</td>
</tr>
<tr>
<td>2</td>
<td>4.00</td>
<td>0 - All Levels</td>
</tr>
</tbody>
</table>

When configuring multiple prices, you must always configure the 0 - All Levels price level as the last price sequence number for the definition. For example, in the following table, the configurations in the previous table are reversed.

<table>
<thead>
<tr>
<th>Price Sequence Number</th>
<th>Price</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4.00</td>
<td>0 - All Levels</td>
</tr>
<tr>
<td>2</td>
<td>8.00</td>
<td>7 - Double</td>
</tr>
</tbody>
</table>

The workstation’s logic is:

- The current level of the transaction is level 7.
- Price number 1 for the item is active on level 0; this includes all levels. The item is $4.00.

The item price $8.00 never becomes active because the 0 - All Levels price level is set as the first price sequence for the definition.

- Configuring Menu Item Prices
Configuring Menu Item Prices

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Item Maintenance**.
2. Click **Search** to show all menu items, and then double-click a menu item master record.
3. Click **Prices**, and then click the **Insert** button on the toolbar.
4. From the **Prices to Add** field, select **Price Sequence #1**, enter the **Default Price** for the menu item, and then click **OK**.
5. Configure the price record. The following table describes the price record fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price</td>
<td>Enter the menu item price amount.</td>
</tr>
<tr>
<td>(Optional) Prep Cost</td>
<td>Enter the menu item prep cost.</td>
</tr>
<tr>
<td>Tax Class Override</td>
<td>To allow the menu item price to use a different tax class than the tax class configured for the menu item definition, select a new tax class from the list. If you select <strong>0 - None</strong>, the price uses the tax class configured for the menu item class associated with the menu item definition.</td>
</tr>
<tr>
<td>Service Charge Group</td>
<td>If the price includes a service charge, select a service charge group from the list.</td>
</tr>
<tr>
<td>Active on Level</td>
<td>Select the main or sub menu level in which this price becomes active. Select <strong>0 - All Levels</strong> to make the price active for all menu levels.</td>
</tr>
<tr>
<td>Options</td>
<td>If the price applies for the item when ordered as a course for a fixed price meal, select <strong>1 - Price for Fixed Price Meal Course</strong>.</td>
</tr>
<tr>
<td></td>
<td>If the price applies when the item is ordered as a course for a fixed price meal as well as when ordered as a normal menu item entry, select <strong>2 - Price for Fixed Price Meal Course and Regular Menu Item</strong>.</td>
</tr>
<tr>
<td>Effectivity Group</td>
<td>To make the price active at a specific date and time, select the corresponding effectivity group from the list.</td>
</tr>
</tbody>
</table>

6. Click **Save**.
7. Repeat Steps 3 through 6 to add price definitions for the menu item.
Configuring Menu Item Prices for Multiple Definitions

You can define price records for multiple menu item definitions simultaneously.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.

2. (Optional) In table view, click the Definition Records tab, and then select the definitions for which to add the new price records.
   This is the most common method of adding prices to definitions.

3. Click Insert on the toolbar.

4. From the Select a task to perform drop-down list, select Add Prices to Definitions.

5. To insert the new price records to the definitions you selected in Step 2, select Selected Records from the Range Type drop-down list.
   This is the default setting if Menu Item Definitions are active in table view and you selected at least one menu item definition before accessing the Add Menu Items dialog. The selected records show beneath the Range Type drop-down list.

6. To insert the new price records into a range of menu item definitions:
   a. Select Select Range from the Range Type drop-down list.
   b. Select the first and last definition records to receive the new prices from the Begin Range and the End Range fields respectively.

7. From the Prices to Add list, select the price sequences to add for each menu item definition selected, and then enter the Price.
   Simphony ignores requests to create the same price sequence for a definition multiple times and requests to create prices greater than sequence number 8. For example, if a definition already has six prices and you choose to add three prices, Simphony does not create price 9.

8. Select the Menu Level in which the new price records become active, and then click OK.
   Prices are active on either the sub level or the main level, as dictated by the Menu Item Definition's class.
Menu Levels

Simphony uses menu levels to:

• Determine which sales items (Menu Items, Discounts, Service Charges, Tender/Medias) are available in a transaction.
• Allow different prices for one menu item.

A main menu level and a sub menu level are always active. You can determine which levels are active by default (using the menu level hierarchy) and allow workstation operators to change the levels during a transaction using a function key or menu level pop-ups. You can also configure the status bar in the upper or lower area of the workstation to show main and sub level names that are active.

Auto Menu Level

You can set the main menu level, sub menu level, or both to change automatically at a specific time of day. This configuration is called auto menu level, and controls the availability of sales detail items. For example, a revenue center can offer an Early Bird Special (Burgers are $5.00) every weekday from 3:00 p.m. to 6:00 p.m. For the Early Bird Special to automatically occur, you can set an auto menu level from 3:00 p.m. to 6:00 p.m. Monday through Friday. Set menu item definitions with multiple prices accordingly (one price for the Early Bird level and another general price).

If you configure auto menu levels to overlap, menu levels become active based on the order in which you set the auto menu levels. After the workstation determines that one level is active, it does not look at the other auto menu levels. Therefore, you must pay special attention when configuring multiple auto menu levels that occur on the same days at the same times.

According to the configuration in the following table, at 3:00 p.m. the main level become 2 - Early Bird, and at 4:00 p.m. the main level becomes 3 - Free Drinks. This occurs because the Free Drinks level is set at auto level 1, and starts after Early Bird, which is set at auto level 2.

<table>
<thead>
<tr>
<th>Number</th>
<th>Main Level</th>
<th>Start Time</th>
<th>End Time</th>
<th>Days Active</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3 - Free Drinks</td>
<td>16:00</td>
<td>17:00</td>
<td>Monday–Friday</td>
</tr>
<tr>
<td>2</td>
<td>2 - Early Bird</td>
<td>15:00</td>
<td>18:00</td>
<td>Monday–Friday</td>
</tr>
</tbody>
</table>

The workstation’s logic for these two menu levels is explained in the following table.
Table 22-2  Workstation Logic

<table>
<thead>
<tr>
<th>Time</th>
<th>Logic</th>
</tr>
</thead>
</table>
| 15:00 | Is auto level 1 active? No  
Is auto level 2 active? Yes. Active main level is 2 - Early Bird |
| 16:00 | Is auto level 1 active? Yes. Active level is 3 - Free Drinks |
| 17:00 | Is auto level 1 active? No  
Is auto level 2 active? Yes. Active main level is 2 - Early Bird |
| 18:00 | Is auto level 1 active? No  
Is auto level 2 active? No  
The main level is 1 - Regular, which is the default menu level for the revenue center |

Menu Level Hierarchy

The following menu level hierarchy determines which setting controls the default transaction menu levels:

Table 22-3  Menu Level Hierarchy

<table>
<thead>
<tr>
<th>Number</th>
<th>Enterprise Management Console (EMC) Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Serving Periods</td>
<td>If the active serving period has a main or sub level that is not 0, that is the active main or sub level.</td>
</tr>
<tr>
<td>2</td>
<td>Auto Menu Levels table</td>
<td>If the time of day falls during an active auto menu level, the main or sub level that is specified for that auto menu level is the active level.</td>
</tr>
<tr>
<td>3</td>
<td>Transaction Menu Level Defaults</td>
<td>If the main or sub level set in the RVC Parameters module is not 0, that is the active main or sub level.</td>
</tr>
<tr>
<td>4</td>
<td>Main 1 and sub 1 are always defaults</td>
<td>If the other hierarchy rules have not been met, the workstation defaults to main level 1 and sub level 1.</td>
</tr>
</tbody>
</table>

Menu Level Configuration Tasks

Setting up menu levels consists of completing the following tasks:

- Set up main, sub, and custom menu levels
- Configure the default main and sub levels for serving periods
- Configure auto menu levels
- Configure the default menu levels for a revenue center
- Configure the active menu levels for menu item definitions, prices, discounts, service charges, and Tender/Media
- Configure the functionality of menu items at the workstation
- Setting Main, Sub, and Custom Menu Levels
• Setting the Default Main and Sub Levels for Serving Periods
• Configuring Auto Menu Levels
• Setting the Default Menu Levels for a Revenue Center
• Configuring Active Menu Levels for Menu Item Definitions and Prices

Related Topics
• Setting Main, Sub, and Custom Menu Levels
• Setting the Default Main and Sub Levels for Serving Periods
• Configuring Auto Menu Levels
• Setting the Default Menu Levels for a Revenue Center
• Configuring Active Menu Levels for Menu Item Definitions and Prices
• Configuring Menu Items

Setting Main, Sub, and Custom Menu Levels

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Level Sets.

   The Type column specifies whether the Menu Level Set refers to the Main Levels, the Sub Levels, or to the levels defined within the record. Main Levels and Sub Levels are not configured in this module. However, you can create an entry for the entire Main Level Set and Sub Level Set in this module; this allows you to configure the Options and Default Master Group fields for Main and Sub levels.

2. To create a custom menu level, insert a new record, and then enter a custom level set name.

3. To define main menu levels, double-click Main.

4. To define sub menu levels, double-click Sub.

5. To define menu levels for a custom level set, double-click the new custom level that you created in Step 2.

6. Select the appropriate options:
   a. To change the menu level to the default level when the workstation operator presses a touchscreen button corresponding to any menu level in this menu level set again, select 1 - Pressing level key again reverts to default level.
   b. If the menu level set is bound to a Default Master Group and you want the POS client to switch the active parent menu item when the active menu level changes, select 2 - Bound to parent.

7. (Optional) Select the Default Master Group for the menu level set.

   This field is used for conversational ordering. If a Default Master Group is assigned, when a Menu Level in this group is pressed, Simphony determines which item from the selected Menu Item Group (if any) to apply to the check.

8. From the Menu Level Entries section, define the menu levels (for example, Small, Medium, and Large).

9. (Optional) Enter the Prefix or Suffix for each menu level to show on the check detail area and print on guest checks and customer receipts.

10. To define a menu level as the default level for the menu level set:
a. In the Options column, click the ellipsis point (...) button adjacent to the default menu level.

b. Select 1 - Default, and then click OK.

11. To define a menu level as an anonymous level for the menu level set:
   a. In the Options column, click the ellipsis point (...) button adjacent to the anonymous menu level.
   b. Select 2 - Anonymous, and then click OK.

   The Default and Anonymous menu levels are generic, and are typically used with $0.00 priced menu item definitions that have names such as [SIZE] Hot Drink or [TEMP] Drink.

12. Click Save.

Related Topics
• Menu Levels

Setting the Default Main and Sub Levels for Serving Periods

1. Select the revenue center, click Configuration, and then click Serving Periods.
2. Double-click a serving period record.
3. On the General tab, select the Default Main Level, and then select the Default Sub Level.
4. Click Save.

Related Topics
• Menu Levels

Configuring Auto Menu Levels

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Auto Menu Levels.
2. In the Start column, enter the time at which the menu level becomes active.
3. In the End column, enter the time at which the menu level becomes inactive.
4. Select the Main Level, and then select the Sub Level.
5. Click the ellipsis point (...) button from the Options column.
6. Select 1 - This Entry is Active, and then select one or more of the following options that correspond with the days that the menu level becomes active:
   • 2 - Active On Sunday
   • 3 - Active On Monday
   • 4 - Active On Tuesday
   • 5 - Active On Wednesday
   • 6 - Active On Thursday
   • 7 - Active On Friday
   • 8 - Active On Saturday
7. Click Save.

Related Topics
- Menu Levels

Setting the Default Menu Levels for a Revenue Center

1. Select the revenue center, click Setup, and then click RVC Parameters.
2. On the General tab, select the Default Main Level, and then select the Default Sub Level.
3. Click the Options tab, and then set the main and sub menu levels as follows:
   - To set the workstation to remain at the current main menu level after completing a transaction, select 23 - Retain Current Main Level after a Transaction.
   - To set the workstation to remain at the current sub menu level after completing a transaction, select 24 - Retain Current Sub Level after a Transaction.
4. Click Save.

Related Topics
- Menu Levels

Configuring Active Menu Levels for Menu Item Definitions and Prices

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.
2. Search for and then double-click a menu item master record.
3. If the menu item has multiple definitions, select a definition, and then click the General tab.
4. From the Menu Level Availability section, select the active main and sub levels for the item.
5. To set the menu item definition as active on all menu levels, click All.
6. To set the menu item definition as active on a custom menu level:
   a. Click Menu Levels Tab, select a Menu Level Set, and then select the menu levels.
   b. To set the definition as active on all custom levels, select Active on All Levels.
7. If the menu item has multiple price records click Prices, and then select the Active Menu Level for each price definition.
   When menu items are assigned to a class which uses sub level pricing (Menu Item Class option 10 - ON = Use Sub Level Pricing; OFF = Use Main Level Pricing is set), Simphony lists sub levels.
8. Click Save.
Related Topics

- Menu Levels
Sales Itemizers

Sales itemizers are used with PMS postings and other third-party interfaces. When the workstation operator adds items to a check, Simphony maintains various subtotals, known as itemizers, in the background. An itemizer is a bucket where totals accumulate. Simphony uses sales itemizers to separate menu item sales into categories such as food, beverage, and merchandise. You can configure up to 16 sales itemizers, which can output in the Summary Totals section of a guest check or customer receipt in lieu of the Subtotal.

- Configuring Sales Itemizers

### Configuring Sales Itemizers

1. Select the Enterprise level, click **Descriptors**, and then click **Sales Itemizers**.
2. In the **Text** column, enter the names for each descriptor.
3. Click **Save**.
Screen Look Up (SLU)

A screen look up (SLU) is a touchscreen button that gives workstation operators access to a list of items, except the workstation shows each item in the list as a separate touchscreen button. For example, the Open Check SLU shows separate touchscreen buttons for each open check within the revenue center. When a workstation operator presses a menu item SLU (for example, appetizers), the workstation shows all menu items belonging to that SLU. Typically menu item buttons are not added directly to a touchscreen, but instead menu items are usually linked to SLUs.

You can configure screen look ups for the following items:

- Menu Items
- Discounts
- Service Charges
- Family Groups
- Major Groups
- Custom Reports
- Open Checks
- Configuring Screen Look Ups for Menu Items
- Configuring Screen Look Ups for Discounts
- Configuring Screen Look Ups for Service Charges
- Configuring Menu Item Screen Look Ups by Family Group
- Configuring Menu Item Screen Look Ups by Major Group
- Configuring Screen Look Ups for Custom Reports
- Configuring Screen Look Ups for Open Checks

Configuring Screen Look Ups for Menu Items

1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and then click Menu Item.
2. Insert a new record, enter a name for the menu item screen look up (for example, Breakfast) in the Record Name field, and then click OK.
3. Repeat Step 2 to add more SLUs, and then click Save.
4. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.
5. Double-click a menu item, and then click General.
6. Select the relevant SLU from the Touchscreen Properties section.
7. (Optional) Select a Mobile MICROS SLU key for the definition.
When the operator presses a SLU button on the Mobile MICROS device, all menu items belonging to that SLU appear. Do not link more than 1,024 menu items to a single MMH SLU.

8. (Optional) Enter a SLU Sort Priority (between 1-99) for the menu item.

Use this field when Touchscreen Style option Sort Screen Using Menu Item Sort Priorities is set. When configured, menu items with Sort Priority 1 appear on the screen first, followed by menu items with Sort priority 2, and so on up to Sort Priority 99, and then finally Sort Priority 0 items.

9. Repeat Steps 5 through 8 for all menu items to appear on screen lookups.

10. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

11. Double-click the transaction page on which you want the screen look up to appear on the workstation.

12. Click Other in the Page Design toolbar, and then click Sales SLU.

13. Select Menu Item from the Type drop-down list, select SLU as the Property, and then select the menu item screen lookup as the Value.

14. Select the Menu Item Display Name, and then click Save.

15. If the revenue center uses hand held POS client devices:
   a. Select Dynamic SLU as the Property, and then select a menu item screen look up group as the SLU Value.
   b. Enter a non-zero value for the Visual State(s).
   
   The application uses the Visual State value to link menu item screen look ups with their corresponding Visual State buttons, which workstation operators use to change the menu items that appear in the Dynamic SLU.
   c. To add more screen look ups to the Dynamic SLU, click Add.
   d. Select the Menu Item Display Name, and then click Save.
   e. Insert buttons for each screen look up that you added to the Dynamic SLU.
   
   For example, if you added five screen look up groups to the Dynamic SLU, insert five buttons.
   f. Select Function from the Type drop-down list, and then select Visual State from the Function list.
   g. In the Arguments field, enter the Visual State value that you assigned to a screen look up group in Step 14-b.
   h. Click Save.

- Configuring Screen Look Ups for Discounts
- Configuring Screen Look Ups for Service Charges
- Configuring Menu Item Screen Look Ups by Family Group
- Configuring Menu Item Screen Look Ups by Major Group
- Configuring Screen Look Ups for Custom Reports
- Configuring Screen Look Ups for Open Checks
Configuring Screen Look Ups for Discounts

1. Select the Enterprise, property, or zone, click Descriptors, and then click Discount.
2. Enter names for discount screen look up groups in the Text column, and then click Save.
3. Select the Enterprise property, or zone, click Configuration, and then click Discounts.
4. Double-click a record, and then click NLU/SLU.
5. Select the relevant SLU for the discount, and then click Save.
6. Repeat Steps 3 through 5 for all discounts to appear in screen lookups.
7. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
8. Double-click the transaction page on which you want the screen look up to appear on the workstation.
9. Click Other in the Page Design toolbar, and then click Sales SLU.
10. Select Discount from the Type drop-down list, and then select the discount screen lookup from the Value drop-down list.
11. Click Save.

- Configuring Screen Look Ups for Menu Items
- Configuring Screen Look Ups for Service Charges
- Configuring Menu Item Screen Look Ups by Family Group
- Configuring Menu Item Screen Look Ups by Major Group
- Configuring Screen Look Ups for Custom Reports
- Configuring Screen Look Ups for Open Checks

Configuring Screen Look Ups for Service Charges

1. Select the Enterprise property, or zone, click Descriptors, and then click Service Charge.
2. Enter names for service charge screen look ups in the Text column.
3. Click Save.
4. Select the Enterprise property, or zone, click Configuration, and then click Service Charges.
5. Double-click a record, and then click NLU/SLU.
6. Select the relevant SLU for the service charge.
7. Click Save.
8. Repeat Steps 4 through 7 for all service charges to appear in screen lookups.
9. Select the Enterprise, property, revenue center, or zone, click Configuration and, and then click Page Design.
10. Double-click the transaction page on which you want the screen look up to appear on the workstation.

11. Click Other in the Page Design toolbar, and then click Sales SLU.

12. Select Service Charge from the Type drop-down list, and then select the service charge screen lookup as the Value.

13. Click Save.

• Configuring Screen Look Ups for Menu Items
• Configuring Screen Look Ups for Discounts
• Configuring Menu Item Screen Look Ups by Family Group
• Configuring Menu Item Screen Look Ups by Major Group
• Configuring Screen Look Ups for Custom Reports
• Configuring Screen Look Ups for Open Checks

Configuring Menu Item Screen Look Ups by Family Group

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

2. Double-click the transaction page on which you want the screen look up to appear on the workstation.

3. Click Other in the Page Design toolbar, and then click Sales SLU.

4. Select Menu Item from the Type drop-down list, select Family Group as the Property, and then select the family group to show in the screen look up as the Value.

5. Select the Menu Item Display Name.

6. Click Save.

• Configuring Screen Look Ups for Menu Items
• Configuring Screen Look Ups for Discounts
• Configuring Screen Look Ups for Service Charges
• Configuring Menu Item Screen Look Ups by Major Group
• Configuring Screen Look Ups for Custom Reports
• Configuring Screen Look Ups for Open Checks

Configuring Menu Item Screen Look Ups by Major Group

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

2. Double-click the transaction page on which you want the screen look up to appear on the workstation.

3. Click Other in the Page Design toolbar, and then click Sales SLU.
4. Select **Menu Item** from the **Type** drop-down list, select **Major Group** as the **Property**, and then select the major group to show in the screen look up as the **Value**.

5. Select the **Menu Item Display Name**.

6. Click **Save**.

- Configuring Screen Look Ups for Menu Items
- Configuring Screen Look Ups for Discounts
- Configuring Screen Look Ups for Service Charges
- Configuring Item Screen Look Up by Family Group
- Configuring Screen Look Ups for Custom Reports
- Configuring Screen Look Ups for Open Checks

## Configuring Screen Look Ups for Custom Reports

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Double-click the transaction page on which you want the screen look up to appear on the workstation.

3. Click **Other** in the Page Design toolbar, and then click **Sales SLU**.

4. Select **Custom Report** from the **Type** drop-down list.

5. Click **Save**.

- Configuring Screen Look Ups for Menu Items
- Configuring Screen Look Ups for Discounts
- Configuring Screen Look Ups for Service Charges
- Configuring Item Screen Look Up by Family Group
- Configuring Item Screen Look Ups by Major Group
- Configuring Screen Look Ups for Open Checks

## Configuring Screen Look Ups for Open Checks

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Double-click the transaction page on which you want the screen look up to appear on the workstation.

3. Click **Other** in the Page Design toolbar, and then click **Check SLU**.

4. In the **Show Checks For** drop-down list, select one of the following:
   - **All Employees**: Select this option to set the SLU to show open checks belonging to all employees.
   - **Currently Signed In Employee**: Select this option to set the SLU to show open checks belonging to only the employee who is signed in.
5. Select the type of open checks to appear on the SLU:

<table>
<thead>
<tr>
<th>Table 24-1  Open Check Filter Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open Check SLU Option</strong></td>
</tr>
<tr>
<td>All Checks</td>
</tr>
<tr>
<td>Autofire Checks Only</td>
</tr>
<tr>
<td>All Except Autofire Checks</td>
</tr>
<tr>
<td>Checks with Held Items Only</td>
</tr>
<tr>
<td>All Except Checks with Held Items</td>
</tr>
<tr>
<td>All Except Autofire and Checks with Held Items</td>
</tr>
<tr>
<td>Autofire Checks with Held Items Only</td>
</tr>
</tbody>
</table>

6. In the **Sort Order** drop-down list, select the primary sort criteria for the SLU. Selecting a **Sort Order** option in the Page Design module simplifies SLU sorting configuration in the EMC.

<table>
<thead>
<tr>
<th>Table 24-2  Open Check Sort Order Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open Check SLU Sort Order Option</strong></td>
</tr>
<tr>
<td>Check Open Time</td>
</tr>
<tr>
<td>Table Name</td>
</tr>
<tr>
<td>Service Total Time</td>
</tr>
</tbody>
</table>

Sort Order Overrides:
When options 65 - Sort Check SLU by Table Name (in the RVC Parameters module) or 23 - Sort Check SLU by Table Name (in the Employee Classes module or the Employee Maintenance module (Operator Records tab)) are enabled, these options override the check SLU Sort Order set here in the Page Design module (described in the preceding table). When options 65 or 23 are enabled, the Page Design setting is the secondary sort order when no table name/number is used.

Sort Order Exceptions:

- When Table Name sort order is enabled, checks using a Check Name (ID), where the name or ID is a customer reference, are shown first in the Check SLU in alphabetical order so they can be easily identified.
- Autofire (future) checks are listed at the end of the check SLU, irrespective of the sort order setting, and follow regular checks chronologically sorted by scheduled fire date/time.

7. To show only open checks that belong to specific order types (for example, Dine-in or Take Out), select one or more order types from the Order Type drop-down list, and then click Add.

8. Click Save.

- Configuring Screen Look Ups for Menu Items
- Configuring Screen Look Ups for Discounts
- Configuring Screen Look Ups for Service Charges
- Configuring Menu Item Screen Look Ups by Family Group
- Configuring Menu Item Screen Look Ups by Major Group
- Configuring Screen Look Ups for Custom Reports
Number Look Up (NLU)

A number look up (NLU) is a touchscreen button that allows workstation operators to access a numbered list of items. The workstation operator can select one of the following items or enter the relevant NLU number to apply the item to the transaction:

- Discounts
- Main Levels
- Menu Items
- Service Charges
- Sub Levels
- Tender/Media

To show an item in NLU, you must configure a valid NLU number greater than zero (0) for the item. You can intentionally assign duplicate NLU numbers. If this occurs, the workstation applies the lowest numbered record (by object number) to the check. When showing discounts, service charges, and tender/media records, the workstation takes the active menu level of the transaction into consideration. For example, Chardonnay has 3 definitions used: 4-ounce pour (small), 6-ounce pour (medium), and carafe (large). All three definitions are configured with NLU 23. The workstation operator selects the Small, Medium, or Large Menu Level and the 23 menu item NLU to get the desired Chardonnay.

- Configuring Number Look Ups for Discounts
- Configuring Number Look Ups for Service Charges
- Configuring Number Look Ups for Tender/Media Records
- Configuring Number Look Ups for Main and Sub Levels
- Configuring NLU Groups

Configuring Number Look Ups for Discounts

1. Select the Enterprise or property, click Configuration, and then click Discounts.
2. Double-click a record, and then click NLU/SLU.
3. Enter a unique NLU number for the discount.
   You can enter a value between 1 and 255.
4. Click Save.
5. Repeat Steps 2 through 4 for all discounts to appear in the number look up.
6. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
7. Double-click the transaction page on which you want the number look up to appear on the workstation.

8. Insert a new button, select Function from the Type drop-down list, select Discount NLU from the Function list, and then click OK.

9. Click Save.

Configuring Number Look Ups for Service Charges

1. Select the Enterprise or property, click Configuration, and then click Service Charges.

2. Double-click a record, and then click NLU/SLU.

3. Enter a unique NLU number for the service charge.
   You can enter a value between 1 and 255.

4. Click Save.

5. Repeat Steps 2 through 4 for all service charges to appear in the number look up.

6. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

7. Double-click the transaction page on which you want the number look up to appear on the workstation.

8. Insert a new button, select Function from the Type drop-down list, select Service Charge NLU from the Function list, and then click OK.

9. Click Save.

Configuring Number Look Ups for Tender/Media Records

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Double-click a record.

3. Enter a unique NLU number for the tender/media record.
   You can enter a value between 1 and 255.

4. Click Save.

5. Repeat Steps 2 through 4 for all tender/media records to appear in the number look up.

6. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
7. Double-click the transaction page on which you want the number look up to appear on the workstation.

8. Insert a new button, select Function from the Type drop-down list, select Tender/Media NLU from the Function list, and then click OK.

9. Click Save.

• Configuring Number Look Ups for Discounts
• Configuring Number Look Ups for Service Charges
• Configuring Number Look Ups for Main and Sub Levels

Configuring Number Look Ups for Main and Sub Levels

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

2. Double-click the transaction page on which you want the number look up to appear on the workstation.

3. Insert a new button, select Function from the Type drop-down list, select either Main Level NLU or Sub Level NLU from the Function list, and then click OK.

4. Click Save.

• Configuring Number Look Ups for Discounts
• Configuring Number Look Ups for Service Charges
• Configuring Number Look Ups for Tender/Media Records

Configuring Number Lookups for Menu Items

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.

2. Double-click a menu item, and then click the General tab.

3. Select the relevant NLU Group from the Number Lookup Properties section.

4. Enter a unique NLU Number for the discount. Up to 12 digits are allowed

5. Click Save.

6. Repeat Steps 2 through 5 for all menu items to appear in the number look up.

7. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

8. Double-click the transaction page on which you want the number look up to appear on the workstation.

9. Insert a new button, select Function from the Type drop-down list, select Menu Item NLU from the Function list, and then click OK.

10. Click Save.
Configuring NLU Groups

An NLU Group contains menu items that workstation operators can scan with a barcode scanner to look up items.

1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and then click NLU Names.
2. In the Text field, enter the NLU Group name (for example, Barcode Items).
   You can configure up to 32 NLU Groups.
3. Click Save.
4. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.
5. Select a menu item record (for example, potato chips).
6. Select the NLU Group to associate with the menu item.
7. Enter the NLU number or barcode value in the NLU Number field.
8. Repeat Steps 5 through 7 for each menu item that associates with an NLU Group.
9. Click Save.
Weighed Menu Items

A weighed menu item is measured in ounces, pounds, or kilograms and is priced per unit of measurement (for example, lobster is sold by the pound). You can measure the weight manually or automatically. The workstation calculates the price regardless of the weight entry method.

- Manual: The workstation operator is prompted to enter the weight of the item if the scale is not connected.
- Automatic: A scale attached to a workstation can automatically calculate the weight of the item.

Tare weight is the weight of a container or wrapper that is deducted from the gross weight to obtain the net weight. For example, in a restaurant with a salad bar where salad is sold by weight, the customer should not be charged for the weight of the container. To prevent this, a tare weight is configured for the salad menu item, and the weight of the salad's container is automatically subtracted from the weight of the salad.

The weight and tare weight (if set) appear for a weighed menu item on guest checks and customer receipts. The weight formatting meets the United States Department of Agriculture Weights and Measures requirements for scale certification. The weight is determined by the Unit of Measure (UOM) as follows:

- Kilograms: 0.000
- Pounds: 0.00
- Ounces: 0.0

The UOM must match in the Enterprise Management Console (EMC) configuration and on the scale setting. For example, the scale must measure in ounces and EMC must be set to use ounces.

- Configuring a Weighed Menu Item
- Setting the Tare Weight for a Menu Item

Related Topics

- Setting the Tare Weight for a Menu Item
- Configuring a Weighed Menu Item
- Configuring a Scale

Configuring a Weighed Menu Item

There are two methods of configuring a weighed menu item. You can use one of the following:

1. Assign the menu item to a menu item class that has option 15 - Weighed Items set.
2. Configure a Tare Weight for the menu item definition. See Setting the Tare Weight for a Menu Item for more information.
Setting the Tare Weight for a Menu Item

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.
2. Click Search to show all menu items, and then double-click a menu item master record.
3. Click the Definition Records tab in the lower area of the screen.
4. In the Tare Weight field, enter the weight of the empty package for an item that is sold by weight (for example, the weight of the salad container at a salad bar, where salad is sold by weight).
   
   The Tare Weight should not be more accurate than your scale can measure so that the application does not round. For kilograms this is to the thousandth 0.000, for pounds the hundredth 0.00, and for ounces the tenth 0.0.
5. Click Save.
6. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Control Parameters.
7. Click the Options tab, and then select 13 - Convert Weight to System Unit of Measure.
   
   You must set this option in the United States to comply with the Department of Agriculture Weights and Measure requirements. Setting this option allows the POS client to convert the item weight to the property’s UOM if the UOM received from a scale does not correspond to the UOM set from the Property Parameters module.
8. Click Save.
Menu Item Waste describes menu items that are not sold to customers due to reasons such as spillage, spoilage and quality standards. Menu Item Waste also includes menu items that are donated (for example, to soup kitchens, employee parties, or used for photo shoots). There are three main characteristics of a menu item waste check:

- Does not post to sales
- Deplete inventory
- Service Total and Print functions close a waste check

When menu item waste occurs, authorized workstation operators can begin a menu item waste check and then enter menu items to waste or donate. Managers can generate waste reports by revenue center, menu item, employee, and waste reason. Depending on the reasons for waste, managers can take action to reduce inventory loss. You can differentiate waste checks from other checks in the Employee Journal Report and the Check Journal Report by the Waste Check banner on the check header.

The following table lists the functional differences between menu item waste checks and guest checks.

### Table 27-1 Differences Between Waste Checks and Guest Checks

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu Item Waste Checks</th>
<th>Guest Checks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kitchen Display Systems (KDS) or screen lookups display the check</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Reopen a closed check</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Apply discounts</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Apply taxes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Apply service charges</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Apply guest count</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Return item</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Edit seat</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Split check</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Gift card or credit card operations</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Send and Stay</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Hold and Fire</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Transaction void</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Transaction return</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Menu item availability</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Complete the following tasks to configure the Menu Item Waste feature:

- Configure employee privileges to begin waste checks and run waste check reports
- Define reasons for menu items declared as waste
- Configure waste receipt headers and trailers
- (Optional) Hide price details on waste checks
- Add a Declare Waste button to the touchscreen page
- Allowing Employees to Begin Waste Checks and Run Waste Reports
- Configuring Waste Reasons
- Configuring Waste Receipt Headers and Trailers
- Hiding Price Details on Waste Checks
- Creating the Declare Waste Button

### Allowing Employees to Begin Waste Checks and Run Waste Reports

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.
2. Select the role type, and then click the **Operations** tab.
3. To allow employees associated with this role to begin waste checks and to authorize other employees to begin waste checks, select **263 - Authorize/Begin Menu Item Waste Check**.
4. Select the appropriate report privileges as described in the following table:

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Allows the Employee to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>31063 - Run Menu Item Waste Report</td>
<td>Run the Menu Item Waste Report from the workstation.</td>
</tr>
<tr>
<td>31065 - Run Waste Detail Report</td>
<td>Run the Waste Detail Report from the workstation.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

### Configuring Waste Reasons

1. Select the Enterprise level, click **Descriptors**, and then click **Void/Return/Waste Reasons**.
2. To add a new waste reason, enter a waste reason in an empty row of the Text column, and then select **2 - Use for Waste** in the Options column.
3. To use an existing void or return reason as a waste reason, select **2 - Use for Waste** in the Options column adjacent to the void or return reason. The options work independently of each other; you can set one, both, or none.

4. Click **Save**.

### Configuring Waste Receipt Headers and Trailers

When you post a waste check, the guest check printer assigned to the workstation prints a waste receipt.

1. Select the Enterprise level, and then click **Descriptors**.

2. Select one of the following options, depending on whether you want to configure receipt headers or trailers:
   - **Waste Receipt Headers**
   - **Waste Receipt Trailers**

3. Perform one of the following actions:
   - Enter text for the header or trailer in the rows of the Text column.
   - Select a check box in the **Use Logo** column, and then select a logo using the ellipsis point (...) button in the **Logo** column.

4. Click **Save**.

### Hiding Price Details on Waste Checks

A waste check measures the cost of wasted inventory as opposed to a guest check that posts the prices of menu items to the sales totals.

Complete these steps if you do not want to show prices of waste menu items in the check detail area of the workstation screen or print prices on waste receipts.

1. Select the Enterprise level, click **Setup**, and then click **Format Parameters**.

2. Click the **Options** tab, and then select **56 - Do not display/print price for Waste**.

3. Click **Save**.

### Creating the Declare Waste Button

To declare waste, you need to add the **Declare Waste** function key to a page.

1. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Page Design**.

2. Open the Front of House page on which to place the **Declare Waste** button.

3. On the **Edit** tab, select the page area in which to define the **Declare Waste** button.

4. Click **Button** to add a button.

5. On the **General** subtab, enter the button name in the **Legend** field.

6. Select **Function** from the **Type** drop-down list.

7. Click the black arrow directly beneath the **Type** drop-down list, and then select **Declare Waste**.
8. Highlight the Declare Waste button.
9. Position and size the button on the page. Use the Style arrow to change the color.
10. Click Save.
Menu Item Refills

Refills is a function that provides workstation operators the ability to reorder menu items from the previous round of a check to the current round, free of charge. It is ideal for occasions such as an all-you-can-eat buffet where customers can reorder menu items for free until the refill limit of the menu item is reached.

When a menu item with a condiment is refilled, the condiment retains its cost for the restaurant, while the sales price of the parent menu item shows a zero amount.

To control costs, only one refill is enabled for each parent menu item per service round.

- Allowing Employees to Refill Menu Items
- Making Menu Items Refillable and Configuring the Refill Limit
- Adding Refill Buttons

Related Topics
- Allowing Employees to Refill Menu Items
- Making Menu Items Refillable and Configuring the Refill Limit
- Adding Refill Buttons

Allowing Employees to Refill Menu Items

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Double-click the role type record (for example, administrator, manager or server).
3. Click the Operations tab, click the Transactions subtab, and then select 186 - Perform Menu Item Refills.
4. Click Save.

- Making Menu Items Refillable and Configuring the Refill Limit
- Adding Refill Buttons

Related Topics
- Menu Item Refills

Making Menu Items Refillable and Configuring the Refill Limit

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Classes.
2. Double-click a menu item class to open it.
3. Click the Options tab, and then select 72 - Enable Refill.
4. Click the **General** tab, and then enter maximum number of refills customers can order in the **Maximum Refill Count** field. The maximum refill count is 99.

5. Enter a label (for example, **Refill**) to identify refill items on printed order chits in the **Refill Descriptor** field. Up to 12 characters are allowed.

6. Click **Save**.

7. Repeat Steps 2 through 6 for all menu item classes that are refillable.

### Related Topics

- Allowing Employees to Refill Menu Items
- Adding Refill Buttons

---

### Adding Refill Buttons

In order for workstation operators to initiate refills for customers, you must configure touchscreen buttons for the refill function. There are two types of refill functions.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Open the page on which to place the refill buttons.

3. On the **Edit** tab, select the page area in which to define the buttons.

4. Click **Button**, and then on the General subtab, select **Function** from the **Type** drop-down list.

5. Click the black arrow directly beneath the **Type** drop-down list, and then select **Transaction** from the **Type** pane.

6. Select one of the following function keys, and then click **OK**:
   - **Refill Auto**: Shows a list of refillable items on the check for selection.
   - **Refill Interactive**: Refills only the parent menu item and allows the workstation operator to select required and allowed condiments as necessary. Only one menu item is refillable at a time using this function.

7. Enter a **Legend** for the button (for example, **Refill**), and then position and size the button on the page.

8. Repeat Steps 4 through 7 and create a button for the remaining Refill function.

9. Click **Save**.

### Related Topics

- Allowing Employees to Refill Menu Items
- Making Menu Items Refillable and Configuring the Refill Limit

---
Condiments typically provide details to the cook preparing the menu item, such as a rare steak and salad dressing. Other examples of condiments include tomatoes, onions, and pickles. In Simphony, enhanced condiment prefixes include the words extra, add, substitute, and without.

Setting up condiments consists of completing the tasks listed in the following table:

Table 29-1  Condiment Configuration Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create condiment groups</td>
<td>Configuring Condiment Groups</td>
</tr>
<tr>
<td>Create menu item classes for the condiment</td>
<td>Creating Menu Item Classes for Condiment Groups</td>
</tr>
<tr>
<td>groups</td>
<td></td>
</tr>
<tr>
<td>Create menu item master records for condiments</td>
<td>Creating Menu Item Master Records for Condiments</td>
</tr>
<tr>
<td>and assign to condiment classes</td>
<td></td>
</tr>
<tr>
<td>Create condiment sets and assign condiments</td>
<td>Configuring Condiment Sets</td>
</tr>
<tr>
<td>Assign condiments to parent menu item classes</td>
<td>Assigning Condiments to Parent Menu Item Classes</td>
</tr>
<tr>
<td>Assign default condiments to parent menu items</td>
<td>Assigning Default Condiments to Parent Menu Items</td>
</tr>
<tr>
<td>Create condiment prefixes</td>
<td>Configuring Condiment Prefixes</td>
</tr>
<tr>
<td>Configure additional settings for condiment</td>
<td>Setting Condiment Appearance</td>
</tr>
<tr>
<td>appearance on workstations, guest checks,</td>
<td></td>
</tr>
<tr>
<td>and customer receipts</td>
<td></td>
</tr>
</tbody>
</table>

• Condiment Groups and Condiment Sets
• Configuring Condiment Groups
• Creating Menu Item Classes for Condiment Groups
• Creating Menu Item Master Records for Condiments
• Configuring Condiment Sets
• Assigning Condiments to Parent Menu Item Classes
• Assigning Default Condiments to Parent Menu Items
• Condiment Prefixes
• Creating Condiment Prefix Menu Items
• Creating Menu Item Classes for Prefixes
• Using Condiment Prefixes with Menu Item Classes
• Disabling Condiment Prefixes
• Configuring Touchscreen Buttons for Condiment Prefixes
Condiment Groups and Condiment Sets

A condiment set defines the condiments that accompany the parent menu item. For example, a condiment set for a bacon cheeseburger includes the following condiments:

- Bacon
- Cheddar Cheese
- Mayonnaise
- Lettuce
- Ketchup

A condiment group defines the category to which a condiment set belongs and dictates its behavior.

Related Topics

- Configuring Condiment Groups
- Creating Menu Item Classes for Condiment Groups
- Creating Menu Item Master Records for Condiments
- Configuring Condiment Sets
- Assigning Condiments to Parent Menu Item Classes
- Assigning Default Condiments to Parent Menu Items
- Setting Condiment Appearance

Configuring Condiment Groups

1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and then click Condiment Group Names.

2. Enter condiment group names (for example, Meat Group or Cheese Group) in the Text field.

3. Click Save.

Related Topics

- Condiment Groups and Condiment Sets
Creating Menu Item Classes for Condiment Groups

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Classes.

2. Insert a new record, enter the class name, and double-click the new record.

3. On the General tab, select the Condiment Order Type from the drop-down list.
   This setting describes how the condiment is added to a check when it is ordered:
   - **0 - Add**: Select to create a new item on the check even if it already exists for that parent.
   - **1 - Increment**: Select to add the item if it does not exist for the parent or increments an existing one.
   - **2 - Replace In Condiment Group**: Select to remove any items that exist in the item's member condiment group before adding it (this simulates a radio button effect).
   - **3 - Replace In Master Group**: Select to remove any items that exist in the item's master group before adding it.
   - **4 - Toggle**: Select to toggle the item on and off.

4. Click the Options tab, and then select 2 - ON = Condiment Menu Items; OFF = Regular Menu Items.
   When you select this option, Simphony updates the Type column in table view to Condiment for this menu item class. For a menu item to be a condiment, it must belong to a class where at least one Member Condiment Group is enabled.

5. To set no charge for the condiments in this class, select 8 - Allow Menu Items in this Class to be Non-Priced.

6. To set each condiment in this class to print to a specific order device, select 22 - ON = Use Own Output Link; OFF = Use Parent's (Condiments Only).
   By default, the ideal setup of a condiment group class is to keep this option deselected and to select all order devices as the output. This ensures that the condiment always follows the parent item to its order devices. This option does not apply to Condiment Prefixes.

7. To override order device programming of the parent menu item, select 58 - Condiment order device programming overrides that of parent.
   When this option is selected, order devices programmed for the condiments class overrides the order devices defined for parent menu items. Use this option in a situation where a menu item is sent to a different order device when a specific condiment is added. For example, a Muffin served at room temperature outputs to the Pantry Order Device. Warm is set to output to the Hot Order Device. When the Condiment Warm with this option set is added to the Menu Item Muffin, the Muffin will use the Order Device output of the Warm Condiment and go to the Hot Order Device instead of the usual Pantry. This option does not function if the menu item is a Condiment Prefix.

8. Click the Condiment Groups tab, and then select the Member Condiment Groups for the class.
   For example, if the condiment class is Deli Meat Class, select Meat Group from the Member Condiment Groups list.
9. Click **Save**.

10. Repeat Steps 2 through 9 to create menu item classes for all condiment groups.

**Related Topics**
- Condiment Groups and Condiment Sets

---

**Creating Menu Item Master Records for Condiments**

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Item Maintenance**.

2. Insert a new record, and then enter the condiment name (for example, Ham).

3. Search for and then double-click the new record.

4. Insert a definition record, and then click the **General** subtab.

5. From the Name and Class section, select the **Menu Item Class** for the condiment.

6. To set a priced condiment:
   a. Click the **Prices** subtab, insert a price definition, and then enter the **Price** for the condiment.
   b. To set the price to become active at a specific menu level, select **Active On Level**, and then select the level.

7. Click **Save**.

8. Repeat Steps 2 through 6 to create menu item master records for all condiments.

**Related Topics**
- Condiment Groups and Condiment Sets

---

**Configuring Condiment Sets**

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Condiment Sets**.

2. Insert a new record, enter a name for the condiment group, and then double-click the new record.

3. Click **Add** from the Condiments section.

4. From the Menu Item column, click the ellipsis point (...) button, select a condiment from the list, and then click **OK**.

5. Enter the number of condiments that accompany the condiment group in the **Default Count** field.
   For example, if the condiment is a slice of cheddar cheese and you enter number 2 as the default count, 2 slices of cheddar cheese accompany the condiment.

6. In the **Sort Order** field, enter the order in which the workstation shows the condiment on screen.

7. If you want the condiment to remain in the order when the workstation operator changes a menu item to plain (for example, when a workstation operator changes the order to a plain bacon cheeseburger, the bacon and the cheese are not removed), click the ellipsis point (...) button from the **Options** column, select **1 - Persist On Plain**, and then click **OK**.
8. Enter the **Menu Item Definition Sequence** number that coincides with this condiment.

The Menu Item Definition Sequence number helps workstation operators switch between condiments. For example, the cheeseburger has two menu item definitions. If the customer orders definition 1, the cheeseburger should have cheddar cheese and if the customer orders definition 2, the cheeseburger should have mozzarella cheese. When configuring the condiment group for the cheeseburger, you must enter 1 as the Menu Item Definition Sequence for the condiment cheddar cheese and 2 as the Menu Item Definition Sequence for the condiment mozzarella cheese.

9. Repeat Steps 3 through 8 to add more condiments to the condiment group.

10. Click **Save**.

**Related Topics**

- Condiment Groups and Condiment Sets

---

### Assigning Condiments to Parent Menu Item Classes

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Item Classes**.

2. Double-click a parent menu item class.

3. Click the **Condiment Groups** tab, and then select the appropriate **Required Condiment Groups** and **Allowed Condiment Groups** for the class.

For example, if the parent menu item class is Sandwich Class, the required and allowed condiment groups are listed in the following table:

**Table 29-2  Examples of Required and Allowed Condiment Groups**

<table>
<thead>
<tr>
<th>Condiment Group</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Required Condiment</strong></td>
<td>Meat Group, Bread Group</td>
</tr>
<tr>
<td></td>
<td>Each Required Condiment Group that you select appears on the Forced Condiments tab. From there you can enter the <strong>Minimum</strong> and <strong>Maximum</strong> amounts for each item.</td>
</tr>
<tr>
<td><strong>Allowed Condiment</strong></td>
<td>Meat Group, Bread Group, Cheese Group, Sauce Group, and Veggie Group</td>
</tr>
</tbody>
</table>

4. (Optional) Click the **Forced Condiments** tab.

5. For each required condiment group, enter the **Minimum** and **Maximum** condiment count required to complete the order.

For example, if you set the minimum condiment count for Veggie Group as 2, the workstation operator must add two types of vegetables to complete the order.

6. To limit the number of selections that workstation operators can add from a condiment group at a certain menu level, enter the **Threshold 1** and **Threshold 2** for each required condiment group.

Typically, the menu level controls which price is used for a condiment. The threshold values allow you to determine when the price of a condiment changes, based on the number of items selected.
7. Click the **Options** tab, and then select the appropriate options as described in the following table:

### Table 29-3  Condiment Menu Item Class Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9 - Condiment Changes Print Group of Parent Menu Item</td>
<td>Select this option to have the menu items in this class use the print group of the condiment. This is used to modify the parent menu item’s Order Device Sorting. For example, you can use the condiment As Entree to modify an appetizer, forcing it to print and sort with other entrée menu items. If a parent menu item has several condiments with this option set, the last condiment for which this option is enabled determines the parent’s print group. The menu item cannot be a Condiment Prefix.</td>
</tr>
<tr>
<td>21 - Require Number of Condiments to Match Number of Parent Items</td>
<td>Select this option to match the number of the required condiments belonging to the menu item class to the number of parent menu items ordered. For example, if selected, when a workstation operator orders 3 Steak Dinner, the operator is prompted for the Meat Temperature condiment group three times. If this option is deselected and a workstation operator orders 3 Steak Dinner, the operator is prompted for the Meat Temperature condiment only once, and the cook assumes that all three steaks are to be prepared at the same temperature.</td>
</tr>
<tr>
<td>23 - Add Condiment Price to the Parent Item’s Price on Check Only</td>
<td>Select this option to have guest checks and customer receipts show the price of condiment added to the price of the menu item it is modifying. For example, a Salad is $5.00, and Blue Cheese dressing is $0.25. With option 23 set, the guest check and receipt show the price as $5.25. This option does not apply to Condiments Prefixes.</td>
</tr>
</tbody>
</table>
### Table 29-3  (Cont.) Condiment Menu Item Class Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>30 - Sort Condiments by Print Group</td>
<td>Select this option to sort condiments according to their print group. Deselect to print condiments in the order in which they were ordered. For example, Prime Rib requires three condiments: meat temperature, potato type, and salad dressing. In addition to these required condiments, which must be entered first, other condiments such as End Cut are ordered for this item. By configuring menu item class print groups to anticipate this situation, the meat temperature items are assigned to Print Group 1, the potato type and salad dressing items are assigned to Print Group 4, and the End Cut item is assigned to Print Group 2. When the item is added, the cook sees the condiments print in this order: meat temperature, End Cut, potato type, and then salad dressing. Therefore, Simphony sorted the End Cut item immediately after the meat temperature, making the order receipt more logical to read. This option does not apply to Condiment Prefixes.</td>
</tr>
<tr>
<td>41 - Consolidate Menu Items with Condiments on Order Output</td>
<td>Select this option to have order devices consolidate items with condiments and print each condiment with the seat number to which the condiment applies. You must also select 6 - Print Seat Numbers with Individual Items from the Order Devices module at the revenue center level.</td>
</tr>
<tr>
<td>42 - Consolidate Parents with Matching Condiments on Order Output</td>
<td>Select this option to have order devices consolidate parent menu items with identical condiments.</td>
</tr>
<tr>
<td>54 - Condiment entry/display relational to Parent Item's quantity</td>
<td>Select to show the number of condiments for each parent menu item. Deselect to add each condiment individually or by quantity without relation to the parent item’s quantity. Use this option based on the ordering process and flow of operations. For example, if set and there are 3 Burgers, when a workstation operator enters 2 Cheese, each Burger will get 2 cheese for a total of 6 Cheese. Because the condiments are relational to the parent item’s quantity, it only shows how many Cheese each Burger will get—in this example 2 for each Burger. If deselected, to order 2 Cheese for each Burger, workstation operators must enter 6 Cheese.</td>
</tr>
</tbody>
</table>

8. Click **Save**.
9. Repeat Steps 2 through 8 for all parent menu item classes.

Related Topics

• Condiment Groups and Condiment Sets

Assigning Default Condiments to Parent Menu Items

Default condiments are not supported with Transaction Services. If you are using Transaction Services, workstation operators need to add default condiments separately.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.

2. Search for and double-click a parent menu item record.

3. Click the Default Condiments subtab, and then click Add.

4. Click the ellipsis point (…) button from the Condiment Set column, select the condiment set, and then click OK.

5. (Optional) Enter the sort group number for the condiment set in the Sort Group column.

   All condiment sets appear in the workstation according to the Sort Group. Condiment sets in Sort Group 0 appear first, followed by 1, 2, and so on. Items that have the same Sort Group number appear as they are listed in the EMC.

6. To show the default condiments, click the ellipsis point (…) button from the Options column, and then select 1 - Display when in default state.

7. To always charge guests for the condiment count, select 2 - Charge for entire sales count, and then click OK.

   For example, if a burger comes with 2 slices of cheese by default, the guest is charged regardless of whether they order 1 or 2 slices of cheese on the burger. If you do not select this option, guests are only charged when the condiment count exceeds the default count.

8. Click Save.

Related Topics

• Condiment Groups and Condiment Sets

Condiment Prefixes

Many restaurants allow workstation operators to modify menu items, such as adding, removing, increasing and decreasing the number of condiments on the item. Workstation operators can add prefixes (for example, No, Add, Extra) before the condiment on the guest check, order devices, and customer receipts. This provides helpful preparation instructions to the kitchen staff and eliminates order confusion.

Condiment prefixes follow the same print class settings configured for the condiment to which they are associated.

Complete the following tasks to set up condiment prefixes:

• Create condiment prefix menu items
• Create menu item classes for the prefixes
• Activate and deactivate condiment prefixes
• Configure separate touchscreen buttons for condiment prefixes

**Related Topics**
• Creating Condiment Prefix Menu Items
• Creating Menu Item Classes for Prefixes
• Using Condiment Prefixes with Menu Item Classes
• Disabling Condiment Prefixes
• Configuring Touchscreen Buttons for Condiment Prefixes

### Creating Condiment Prefix Menu Items

1. Select the Enterprise, click **Configuration**, and then click **Menu Item Maintenance**.
2. Insert a new record and name it **Prefixes**.
3. Select the **Prefixes** header record and insert a new record. Enter the prefix (for example, ADD) as the name for the new menu item record.
4. Double-click the record you created in Step 3, and then click **Menu Levels Tab**.
5. Select **Active on All Levels**.
6. Click **Prices** and insert a $0 priced record.
7. Click **Save**.
8. Repeat Steps 3 through 7 to create records for the remaining prefixes.

**Related Topics**
• Condiment Prefixes

### Creating Menu Item Classes for Prefixes

1. Select the Enterprise level, click **Descriptors**, and then click **Condiment Group Names**.
2. In the **Text** field, enter a group name to appear in the POS client for the condiment prefixes.
3. Click **Save**.
4. Select the Enterprise level, click **Configuration**, and then click **Menu Item Classes**.
5. Insert a new record and name it after a prefix (for example, Add).
6. Double-click the new record.
7. On the **General** tab, select the **Condiment Prefix Type** that corresponds to the prefix menu item class that you created in Step 5:
   • **1 - Description Prefix**: Indicates that the prefix describes the condiment it modifies more clearly (for example, Lite Mayo).
   • **2 - No Prefix**: Indicates the removal of the default condiment (for example, No Cheddar).
• **3 - Add Prefix**: Indicates the addition of a non-default condiment (for example, Add American).

• **4 - Sub Prefix**: Identifies the item as replacing a default condiment with a similar condiment (for example, No American, Sub Cheddar).

• **5 - Plain Prefix**: Works like a function key. When selected, all condiments are removed from the check detail. If an item is re-added after being set to Plain, the workstation shows the items in the check detail, including default items that are placed back on the menu item. Switching the Plain key is the same as selecting the Reset key.

• **6 - Reset Prefix**: Resets the menu item to its original ordered state with no non-default condiments ordered and all of the default condiments automatically ordered.

8. Click the Options tab, and then select 2 - **ON** = Condiment Menu Items; **OFF** = Regular Menu Items and 8 - **Allow Menu Items in this Class to be Non-Priced**.

9. Click the **Condiments Group** tab.

10. From the Member Condiment Groups section, select the condiment group that you created in Step 2.

11. Click **Save**.

12. Repeat Steps 5 through 11 to configure menu item classes for the remaining prefixes.

**Related Topics**
- Condiment Prefixes

### Using Condiment Prefixes with Menu Item Classes

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Item Classes**.

2. For all regular menu item classes, select **65 - Support Enhanced Prefix Mode (Parent Only)**, and then click **OK**.

   If you are not using condiment prefixes, do not select **65 - Support Enhanced Prefix Mode (Parent Only)**.

3. Click **Save**.

**Related Topics**
- Condiment Prefixes

### Disabling Condiment Prefixes

You can disable condiment prefixes to prevent them from appearing in the Combo/Condiment Orderer.

1. Select the Enterprise level, click **Configuration**, and then click **Menu Item Classes**.

2. Double-click a regular menu item class with condiments.

3. Click the **Condiments Group** tab, and then change all Allowed Condiment Groups to Required Condiment Groups.
4. From the Allowed Condiment Groups section, select the condiment group you created in the section Creating Menu Items Classes for Prefixes.
5. Click the Forced Condiments tab, and then set the Minimum value for the previously enabled condiment groups to 0 (zero).
6. Repeat Steps 2 through 5 for all regular menu items with condiments.
7. Click Save.

Related Topics
• Condiment Prefixes

Configuring Touchscreen Buttons for Condiment Prefixes
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Locate the Combo/Condiment Orderer and deselect Allowed.
3. Click Save.
4. Insert a new button on the transaction screen, select Menu Item as the button type, and then select a prefix as the menu item (for example, ADD).
5. Enter or generate a legend for the button, and then click Save.
6. Repeat Steps 4 and 5 to configure touchscreen buttons for the remaining condiment prefixes.

Related Topics
• Condiment Prefixes

Setting Condiment Appearance
1. Select the Enterprise, property, or revenue center, click Setup, and then click Format Parameters.
2. Click the Options tab, and then select the appropriate options:
   • To show as many condiments as possible printed together on each line of guest checks and customer receipts, select 4 - Wrap Condiments on Guest Checks.
   • To hide previous round condiments and show only the parent menu item when a workstation operator picks up a check, select 35 - Hide Previous Round Condiments on Display.
   • To set the check detail area to actively sort condiments while they are added, select 45 - Sort Current Round Condiments on Screen. Condiment sorting occurs only when items are in different print groups and the parent allows condiment sorting.
3. Click Save.
4. Select the Enterprise, property, or revenue center, click Setup, and then click Control Parameters.
5. Click the Options tab, and then select the appropriate options:
To show only condiments that workstation operators are allowed to add with the parent menu item, select **37 - Enable Condiment Masking**.

To allow workstation operators to add condiments out of order (conversational ordering), select **44 - Permit Required Condiments To Be Entered Out Of Order**.

6. Click **Save**.

7. Select the revenue center, click **Setup**, and then click **Order Devices**.

8. Double-click a printer record, and then click the **Options** tab.

9. To print condiments in red font, select **10 - Print Condiments in Red (Overrides Print Class Settings)**.

10. Click **Save**.

**Related Topics**
- **Condiment Groups and Condiment Sets**

### Popup Condiment Orderer

The Popup Condiment Orderer provides a screen workflow that automatically advances the workstation operator through required condiments when adding menu items.

The Popup Condiment Orderer resides in a template. The system creates a page (based on the template) that pops up for required condiments. When adding a menu item (for example, Steak) that requires condiment selection to a transaction, the page with the template appears as a popup where the workstation operator can select the required condiment groups (for example, meat temperature and sauce).

The workstation operator can also recall a Popup Condiment Orderer to modify the required condiments of a previously ordered menu item. The workstation operator can select the parent item or condiment in the check detail or select the Recall Popup Condiment Orderer function key (depending on configuration).

Unlike the regular Condiment Orderer, the Popup Condiment Orderer automatically pops up and closes.

Complete the following tasks to set up the Popup Condiment Orderer:
- Configure a Popup Condiment Orderer page
- Configure a revenue center to use the Popup Condiment Orderer
- Configure a menu item class to use the Popup Condiment Orderer

**Related Topics**
- **Configuring a Popup Condiment Orderer Page**
- **Configuring a Revenue Center to Use the Popup Condiment Orderer**
- **Configuring Menu Items Linked to Classes to Use the Popup Condiment Orderer**

### Configuring a Popup Condiment Orderer Page

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.
2. Insert a record for **Popup Condiment Orderer** if it does not exist.

3. Double-click the record to open it.

4. Select **Specify Template**, and then select **Popup Condiment Orderer** from the **Internal Templates** list.

   The template is preset with a Condiment Orderer control and a Done button. You cannot delete these elements from the template, nor can you copy elements to this template. The Popup Condiment Orderer template supports two key functions: Void and Transaction Cancel.

5. From the **Popup Type** drop-down list, select the location for the Popup Condiment Orderer on the page. (The Popup Types do not apply to POS clients running the Android mobile operating system.)
   
   • Full Screen
   
   • Centered
   
   • Next to Check Detail Area
   
   • In Dynamic Content Area

6. Select **Allow selection in check detail area** to allow workstation operators to select the current menu item and its condiments in the check detail area while the Popup Condiment Orderer is open.

7. Select **Manually dismiss Condiment Orderer** to have the Popup Condiment Orderer remain open after the workstation operator selects all required condiments. The workstation operator must use the **Done** button to close the Popup Condiment Orderer.

   If you configure required condiment groups with a zero minimum count, select **Manually dismiss Condiment Orderer**. Otherwise the Popup Condiment Orderer automatically closes because the application meets the minimum required count (zero) before the workstation operator orders a condiment in the group.

8. (Optional) Change the page settings, such as layout and button styles. You cannot modify the dimmed settings.

9. (Optional) Repeat Steps 2 through 8 to create additional Popup Condiment Orderer pages. The POS client requires one page for initial condiment selection and subsequent editing, although you can configure two pages.

   When you designate Next Page/Panel for menu items (in menu item classes and on menu item buttons), the POS client goes to the designated page or panel after the Popup Condiment Orderer closes (either manually or automatically).

10. Click **Save**.

**Related Topics**

• **Popup Condiment Orderer**

### Configuring a Revenue Center to Use the Popup Condiment Orderer

1. Select the revenue center, click **Setup**, and then click **RVC Parameters**.
2. From the **Default Condiment Ordering Popup** drop-down list, select the default Popup Condiment Orderer Page to appear when the workstation operator adds a menu item with required condiments for the revenue center.

3. From the **Default Condiment Editing Popup** drop-down list, select the default Popup Condiment Orderer Page to appear when the workstation operator selects a menu item with required condiments in the check detail area for the revenue center.

4. Click **Save**.

**Related Topics**
- **Popup Condiment Orderer**

---

### Configuring Menu Items Linked to Classes to Use the Popup Condiment Orderer

The Popup Condiment Orderer configuration in the Menu Item Classes module overrides the revenue center configuration in the RVC Parameters module.

If you do not configure a revenue center or menu item class to use the Popup Condiment Orderer, the feature is turned off. You can use a mix of the settings. For example, you can set the revenue center to use the Popup Condiment Orderer, and set specific menu items to use the revenue center parameter, other menu items to use a different Popup Condiment Orderer, and some menu items with no popup.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Item Classes**.

2. Double-click the menu item class record.

3. From the **Condiment Order Popup** drop-down list, select the Popup Condiment Orderer Page to automatically appear when the workstation operator orders a menu item with required condiments:

   If you want the menu item class to use the Default Condiment Ordering Popup assigned to the revenue center, select **0 - Use Revenue Center Parameter**.

4. From the **Condiment Edit Popup** drop-down list, select the Popup Condiment Orderer Page to automatically appear when the workstation operator selects a menu item with required condiments in the check detail area:

   If you want the menu item class to use the Default Condiment Editing Popup assigned to the revenue center, select **0 - Use Revenue Center Parameter**.

To use gestures on transaction pages, set the **Condiment Edit Popup** to **No Popup** for the menu item classes, and use the **Recall Popup Condiment Orderer** function key to modify previously ordered required condiments.

5. Click **Save**.

**Related Topics**
- **Popup Condiment Orderer**
A combo meal consists of two or more menu items grouped together in combo meal groups and sold to the customer for a single price. Quick service restaurants typically sell combo meals to increase business by packaging the most frequently requested menu combinations (for example, hamburger, fries, and a drink) and offering them for a lower price than à la carte items.

A combo meal group allows you to configure the menu items within a group so that the POS client knows which items to combine. Two typical combo meal groups are combo sides and combo drinks. For example, you can configure a meal named Combo 1 with a primary menu item called Combo Sandwiches and additional Combo Groups (such as Combo Drinks and Combo Side Items).

A fixed price meal (FPM) is a complete meal offered at a fixed price. For example, during special occasions or holidays, restaurants sometimes serve multi-course meals with only a few menu item choices for each course, and charge a fixed total price.

There is no restriction on the number of FPMs or courses. The workstation operator can order multiple meals on the same seat. The sides can default to a placeholder menu item that the workstation operator replaces in a later round. Placeholder menu items can be shown or hidden in the check detail area.

You can configure FPMs like combo meals. Creating Combo Meal Groups contains more information about assembling required items for a FPM, and assigning alternate groups to allow guests to substitute items.

- Combo Meal Group Pricing
- Placeholder Menu Items in Combo Meals
- Creating Combo Meal Groups
- Creating Combo Meals
- Configuring Additional Combo Meal Settings
- Creating Combo Meal Pages
- Combo Meal Function Keys

### Combo Meal Group Pricing

You can use many pricing scenarios for combo meal groups, as described in the following examples.

**Pricing Combo Meal Groups Based on Side Items**

You can price side items on the combo meal’s side items level instead of the pricing at the combo meal groups items level. In some cases, this simplifies combo meal price configuration. If you set prices in both places, the pricing on the combo meal groups item level takes precedence. Consider the following examples:

- (Traditional Pricing) Combo Meal #1 Drink price $0.99
Pricing Combo Meal Groups Based on Size

The following figure illustrates the configuration of a basic combo meal group using different sizes and associated prices. A combo meal group called Combo Drinks contains the menu items Small Cola, Medium Cola and Large Cola. The Medium Cola is the default drink for all applicable Order Types. The workstation operator does not need to make a selection when adding the combo meal item using the workstation. The application automatically adds the Medium Cola as the default selection. (A workstation operator can modify this choice using the sizing or substitute function keys.) You can apply the prices of $1.00 for the Medium Cola and $2.00 for the Large Cola. To use combo meal sizing, set the Small Cola as the Size 1 Item, the Medium Cola as the Size 2 Item and the Large Cola as the Size 3 Item. You must set Size 1-4 Item settings for all sizable combo group items listed. To enable workstation operators to add or change combo meal item sizes, add buttons to the combo transaction page using the Page Design module.

Figure 30-1   Example of Pricing Based on Item Size

Pricing Combo Meal Groups Based on Menu Item Definition

The following figure shows another optional pricing convention. You can price any combo meal menu item (for example, a Hamburger Combo to include all combo side
and drink items). Set the combo’s price in the menu item definition record (in the Menu Item Maintenance module), and deselect option **4 - Add Side Prices To Meal Price** in the Combo Meals module.

**Figure 30-2  Example of Pricing Based on Menu Item Definition**

Another method is to lower the combo meal menu item price and then roll the price of the combo sides and combo drink items into the price of the primary combo meal menu item.

- **Placeholder Menu Items in Combo Meals**

**Related Topics**

- Creating Combo Meal Groups
- Creating Combo Meals
- Configuring Additional Combo Meal Settings
- Creating Combo Meal Pages
- Combo Meal Function Keys

**Placeholder Menu Items in Combo Meals**

When ordering a combo meal, the guest might not know what they want for dessert when placing the initial appetizer and entrée for a combo meal. The workstation operator can post a placeholder menu item to complete the combo meal, substituting it with the guest's dessert choice (made after the entrée is cleared and they are ready to order dessert). Placeholder items stand in for unknown items until the workstation operator substitutes the placeholder item with the actual menu item in a subsequent service round.

You need to configure a placeholder as a menu item (MI), including inserting a MI master, MI definition and a $0.00 price record. Additionally, assign a MI class to its MI definition file using the placeholder options. Then add the placeholder menu item to each desired combo meal group (for example, combo sides) so that Simphony shows the placeholder item on the Child Orderer area of the page. When the workstation...
operator selects the placeholder item, it occupies a place in the check to enable service total.

The workstation operator can substitute the placeholder menu item at any time prior to closing the check. After substituting it with a valid item (as shown in the following figure), the workstation operator cannot change the item back to a placeholder item. However, the workstation operator can substitute with another valid item.

- Combo Meal Group Pricing

Related Topics
- Creating Combo Meal Groups
- Creating Combo Meals
- Configuring Additional Combo Meal Settings
- Creating Combo Meal Pages
- Combo Meal Function Keys

Creating Combo Meal Groups

You need to configure the menu items that comprise a combo meal group. Then you can configure combo meals using two EMC modules: Combo Meal Groups and Combo Meals. Configure the Combo Meal Groups module first and then configure the Combo Meals module.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Combo Meal Groups.

2. Insert a record for a new combo meal group with the appropriate name, or double-click an existing record.

3. Select the appropriate combo group configuration options:
   - 1 - Allow Discounts: Select this option to apply discounts to items in the group. The discount being applied must have option 25 - Discount Combo Meal Group Items set from the Discounts module.
   - 2 - Substitution Group items use this sides price: Select this option to set the menu item price to the side’s combo meal price specified on the combo meal form. The price setting occurs when the workstation operator substitutes a combo meal side with a menu item from an alternate group. Deselect this option to set the menu item price in the alternate group.

4. (Optional) To enable substitution side items, add Alternate Groups using the Add link.
   - When Alternate Groups are present, workstation operators can substitute combo side items with other combo meal groups. For example, the guest might want to have an onion rings side item that is generally available in Combo Meal #2 with a Combo Meal #4. You can add a Combo Onion Rings alternate group that enables menu item substitution with a Combo Fries group. Configuring alternate side groups enables the application to substitute these side menu items. You must configure an Alternate Side button (using the Page Design module) to substitute items in the POS client.
   - If you are using Simphony version 2.7 MR3 or later, configure FPMs in the Alternate Groups field. For example, guests often substitute an appetizer or
5. Click the **Items** tab to configure all menu items within a combo meal group.

6. Click the **Add** and **Delete** links to add or remove menu items from the combo meal group.

7. Enter or select information in the following fields for each item:

**Table 30-1  Combo Meal Group Fields**

<table>
<thead>
<tr>
<th>Field or Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primary Menu Item</strong></td>
<td>Select a menu item to be the primary item in the combo meal group. This field shows all menu item master records that contain a definition in the revenue center.</td>
</tr>
<tr>
<td><strong>Quantity</strong></td>
<td>Enter the number of times the menu item is needed in the combo group (for example, a combo meal has one hamburger).</td>
</tr>
<tr>
<td><strong>1 - Default when no Order Type declared</strong></td>
<td>Select this option to make the selected item the default item for the combo group without an Order Type.</td>
</tr>
<tr>
<td><strong>2 - 9 Default for Order Types 1-8</strong></td>
<td>Select these options to make the selected item the default item when Order Type 1 (through 8) is active. Deselect these options to have the workstation operator select an item to fulfill the combo meal requirements.</td>
</tr>
<tr>
<td><strong>10 - Autofill</strong></td>
<td>Select this option to change the quantity of the side item ordered to the number of remaining items to complete the side requirements when the workstation operator orders one of the combo meals and more than one remaining item is required.</td>
</tr>
<tr>
<td><strong>Size 1-4 Items</strong></td>
<td>Select a menu item that substitutes for the <strong>Primary Menu Item</strong> when using the Combo Size 1 through Size 4 function keys (set in Page Design under <strong>Type</strong>). This list shows all menu items assigned to the combo group after saving the items. You cannot copy or paste combo meal groups in the EMC. The Size 1-4 Items field populates only after you save items. For example, if you create a new combo group and add the items Soda and Large Soda, you must save these items before selecting either item in this field.</td>
</tr>
<tr>
<td><strong>Size 1-4 Menu Levels</strong></td>
<td>Select a menu level that can affect the price of the substituted Size 1-4 Items.</td>
</tr>
</tbody>
</table>

8. To set specific side items with a different price (upcharge), click the **Prices** subtab. For example, Fries are priced at $0.00, but there is an extra charge of $1.25 when the guest orders Onion Rings.
9. Click the **Add** and **Delete** links to add or remove prices for each item. You can configure up to 8 prices for a single item.

Set the following fields when adding a price:

- **Price**: Enter the price to charge for the item.
- **Prep Cost**: Enter the à la carte price of the combo group item.
- **Active On Level**: Select the menu level on which the price is active.
- (Optional) **Effectivity Group**: Select the effectivity group for this price.
- (Optional) **Date Start** and **Date End**: Enter start and end dates.

10. Click **Save**.

- Creating Combo Meals
- Configuring Additional Combo Meal Settings
- Creating Combo Meal Pages

**Related Topics**

- Combo Meal Group Pricing
- Placeholder Menu Items in Combo Meals
- Combo Meal Function Keys

---

**Creating Combo Meals**

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Combo Meals**.

2. Insert a record for a new combo meal, or double-click an existing record.

3. Click the **Select** link next to the **Menu Item Master** field, select the menu item that represents the combo meal, and then click **OK**.

4. Click the ellipsis point button, select the **Primary Combo Group**, and then click **OK**.

   This is the combo meal group of the primary item for the combo meal. For example, if you have a Burger Combo, you might select a Burgers Combo Meal Group.

5. In the **Priority** field, enter the combo meal priority when workstation operators press the **Auto Combo** function key.

6. From the **Auto Combo Algorithm** drop-down list, select the setting for the application to use when the workstation operator creates a combo meal from menu items already listed on a check. When the workstation operator presses the **Auto Combo** function key, the application uses one of the following options to combine the combo meal items:

   - **0 - First Deal Found**: Select this option to have the application use and combine the first items found.
   - **1 - Best Deal for Customer**: Select this option to combine the most expensive items as a combo meal.
   - **2 - Best Deal for Merchant**: Select this option to combine the least expensive items as a combo meal.
Select the appropriate options as described in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Disable Auto-Combo Recognition</td>
<td>Select this option to prevent the combo meal from being considered when the workstation operator presses the Auto Combo function key.</td>
</tr>
<tr>
<td>2 - Allow Auto-Combo in Previous Round</td>
<td>Select this option to allow the combo meal to consider previous-round items when the workstation operator presses the Auto Combo function key.</td>
</tr>
<tr>
<td>3 - Is Sized Combo Meal</td>
<td>Select this option to allow the combo meal to use Combo Size Size 1-4 function keys, changing the size of the items ordered.</td>
</tr>
<tr>
<td>4 - Add Side Prices To Meal Price</td>
<td>Select this option to add the prices of the meal's side items to the price of the meal on the Kitchen Display System (KDS) display and the customer receipt.</td>
</tr>
<tr>
<td>5 - Only Print Priced Sides On Guest Check</td>
<td>Select this option to prevent the meal's side items from printing on the customer receipt when they have no price, or when their price rolls into the price of the meal.</td>
</tr>
<tr>
<td>6 - No Charge For Condiments</td>
<td>Select this option when added condiments (to the meal) are non-priced.</td>
</tr>
</tbody>
</table>
| 7 - No Bulk Order With Quantity Order                                   | Select this option to prompt the workstation operator for each non-default side item per meal. This option is used when a workstation operator adds more than one combo meal.  
Deselect this option to allow the workstation operator to specify a count when ordering non-default side items. When you deselect this option, the application does not continue to the next side item until all of the combo meals satisfy the side items requirement. |
| 8 - Allow Resizing of Individual Sides                                  | Select this option to allow the workstation operator to change the size of one selected combo meal side item. Deselect this option to allow the workstation operator to resize the entire combo meal. |
| 9 - Do Not Show With Combo Meal Choices                                 | If workstation operators can create multiple combo meals from the existing menu items listed on a check and you select this option, a system-generated list of available choices does not include the combo meal. This combo meal only appears in the list when no combo meals are found. |
| 10 - Keep Last Item Selected after Ordering a New Meal                  | Select this option if you expect modifications to the combo meal after adding the last side, keeping the combo meal selected. This is particularly useful if the last side is often modified. |
Table 30-2  (Cont.) Combo Meal Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 - Is Defined Combo Meal</td>
<td>Select this option to allow the application to incorporate the meal items in the combo as individual menu items in the Auto Combo On The Fly process. For example, you can configure a Donut 6 combo meal and set option 11. When a guest orders a Donut 6 combo and then adds one more donut, the option allows the application to handle the Donut 6 combo as six individual donuts. The auto combo procedure creates an auto combo meal from the menu items added to the check in the current round and initiates a Donut 7 combo instead of adding a seventh donut at full price. This results in a lower price for the customer.</td>
</tr>
</tbody>
</table>

8. To add a combo group:
   a. Click the Add link in the Combo Groups section.
   b. Enter the Side Count.
   c. Click the ellipsis button in the Side Item Group column, select the side items for the combo meal, and then click OK.
   For example, if the combo meal is a Burger, Fries, and Soda, the side items include two Combo Meal Groups: Fries and Soda.

9. Do not price items within the combo meal's Combo Group Price field for combo size meals as this could cause issues with the Size 1-4 Items fields in the Combo Meal Groups module. See Creating Combo Meal Groups for more information.

10. Click Save.

   • Creating Combo Meal Groups
   • Configuring Additional Combo Meal Settings
   • Creating Combo Meal Pages

Related Topics
   • Combo Meal Group Pricing
   • Placeholder Menu Items in Combo Meals
   • Combo Meal Function Keys

Configuring Additional Combo Meal Settings

You can configure additional combo meal options in various EMC modules.

1. To prevent tendering with incomplete combo meals:
   a. Select the Enterprise, property, or zone, click Configuration, and then click Tender/Media.
   b. Double-click the tender media record.
c. Click the **Options** tab, and then click the **Printing Options** subtab.

d. To prevent the tender from being enabled when a meal is missing a side item, select **85 - Not Allowed With Incomplete Meals**.

e. Click **Save**.

2. To enable workstation operators to add incomplete combo meals and placeholder items:

   a. Select the Enterprise level, click **Configuration**, and then click **Roles**.

   b. Double-click the role record.

   c. Click the **Operations** tab, and then click the **Transactions** subtab.

   d. To enable workstation operators to add a parent item without a required condiment, select **161 - Allow Incomplete Item**.

      The parent menu item must have **59 - Allow Item Incomplete Based on Role** set from the Menu Item Classes module.

   e. To enable workstation operators to authorize or perform a service total or tender on a transaction with a placeholder item, select **164 - Authorize/Perform Service Total/Payment with Placeholder item**.

      You must also set option **85 - Not Allowed With Incomplete Meals** in the Tender/Media module. **Placeholder Menu Items in Combo Meals** contains more information.

   f. Click **Save**.

3. To configure revenue center parameters for combo meals:

   a. Select the revenue center, click **Setup**, and then click **RVC Parameters**.

   b. Click the **Options** tab.

   c. To enable the combo key to function with Auto Combo Meal recognition, select **51 - Allow Auto Combo Meal Recognition with the "Combo" key**.

   d. To enable the Auto Combo Meal recognition to create combo meals from menu items that were ordered in previous rounds, select **52 - Allow Creation of Combo Meals from Previous Round Menu Items**.

   e. To show a list of combo meal choices when the workstation operator attempts to create meals from menu items already on the check, select **55 - Show Combo Meal Choices**.

   f. To have the application create combo meals from the menu items added to the check in the current round, select **58 - Auto Combo Items On The Fly**.

   g. Click **Save**.

4. To configure menu item class options:

   a. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Item Classes**.

   b. Double-click the menu item class record.

   c. Click the **Options** tab.

   d. To indicate that all menu items in the class are the priced (parent) portion of a Fixed Price Meal, select **35 - Fixed Price Meal**.

      If this option is not selected, the class is treated as a child (non-priced) component of a Fixed Price Meal. The system relies on the setting of the
Course Mask options to determine whether a menu item class is associated with a fixed price meal.

e. To have items in this class use the Fixed Price Meals group for output devices when the item fulfills the course requirement, select **37 - Use Parent’s Print Group for a Fixed Price Meal Course**.

f. To make condiments free when ordered as part of a combo meal, select **47 - Suppress Price with Combo Meal**. This option is for condiment menu items only. This option does not apply if the Condiment Prefix Type is non-0 (meaning that the menu item is a Condiment Prefix).

g. To enable the workstation operator to add a menu item without satisfying the required condiment’s conditions, select **59 - Allow Item Incomplete Based On Role**.

The role privilege **161 - Allow Incomplete Item** must be set for the workstation operator ordering a parent item with this menu item class.

h. If the menu item is a placeholder in a combo meal, select **60 - Placeholder**.

i. To hide placeholder items from the check detail area, select **61 - No Placeholder Display**.

j. Click **Save**.

- Creating Combo Meal Groups
- Creating Combo Meals
- Creating Combo Meal Pages

**Related Topics**
- Combo Meal Group Pricing
- Placeholder Menu Items in Combo Meals
- Combo Meal Function Keys

---

**Creating Combo Meal Pages**

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Open the page (typically the Transaction page) on which to place the combo meal keys and functions.

3. Click **Button**, and then create combo meal menu item keys on the Transaction page.

4. Click **Other...**, and then add a **Condiment/Combo Orderer**.

   Add the Condiment/Combo Orderer to the same Transaction page as the combo menu items and function keys to view the combo meals and substitute side items easier.

5. Select the **Condiment/Combo Orderer**, click the **Data** tab, and then select **Display Title Bar**.

   The Display Title Bar on the POS client indicates when required combo meal sides or condiments are not ordered.
6. Select **Combo Meal Side** to have the application generate and show combo meal side items.

7. (Optional) Create combo meal size keys (if needed). These keys enable switching between sizes of combo meal items. You can name the combo size keys for an actual size such as small, medium, or large, or Combo Size 1, Combo Size 2, and so on.

![Figure 30-3 Combo Meal Size Key](image)

8. Add the appropriate function keys to the Combo Meal Transaction page (for example **Combo**, **Un-Combo**, **Auto Combo** and **Combo Multi-Selection**).

   **Combo Meal Function Keys** contains more information about each combo meal function key.

9. Configure keys for all individual menu items available (in particular combo groups).

10. Click **Save**.

    - **Creating Combo Meal Groups**
    - **Creating Combo Meals**
    - **Configuring Additional Combo Meal Settings**

**Related Topics**

- **Combo Meal Group Pricing**
- **Placeholder Menu Items in Combo Meals**
- **Combo Meal Function Keys**

**Combo Meal Function Keys**

Workstation operators can use the following function keys (if configured) with combo meals:
### Table 30-3  Combo Meal Function Keys

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Combo</td>
<td>This key allows the workstation operator to create one or more combo meals from existing menu items.</td>
</tr>
<tr>
<td>Combo</td>
<td>This key changes the selected item or the last item on the check to a combo meal. The item must be a primary combo item.</td>
</tr>
<tr>
<td></td>
<td>For example, if the combo meal is a burger with fries and a drink, the burger item must be the highlighted item or the last item ordered before pressing this key.</td>
</tr>
<tr>
<td>Combo Alternate Side</td>
<td>This key allows the workstation operator to substitute a combo meal side with a selection from another combo meal group (for example, when a customer orders an appetizer instead of an entree in a combo meal).</td>
</tr>
<tr>
<td>Combo Bulk Order</td>
<td>This key allows the workstation operator to order multiple combo meals at a time. The workstation operator must meet each combo’s side item requirements before moving on to order the next combo’s side items.</td>
</tr>
<tr>
<td>Combo Multi Selection</td>
<td>This key allows the workstation operator to select existing menu items to combine into a combo meal. This function shows the check detail in a window, which allows the workstation operator to select individual items to make up the combo meal. This gives the workstation operator greater control in determining what is included in the combo meal.</td>
</tr>
<tr>
<td>Un-Combo</td>
<td>This key separates an existing combo meal into individual a la carte items (non-combo pricing takes effect).</td>
</tr>
<tr>
<td>Type - Combo Order Size</td>
<td>This key changes the order size before ordering the combo meal.</td>
</tr>
<tr>
<td>Type - Combo Size 1-4</td>
<td>These keys change the combo size after ordering the combo meal. Using these keys causes the workstation to resize the selected combo meal or combo meal side item to selected sizes 1 through 4. If the workstation operator does not select an item, the last item on the check is resized.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Combo Meal Group Pricing
- Placeholder Menu Items in Combo Meals
- Creating Combo Meal Groups
- Creating Combo Meals
- Configuring Additional Combo Meal Settings
- Creating Combo Meal Pages
31

Guest Checks

A guest check contains a record of all sales on the check, from the guest’s initial menu item to final payment.

- Configuring Guest Check Numbers
- Configuring Guest Check Headers and Trailers
- Creating a Service Total to End the Current Service Round of Checks
- Adding a Service Total Key to the Transaction Page
- Fast Transactions
- Configuring Fast Transactions
- Full Seat Checks
- Configuring a Print Full Seat Check Service Total
- Creating a Full Seat Check Button
- Splitting Off an Item
- Configuring a Split Off Item Button
- Conversational Ordering
  - Creating Menu Item Master Groups for Conversational Ordering
  - Configuring Menu Level Sets for Conversational Ordering
  - Configuring Menu Item Classes for Conversational Ordering
  - Configuring Menu Items for Conversational Ordering
  - Creating Buttons for Conversational Ordering
  - Configuring Employee Privileges for Automatic Check Firing
  - Configuring Automatic Check Firing
  - Configuring Employee Privileges for Check Re-firing
  - Configuring the Check Re-fire Button
- Suspend and Resume
- Configuring Suspend and Resume
- Creating a Suspend and Resume Button
- Setting the Employee Auto Sign Out Period
- Follow Me
- Configuring Follow Me Checks
- Order Handling on Open Checks
- Holding and Sending Items to Order Devices
- Configuring Send and Stay
• Setting the Hold and Fire Option
• Setting the Hold and Fire Tender Notification
• Setting a Reminder for Items on Hold
• Configuring Checks with Items on Hold to End Current Service Round
• Configuring Check Handling For Closing Checks With Held Items
• Configuring Item Hold Buttons
• Configuring the Fire Now Button
• Team Service
• Reports and Totals Posting for Team Checks
• Enabling Team Service
• Configuring Team Service Privileges
• Configuring Revenue Centers to Delete Service Teams at the Start of Day
• Adding Team Service Buttons
• Closed Guest Check Operations
• Configuring Closed Check Settings
• Allowing Employees to Adjust Closed Checks
• Allowing Employees to Reopen and Edit a Closed Check
• Allowing Employees to Reprint Closed Checks
• Allowing Employees to Manually Replay Checks Through the Workstation
• Check Add/Transfer
• Allowing Employees to Add or Transfer Checks
• Configuring the Add/Transfer Revenue Centers
• Configuring Add/Transfer Buttons
• Seat Filtering and Memo Checks
• Configuring Memo Check Printing
• Configuring Service Charges for Seat Filtering
• Configuring Seat Filter Management Buttons

Configuring Guest Check Numbers

The guest check number can be between 1 and 99999999 (an eight-digit number). Generally check numbers are created in sequential order. If a workstation operator begins check number 10000007, the next check number for the revenue center is 10000008. Check numbers are maintained at the revenue center.

If the property has multiple revenue centers and wants to keep unique check numbers for each revenue center, you can assign an exclusive range or check numbers per revenue center. For example, Revenue Center 1 could have checks from 1000 to 1999 and Revenue Center 2 could have checks from 2000 to 2999.

1. Select the revenue center, click Setup, and then click RVC Parameters.
2. To set guest check numbers to generate automatically, enter the **Min Guest Check #** and the **Max Guest Check #** on the **General** tab.

When Simphony generates check numbers automatically, after reaching the Max Guest Check # value, the next check number is the Min Guest Check # value.

3. To enable workstation operators to manually assign guest check numbers, click the **Options** tab, and then select **1 - Operator Assigns Check Numbers**.

   This option is used at properties that have guest checks with pre-printed numbers.

4. Click **Save**.

   - Configuring Guest Check Headers and Trailers
   - Creating a Service Total to End the Current Service Round of Checks
   - Adding a Service Total Key to the Transaction Page

---

### Configuring Guest Check Headers and Trailers

Guest check headers and trailers are leading and trailing lines that print on guest checks. Typically, the header lines include the name of the property or revenue center and address. The trailer lines generally show gratitude or promotional information about upcoming events. At hotels, guest check trailers are often configured to show room charge information for the customer to complete. You can also set a header or trailer line to print logos rather than text.

Headers print automatically on guest checks. You must set trailers to print per tender/media record.

1. Select the Enterprise, property, revenue center, or zone, click **Descriptors**, and then click either **Guest Check Headers** or **Guest Check Trailers**.

2. For each row, enter information in the following fields:
   - **Text**: Enter the text to appear on the header or trailer.
   - (Optional) **Use Logo**: Select this option to print a logo rather than text on the guest check header or trailer.
   - (Optional) **Logo**: If you selected **Use Logo**, select an image.

3. Click **Save**.

4. To configure trailers to print for each tender media record, select the Enterprise, property or zone, click **Configuration**, and then click **Tender/Media**.

5. Double-click the tender record.

6. Click the **Options** tab, and then click the **Printing Options** subtab.

7. Set the appropriate options as described in the following table:
### Table 31-1 Trailer Printing Options for a Tender Record

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 - Print Sales Itemizers</td>
<td>Select this option to print the sales itemizer lines on guest checks, customer receipts, and memo checks when workstation operators use the tender record. Deselect this option to suppress printing of the sales itemizers.</td>
</tr>
<tr>
<td>21 - Print Summary Totals</td>
<td>Select this option to print the summary totals (subtotal, tax, amount due, and change due) on guest checks, customer receipts, and memo checks when workstation operators press the key. Deselect this option to suppress printing of the summary totals.</td>
</tr>
<tr>
<td>22 - Print Check Trailer</td>
<td>Select this option to print the guest check trailer lines at the end of the guest check.</td>
</tr>
<tr>
<td>28 - Print Guest Check Trailer on Fast Transaction Customer Receipt</td>
<td>Select this option to print the guest check trailer on the customer receipt when workstation operators use the tender to close a fast transaction. Deselect this option to prevent the trailer from printing on customer receipts.</td>
</tr>
</tbody>
</table>

8. Click **Save**.

- Configuring Guest Check Numbers
- Creating a Service Total to End the Current Service Round of Checks
- Adding a Service Total Key to the Transaction Page

### Creating a Service Total to End the Current Service Round of Checks

You can configure the following two types of service totals. Both types are used to end the current service round of guest checks:

- Service totals that send menu items to order devices, end the current service round, and post totals
- Service totals that send menu items to order devices, end the current service round, post totals, and print to order devices

1. To have the service total send menu items to order devices:
   a. Select the Enterprise or property, click **Configuration**, and then click **Tender/Media**.
   b. Insert a new record, enter a name for the new tender record (for example, Send), and then double-click the new tender record.
   c. From the **Key Type** drop-down list, select **Service Total**.
   d. Click **Menu Levels**, and then select the Main and Sub Levels on which the service total is active.
   e. Click **Save**.
2. To have the service total send menu items to order devices and print the guest check:
   a. Select the Enterprise or property, click Configuration and Tender/Media.
   b. Insert a new record, enter a name for the new tender record (for example, Print), and double-click the new tender record.
   c. From the Key Type drop-down list, select Service Total.
   d. Click Options and then click Printing Options.
   e. Select 23 - Print Check on Demand.
   f. Click Menu Levels and select the Main and Sub Levels on which the service total is active.
   g. Click Save.

   • Configuring Guest Check Numbers
   • Configuring Guest Check Headers and Trailers
   • Adding a Service Total Key to the Transaction Page

Adding a Service Total Key to the Transaction Page

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Open the page (typically the Transaction page) on which to place the Service Total function key.
3. On the Edit tab, select the page area in which to define the Service Total key.
4. Click Button.
5. On the General subtab, enter the function key name (for example, Service Total or Send and Stay (if you are using Send and Stay functionality)) in the Legend field.
6. From the Type drop-down list, select Tender/Media.
7. Click the black arrow beneath the Type drop-down list.
8. Select the Service Total tender, and then click OK.
9. Position and size the button on the page. Use the Style arrow to change the color.
10. Click Save.

   • Configuring Guest Check Numbers
   • Configuring Guest Check Headers and Trailers
   • Creating a Service Total to End the Current Service Round of Checks
   • Configuring Send and Stay
   • Setting the Hold and Fire Option
   • Setting the Hold and Fire Tender Notification
   • Setting a Reminder for Items on Hold
   • Configuring Checks with Items on Hold to End Current Service Round
   • Configuring Check Handling For Closing Checks With Held Items
Fast Transactions

A Fast Transaction is a transaction that is started by selecting a menu item or scanning a barcode to post a menu item rather than selecting a Begin Check function key. Workstation operators can quickly start transactions by pressing a menu item key or scanning an item. Fast transactions are used in quick service or retail environments where a workstation operator begins transactions repeatedly, and rarely assigns customers to a specific table or check number.

Related Topics
• Configuring Fast Transactions

Configuring Fast Transactions

1. Select the revenue center, click Setup, and then click RVC Parameters.
2. Click the Options tab, and then select 15 - Allow Fast Transactions.
3. To prevent customer receipts from automatically printing after each fast transaction, select 9 - On Demand Customer Receipts.
4. Click Save.
5. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Format Parameters.
6. Click the Options tab.
7. To print the check number at the bottom of the customer receipt to be used as an order number, select 21 - Print order number at bottom of Receipts.
8. Click Save.
9. Select the Enterprise, property, or zone, click Configuration, and then click Tender/Media.
10. Double-click the tender record.
11. Click the Options tab, and then click the Printing Options subtab.
12. To print the guest check trailer on the customer receipt when a workstation operator uses the tender to close a fast transaction, select 28 - Print Guest Check Trailer on Fast Transaction Customer Receipt.
13. Click Save.

Related Topics
• Fast Transactions
Full Seat Checks

A full seat check shows each seat’s menu items with the subtotal separated by the seat header. Unlike a seat check, each full seat check includes a check header, a check trailer, and a paper cut. This feature is available with Simphony version 2.5 Maintenance Release 1 and later.

Figure 31-1  Example of Full Seat Check

Related Topics
• Configuring a Print Full Seat Check Service Total
• Creating a Full Seat Check Button

Configuring a Print Full Seat Check Service Total

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.
2. Add a new record, and then double-click it to open in form view.
3. Select 2 - Service Total from the Key Type drop-down list.
4. Click the Options tab, and then click the Printing Options subtab.
5. Select 16 - Print Full Seat Check.
   If you also select 14 - Print Seat Check, option 16 overrides option 14.
6. Select 21 - Print Summary Totals.
7. Click the Menu Levels tab, and then select the Main and Sub Level on which the Print Full Seat Check Service Total is available.
8. Click Save.

9. Add a touchscreen button for the tender/media record that you created in Step 2. Creating a Full Seat Check Button contains more information about configuring the touchscreen button.

   • Creating a Full Seat Check Button

Related Topics

• Full Seat Checks

Creating a Full Seat Check Button

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

2. Open the page on which to place the Full Seat Check button.

3. On the Edit tab, select the page area in which to define the Full Seat Check button.

4. Click Button to add a button.

5. On the General subtab, enter the button name in the Legend field.

6. Select Tender/Media from the Type drop-down list.

7. Click the black arrow directly beneath the Type drop-down list, and then select Full Seat Check.

8. Highlight the Full Seat Check button.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. Click Save.

   • Configuring a Print Full Seat Check Service Total

Related Topics

• Full Seat Checks

Splitting Off an Item

A Split Off Item is a function key that enables workstation operators to separate (split) one or more items from a multiple quantity menu item entry so that it can be modified independently from the original item.

For example, a guest orders 3 burgers with 2 pieces of cheese and bacon. The guest then later requests to add ketchup to one burger. The workstation operator uses Split Off Item to separate one of the burgers and adds ketchup to it.
When a workstation operator splits a multiple quantity menu item with condiments (required or non-required condiments) the following results appear on the check:

- The condiments of the original item and their quantities are carried over to each split item.
- The quantity of the original parent menu item is reduced by the number of items split.

For example, if the workstation operator originally adds 3 burgers, after splitting one item, the original item entry shows as 2 burgers while the new split entry shows as 1 burger.

**Related Topics**

- Configuring a Split Off Item Button

**Configuring a Split Off Item Button**

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.
2. Open the page on which to place the **Split Off Item** button.
3. On the **Edit** tab, select the page area in which to define the **Split Off Item** button.
4. Click **Button** to add a button.
5. On the **General** subtab, enter the button name in the **Legend** field.
6. Select **Function** from the **Type** drop-down list.
7. Click the black arrow directly beneath the Type drop-down list, and then select Menu Item.
8. Highlight the Split Off Item button.
9. Position and size the button on the page. Use the Style arrow to change the color.
10. Click Save.

Related Topics
- Splitting Off an Item

Conversational Ordering

Conversational ordering allows workstation operators to add specially configured menu items for guests who order these items in no particular sequence. For example, in a coffee shop, the workstation operator requires the following items:
- Drink Type (Espresso, Latte, Mocha, Tea)
- Drink Size (Small, Medium, Large)
- Drink Temperature (Hot, Iced)
- Condiments or Modifiers (Whipped Cream, Cinnamon, Skim Milk)

When using conversational ordering, the workstation operator adds the order as a guest states items (for example, an iced mocha, medium size, with whipped cream), improving Speed of Service (SOS), ease of ordering for guests, and overall order accuracy.

Setting up conversational ordering consists of completing the following tasks:
- Creating Menu Item Master Groups
- Configuring Menu Level Sets
- Configuring Menu Item Classes
- Setting Menu Items
- Creating Front of House Buttons

Related Topics
- Creating Menu Item Master Groups for Conversational Ordering
- Configuring Menu Level Sets for Conversational Ordering
- Configuring Menu Item Classes for Conversational Ordering
- Configuring Menu Items for Conversational Ordering
- Creating Buttons for Conversational Ordering

Creating Menu Item Master Groups for Conversational Ordering

1. Select the Enterprise, property, or zone, click Configuration, and then click Menu Item Master Groups.
2. Insert a new Menu Item Master Group.
In the coffee shop example, you could create the following groups: Espresso, Latte, Mocha, and Americano.

3. Click **Save**.

- Configuring Menu Level Sets for Conversational Ordering
- Configuring Menu Item Classes for Conversational Ordering
- Configuring Menu Items for Conversational Ordering
- Creating Buttons for Conversational Ordering

**Related Topics**
- Conversational Ordering

## Configuring Menu Level Sets for Conversational Ordering

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Level Sets**.

2. Insert a new Menu Level Set.

   In the coffee shop example, you could create Size and Temperature Menu Level Sets.

3. Select the **Default Master Group** for each Menu Level Set.

   In the coffee shop example, you could select **Drinks** as the Default Master Group. When a workstation operators selects a Menu Level in this group, Simphony determines which item of the selected Menu Item Group to apply to the check.

4. Double-click a Menu Level Set to open it in form view.

5. From the General section, select **2 - Bound to parent** to bind the Menu Item Master Group (for example, Drinks) to the custom Menu Levels (for example, Size and Temperature).

   When a guest initially orders a drink by either Size or Temperature, those menu items link to the Menu Item Master Group, which also link to Anonymous Menu Level Entry Options. This enables the workstation operator to add items in the exact order that the guest states or orders them.

6. From the Menu Level Entries section, click **Add**.

7. Enter menu level names for the Menu Level Set (for example, you could add Small, Medium, and Large Menu Level Entries to the Size Menu Level Set).

8. For each Menu Level Entry, select the **Default** and **Anonymous** options.

   Selecting these options enable the menu level sets to serve as temporary $0.00 placeholders for menu items when guests order them out of sequence.

9. Click **Save**.

- Creating Menu Item Master Groups for Conversational Ordering
- Configuring Menu Item Classes for Conversational Ordering
- Configuring Menu Items for Conversational Ordering
- Creating Buttons for Conversational Ordering
Related Topics

- Conversational Ordering

Configuring Menu Item Classes for Conversational Ordering

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Item Classes**.

2. Insert a new Menu Item Class record.

   - For each menu item that a guest can order through Conversational Ordering, create at least two Menu Item Classes to accommodate the guest in ordering the same menu item in different ways. In the coffee shop example, each coffee type might have two classes: Latte Anonymous and Latte Defined. Create the Anonymous class first.

   - Create a generic Menu Item Class to assign only to Menu Item Definitions that are $0.00 priced menu items. In the coffee shop example, the Menu Item Class Drink Anonymous can be used for Menu Item Definitions such as {SIZE} Large Drink or {TEMP} Hot Drink. This Menu Item Class is assigned to the Default Master Group named Drinks.

3. Double-click a Menu Item Class to open it in form view.

4. From the General tab, select **2 - Replace in Condiment Group** from the **Condiment Order Type** drop-down list.

   Setting this option replaces the previously selected condiment with the latest condiment choice when the workstation operator selects condiments. If you set the Increment option, a priced condiment can be added to a transaction, such as a shot of espresso.

5. (Optional) Select the default parent to order from the **Default Master Group** drop-down list.

   In conversational ordering you can assign a default parent item to a condiment so that when the condiment is ordered without an existing parent, Simphony orders the condiment's default parent. For example, the condiment American Cheese has Burger as its default parent. If the workstation operator orders American Cheese and there is no current parent, Simphony orders the Burger automatically and the American Cheese appears as a condiment on the burger.

   Set this field only for condiments; it is meaningless for parent items.

6. Click the **Options** tab.

7. For each Menu Item Class with Anonymous in the name, select the following options:

   - **8 - Allow Menu Items in this Class to be Non-Priced**
   - **49 - Participates in Menu Item Master Switching**
   - **50 - Anonymous Menu Item**

8. For each Menu Item Class with Defined in the name, select the following options:

   - **8 - Allow Menu Items in this Class to be Non-Priced**
   - **49 - Participates in Menu Item Master Switching**

9. For the generic Menu Item Class, select the following options:
8 - Allow Menu Items in this Class to be Non-Priced
49 - Participates in Menu Item Master Switching
50 - Anonymous Menu Item

10. Click the **Condiment Groups** tab.

11. For each Menu Item Class, select the appropriate condiment groups:
   - **Required Condiment Groups**: These condiment groups must be entered when a workstation operator adds menu items in this class.
   - **Allowed Condiment Groups**: These condiment groups are allowed to be entered as condiments for menu items in this class.
   - **Member Condiment Groups**: These condiment groups consist of menu items in this class.

12. Click **Save**.

- Creating Menu Item Master Groups for Conversational Ordering
- Configuring Menu Level Sets for Conversational Ordering
- Configuring Menu Items for Conversational Ordering
- Creating Buttons for Conversational Ordering

**Related Topics**
- Conversational Ordering

**Configuring Menu Items for Conversational Ordering**

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Item Maintenance**.

2. Insert a menu item master record for each menu item (including condiments) that can be ordered using conversational ordering. You need to account for all potential ordering combinations a guest might use. Use braces {} to surround the generic variables such as {SIZE} and {TEMP}.

   In the coffee shop example shown in the following figure, you might have records for {SIZE} {TEMP} Drink, {SIZE} Hot Drink, and so on.
Figure 31-3  Menu Item Master Records for Conversationally Ordered Items

3. Select the **Major Group**, the **Family Group**, and the **Master Group**.

4. Click the **Definition Records** tab in the lower area of the page.

5. Set the following for each record:
   - Menu Item Class
   - Menu Item Price
   - Menu Level Availability
   - Default Condiments

6. Click **Save**.

- Creating Menu Item Master Groups for Conversational Ordering
- Configuring Menu Level Sets for Conversational Ordering
- Configuring Menu Item Classes for Conversational Ordering
- Creating Buttons for Conversational Ordering

**Related Topics**
- Conversational Ordering
Creating Buttons for Conversational Ordering

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Open the page on which to place menu item master buttons.
3. On the Edit tab, select the page area in which to define the menu items (including condiments) (typically the transaction area).
4. Click Button to add a button.
5. On the General subtab, select the appropriate function from the Type drop-down list.
6. Click the black arrow beneath the Type drop-down list.
7. Position and size the button on the page. Use the Style arrow to change the color.
8. In the Legend field, enter the button name.
9. Click Save.
10. Repeat these steps to create buttons for each of the menu item master names.

- Creating Menu Item Master Groups for Conversational Ordering
- Configuring Menu Level Sets for Conversational Ordering
- Configuring Menu Item Classes for Conversational Ordering
- Configuring Menu Items for Conversational Ordering

Related Topics
- Conversational Ordering

Configuring Employee Privileges for Automatic Check Firing

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Double-click an employee role, click the Operations tab, and then click the Guest Checks subtab.
3. Select the appropriate privileges. The following table describes the privileges corresponding to automatic check firing.

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>183 - Begin Autofire Check using [Begin Autofire Check] Key</td>
<td>Select this option to allow employees in this role to create checks with orders that automatically fire at a preset time using the Begin Autofire Check function key.</td>
</tr>
<tr>
<td>184 - Authorize/Perform Pickup of Autofire Check Belonging to Another Operator</td>
<td>Select this option to allow employees in this role to pick up and edit checks with orders that fire at a preset time from other employees.</td>
</tr>
</tbody>
</table>
Table 31-2  (Cont.) Employee Guest Check Privileges for Automatic Check Firing

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>185 - Authorize/Perform Edit of Autofire Date/Time</td>
<td>Select this option to allow employees in this role to modify the date and time that orders are set to automatically fire.</td>
</tr>
</tbody>
</table>

4. To allow employees in this role to generate the Autofire Open Check Report from the workstation, click the **Ad Hoc Reports** subtab, and then select **31030 - Run Autofire Open Check Report**.

5. Click **Save**.

Configuring Automatic Check Firing

1. Select the revenue center, click **Setup**, and then click **RVC Parameters**.

2. Click the **Autofire** tab, and then configure the fields as described in the following table:

Table 31-3  Automatic Check Firing Fields

<table>
<thead>
<tr>
<th>Fields and Options</th>
<th>Description</th>
</tr>
</thead>
</table>
| (Optional) Autofire Employee | To allow a specific employee to become the owner of all checks, including those placed using Transaction Services after the orders fire, select a workstation operator, and then click **OK**.  
  • If you select an Autofire Employee, all sales totals post to the designated workstation operator and the checks appear under the Autofire Employee in the Open Check Report.  
  • If you do not select an Autofire Employee, the check operator remains the owner of the check after the order fires. |
| Autofire Workstation       | Select the workstation from which the orders fire and print. The application uses this value to determine the order output devices and workstation printers to use when an order fires. |
| Default Autofire Tender/Media | Select a service total that workstation operators can use with Autofire.  
  You can assign any service total. Oracle recommends configuring a separate service total for automatic order firing to allow workstation operators to identify the designated touchscreen button. **Creating a Service Total to End the Current Round of Checks** contains information about configuring a service total. |
### Table 31-3  (Cont.) Automatic Check Firing Fields

<table>
<thead>
<tr>
<th>Fields and Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup Autofire Delay (Mins)</td>
<td>Enter the amount of time (in minutes) that the autofire workstation must try to fire the orders.</td>
</tr>
<tr>
<td></td>
<td>After the Backup Autofire Delay time elapses, if the autofire workstation is unsuccessful at firing the order, the workstation at which the check was originally created tries to fire the order. If both workstations fail, a memo chit prints and a workstation operator must manually fire the order.</td>
</tr>
<tr>
<td>(Optional) Maximum Days</td>
<td>Enter the maximum number of days for which workstation operators can schedule orders to fire automatically.</td>
</tr>
<tr>
<td>(Optional) 1 - Print Autofire Memo at Time of Entry</td>
<td>Select this option if you want a memo chit to print when workstation operators create orders that fire automatically.</td>
</tr>
<tr>
<td>(Optional) 2 - Print Guest Check at Time of Autofire</td>
<td>Select this option if you want a guest check to print when an order automatically fires to order devices.</td>
</tr>
<tr>
<td></td>
<td>If you select this option, guest checks print at the guest check printer assigned to the autofire workstation.</td>
</tr>
<tr>
<td>3 - Enable Autofire in this Revenue Center</td>
<td>Select this option to allow the revenue center to create orders that fire automatically.</td>
</tr>
<tr>
<td></td>
<td>If you are using DOM, do not enable Autofire or hold and fire.</td>
</tr>
</tbody>
</table>

3. Click **Save**.
4. Select the Enterprise, property, revenue center, or zone, click **Descriptors**, and then click **Autofire Check Offline Header**.
5. From the **Text** column, enter the header lines to print on memo chits when orders fail to fire automatically.
6. To add a logo to the header, select **Use Logo**, click the ellipsis point (…) button from the Logo column, select the logo from the list, and then click **OK**.
7. Click **Save**.
8. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.
9. Insert a new button on the transaction page, select **Function** from the **Type** drop-down list, and then select **Begin Autofire Check** from the **Function** list.
10. Click **Save**.

### Configuring Employee Privileges for Check Re-firing

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.

---

**ORACLE**
2. Double-click an employee role, click the Operations tab, and then click the Transaction subtab.
3. To allow employees in this role to re-fire items in a previous round, select 293 - Authorize/perform re-fire Menu item.
4. Click Save.

• Configuring the Check Re-fire Button

Configuring the Check Re-fire Button

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Open the transaction page on which to place the Re-fire button.
3. On the Edit tab, select the page area in which to define the Re-fire button.
4. Click Button.
5. On the General subtab, enter the button name (for example, Re-fire Pending Checks) in the Legend field.
6. Select Function from the Type drop-down list.
7. Click the black arrow directly beneath the Type drop-down list, select Re-fire, and then click OK.
8. Position and size the button on the page. Use the Style arrow to change the color.
9. Click Save.

• Configuring Employee Privileges for Check Re-firing

Suspend and Resume

With the Suspend and Resume feature, workstation operators can:
• Suspend a check started by another employee, and sign on to the workstation.
• Suspend a check when the workstation automatically signs off an employee.
• Suspend a check using a Service Total key.

When suspended, the check is stored in the memory until a workstation operator resumes it by signing on to a workstation.

Related Topics
• Configuring Suspend and Resume
• Creating a Suspend and Resume Button
• Setting the Employee Auto Sign Out Period

Configuring Suspend and Resume

1. Select the revenue center, click Setup, and then click RVC Parameters.
2. Click the Options tab, and then select 60 - Enable Suspend/Resume.
3. Click **Save**.

4. Select the Enterprise, property, or zone, click **Configuration**, and then click **Tender/Media**.

5. Insert a record with the tender name.

6. Double-click the tender record.

7. On the **General** tab, select **2 - Service Total** from the **Key Type** drop-down list.

8. Click the **Options** tab, and then click the **Ops Behavior** subtab.

9. Select **74 - Suspend Order**.

10. Click **Save**.

- **Creating a Suspend and Resume Button**
- **Setting the Employee Auto Sign Out Period**

**Related Topics**
- **Suspend and Resume**

---

**Creating a Suspend and Resume Button**

To allow workstation operators to manually suspend a check, you need to add a button assigned to the service total tender record.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Open the page on which to place the Suspend/Resume button.

3. On the **Edit** tab, select the page area in which to define the Suspend/Resume button.

4. Click **Button**.

5. On the **General** subtab, enter the button name in the **Legend** field.

6. Select **Tender/Media** from the **Type** drop-down list.

7. Click the black arrow directly beneath the **Type** drop-down list, select the tender you created for the suspend and resume service total, and then click **OK**.

8. Position and size the button on the page. Use the Style arrow to change the color.

9. Click **Save**.

- **Configuring Suspend and Resume**
- **Setting the Employee Auto Sign Out Period**

**Related Topics**
- **Suspend and Resume**

---

**Setting the Employee Auto Sign Out Period**

To automatically suspend a check and sign out an employee, you need to define the automatic operator popup interval.
1. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Control Parameters**.
2. Click the **Configuration** tab.
3. In the **Automatic Operator "Popup" Interval (min:sec)** field, enter the amount of time (in minutes and seconds) that the workstation waits before signing out an inactive popup workstation operator.
4. Click **Save**.

**Follow Me**

Follow Me extends the functionality of the suspend and resume feature in Simphony. Follow Me allows workstation operators to use suspended checks across workstations in the same revenue center. This feature increases speed of service in a pub or fast casual restaurant environment.

For example, a pub may have three workstations and up to twelve bartenders working simultaneously. Each bartender can sign on and sign off at any workstation. A bartender can begin a check on workstation 1, prepare a drink, and then sign on to workstation 2 to resume the check. The check is suspended on workstation 1 and automatically resumed on workstation 2. Any menu items, discounts, and service charges that were added on workstation 1 appear on workstation 2. A check can be open on only one workstation at a time.

The journal logs the suspend and resume history of each check and lists the workstation on which the suspend and resume transaction was performed.

**Related Topics**
- Configuring Follow Me Checks

**Configuring Follow Me Checks**

1. Select the revenue center, click **Setup**, and then click **RVC Parameters**.
2. Click the **Options** tab, and then select **68 - Enable Follow Me**.
   
   When you set Follow Me, option **60 - Enable Suspend/Resume** dims, and vice versa. You cannot select both Follow Me and Suspend/Resume; they are mutually exclusive. When you set Follow Me, each workstation in the revenue center participates in the Follow Me operation.
3. Select the property, click **Setup**, and then click **Workstations**.
4. On the **General** tab, enter information in the fields as described in the following table:
### Table 31-4 Workstation Timeout Settings

<table>
<thead>
<tr>
<th>Timeout Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Inactivity Timeout</td>
<td>Enter the number of seconds that the workstation waits before prompting the workstation operator to cancel a transaction. If you set this value to 0 (zero), the Cancel dialog does not appear. If you select 68 - Enable Follow Me from the RVC Parameters module, the guest check is automatically suspended rather than cancelled.</td>
</tr>
<tr>
<td>Check Inactivity Dialog Timeout</td>
<td>Enter the number of seconds that the workstation shows the Do you need more time? Inactivity dialog before automatically cancelling the transaction. If you set this value to 0 (zero), the Cancel dialog does not appear.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

#### Related Topics
- **Follow Me**

### Order Handling on Open Checks

This section describes how to configure the following Simphony features:
- **Send and Stay**: Send orders to order devices (such as remote printers or a Kitchen Display System (KDS)) when performing a Service Total while the guest check remains open.
- **Timed Fire**: Manually or automatically send items on a guest check to order devices in groups over a period of time at preset times.

#### Related Topics
- **Configuring Send and Stay**
- **Adding a Service Total Key to the Transaction Page**
- **Setting the Hold and Fire Option**
- **Setting the Hold and Fire Tender Notification**
- **Setting a Reminder for Items on Hold**
- **Configuring Checks with Items on Hold to End Current Service Round**
- **Configuring Check Handling For Closing Checks With Held Items**
- **Configuring Item Hold Buttons**

### Holding and Sending Items to Order Devices

The following table describes how to configure the workstation to hold and send menu items on open guest checks to order devices.
Table 31-5  Configure Workstations to Hold Items on Guest Checks

<table>
<thead>
<tr>
<th>Task</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable option to hold items on guest checks and add touchscreen buttons</td>
<td>Setting the Hold and Fire Option</td>
</tr>
<tr>
<td>Enable workstation notifications for held menu items when tendering</td>
<td>Setting the Hold and Fire Tender Notification</td>
</tr>
<tr>
<td>Configure workstations to remind workstation operators of checks with items on hold after signing into the workstation</td>
<td>Setting a Reminder for Items on Hold</td>
</tr>
<tr>
<td>Configure guest checks with items on hold to end current service round and add touchscreen buttons</td>
<td>Setting Checks with Items on Hold to End Current Service Round</td>
</tr>
<tr>
<td>Configure how to handle items on hold when closing checks</td>
<td>Setting Check Handling with Items on Hold when Closing Checks</td>
</tr>
<tr>
<td>(Optional) Configure Check Screen Look Up (SLU) to display checks with only held items</td>
<td>Configuring Check Screen Lookup (SLU) to Show Checks with only Held Items</td>
</tr>
</tbody>
</table>

Related Topics

- Configuring Send and Stay
- Adding a Service Total Key to the Transaction Page
- Setting the Hold and Fire Option
- Setting the Hold and Fire Tender Notification
- Setting a Reminder for Items on Hold
- Configuring Checks with Items on Hold to End Current Service Round
- Configuring Check Handling For Closing Checks With Held Items
- Configuring Item Hold Buttons

Configuring Send and Stay

Follow these instructions to configure the Service Total to send items to be prepared while the check remains open.

1. Select the property, click Configuration, and then click Tender/Media.
2. Insert a Service Total record if it does not exist.
3. Double-click the record to open it.
4. On the General tab, select 2 - Service Total from the Key Type drop-down list.
5. Click the Options tab, and then click the Ops Behavior subtab.
6. Select 95 - Send Order.
7. Click Save.
8. Add a touchscreen button for the tender/media record that you created in Step 2. Adding a Service Total Key to the Transaction Page contains more information about configuring a service total touchscreen button.
• Adding a Service Total Key to the Transaction Page
• Setting the Hold and Fire Option
• Setting the Hold and Fire Tender Notification
• Setting a Reminder for Items on Hold
• Configuring Checks with Items on Hold to End Current Service Round
• Configuring Check Handling For Closing Checks With Held Items
• Configuring Item Hold Buttons

Related Topics
• Order Handling on Open Checks
• Holding and Sending Items to Order Devices

Setting the Hold and Fire Option

1. Select the revenue center, click Setup, and then click RVC Parameters. Do not enable hold and fire if you are using DOM.
2. Click the Options tab, and then select 70 - Enable Hold and Fire.
3. Click Save.

• Configuring Send and Stay
• Adding a Service Total Key to the Transaction Page
• Setting the Hold and Fire Tender Notification
• Setting a Reminder for Items on Hold
• Configuring Checks with Items on Hold to End Current Service Round
• Configuring Check Handling For Closing Checks With Held Items
• Configuring Item Hold Buttons

Related Topics
• Order Handling on Open Checks
• Holding and Sending Items to Order Devices

Setting the Hold and Fire Tender Notification

1. Select the revenue center, click Setup, and then click Control Parameters.
2. Click the Options tab, and then select 66 - Enable Hold and Fire Final Tender Notification.
   This notification indicates that unfired menu items are on a check during the final tender process.
3. Click Save.

• Configuring Send and Stay
• Adding a Service Total Key to the Transaction Page
Setting a Reminder for Items on Hold

1. Select the Enterprise level, click Setup, and then click Control Parameters.
2. Click the Configuration tab.
3. In the Confirm Threshold Period for Items on Hold (minutes) field, enter the time that elapses before notifying workstation operators of checks with items on hold.
   If you set the Confirm Threshold Period for Items on Hold (minutes) to 0, the workstation shows a reminder each time a workstation operator signs on to the workstation.
4. Click Save.

Chapter 31
Setting a Reminder for Items on Hold

31-24
6. Select **2- Hold Order** from the **Hold Type** drop-down list. The Hold Type is used with Hold and Fire to establish the order device output instructions for menu items on the guest check. The following options are available.
   - **0 - Fire Order**: Sends all menu items, including items on hold, to order devices. Items that you configure to send at a preset time are exempt from this service total type.
   - **1 - Keep Held Status**: Sends all items to the order device except those on hold.
   - **2 - Hold Order**: Holds the entire guest check.

7. Click **Save**.

8. Repeat Steps 2 through 7 and configure service totals for **Fire Order** and **Keep Held Status**.

9. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

10. Open the Front of House touchscreen page (typically the Transaction page) on which to place the service total buttons.

11. On the **Edit** tab, select the page area in which to define buttons, and then click **Button**.

12. On the General subtab, select **Tender/Media** from the **Type** drop-down list.

13. Click the black arrow directly beneath the **Type** drop-down list, select **Hold Order**, and then click **OK**.

14. Position and size the button on the page, and then click **Save**.

15. Repeat Steps 11 through 14 and add touchscreen buttons for the **Fire Order** and **Keep Held Status** service total keys.

---

**Related Topics**

- Configuring Send and Stay
- Adding a Service Total Key to the Transaction Page
- Setting the Hold and Fire Option
- Setting the Hold and Fire Tender Notification
- Setting a Reminder for Items on Hold
- Configuring Check Handling For Closing Checks With Held Items
- Configuring Item Hold Buttons

---

**Configuring Check Handling For Closing Checks With Held Items**

1. Select the property, click **Configuration**, and then click **Tender/Media**.
2. Double-click a Service Total tender record to open it.
3. Click the **Options** tab, and then click the **Ops Behavior** subtab.

4. In the **Tender Media Hold Types** section, select a **Hold Type** for each type of Service Total tender used when making a payment and closing a guest check. The following table describes the Hold Types and their affect on the workstation messages.

<table>
<thead>
<tr>
<th>Hold Type</th>
<th>Workstation Message When Closing a Check with Items on Hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - Fire Order</td>
<td>Select this option to send all items on hold to the order devices. This is the default Hold Type.</td>
</tr>
<tr>
<td>1 - Keep Held Status</td>
<td>Select this option to show a message asking the workstation operator whether to send the items on hold to the order devices or to close the check without sending the items.</td>
</tr>
<tr>
<td>2 - Hold Order</td>
<td>Select this option to show a message asking the workstation operator whether to send the items on hold to the order devices or to close the check without sending the items.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

- **Configuring Send and Stay**
- **Adding a Service Total Key to the Transaction Page**
- **Setting the Hold and Fire Option**
- **Setting the Hold and Fire Tender Notification**
- **Setting a Reminder for Items on Hold**
- **Configuring Checks with Items on Hold to End Current Service Round**
- **Configuring Item Hold Buttons**

**Related Topics**
- **Order Handling on Open Checks**
- **Holding and Sending Items to Order Devices**

**Configuring Item Hold Buttons**

To allow workstation operators to hold items on a check without sending to order devices, you need to add buttons to the touchscreen page.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Open the page on which to place the buttons, and then on the **Edit** tab, select the page area in which to define the buttons.

3. Click **Button**, and then on the **General** subtab, select **Function** from the **Type** drop-down list.

4. Click the black arrow directly beneath the **Type** drop-down list, select **Transaction** from the **Type** pane, and then select one of the following functions:
• **Hold**: Holds the menu items selected in the check detail area.

• **Hold Transaction**: Holds every successive menu item added to the check during the current round.

• **Timed Fire Menu Item**: Holds selected items or an entire check until a predefined time.

• **View Fire Times**: Shows the time each menu item is configured to send to order devices.

5. Click **OK**, enter a **Legend** for the button, and then position and size the button on the page.

6. Repeat Steps 3 through 5 and configure buttons for the remaining hold functions in Step 4, and then click **Save**.

- **Configuring Send and Stay**
- **Adding a Service Total Key to the Transaction Page**
- **Setting the Hold and Fire Option**
- **Setting the Hold and Fire Tender Notification**
- **Setting a Reminder for Items on Hold**
- **Configuring Checks with Items on Hold to End Current Service Round**
- **Configuring Check Handling For Closing Checks With Held Items**

**Related Topics**

• **Order Handling on Open Checks**

• **Holding and Sending Items to Order Devices**

## Configuring the Fire Now Button

To allow workstation operators to fire items on a check from the current service round to order devices, you need to add a Fire Now button to the touchscreen page.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Open the page on which to place the button, and then on the **Edit** tab, select the page area in which to define the button (for example, a menu item selection page).

3. Click **Button**, and then on the **General** subtab, select **Function** from the **Type** drop-down list.

4. Click the black arrow directly beneath the **Type** drop-down list, select **Fire Now** from the **Type** pane, and then select the **Service Total** configured as the Fire Now Service Total.

5. Click **OK**, enter a **Legend** for the button (for example, Fire Now), and then position and size the button on the page. The selected Tender Media’s number appears in the **Arguments** field for the Fire Now function.

6. Click **Save**.
Team Service

Team Service allows assignment of more than one service personnel to a check. A team of service personnel can work together when there is a large party requiring more than one server. In some environments (usually high-end fine dining establishments), Team Service is used exclusively, regardless of the party size.

Tip and receipt totals are divided equally on the Employee Tip Report among all team members when a team check is closed. This allows resulting pay out of tips or service charges to be paid equally among the team members. As the Employee Tip Report is used for income reporting purposes for tax authorities, tax liabilities are shared equally among team members. See Reports and Totals Posting for Team Checks for more information.

Team members can access checks where they are assigned as part of the team, even if they are not the check owner. This is independent of Role option 18 - Authorize/Perform Pickup of a Check Belonging to Another Operator.

Related Topics
- Enabling Team Service
- Configuring Team Service Privileges
- Configuring Revenue Centers to Delete Service Teams at the Start of Day
- Adding Team Service Buttons

Reports and Totals Posting for Team Checks

Team Service only affects Employee Tip Report totals. The Employee Financial Report is not impacted. When a team check is closed, all totals post as usual to the Employee Financial Report of the check operator. Totals posted to the Employee Tip Report are distributed equally among all members of the team.

The following table shows an example result from totals posting of a team check with three team members. Totals post only to the Employee Financial Report of the check owner (Employee 1) while totals are distributed equally among all team members on the Employee Tip Report.

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Total</th>
<th>Employee 1</th>
<th>Employee 2</th>
<th>Employee 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Financial</td>
<td>Net Sales</td>
<td>$ 3000.00</td>
<td>$ 0</td>
<td>$ 0</td>
</tr>
<tr>
<td>Employee Financial</td>
<td>Charge Tips</td>
<td>$ 300.00</td>
<td>$ 0</td>
<td>$ 0</td>
</tr>
<tr>
<td>Employee Tip Report</td>
<td>Gross Receipts</td>
<td>$ 1000.00</td>
<td>$ 1000.00</td>
<td>$ 1000.00</td>
</tr>
<tr>
<td>Employee Tip Report</td>
<td>Charge Tips</td>
<td>$ 100.00</td>
<td>$ 100.00</td>
<td>$ 100.00</td>
</tr>
</tbody>
</table>
Totals posted to the Employee Tip Report outside of a team check, such as those from regular guest checks or employee tip declarations, are posted in the normal manner. This reporting is visible in both Ad Hoc Reports available at the workstation and in Reporting and Analytics Reports.

- Team Service

Related Topics
- Enabling Team Service
- Configuring Team Service Privileges
- Configuring Revenue Centers to Delete Service Teams at the Start of Day
- Adding Team Service Buttons

Enabling Team Service

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Format Parameters.
2. Click the Options tab, and then select 29 - Enable Team Service.
3. To print the names of all team members on guest checks, select 41 - Print Team Member Names on Guest Check.
4. Click Save.

Related Topics
- Team Service
- Reports and Totals Posting for Team Checks

Configuring Team Service Privileges

1. Select the Enterprise, click Configuration, and then click Roles.
2. Double-click the role type, click the Operations tab, and then click the Miscellaneous subtab.
3. Select the appropriate privileges. The following table summarizes the privileges associated with Team Service and the recommended roles to have the privilege set:

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allows the Employee to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>190</td>
<td>Authorize/Create Team</td>
<td>Create a team and add initial team members to it, and to authorize others to do so.</td>
</tr>
<tr>
<td>191</td>
<td>Authorize/Add or Delete Team Member to a Team</td>
<td>Add or delete members to an existing team, and to authorize others to do so.</td>
</tr>
<tr>
<td>192</td>
<td>Authorize/Delete a Team</td>
<td>Delete an existing team, and to authorize others to do so.</td>
</tr>
</tbody>
</table>
Table 31-8    (Cont.) Team Service Privileges

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allows the Employee to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>193</td>
<td>Print a list of Teams</td>
<td>Print a team list showing the name of the team and all assigned members, and to authorize others to do so.</td>
</tr>
<tr>
<td>196</td>
<td>Available as Team Service Team Member</td>
<td>Appear in selection lists when assigning team member.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

**Related Topics**

- Team Service
- Reports and Totals Posting for Team Checks

**Configuring Revenue Centers to Delete Service Teams at the Start of Day**

You can configure Simphony to automatically remove all teams on a daily basis for locations that use Team Service as a standard of operation. As team members usually change each day based on employee scheduling and availability, this allows managers to create new teams each day without having to edit or delete previous teams.

1. Select the Enterprise or property, click **Configuration**, and then click **Task Schedules**.

2. Insert a new record, and then double-click the record to open it.

3. On the **General** tab, select **7 - Workstation** as the **Service Type**, and then select **3 - Reset Team Service** as the **Task Type**.

4. Select **4 - Recurring - Daily** as the **Schedule Type**, select **Enabled**, and then select the **Start Date**.

5. Click the **Recurrence** tab.

6. In the Daily Frequency section, set the time at which to run the task, and then click **Save**.

7. Repeat Steps 2 through 6 to create another task, but change the **Service Type** to **8 - Check and Posting**.

**Related Topics**

- Team Service
- Reports and Totals Posting for Team Checks

**Adding Team Service Buttons**

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.
2. Open the page on which to place the Team Service buttons, and then on the Edit tab, select the page area in which to define the buttons.

3. Click Button, and then on the General subtab, select Function from the Type drop-down list.

4. Click the black arrow directly beneath the Type drop-down list, and then select Check Begin Pickup from the Type pane.

5. Select Begin Team Check, and then click OK.

   The Begin Team Check key allows workstation operators to start a team check. If the workstation operator is a member of multiple teams, the workstation shows a list of teams.

6. Enter a Legend for the button (for example, Begin Team Check), and then position and size the button on the page.

7. Click Save.

8. Repeat Steps 3 through 7 and add buttons for the following functions:
   - Create Team Members or Add Team to Check: Creates, edits, or deletes a team; adds a team to a check; and prints a team list.
   - Edit Team: Shows team information and allows member editing.
   - Remove Team from Check: Removes the team from a check.

Related Topics
- Team Service
- Reports and Totals Posting for Team Checks

Closed Guest Check Operations

After a check is closed, you can allow workstation operators to perform these operations:
- Adjust Closed Check: Change or add a tip, tender, or guest count to a closed check without reopening it.
- Reopen Closed Check: Reopen the check and use as a regular guest check. All menu items from the check are considered previous-round items.
- Reprint Closed Check: Reprint checks for a closed transaction in the current or previous business dates.
- Reprint Previous Closed Check: Reprint a receipt for the last closed check.

Related Topics
- Configuring Closed Check Settings
- Allowing Employees to Adjust Closed Checks
- Allowing Employees to Reopen and Edit a Closed Check
- Allowing Employees to Reprint Closed Checks
- Allowing Employees to Manually Replay Checks Through the Workstation
Configuring Closed Check Settings

1. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Control Parameters**.

2. Click the **Configuration** tab, and then enter information in the following fields:
   - **Number of Days to Adjust Closed Checks**: Enter the number of days (0-999) a privileged employee can adjust closed checks. Enter 0 to allow the adjustment for the current business day only.
   - **Number of Days to Reopen/Reprint Closed Check from Previous Business Day**: Enter the number of days (0-999) a privileged employee can reopen or reprint closed checks. Enter 0 to allow checks from the current business day only to be reopened or reprinted.

   You can override both values above in the Control Parameters module by configuring the **Number of Days to Save Closed Checks**. Checks are purged from the database based on the value for the **Number of Days to Save Closed Checks**.

3. To allow privileged operators to service total reopened checks, click the **Options** tab, and then select **31 - Allow Service Total of Closed Checks**.

4. Click **Save**.

5. To retain the original guest check number when reopened:
   a. Select the revenue center, click **Setup**, and then click **RVC Parameters**.
   b. Click the **Options** tab, and then select **37 - Keep The Same Check Number When a Check is Reopened**.

    If deselected, Simphony assigns a new guest check number to the check when reopened.
   c. Click **Save**.

6. To configure reprinting of closed checks:
   a. Select the Enterprise or property, click **Configuration**, and then click **Tender/Media**.
   b. Insert a Service Total tender record if it does not exist.
   c. Double-click the Service Total record to open it.
   d. On the **General** tab, select **2 - Service Total** as the **Key Type**.
   e. Click the **Options** tab, and then click the **Printing Options** subtab.
   f. Select **19 - Reprint Check**.

    Setting option 19 does not print an exact copy of the receipt unless the printing options are the same as the original tender.

    You can enable other options to include elements of the check, such as **21 - Print Summary Totals** or **22 - Print Check Trailer**, but selecting these options is not required.
   g. Click **Save**.
   h. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Tender Parameters**.
i. Click the **Configuration** tab, and then in the **Default Reprint Check Tender/Media** drop-down list, select the Service Total tender from step 6-b.

j. Click **Save**.

**Related Topics**

- **Closed Guest Check Operations**

---

**Allowing Employees to Adjust Closed Checks**

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.

2. Double-click the role type, click the **Operations** tab, click the **Guest Checks** subtab, and then select the appropriate options:
   - **67 - Authorize/Perform Adjust Closed Check**: Select to allow employees with this role to use the Adjust Closed Check function key, and to authorize others to do so. A closed check adjustment allows the user (if privileged to void Tender/Media from a previous round) to adjust the tender/media, charge tip, or the number of guests on a closed check.
   - **133 - Auth/Perform Adjust Closed Check from Previous Business Days**: Select to allow employees with this role to adjust closed checks from previous business days.

3. Click **Save**.

4. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

5. Open the page on which to place the Adjust Closed Check buttons.

6. On the **Edit** tab, select the page area in which to define the buttons.

7. Click **Button**, and then on the General subtab, select **Function** from the **Type** drop-down list.

8. Click the black arrow directly beneath the **Type** drop-down list, and then select **Check Begin Pickup** from the **Type** pane.

9. Select the appropriate function key, and then click **OK**.
   - **Adjust Closed Check**: Prompts for the check number of the closed check to adjust.
   - **Adjust Closed Check From List**: Prompts to select a closed check to adjust from a list of checks for the current business day.

When adjusting a check using either function key, workstation operators can edit tenders, charge tips, and the number of guests on the check, but the check itself is not reopened.

10. Enter a **Legend** for the button, and then position and size the button on the page.

11. (Optional) Repeat Steps 7 through 10 and configure a button for the remaining Adjust Closed Check function in Step 9, and then click **Save**.

**Related Topics**

- **Closed Guest Check Operations**
Allowing Employees to Reopen and Edit a Closed Check

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type, click the Operations tab, click the Guest Checks subtab, and then select the appropriate options:
   - **68 - Authorize/Perform Reopen Closed Check**: Select to allow employees with this role to use the Reopen Closed Check key, and to authorize others to do so.
   - **134 - Auth/Perform Reopen Closed Check from Previous Business Days**: Select to allow employees with this role to reopen closed checks from previous business days.

3. Click the Voids/Returns subtab, and then select the appropriate options:
   - **69 - Authorize/Perform Void of Menu Items on Closed Checks**: Select to allow employees with this role to void menu items from closed checks after they have been reopened, and to authorize others to do so. You must also select Roles option **25 - Authorize/Perform Void of Menu Items from a Previous Round**.
   - **70 - Authorize/Perform Void of Discounts on Closed Checks**: Select to allow employees with this role to void discounts from closed checks after they have been reopened, and to authorize others to do so. You must also select Roles option **27 - Authorize/Perform Void of Discounts from a Previous Round**.
   - **71 - Authorize/Perform Void of Service Charges on Closed Checks**: Select to allow employees with this role to void service charges from closed checks after they have been reopened, and to authorize others to do so. You must also select Roles option **28 - Authorize/Perform Void of Service Charges from a Previous Round**.

4. Click Save.

5. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

6. Open the page on which to place the Reopen Closed Check buttons.

7. On the Edit tab, select the page area in which to define the buttons.

8. Click Button, and then on the General subtab, select Function from the Type drop-down list.

9. Click the black arrow directly beneath the Type drop-down list, and then select Check Begin Pickup from the Type pane.

10. Select the appropriate function key, and then click OK.
   - **Reopen Closed Check**: Prompts for the check number of the closed check to reopen.
   - **Reopen Closed Check From List**: Reopens the closed checks selected from a list of closed checks available on the current workstation.

11. Enter a Legend for the button, and then position and size the button on the page.

12. Repeat Steps 8 through 11 to create a button for the remaining Reopen Closed Check function in Step 10, and then click Save.
Related Topics

- Closed Guest Check Operations

Allowing Employees to Reprint Closed Checks

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.
2. Double-click the role type, click the **Operations** tab, click the **Printing** subtab, and then select the appropriate options:

   **Table 31-9  Check Reprinting Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>23 - Authorize/Perform Unlimited Reprinting/</td>
<td>Select to allow employees associated with this role to perform two functions:</td>
</tr>
<tr>
<td>Printing of a Check</td>
<td>a. Allow On-Demand operators to print more guest checks than the maximum number allowed.</td>
</tr>
<tr>
<td></td>
<td>b. Allow By-Round operators to use the Reprint Closed Check key.</td>
</tr>
<tr>
<td>24 - Authorize/Perform Reprinting of Closed</td>
<td>Select to allow employees with this role to reprint a closed guest checks and to authorize others to do so.</td>
</tr>
<tr>
<td>Checks</td>
<td>Selecting this option also allows employees to grant authorization to others for these functions.</td>
</tr>
<tr>
<td>157 - Authorize/Perform Reprinting of Closed</td>
<td>Select to allow employees with this role to reprint a guest check from previous business days.</td>
</tr>
<tr>
<td>Checks from Previous Business Days</td>
<td></td>
</tr>
</tbody>
</table>

3. Click **Save**.
4. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.
5. Open the Front of House page on which to place the Reprint Closed Check buttons.
6. On the **Edit** tab, select the page area in which to define button.
7. Click **Button**, and then on the General subtab, select **Function** from the Type drop-down list.
8. Click the black arrow directly beneath the **Type** drop-down list, and then select **Print** from the **Type** pane.
9. Select **Reprint Closed Check**, and then click **OK**.
   When this function key is used, the Default Reprint Check Tender assigned in Tender Parameters is used to print the check.
10. Enter a **Legend** for the button, and then position and size the button on the page.
11. Repeat steps 7 through 10 to create a **Reprint Previous Closed Check** button.
   This function key is used to reprint a receipt for the last closed check.
12. Click **Save**.
Allowing Employees to Manually Replay Checks Through the Workstation

Beginning with Simphony version 2.9.2, you must grant employees permission to manually replay offline checks through the Property Management Console (PMC), if an offline POS workstation fails to automatically replay its checks before reconnecting online.

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Double-click the role type record (for example, administrator or manager).
3. Click the Operations tab, and then click the PMC General/Reports subtab.
4. Select 30001 - Run PMC to allow employees associated with this role to launch the PMC on workstations using the Launch PMC function key.
5. Click the PMC Procedures subtab, and then select 30069 - Replay Checks from the Other Procedure Options section.
6. Click Save.

Check Add/Transfer

Transferring checks is a procedure that changes ownership of a guest check. Simphony enables privileged workstation operators to transfer checks from another server to themselves by employee number or by employee ID number. Guest checks may also be transferred across Revenue Centers. The Transfer Checks function only transfers the ownership of the guest check; it does not transfer the check's sales totals for reporting purposes.

Add Check means to combine two checks together while in a transaction.

Allowing Employees to Add or Transfer Checks

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Double-click the role type record (for example, administrator, manager or server).
3. Click the Operations tab, and then click the Guest Checks subtab.
4. Select the appropriate permission options for the user role:
• **45 - Authorize Transfer of Checks in the Same Revenue Center:** Select to allow employees with this role to transfer checks from another operator within the same revenue center, and to authorize others to do so.

• **46 - Authorize Transfer of Checks Between Revenue Centers:** Select to allow employees with this role to transfer checks from another revenue center, and to authorize others to do so.

• **47 - Authorize Adding of Checks in the Same Revenue Center:** Select to allow employees with this role to add checks (to be in a check, and add another check to it) within a revenue center, and to authorize others to do so.

• **48 - Authorize Adding of Checks Between Revenue Centers:** Select to allow employees with this role to add checks (to be in a check, and add another check to it) from another revenue center, and to authorize others to do so.

5. Click **Save**.

Related Topics
• Check Add/Transfer

---

**Configuring the Add/Transfer Revenue Centers**

1. Select the revenue center, click **Setup**, and then click **RVC Parameters**.

2. On the General tab, scroll down to the Add/Transfer Revenue Center section, and then select up to eight revenue centers from which checks can be transferred into this revenue center.

3. Click **Save**.

4. Repeat Steps 1 through 3 for all revenue centers in the property.

Related Topics
• Check Add/Transfer

---

**Configuring Add/Transfer Buttons**

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Open the page on which to place the Add/Transfer buttons.

3. Click the **Edit** tab, and then select the page area in which to define the buttons.

4. Click **Button**, and then on the **General** subtab, select **Function** from the **Type** drop-down list.

5. Click the black arrow directly beneath the **Type** drop-down list, select **Check Add** from the **Type** pane.

6. Select one of the following function keys, and then click **OK**:  
   • **Add/Transfer by Number**: Adds or transfers a check within the same revenue center using the check number entered.
   
   • **Add/Transfer Check by Number RVC Index**: Adds or transfers a check (using the check number) from the revenue center specified in the Index field.
The Index field points to one of the eight revenue centers configured in the Add/Transfer section of the RVC Parameters module.

- **Add/Transfer Check by Number Prompt RVC**: Adds or transfers a check (using the check number) from one of the eight add/transfer revenue centers configured in the RVC Parameters module.
- **Add/Transfer Check by Table**: Adds or transfers a check within a revenue center. The workstation client prompts for the table number or table ID of the check to be added or transferred.
- **Add/Transfer Check by Table RVC Index**: Adds or transfers a check (using the table number or table ID) from the revenue center specified in the Index field. The Index field points to one of the eight revenue centers configured in the add/transfer section of the RVC Parameters module.
- **Add/Transfer Check by Table Prompt RVC**: Adds or transfers a check (using the table number or table ID) from one of the eight add/transfer revenue centers configured in the RVC Parameters module.
- **Add/Transfer Check From List Prompt RVC**: Prompts users for the revenue center, and then shows all open checks that can be added or transferred from others within the specified revenue center.
- **Add/Transfer Check From List RVC Index**: Shows all open checks in the revenue center (specified by the Index field) that can be added or transferred from others. The Index field points to one of the eight revenue centers configured in the Add/Transfer section of the RVC Parameters module.
- **Add/Transfer Check SLU**: Shows a list of checks that can be added or transferred from other workstation operators on the Open Check SLU.

7. Enter a **Legend** for the button, and then position and size the button on the page.

8. Repeat Steps 4 through 7 to create buttons as needed for the remaining Add/Transfer functions in Step 6.

9. Click **Save**.

**Related Topics**

- **Check Add/Transfer**

### Seat Filtering and Memo Checks

You can configure check filtering by one or more seat numbers, allow workstation operators to apply a tender only for the detail and summary totals associated with the seat, and if required, allow workstation operators to create a check for the filtered seats. This enables workstation operators to:

- Review check detail posting to facilitate the delivery of meals to the proper guest
- Print checks for one or more seats, or for groups of seats in a large party without creating separate checks

For example, a party of four arrives at the restaurant. A workstation operator begins a check for the table, assigning a seat number to each order. When the party has completed the dining experience, guests at seats 1 and 2 want to pay and leave before the guests at seats 3 and 4. The workstation operator can:

1. Filter the check by seats 1 and 2.
2. Apply a tender and close the check for the filtered seats.

3. If configured, print a memo check.

4. Close the check by tendering the remaining seats.

After applying a tender to a filtered check, items belonging to the filtered seat or seats are removed from the primary guest check.

The check for the filtered seats is referred to as a memo check. After closing a memo check, depending on the configuration, the active seat in the filter increments to the next seat number, and menu items associated with that seat appear in the check detail area. A memo tendered check contains the same information as the primary check when closed, such as service team details, event details, and suite owner details.

Workstation operators can identify memo checks on the Check Journal Report by the MEMO CHECK banner on the check header and in ad-hoc reports, as well as on the printed check.

Figure 31-4 Sample Check Filtered by Seats
If a workstation operator prints a memo check before applying a tender to the filtered seats, the memo check prints with the check number of the primary check. If a workstation operator prints a memo check after applying a tender and closing the check, a new check number is assigned to the check that is closed. This check numbering continues until the last items on the check are tendered, which closes the primary check and retains the number.

**Applying Discounts on Memo Checks**

Workstation operators can apply manual discounts to a memo check.

- If one seat is in the active seat filter, the manual discount is applied to the seat that is filtered, and the indicator next to the discount shows the seat number in the check detail.
- If multiple seats are in the active seat filter, the manual discount is applied to all seats that are in the seat filter, but not on the remaining items on the primary check. The indicator next to the discount shows the letter F in the check detail as the discount is applied to multiple seats.
- If there is no active seat filter, the manual discount is applied to the entire check. There is no indicator next to the discount in the check detail.

If an automatic or coupon discount is applied to the primary check, Simphony recalculates the discount when the check is filtered by seats. That is, Simphony applies the automatic or coupon discount to the memo check only if the menu items for the filtered seats are eligible for the discount.

**Performing Operations on a Memo Check**

The following conditions apply when performing operations on a memo check:

- When the check is filtered by multiple seats, new menu items, discounts, and service charges are added to the lowest seat number.
- Workstation operators cannot perform the following functions when a seat filter is active:
Performing Memo Tenders When Using a Kitchen Display System (KDS)

The following conditions apply to the KDS when performing a memo tender:

- KDS Reports and report drill downs do not account for memo tendered or split checks in check counts, timings, and check detail.
- Check modifications such as adding new menu items to a check, adding or editing condiments, and the voiding of existing menu items are not allowed when the following Dynamic Order Mode (DOM) types are enabled:
  - Fire on Fly
  - Fire on Next
  - Fire on Tender

Related Topics

- Configuring Memo Check Printing
- Configuring Service Charges for Seat Filtering
- Configuring Seat Filter Management Buttons

Configuring Memo Check Printing

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.
2. Insert a new record, name it Print Memo Check, and then click OK.
3. Double-click the Print Memo Check record to open it.
4. From the Key Type drop-down list, select 2 - Service Total.
5. Click the Options tab, click the Printing Options subtab, and then select the following options:
   - 13 - Print Memo Check: Select to allow this key to print memo checks.
   - (Optional) 15 - Increment Active Seat # after Memo Check Print: Select to increment the active seat number on the seat filter or active memo check number to the next number each time this key is used to print. This allows workstation operators to, in succession, generate Memo Checks or to apply Memo Tenders. When this option is selected, pop-up operators remain signed in when the seat filter is reset. Deselect to reset the seat filter when this key is used to print.

Select 13 and (optionally) 15 for all tender medias that can be used for Memo Tendering.
6. Click **Save**.
7. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.
8. Open the page on which to place the memo check button.
9. On the **Edit** tab, select the page area in which to define the buttons.
10. Click **Button**, and then on the General subtab, select **Tender/Media** from the **Type** drop-down list.
11. Click the black arrow beneath the **Type** drop-down list, select **Print Memo Check** from the list and then click **OK**.
12. Enter a **Legend** for the button (for example, Print Memo Check), and then position and size the button on the page.
13. Click **Save**.
14. (Optional) To prompt for the guest count for memo checks:
   a. Select the Enterprise, property, revenue center, or zone, click the **Setup** tab, and then click **Control Parameters**.
   b. Click the **Options** tab, and then select **9 - Prompt for Guest Count when Split Check**.

**Related Topics**
- **Seat Filtering and Memo Checks**

**Configuring Service Charges for Seat Filtering**

When a check is filtered by seats, automatic service charges prorate based on the active menu items. Manual service charges do not prorate when seat filtering is active. Instead, the manual service charge is added to the last memo check that is closed for the table. To set manual service charges to prorate based on the filtered seats:

1. Select the Enterprise, property, or zone, click **Configuration**, and then click **Service Charges**.
2. Insert a record for either an automatic or a manual amount service charge with prorate option, or double-click an existing automatic or manual service charge record to open it.
3. On the **General** tab, select option **2 - On = Amount; Off = Percentage**, and then enter the service charge value in the **Amount** field under General Settings.
4. If required for your country, select the **Tax Class** from the drop-down list.
5. Select option **30 - Prorate Service Charges to Menu Items**.
   When selected, the service charge prorates based on the value of the menu items in the filtered seats. This overrides the requirement for the minimum number of guest count for a memo check, if the minimum guest count requirement is met for the entire check.
6. If you are configuring a manual amount service charge with prorate option, complete the following substeps to prorate to all menu items with corresponding service charge itemizers:
   a. Click the **Itemizers** tab, and then select all service charge itemizers.
b. Click the Menu Levels tab, and then select the appropriate Main and Sub Levels.

7. Click the Output tab, and then select Print on Customer Receipt, Print on Journal, and Print on Guest Check.

8. Click Save.

Related Topics
• Seat Filtering and Memo Checks

Configuring Seat Filter Management Buttons

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.

2. Open the page on which to place the memo check button.

3. On the Edit tab, select the page area in which to define the buttons.

4. Click Button, and then on the General subtab, select Function from the Type drop-down list.

5. Click the black arrow beneath the Type drop-down list, and then select Guest Seat from the Type pane.

6. Select one of the following function keys, and then click OK:
   • Manage Seat Filter: A pop-up screen appears showing all available seats on the guest check, and lets you add or remove seats interactively from the seat filter.
   • Add to Seat Filter: Prompts you for a seat number that is to be filtered (if no seat filter is active), or adds the seat number to an active seat filter.
   • Remove From Seat Filter: Prompts you for the seat number that you want to remove from the current seat filter.
   • Clear Seat Filter: Removes all seats from the current seat filter.
   • Edit Seat: Allows you to change the seat number of previously ordered menu items.

7. Enter a Legend for the button, and then position and size the button on the page.

8. Repeat Steps 3 through 6 and create buttons for the remaining functions in Step 6.

9. Click Save.

Related Topics
• Seat Filtering and Memo Checks
A touchscreen page is a defined layout of functions and buttons that you configure in the EMC. The touchscreen page appears on the workstation, allowing workstation operators to perform operations and transactions on the POS client.

Page templates allow you to customize a workstation touchscreen page in various ways. Page templates are categorized into the following types:

- **Classic templates**: These templates are similar to Simphony First Edition touchscreen templates
- **Blank templates**: These templates are used for customized pages or a Sign On page
- **Tabbed templates**: These templates are used for Sign On and Transaction pages

Tabbed templates allow the greatest functionality. With a tabbed template, you can configure multiple tabs on the page. Approximately 50 tabs and subtabs can appear on a page, and each tab and subtab contain up to 50 buttons. Having a large number of buttons on a single page allows you to configure a small number of pages for a revenue center. A tab is used for navigation. Navigation on a page is consistent from page to page (navigation bar and subtabs).

Pages can contain buttons and more sophisticated content, such as dining tables, Screen Lookups (SLUs), numeric entry areas, and background panels for highlighted groups of controls. All buttons performs a function.

The content appearing on a page can be dynamic based on the menu levels, serving period, employee class, or other criteria. For example, you can show a Manager Functions tab only if the manager is assigned to one of three manager employee classes.

When editing pages from the Page Design module, what-you-see-is-what-you-get.

- **Page Design**
- **Assigning Default Touchscreen Pages**
- **Configuring Function Keys**
- **Configuring Macros**

### Page Design

A touchscreen page is a defined layout of functions and buttons that you configure in the EMC. The touchscreen page appears on the workstation, allowing workstation operators to perform operations and transactions on the POS client.

Page templates allow you to customize a workstation touchscreen page in various ways. Page templates are categorized into the following types:

- **Classic templates**: These templates are similar to Simphony First Edition touchscreen templates
• Blank templates: These templates are used for customized pages or a Sign On page
• Tabbed templates: These templates are used for Sign On and Transaction pages

Tabbed templates allow the greatest functionality. With a tabbed template, you can configure multiple tabs on the page. Approximately 50 tabs and subtabs can appear on a page, and each tab and subtab contain up to 50 buttons. Having a large number of buttons on a single page allows you to configure a small number of pages for a revenue center. A tab is used for navigation. Navigation on a page is consistent from page to page (navigation bar and subtabs).

Pages can contain buttons and more sophisticated content, such as dining tables, Screen Lookups (SLUs), numeric entry areas, and background panels for highlighted groups of controls. All buttons performs a function.

The content appearing on a page can be dynamic based on the menu levels, serving period, employee class, or other criteria. For example, you can show a Manager Functions tab only if the manager is assigned to one of three manager employee classes.

When editing pages from the Page Design module, what-you-see-is-what-you-get.

Related Topics
• Configuring Function Keys
• Configuring Macros

Assigning Default Touchscreen Pages

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Assignment.
2. Click the Configuration tab, and then configure the following settings:
   • Default Sign In Page: Select the page to show when workstation operators are not signed on to a workstation.
   • Default Transaction Page: Select the page to show for workstation operators who sign on to this location when a transaction page is not defined (through operator, Employee Class, and so on).
   • Default Training Page: Select the page to show for workstation operators in training mode. If you select 0 - None, employees in training mode see the default touchscreen based on the touchscreen hierarchy.
3. Click Save.

Configuring Function Keys

Function keys allow workstation operators to perform a variety of tasks, such as beginning a guest check, opening a cash drawer, authorizing a credit card, transferring checks, printing customer receipts, and many other operations.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Open the page on which to place a function key.
3. On the Edit tab, select the page area in which to define the function key.
4. Click **Button**.
5. On the **General** subtab, enter the key name in the **Legend** field.
6. From the **Type** drop-down list, select **Function**.
7. Click the black arrow beneath the **Type** drop-down list.
8. Select the appropriate function, and then click **OK**.
9. Position and size the button on the page. Use the Style arrow to change the color.
10. Click **Save**.

**Configuring Macros**

- **Related Topics**
  - **Page Design**

---

**Configuring Macros**

A macro is a button that, when pressed, executes a series of commands. Macros save time when workstation operators frequently enter certain sequences or keystrokes. You can set macros to include menu items, service charges, discounts, tenders, function keys, alphanumeric keys, or a link to another macro.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.
2. Open the page on which to place the macro button.
3. On the **Edit** tab, select the page area in which to define the macro button.
4. Click **Button** to add a button.
5. On the **General** subtab, enter the button name in the **Legend** field.
6. From the **Type** drop-down list, select **Function**.
7. Click the black arrow directly beneath the **Type** drop-down list, select the **Macro** function, and then click **OK**.
8. Click the **Edit Macro Keys** button, and then add the appropriate steps in the proper sequence.
9. Highlight the macro button.
10. Position and size the button on the page. Use the Style arrow to change the color.
11. Click **Save**.

- **Configuring Function Keys**

**Related Topics**

- **Page Design**
Rental Deposits

Rental deposits are used in Simphony to record advance payments on scheduled events, such as banquets, parties, room rentals, or as a security deposit on loaned items, such as bowling shoes. The Rental Deposits feature allows workstation operators to accept, apply, record, report, and refund rental deposits taken at the POS client.

A rental deposit can be a menu item or a non-revenue service charge. Unlike traditional non-revenue service charges, a check can contain more than one rental deposit.

Automatic discounts are not applied to rental menu items as the discount amount can change when other items are added to the check.

- Configuring Deposits as a Menu Item
- Configuring Deposits as a Service Charge
- Configuring Rental Deposit Buttons

Related Topics
- Configuring Deposits as a Menu Item
- Configuring Deposits as a Service Charge
- Configuring Rental Deposit Buttons

Configuring Deposits as a Menu Item

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Classes.
2. Insert a new record for the rental item (for example, Bike Rental or Bowling Shoes).
3. Double-click the new record to open it, and then click the Options tab.
4. Select 64 - Rental Deposit, and then click Save.
   Enabling this option makes all menu items assigned to this class Rental Deposits. You can use this option with the Deposit Handling feature to apply a deposit to a check.
5. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.
6. Insert a new record and name it the same as the rental item.
7. Double-click the new record to open it, insert a definition record, and then click the General tab.
8. From Menu Item Class, select the class that you created in Step 2, and then click Save.
9. Select the revenue center, click Setup, and then click RVC Parameters.
10. On the **General** tab, select the rental item that you created in Step 6 from the **Deposit Forfeit Return Item (Menu Item)** drop-down list, and then click **Save**.

11. Add a button for the rental item to the workstation Transaction page. See **Adding Menu Item Keys to the Transaction Page** for instructions.

**Related Topics**
- Rental Deposits

### Configuring Deposits as a Service Charge

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Menu Item Classes**.

2. Insert a new record for the rental service charge (for example, Banquet Service Charge or Conference Room Rental Service Charge).

3. Double-click the new record to open it, and then click the **Options** tab.

4. Select **64 - Rental Deposit**, and then click **Save**.

5. Select the Enterprise or property, click **Configuration**, and then click **Service Charges**.

6. Insert a new record and name it the same as the rental service charge.

7. Double-click the new record to open it.

8. On the **General** tab, select **23 - Rental Deposit**, and then configure the following settings:
   - **1 - On = Open; Off = Preset**: Select to make the rental deposit service charge an open service charge, prompting workstation operators for the amount or percentage. Deselect to use a preset amount or preset percentage for the rental deposit service charge.
   - **2 - On = Amount; Off = Percentage**: Select to make the rental deposit service charge an amount service charge. Deselect to make the rental deposit service charge a percentage service charge.

9. Click **Save**.

10. Select the revenue center, click **Setup**, and then click **RVC Parameters**.

11. Click the **Options** tab, and then select **67 - Use Service Charge as Deposit Forfeit Return Item**.

12. Click the **General** tab, and then select the service charge that you created in Step 6 from the **Deposit Forfeit Return Item (Service Charge)** drop-down list.

13. Click **Save**.

**Related Topics**
- Rental Deposits

### Configuring Rental Deposit Buttons

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Open the page on which to place the Rental Deposit buttons.
3. Click the Edit tab, and then select the page area in which to define the buttons.

4. Click Button, and then on the General subtab, select Function from the Type drop-down list.

5. Click the black arrow directly beneath the Type drop-down list, select Transaction from the Type pane.

6. Select one of the following function keys, and then click OK:
   - Apply Deposit: Applies a deposit to an active guest check containing a rental deposit.
   - Edit Deposit: Modifies information for the current or future rounds for a deposit in the check detail area.
   - Show Deposit: Refunds a deposit on a closed check, or prints a deposit report for all deposits or a selected deposit.

7. Enter a Legend for the button, and then position and size the button on the page.

8. Repeat Steps 4 through 7 and create buttons for the remaining Rental Deposit functions in Step 6.

9. Click Save.

10. If you configured a deposit as a service charge, add a button for the Deposits service charge to the transaction page. Creating Service Charge Buttons contains instructions.

Related Topics
- Rental Deposits
A business day refers to the beginning and end times of a day of business. A business day can have any begin time, but typically a business day starts in the early morning hours during a slow or closed period of operations (for example, 3:00 a.m. or 4:00 a.m.). A calendar day always begins at 12:00 a.m.

To reset daily check and employee totals, a property or revenue center must start a new business day.

- **Start of Day**
- **Start of Day Business Rules**
- **Start of Day with Offline Workstations or Server**
- **Configuring Start of Day**

### Start of Day

Start of Day (SOD) is the process that begins a new business day at a property. The SOD can be set to run automatically or manually.

When the time of day occurs that a new business day is automatically configured to start (for example, at 4:00 a.m. each day), the following actions occur in the order listed:

- Simphony increases the Business Day and updates the status of checks and employees.
- The PC Autosequence runs, and typically performs the following actions:
  - Batches and settles credit cards
  - Runs custom applications for a property
- After the SOD Autosequence completes, Simphony checks to see whether it is time to run other autosequences (such as Start of Week Autosequence, Start of Pay Period Autosequence, and so on).

Many properties like to start a new business day manually at their own time (after a night auditor balances reports). Often these properties stop their Simphony and property management systems at the same time, roll to a new business day, and then bring the systems back up. An administrator can manually run SOD in Simphony using an interaction called PC Autosequence (from the EMC) or by pressing a button on the workstation. When SOD begins manually, Simphony performs the same actions as if it were run automatically. The only difference is the method by which SOD begins.

- **Start of Day Business Rules**
- **Start of Day with Offline Workstations or Server**

**Related Topics**

- **Configuring Start of Day**
Start of Day Business Rules

Simphony has business rules to determine how and when a business day can begin, and which business day is beginning. The rules exist for both automatic and manual SOD.

When starting a new business day, the following rules apply:

• SOD cannot be run twice in 8 hours.
• SOD cannot be run twice between midnight and noon.
• SOD cannot be run twice between noon and midnight.
• When a business day is scheduled to run automatically, it is not possible to start the business day manually with a PC Autosequence.

A business day is calculated based on noon (12:00 p.m.) to noon times.

• If SOD is run before noon, Simphony assumes the business day completed is for the previous calendar day. (If SOD runs at 3:05 a.m. on the 17th, the 16th is the business day that is closing, and the 17th is the business day being started.)
• If SOD is run after noon, Simphony assumes the business day completed is for the current calendar day. (If SOD is run at 11:52 p.m. on the 17th, the 17th is the business day that is closing, and the 18th is the business day being started.)

Related Topics

• Configuring Start of Day

Start of Day with Offline Workstations or Server

Workstations are aware of the business date configuration so that offline reports show relevant information. Consider the following scenario:

• Every business day begins at 3:00 p.m.
• On Tuesday at approximately 11:00 a.m., a property loses communication with the database (the property is in Yellow Mode).
• The site is offline until Friday afternoon.

In this situation, workstations run reports as if SOD occurred. For example, a report taken for today on Wednesday at 4:00 p.m. shows data from Wednesday at 3:00 a.m. (the time SOD would have occurred) to the current second when the report was taken.

In addition, if days are configured for manual SOD, workstation reports assume that the business day begins 24 hours after the previous SOD occurred. In this situation, a dialog box appears on workstations informing the manager that a new business day has begun.

Catch-Up mode increases the business day after the Simphony server goes offline during an automatically scheduled SOD time period. Consider the following scenario:

• SOD is set to run automatically at 4:00 a.m.
• At 2:00 a.m., the Simphony server experiences a power failure.
At 6:00 a.m., the Simphony server is online again. In Catch-Up mode, the SOD Autosequence does not start. With Catch-Up mode, the business day still starts at 4:00 a.m. When Simphony comes online at 6:00 a.m., the PERIOD_INSTANCE table is populated with rows to indicate that the business day started. The rows do not show a 6:00 a.m. run time, however. Catch-Up mode knows that the application was supposed to have started at 4:00 a.m., so the rows are created with 4:00 a.m. as the start time. Simphony can catch-up from up to two missed automatic start of days and make the appropriate PERIOD_INSTANCE entries.

Related Topics
- Configuring Start of Day

**Configuring Start of Day**

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.
2. Select the role type (such as manager), click the **Operations** tab, and then click the **PMC Procedures** subtab.
3. Select the appropriate start of day role privileges:
   - **30058 - Run Start of Day from OPS**: Select this option to allow all employees with the role to increment the business date from the property's Check and Posting Service (CAPS) workstation.
   - **30059 - Prevent Running SOD from OPS with Open Checks**: Select this option so that Start of Day (SOD) cannot run when open checks exist.
4. Click **Save**.
5. To allow a manager or administrator to manually run SOD from a workstation, select the Enterprise, property, or revenue center, click **Configuration**, and then click **Page Design**. Otherwise, skip to Step 14.
6. Select the page on which to place the **Start of Day** button.
   - The **Start of Day** button allows a manager or administrator to manually run the Start of Day on a workstation.
7. Add a Start of Day button:
   a. In the **Legend** field, enter **Run Start of Day**.
   b. From the **Type** drop-down list, select **Function**.
   c. Click the arrow beneath the **Type** drop-down list, and then select **Start of Day**.
   d. Position and size the new button on the page.
8. Click **Save**.
9. Select the property, click **Setup**, and then click **Property Parameters**.
10. Click the **Options** tab.
11. To allow a manager or administrator to manually run SOD from a workstation, select **48 - Run Start of Day from OPS**.
12. Click the **Calendar** tab.
13. Select Run Manually for each day of the week.

14. In the Manual SOD Safety catch time field, set the time when the application automatically increments the business date if someone forgets to manually run SOD.

The application checks to see whether SOD occurred within a 24-hour period for the selected property. This time is based on the time zone of the property.

15. Click Save.

16. Select the Enterprise level, click Configuration, and then click PC Autosequences.

17. Insert a PC Autosequence record and name it Increment Business Day.

18. Open the record, and then select the Allowed Properties to view the autosequence.

19. (Optional) Add Parameters as appropriate. For example, you can enter a property number and exclude a revenue center number.

20. On the Steps tab, add a step, and then from the Step Type drop-down list, select 3 - Increment Business Date.

21. Click Save.

Related Topics

- Start of Day
- Start of Day Business Rules
- Start of Day with Offline Workstations or Server
Updating POS Client Configuration

You can establish the frequency with which database synchronization jobs run on the workstations. By default, the workstations and Kitchen Display System (KDS) Controllers wait 30 minutes to retrieve the latest updates from the database.

The Database Update Frequency setting exists in three EMC modules:

- Property Parameters
- Workstations
- KDS Controller

The Workstations module setting or KDS Controller module setting takes precedence over the Property Parameters setting. If the workstation’s Database Update Frequency setting is greater than the Property Parameters setting, the highest configured value within the entire Workstations module for the property is used for the purge jobs event scheduling calculation.

- Setting the Database Update Frequency

Setting the Database Update Frequency

1. Select the property, click Setup, and then click Property Parameters.
2. Click the Workstations tab.
3. In the Database Update Frequency field, enter the number of seconds that workstations and KDS Controllers wait to retrieve the latest updates from the database.
4. Click Save.
5. To override this setting for the workstation, select the property, click Setup, and then click Workstations.
6. Double-click the workstation.
7. On the General tab, set the Database Update Frequency timeout value.
8. Click Save.
9. To override this setting for the KDS, select the property, click Setup, and then click KDS Controllers.
10. Double-click the KDS record.
11. On the General tab, set the Database Update Frequency timeout value.
12. Click Save.
Clearing Totals

If you have the appropriate privileges, you can purge unwanted transaction totals accumulated during testing and training periods prior to going live. Clearing totals immediately purges the totals for all of the designated property’s revenue centers from the Enterprise. You cannot clear totals for individual revenue centers.

The Clear Totals operation performs the following tasks:

- Immediately purges the property's transaction totals and check related data on and prior to the selected business date from the Enterprise
- Initiates a request to run a purge job for the reporting database (Oracle Hospitality Reporting and Analytics Advanced) totals
- Purges the MRequest Queues data
- Purges the Journal log file data
- (Optional) Purges Cash Management data

After the Clear Totals operation begins, two data purging events are scheduled to run for the following purge jobs:

- Check and Posting Service (CAPS) Database: This event runs first based on the Database Update Frequency setting, plus an additional 30 minutes. When the scheduled time is reached, the application purges the designated property’s CAPS database.
- Workstation DataStore Data: This event runs second based on the Database Update Frequency setting, plus an additional 45 minutes. When the scheduled time is reached, the application purges the DataStore data from the designated property’s workstations.

Running the Clear Totals Operation

Before clearing totals, you must batch and settle all credit card transactions dated prior to the specified business date. You cannot clear totals when unbatched credit cards exist. Oracle recommends that you generate and save all credit card related reports from either the EMC or Oracle Hospitality Reporting and Analytics for historical reference.

Time Zone synchronization between the Simphony application server and workstations is important for the Clear Totals operation to work correctly. The CAL keeps the time settings on Simphony clients in sync with the Simphony application server. Some devices do not use CAL for configuration, and these devices can become out of sync with the Simphony application server. Therefore, before running the Clear Totals operation, ensure that the time settings on non-CAL devices are set to match the Simphony application server’s time settings as closely as possible.

1. Select the property, click **Tasks**, and then click **Clear Totals**.
2. Select the **Business Date** from the drop-down list.

3. Click **Clear Totals**. The Result window shows the status of each purged job.

4. Select the property, click **Setup**, and then click **Workstations**.

5. Look at the column named **Totals Cleared Through**, and verify that the date and time appear in the column for each workstation at the property.

6. Double-click the Check and Posting Service (CAPS) workstation, and then click the **Service Host** tab.

7. Verify that the date and time appear in the **Totals Cleared Through** column for the CAPS workstation.

EGateway log files show the date and time a Clear Totals operation was performed.
The Check and Posting Service (CAPS) is a required service that runs on-premises at the property. CAPS acts as the bridge between the Enterprise and the property, providing resiliency and increasing system performance. As workstation operators perform transactions and other operations on POS clients, CAPS stores the information and then posts in real-time to the Enterprise. Each property must have CAPS configured because without it, information occurring on the POS clients does not post to the Enterprise.

In the event of a WAN outage, POS clients are largely unaffected as they continue to post transactions to the on-premises CAPS. During a WAN outage, the Enterprise is inaccessible to the property; changes made in EMC are not reflected on POS clients, and Reporting and Analytics reports do not include the live transactions. Other systems and functions that rely on Enterprise connectivity are similarly impacted. When the WAN connection is restored, CAPS posts the information to the Enterprise.

CAPS also serves as the arbitrator of check sharing by maintaining a record of check ownership. This minimizes the likelihood of multiple POS clients having conflicting versions of a check.

Some properties perform a large volume of transactions that overwhelm the POS client workload. For these environments, it may be necessary to run CAPS on a PC with significantly more computing resources and disk space. The information in this chapter explains the variety of configuration methods for CAPS.

- CAPS Configuration Methods
- CAPS Supported Software and Hardware
- CAPS Configuration Tool
- Prerequisite Products for CAPS
- Configuring CAPS on Microsoft IIS with Oracle Database on Enterprise Server
- Configuring CAPS on Microsoft IIS with Oracle Database on Remote Service Host
- Configuring CAPS on Microsoft IIS with SQL Server Database on Enterprise Server
- Configuring CAPS on Microsoft IIS with SQL Server Database on Remote Service Host
- Upgrading Microsoft IIS CAPS
- Configuring CAPS as a Windows Service with an Oracle Database
- Configuring CAPS as a Windows Service with a Microsoft SQL Database
- Optional CAPS Configuration Tasks
CAPS Configuration Methods

Beginning with Simphony version 2.9, you can run the CAPS web application on Microsoft Internet Information Services (IIS) and also have the CAPS database reside on an Oracle database.

Running CAPS as a web service is an alternative method to running CAPS as a Windows service and a workstation-based service. In Simphony versions earlier than 2.9, CAPS runs only on a Microsoft SQL Server database and the embedded Simphony Service Host Webkit web server.

CAPS needs to be on-property regardless of which configuration fits the business architecture. CAPS holds state information of checks and hence, the CAPS service must be on sticky sessions. The CAPS service cannot reside behind a load balancer.

You can run CAPS using one of the following types of configuration methods:

- CAPS Running on a POS Client Workstation (along with the POS client)
- CAPS Running on a POS Client Workstation (without the POS client)
- CAPS Running as a Windows Service with Oracle database
- CAPS Running as a Windows Service with Microsoft SQL Server database
- CAPS Running as a Web Service on Microsoft Internet Information Services (IIS) with Oracle database
- CAPS Running as a Web Service on Microsoft IIS with Microsoft SQL Server database

Table 37-1  CAPS Configuration Methods

<table>
<thead>
<tr>
<th>CAPS Configuration Details</th>
<th>CAPS on a POS Client Workstation</th>
<th>CAPS as a Windows Service</th>
<th>CAPS as a Web Service on Microsoft IIS</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAPS Database</td>
<td>Microsoft SQL Express</td>
<td>Microsoft SQL Server</td>
<td>Oracle Database</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Server Database</td>
<td></td>
</tr>
<tr>
<td>CAPS Service Host</td>
<td>POS client</td>
<td>CAPS Only</td>
<td>CAPS Only</td>
</tr>
<tr>
<td>Hardware</td>
<td>All supported Oracle</td>
<td>All supported Microsoft</td>
<td>All supported Microsoft</td>
</tr>
<tr>
<td></td>
<td>MICROS workstations</td>
<td>Windows Servers</td>
<td>Windows Servers</td>
</tr>
</tbody>
</table>

- CAPS Supported Software and Hardware
- CAPS Configuration Tool
- Prerequisite Products for CAPS
- Tasks to Set Up CAPS as a Web Service on Microsoft Internet Information Services (IIS)

CAPS Supported Software and Hardware
Recommended Workstations for CAPS

- Oracle MICROS Workstation 610
- Oracle MICROS Workstation 620
- Oracle MICROS Workstation 650
- Oracle MICROS PC Workstation 2015 (Microsoft POSReady 7, Microsoft Windows 7 Professional)
- Oracle MICROS Workstation 5A (Microsoft POSReady 7, Microsoft POSReady 2009)

CAPS Supported Operating Systems

- Microsoft Windows Server 2012 R2
- Microsoft Windows Server 2008 R2
- Microsoft Windows 10 IoT Enterprise (formerly Industry)
- Microsoft Windows 8.1
- Microsoft Windows 7
- Microsoft POSReady 7
- Microsoft POSReady 2009

CAPS Supported Databases

- Oracle Database 12c Standard Edition
- Microsoft SQL Server 2012 R2 Enterprise or Standard or Express Edition
- Microsoft SQL Server 2008 R2 Enterprise or Standard or Express Edition

CAPS Configuration Tool

To facilitate CAPS configuration, you can use the CAPS Configuration Tool. The CAPS Configuration Tool is packaged with the Simphony 18.1 release during an installation or upgrade, deploys on the Simphony server to the [Drive letter]: \MICROS\Simphony2\Tools folder, and is named CAPSConfigurator.

If privileged to do so, when you click CAPSConfigurator, use your EMC logon credentials to sign on to the tool. The tool provides an option to upgrade CAPS to future versions of Simphony, create the CAPS database schema on either an Oracle or Microsoft SQL Server database. The tool can also assist you in configuring the service on IIS, and finally, it can authenticate CAPS on existing Services Hosts running instances of CAPS on IIS.
Figure 37-1  CAPS Configurator Tool

Configuring CAPS Access contains important information about enabling the privileges to access the CAPS Configuration Tool.

- CAPS Configuration Methods
- CAPS Supported Software and Hardware
- Prerequisite Products for CAPS
- Tasks to Set Up CAPS as a Web Service on Microsoft Internet Information Services (IIS)

Prerequisite Products for CAPS

The following prerequisite products are required when using CAPS as a web service on Microsoft Internet Information Services (IIS), unless otherwise noted.

- Simphony Version 2.9 or Later
- Database Platform (one of the following):
  - Oracle Database 12c Server
  - Oracle Database 12c Standard Edition
  - Microsoft SQL Server 2012
- Operating System Components:
  - Microsoft IIS
  - Microsoft .NET Framework 4.6.1
- Tasks to Set Up CAPS as a Web Service on Microsoft Internet Information Services (IIS)
Tasks to Set Up CAPS as a Web Service on Microsoft Internet Information Services (IIS)

Setting up CAPS as a web service consists of completing the following tasks:

- Allowing access to the CAPS Configuration Tool
- Enabling users to install and authenticate workstations
- Configuring the Service Host for CAPS in the EMC
- Installing CAPS database software (Oracle or Microsoft SQL Server)
- Configuring the CAPS database
- Configuring the Service on Microsoft IIS

Configuring CAPS Access contains important information about enabling the privileges to access the CAPS Configuration Tool.

Configuring CAPS Access

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Select the role type, click the Operations tab, and then click the Miscellaneous subtab.
3. Select the following Miscellaneous options:
   - 10061 - Allow Access to the IIS CAPS Configurator Tool
• 10065 - Download Software, Install and Authenticate Clients and Service Hosts Using CAL

4. Click **Save**.

**Note:**

Before you perform an upgrade to Simphony 18.1 from Simphony versions 2.9.x or 2.10, you need to ensure that the options described above are enabled before running the post-upgrade CAPS Configuration Tool. Specifically, if option 10065 is disabled prior to the upgrade, after the upgrade, an error message appears during your login to the CAPS Configuration Tool. If you click **OK** on the error message window, you can log onto the CAPS Configuration Tool, but you cannot utilize the **Authenticate CAPS** button (added to the CAPS Configuration Tool for the Simphony 18.1 release).

### Configuring the Service Host for CAPS in EMC

Follow these steps to configure the Service Host for a hosted Enterprise with Simphony Premium Cloud Service users:

1. Select the Enterprise level, click **Setup**, and then click **Service Hosts**.
2. Insert a new Service Host record, and then double-click it to open in form view.
3. In the **Host Name** field, enter the host name of the Simphony application server where Microsoft IIS is running.
4. Enter the **Subnet Mask** and the **Default Gateway** of the Enterprise server.
5. Click **Save**.
6. Select the property, click **Setup**, and then click **Property Parameters**.
7. Click the **Workstations** tab.
8. From the Service Hosts section, select the CAPS Service Host created in Step 1, and then enter the **Port** number for CAPS configuration. For example, port number 8050.

   This port is the unused port number and is different from the EGateway service port.
9. Click **Save**.

### Configuring CAPS with an Oracle Database

1. Run the ODP.NET_12CR2.bat under the current directory with administrator privileges from a command prompt.
2. Navigate to the directory containing the CAPSConfigurator folder.

   Depending on your configuration method, the path is one of the following:
   • [Drive Letter]:\MICROS\Simphony2\Tools\CAPSConfigurator
   • [Drive Letter]:\MICROS\Simphony\CAPSonIIS\Tools\CAPSConfigurator
3. Double-click **CAPSConfigurator**, enter the server and port number of the EGateway, and sign in using your EMC credentials. A list of Service Hosts appears.

4. Click the Service Host to configure.

5. Click **CAPS Schema**.

6. Enter the appropriate information in the CAPS Schema dialog, and then click **Next**.
   - **Database**: Select the Oracle database type.
   - **Server**: Enter the server name.
   - **Port**: Enter the port number.
   - **Service name**: Enter the service name.
   - **Admin User**: Enter the administrative user name used to sign onto the Oracle database server, for example, the system user name. This user name cannot be a DBA user.
   - **Password**: Enter the current user’s password to sign onto the Oracle database server.

7. In the next CAPS Schema dialog, enter the **User Name**, **Password**, and **Confirm Password** to create a new database user for the CAPS database, and then click **Next**.

8. Click **OK** to confirm. A message indicates success.

The CAPS Schema dbsettings.xml is configured at one of the following directories (depending on your configuration):
- [Drive Letter]:\MICROS\Simphony2\IISCAPSServiceHost
- [Drive Letter]:\MICROS\Simphony\IISCAPSServiceHost

**Configuring CAPS Access** contains important information about enabling the privileges to access the CAPS Configuration Tool.

### Configuring CAPS on Microsoft IIS

In the CAPS Configurator Tool, click **Configure CAPS**.

The CAPS Configurator Tool detects and configures the new Service Host. Upon successful configuration, the configured check box in the UI is automatically selected for the configured Service Host. A browser opens with the configured CAPS URL.

**CAPS is configured at** [Drive Letter]:\MICROS\Simphony2\EgatewayService\IISCAPSServiceHost.

**Configuring CAPS Access** contains important information about enabling the privileges to access the CAPS Configuration Tool.

### Configuring CAPS on Microsoft IIS with Oracle Database on Remote Service Host

The CAPS service must run on the same server where the Oracle database is installed.
• Configuring CAPS Access
• Configuring the Service Host for CAPS in EMC
• Preparing the Server to Configure CAPS
• Configuring CAPS with an Oracle Database
• Configuring CAPS on Microsoft IIS

Configuring CAPS Access

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Select the role type, click the Operations tab, and then click the Miscellaneous subtab.
3. Select the following Miscellaneous options:
   • 10061 - Allow Access to the IIS CAPS Configurator Tool
   • 10065 - Download Software, Install and Authenticate Clients and Service Hosts Using CAL
4. Click Save.

Note:
Before you perform an upgrade to Simphony 18.1 from Simphony versions 2.9.x or 2.10, you need to ensure that the options described above are enabled before running the post-upgrade CAPS Configuration Tool. Specifically, if option 10065 is disabled prior to the upgrade, after the upgrade, an error message appears during your login to the CAPS Configuration Tool. If you click OK on the error message window, you can log onto the CAPS Configuration Tool, but you cannot utilize the Authenticate CAPS button (added to the CAPS Configuration Tool for the Simphony 18.1 release).

Configuring the Service Host for CAPS in EMC

1. To configure the Service Host for a hosted Enterprise with Simphony Standard Cloud Service users:
   a. Select the property level, click Setup, and then click Workstations.
   b. Insert a new workstation record, and then double-click it to open in form view.
   c. On the General tab, enter the host name of the remote server where CAPS will be configured in the Address/Host Name field.
   d. Enter the Subnet Mask and the Default Gateway of the remote server where CAPS will be configured.
   e. If you are configuring CAPS as a Windows Service, select Is Windows Service. Otherwise, skip this step.
   f. Click Save.
   g. Click the Remove OPS From Service Host link, and then click Yes to confirm.
2. To configure the Service Host for a hosted Enterprise with Simphony Premium Cloud Service users:
   a. Select the Enterprise level, click **Setup**, and then click **Service Hosts**.
   b. Insert a new Service Host record, and then double-click it to open in form view.
   c. In the **Host Name** field, enter the host name of the remote server where CAPS will be configured.
   d. Enter the **Subnet Mask** and the **Default Gateway** of the remote server.
   e. If you are configuring CAPS as a Windows Service, select **Is Windows Service**. Otherwise, skip this step.
   f. Click **Save**.

3. Select the property, click **Setup**, and then click **Property Parameters**.

4. Click the **Workstations** tab.

5. From the Service Hosts section, select the CAPS Service Host created in Step 1 or 2, and then enter the **Port** number for CAPS configuration.

   This Port is the unused port number and is different from the Egateway service port.

6. Click **Save**.

## Preparing the Server to Configure CAPS

1. Ensure that the Server has the latest Microsoft Windows patches.

2. Turn on the Microsoft Windows features:
   - Microsoft .NET Framework 3.5
   - Microsoft IIS


4. Install the database: either Oracle Database 12c Server or Microsoft SQL Server.

   If using the Oracle Database 12c Server:
   - Deselect the pluggable database option.
   - Select the database admin user system account or equivalent.

5. In the EMC, configure the CAPSOnIIS CAL package for deployment to the Remote Service Host.

6. Install the CAL client on the Remote Service Host.

7. In the EMC, deploy the CAPSOnIIS CAL Package to the configured Service Host.

   After completion, this package is available in the [Drive Letter]:\Micros\Simphony\CAPSonIIS folder.

8. If you are using Oracle Database 12c Release 2 for the CAPS database, complete the following steps:
   a. Navigate to [Drive Letter]:\Micros\Simphony\CAPSonIIS\Tools \ODP.NET_12CR2, and then follow the instructions in the Readme.
   b. Run the ODP.NET_12CR2.bat under the current directory with administrator privileges from a command prompt.
During batch file execution, the status appears in the Command Prompt window.

c. After successful execution of the batch file, close the Command Prompt window.

Configuring CAPS with an Oracle Database

1. Run the ODP.NET_12CR2.bat under the current directory with administrator privileges from a command prompt.

2. Navigate to the directory containing the CAPSConfigurator folder.
   Depending on your configuration method, the path is one of the following:
   • [Drive Letter]:\MICROS\Simphony2\Tools\CAPSConfigurator
   • [Drive Letter]:\MICROS\Simphony\CAPSonIIS\Tools \CAPSConfigurator

3. Double-click CAPSConfigurator, enter the server and port number of the EGateway, and sign in using your EMC credentials. A list of Service Hosts appears.

4. Click the Service Host to configure.

5. Click CAPS Schema.

6. Enter the appropriate information in the CAPS Schema dialog, and then click Next.
   • Database: Select the Oracle database type.
   • Server: Enter the server name.
   • Port: Enter the port number.
   • Service name: Enter the service name.
   • Admin User: Enter the administrative user name used to sign onto the Oracle database server, for example, the system user name. This user name cannot be a DBA user.
   • Password: Enter the current user's password to sign onto the Oracle database server.

7. In the next CAPS Schema dialog, enter the User Name, Password, and Confirm Password to create a new database user for the CAPS database, and then click Next.

8. Click OK to confirm. A message indicates success.

The CAPS Schema dbsettings.xml is configured at one of the following directories (depending on your configuration):
   • [Drive Letter]:\MICROS\Simphony2\IISCAPSServiceHost
   • [Drive Letter]:\MICROS\Simphony\IISCAPSServiceHost

Configuring CAPS Access contains important information about enabling the privileges to access the CAPS Configuration Tool.
Configuring CAPS on Microsoft IIS

In the CAPS Configurator Tool, click **Configure CAPS**.

The CAPS Configurator Tool detects and configures the new Service Host. Upon successful configuration, the configured check box in the UI is automatically selected for the configured Service Host. A browser opens with the configured CAPS URL.

**CAPS is configured at** [Drive Letter]:\MICROS\Simphony2\EgatewayService\IISCAPSServiceHost.

**Configuring CAPS Access** contains important information about enabling the privileges to access the CAPS Configuration Tool.

Configuring CAPS on Microsoft IIS with SQL Server Database on Enterprise Server

This type of configuration is available only for customers using Simphony Premium Cloud Service, not with Simphony Standard Cloud Service.

- Configuring CAPS Access
- Configuring the Service Host for CAPS in EMC
- Configuring CAPS with a Microsoft SQL Server Database
- Configuring CAPS on Microsoft IIS

Configuring CAPS Access

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.
2. Select the role type, click the **Operations** tab, and then click the **Miscellaneous** subtab.
3. Select the following Miscellaneous options:
   - 10061 - Allow Access to the IIS CAPS Configurator Tool
   - 10065 - Download Software, Install and Authenticate Clients and Service Hosts Using CAL
4. Click **Save**.

**Note:**

Before you perform an upgrade to Simphony 18.1 from Simphony versions 2.9.x or 2.10, you need to ensure that the options described above are enabled before running the post-upgrade CAPS Configuration Tool. Specifically, if option 10065 is disabled prior to the upgrade, after the upgrade, an error message appears during your login to the CAPS Configuration Tool. If you click **OK** on the error message window, you can log onto the CAPS Configuration Tool, but you cannot utilize the **Authenticate CAPS** button (added to the CAPS Configuration Tool for the Simphony 18.1 release).
Configuring the Service Host for CAPS in EMC

Follow these steps to configure the Service Host for a hosted Enterprise with Simphony Premium Cloud Service users:

1. Select the Enterprise level, click Setup, and then click Service Hosts.
2. Insert a new Service Host record, and then double-click it to open in form view.
3. In the Host Name field, enter the host name of the Simphony application server where Microsoft IIS is running.
4. Enter the Subnet Mask and the Default Gateway of the Enterprise server.
5. Click Save.
6. Select the property, click Setup, and then click Property Parameters.
7. Click the Workstations tab.
8. From the Service Hosts section, select the CAPS Service Host created in Step 1, and then enter the Port number for CAPS configuration. For example, port number 8050.
   This port is the unused port number and is different from the EGateway service port.
9. Click Save.

Configuring CAPS with a Microsoft SQL Server Database

1. Navigate to the directory containing the CAPSConfigurator folder.
   Depending on your configuration method, the path is one of the following:
   • [Drive Letter]:\MICROS\Simphony2\Tools\CAPSConfigurator
   • [Drive Letter]:\MICROS\Simphony\CAPSOnIIS\Tools\CAPSConfigurator
2. Double-click CAPSConfigurator.exe, enter the server and port number of the Egateway, and sign in using your EMC credentials. A list of Service Hosts appears.
3. Click the Service Host to configure.
5. Enter the appropriate information in the CAPS Schema dialog, and then click Next.
   • Database: Select the SQL Server database type.
   • Server: Enter the server name.
   • Port: Enter the port number.
   • CAPS DB: Enter a name for the CAPS database.
   • Admin User: Enter the administrative user name used to connect to the database server.
   • Password: Enter the administrative password.
6. Enter the credentials to create a new database user for the CAPS database, and then click OK.
Configuring CAPS on Microsoft IIS

In the CAPS Configurator Tool, click **Configure CAPS**.

The CAPS Configurator Tool detects and configures the new Service Host. Upon successful configuration, the configured check box in the UI is automatically selected for the configured Service Host. A browser opens with the configured CAPS URL.

CAPS is configured at [Drive Letter]:\MICROS\Simphony2\EGatewayService\IISCAPSServiceHost.

**Configuring CAPS Access** contains important information about enabling the privileges to access the CAPS Configuration Tool.

Configuring CAPS on Microsoft IIS with SQL Server Database on Remote Service Host

The CAPS service must run on the same server where the Microsoft SQL Server database is installed.

- Configuring CAPS Access
- Configuring the Service Host for CAPS in EMC
- Preparing the Server to Configure CAPS
- Configuring CAPS with a Microsoft SQL Server Database
- Configuring CAPS on Microsoft IIS

**Configuring CAPS Access**

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.
2. Select the role type, click the **Operations** tab, and then click the **Miscellaneous** subtab.
3. Select the following Miscellaneous options:
   - **10061 - Allow Access to the IIS CAPS Configurator Tool**
   - **10065 - Download Software, Install and Authenticate Clients and Service Hosts Using CAL**
4. Click **Save**.
Configuring the Service Host for CAPS in EMC

1. To configure the Service Host for a hosted Enterprise with Simphony Standard Cloud Service users:
   a. Select the property level, click Setup, and then click Workstations.
   b. Insert a new workstation record, and then double-click it to open in form view.
   c. On the General tab, enter the host name of the remote server where CAPS will be configured in the Address/Host Name field.
   d. Enter the Subnet Mask and the Default Gateway of the remote server where CAPS will be configured.
   e. If you are configuring CAPS as a Windows Service, select Is Windows Service. Otherwise, skip this step.
   f. Click Save.
   g. Click the Remove OPS From Service Host link, and then click Yes to confirm.

2. To configure the Service Host for a hosted Enterprise with Simphony Premium Cloud Service users:
   a. Select the Enterprise level, click Setup, and then click Service Hosts.
   b. Insert a new Service Host record, and then double-click it to open in form view.
   c. In the Host Name field, enter the host name of the remote server where CAPS will be configured.
   d. Enter the Subnet Mask and the Default Gateway of the remote server.
   e. If you are configuring CAPS as a Windows Service, select Is Windows Service. Otherwise, skip this step.
   f. Click Save.

3. Select the property, click Setup, and then click Property Parameters.

4. Click the Workstations tab.

5. From the Service Hosts section, select the CAPS Service Host created in Step 1 or 2, and then enter the Port number for CAPS configuration.

This Port is the unused port number and is different from the Egateway service port.
6. Click Save.

Preparing the Server to Configure CAPS

1. Ensure that the Server has the latest Microsoft Windows patches.
2. Turn on the Microsoft Windows features:
   • Microsoft .NET Framework 3.5
   • Microsoft IIS
4. Install the database: either Oracle Database 12c Server or Microsoft SQL Server.
   If using the Oracle Database 12c Server:
   • Deselect the pluggable database option.
   • Select the database admin user system account or equivalent.
5. In the EMC, configure the CAPSOnIIS CAL package for deployment to the Remote Service Host.
6. Install the CAL client on the Remote Service Host.
7. In the EMC, deploy the CAPSOnIIS CAL Package to the configured Service Host.
   After completion, this package is available in the [Drive Letter]:\Micros\Simphony \CAPSonIIS folder.
8. If you are using Oracle Database 12c Release 2 for the CAPS database, complete the following steps:
   a. Navigate to [Drive Letter]:\MICROS\Simphony\CAPSonIIS\Tools \ODP.NET_12CR2, and then follow the instructions in the Readme.
   b. Run the ODP.NET_12CR2.bat under the current directory with administrator privileges from a command prompt.
      During batch file execution, the status appears in the Command Prompt window.
   c. After successful execution of the batch file, close the Command Prompt window.

Configuring CAPS with a Microsoft SQL Server Database

1. Navigate to the directory containing the CAPSConfigurator folder.
   Depending on your configuration method, the path is one of the following:
   • [Drive Letter]:\MICROS\Simphony2\Tools\CAPSConfigurator
   • [Drive Letter]:\MICROS\Simphony\CAPSonIIS\Tools\CAPSConfigurator
2. Double-click CAPSConfigurator.exe, enter the server and port number of the Egateway, and sign in using your EMC credentials. A list of Service Hosts appears.
3. Click the Service Host to configure.
5. Enter the appropriate information in the CAPS Schema dialog, and then click **Next**.
   - **Database**: Select the SQL Server database type.
   - **Server**: Enter the server name.
   - **Port**: Enter the port number.
   - **CAPS DB**: Enter a name for the CAPS database.
   - **Admin User**: Enter the administrative user name used to connect to the database server.
   - **Password**: Enter the administrative password.

6. Enter the credentials to create a new database user for the CAPS database, and then click **OK**.
   - **User Name**
   - **Password**
   - **Confirm Password**

   A message indicates success.

   The CAPS Schema dbsettings.xml is configured at one of the following directories (depending on your configuration):
   - [Drive Letter]\MICROS\Simphony2\IISCAPSServiceHost
   - [Drive Letter]\MICROS\Simphony\IISCAPSServiceHost

### Configuring CAPS on Microsoft IIS

In the CAPS Configurator Tool, click **Configure CAPS**.

The CAPS Configurator Tool detects and configures the new Service Host. Upon successful configuration, the configured check box in the UI is automatically selected for the configured Service Host. A browser opens with the configured CAPS URL.

CAPS is configured at [Drive Letter]\MICROS\Simphony2\EgatewayService\IISCAPSServiceHost.

**Configuring CAPS Access** contains important information about enabling the privileges to access the CAPS Configuration Tool.

### Upgrading Microsoft IIS CAPS

- Upgrading Microsoft IIS CAPS on Enterprise Server
- Upgrading Microsoft IIS CAPS on Remote Service Host

### Upgrading Microsoft IIS CAPS on Enterprise Server

1. Upgrade Simphony on the Enterprise server.

2. Browse to [Drive Letter]\Micros\Simphony\Tools \CAPSConfigurator.
3. Double-click **CAPSConfigurator**, enter the server and port number of the EGateway, and sign in using your EMC credentials. A list of Service Hosts appears.

4. Select the Service Host configured on this server that needs to be upgraded.

5. Click **Upgrade CAPS**.

   The CAPS Configurator Tool detects and configures the Service Host. Upon successful configuration, the configured check box in the UI is automatically selected for the configured Service Host. A browser opens with the configured CAPS URL.

   Configuring CAPS Access contains important information about enabling the privileges to access the CAPS Configuration Tool.

---

### Upgrading Microsoft IIS CAPS on Remote Service Host

1. Upgrade Simphony on the Enterprise server.

2. In the EMC, deploy the CAPSOnIIS CAL package to the configured Service Host.

3. **Browse** to `[Drive letter]`:\`Micros\Simphony2\CAPSOnIIS\Tools\CAPSConfigurator` on the remote server.

4. Double-click **CAPSConfigurator**, enter the server and port number of the EGateway, and sign in using your EMC credentials. A list of Service Hosts appears.

5. Select the Service Host configured on this server that needs to be upgraded.

6. Click **Upgrade CAPS**.

   The CAPS Configurator Tool detects and configures the Service Host. Upon successful configuration, the configured check box in the UI is automatically selected for the configured Service Host. A browser opens with the configured CAPS URL.

   Configuring CAPS Access contains important information about enabling the privileges to access the CAPS Configuration Tool.

---

### Configuring CAPS as a Windows Service with an Oracle Database

CAPS must run on the same server where the Oracle database is installed. You can set up CAPS as a Windows service only on remote servers—not on the Enterprise server—for both Simphony Premium Cloud Service and Simphony Standard Cloud Service users.

- Configuring CAPS Access
- Configuring the Service Host for CAPS in EMC
- Preparing the Server to Configure CAPS
- Configuring CAPS with an Oracle Database
- Copying the Database Settings
- Starting the CAPS Service
Configuring CAPS Access

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Select the role type, click the Operations tab, and then click the Miscellaneous subtab.
3. Select the following Miscellaneous options:
   - 10061 - Allow Access to the IIS CAPS Configurator Tool
   - 10065 - Download Software, Install and Authenticate Clients and Service Hosts Using CAL
4. Click Save.

**Note:**

Before you perform an upgrade to Simphony 18.1 from Simphony versions 2.9.x or 2.10, you need to ensure that the options described above are enabled before running the post-upgrade CAPS Configuration Tool. Specifically, if option 10065 is disabled prior to the upgrade, after the upgrade, an error message appears during your login to the CAPS Configuration Tool. If you click OK on the error message window, you can log onto the CAPS Configuration Tool, but you cannot utilize the **Authenticate CAPS** button (added to the CAPS Configuration Tool for the Simphony 18.1 release).

Configuring the Service Host for CAPS in EMC

1. To configure the Service Host for a hosted Enterprise with Simphony Standard Cloud Service users:
   a. Select the property level, click Setup, and then click Workstations.
   b. Insert a new workstation record, and then double-click it to open in form view.
   c. On the General tab, enter the host name of the remote server where CAPS will be configured in the Address/Host Name field.
   d. Enter the Subnet Mask and the Default Gateway of the remote server where CAPS will be configured.
   e. If you are configuring CAPS as a Windows Service, select Is Windows Service. Otherwise, skip this step.
   f. Click Save.
   g. Click the Remove OPS From Service Host link, and then click Yes to confirm.

2. To configure the Service Host for a hosted Enterprise with Simphony Premium Cloud Service users:
   a. Select the Enterprise level, click Setup, and then click Service Hosts.
   b. Insert a new Service Host record, and then double-click it to open in form view.
   c. In the Host Name field, enter the host name of the remote server where CAPS will be configured.
d. Enter the **Subnet Mask** and the **Default Gateway** of the remote server.

e. If you are configuring CAPS as a Windows Service, select **Is Windows Service**. Otherwise, skip this step.

f. Click **Save**.

3. Select the property, click **Setup**, and then click **Property Parameters**.

4. Click the **Workstations** tab.

5. From the Service Hosts section, select the CAPS Service Host created in Step 1 or 2, and then enter the **Port** number for CAPS configuration.

   This Port is the unused port number and is different from the Egateway service port.

6. Click **Save**.

### Preparing the Server to Configure CAPS

1. Ensure that the Server has the latest Microsoft Windows updates.

2. Turn on the Microsoft Windows features:
   - Microsoft .NET Framework 3.5
   - Microsoft IIS


4. Install the Oracle 12c 32-bit client.

5. Install the Oracle Database 12c Server.
   a. Deselect the pluggable database option.
   b. Select the database admin user system account or equivalent.

6. From the EMC, configure the CAPSOnIIS CAL package for deployment to the Remote Service Host.

7. Set up the Service Host prerequisites for deployment to the Remote Service Host.

8. Set up the Service Host for deployment to the Remote Service Host.


10. From the EMC, deploy the CAPSOnIIS CAL Package to the configured Service Host.

11. If you are using Oracle Database 12c Release 2 for the CAPS database, complete the following steps:
   a. Navigate to [Drive Letter]:\Micros\Simphony\CAPSOnIIS\Tools\ODP.NET_12CR2, and then follow the instructions in the Readme.
   b. Run the ODP.NET_12CR2.bat under the current directory with administrator privileges from a command prompt.
      During batch file execution, the status appears in the Command Prompt window.
   c. After successful execution of the batch file, close the Command Prompt window.

12. Deploy the Service Host prerequisites CAL Package.
13. Deploy the Service Host CAL Package.

14. Stop the CAPS Service.

Configuring CAPS with an Oracle Database

1. Run the ODP.NET_12CR2.bat under the current directory with administrator privileges from a command prompt.

2. Navigate to the directory containing the CAPSConfigurator folder. Depending on your configuration method, the path is one of the following:
   - [Drive Letter]\MICROS\Simphony2\Tools\CAPSConfigurator
   - [Drive Letter]\MICROS\Simphony\CAPSonIIS\Tools \CAPSConfigurator

3. Double-click CAPSConfigurator, enter the server and port number of the EGateway, and sign in using your EMC credentials. A list of Service Hosts appears.

4. Click the Service Host to configure.

5. Click CAPS Schema.

6. Enter the appropriate information in the CAPS Schema dialog, and then click Next.
   - **Database**: Select the Oracle database type.
   - **Server**: Enter the server name.
   - **Port**: Enter the port number.
   - **Service name**: Enter the service name.
   - **Admin User**: Enter the administrative user name used to sign onto the Oracle database server, for example, the system user name. This user name cannot be a DBA user.
   - **Password**: Enter the current user’s password to sign onto the Oracle database server.

7. In the next CAPS Schema dialog, enter the **User Name**, **Password**, and **Confirm Password** to create a new database user for the CAPS database, and then click Next.

8. Click OK to confirm. A message indicates success.

   The CAPS Schema dbsettings.xml is configured at one of the following directories (depending on your configuration):
   - [Drive Letter]\MICROS\Simphony2\IISCAPSServiceHost
   - [Drive Letter]\MICROS\Simphony\IISCAPSServiceHost

   **Configuring CAPS Access** contains important information about enabling the privileges to access the CAPS Configuration Tool.

Copying the Database Settings

Copy and replace the dbsettings.xml file from the CAPS_DIRECTORY_PATH (for example, copy from [Drive Letter]\MICROS\Simphony)
Starting the CAPS Service

After the CAL process is complete, CAPS starts automatically. It may take several seconds to create all tables and to synchronize data the first time on the Microsoft SQL Server CAPS database.

Configuring CAPS as a Windows Service with a Microsoft SQL Database

CAPS must run on the same server where the Microsoft SQL Server database is installed.

- Configuring the Service Host for CAPS in EMC
- Preparing the Server to Configure CAPS
- Starting the CAPS Service

Configuring the Service Host for CAPS in EMC

1. To configure the Service Host for a hosted Enterprise with Simphony Standard Cloud Service users:
   a. Select the property level, click Setup, and then click Workstations.
   b. Insert a new workstation record, and then double-click it to open in form view.
   c. On the General tab, enter the host name of the remote server where CAPS will be configured in the Address/Host Name field.
   d. Enter the Subnet Mask and the Default Gateway of the remote server where CAPS will be configured.
   e. If you are configuring CAPS as a Windows Service, select Is Windows Service. Otherwise, skip this step.
   f. Click Save.
   g. Click the Remove OPS From Service Host link, and then click Yes to confirm.

2. To configure the Service Host for a hosted Enterprise with Simphony Premium Cloud Service users:
   a. Select the Enterprise level, click Setup, and then click Service Hosts.
   b. Insert a new Service Host record, and then double-click it to open in form view.
   c. In the Host Name field, enter the host name of the remote server where CAPS will be configured.
   d. Enter the Subnet Mask and the Default Gateway of the remote server.
   e. If you are configuring CAPS as a Windows Service, select Is Windows Service. Otherwise, skip this step.
   f. Click Save.
3. Select the property, click Setup, and then click Property Parameters.

4. Click the Workstations tab.

5. From the Service Hosts section, select the CAPS Service Host created in Step 1 or 2, and then enter the Port number for CAPS configuration.

   This Port is the unused port number and is different from the Egateway service port.

6. Click Save.

Preparing the Server to Configure CAPS

1. Ensure that the Server has the latest Microsoft Windows patches.

2. Turn on the Microsoft Windows features:
   - Microsoft .NET Framework 3.5
   - Microsoft IIS


4. Install Microsoft SQL Server with the instance name SQLExpress. Use the Simphony default sa user password during installation.

   The Oracle Hospitality Simphony Security Guide contains information on using secure passwords and changing default passwords.

5. In the EMC, set up the Service Host prerequisites for deployment to the Remote Service Host.

6. In the EMC, set up the Service Host for deployment to the Remote Service Host.

7. Install the CAL client on the Remote Service Host.

8. Use CAL to configure the Service Host prerequisites and the CAPS Service Host.

Starting the CAPS Service

After the CAL process is complete, CAPS starts automatically. It may take several seconds to create all tables and to synchronize data the first time on the Microsoft SQL Server CAPS database.

Optional CAPS Configuration Tasks

- Configuring the Show Database Provider Button
- Encrypting Database Credentials
- Verifying CAPS Installation
- Configuring IIS Application Pool Settings
- CAL Installation Prerequisites for a Workstation without the POS Interface (CAPS Only Workstation)
CAL Installation Prerequisites for a Workstation without the POS Interface (CAPS Only Workstation)

Before installing CAL on a CAPS-only workstation, perform the following functions:

- Configure a service host for CAPS. See Configuring the Service Host for CAPS in EMC for instructions.
- Assign the employee privilege to download software, install and authenticate clients and Service Hosts using CAL.

Beginning with Simphony version 2.9.1 (which includes CAL version 139), users must have the employee privilege assigned to the appropriate role to successfully authenticate workstations, Android devices, and Kitchen Display Systems (KDS). After installing or upgrading to Simphony version 2.9.1 or later, you must assign the privilege to a user’s role. When the Role option is set, employees can use their EMC logon credentials when CAL’ing devices. See Allowing Employees to Install and Authenticate POS Clients and Service Hosts for instructions to assign the privilege.

- Set the CAL deployment schedule. See Configuring the Deployment Schedule to Install CAL on a POS Client Workstation without Ops for instructions.

Configuring the Deployment Schedule to Install CAL on a Workstation without the POS Interface

1. Select the Enterprise, click **Setup**, and then click **CAL Packages**.
2. For Simphony version 2.9 and Simphony version 2.9.1:
   a. If the CAPS workstation is running Microsoft Windows Embedded POSReady 2009, select **Service Host Prereqs** from the left pane.
   b. If the CAPS workstation is running Microsoft Windows 7 or later, select **Service Host Prereqs (SQL 2012)** from the left pane.
3. For Simphony version 2.9.2, select **Service Host Prereqs** from the left pane for all POS clients.
4. Click the **Deployment Schedule** tab, and then click **Add Deployment**.
5. From the Deployment Type column, select **2 - Specific Service Host**.
6. In the Service Host column, click the ellipsis (...) point button, select the CAPS workstation, and then click **OK**.
7. In the Action To Take column, select **0 - Install**, and then click **Save**.
8. Select **Service Host** from the left pane, and then repeat Steps 4 through 7.

Installing CAL on a Workstation without the POS Interface

1. On the workstation, press **Start**, select **All Programs**, select **Micros Client Application Loader**, and then select **McrsCAL Config**.
2. Decipher and enter the correct access code, and then press the **Configure CAL** button.

3. Enter the correct code based on the six-digit number shown at the top, and then press **Next**.

4. In the Enter CAL Server dialog, select **MICROS Simphony** as the **POS Type**. **MICROS Simphony** is used for both Simphony Standard and Premium Cloud Service environments.

5. Set the following values, and then press **Next**:
   - **Server Name**: Leave this field blank.
   - **Server IP/URL**: Leave this field blank.
   - **CAL Enabled**: Select this option if it is not automatically set by default.
   - **Secure Connection**: Select this option to use the Translation Layer Security (TLS) 1.2 Encryption protocol. (If you are installing CAL version 139 or later, this option is set by default.)
   - **Server**: Enter the CAPS server name.
   - **Port**: Enter 443.
   - **Update**: Click the **Update** button to automatically fill the **Server Name** and **Server IP/URL** fields after the application server name is resolved and recognized. You are now required to use an HTTPS secure connection in your **Server URL**.

6. If you are using Simphony version 2.9 (CAL version 138), skip to Step 8.

7. Beginning with Simphony version 2.9.1 and later, if you are installed on a Simphony Standard or Premium Cloud Service environment, CAL prompts you to enter your Simphony EMC logon credentials. Enter your **User name** and **Password** in the CAL Authentication dialog, and then press the **Login** button.

8. If the Enterprise has multiple properties, select the property from the Property Search and Select dialog, and then press **Next**.

   If the property does not appear in the list, enter the property name in the **Property Name** field, and then press **Search**.

   You do not see a property list if only one property is configured or if there are multiple properties, but only one property is using workstations.

9. In the Select WS Identity dialog, select the **Show Service Hosts** option, select the appropriate service host from the available workstation list, and then press **Save**. Make sure the Service Host ID and Workstation ID populate. The workstation automatically restarts several times when installing the CAL package.
10. If you are using Simphony version 2.9 or Simphony version 2.9.2, after the CAL process completes:

a. Browse to [Drive letter]:\MICROS\Simphony\webserver, and then click AuthenticationServer.

b. For Simphony version 2.9, enter the following details in the Authentication Server application:

- **Client Service ID**: Enter the Service ID for Check and Posting. You can find the Service ID in the Workstations tab of the Property Parameters module.
- **Installer Username**: Enter the Install User Security Username configured in the Security tab of the Property Parameters module. Contact your system administrator for assistance.
- **Installer Password**: Enter the Install User Security Password configured in the Security tab of the Property Parameters module. Contact your system administrator for assistance.
c. For Simphony version 2.9.2 and later, enter the following details in the Authentication Server application:

- **Service Host ID**: The service host ID. This value is automatically populated.
- **EMC Username**: Enter your EMC user name.
- **EMC Password**: Enter your EMC password.
d. Click Authenticate.
e. Restart the workstation.

Configuring the Show Database Provider Button

The following steps are optional:

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Double-click the page on which you want the Show Database Provider button to appear (typically the Sign In page).
3. Insert a new button.
4. On the General tab, select Function from the Type drop-down list, and then click the right arrow beneath the Type field.
5. On the left pane, in the Name field, enter Show Database Provider.
6. On the right pane, select Show Database Provider as the result, and then click OK.
7. Click Generate Legend to set Show Database Provider as the button name.
8. Click Save.

Encrypting Database Credentials

The following steps are optional:

1. Browse to [Drive Letter]:\MICROS\Simphony2\Tools\Crypt folder.
2. Run Crypt.exe.
3. Enter or copy the complete [CAPS HOSTED DIRECTORY]\DbSettings.xml path (for example, \[Drive Letter]\:\MICROS\Simphony \IISCAPSServiceHost).
4. Click Read DB Settings.
5. Select CPSERVICEDB from the drop-down list.
6. Enter the password, and then click Encrypt Password.

Verifying CAPS Installation

The following steps are optional:

1. If CAPS is configured on a Microsoft SQL Server database, expand the CAPS database tree and verify the tables listed.
2. If CAPS is configured on an Oracle database, log in as the CAPS user to verify the tables.
3. Verify the log files on the CAPS EGateway log and the workstation EGateway log folders.
4. Configure a new POS client workstation that points to CAPS from the Property Parameters module (Workstations tab).
   See Adding a Workstation for more information.
5. Click the Show Database Provider button, and then verify that one of the following appears, depending on the CAPS database installation type:
   • CAPS DB: as Oracle
   • CAPS DB: as SQL Server
6. Verify that the CAPS status is online.
7. Add a few test transactions from the workstation.
8. Verify that the transaction details post to the CHECKS table on the workstation datastore database, the CAPS database, and the Simphony transaction database.

Configuring IIS Application Pool Settings

• Configuring Recycle Settings for the IIS Application Pool
• Restarting Microsoft IIS CAPS

Configuring Recycle Settings for the IIS Application Pool

For instructions on configuring an application pool to recycle at a scheduled time, refer to the Microsoft TechNet Library at https://technet.microsoft.com/en-us/. Ensure that the times you set do not coincide with the Start of Day (SOD) or periods of peak sales activity. If you configure the application pool to recycle at a scheduled time using the IIS Manager, consider the following recycle settings for the IIS Application Pools.

• Set the Memory Based Maximums to less than half of the available server memory.
• Set the .NET Integration mode to Classic for the CAPS Application Pool.
• Set the **Disable Overlapped Recycle** setting to **True** for the CAPS Application Pool.
• Leave the Application Pool’s Pipeline mode settings on the default settings.

**Restarting Microsoft IIS CAPS**

The following steps are optional:

1. From Microsoft IIS Manager, recycle the CAPS application pool.
2. Click the configured IIS CAPS application under the website, and switch to Content View.
3. Right-click **EGateway.asmx** and select **Browse**. The new CAPS Egateway.asmx URL opens in the default internet browser.
Printers

Printers and order devices are critical types of hardware that allow communication between the Front of House and other areas of a restaurant, such as the kitchen and bar.

- Print Controller
- Roll Printer
- Slip Printer
- Internet Protocol (IP) Printer
- Bluetooth Printer
- Printer Groups
- Configuring a Printer
- Creating, Editing, and Removing Printer Groups
- Configuring the Change Default Printer Destination Button
- Configuring a Printer Order Device
- Secondary Printing
- Configuring Secondary Printing
- Printer DIP and Memory Switch Settings

Print Controller

A Print Controller is a service that sends print jobs to a printer. Each POS client process has a built-in Print Controller. A workstation typically acts as a Print Controller. When a workstation operator performs an action that causes a guest check, order receipt, or other printing type to print, the POS client process does not communicate directly with the printer receiving the print job. Instead, the POS client process sends a message to the Print Controller (usually a workstation) that controls the printer. This Print Controller then receives notification that the print job succeeded or failed, and routes the success or failure information back to the workstation that sent the print job.

Ensure that employees in a revenue center know which workstations act as Print Controllers for remote printers. This knowledge helps in troubleshooting printing problems.

Oracle Hospitality recommends that you have both a primary printer and a backup printer, and that primary and backup printers reside on two different Print Controllers. This configuration prevents a single point of failure from causing multiple remote printers to stop printing.

A single Print Controller can control multiple printers. For example, one workstation can control the following printers:

- Local printer that is physically attached to the workstation (used for guest checks and customer receipts)
• Hot food printer that is a remote Ethernet kitchen printer (used for order receipts)

In this configuration, if the workstation loses power or network connectivity, other workstations cannot print to either of these printers. This is generally not a problem because the print jobs print to the backup printer as appropriate.

In another example, one workstation can control the following printers:
• Local printer that is physically attached to the workstation
• Hot food printer that is a remote Ethernet kitchen printer
• Cold food printer that is a remote Ethernet kitchen printer and backs up the hot food printer

Oracle Hospitality does not recommend this configuration. In this example, if the workstation loses power or network connectivity, other workstations cannot print to any of these printers. In this scenario, no order receipts print to the hot or cold printers in the kitchen. Kitchen operations would likely be severely impacted.

• Roll Printer
• Slip Printer
• Internet Protocol (IP) Printer
• Bluetooth Printer

Related Topics
• Configuring a Printer

Roll Printer

A roll printer uses a roll of paper as its source media. Thermal printers and impact printers are two types of roll printers that you can use with Simphony.

Thermal Printer

A thermal printer does not use ink. Special thermal paper is provided for these printers to burn the text onto the paper. Thermal printers are primarily used as guest check and customer receipt printers. They are used infrequently in kitchens due to the heat reaction. Thermal printers are ideal in public areas as the printing operation is quiet.

Impact Printer

An impact printer is something of a retronym. All printers were impact printers prior to the invention of the thermal printer. An impact printer is primarily used in kitchens to print order receipts. Impact printers can print in black and red, and they can be used with two-ply paper.

• Print Controller
• Slip Printer
• Internet Protocol (IP) Printer
• Bluetooth Printer

Related Topics
• Configuring a Printer
Slip Printer

A slip printer does not contain paper. The workstation operator must add a piece (or slip) of paper per print job. Properties who use custom stationery (often containing a company logo or other similar artwork) generally use slip printers for guest checks and customer receipts. Slip printers are also used for check endorsement printing. The slips that are used by these printers are often called hard checks because they are usually made of card stock.

- Print Controller
- Roll Printer
- Internet Protocol (IP) Printer
- Bluetooth Printer

Related Topics
- Configuring a Printer

Internet Protocol (IP) Printer

An IP printer communicates with the Print Controller through a computer network that uses the IP address for communication.

- Print Controller
- Roll Printer
- Slip Printer
- Bluetooth Printer

Related Topics
- Configuring a Printer

Bluetooth Printer

Bluetooth printing refers to printing from an Oracle MICROS Tablet E-Series to a wireless printer through the Bluetooth protocol.

There is a one-to-one relationship between a tablet and a Bluetooth printer. After you identify and configure a Bluetooth printer and manually pair it with a specific Oracle MICROS Tablet E-Series as the Print Controller Service Host, you cannot assign another Oracle MICROS Tablet E-Series to the same Bluetooth printer.

- Print Controller
- Roll Printer
- Slip Printer
- Internet Protocol (IP) Printer

Related Topics
- Configuring a Printer
Printer Groups

If the property is large and has many printers disbursed over a wide area, you may find it useful to configure a limited list of printers that are selectable by workstation operators. The workstation operator can select a printer that is nearby from the list at the POS client (usually a mobile tablet device), and optionally set this printer as the default printer for future print jobs. When a workstation operator selects a default destination printer, the selection automatically resets at Start of Day.

A default printer group named **All Destination Printers** exists in the Printer Groups module. You cannot change this default printer group. If you do not create printer groups, all printers with the option **Destination Printer** (set in the Printers module) belong to the **All Destination Printers** printer group. The **All Destination Printers** default printer group is useful for properties that need only one group of destination printers.

Related Topics

- Creating, Editing, and Removing Printer Groups

Configuring a Printer

1. Select the property, click **Setup**, and then click **Printers**.
2. Insert a printer record, name the printer, and then click **OK**.
3. Double-click the printer record to open it.
4. Select the **Workstation** from the drop-down list.
5. Select the **Printer Type** from the drop-down list.
   Select **Epson Bluetooth Printer** for all Bluetooth printers.
6. If the roll printer is a thermal printer, select **Thermal printer** in the **Printer Options** section.
7. Enter the number of lines to advance the guest check or customer receipt after printing the trailer text in the **Trailing Line Feeds** field.
   The value in this field defaults to the recommended trailing line feeds for the printer communication type, as listed in the following table. You can change the default value.

   **Table 38-1**  **Trailing Line Feeds per Printer Communication Type**

<table>
<thead>
<tr>
<th>Printer Communication Type</th>
<th>Trailing Number of Lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bluetooth</td>
<td>1</td>
</tr>
<tr>
<td>Ethernet</td>
<td>1</td>
</tr>
<tr>
<td>Integrated Device Network (IDN)</td>
<td>1</td>
</tr>
<tr>
<td>Serial</td>
<td>6</td>
</tr>
<tr>
<td>OPOS</td>
<td>6</td>
</tr>
</tbody>
</table>

8. (Optional) To set the printer to print logos, select **Enable Logo Printing**.
   Simphony does not support logo printing on printers with multi-language cards.
When configuring Epson TM-P60 and TM-T88 Ethernet Thermal printers, configure the logo to print in the center of the guest check or customer receipt by selecting the paper size of the printer from the **Center Logo Using** drop-down list.

- Epson TM-P60 Ethernet Thermal printers: Set the paper size to **2 1/4” (58mm) Paper**.
- Epson TM-T88 Ethernet Thermal printers: Set the paper size to **3 1/8” (80mm) Paper**.

**Logo Printing** contains more information about setting up logos to print on guest checks and customer receipts.

9. To allow the printer to be selectable by workstation operators (typically used with mobile POS client devices), select **Destination Printer**.

Bluetooth printers are not selectable.

10. Configure the appropriate values for the printer type. Specific fields become active based on the printer type you selected.

The following table lists the printer types and indicates information for each applicable field. Enter or select information for the fields based on the printer you are configuring. Fields denoted as Not applicable are not needed for the printer type.

**Table 38-2  Printer Configuration by Printer Type**

<table>
<thead>
<tr>
<th>Field</th>
<th>Roll Printer</th>
<th>Slip Printer</th>
<th>IP Printer</th>
<th>Bluetooth Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>COM Port</td>
<td>Select the communications port for the printer.</td>
<td>Select the communications port for the printer.</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>Select the baud rate for the printer.</td>
<td>Select the baud rate for the printer.</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Parity</td>
<td>Select the parity for the printer.</td>
<td>Select the parity for the printer.</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Data Bits</td>
<td>Select the data bits for the printer.</td>
<td>Select the data bits for the printer.</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>Select the stop bits for the printer.</td>
<td>Select the stop bits for the printer.</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>PIN</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Set the four-digit passkey that must be entered into the device before printing.</td>
</tr>
</tbody>
</table>
### Table 38-2  (Cont.) Printer Configuration by Printer Type

<table>
<thead>
<tr>
<th>Field</th>
<th>Roll Printer</th>
<th>Slip Printer</th>
<th>IP Printer</th>
<th>Bluetooth Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>(Optional) Enter the Bluetooth ID of the printer. You can leave this field blank to allow configuration from a mobile device when using different printers per event.</td>
</tr>
<tr>
<td>Number of Columns</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>This setting determines the report width so that guest checks and reports print with center alignment. By default, the width is set to 32 columns. Select 40 for Bixolon SPP-R300, SPP-R310, and R310iK Bluetooth printers.</td>
</tr>
<tr>
<td>Address</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Enter the IP address or hostname of the printer. If you are using the printer for banquet checks, enter the hostname.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Port</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Enter the port number for the IP printer.</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

11. Click **Save**.

12. Select the property, click **Setup**, and then click **Workstations**.

13. Double-click the workstation to open it.

14. Click the **Printers** tab.

15. Click the **Select** link to set the appropriate **Printer** for each type of print job. Click the **Set for All Destination Printers** link to set the same printer for each type of print job.

The printer defined here (primary or backup) always appears in the Destination Printers list on the POS client, even if you do not add it to the **Destination Printer**
16. Click the **Select** link and assign each printer type to a **Destination Printer Group**. Click the **Set for All Destination Printers** link to set the same printer type for all destination printer groups.

Selecting a **Destination Printer Group** overrides the printer selected for the printer type.

Printers with the option **Selectable as Destination Printer** set belong to a default **Destination Printer Group** called **All Destination Printers**.

If you define a **Destination Printer Group** for the Backup Printer, the workstation operator is prompted at the time of printing for both the primary printer (if it has a group defined) and the Backup Printer.

17. Click the **Options** tab.

18. To automatically disable the Destination Printers prompt (if configured) when a dockable workstation (tablet device) is attached to the stand and has access to an attached printer, leave the option **60 - Prompt for Destination Printer when docked** deselected. Select option **60** to have the POS client prompt to select a printer when a workstation is docked.

19. Click **Save**.

20. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Format Parameters**.

21. Click the **Configuration** tab, and then enter the appropriate information in the following fields:

### Table 38-3 Print Output Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines on First Page</td>
<td>Enter the maximum number of lines to print on the first page of the guest check before prompting for a new check to begin a new order receipt.</td>
</tr>
<tr>
<td>Lines on Other Pages</td>
<td>Enter the maximum number of lines to print on successive pages of the guest check before prompting for a new check to begin a new order receipt.</td>
</tr>
<tr>
<td>Line Feeds Before First Page</td>
<td>Enter the number of lines to advance before printing the guest check header. You can add extra space for the check so it appears properly in custom check presentation binders.</td>
</tr>
<tr>
<td>Line Feeds Before Other Pages</td>
<td>Enter the number of lines to advance before printing begins on the next successive page. The line feeds set here are included in the number configured for the Lines on Other Pages field. For example, if you set this field to 5 and set Lines on Other Pages to 30, the pages have 25 lines of text.</td>
</tr>
</tbody>
</table>
Table 38-3  (Cont.) Print Output Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Lines Per Roll Check/Receipt</td>
<td>Enter the minimum number of lines to print on guest checks and customer receipts. Blank lines are added after printing to achieve the minimum. Use this field if you want guest checks and customer receipts that are printed on a roll printer to have a minimum length in order to fit into guest check covers.</td>
</tr>
<tr>
<td>Number of Guest Check Information Lines</td>
<td>Enter the number of detail lines (0 through 30) that can be entered in a System Interface Module (SIM) dialog box.</td>
</tr>
</tbody>
</table>

22. Click the **Options** tab.

23. Select the appropriate printing options:
   - **57 - Do Not Print Change/Payment Due in Double Wide**: Select this option if you do not want double-wide formatting on the Change Due line of a receipt or the Total Due line of a check.
   - **58 - Do Not Consolidate Current Round Items in Printed Guest Check**: Select this option if you do not want to combine identical items which are ordered in multiples in the current round when printing a receipt.

24. Click **Save**.

**Related Topics**
- Print Controller
- Roll Printer
- Slip Printer
- Internet Protocol (IP) Printer
- Bluetooth Printer

### Creating, Editing, and Removing Printer Groups

1. Select the property, click **Setup**, and then click **Printer Groups**.
2. Insert a printer group record, name the printer group, and then click **OK**.
3. Double-click the printer group record to open it.
4. To add a printer to the printer group, click the **Add** link, click the ellipsis button, and then select the printer.
   - You can add any printer to any printer group, regardless of the **Destination Printer** option setting. You can add one printer to multiple printer groups.
5. Repeat Steps 1 through 4 for to create more printer groups and to add printers to the groups.
6. To delete a printer from a printer group, select the printer, and then click the **Delete** link.
7. Click **Save**.
8. To edit a printer group, highlight the record, change the values, and then click **Save**.

9. To remove a printer group, highlight the record, and then click **Delete** on the toolbar.

**Related Topics**
- **Printer Groups**

## Configuring the Change Default Printer Destination Button

You need to create a button which allows workstation operators to set and reset the default printer selection.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.
2. Open the Front of House page on which to place the Change Default Printer Destination button,
3. On the **Edit** tab, select the page area in which to define the button.
4. Click **Button**.
5. On the **General** subtab, enter the button name in the **Legend** field.
6. From the **Type** drop-down list, select **Function**.
7. Click the black arrow beneath the **Type** drop-down list, select **Change Default Printer Destination**, and then click **OK**.
8. Position and size the button on the page. Use the Style arrow to change the color.
9. Click **Save**.

## Configuring a Printer Order Device

You can configure order chits to send to a printer at the kitchen when checks are service totalled on a workstation.

1. Select the revenue center, click **Setup**, and then click **Order Devices**.
2. Insert an order device record for the printer (for example, Kitchen Hot Printer), and then double-click the record to open it.
3. On the **General** tab, select **1 - Remote** from the **Device Type** drop-down list, select **0 - Printer** from the **Primary Device Type** drop-down list, and then select the appropriate printer record from the **Device** drop-down list.
4. If you have a backup printer, select the **Backup Device** from the drop-down list.
5. From the **Order Device Redirect** drop-down list, select the printer order device that you created in Step 2.
6. From the **Menu Item Printing** drop-down list, select the items to route to this KDS:
   - **0 - All Items**: Select to route all menu items.
   - **1 - Only Items with Condiments**: Select to route only menu items with condiments.
   - **2 - Only Items without Condiments**: Select to route only menu items without condiments.
7. From the **Condiment Sort Type** drop-down list, select how to sort the condiments on the order chits. Condiment sorting only works if you have set Menu Item Classes option **30 - Sort Condiments by Print Group** for the parent menu items.

   - **No condiment sorting**: Select to list condiments in the order in which they are entered on the check by the workstation operator. Allowed condiments sort in the order assigned in Condiment Sets, if configured.

   - **Sort allowed condiments**: Select to sort only allowed condiments based on the print group. The sort order configured for allowed condiments in Condiment Sets is discarded. If required condiments are ordered in between allowed condiments, the required condiments remain in the same position in which order they were ordered.

   - **Sort all condiments**: Select to sort all condiments based on the print group, regardless of condiment type.

8. Configure the following Print Settings:

   **Table 38-4  Order Devices Printer Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max # Lines per Chit</td>
<td>Enter the maximum number of lines (0 to 99) to print on each page of an order chit. Oracle MICROS roll printers print 6 lines per inch.</td>
</tr>
<tr>
<td>Sort/Consolidation Method</td>
<td>Select the parent menu item sort and consolidation method for this order device.</td>
</tr>
<tr>
<td>Language</td>
<td>Select the primary language for the order device. This field only shows the languages that are assigned to the property in the Property Parameters module.</td>
</tr>
<tr>
<td>Language 2</td>
<td>To print the output in a second language, select the secondary language.</td>
</tr>
<tr>
<td>Language 3</td>
<td>To print the output in a third language, select the third language.</td>
</tr>
<tr>
<td>Line Feeds Before Order</td>
<td>Enter the number of lines to advance before printing the order on order chits.</td>
</tr>
<tr>
<td>Line Feeds After Order</td>
<td>Enter the number of lines to advance after printing the order on order chits.</td>
</tr>
</tbody>
</table>

9. Click the **Options** tab, and then select the appropriate printer options as described in the following table:

   **Table 38-5  Order Devices Printer Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - On = Print Trans Emp Name and #; Off = Print Chk Emp Name and #</td>
<td>Select this option to print the employee name and number of the transaction operator on the order chit. Deselect to print the employee name and number of the check operator.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>3 - Print Dopplebon</td>
<td>Select this option to print a separate order chit for each menu item in the current service round (dopplebon style). Deselect to print one order chit for all menu items in the current service round (the default printing style).</td>
</tr>
<tr>
<td>4 - Print Dopplebon Summary</td>
<td>Select this option to print an order summary chit before printing an order's dopplebon order chits. Deselect to suppress dopplebon summary chit printing</td>
</tr>
<tr>
<td>6 - Print Seat Numbers with Individual Items</td>
<td>Select this option to print seat numbers with each individual menu item. If the order device is set to consolidate (Sort/Consolidate Method on the General tab), the seats print as a Seat Header above the detail item.</td>
</tr>
<tr>
<td>7 - Print Revenue Center Name on Orders</td>
<td>Select this option to print the revenue center name with each order sent to this order device. The name prints in double-wide characters. Deselect to suppress printing the revenue center name.</td>
</tr>
<tr>
<td>9 - On = Print void marker before Void; Off = Print Void in Red</td>
<td>Select this option to print a \texttt{VV VOID VV} line, in red or inverse, in front of voided menu items. Deselect to print voided items in red, without the \texttt{VV Void VV} line.</td>
</tr>
<tr>
<td>10 - Print Condiments in Red (Overrides Print Class Settings)</td>
<td>Select this option to print condiments in red ink or in inverse. Deselect to print condiments in red/inverse or in black, depending on the Print Class Red/Black option setting.</td>
</tr>
<tr>
<td>11 - Print Both Menu Item Names</td>
<td>Select this option to print both names entered for a Menu Item Definition on the order chit. Deselect to print only one name. When this option is deselected, the name that prints is determined by the Menu Item Definition's Menu Item Class option \texttt{Print Name 2 on Order Output Instead of Name 1}.</td>
</tr>
<tr>
<td>13 - Print Guest Check Info Lines Before Header on Order Device</td>
<td>Select this option to print guest check information lines before the order device header.</td>
</tr>
<tr>
<td>14 - Print Guest Check Info Lines After Header on Order Device</td>
<td>Select this option to print guest check information lines after the order device header.</td>
</tr>
<tr>
<td>15 - Print Guest Check Info Lines After Trailer on Order Device</td>
<td>Select this option to print guest check information lines after the order device trailer.</td>
</tr>
<tr>
<td>16 - Print Secondary Items</td>
<td>See \texttt{Secondary Printing} for more information.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>21 - Exclude Voids</td>
<td>Select this option if you do not want voids of previous round items to be sent to the kitchen.</td>
</tr>
<tr>
<td>22 - Intersperse Different Languages</td>
<td>If you are printing in more than one language, select this option to print the menu item in each language before printing any condiments. For example, the output will be menu item name in language 1, menu item name in language 2, 1st condiment in language 1, 1st condiment in language 2.</td>
</tr>
<tr>
<td>23 - Identify Combo Meals</td>
<td>Select this option to print a flag to denote menu items that are part of a combo meal. If printing Asian characters, the information is printed on the preceding line due to space limitations.</td>
</tr>
<tr>
<td>24 - Print Dining Course Header</td>
<td>Select this option to print a dining course header and to group the menu items by dining course.</td>
</tr>
<tr>
<td>25 - Format Prefix On Separate Line</td>
<td>Select this option to print the prefix on a separate line above the condiment. Deselect to print the prefix on the same line as the condiment that it modifies.</td>
</tr>
<tr>
<td>26 - Print Single Wide</td>
<td>Select this option to print orders in single-width characters. This supports longer menu item names, but has the drawback of not being as readable from a distance.</td>
</tr>
</tbody>
</table>

10. Click **Save**.
11. Select the property, click **Setup**, and then click **Workstations**.
12. Double-click the workstation record for which to assign the printer order device, and then click the **Order Devices** tab.
13. Select the printer order device from the Order Device Output list, and then click **Save**.

**Secondary Printing**

Secondary printing enables you to print menu items to additional printers as secondary items. A secondary item is one that is part of the same order, but prepared at another Prep Station. This allows the prep cook to know what other items accompany the dish. For example, a house salad is a primary item on the Cold Line, but a secondary item on the Hot Line. When secondary printing is enabled, the cook reading the chit from the Hot Printer sees the items necessary for preparation at the Hot Line and also any items being prepared by other cooks that were added to the check at the same time. This feature allows the kitchen to synchronize orders for delivery. For example, pizza dip and chicken wings are programmed to print to the Hot Printer, and house salad and mesclun mix are programmed to print to the Cold Printer. If the cook who prepares the salads does not know that the chicken wings and pizza dip go with the salad order,
the cook might prepare the salads immediately. This can cause the salads to get warm or wilt and possibly having to be remade.

Secondary items print in a smaller font at the bottom of the order chit.

**Figure 38-1  Example Order Chit with Secondary Items**

![Example Order Chit with Secondary Items](image)

**Related Topics**
- Configuring Secondary Printing

## Configuring Secondary Printing

1. Select the revenue center, click **Setup**, and then click **Order Devices**.
2. Double-click a printer order device record, and then click the **Options** tab.
3. Select the appropriate options that apply to secondary printing, and then click **Save**:
   - **16 - Print Secondary Items**: Select this option to allow this order device to print items sent from other printers as secondary items.
   - **17 - Broadcast Secondary Print Jobs to All Printers**: Select this option to send all items programmed to print at this order device to other printers to print as secondary items. Items print only at other printers that have **16 - Print Secondary Items** enabled.
   - **18 - Print Secondary Printer Header**: Select this option to print the name of the printer from which the secondary items are being broadcasted.
• **19 - Print Secondary Items in Red**: Select this option to print secondary items in red.

• **20 - Suppress Blank Lines Between Secondary Items**: Select this option to remove extra line spacing between secondary items on order chits.

**Related Topics**

• Secondary Printing

**Printer DIP and Memory Switch Settings**

The following links explain the setup and configuration of DIP and memory switch settings:

• Epson Printer Setup for IDN Module

• Printer DIP Switch/Memory Switch Setting when using UB-IDN (IDN02) Interface

• Printer DIP Switch/Memory Switch Setting when using UB-IDML (IDNML02) Interface

• Printer DIP Switch/Memory Switch Setting when using UB-E02 (E03) Interface

• Printer DIP Switch/Memory Switch Setting when using UB-EML Interface

• Printer DIP Switch/Memory Switch Setting when using UB-EML02 Interface

• DIP Switch Definitions

**Epson Printer Setup for IDN Module**

Setup the module DIP switches as follows:

**Table 38-6  Printer ID**

<table>
<thead>
<tr>
<th>DEVICE #</th>
<th>DS1</th>
<th>DS2</th>
<th>DS3</th>
<th>DS4</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>ON*</td>
</tr>
<tr>
<td>02</td>
<td>-</td>
<td>-</td>
<td>ON</td>
<td>-</td>
</tr>
<tr>
<td>03</td>
<td>-</td>
<td>-</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>04</td>
<td>-</td>
<td>ON</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>05</td>
<td>-</td>
<td>ON</td>
<td>-</td>
<td>ON</td>
</tr>
<tr>
<td>06</td>
<td>-</td>
<td>ON</td>
<td>ON</td>
<td>-</td>
</tr>
<tr>
<td>07</td>
<td>-</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>08</td>
<td>ON</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>09</td>
<td>ON</td>
<td>-</td>
<td>-</td>
<td>ON</td>
</tr>
<tr>
<td>10</td>
<td>ON</td>
<td>-</td>
<td>ON</td>
<td>-</td>
</tr>
<tr>
<td>11</td>
<td>ON</td>
<td>-</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>12</td>
<td>ON</td>
<td>ON</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>13</td>
<td>ON</td>
<td>ON</td>
<td>-</td>
<td>ON</td>
</tr>
<tr>
<td>14</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>-</td>
</tr>
<tr>
<td>15</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
</tbody>
</table>
### Table 38-7  Baud Rate

<table>
<thead>
<tr>
<th>BAUD RATE</th>
<th>DS5</th>
<th>DS6</th>
</tr>
</thead>
<tbody>
<tr>
<td>9600</td>
<td>-*</td>
<td>-*</td>
</tr>
<tr>
<td>19200</td>
<td>ON</td>
<td>-</td>
</tr>
<tr>
<td>38400</td>
<td>-</td>
<td>ON</td>
</tr>
</tbody>
</table>

*Factory Default

### Figure 38-2  Back of Printer and Module Faceplate

Set the annunciator to OFF by doing the following:

1. Make sure the printer is off.
2. Set the switches to the necessary parameters.
3. Turn the printer on. The Status sheet should subsequently print.

4. Turn the printer off. Set IDN switches back to their default setting.

**Printer DIP Switch/Memory Switch Setting when using UB-IDN (IDN02) Interface**

<table>
<thead>
<tr>
<th>Table 38-8</th>
<th>TM-U200, TM-U220, TM-U2300</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIP SW 1</td>
<td>DIP SW 2</td>
</tr>
<tr>
<td>1–1</td>
<td>x</td>
</tr>
<tr>
<td>1–2</td>
<td>x</td>
</tr>
<tr>
<td>1–3</td>
<td>OFF</td>
</tr>
<tr>
<td>1–4</td>
<td>OFF</td>
</tr>
<tr>
<td>1–5</td>
<td>OFF</td>
</tr>
<tr>
<td>1–6</td>
<td>OFF</td>
</tr>
<tr>
<td>1–7</td>
<td>OFF</td>
</tr>
<tr>
<td>1–8</td>
<td>OFF</td>
</tr>
<tr>
<td>2–1</td>
<td>x</td>
</tr>
<tr>
<td>2–2</td>
<td>x</td>
</tr>
<tr>
<td>2–3</td>
<td>OFF</td>
</tr>
<tr>
<td>2–4</td>
<td>OFF</td>
</tr>
<tr>
<td>2–5</td>
<td>OFF</td>
</tr>
<tr>
<td>2–6</td>
<td>OFF</td>
</tr>
<tr>
<td>2–7</td>
<td>OFF</td>
</tr>
<tr>
<td>2–8</td>
<td>OFF</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 38-9</th>
<th>TM-T88 Series</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIP SW 1</td>
<td>DIP SW 2</td>
</tr>
<tr>
<td>1–1</td>
<td>x</td>
</tr>
<tr>
<td>1–2</td>
<td>x</td>
</tr>
<tr>
<td>1–3</td>
<td>OFF</td>
</tr>
<tr>
<td>1–4</td>
<td>OFF</td>
</tr>
<tr>
<td>1–5</td>
<td>OFF</td>
</tr>
<tr>
<td>1–6</td>
<td>OFF</td>
</tr>
<tr>
<td>1–7</td>
<td>OFF</td>
</tr>
<tr>
<td>1–8</td>
<td>OFF</td>
</tr>
<tr>
<td>2–1</td>
<td>x</td>
</tr>
<tr>
<td>2–2</td>
<td>x</td>
</tr>
<tr>
<td>2–3</td>
<td>OFF</td>
</tr>
<tr>
<td>2–4</td>
<td>OFF</td>
</tr>
<tr>
<td>2–5</td>
<td>OFF</td>
</tr>
<tr>
<td>2–6</td>
<td>OFF</td>
</tr>
<tr>
<td>2–7</td>
<td>OFF</td>
</tr>
<tr>
<td>2–8</td>
<td>OFF</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 38-10</th>
<th>TM-T90, TM-L90 (Non-Peeler &amp; Peeler)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIP SW 1</td>
<td></td>
</tr>
<tr>
<td>1–1</td>
<td>x</td>
</tr>
<tr>
<td>1–2</td>
<td>ON</td>
</tr>
<tr>
<td>1–3</td>
<td>OFF</td>
</tr>
<tr>
<td>1–4</td>
<td>OFF</td>
</tr>
<tr>
<td>1–5</td>
<td>OFF</td>
</tr>
<tr>
<td>1–6</td>
<td>OFF</td>
</tr>
<tr>
<td>1–7</td>
<td>ON</td>
</tr>
<tr>
<td>1–8</td>
<td>OFF</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 38-11</th>
<th>TM-T70</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIP SW 1</td>
<td>DIP SW 2</td>
</tr>
<tr>
<td>1–1</td>
<td>x</td>
</tr>
<tr>
<td>1–2</td>
<td>OFF</td>
</tr>
<tr>
<td>1–3</td>
<td>OFF</td>
</tr>
<tr>
<td>1–4</td>
<td>OFF</td>
</tr>
<tr>
<td>1–5</td>
<td>OFF</td>
</tr>
<tr>
<td>1–6</td>
<td>OFF</td>
</tr>
<tr>
<td>1–7</td>
<td>ON</td>
</tr>
<tr>
<td>1–8</td>
<td>OFF</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 38-12</th>
<th>TM-T70II</th>
</tr>
</thead>
<tbody>
<tr>
<td>No DIP SW or Memory SW change is necessary.</td>
<td></td>
</tr>
<tr>
<td>Use GS (E command (Fn=11)) to set Serial Port Communication Parameters.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 38-13</th>
<th>Legend</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>ON</td>
</tr>
<tr>
<td>OFF*</td>
<td>ON*</td>
</tr>
<tr>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>
Printer DIP Switch/Memory Switch Setting when using UB-IDML (IDNML02) Interface

### Table 38-14 TM-U200A

<table>
<thead>
<tr>
<th>DIP SW 1</th>
<th>DIP SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>x</td>
</tr>
<tr>
<td>1-2</td>
<td>ON</td>
</tr>
<tr>
<td>1-3</td>
<td>x</td>
</tr>
<tr>
<td>1-4</td>
<td>x</td>
</tr>
<tr>
<td>1-5</td>
<td>x</td>
</tr>
<tr>
<td>1-6</td>
<td>x</td>
</tr>
<tr>
<td>1-7</td>
<td>ON</td>
</tr>
<tr>
<td>1-8</td>
<td>x</td>
</tr>
<tr>
<td>2-1</td>
<td>ON</td>
</tr>
<tr>
<td>2-2</td>
<td>x</td>
</tr>
<tr>
<td>2-3</td>
<td>x</td>
</tr>
<tr>
<td>2-4</td>
<td>x</td>
</tr>
<tr>
<td>2-5</td>
<td>ON</td>
</tr>
<tr>
<td>2-6</td>
<td>x</td>
</tr>
<tr>
<td>2-7</td>
<td>x</td>
</tr>
<tr>
<td>2-8</td>
<td>ON</td>
</tr>
</tbody>
</table>

### Table 38-15 TM-U200B/D

<table>
<thead>
<tr>
<th>DIP SW 1</th>
<th>DIP SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>x</td>
</tr>
<tr>
<td>1-2</td>
<td>ON</td>
</tr>
<tr>
<td>1-3</td>
<td>x</td>
</tr>
<tr>
<td>1-4</td>
<td>x</td>
</tr>
<tr>
<td>1-5</td>
<td>x</td>
</tr>
<tr>
<td>1-6</td>
<td>x</td>
</tr>
<tr>
<td>1-7</td>
<td>ON</td>
</tr>
<tr>
<td>1-8</td>
<td>x</td>
</tr>
<tr>
<td>2-1</td>
<td>ON</td>
</tr>
<tr>
<td>2-2</td>
<td>x</td>
</tr>
<tr>
<td>2-3</td>
<td>x</td>
</tr>
<tr>
<td>2-4</td>
<td>x</td>
</tr>
<tr>
<td>2-5</td>
<td>ON</td>
</tr>
<tr>
<td>2-6</td>
<td>x</td>
</tr>
<tr>
<td>2-7</td>
<td>x</td>
</tr>
<tr>
<td>2-8</td>
<td>ON</td>
</tr>
</tbody>
</table>

### Table 38-16 TM-U220 A/B/D (STD)

<table>
<thead>
<tr>
<th>DIP SW 1</th>
<th>DIP SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>x</td>
</tr>
<tr>
<td>1-2</td>
<td>ON</td>
</tr>
<tr>
<td>1-3</td>
<td>x</td>
</tr>
<tr>
<td>1-4</td>
<td>x</td>
</tr>
<tr>
<td>1-5</td>
<td>x</td>
</tr>
<tr>
<td>1-6</td>
<td>x</td>
</tr>
<tr>
<td>1-7</td>
<td>ON</td>
</tr>
<tr>
<td>1-8</td>
<td>x</td>
</tr>
<tr>
<td>2-1</td>
<td>ON</td>
</tr>
<tr>
<td>2-2</td>
<td>x</td>
</tr>
<tr>
<td>2-3</td>
<td>x</td>
</tr>
<tr>
<td>2-4</td>
<td>x</td>
</tr>
<tr>
<td>2-5</td>
<td>ON</td>
</tr>
<tr>
<td>2-6</td>
<td>x</td>
</tr>
<tr>
<td>2-7</td>
<td>x</td>
</tr>
<tr>
<td>2-8</td>
<td>ON</td>
</tr>
</tbody>
</table>

### Table 38-17 TM-U220 B/D (STD US), TM-U230

<table>
<thead>
<tr>
<th>DIP SW 1</th>
<th>DIP SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>x</td>
</tr>
<tr>
<td>1-2</td>
<td>ON</td>
</tr>
<tr>
<td>1-3</td>
<td>x</td>
</tr>
<tr>
<td>1-4</td>
<td>x</td>
</tr>
<tr>
<td>1-5</td>
<td>x</td>
</tr>
<tr>
<td>1-6</td>
<td>x</td>
</tr>
<tr>
<td>1-7</td>
<td>ON</td>
</tr>
<tr>
<td>1-8</td>
<td>x</td>
</tr>
<tr>
<td>2-1</td>
<td>ON</td>
</tr>
<tr>
<td>2-2</td>
<td>x</td>
</tr>
<tr>
<td>2-3</td>
<td>x</td>
</tr>
<tr>
<td>2-4</td>
<td>x</td>
</tr>
<tr>
<td>2-5</td>
<td>ON</td>
</tr>
<tr>
<td>2-6</td>
<td>x</td>
</tr>
<tr>
<td>2-7</td>
<td>x</td>
</tr>
<tr>
<td>2-8</td>
<td>ON</td>
</tr>
</tbody>
</table>

### Table 38-18 TM-U230 with firmware x.xx RV-EMC

<table>
<thead>
<tr>
<th>DIP SW 1</th>
<th>DIP SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>OFF</td>
</tr>
<tr>
<td>1-2</td>
<td>ON</td>
</tr>
<tr>
<td>1-3</td>
<td>x</td>
</tr>
<tr>
<td>1-4</td>
<td>x</td>
</tr>
<tr>
<td>1-5</td>
<td>x</td>
</tr>
<tr>
<td>1-6</td>
<td>ON</td>
</tr>
<tr>
<td>1-7</td>
<td>x</td>
</tr>
<tr>
<td>1-8</td>
<td>x</td>
</tr>
<tr>
<td>2-1</td>
<td>ON</td>
</tr>
<tr>
<td>2-2</td>
<td>x</td>
</tr>
<tr>
<td>2-3</td>
<td>x</td>
</tr>
<tr>
<td>2-4</td>
<td>x</td>
</tr>
<tr>
<td>2-5</td>
<td>ON</td>
</tr>
<tr>
<td>2-6</td>
<td>x</td>
</tr>
<tr>
<td>2-7</td>
<td>x</td>
</tr>
<tr>
<td>2-8</td>
<td>ON</td>
</tr>
</tbody>
</table>

### Table 38-19 TM-T88III/IV/V

<table>
<thead>
<tr>
<th>DIP SW 1</th>
<th>DIP SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>x</td>
</tr>
<tr>
<td>1-2</td>
<td>x</td>
</tr>
<tr>
<td>1-3</td>
<td>x</td>
</tr>
<tr>
<td>1-4</td>
<td>x</td>
</tr>
<tr>
<td>1-5</td>
<td>x</td>
</tr>
<tr>
<td>1-6</td>
<td>x</td>
</tr>
<tr>
<td>1-7</td>
<td>x</td>
</tr>
<tr>
<td>1-8</td>
<td>ON</td>
</tr>
<tr>
<td>1-9</td>
<td>x</td>
</tr>
<tr>
<td>2-1</td>
<td>ON</td>
</tr>
<tr>
<td>2-2</td>
<td>x</td>
</tr>
<tr>
<td>2-3</td>
<td>x</td>
</tr>
<tr>
<td>2-4</td>
<td>x</td>
</tr>
<tr>
<td>2-5</td>
<td>ON</td>
</tr>
<tr>
<td>2-6</td>
<td>x</td>
</tr>
<tr>
<td>2-7</td>
<td>x</td>
</tr>
<tr>
<td>2-8</td>
<td>ON</td>
</tr>
</tbody>
</table>

### Table 38-20 TM-T90, TM-L90 (Peeler & Non-Peeler) — DIP Switch

<table>
<thead>
<tr>
<th>DIP SW 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
</tr>
<tr>
<td>1-2</td>
</tr>
<tr>
<td>1-3</td>
</tr>
<tr>
<td>1-4</td>
</tr>
<tr>
<td>1-5</td>
</tr>
<tr>
<td>1-6</td>
</tr>
<tr>
<td>1-7</td>
</tr>
<tr>
<td>1-8</td>
</tr>
</tbody>
</table>
### Table 38-20 (Cont.) TM-T90, TM-L90 (Peeler & Non-Peeler) — DIP Switch

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-21 TM-T90, TM-L90 (Peeler & Non-Peeler) — Memory Switch

<table>
<thead>
<tr>
<th>Mem</th>
<th>SW</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>1–2</td>
<td>1–3</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>ON</td>
</tr>
</tbody>
</table>

### Table 38-22 TM-T70

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-23 TM-T70II

No DIP SW or Memory SW change is necessary.

### Table 38-24 Legend

<table>
<thead>
<tr>
<th>OFF</th>
<th>ON</th>
<th>= Mandatory Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF*</td>
<td>ON*</td>
<td>= Recommended Setting</td>
</tr>
<tr>
<td>x</td>
<td></td>
<td>= Don't Care</td>
</tr>
</tbody>
</table>

Printer DIP Switch/Memory Switch Setting when using UB-E02 (E03) Interface

### Table 38-25 TM-U200A

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-26 TM-U200B/D

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>
### Table 38-27  TM-U220 A/B/D (STD)

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW 1</th>
<th>DIP</th>
<th>SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>ON</td>
<td>1–2</td>
<td>ON</td>
</tr>
<tr>
<td>1–3</td>
<td>x</td>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>x</td>
<td>1–8</td>
<td>x</td>
</tr>
<tr>
<td>2–1</td>
<td>x</td>
<td>2–2</td>
<td>x</td>
</tr>
<tr>
<td>2–3</td>
<td>x</td>
<td>2–4</td>
<td>x</td>
</tr>
<tr>
<td>2–5</td>
<td>x</td>
<td>2–6</td>
<td>x</td>
</tr>
<tr>
<td>2–7</td>
<td>x</td>
<td>2–8</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-28  TM-U220 B/D (STD US), TM-U230

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW 1</th>
<th>DIP</th>
<th>SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>ON</td>
<td>1–2</td>
<td>ON</td>
</tr>
<tr>
<td>1–3</td>
<td>x</td>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>x</td>
<td>1–8</td>
<td>x</td>
</tr>
<tr>
<td>2–1</td>
<td>x</td>
<td>2–2</td>
<td>x</td>
</tr>
<tr>
<td>2–3</td>
<td>x</td>
<td>2–4</td>
<td>x</td>
</tr>
<tr>
<td>2–5</td>
<td>x</td>
<td>2–6</td>
<td>x</td>
</tr>
<tr>
<td>2–7</td>
<td>x</td>
<td>2–8</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-29  TM-T88III/IV/V

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW 1</th>
<th>DIP</th>
<th>SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>ON</td>
<td>1–2</td>
<td>ON</td>
</tr>
<tr>
<td>1–3</td>
<td>x</td>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>x</td>
<td>1–8</td>
<td>x</td>
</tr>
<tr>
<td>2–1</td>
<td>x</td>
<td>2–2</td>
<td>x</td>
</tr>
<tr>
<td>2–3</td>
<td>x</td>
<td>2–4</td>
<td>x</td>
</tr>
<tr>
<td>2–5</td>
<td>x</td>
<td>2–6</td>
<td>x</td>
</tr>
<tr>
<td>2–7</td>
<td>x</td>
<td>2–8</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-30  TM-T90, TM-L90 (Peeler & Non-Peeler) — DIP Switch

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>ON</td>
</tr>
<tr>
<td>1–2</td>
<td>ON</td>
</tr>
<tr>
<td>1–3</td>
<td>x</td>
</tr>
<tr>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
</tr>
<tr>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>x</td>
</tr>
<tr>
<td>1–8</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-31  TM-T90, TML90 (Peeler & Non-Peeler) — Memory Switch

<table>
<thead>
<tr>
<th>Mem</th>
<th>SW 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>ON</td>
</tr>
<tr>
<td>1–2</td>
<td>ON</td>
</tr>
<tr>
<td>1–3</td>
<td>x</td>
</tr>
<tr>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
</tr>
<tr>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>x</td>
</tr>
<tr>
<td>1–8</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-32  TM-T70

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW 1</th>
<th>DIP</th>
<th>SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>ON</td>
<td>1–2</td>
<td>ON</td>
</tr>
<tr>
<td>1–3</td>
<td>x</td>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>x</td>
<td>1–8</td>
<td>x</td>
</tr>
<tr>
<td>2–1</td>
<td>x</td>
<td>2–2</td>
<td>x</td>
</tr>
<tr>
<td>2–3</td>
<td>x</td>
<td>2–4</td>
<td>x</td>
</tr>
<tr>
<td>2–5</td>
<td>x</td>
<td>2–6</td>
<td>x</td>
</tr>
<tr>
<td>2–7</td>
<td>x</td>
<td>2–8</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-33  TM-T70II

No DIP SW or Memory SW change is necessary.

### Table 38-34  Legend

<table>
<thead>
<tr>
<th>OFF</th>
<th>ON</th>
<th>= Mandatory Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF*</td>
<td>ON*</td>
<td>= Recommended Setting</td>
</tr>
<tr>
<td>x</td>
<td></td>
<td>= Don’t Care</td>
</tr>
</tbody>
</table>
### Printer DIP Switch/Memory Switch Setting when using UB-EML Interface

#### Table 38-35  TM-U200A

<table>
<thead>
<tr>
<th>DIP SW 1</th>
<th>DIP SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>x</td>
</tr>
<tr>
<td>1–2</td>
<td>ON</td>
</tr>
<tr>
<td>1–3</td>
<td>x</td>
</tr>
<tr>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
</tr>
<tr>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>ON</td>
</tr>
<tr>
<td>1–8</td>
<td>x</td>
</tr>
<tr>
<td>2–1</td>
<td>x</td>
</tr>
<tr>
<td>2–2</td>
<td>OFF</td>
</tr>
<tr>
<td>2–3</td>
<td>x</td>
</tr>
<tr>
<td>2–4</td>
<td>x</td>
</tr>
<tr>
<td>2–5</td>
<td>ON</td>
</tr>
<tr>
<td>2–6</td>
<td>OFF</td>
</tr>
<tr>
<td>2–7</td>
<td>OFF</td>
</tr>
<tr>
<td>2–8</td>
<td>ON</td>
</tr>
</tbody>
</table>

#### Table 38-36  TM-U200B/D

<table>
<thead>
<tr>
<th>DIP SW 1</th>
<th>DIP SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>ON</td>
</tr>
<tr>
<td>1–2</td>
<td>x</td>
</tr>
<tr>
<td>1–3</td>
<td>ON</td>
</tr>
<tr>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
</tr>
<tr>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>OCT</td>
</tr>
<tr>
<td>1–8</td>
<td>x</td>
</tr>
<tr>
<td>2–1</td>
<td>OFF</td>
</tr>
<tr>
<td>2–2</td>
<td>OFF</td>
</tr>
<tr>
<td>2–3</td>
<td>ON</td>
</tr>
<tr>
<td>2–4</td>
<td>OFF</td>
</tr>
<tr>
<td>2–5</td>
<td>OFF</td>
</tr>
<tr>
<td>2–6</td>
<td>x</td>
</tr>
<tr>
<td>2–7</td>
<td>x</td>
</tr>
<tr>
<td>2–8</td>
<td>x</td>
</tr>
</tbody>
</table>

#### Table 38-37  TM-U220 A/B/D (STD)

<table>
<thead>
<tr>
<th>DIP SW 1</th>
<th>DIP SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>ON</td>
</tr>
<tr>
<td>1–2</td>
<td>x</td>
</tr>
<tr>
<td>1–3</td>
<td>ON</td>
</tr>
<tr>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
</tr>
<tr>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>OFF</td>
</tr>
<tr>
<td>1–8</td>
<td>ON</td>
</tr>
<tr>
<td>2–1</td>
<td>x</td>
</tr>
<tr>
<td>2–2</td>
<td>OFF</td>
</tr>
<tr>
<td>2–3</td>
<td>OFF</td>
</tr>
<tr>
<td>2–4</td>
<td>OFF</td>
</tr>
<tr>
<td>2–5</td>
<td>OFF</td>
</tr>
<tr>
<td>2–6</td>
<td>x</td>
</tr>
<tr>
<td>2–7</td>
<td>x</td>
</tr>
<tr>
<td>2–8</td>
<td>x</td>
</tr>
</tbody>
</table>

#### Table 38-38  TM-U220 B/D (STD US)

<table>
<thead>
<tr>
<th>DIP SW 1</th>
<th>DIP SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>x</td>
</tr>
<tr>
<td>1–2</td>
<td>ON</td>
</tr>
<tr>
<td>1–3</td>
<td>x</td>
</tr>
<tr>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
</tr>
<tr>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>OFF</td>
</tr>
<tr>
<td>1–8</td>
<td>ON</td>
</tr>
<tr>
<td>2–1</td>
<td>x</td>
</tr>
<tr>
<td>2–2</td>
<td>OFF</td>
</tr>
<tr>
<td>2–3</td>
<td>ON</td>
</tr>
<tr>
<td>2–4</td>
<td>OFF</td>
</tr>
<tr>
<td>2–5</td>
<td>OFF</td>
</tr>
<tr>
<td>2–6</td>
<td>x</td>
</tr>
<tr>
<td>2–7</td>
<td>x</td>
</tr>
<tr>
<td>2–8</td>
<td>x</td>
</tr>
</tbody>
</table>

#### Table 38-39  TM-U230

<table>
<thead>
<tr>
<th>DIP SW 1</th>
<th>DIP SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>ON</td>
</tr>
<tr>
<td>1–2</td>
<td>x</td>
</tr>
<tr>
<td>1–3</td>
<td>ON</td>
</tr>
<tr>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
</tr>
<tr>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>OFF</td>
</tr>
<tr>
<td>1–8</td>
<td>ON</td>
</tr>
<tr>
<td>2–1</td>
<td>x</td>
</tr>
<tr>
<td>2–2</td>
<td>OFF</td>
</tr>
<tr>
<td>2–3</td>
<td>OFF</td>
</tr>
<tr>
<td>2–4</td>
<td>OFF</td>
</tr>
<tr>
<td>2–5</td>
<td>OFF</td>
</tr>
<tr>
<td>2–6</td>
<td>x</td>
</tr>
<tr>
<td>2–7</td>
<td>x</td>
</tr>
<tr>
<td>2–8</td>
<td>x</td>
</tr>
</tbody>
</table>

#### Table 38-40  TM-T88III/IV/V

<table>
<thead>
<tr>
<th>DIP SW 1</th>
<th>DIP SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>x</td>
</tr>
<tr>
<td>1–2</td>
<td>x</td>
</tr>
<tr>
<td>1–3</td>
<td>x</td>
</tr>
<tr>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
</tr>
<tr>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>ON</td>
</tr>
<tr>
<td>1–8</td>
<td>x</td>
</tr>
<tr>
<td>2–1</td>
<td>x</td>
</tr>
<tr>
<td>2–2</td>
<td>OFF</td>
</tr>
<tr>
<td>2–3</td>
<td>x</td>
</tr>
<tr>
<td>2–4</td>
<td>x</td>
</tr>
<tr>
<td>2–5</td>
<td>ON</td>
</tr>
<tr>
<td>2–6</td>
<td>OFF</td>
</tr>
<tr>
<td>2–7</td>
<td>x</td>
</tr>
<tr>
<td>2–8</td>
<td>x</td>
</tr>
</tbody>
</table>

#### Table 38-41  TM-T90 — DIP Switch

<table>
<thead>
<tr>
<th>DIP SW 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
</tr>
<tr>
<td>1–2</td>
</tr>
<tr>
<td>1–3</td>
</tr>
<tr>
<td>1–4</td>
</tr>
<tr>
<td>1–5</td>
</tr>
<tr>
<td>1–6</td>
</tr>
<tr>
<td>1–7</td>
</tr>
<tr>
<td>1–8</td>
</tr>
</tbody>
</table>
### Table 38-41  (Cont.) TM-T90 — DIP Switch

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-42  TM-T90 — Memory Switch 1

<table>
<thead>
<tr>
<th>Mem</th>
<th>SW 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>OFF</td>
</tr>
<tr>
<td>1–2</td>
<td>OFF</td>
</tr>
<tr>
<td>1–3</td>
<td>OFF</td>
</tr>
<tr>
<td>1–4</td>
<td>OFF</td>
</tr>
<tr>
<td>1–5</td>
<td>ON</td>
</tr>
<tr>
<td>1–6</td>
<td>OFF</td>
</tr>
<tr>
<td>1–7</td>
<td>OFF</td>
</tr>
<tr>
<td>1–8</td>
<td>ON</td>
</tr>
</tbody>
</table>

### Table 38-43  Memory Switch 2

<table>
<thead>
<tr>
<th>Mem</th>
<th>SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>2–1</td>
<td>ON</td>
</tr>
<tr>
<td>2–2</td>
<td>x</td>
</tr>
<tr>
<td>2–3</td>
<td>x</td>
</tr>
<tr>
<td>2–4</td>
<td>x</td>
</tr>
<tr>
<td>2–5</td>
<td>x</td>
</tr>
<tr>
<td>2–6</td>
<td>x</td>
</tr>
<tr>
<td>2–7</td>
<td>x</td>
</tr>
<tr>
<td>2–8</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-44  Memory Switch 8

<table>
<thead>
<tr>
<th>Mem</th>
<th>SW 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>8–1</td>
<td>OFF</td>
</tr>
<tr>
<td>8–2</td>
<td>OFF</td>
</tr>
<tr>
<td>8–3</td>
<td>OFF</td>
</tr>
<tr>
<td>8–4</td>
<td>ON</td>
</tr>
<tr>
<td>8–5</td>
<td>x</td>
</tr>
<tr>
<td>8–6</td>
<td>x</td>
</tr>
<tr>
<td>8–7</td>
<td>x</td>
</tr>
<tr>
<td>8–8</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-45  Legend

<table>
<thead>
<tr>
<th>OFF</th>
<th>ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF*</td>
<td>ON*</td>
</tr>
<tr>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>

= Mandatory Setting  
= Recommended Setting  
= Don't Care

Printer DIP Switch/Memory Switch Setting when using UB-EML02 Interface

### Table 38-46  TM-U220 A/B/D (STD)

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW 1</th>
<th>DIP</th>
<th>SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>OFF</td>
<td>1–2</td>
<td>x</td>
</tr>
<tr>
<td>1–3</td>
<td>x</td>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>x</td>
<td>1–8</td>
<td>x</td>
</tr>
<tr>
<td>2–1</td>
<td>ON</td>
<td>2–2</td>
<td>x</td>
</tr>
<tr>
<td>2–3</td>
<td>x</td>
<td>2–4</td>
<td>x</td>
</tr>
<tr>
<td>2–5</td>
<td>x</td>
<td>2–6</td>
<td>ON</td>
</tr>
<tr>
<td>2–7</td>
<td>x</td>
<td>2–8</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-47  TM-U220 B/D (STD US)

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW 1</th>
<th>DIP</th>
<th>SW 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>OFF</td>
<td>1–2</td>
<td>x</td>
</tr>
<tr>
<td>1–3</td>
<td>x</td>
<td>1–4</td>
<td>x</td>
</tr>
<tr>
<td>1–5</td>
<td>x</td>
<td>1–6</td>
<td>x</td>
</tr>
<tr>
<td>1–7</td>
<td>x</td>
<td>1–8</td>
<td>x</td>
</tr>
<tr>
<td>2–1</td>
<td>ON</td>
<td>2–2</td>
<td>x</td>
</tr>
<tr>
<td>2–3</td>
<td>x</td>
<td>2–4</td>
<td>x</td>
</tr>
<tr>
<td>2–5</td>
<td>x</td>
<td>2–6</td>
<td>ON</td>
</tr>
<tr>
<td>2–7</td>
<td>x</td>
<td>2–8</td>
<td>x</td>
</tr>
</tbody>
</table>
### Table 38-48  TM-T88IV/T88V

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW</th>
<th>1</th>
<th>DIP</th>
<th>SW</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>1–2</td>
<td>1–3</td>
<td>1–4</td>
<td>1–5</td>
<td>1–6</td>
</tr>
<tr>
<td>OFF</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-49  TM-T90/L90 — DIP Switch 1

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>1–2</td>
<td>1–3</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-50  TM-T90/L90 — Memory Switch 1

<table>
<thead>
<tr>
<th>Mem</th>
<th>SW</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>1–2</td>
<td>1–3</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>x</td>
<td>OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>

### Table 38-51  TM-T90/L90 — Memory Switch 2

<table>
<thead>
<tr>
<th>Mem</th>
<th>SW</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>2–1</td>
<td>2–2</td>
<td>2–3</td>
</tr>
<tr>
<td>ON</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-52  TM-T90/L90 — Memory Switch 8

<table>
<thead>
<tr>
<th>Mem</th>
<th>SW</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>8–1</td>
<td>8–2</td>
<td>8–3</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>OFF</td>
</tr>
</tbody>
</table>

### Table 38-53  TM-T70

<table>
<thead>
<tr>
<th>DIP</th>
<th>SW</th>
<th>1</th>
<th>DIP</th>
<th>SW</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>1–2</td>
<td>1–3</td>
<td>1–4</td>
<td>1–5</td>
<td>1–6</td>
</tr>
<tr>
<td>OFF</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

### Table 38-54  TM-T70II — DIP Switch

No DIP Switch.

### Table 38-55  TM-T70II — Memory Switch

<table>
<thead>
<tr>
<th>Mem</th>
<th>SW</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>1–2</td>
<td>1–3</td>
</tr>
<tr>
<td>1–4</td>
<td>1–5</td>
<td>1–6</td>
</tr>
<tr>
<td>1–7</td>
<td>1–8</td>
<td>1–9</td>
</tr>
</tbody>
</table>
Table 38-55  (Cont.) TM-T70II — Memory Switch

<table>
<thead>
<tr>
<th>Mem</th>
<th>SW</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>x</td>
<td>OFF</td>
</tr>
</tbody>
</table>

Table 38-56  Legend

<table>
<thead>
<tr>
<th>OFF</th>
<th>ON</th>
<th>OFF*</th>
<th>ON*</th>
<th>= Mandatory Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>= Recommended Setting</td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>= Don’t Care</td>
</tr>
</tbody>
</table>

DIP Switch Definitions

TM-U200A

1. RS-232 serial interface model

Table 38-57  DIP Switch 1

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data reception error</td>
<td>Ignored</td>
<td>Prints “?”</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ANK model:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1000 bytes</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Multilingual</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>model: 512</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>bytes</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Receive buffer capacity</td>
<td>40 bytes</td>
<td></td>
<td>Off</td>
</tr>
<tr>
<td>3</td>
<td>Handshaking</td>
<td>XON/XOFF</td>
<td>DTR/DSR</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Word length</td>
<td>7 bit</td>
<td>8 bit</td>
<td>Off</td>
</tr>
<tr>
<td>5</td>
<td>Parity check</td>
<td>Yes</td>
<td>No</td>
<td>Off</td>
</tr>
<tr>
<td>6</td>
<td>Parity selection</td>
<td>Even</td>
<td>Odd</td>
<td>Off</td>
</tr>
<tr>
<td>7</td>
<td>Baud rate selection</td>
<td>4800 bps</td>
<td>9600 bps</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>BUSY condition</td>
<td>Receive buffer-full</td>
<td>Off-line Receive buffer-full</td>
<td>Off</td>
</tr>
</tbody>
</table>

Table 38-58  DIP Switch 2

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selects number of characters per line (cpl) 7x9 font / 9x9 font</td>
<td>42 cpl / 35 cpl</td>
<td>40 cpl / 33 cpl</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>For internal use only (*1) (Autocutter)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>On</td>
</tr>
<tr>
<td>3</td>
<td>For internal use only (*1) (Autocutter)</td>
<td>Asynchronous</td>
<td>Synchronous with clock</td>
<td>Off</td>
</tr>
</tbody>
</table>
### Table 38-58  (Cont.) DIP Switch 2

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
</tr>
<tr>
<td>5</td>
<td>For internal use only (*1) (Semi-autoloading)</td>
<td>For type A</td>
<td>For type B/D</td>
<td>On</td>
</tr>
<tr>
<td>6</td>
<td>For internal use only (*1) (Flash memory rewriting)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>Off</td>
</tr>
<tr>
<td>7</td>
<td>Pin 6 reset signal</td>
<td>Used</td>
<td>Not used</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>Pin 25 reset signal</td>
<td>Used</td>
<td>Not used</td>
<td>Off</td>
</tr>
</tbody>
</table>

2. Parallel interface model

### Table 38-59  DIP Switch 1

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Auto line feed</td>
<td>Enabled</td>
<td>Disabled</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>Receive buffer</td>
<td>40 bytes</td>
<td>–</td>
<td>Off</td>
</tr>
<tr>
<td>3–7</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>Busy condition</td>
<td>Receive buffer-full</td>
<td>Off-line Receive buffer-full</td>
<td>Off</td>
</tr>
</tbody>
</table>

### Table 38-60  DIP Switch 2

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selects number of characters per line (cpl) 7x9 font / 9x9 font</td>
<td>42 cpl / 35 cpl</td>
<td>40 cpl / 33 cpl</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>For internal use only (*1) (Autocutter)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>On</td>
</tr>
<tr>
<td>3</td>
<td>For internal use only (*1) (Interface synchronization)</td>
<td>Asynchronous</td>
<td>Synchronous with clock</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
</tr>
<tr>
<td>5</td>
<td>For internal use only (*1) (semi-autoloading)</td>
<td>For Type A</td>
<td>For type B/D</td>
<td>On</td>
</tr>
<tr>
<td>6</td>
<td>For internal use only (*1) (Flash memory rewriting)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>Off</td>
</tr>
<tr>
<td>7</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>Pin 31 reset signal</td>
<td>Used</td>
<td>Not Used</td>
<td>On</td>
</tr>
</tbody>
</table>
### Table 38-61  DIP Switch 1

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data reception error</td>
<td>Ignored</td>
<td>Prints “?”</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ANK model: 1000 bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Multilingual model: 512 bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Receive buffer capacity</td>
<td>40 bytes</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>3</td>
<td>Handshaking</td>
<td>XON/XOFF</td>
<td>DTR/DSR</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Word length</td>
<td>7 bit</td>
<td>8 bit</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>5</td>
<td>Parity check</td>
<td>Yes</td>
<td>No</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>6</td>
<td>Parity selection</td>
<td>Even</td>
<td>Odd</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>7</td>
<td>Baud rate selection</td>
<td>4800 bps</td>
<td>9600 bps</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off-line</td>
<td>Receive buffer-full</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>

*1: Do not change the settings of DIP switches 2–2, 2–5, 2–6, and 2–7.

2. Parallel interface model

### Table 38-62  DIP Switch 2

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selects number of characters per line (cpl) 7x9 font / 9x9 font</td>
<td>42 cpl / 35 cpl</td>
<td>40 cpl / 33 cpl</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>For internal use only (*1) (Autocutter)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>3</td>
<td>Pin 6 reset signal</td>
<td>Used</td>
<td>Not used</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Pin 25 reset signal</td>
<td>Used</td>
<td>Not used</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>5</td>
<td>For internal use only (*1) (Semi-autoloading)</td>
<td>For type A</td>
<td>For type B/D</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>6</td>
<td>For internal use only (*1) (Flash memory rewriting)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>7</td>
<td>For internal use only (*1) (Interface synchronization)</td>
<td>Asynchronous</td>
<td>Synchronous with clock</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>

### Table 38-63  DIP Switch 1

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Auto line feed</td>
<td>Enabled</td>
<td>Disabled</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>
**Table 38-63  (Cont.) DIP Switch 1**

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Receive buffer</td>
<td>40 bytes</td>
<td>ANK Model: 1000 bytes Multilingual mode: 512 bytes</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>3–7</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>Busy condition</td>
<td>Receive buffer-full</td>
<td>Off-line Receive buffer-full</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>

**Table 38-64  DIP Switch 2**

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selects number of characters per line (cpl) 7 x 9 / 9 x 9 font</td>
<td>42 cpl / 35 cpl</td>
<td>40 cpl / 33 cpl</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>For internal use only (*1) (Autocutter)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>3</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Pin 31 reset signal</td>
<td>Used</td>
<td>Not used</td>
<td>On</td>
<td>On</td>
</tr>
<tr>
<td>5</td>
<td>For internal use only (*1) (semi-autoloading)</td>
<td>For type A</td>
<td>For type B/D</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>6</td>
<td>For internal use only (*1) (Flash memory rewriting)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>7</td>
<td>For internal use only (*1) (Interface synchronization)</td>
<td>Asynchronous</td>
<td>Synchronous with clock</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>

*1: Do not change the settings of DIP switches 2–2, 2–5, 2–6, and 2–7.

**TM-U220A/B/D (STD)**

1. Serial interface model

**Table 38-65  DIP Switch 1**

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default A</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data reception error</td>
<td>Ignored</td>
<td>Print “?”</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>Receive buffer capacity</td>
<td>40 bytes</td>
<td>4 KB</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>
### Table 38-65  (Cont.) DIP Switch 1

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default A</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Handshaking</td>
<td>XON/ XOFF</td>
<td>DTR/DSR</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Word length</td>
<td>7 bits</td>
<td>8 bits</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>5</td>
<td>Parity check</td>
<td>Yes</td>
<td>No</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>6</td>
<td>Parity selection</td>
<td>Even</td>
<td>Odd</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>7</td>
<td>Transmission speed selection</td>
<td>4800 bps</td>
<td>9600 bps</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>BUSY condition</td>
<td>Receive buffer-full</td>
<td>Offline</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>

### Table 38-66  DIP Switch 2

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default A</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selects number of characters per line (cpl) (*)</td>
<td>42 cpl / 35 cpl</td>
<td>40 cpl / 33 cpl</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>Reserved (Autocutter)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>On</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>3</td>
<td>Undefined</td>
<td>—</td>
<td>—</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Serial communication set selection</td>
<td>By memory switch</td>
<td>By DIP switch</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>5</td>
<td>Undefined</td>
<td>—</td>
<td>—</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>6</td>
<td>Reserved (Flash memory rewriting)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>7</td>
<td>Pin 6 reset signal</td>
<td>Used</td>
<td>Not used</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>Pin 25 reset signal</td>
<td>Used</td>
<td>Not used</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>

(*) Selection of dots between characters: On = 2 half dots, Off = 3 half dots

The number of characters per line in the Table indicates for the 76 mm-width paper.

2. Parallel interface model

### Table 38-67  DIP Switch 1

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default A</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Auto line feed</td>
<td>Enabled</td>
<td>Disabled</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>Receive buffer</td>
<td>40 bytes</td>
<td>4KB</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>
### Table 38-67  (Cont.) DIP Switch 1

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default A</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>5</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>6</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>7</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>BUSY condition</td>
<td>Receive buffer-full</td>
<td>Offline</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>

### Table 38-68  DIP Switch 2

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default A</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selects number of characters per line (cpl) (*)</td>
<td>42 cpl / 35 cpl</td>
<td>40 cpl / 33 cpl</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>Reserved (Autocutter)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>On</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>3</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>5</td>
<td>Reserved (Flash memory rewriting)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>6</td>
<td>Pin 31 reset signal</td>
<td>Used</td>
<td>Not used</td>
<td>On</td>
<td>On</td>
<td>On</td>
</tr>
</tbody>
</table>

(*) Selection of dots between characters: On = 2 half dots, Off = 3 half dots.

The number of characters per line in the Table indicates for the 76 mm-width paper.

**TM-U220B/D (US STD)**

1. Serial interface model

### Table 38-69  DIP Switch 1

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Printing mode</td>
<td>Right side up printing mode</td>
<td>Normal printing mode</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>Receive buffer capacity</td>
<td>40 bytes</td>
<td>4KB</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>3</td>
<td>Handshaking</td>
<td>XON/XOFF</td>
<td>DTR/DSR</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>
### Table 38-69  (Cont.) DIP Switch 1

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Word length</td>
<td>7 bits</td>
<td>8 bits</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>5</td>
<td>Parity check</td>
<td>Yes</td>
<td>No</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>6</td>
<td>Parity selection</td>
<td>Even</td>
<td>Odd</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>7</td>
<td>Transmission speed selection</td>
<td>4800 bps</td>
<td>9600 bps</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>BUSY condition</td>
<td>Receive buffer-full</td>
<td>Offline</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>

### Table 38-70  DIP Switch 2

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selects number of characters per line (cpl) (*)</td>
<td>42 cpl / 35 cpl</td>
<td>40 cpl / 33 cpl</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>Reserved (Autocutter)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>3</td>
<td>Pin 6 reset signal</td>
<td>Used</td>
<td>Not used</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Pin 25 reset signal</td>
<td>Used</td>
<td>Not used</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>5</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>6</td>
<td>Reserved (Flash memory rewriting)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>7</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>Serial communication set selection</td>
<td>By memory switch</td>
<td>By DIP switch</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>

(*) Selection of dots between characters: On = 2 half dots, Off = 3 half dots.

The number of characters per line in the Table indicates for the 76 mm-width paper.

2. Parallel interface model

### Table 38-71  DIP Switch 1

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Printing mode</td>
<td>Right side up printing mode</td>
<td>Normal printing mode</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>Receive buffer</td>
<td>40 bytes</td>
<td>4KB</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>3</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>5</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>6</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>
Table 38-71  (Cont.) DIP Switch 1

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>BUSY condition</td>
<td>Receive buffer-full</td>
<td>Offline</td>
<td>Receive buffer-full</td>
<td>Off</td>
</tr>
</tbody>
</table>

Table 38-72  DIP Switch 2

<table>
<thead>
<tr>
<th>Switch No.</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Default B</th>
<th>Default D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selects number of characters per line (cpl) (*)</td>
<td>42 cpl / 35 cpl</td>
<td>40 cpl / 33 cpl</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>Reserved (Autocutter)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>3</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Pin 31 reset signal</td>
<td>Used</td>
<td>Not used</td>
<td>On</td>
<td>On</td>
</tr>
<tr>
<td>5</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>6</td>
<td>Reserved (Flash memory rewriting)</td>
<td>Enabled</td>
<td>Disabled</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>7</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>8</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>

(*) Selection of dots between characters: On = 2 half dots, Off = 3 half dots.
The number of characters per line in the Table indicates for the 76 mm-width paper.

**TM-T88III/IV/V**

**TM-T70**

1. Serial interface specification

Table 38-73  DIP Switch 1

<table>
<thead>
<tr>
<th>SW 1</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Factory Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data reception error</td>
<td>Ignored</td>
<td>Prints “?”</td>
<td>OFF</td>
</tr>
<tr>
<td>2</td>
<td>Receive buffer capacity</td>
<td>45 bytes</td>
<td>4 KB</td>
<td>OFF</td>
</tr>
<tr>
<td>3</td>
<td>Handshaking</td>
<td>XON/XOFF</td>
<td>DTR/DSR</td>
<td>OFF</td>
</tr>
<tr>
<td>4</td>
<td>Word length</td>
<td>7 bits</td>
<td>8 bits</td>
<td>OFF</td>
</tr>
<tr>
<td>5</td>
<td>Parity check</td>
<td>Yes</td>
<td>No</td>
<td>OFF</td>
</tr>
<tr>
<td>6</td>
<td>Selection of parity</td>
<td>Even</td>
<td>Odd</td>
<td>OFF</td>
</tr>
<tr>
<td>7</td>
<td>Selection of transmission speed</td>
<td>See Table 18</td>
<td>See Table 18</td>
<td>ON</td>
</tr>
</tbody>
</table>
Table 38-73  (Cont.) DIP Switch 1

<table>
<thead>
<tr>
<th>SW 1</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Factory Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Selection of transmission speed</td>
<td>See Table 18</td>
<td>See Table 18</td>
<td>OFF</td>
</tr>
</tbody>
</table>

Table 38-74  Transmission Speed

<table>
<thead>
<tr>
<th>Transmission speed (bps)</th>
<th>SW 1–7</th>
<th>SW 1–8</th>
</tr>
</thead>
<tbody>
<tr>
<td>(*1)</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>4800</td>
<td>OFF</td>
<td>ON</td>
</tr>
<tr>
<td>9600</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>19200</td>
<td>OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>

bps: bits per second

Table 38-75  DIP Switch 2

<table>
<thead>
<tr>
<th>SW 2</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Factory Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Handshaking (Condition or BUSY)</td>
<td>Receive buffer full</td>
<td>Offline</td>
<td>OFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Receive buffer-full</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Reserved (Do not change settings)</td>
<td>Fixed to OFF</td>
<td>Fixed to OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>3</td>
<td>Selects print density</td>
<td>See Table 20</td>
<td>See Table 20</td>
<td>OFF</td>
</tr>
<tr>
<td>4</td>
<td>Selects print density</td>
<td>See Table 20</td>
<td>See Table 20</td>
<td>OFF</td>
</tr>
<tr>
<td>5</td>
<td>Setting the conditions that cancel the receive buffer BUSY state (This function is effective when the receive buffer capacity is set to 4 KB.)</td>
<td>Cancels the BUSY state when the remaining capacity of the receive buffer reaches 138 bytes.</td>
<td>Cancels the BUSY state when the remaining capacity of the receive buffer reaches 256 bytes.</td>
<td>OFF</td>
</tr>
<tr>
<td>6</td>
<td>Reserved (Do not change settings)</td>
<td>Fixed to OFF</td>
<td>Fixed to OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>7</td>
<td>I/F pin 6 reset signal</td>
<td>Enabled</td>
<td>Disabled</td>
<td>OFF</td>
</tr>
<tr>
<td>8</td>
<td>I/F pin 25 reset signal</td>
<td>Enabled</td>
<td>Disabled</td>
<td>OFF</td>
</tr>
</tbody>
</table>

Table 38-76  DIP Switch 2–3 and 2–4

<table>
<thead>
<tr>
<th>Switch No. 3</th>
<th>Switch No. 4</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>OFF</td>
<td>Print density (Standard)</td>
</tr>
<tr>
<td>ON</td>
<td>OFF</td>
<td>Print density (Medium)</td>
</tr>
<tr>
<td>OFF</td>
<td>ON</td>
<td>Print density (Dark)</td>
</tr>
<tr>
<td>ON</td>
<td>ON</td>
<td>Prohibited</td>
</tr>
</tbody>
</table>

2. Parallel interface specification
### Table 38-77  DIP Switch 1

<table>
<thead>
<tr>
<th>SW</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Factory Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Auto line feed</td>
<td>Always enabled</td>
<td>Always disabled</td>
<td>OFF</td>
</tr>
<tr>
<td>2</td>
<td>Receive buffer capacity</td>
<td>45 bytes</td>
<td>4 KB</td>
<td>OFF</td>
</tr>
<tr>
<td>3</td>
<td>Selects paper sensors to output paper-end signals</td>
<td>Disabled</td>
<td>Roll paper end sensor enabled; roll paper near-end sensor enabled</td>
<td>OFF</td>
</tr>
<tr>
<td>4</td>
<td>Sets error signal</td>
<td>Disabled</td>
<td>Enabled</td>
<td>OFF</td>
</tr>
<tr>
<td>5–8</td>
<td>Undefined</td>
<td>–</td>
<td>–</td>
<td>OFF</td>
</tr>
</tbody>
</table>

### Table 38-78  DIP Switch 2

<table>
<thead>
<tr>
<th>SW</th>
<th>Function</th>
<th>ON</th>
<th>OFF</th>
<th>Factory Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Handshaking (Condition for BUSY)</td>
<td>Receive buffer full</td>
<td>Offline</td>
<td>OFF</td>
</tr>
<tr>
<td>2</td>
<td>Reserved (Do not change settings)</td>
<td>Fixed to OFF</td>
<td>Fixed to OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>3</td>
<td>Selects print density</td>
<td>See Table 23</td>
<td>See Table 23</td>
<td>OFF</td>
</tr>
<tr>
<td>4</td>
<td>Selects print density</td>
<td>See Table 23</td>
<td>See Table 23</td>
<td>OFF</td>
</tr>
<tr>
<td>5</td>
<td>Setting the conditions that cancel the receive buffer BUSY state (this function is effective when the capacity of the receive buffer is set to 4 KB).</td>
<td>Cancels the BUSY state when the remaining capacity of the receive buffer reaches 138 bytes.</td>
<td>Cancels the BUSY state when the remaining capacity of the receive buffer reaches 256 bytes.</td>
<td>OFF</td>
</tr>
<tr>
<td>6</td>
<td>Reserved (Do not change settings)</td>
<td>Fixed to OFF</td>
<td>Fixed to OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>7</td>
<td>Reserved (Do not change settings)</td>
<td>Fixed to OFF</td>
<td>Fixed to OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>8</td>
<td>Interface pin 31 reset signal (Do not change settings)</td>
<td>Fixed to ON</td>
<td>Fixed to ON</td>
<td>ON</td>
</tr>
</tbody>
</table>

### Table 38-79  DIP Switch 2–3 and 2–4

<table>
<thead>
<tr>
<th>3</th>
<th>4</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>OFF</td>
<td>Print density (Standard)</td>
</tr>
<tr>
<td>ON</td>
<td>OFF</td>
<td>Print density (Medium)</td>
</tr>
<tr>
<td>OFF</td>
<td>ON</td>
<td>Print density (Dark)</td>
</tr>
<tr>
<td>ON</td>
<td>ON</td>
<td>Prohibited</td>
</tr>
</tbody>
</table>
### Table 38-80  Memory Switch 1

<table>
<thead>
<tr>
<th>Memory Switch</th>
<th>Function</th>
<th>Setting Value — 48 (OFF)</th>
<th>Setting Value — 49 (ON)</th>
<th>Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>(Reserved)</td>
<td></td>
<td></td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>1–2</td>
<td>Receive buffer capacity</td>
<td>4 KB</td>
<td>45 bytes</td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>1–3</td>
<td>Condition for BUSY</td>
<td>Receive buffer full or offline</td>
<td>Receive buffer full offline</td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>1–4</td>
<td>Data processing for receiving error</td>
<td>Replaced with &quot;?&quot;</td>
<td>Ignored</td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>1–5</td>
<td>Automatic line feed</td>
<td>Always disabled</td>
<td>Always enabled</td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>1–6</td>
<td>(Reserved)</td>
<td></td>
<td></td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>1–7</td>
<td>(Reserved)</td>
<td></td>
<td></td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>1–8</td>
<td>(Reserved)</td>
<td></td>
<td></td>
<td>48 (OFF)</td>
</tr>
</tbody>
</table>

### Table 38-81  Memory Switch 2

<table>
<thead>
<tr>
<th>Memory Switch</th>
<th>Function</th>
<th>Setting Value — 48 (OFF)</th>
<th>Setting Value — 49 (ON)</th>
<th>Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>2–1 to 2–8</td>
<td>(Reserved)</td>
<td></td>
<td></td>
<td>48 (OFF)</td>
</tr>
</tbody>
</table>

### Table 38-82  Memory Switch 3

<table>
<thead>
<tr>
<th>Memory Switch</th>
<th>Function</th>
<th>Setting Value — 48 (OFF)</th>
<th>Setting Value — 49 (ON)</th>
<th>Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>3–1 to 3–8</td>
<td>(Reserved)</td>
<td></td>
<td></td>
<td>48 (OFF)</td>
</tr>
</tbody>
</table>

### Table 38-83  Memory Switch 4

<table>
<thead>
<tr>
<th>Memory Switch</th>
<th>Function</th>
<th>Setting Value — 48 (OFF)</th>
<th>Setting Value — 49 (ON)</th>
<th>Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>4–1 to 4–8</td>
<td>(Reserved)</td>
<td></td>
<td></td>
<td>48 (OFF)</td>
</tr>
</tbody>
</table>

### Table 38-84  Memory Switch 5

<table>
<thead>
<tr>
<th>Memory Switch</th>
<th>Function</th>
<th>Setting Value — 48 (OFF)</th>
<th>Setting Value — 49 (ON)</th>
<th>Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>5–1</td>
<td>Sets USB power-saving function *1</td>
<td>Enabled</td>
<td>Disabled</td>
<td>48 (OFF)</td>
</tr>
</tbody>
</table>
### Table 38-84 (Cont.) Memory Switch 5

<table>
<thead>
<tr>
<th>Memory Switch</th>
<th>Function</th>
<th>Setting Value — 48 (OFF)</th>
<th>Setting Value — 49 (ON)</th>
<th>Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>5–2</td>
<td>Sets recovery conditions from receive buffer BUSY (Enabled when the receive buffer capacity is set to 4 KB)</td>
<td>Recovers when the remaining receive buffer capacity becomes 256 bytes</td>
<td>Recovers when the remaining receive buffer capacity becomes 138 bytes</td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>5–3</td>
<td>Selects paper sensors to output paper-end signals (default value of ESC c 3)</td>
<td>Roll paper end sensor enabled; roll paper near-end sensor enabled</td>
<td>Disabled</td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>5–4</td>
<td>Sets error signal</td>
<td>Enabled</td>
<td>Disabled</td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>5–5</td>
<td>(Reserved)</td>
<td>—</td>
<td>—</td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>5–6</td>
<td>(Reserved)</td>
<td>—</td>
<td>—</td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>5–7</td>
<td>(Reserved)</td>
<td>—</td>
<td>—</td>
<td>48 (OFF)</td>
</tr>
<tr>
<td>5–8</td>
<td>(Reserved)</td>
<td>—</td>
<td>—</td>
<td>48 (OFF)</td>
</tr>
</tbody>
</table>

*1: Valid only when the USB interface communication condition is set to the vendor-defined class and the system configuration is set so that the USB driver can support the USB power-saving function.

### Function 11

**<Function 11> GS (E pL pH fn a d1...dk) (fn = 11)**

**[Name]**
Set the configuration item for the serial interface

**[Format]**
ASCII GS (E pL pH fn a d1 ... dk)

**[Hex]**
1D 14 0F 66 39 (39 = C9 hex)

**[Range]**
3 ≤ (pL + pH x 256) ≤ 65535
0 ≤ pL ≤ 255, 0 ≤ pH ≤ 255

**[Default (upon shipment)]**

* **[ANK model, Japanese model, South Asia model]***
  * [Traditional Chinese model, Simplified Chinese model]
  * [ANK model (T86T command compatibility mode enabled)]

### Function 11 — Descriptions

- Sets the configuration item for the serial interface specified by a to the values specified by d.

<table>
<thead>
<tr>
<th>a</th>
<th>Configuration Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Transmission speed</td>
</tr>
<tr>
<td>2</td>
<td>Parity</td>
</tr>
<tr>
<td>3</td>
<td>Handshaking</td>
</tr>
<tr>
<td>4</td>
<td>Bit length</td>
</tr>
</tbody>
</table>

- Transmission speed settings (a = 1)
### Transmission Speed

<table>
<thead>
<tr>
<th><code>d1...dk</code></th>
<th>Transmission Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;2400&quot;</td>
<td>2400 bps</td>
</tr>
<tr>
<td>&quot;4800&quot;</td>
<td>4800 bps</td>
</tr>
<tr>
<td>&quot;9600&quot;</td>
<td>9600 bps</td>
</tr>
<tr>
<td>&quot;19200&quot;</td>
<td>19200 bps</td>
</tr>
<tr>
<td>&quot;38400&quot;</td>
<td>38400 bps</td>
</tr>
<tr>
<td>&quot;57600&quot;</td>
<td>57600 bps</td>
</tr>
<tr>
<td>&quot;115200&quot;</td>
<td>115200 bps</td>
</tr>
</tbody>
</table>

- **Parity settings (a = 2)**

<table>
<thead>
<tr>
<th><code>d1</code></th>
<th>Parity</th>
</tr>
</thead>
<tbody>
<tr>
<td>48</td>
<td>None</td>
</tr>
<tr>
<td>49</td>
<td>Odd</td>
</tr>
<tr>
<td>50</td>
<td>Even</td>
</tr>
</tbody>
</table>

- **Handshaking settings (a = 3)**

<table>
<thead>
<tr>
<th><code>d1</code></th>
<th>Handshaking</th>
</tr>
</thead>
<tbody>
<tr>
<td>48</td>
<td>DTR/DSR control</td>
</tr>
<tr>
<td>49</td>
<td>XON/XOFF control</td>
</tr>
</tbody>
</table>

- **Bit length settings (a = 4)**

<table>
<thead>
<tr>
<th><code>d1</code></th>
<th>Bit Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>55</td>
<td>7 bits</td>
</tr>
<tr>
<td>56</td>
<td>8 bits</td>
</tr>
</tbody>
</table>
You can print the logo of your Enterprise, property, or revenue center on guest checks, customer receipts, and credit card vouchers. Simphony only supports monochrome bitmap image files. Use Microsoft Paint to convert an image to a monochrome bitmap. Adhere to the following rules governing the size of your logo:

- The image area must not exceed 98,304 pixels. (Keep in mind that a logo that is 512 x 384 pixels exceeds 98,304 pixels.)
- The image width must not exceed 512 pixels.
- The image height must not exceed 384 pixels.
- The bitmap file must not exceed 8 kilobytes in size.

Simphony does not support logo printing on printers with multi-language cards.

**Note:**

At this time, support for logo printing on OPOS printers only applies to the Simphony 18.2.3 release.

Complete the following tasks to set up logo printing:

- Upload a logo to Simphony
- Assign a logo to guest checks, customer receipts, and credit card vouchers
- Set the printer to print the logo
- Ensure that the DIP settings for the printer’s buffer are set to the higher value to accommodate the logo’s additional data

For more information on DIP settings, please refer to the following: Printer DIP and Memory Switch Settings

- Uploading a Logo to Simphony
- Assigning a Logo to Guest Checks and Customer Receipts

### Uploading a Logo to Simphony

1. Select the Enterprise level, click **Configuration**, and then click **Print Logos**.
2. Insert a new record, and then double-click it to open in form view.
3. Click **Load Image**.
4. Select the image, and then click **Open** to upload it to Simphony. After the logo uploads, an image preview appears.
5. Alternately, you can copy the image to your clipboard, and then click **Paste Image** to upload it to Simphony.
6. Click **Save**.

- **Assigning a Logo to Guest Checks and Customer Receipts**

**Assigning a Logo to Guest Checks and Customer Receipts**

1. Select the Enterprise, property, revenue center, or zone, click **Descriptors**, and then click **Guest Check Headers**.

2. Select a check box in the **Use Logo** column.

   If you select **Use Logo** for an existing record that has content in the **Text** column, that text no longer appears on printed guest checks and customer receipts.

3. Click the ellipsis point (...) button in the **Logo** column, select the image you uploaded, and then click **OK**.

4. Click **Save**.

5. To assign the logo to customer receipts and guest check trailers, repeat these steps, selecting the **Guest Check Trailers** and **Customer Receipt Headers** modules in Step 1.

   You must also select **28 - Print Guest Check Trailer on Fast Transaction Customer Receipt** for tender records from the Tender/Media options. If you do not set this option, trailers do not print on customer receipts when the tender is used to close a fast transaction.

6. Click **Save**.

- **Uploading a Logo to Simphony**
Kitchen or bar staff want to preview orders to get a head start on preparing items that require more prep or cooking time to assist in delivering orders more quickly. Pre-production printing allows servers to send certain menu items to remote printers, prior to finalizing the current round.

Operationally, as servers key in an order, they can select a Pre-Production Chit (Tender/Media Service Total) button to send the pre-production items to remote printers. For easier recognition, pre-production chits are formatted differently than the output of conventional order chits.

Note:
Once an item has been fired via pre-production chit printing, if you add a second item and select pre-production chit printing again, it only fires that second item. The first item does not trigger the re-fire of a pre-production chit.

**Configuring Print Classes for Pre-Production Chits (Release 18.2.3 only)**

To configure and assign printers to a pre-production Print Class:

1. Access the EMC, click the enterprise or property level, select the Configuration tab, and then click the Print Classes module.
2. Insert a new record and enter the name of the pre-production print class in the Name field. For example, Print Pre-Production Chit.
3. Configure settings within the Options section as needed.
4. Select the Routing Group from the drop-down list from the Output section. Typically, enabling the 0 – Use Order Devices routing group suffices for most pre-production chit printing tasks.

**Configuring Tender/Media - Service Total Records for Pre-Production Chits (Release 18.2.3 only)**

**Configuring Menu Item Classes for Pre-Production Chits (Release 18.2.3 only)**

**Configuring a Page Design Button for Pre-Production Chits (Release 18.2.3 only)**

**Example of a Pre-Production Chit (Release 18.2.3 only)**
Configuring Tender/Media - Service Total Records for Pre-Production Chits (Release 18.2.3 only)

To configure Tender/Media - Service Total records for pre-production chit printing:

1. Access the EMC, click the enterprise or property level, select the Configuration tab, and then select the Tender Media module.
2. Insert a new record, and enter the name of the pre-production service total record. For example, Print Pre-Production Chit.
3. From the General Settings section, assign a Privilege Group that allows users to utilize this service total.
4. From the Key Type field, select 2 - Service Total from the drop-down list.
5. Configure the balance of the General tab settings, and then click the Options tab.
6. Click the Printing Options tab, and then scroll down and enable the 98 - Print Pre-Production Chit option.
7. Click the Ops Behavior tab and select 2 - Hold Order as the Tender Media Hold Type from the drop-down list.
8. Configure the balance of this service total record’s settings and Save.

Configuring Menu Item Classes for Pre-Production Chits (Release 18.2.3 only)

To configure Menu Item Classes to generate pre-production chits:

1. Access the EMC, click the enterprise, property, or revenue center level, select the Configuration tab, and then select the Menu Item Classes module.
2. Determine which menu items you want pre-production chit printing to apply, navigate to each of these items assigned Menu Item Class and assign the .
3. From the General tab, select the pre-production print class from the Pre-Production Chit Print Class drop-down list and Save.
Configuring a Page Design Button for Pre-Production Chits (Release 18.2.3 only)

To configure a workstation button to generate pre-production chit printing:

1. Access the EMC, click the enterprise, property, or revenue center level, select the Configuration tab, and then select the Page Design module.

2. On the order entry pages of your choice, add a new button and configure the following fields:
   a. **Legend** - Enter the buttons text.
   b. **Type** - Select Tender/Media, and then select the Print Pre-Production Chit, Tender/Media - Service Total record.
3. Configure the balance of the button’s settings.

4. Click Save.

Example of a Pre-Production Chit (Release 18.2.3 only)

Pre-Production chits are formatted differently than conventional order output to remote printers. The text *TO BE PREPARED* is printed by default on each chit (with the Order Type showing directly under it), just prior to the Dining Course name (if enabled), and then the quantity ordered is printed adjacent to each ordered Menu Item.

**Note:**

If enabled, the Dining Course Name prints and also adheres to the Print Classes settings, whereby if the **4 - On = Red, Off = Black** option is enabled, the Dining Course name prints in red, and prints in black if disabled.

Here is an example of a Pre-Production Chit:
Figure 40-3  Example of a Pre-Production Chit

Printer Name
Employee ID  Employee Name
----------------------------------------
CHK NUMBER
----------------------------------------
* TO BE PREPARED *
Order Type
[Dining Course Name] (if enabled)
Quantity Menu Item Name

[Dining Course Name] (if enabled)
Quantity Menu Item Name
Peripheral devices connect with and relay information to or from Simphony. For example, common POS peripheral devices include magnetic card readers, cash drawers, coin dispensers, printers, pole displays, and scales.

- Cash Drawer Assignment and Unassignment
- Configuring a Cash Drawer
- Coin Dispenser
- Configuring a Coin Dispenser
- Magnetic Stripe Reader
- Installing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices
- Configuring a Magnetic Stripe Reader
- Testing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices
- Barcode Reader Setup Methods
- Configuring a Barcode Reader Using the Barcodes Module Method
- Configuring a Barcode Reader Using the Number Lookup (NLU) Method
- Configuring the 1D/2D Imager Scanner
- Fingerprint Scanning
- Configuring the Biometrics CAL Package Deployment
- Configuring Employee Privileges for the Fingerprint Reader
- Configuring the Touchscreen Home or Sign In Page to Assign Employee Personal Identification Number (PIN)
- Configuring the Workstation Employee Fingerprint Sign In Options
- Scanning a Fingerprint
- Configuring a Scale
- Sales Recording Module (SRM)
- Enabling SRM for a Property
- Configuring SRM Payment Types for Tenders
- Enabling SRM for Printers
- Configuring the Quebec SRM Control Button
- Allowing Employees to Enable and Disable SRM from the Workstation
Cash Drawer Assignment and Unassignment

You can assign a cash drawer in the following ways:

- By workstation
- By workstation operator

Giving multiple employees access to a single cash drawer is less secure than requiring employees to be assigned to a cash drawer.

When you set the option **Assign Cash Drawer By User Workstation** from the Workstations module, workstation operators can assign themselves to a cash drawer using one of the following function keys:

- 848 - Assign Cash Drawer
- 839 - Assign Cash Drawer 1
- 840 - Assign Cash Drawer 2

The following table compares these function keys:

<table>
<thead>
<tr>
<th>848 - Assign Cash Drawer</th>
<th>839 - Assign Cash Drawer 1 and 840 - Assign Cash Drawer 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigns the drawer to the workstation operator who is signed in.</td>
<td>Assigns the drawer to the workstation operator who is signed in.</td>
</tr>
<tr>
<td>If two drawers are used with the workstation, Simphony assigns drawer 1 if both are unassigned. If drawer 1 is assigned, Simphony assigns drawer 2, and vice-versa.</td>
<td>If two drawers are used with the workstation, these keys allow the workstation operator to select the drawer he or she wants to assign. (To offer a choice, you must configure both keys on the touchscreen.)</td>
</tr>
<tr>
<td>Using this key opens the cash drawer.</td>
<td>Using this key does not open the cash drawer.</td>
</tr>
<tr>
<td>If the cash drawer is unassigned, using this key prompts the workstation operator to assign the cash drawer number.</td>
<td>If the cash drawer is unassigned, using this key prompts the workstation operator to assign the cash drawer number, while the top of the screen shows INACTIVE (no one is assigned).</td>
</tr>
<tr>
<td>If a workstation operator attempts to assign the drawer when another workstation operator is already assigned, the following error message appears: All Cash Drawers Currently Assigned.</td>
<td>If the workstation operator attempts to assign the drawer when another workstation operator is already assigned, no error message appears. The top of the screen show NAME (of the person assigned to the drawer). Thus, one person may assign the drawer and override the workstation operator who is already assigned.</td>
</tr>
<tr>
<td>All workstation operators can use this function key.</td>
<td>All workstation operators cannot use this function key.</td>
</tr>
<tr>
<td>At the end of a shift, the workstation operator or a privileged manager needs to unassign the drawer to allow another workstation operator to use the drawer.</td>
<td>At the end of a shift, it is not necessary to unassign the drawer because another workstation operator may override the assigned workstation operator.</td>
</tr>
</tbody>
</table>

The **849 - Unassign Cash Drawer** function key unassigns the drawer from the workstation operator, regardless of whether the workstation operator assigned the
drawer using function 848 or 839/840. All workstation operators can always unassign themselves from a drawer. You can prevent this by removing the Unassign Cash Drawer function key from the touchscreen or restrict its access using a lockout macro.

**Related Topics**

- Configuring a Cash Drawer

## Configuring a Cash Drawer

1. Select the property, click **Setup**, and then click **Workstations**.
2. Double-click the workstation to be used with the cash drawer.
3. Click the **Transactions** tab.
4. Select the number of **Cash Drawers** (0, 1, or 2) that are physically installed at the workstation.
5. In the **Cash Drawer Beep Timeout** field, enter the number of seconds the cash drawer can be open before the workstation begins beeping. If you set this value to 0 (zero), beeping does not occur.
6. In the **Cash Drawer Notify Timeout** field, enter the number of seconds the cash drawer can be open before the workstation posts a message to the journal log file. If you set this value to 0 (zero), the message does not post to the journal log.
7. Click the **Options** tab, and then click the **Hardware/Cash Drawer** subtab.
8. Select the appropriate cash drawer options.

### Table 41-2 Cash Drawer Workstation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require Cash Drawer to be Closed Before New Transaction</td>
<td>Select this option to require the workstation operator to close the cash drawer before beginning a new transaction. Deselect this option to allow transactions to begin while a cash drawer is open.</td>
</tr>
<tr>
<td>Assign Cash Drawer By User Workstation</td>
<td>Select this option to allow workstation operators to assign themselves to the cash drawer using the one of the function keys (848 - Assign Cash Drawer, 839 - Assign Cash Drawer 1, or 840 - Assign Cash Drawer 2). Only the workstation operator assigned to the drawer can open it.</td>
</tr>
<tr>
<td>Use Other Cash Drawer for Other Currency</td>
<td>Select this option if two cash drawers are in use for the workstation and one is dedicated to foreign currency.</td>
</tr>
<tr>
<td>Require Cash Drawer Assignment to Begin Transaction</td>
<td>Select this option to require a workstation operator to have a cash drawer assigned prior to beginning a transaction at the workstation.</td>
</tr>
</tbody>
</table>

9. Click **Save**.

10. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Control Parameters**.
11. Click the **Options** tab.

12. Select the appropriate cash drawer options.

**Table 41-3  Cash Drawer Control Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| 23 - Open Drawer Only if Balance Due is 0.00 | Select this option to prevent a tender/media key from opening the cash drawer unless the balance due is $0.00. Deselect this option to allow a tender/media key to open the cash drawer even if there is a balance due on the transaction.  
If the transaction’s subtotal is $0.00 and you set **36 - Do Not Open Cash Drawer if Subtotal is 0.00**, the setting of option **23** is irrelevant. |
| 33 - Employee ID Required With [No Sale] Key | Select this option to prompt for the signed-on workstation operator’s employee ID after pressing the **No Sale** key. Deselect this option to allow workstation operators to use the **No Sale** key any time a privileged employee is signed on.  
This feature is used by staydown operators (such as bartenders or sales clerks) who typically walk away from the workstation, and by prompting for employee ID, mischievous persons cannot open the drawer. |
| 36 - Do Not Open Drawer if Subtotal is 0.00 | Select this option to prevent the cash drawer from opening for transactions in which the subtotal is $0.00. Deselect this option to allow the cash drawer to open whenever a workstation operator uses a tender/media key that is configured to open the drawer. |
| 42 - Always Open Cash Drawer if Change Due | Select this option to allow the cash drawer to open when there are no tenders on the check that should usually open the drawer.  
The transaction must have change due, and the current tender must not be configured to open the drawer.  
This option is typically used for Tender/Media records such as gift certificates, where change is issued only if the gift certificate exceeds the value of the transaction (thus, the drawer should be opened to issue change), but the drawer remains closed when the gift certificate does not exceed the transaction’s total. |
| 65 - Allow open of Cash Drawer on Service Charge | Select this option to allow the cash drawer to open for transactions where the service charge has a value greater than $0.00, but the subtotal is $0.00.  
If you selected **36 - Do Not Open if Subtotal is $0.00**, you must also select this option to allow the cash drawer to open for service charge only guest checks. |
The cash drawer will always open when using the OpsCheckCashDrawerEvent Extensibility function. When the Extensibility function OpsCheckCashDrawerEvent requests to open a cash drawer, the following cash drawer options are overridden:

- **23 - Open Drawer Only if Balance Due is 0.00**
- **36 - Do Not Open Drawer if Subtotal is 0.00**
- **42 - Always Open Cash Drawer if Change Due**
- **65 - Allow open of Cash Drawer on Service Charge**

13. Click **Save**.

14. Select the Enterprise, click **Configuration**, and then click **Roles**.

15. Select the role type, click the **Operations** tab, and then click the **Miscellaneous** subtab.

16. Select the appropriate options for cash drawer privileges.

### Table 41-4  Cash Drawer Privilege Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>17 - Authorize/Perform unassignment of cash drawer from others</td>
<td>Select this option to allow employees in the employee class to use the <strong>Unassign Cash Drawer</strong> function key to unassign cash drawers from other workstation operators. Do not select this option for every employee; set it only for management employee classes. Setting this option allows workstation operators in the employee class to use function keys <strong>839 - Assign Cash Drawer 1</strong> and <strong>840 - Assign Cash Drawer 2</strong>.</td>
</tr>
<tr>
<td>34 - Authorize Open Cash Drawer Using the [No Sale] Key</td>
<td>Select this option to allow employees associated with the role to open the cash drawer outside of a transaction using the <strong>No Sale</strong> key, and to authorize non-privileged employees to do so.</td>
</tr>
<tr>
<td>88 - Authorize Cash Drawer Reconnection</td>
<td>Select this option to allow employees associated with the role to authorize a cash drawer cable reconnection on a workstation.</td>
</tr>
</tbody>
</table>

17. Click **Save**.

**Related Topics**

- **Cash Drawer Assignment and Unassignment**

## Coin Dispenser

A coin dispenser (sometimes called a coin changer) is a device attached to a workstation that holds coins. A coin dispenser is not assigned to a workstation or server. When connected to a workstation and configured, a cash tender sends commands to the coin dispenser to dispense coins. The coin dispenser controls only the coin portion of a cash transaction. If the customer presents $20.00 to pay a $16.45 guest check, the coin dispenser automatically dispenses $0.55, but the workstation operator must give the remaining $3.00 to the customer.
The coin dispenser hardware varies the coins that are dispensed to avoid depleting a single type of coin. For example, if the device dispenses $0.55 three times in a row, it is probable that both of the following combinations dispense at least once:

- 1 Quarter and 3 Dimes
- 2 Quarters and 1 Nickel

**Related Topics**
- Configuring a Coin Dispenser

**Configuring a Coin Dispenser**

1. Select the property, click **Setup**, and then click **Workstations**.
2. Double-click the workstation to open it in form view.
3. Click the **Devices** tab.
4. From the Peripheral Device Configuration section, click **Add**.
5. From the **Select Peripheral Device Type** drop-down list, select **Coin Dispenser**.
6. Enter the **COM Port**, and then click **OK**.
7. Click **Save**.
8. On the workstation, allow the configuration change to download to the POS client.
9. Connect the coin dispenser’s serial cable to the appropriate COM port.
10. Restart the workstation.
11. If the workstation is a Win32 client, modify the device settings for the COM port to match the COM Port you set in Step 6.
    
    Ensure that a workstation with an attached coin dispenser does not have a printer or other device configured for the same COM port as the coin dispenser. Having another device connected but not in use can cause problems with coin dispenser operations.
12. Restart the workstation.
13. Verify that the coin dispenser is connected and ready for operation:
    a. Sign on to the workstation as an employee with PMC privileges.
    b. Launch PMC, and then click the **Functions** tab.
    c. Click **Device Diagnostics**.
    d. Click **Dispense Change**. The coin dispenser dispenses a penny when successfully connected.

**Related Topics**
- Coin Dispenser

**Magnetic Stripe Reader**

Workstation operators scan magnetic stripe cards using a magnetic stripe reader (MSR) attached to a workstation. Magnetic cards are commonly used as:

- Credit Cards
Installing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices

The MSR sleeve for Oracle MICROS Tablet E-Series 8-inch and 11-inch devices supports Transaction Vault Second Generation (TV2G) and data encryption.

Before installing the MSR sleeve driver for Oracle MICROS Tablet E-Series devices, ensure that the device has the following prerequisite requirements:

- Microsoft Windows 8.1 operating system
- Microsoft .NET Framework 4.0 or later

Contact Oracle Support to obtain the VeriFone E23x card reader driver before you begin the following steps.

1. If a previous version of the driver exists, uninstall the old driver components before installing the new driver.
   a. From the Control Panel, select Programs and Features.
   b. Uninstall the following components:
      - E23x Driver Installer versions
      - E23x OPOS DLL
      - Microsoft POS for .NET 1.12
      - OPOS Common Control Objects 1.13.001

2. Run the E23xDriverInstaller_1.2.0.exe file, and click Yes each time you are prompted.

3. Run the E23x_OPOS_DLL_Install_1.5.2.0.exe file, and click Yes each time you are prompted.

   The driver and OPOS DLL installation configures a default OPOS device name for the magnetic stripe reader (MSR). Configure Simphony to use the exact name with the MSR.

Configuring a Magnetic Stripe Reader

1. Select the property, click Setup, and then click Workstations.
2. Double-click the workstation to be used with the MSR.
3. Click the Options tab, and then click the Display/Security subtab.
4. Select the appropriate MSR options.

<table>
<thead>
<tr>
<th>Table 41-5 MSR Workstation Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>12 - Mag Card Entry Required for Employee ID</td>
</tr>
<tr>
<td>50 - Mag Card or Fingerprint Scan Required for Employee ID</td>
</tr>
<tr>
<td>51 - Mag Card and Fingerprint Scan Required for Employee ID</td>
</tr>
</tbody>
</table>

5. If you are using an encrypted MSR (for example, the MSR sleeve for Oracle MICROS Tablet E-Series 8-inch and 11-inch devices with Transaction Vault Second Generation (TV2G)), complete the following steps:
   a. Click the Hardware/Cash Drawer subtab.
   b. Select 55 - Enable Encrypted Magnetic Stripe Reader Support.
      
      After you select this option, you cannot turn it off. Before setting this option, ensure that the credit card processor or gateway supports encryption functionality.

6. Click the Devices tab.

7. Click Add, and then select a magnetic stripe reader from the Select Peripheral Device Type drop-down list.

8. Select the COM Port Settings (if necessary), and then click OK.

9. Click Save.

Related Topics
- Magnetic Stripe Reader
- Testing the MSR Sleeve for Oracle MICROS Tablet E-Series 8 and 11 Inch Devices

Testing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices

You can test the MSR swiper functionality after you install the driver and configure the MSR.

1. Copy the `e23xservice.exe` and `e23xD.dll` files to the [Drive Letter]:\Program Files \Verifone\E23xOPOS folder.
2. Close the ServiceHost application.

3. Run `e23xservice.exe`.

4. In the OPOS MSR section of the dialog box, select the following options:
   - Open
   - Claim
   - Enable
   - D. Ev (Data Events)

   After each successful swipe attempt, the D. Ev option is deselected.

5. Swipe the magnetic card. If the card swipe was successful, a message appears with the card data.

Related Topics
- Installing the MSR Sleeve for Oracle MICROS Tablet E-Series 8-Inch and 11-Inch Devices
- Configuring a Magnetic Stripe Reader

Barcode Reader Setup Methods

A barcode is an optical machine-readable representation of data. Barcodes are used to quickly order items. Workstation operators scan barcodes using barcode scanners attached to workstations. When a barcode is scanned, the workstation software processes the data and matches it with a menu item configured in the Simphony database.

The following two methods allow you to configure barcode menu item ordering:
- Use the Barcodes module from the EMC
- Use the number lookup (NLU) method

The following table outlines the differences between the two methods:

<table>
<thead>
<tr>
<th>Barcodes Module Method</th>
<th>NLU Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greater configuration flexibility</td>
<td>Less flexible configuration</td>
</tr>
<tr>
<td>More complex configuration</td>
<td>Simplified configuration</td>
</tr>
<tr>
<td>Associate many different barcodes with the same menu item (for example, pricing chewing gum items the same)</td>
<td>Not supported</td>
</tr>
<tr>
<td>Associate two different prices of one definition with different barcodes (for example, small or large coffee)</td>
<td>Not supported</td>
</tr>
<tr>
<td>Allows up to 14-digit barcode</td>
<td>Allows up to 12-digit barcode</td>
</tr>
</tbody>
</table>

Related Topics
- Configuring a Barcode Reader Using the Barcodes Module Method
- Configuring a Barcode Reader Using the Number Lookup (NLU) Method
Configuring a Barcode Reader Using the Barcodes Module Method

1. Select the Enterprise, property, or revenue center click **Configuration**, and then click **Barcodes**.

2. Insert a barcode record.

3. In the **Barcode** column, enter the numeric value that the barcode represents.

4. Click the ellipsis point (…) button in the **Master** column, select the master menu item to be ordered when the barcode is entered, and then click **OK**.

5. In the **Definition** column, select the Menu Item Definition (belonging to the selected Menu Item Master) to be ordered when the barcode is entered. If you select **0 - All Definitions**, the workstation determines which definition to order at the time the barcode is entered, based on active Menu Levels and other criteria.

   This column is only active when you set the Menu Item Master column to a value other than **0 - None**.

6. In the **Price #** column, select the Menu Item Price (belonging to the selected Menu Item Definition) to be ordered when the barcode is entered. If you select **0 - All Prices**, the workstation determines which price to order at the time the barcode is entered, based on active Menu Levels and other criteria.

   This column is only active when you set the Menu Item Definition column to a value other than **0 - All Definitions**.

7. In the **Alternate Price** column, enter the price to charge for the item when the barcode is entered.

   This value is used only when you set a value greater than 0.00; if the value is 0.00, the price from the Menu Item Price record is used.

8. In the **Alternate Prep Cost** column, enter the prep cost to use for the item when it is ordered by the barcode.

   This value is used only when you set a value greater than 0.00; if the value is 0.00, the prep cost from the Menu Item Price record is used.

9. Click **Save**.

10. Select the Enterprise or property, click **Setup**, and then click **Barcode Format Sets**.

11. Insert a barcode format set record, and then double-click it.

12. Click **Add**.

13. In the **Input Length** field, enter the number of digits in the scanned barcodes.

14. In the **Returned Start** field, enter the first digit to use in the numeric value to return.

15. In the **Returned Length** field, enter the number of digits to read as the numeric value to return.

16. Click **Save**.

17. Select the property, click **Setup**, and then click **Workstations**.

18. Double-click the workstation to be used with the barcode reader.
19. Click the Transactions tab.

20. Select the Barcode Format Set for the workstation to use.
   The Barcode Format Set determines how the workstation reads barcodes of various lengths.

21. Click the Devices tab.

22. Click Add, and then select the barcode reader from the Select Peripheral Device Type drop-down list.

23. Select the COM Port Settings (if necessary), and then click OK.

24. Click Save.

25. Select the revenue center, click Setup, and then click RVC Parameters.

26. From the Barcode Menu Item NLU Group # drop-down list, select the number lookup (NLU) that is reserved for barcodes.
   When you select a value other than 0 - None, workstation operators can order any Menu Item Definition associated with the Barcode Group by scanning or manually entering a barcode. For example, if you set this field to 3 - Barcode, the menu item NLU Group 3 function key can be added to a touchscreen, and the workstation operator can manually enter a barcode and press the key to order the item.

27. Click Save.

Related Topics

• Configuring a Barcode Reader Using the Number Lookup (NLU) Method

Configuring a Barcode Reader Using the Number Lookup (NLU) Method

1. Select the Enterprise, property, revenue center, or zone, click Descriptors, and then click NLU Names.

2. Enter the name of the NLU descriptor (for example, Barcode Items) in the Text field.

3. Click Save.

4. Select the revenue center, click Setup, and then click RVC Parameters.

5. From the Barcode Menu Item NLU Group # drop-down list, select the number lookup (NLU) that you created in Step 2.

6. Click the Options tab.

7. To perform a check digit verification (CDV) on every NLU entry, select 33 - Enable UPC Algorithm for Barcode NLU Entries.

8. To expand barcodes entered in 8-digit UPC-E format to 12-digit UPC-A format, select 34 - Convert UPC-E to UPC-A. If you selected option 33 in Step 7, select option 34 as well.

9. Click Save.
10. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Menu Item Maintenance.

11. Search for and select a menu item definition record for a menu item that can be ordered by barcode.

12. Select the NLU Group from the drop-down list. This is the same NLU that you created in Step 2.

13. Enter the barcode value for the menu item in the NLU Number field.

14. Click Save.

• Configuring a Barcode Reader Using the Barcodes Module Method

Related Topics
• Barcode Reader Setup Methods

Configuring the 1D/2D Imager Scanner

You can configure the 1D/2D Imager Scanner for use with the Oracle MICROS Workstation 6 Series and Oracle MICROS Compact Workstation 310.

1. Select the property, click Setup, and then click Workstations.

2. Double-click the workstation record to open it.

3. Click the Devices tab.

4. Click Add in the Peripheral Device Configuration section.

5. From the Select Peripheral Device Type drop-down list, select Generic Barcode Reader.

6. Under COM Port Settings, select the COM PORT.

   The default COM Port setting is COM14.

   To find the appropriate COM number, navigate to the workstation device manager and locate the COM number associated with the workstation.

7. Click Save.

8. After configuration in EMC, update the workstation.

9. Following the update, shut down the workstation, and then connect the scanner.

   The workstation should always be turned off when connecting or disconnecting a scanner.

10. Restart the workstation.

11. Verify that the scanner is successfully initialized with the workstation.

Fingerprint Scanning

This section describes fingerprint scanning. Fingerprint scanning provides greater security by verifying an employee’s identify. You can use an external USB fingerprint reader with the following devices to scan fingerprints:

• Oracle MICROS Tablet E-Series
• Oracle MICROS Workstation 6 Series
You can require employees to scan fingerprints when performing the following operations:

- Signing in to a workstation
- Clocking in and out
- Authorizing privileged operations

Privileged employees can perform the following actions:

- Enroll themselves and other employees' fingerprints in Simphony
- Register up to ten different fingers (in the event that employee digits become incapacitated (cut, removed, or bandaged))

At registration, the employee places a finger on the fingerprint reader. The reader scans the fingerprint and captures its characteristics (an array of pixels) as Fingerprint Image Data (FID). The reader then extracts fingerprint features as Fingerprint Minutiae Data (FMD) and creates a data record that is stored in database tables in the cloud and in the POS clients where the employee signs in. At sign-in, the reader captures fingerprint data and then uses FMD records to search the local database for a match. If a match is found, the action is performed (such as sign-in). The system does not store pictures, photographs, or images of the fingerprint. There is no way to reconstruct the fingerprint using the stored data.

Auditors can determine whether an employee performed an authorization using a fingerprint reader, manual entry, or magnetic card swipe.

Simphony does not store the fingerprint image. Simphony uses only a mathematical identification of the image. The data stored is similar to a hash of the fingerprint and cannot be used to reconstruct the fingerprint. Collecting or enrolling employee fingerprints is a privileged operation, typically requiring manager authorization. The data is protected at rest and in transit within the Simphony application using the same approaches that all sensitive data is protected. When an employee is deleted from the system, the stored fingerprint data for that employee is also deleted. This applies to all storage at the enterprise and on premise. In current versions, the timing of when an employee is deleted from the system is determined by when a privileged user manually deletes the employee record in EMC.

**Related Topics**

- Configuring the Biometrics CAL Package Deployment
- Configuring Employee Privileges for the Fingerprint Reader
- Configuring the Touchscreen Home or Sign In Page to Assign Employee Personal Identification Number (PIN)
- Configuring the Workstation Employee Fingerprint Sign In Options
- Scanning a Fingerprint

### Configuring the Biometrics CAL Package Deployment

1. Select the Enterprise level, click **Setup**, and then click **CAL Packages**.
2. Select Biometrics from the navigation tree.
3. Click the Deployment Schedules tab.
4. Click Add Deployment.
5. Select 1 - Property/Enterprise from the Deployment Type drop-down list.
6. Select 0 - Enterprise from the Property field.
7. Select 0 - Install from the Action to Take drop-down list.
8. Click Save.

- Configuring Employee Privileges for the Fingerprint Reader
- Configuring the Touchscreen Home or Sign In Page to Assign Employee Personal Identification Number (PIN)
- Configuring the Workstation Employee Fingerprint Sign In Options
- Scanning a Fingerprint

Related Topics
- Fingerprint Scanning

Configuring Employee Privileges for the Fingerprint Reader

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Select the role type, click the Operations tab, and then click the PMC General/Reports subtab.
3. To allow employees associated with the role to open the Property Management Console (PMC) using function key 300, select 30001 - Run PMC.
4. Click the PMC Procedures subtab.
5. Select 30055 - Assign Employee Fingerprint Scan and 30052 - Assign Employee PIN.
6. Click Save.

- Configuring the Biometrics CAL Package Deployment
- Configuring the Touchscreen Home or Sign In Page to Assign Employee Personal Identification Number (PIN)
- Configuring the Workstation Employee Fingerprint Sign In Options
- Scanning a Fingerprint

Related Topics
- Fingerprint Scanning

Configuring the Touchscreen Home or Sign In Page to Assign Employee Personal Identification Number (PIN)

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Open the Home or Sign In page.
3. On the **Edit** tab, click **Button**.
4. On the **General** subtab, enter **Assign PIN** in the **Legend** field.
5. Select **Function** from the **Type** drop-down list.
6. Click the black arrow directly beneath the **Type** drop-down list, and then select **Assign Employee PIN**.
7. Position and size the button on the page. Use the Style arrow to change the color.
8. Click **Save**.

- Configuring the Biometrics CAL Package Deployment
- Configuring Employee Privileges for the Fingerprint Reader
- Configuring the Workstation Employee Fingerprint Sign In Options
- Scanning a Fingerprint

**Related Topics**
- Fingerprint Scanning

### Configuring the Workstation Employee Fingerprint Sign In Options

1. Select the property, click **Setup**, and then click **Workstations**.
2. Double-click the workstation to use with a fingerprint reader.
3. Click the **Options** tab.
4. Select the appropriate security options as described in the following table.

**Table 41-7 Employee Security Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Selecting This Option Requires That All Employees ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>47 - Fingerprint Scan Required for Employee ID</td>
<td>Scan a fingerprint.</td>
</tr>
<tr>
<td>48 - Employee ID or Fingerprint Scan Required for Employee ID</td>
<td>Scan a fingerprint or enter the employee ID number.</td>
</tr>
<tr>
<td>49 - Employee ID and Fingerprint Scan Required for Employee ID</td>
<td>Scan a fingerprint and enter the employee ID number.</td>
</tr>
<tr>
<td>50 - Mag Card or Fingerprint Scan Required for Employee ID</td>
<td>Scan a fingerprint or swipe an employee ID card.</td>
</tr>
<tr>
<td>51 - Mag Card and Fingerprint Scan Required for Employee ID</td>
<td>Scan a fingerprint and swipe an employee ID card.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

- Configuring the Biometrics CAL Package Deployment
- Configuring Employee Privileges for the Fingerprint Reader
Scanning a Fingerprint

You can scan (also called enroll) a fingerprint using a workstation or from the EMC.

If you upgrade Simphony to version 2.9.1 or later, you must deploy the Biometrics 5.0 CAL package, and then re-enroll fingers with an Oracle MICROS or DigitalPersona fingerprint reader. To re-enroll, attach an Oracle MICROS or DigitalPersona fingerprint reader to the workstation, scan an already enrolled finger to sign on to the workstation, and then click OK at the prompt to re-enroll.

1. To scan (initially enroll) a fingerprint using a workstation:
   a. Sign on to the workstation as an employee with the proper role privileges, using an employee ID.
   b. Click the PMC button, and then click the Functions tab.
   c. Click the Edit Employee PIN function.
   d. Select the employee whose fingerprints need to be scanned.
   e. Click the Enroll Fingerprint button.
   f. Follow the prompts to enroll up to three fingers for one employee. Click Yes at the prompt to scan the same finger four times, or click No to return to the Select Employee dialog.
   g. Place the finger to scan on the fingerprint reader, and then remove it when the scan is complete. Each finger is scanned four times. The scanner flashes while scanning and remains lit after the scan is complete. Repeat this step for each finger.

2. To scan (initially enroll) a fingerprint using the EMC:
   a. Select the Enterprise, property, or revenue center, click Configuration, and then click Employee Maintenance.
   b. Search for and select the employee record.
   c. On the General subtab, click the Fingerprint Enrollment button.
   d. Follow the prompts to enroll one or more fingerprints.

Related Topics
• Fingerprint Scanning
Configuring a Scale

A scale connects to the workstation and is used for menu items that are priced by weight (for example, salad bar). You can configure Simphony to calculate weight in ounces, pounds, or kilograms.

1. Select the property, click Setup, and then click Workstations.
2. Double-click the workstation to open it in form view.
3. Click the Devices tab.
4. From the Peripheral Device Configuration section, click Add.
5. From the Select Peripheral Device Type drop-down list, select Scale (Serial).
6. Enter the COM Port to which the scale connects.
7. Select the following settings, and then click OK:
   - Baud Rate: 9600
   - Parity: E
   - Data Bits: 7
   - Stop Bits: 1
8. Click the Options tab, and then click the Hardware/Cash Drawer subtab.
9. Select 13 - Enable Scale Interface to allow communication between the workstation and scale.
10. (Optional) If you are using an Oracle MICROS Tablet E-Series, click the Display/Security subtab, and then deselect 39 - Floating tablet.
11. Click Save.
12. On the workstation, allow the configuration change to download to the POS client.
13. Connect the scale’s serial cable to the workstation’s serial COM port.
14. Connect the scale’s power cord to the outlet.
15. Restart the workstation.
16. Verify that the scale is connected and ready for operation:
   a. Sign on to the workstation as an employee with PMC privileges.
   b. Launch PMC, and then click the Functions tab.
   c. Click Device Diagnostics.
   d. Click Get Scale Weight.
   e. Place a weighed menu item on the scale and add the menu item to a guest check.

• Setting the Tare Weight for a Menu Item
• Configuring a Weighed Menu Item

Related Topics
• Weighed Menu Items
Sales Recording Module (SRM)

An SRM is a microcomputer designed to be connected to a cash register or POS system. It records transaction information such as sales and tax data in a secure memory. After data transmission begins, the SRM device sends the necessary information to a printer which prints a customer receipt with a barcode and information about the restaurant. The SRM is used to produce reports such as a Periodic Sales Summary Report which contains information on sales and transactions carried out over a given period.

Restaurant owners who are also a Quebec Sales Tax (QST) registrant must produce customer receipts using an SRM device and submit a receipt to the customer upon sale of a meal.

Related Topics

- Enabling SRM for a Property
- Configuring SRM Payment Types for Tenders
- Enabling SRM for Printers
- Configuring the Quebec SRM Control Button
- Allowing Employees to Enable and Disable SRM from the Workstation

Enabling SRM for a Property

1. Select the property, click Setup, and then click Property Parameters.
2. On the Options tab, select 38 - Enable Sales Recording Module, and then click Save.

- Configuring SRM Payment Types for Tenders
- Enabling SRM for Printers
- Configuring the Quebec SRM Control Button
- Allowing Employees to Enable and Disable SRM from the Workstation

Related Topics

- Sales Recording Module (SRM)

Configuring SRM Payment Types for Tenders

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Tender/Media.
2. Double-click a Tender Media record to open it.
3. On the General tab, select the appropriate SRM Payment Type for the tender.

The SRM payment types are:

- 1 - ARG: Select this option for cash payments.
• **2 - CRE**: Select this option for credit card payments.
• **3 - DEB**: Select this option for Canadian debit card payments.
• **4 - AUT**: Select this option for other payment types such as gift cards.
• **5 - PKG**: Select this option for full payments where the check value posts to a third party system.

4. **If you selected SRM payment type 5 - PKG**, click the **Options** tab, click the **Taxing Options** subtab, and then click **Select All** to exempt all taxes from the tender.

   If you do not exempt all taxes, they will post both to the SRM as well the third-party application, resulting in duplicate tax entries.

5. **Click the Options tab**, click the **Printing Options** subtab, and then select the following options:
   - **8 - Print Customer Receipt**
   - **21 - Print Summary Totals**
   - **22 - Print Check Trailer**
   - **23 - Print Check on Demand**
   - **28 - Print Guest Check Trailer on Fast Transaction Customer Receipt**

6. **To have the tender print a special/duplicate receipt for the merchant**, click the **Miscellaneous Options** subtab, and then select **84 - Quebec SRM Duplicate**.

   The printed receipt does not include a barcode. This option is used with the Quebec SRM Printer type.

   When option 84 is enabled for the assigned **Default Reprint Check Tender/Media**, the system does not print barcodes on receipts for split checks.

7. Click **Save**.

8. Repeat Steps 2 through 7 for all tenders that you have configured.

• **Enabling SRM for a Property**
• **Enabling SRM for Printers**
• **Configuring the Quebec SRM Control Button**
• **Allowing Employees to Enable and Disable SRM from the Workstation**

### Related Topics

- **Sales Recording Module (SRM)**

---

**Enabling SRM for Printers**

1. **Select the property**, click **Setup**, and then click **Printers**.
2. **Double-click the record for a printer that has an SRM device attached**, select **Quebec SRM Device**, and then click **Save**.
3. Repeat Step 2 for all printers that have an SRM device.

• **Enabling SRM for a Property**
• **Configuring SRM Payment Types for Tenders**
Configuring the Quebec SRM Control Button

You can configure a touchscreen button to allow workstation operators to enable and disable the SRM device locally through the POS client.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Double-click the page on which you want the button to appear on the workstation.
3. Insert a new button.
4. On the General tab, select Function as the Type, and then click the right arrow directly beneath the Type drop-down menu.
5. Select Fiscal from the Type pane, select Quebec SRM Control from the Results pane, and then click OK.
6. Enter a Legend, and click Save.

Allowing Employees to Enable and Disable SRM from the Workstation

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Double-click the role type record (for example, administrator, manager or server).
3. Click the Operations tab, click the Miscellaneous sub-tab, scroll down to Miscellaneous Options, and then select 162 - Authorize/Use Quebec SRM Control Function.
4. Click Save.
Related Topics

- Sales Recording Module (SRM)
Reporting

Various Simphony reports are accessible from Oracle Hospitality Reporting and Analytics, and at the workstation. Reporting and Analytics reports provide access to Enterprise, property, zone, and revenue center information. Workstation reports provide access to property and revenue center totals. You can assign privileges to allow employees to run reports.

- Allowing Employees to Run Reports
- List of Workstation PMC Reports
- Configuring Employee Privileges for Oracle Hospitality Reporting and Analytics
- Configuring the Log Files for Oracle Hospitality Reporting and Analytics
- Viewing Move History Logs
- Configuring Data Retention Limits

Allowing Employees to Run Reports

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Select the role type, click the Operations tab, and then click the PMC General/Reports sub-tab.
3. Select 30001 - Run PMC to allow employees associated with the role to launch the Property Management Console (PMC) on the workstation using Function Key 300, Launch PMC.
4. Select 10022 - Run PMC Reports in Another Revenue Center to allow employees associated with the role to run PMC Autosequences (Reports) for revenue centers other than the revenue center to which they are assigned.
5. Click the Ad Hoc Reports tab.
6. From the Report Options section, select the reports you want employees to run.
7. Click Save.

- Configuring Employee Privileges for Oracle Hospitality Reporting and Analytics
- Configuring the Log Files for Oracle Hospitality Reporting and Analytics

Related Topics
- List of Workstation PMC Reports

List of Workstation PMC Reports

Authorized employees can run the following Property Management Console (PMC) reports when the workstation is in online mode:
Table 42-1  PMC Reports in Online Mode

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Report</td>
<td>Provides financial reporting for a property, revenue center, or employee.</td>
</tr>
<tr>
<td></td>
<td>The Employee Financial Report is based on all sales-related entries, such as checks opened, menu items ordered, and the number and amount of service charges, discounts, and tenders applied. You can use this report to balance the server's bank, and to track individual performance.</td>
</tr>
<tr>
<td>Employee Open Check Report</td>
<td>Provides a list of all open checks belonging to an employee at the time the report is taken. Checks appear in the following order: employee, property or revenue center, and event.</td>
</tr>
<tr>
<td>Employee Closed Check Report</td>
<td>Provides a list of all checks that have been closed by an employee, including reopened checks that were closed again and checks closed as memo checks. In addition, special symbols on the report indicate whether the check was transferred, re-opened, split, or added. Checks appear in the following order: employee, property or revenue center, and event.</td>
</tr>
<tr>
<td>Employee Tip Report</td>
<td>Provides a list of tippable sales in the form of gross receipts from Food and Beverage, charge tips, service charges, tips paid, direct and indirect tip declaration, and percent of tips to sales.</td>
</tr>
<tr>
<td>Employee Labor Detail Report</td>
<td>Provides an account of work performed by each employee. The report includes the dates, times, and job rates of each clock-in and clock-out, the total hours of regular and overtime worked at each job code, and the gross pay earned.</td>
</tr>
<tr>
<td>Employee Labor Summary Report</td>
<td>Provides a summary of the regular and overtime hours worked by each employee at each of their assigned pay rates.</td>
</tr>
<tr>
<td>Cashier Financial Report</td>
<td>Provides financial information for each cashier, including tenders and tips paid.</td>
</tr>
<tr>
<td>Major Group Sales Report</td>
<td>Provides sales totals for each major group.</td>
</tr>
<tr>
<td>Family Group Sales Report</td>
<td>Provides sales totals for each family group.</td>
</tr>
<tr>
<td>Menu Item Summary Report</td>
<td>Provides a list of all menu items.</td>
</tr>
<tr>
<td>Menu Item Sales Report</td>
<td>Provides sales totals for each menu item.</td>
</tr>
<tr>
<td>Time Period Detail Report</td>
<td>Shows each time period as a full report, with a similar format to a system financial report (sales, check profiles, tracking group).</td>
</tr>
<tr>
<td>Time Period Summary Report</td>
<td>Lists each time period with sales information.</td>
</tr>
<tr>
<td>Serving Period Financial Report</td>
<td>Provides financial reporting by serving period.</td>
</tr>
</tbody>
</table>
Table 42-1  (Cont.) PMC Reports in Online Mode

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Sales Report</td>
<td>Provides sales totals for each table.</td>
</tr>
<tr>
<td>Clock-in Status Report</td>
<td>Provides a list of employees who are currently clocked in or on a break.</td>
</tr>
<tr>
<td>Labor Availability Report</td>
<td>Provides a count of all employees clocked in or on break as of the time the report is taken.</td>
</tr>
<tr>
<td>Job Code Report</td>
<td>Summarizes all employee labor totals by job code.</td>
</tr>
<tr>
<td>Employee Autofire Open Check Report</td>
<td>Provides a list of all checks that are scheduled for autofire at the time the report is run. Checks appear by employee, property or revenue center, and event, and sorted by scheduled date and time.</td>
</tr>
<tr>
<td>Employee Journal Report</td>
<td>Provides a journal of all sales transactions by a specific employee shown in a check detail area.</td>
</tr>
<tr>
<td>Check Journal Report</td>
<td>Provides a journal of all sales transactions in a check detail area.</td>
</tr>
<tr>
<td>Tax Summary Report</td>
<td>Provides a list of tax rates.</td>
</tr>
</tbody>
</table>

Authorized employees can run the following Property Management Console (PMC) reports when the workstation is in offline mode:

Table 42-2  PMC Reports in Offline Mode

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offline Revenue Center Financial Report</td>
<td>Provides financial reporting for a revenue center or employee.</td>
</tr>
<tr>
<td>Offline Cashier Financial Report</td>
<td>Provides financial information for each cashier, including tenders and tips paid.</td>
</tr>
<tr>
<td>Offline Employee Open Check Report</td>
<td>Provides a list of all open checks belonging to an employee at the time the report is taken. Checks appear in the following order: employee, revenue center, and event. Unlike the online version of this report, the offline version functions only for a revenue center; it is not possible to take a report for the property.</td>
</tr>
</tbody>
</table>

Related Topics
- Allowing Employees to Run Reports
Configuring Employee Privileges for Oracle Hospitality Reporting and Analytics

1. Select the Enterprise, property, or revenue center, click Configuration, and then click Employee Maintenance.
2. Search for the employee record.
3. Click the Employee Records tab near the lower area of the screen, and then double-click the object number of the appropriate record.
4. Click the Reporting tab to configure an employee's settings as they pertain to logging in to Reporting and Analytics.
5. To grant the employee an active account in the Reporting and Analytics database, select Active.
6. To make the employee a default user for all Reporting and Analytics employee records associated with the same role, select Default User. This allows new employees in Reporting and Analytics who share the same role to use the same settings as this employee.
7. From the Role drop-down list, select Workstation Report.
8. Click Save.


- Allowing Employees to Run Reports
- Configuring the Log Files for Oracle Hospitality Reporting and Analytics

Related Topics
- List of Workstation PMC Reports

Configuring the Log Files for Oracle Hospitality Reporting and Analytics

1. Select the Enterprise level, click Setup, and then click Enterprise Parameters.
2. Click the mymicros.net tab, and then enter the appropriate information. The following table describes the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logs to Keep</td>
<td>Enter the number of Data Transfer Service (DTS) logs to retain.</td>
</tr>
</tbody>
</table>
Table 42-3 (Cont.) Reporting and Analytics Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Files to Keep (days)</td>
<td>Enter the number of days the application retains error file logs.</td>
</tr>
<tr>
<td>Verbosity</td>
<td>Select the Verbosity level for DTS logging. You should typically set this value to Normal. Set verbose logging to Extended or Super for troubleshooting as these elevated levels create large log files and slow performance.</td>
</tr>
<tr>
<td>mymicros.net Machine Name</td>
<td>Enter the name of the Reporting and Analytics server computer using the format http://[YourReportingAndAnalyticsUrl].</td>
</tr>
<tr>
<td>Enterprise mylabor URL</td>
<td>If DTS uses a different Internet Protocol (IP) address to connect to Oracle Hospitality Labor Management, enter the URL. Use the format http://[Name or IP address of the Reporting and Analytics portal server]. If you leave this field blank, DTS uses the Reporting and Analytics machine name to post Labor Management. Workstations do not use this URL.</td>
</tr>
<tr>
<td>Organization ID</td>
<td>Do not change this value unless instructed by your Oracle representative. This field represents the Enterprise organization ID used for reporting to Oracle Hospitality Reporting and Analytics.</td>
</tr>
<tr>
<td>17 - Send selected translations to Simphony Reports</td>
<td>Select this option to send definition translations to Simphony reports. You must also select the Send Translations for this Language to Simphony Reports option from the Language module for each language to be sent to Simphony reports.</td>
</tr>
</tbody>
</table>

3. Click **Save**.


- **Allowing Employees to Run Reports**
- **Configuring Employee Privileges for Oracle Hospitality Reporting and Analytics**

**Related Topics**

- **List of Workstation PMC Reports**

**Viewing Move History Logs**

Database administrators can use the EMC to verify Reporting and Analytics Daily Aggregation and to review the Move History logs of the database. The self-service access to information in EMC eliminates the need to consult the Oracle Hospitality Simphony Data Transfer Service (DTS) log on the application server. Daily Aggregation is logged for each property and each business date.
This feature is compatible with Reporting and Analytics version 9.0 Patch 8 and later.

1. Select the Enterprise level, click **Configuration**, and then click **PC Autosequences**.

2. Double-click the Reporting and Analytics Daily Aggregation record to open it.

3. Click the **Execution History** tab, and then click **Get History**. The list of all Move History Logs appears.

   The Move History logs of the database are listed by date, along with details such as ID, Insert Date, Start Date, Finish Date, Property, and Complete Code (status). If the Complete Code shows Failed, the **Reprocess** button becomes active for a specific property and business date. You can click the **Reprocess** button to set a flag for the DTS to update the Reporting and Analytics Aggregation Service to process the record again.

4. To limit the information shown, select the **Property**, and the **Date Range**, and then click the **Filter** button.

   The maximum date range is 7 days. If you do not select a date at the beginning (default state), the system shows only yesterday and today’s dates.

5. Highlight a record in the Execution History section, and then click **Show Details**. The Execution Detail section shows the date and time that the autosequence started and stopped and additional messages, such as property, location, and status (success or error).

6. Click **Save**.

---

**Configuring Data Retention Limits**

Database administrators can set the length of time data (for example, ECM and Reporting and Analytics aggregation) remains present in the database at the Enterprise and property levels.

1. Select the Enterprise level, click **Setup**, and then click **Enterprise Parameters**.

2. Click the **Miscellaneous** tab.

3. To set data retention limits, in the Purging section, enter the **Days To Keep** for the **Purge Type**.

   This is the number of days from the time a transaction is reported to the enterprise that the application retains it for use in reporting and auditing (for example, from 1 day to 999 days). After the number of days to keep expires, a scheduled event purges the data. By default, the purging jobs purge 1000 records per batch.

   - To set ECM data retention, enter the number of days for **ECM Transaction Detail**.
   - To change the PC Autosequences data retention, enter the number of days for the **Pcasequence Log**.

   Oracle recommends that you leave the default value set at 90 days, and that a subject matter expert change this setting if necessary. The **Pcasequence Log Purge Type** is available in Simphony version 2.10 and later and is compatible with Reporting and Analytics version 9.0 Patch 8 and later.

4. Click **Save**.

   - **Configuring ECM Privileges and Permissions**
• Allowing Users to View Blind Totals
• Allowing Assigned Receptacle Access and Counts
• Configuring Accounting Methods for Users
• Allowing Users to Override Employee Class Options
• Creating, Editing, and Deleting Cash Management Reasons

Related Topics
• ECM Workstation Hardware
• ECM Configuration Levels
43

Auditing

You can use the Audit Trail module to view additions, changes, and deletions made through the EMC and through PMC Procedures. In addition, the Audit Trail reports on successful and failed logins to EMC, PMC Report takers, Key Manager activity, and Audit Trail purges.

In almost every module, you can audit an individual record or a group of similar records. The results usually show the record or records at a specific position. For example, consider the following actions:

1. Add a Tender Media record at Object Number 1234.
2. Change the record’s name to Cash.
3. Delete the record.
4. Add a new record at Object Number 1234.
5. Change the record’s name to MasterCard.

After performing these steps, the Audit This Record results show all five of the changes (not just the changes for steps 4 and 5). Although the first Tender Media record was deleted, it is considered “this record” for functional purposes. In short, all records at the same object number are treated as “this record” and are included in the results.

- Using the Audit Trail
- Using Audit This Record

Related Topics
- Using the Audit Trail
- Using Audit This Record

Using the Audit Trail

You must have the privilege to access the audit trial at the Enterprise or property level. When an Audit Trail report is taken, the activity is logged to the Audit Trail. All Audit Trail Reports taken are logged as an Enterprise level activity. You can use the Audit Trail two different ways: to view the history of a specific record or to perform a general search throughout the entire system.

1. Select the Enterprise or property, click Tasks, and then click Audit Trail.
2. To perform a quick search on the Search tab:
   a. Select the timeframe from the All Changes In drop-down list.
   b. Click the Run Quick Search button.

When you perform a quick search, the application ignores the values in the standard search fields.
3. To perform a standard search, enter or select information in the following fields, and then click the **Search** button.

### Table 43-1  Audit Trail Standard Search Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Select an application from the drop-down list. Depending on your selection, the <strong>Module</strong> drop-down list is active or dimmed. For example, when you select <strong>EMC</strong>, the <strong>Module</strong> drop-down list shows a list of EMC modules.</td>
</tr>
<tr>
<td>Module</td>
<td>Select a module from the drop-down list. This field is active only when the <strong>Application</strong> selection allows a choice of modules. Depending on your selection, the <strong>Object Numbers</strong> field is active or dimmed. For example, when you select <strong>EMC</strong> from the <strong>Application</strong> drop-down list and <strong>Discounts</strong> from the <strong>Module</strong> drop-down list, the <strong>Object Numbers</strong> field becomes active.</td>
</tr>
<tr>
<td>(Optional) Object Numbers</td>
<td>Enter an object number or range to retrieve results based on specific records only. Leave this field blank to have the Audit Trail find all object numbers.</td>
</tr>
<tr>
<td>Operation</td>
<td>Select an operation from the drop-down list. This field is active based on a combination of the <strong>Application</strong> and <strong>Module</strong> selections.</td>
</tr>
<tr>
<td>Zone/Location</td>
<td>Select a zone or location. When you open the Audit Trail from the Enterprise level, this field allows a selection of any property, zone, or revenue centers. When you open the Audit Trail from the property level, this field allows a selection of revenue centers within the property.</td>
</tr>
<tr>
<td>Employee</td>
<td>Click the <strong>Select</strong> link, select an employee, and then click <strong>OK</strong>. When you select a specific employee, only changes made by that employee are included in the results. Click the <strong>Me</strong> link to include only the logged-in employee.</td>
</tr>
<tr>
<td>Date Range</td>
<td>Select the date range to use to query the Audit Trail. Select <strong>User-Defined</strong> to activate the <strong>Start</strong> and <strong>End</strong> fields.</td>
</tr>
<tr>
<td>(Optional) Start and End</td>
<td>To narrow your query to a specific date or date range, select the start and end dates and times. Select <strong>All Dates</strong> to include all dates in the query.</td>
</tr>
</tbody>
</table>
Table 43-1  (Cont.) Audit Trail Standard Search Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Optional) Old/New Values</td>
<td>Enter text for use in the query. This can be useful in finding a specific change to a record, such as when a Hamburger item was renamed to Cheeseburger.</td>
</tr>
<tr>
<td>Preserve Previous Results</td>
<td>Select this option to merge the search results with the previous search results, instead of overwriting them. Deselect this option to see only the results of the most recent search.</td>
</tr>
</tbody>
</table>

4. If the number of results that will be returned exceeds the pre-set thresholds for Audit Trail results (for example, 10,000 records or more), the application prompts you to confirm the action.

5. To view the search results for a quick search or a standard search, click the Results tab.
   a. To save the results, click the Save to Disk button, select the directory, and then click the Save button.
   b. To copy the results into another application (such as Notepad or email) without storing the information, click the Formatted Results button, and then click the Copy button.

6. To manually remove old records from the Audit Trail table in the database, click the Purge tab.
   The Purge tab is visible only at the Enterprise level, and you must have the Purge Audit Trail privilege.

7. Select the date before which the records will be purged, and then click the Purge button. For example, if you select 9/1/2016, the application deletes all records from September 1, 2016 and earlier.

   Records are deleted based on the UTC date of the Audit Trail record.

   In addition to this manually initiated purge, the Data Transfer Service (DTS) purges Audit Trail records automatically.

   • Using Audit This Record

   Related Topics
   • Auditing

Using Audit This Record

1. Select the Enterprise or property, and then open a module that contains at least one record.

2. Highlight one or more records, right-click inside the first column, and then select either Audit This Record (single record) or Audit Selected Records (multiple records). The Audit Record tab shows the information for the selected records.

Alternatively, from the EMC toolbar, click Edit, and then select Audit This Record.
3. To run specific queries on the selected record or records, click the Show Advanced Options link.

4. Use the same search parameters that are available in the Audit Trail module. See Using the Audit Trail for more information.

   • Using the Audit Trail

Related Topics

   • Auditing
Importing and Exporting Data

The Simphony Import/Export Service allows you to:

- Import and export Simphony application data in a comma-separated values (CSV) format, to or from spreadsheet applications
- Import configuration data into the Simphony application database that can be called by external systems, such as a web service application programming interface (API)
- Export configuration data from Simphony that can be called by external systems, such as an on premise inventory management application

The main benefits of this service are:

- Allows you to load configuration data in bulk (for example, making a large number of price changes for menu items, which reduces the amount of time it takes to configure systems)
- Allows third parties to integrate with customer databases (either self-hosted or hosted within an Oracle facility), without providing direct access to the application file server or database
- Allows third parties to build custom interfaces
- Configuring the Import/Export Service Privileges
- Configuring the Import/Export Service
- Configuring Task Schedules for Export Reliability
- Increasing the Import File Size
- Import/Export Service Components

Configuring the Import/Export Service Privileges

You need to configure privileges to allow the appropriate employees to view and access the Simphony Import/Export service from the Simphony Web Portal (SWP).

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Select the role, and then click the EMC Modules tab.
3. Scroll down to the Import/Export setting located within the File column under the Enterprise Modules section. The View setting controls the visibility of the Import/Export service on the SWP toolbar for staff assigned this role.
4. To enable visibility of the Import/Export service from the SWP, select the View checkbox and Save.
5. To hide the Import/Export service from the SWP, leave the View checkbox unselected. This is the default setting.
Configuring the Import/Export Service

Before configuring the Import/Export Service, you must have the appropriate EMC Enterprise privileges assigned to you.

1. Select the Enterprise level, click **Setup**, and then click **Enterprise Parameters**.
2. Click the **Import/Export** tab.
3. Enter the appropriate values in the fields. The following table describes the settings that you can configure for the Import/Export service.

**Table 44-1 Import/Export Service Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root Path for Export/Import File Operations</td>
<td>If you are using Simphony version 2.9.1 or later, this field is disabled. Do not enter information in this field.</td>
</tr>
<tr>
<td>Max No. of Records to Commit Per Batch</td>
<td>Enter the maximum number of records to commit per batch when importing. You can enter a value from 1000 through 20000.</td>
</tr>
<tr>
<td></td>
<td>If you change the default value, restart the Oracle Hospitality Simphony Data Request Processing Service for the changes to take effect.</td>
</tr>
</tbody>
</table>
Table 44-1  (Cont.) Import/Export Service Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import/Export API URL</td>
<td>If you are using an API, enter the IP address of the import/export API.</td>
</tr>
<tr>
<td>Simphony APP URL</td>
<td>Enter the IP address for the Simphony Web Portal:</td>
</tr>
<tr>
<td></td>
<td>https://[ServerName]/SimphonyApp.</td>
</tr>
<tr>
<td>Default Date Time Format</td>
<td>Select the date and time format to use when processing import and export requests.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

- **Configuring the Import/Export Service Privileges**
- **Increasing the Import File Size**

**Related Topics**

- **Import/Export Service Components**

### Configuring Task Schedules for Export Reliability

On HCR systems, the auto-schedule is created only for organizations that exist at the time of the Simphony 18.2 upgrade. New organizations created after the upgrade require schedules to be created manually. Schedules of an existing organization can be used as a template.

1. Select the Enterprise level, click **Configuration**, and then click **Task Scheduler**.
   
   The new schedule types are daily CAPS Export Reliability and daily Workstation Export Reliability schedules.

2. Double-click the desired schedule for configuration.

3. Configure the schedule by enabling the schedule check box.
   
   - Enabling the check box configures the system to run the task scheduler at intervals of 45 minutes for workstations, and 60 minutes for CAPS.
   
   - The recurrence of a schedule is configurable. However, do not change the default values. Changing important details of the scheduler (such as Task Data), results in the scheduler not running.

4. Click **Save**.

### Increasing the Import File Size

Complete these steps if the Enterprise requires you to import files larger than the default 4MB size.

1. Browse to [Drive Letter]:\MICROS\Simphony2\SimphonyImportExport\WebApp\ and open the Web.config file.

2. Add the following line within a comment:
   
   `<httpRuntime targetFramework="4.5" />`

3. Uncomment the following line:
4. Enter the maximum import file size for the maxRequestLength parameter in Kilobits. By default, this value is set to 10 MB.

5. Save the changes.

- Configuring the Import/Export Service Privileges
- Configuring the Import/Export Service

Related Topics
- Import/Export Service Components

Import/Export Service Components

The Simphony Import/Export Service is comprised of four components, plus a Microsoft Windows service. The following table lists the components and their capabilities.

<table>
<thead>
<tr>
<th>Component</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>EGateway URL</td>
<td>Provides access to the Simphony configuration for self-hosted and Enterprise hosting center environments.</td>
</tr>
<tr>
<td>Web Service (REST API)</td>
<td>Assists developers with programmatic integration and the development of third-party application programming interfaces (API).</td>
</tr>
<tr>
<td>Web Service (SOAP API)</td>
<td>The SOAP API has the same functionality as the REST API, except this web service is constructed using the SOAP format rather than the REST format.</td>
</tr>
</tbody>
</table>
| Simphony Web Portal (SWP) | This web application enables you to:  
  - Import and export data manually  
  - Download and store data securely in a database  
  - Export data automatically using the scheduler  
  - Review the status of completed import and export jobs  
  - Access a Help page that provides additional database and API details  
  The SWP is available for all users with Simphony EMC logon credentials. |
| Oracle Hospitality Simphony Data Request Processing Service (Microsoft Windows Service) | This Microsoft Windows service runs as part of throttling and scheduling processes (rather than on demand servicing requests). |

Related Topics
- Configuring the Import/Export Service Privileges
- Configuring the Import/Export Service
- Increasing the Import File Size
Loyalty and Gift Card Interfaces and Drivers

Oracle Hospitality Gift and Loyalty is a customer relationship management (CRM) application that allows properties to manage point-based loyalty card programs and stored value cards (SVC) (also known as gift cards). Gift and Loyalty tracks customer activities (such as frequency of visits, spending, and loyalty account balance) and reports the information through Simphony’s enterprise reporting module. Simphony then sends this information to Gift and Loyalty.

The following table lists common types of loyalty programs:

<table>
<thead>
<tr>
<th>Loyalty Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Points earned per transaction or per visit</td>
<td>An award given for X number of visits. The award could be a discount, coupon for future visit, or stored value added to the loyalty account for later redemption.</td>
</tr>
<tr>
<td>Points earned per dollar spent</td>
<td>An award given for X dollars spent. The award could be a discount, coupon for future visit, or stored value added to the loyalty account for later redemption.</td>
</tr>
<tr>
<td>Discount card</td>
<td>Each time the workstation operator swipes a card, the check receives an automatic discount. Restaurants typically use discount cards to control employee meal discounts.</td>
</tr>
<tr>
<td>Category club card</td>
<td>The customer earns points when ordering a specific type of menu item (for example, burgers).</td>
</tr>
</tbody>
</table>

A stored value program allows a guest to establish a prepaid account to use for purchases at a property. The prepaid payment vehicle is a stored value card with an associated monetary value. A gift card is an example of a stored value card containing a prepaid amount.

- Loyalty and Stored Value Configuration Prerequisites
- Loyalty Configuration Tasks
- Configuring Loyalty and Stored Value Privileges
- Setting Loyalty Options
- Configuring the Loyalty Driver
- Configuring the Loyalty Module
- Stored Value Configuration Tasks
- Setting Stored Value Options
- Configuring the Stored Value Driver
- Configuring the Stored Value Module
Loyalty and Stored Value Configuration Prerequisites

Simphony supports the Gift and Loyalty drivers only on Microsoft Windows CE and Microsoft Windows 32-bit operating systems.

Complete the following tasks before configuring the Loyalty and Stored Value Interfaces and Drivers:

1. Install Simphony version 2.5 Maintenance Release (MR) 1 or later at the property.
2. Obtain access to the EMC within Simphony.
3. Configure unique Tender/Media and Discount records for loyalty transactions. Take note of the record number and type as you need the values to post transactions for Oracle Hospitality Reporting and Analytics and third-party loyalty applications.

   Reporting and Analytics and third-party loyalty applications use the configured Simphony Tender/Media and Discount records to post loyalty transactions to the guest check.

4. (Optional) If the property is using the XProcessor Extension Application for Gift and Loyalty, configure the Gift and Loyalty interface and XProcessor Extension Application at the Enterprise level. Deploy each interface only to the correct locations and clients. After you upgrade the appropriate clients to Simphony version 2.5 MR1 or later, see XProcessor Extension Application Migration for instructions.
   a. Leave the XProcessor installed at the Enterprise level until all clients have been upgraded to Simphony version 2.5 MR1 or later and are using the Gift and Loyalty interface.
   b. Retrieve the data extension overrides for each property (such as URL, userid, user_password, and timeout_seconds). Take note of these settings as you need this information to create the integrated Gift and Loyalty interface.
   c. Take note of the current functions the site uses through XProcessor. You need this information to create buttons for the Gift and Loyalty interface.

5. (Optional) If a third party developed a driver, use the driver configuration settings provided by the third party. Third-party drivers may have unique fields.
Related Topics
• Loyalty Configuration Tasks

Loyalty Configuration Tasks

Complete the following tasks to set up the loyalty interface:
• Complete the configuration prerequisites
• Configure loyalty privileges
• Set loyalty options
• Configure the Loyalty driver
• Configure the Loyalty module
• Create Front of House loyalty buttons
• Allow workstation operators to void loyalty points issued on re-opened checks
• (If applicable) Migrate the XProcessor Extension Application

Related Topics
• Loyalty and Stored Value Configuration Prerequisites
• Configuring Loyalty and Stored Value Privileges
• Setting Loyalty Options
• Configuring the Loyalty Driver
• Configuring the Loyalty Module
• Creating Loyalty and Stored Value Buttons
• Voiding Points on a Re-opened Check
• XProcessor Extension Application Migration

Configuring Loyalty and Stored Value Privileges

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Select the role type, click the Operations tab, and then click the Stored Value Cards subtab.
3. Select the appropriate options for the privileges. The following table summarizes the privileges associated with Loyalty and Stored Value functionality.

<table>
<thead>
<tr>
<th>Table 45-2</th>
<th>Loyalty and Stored Value Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section</td>
<td>Option Number</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>104</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>105</td>
</tr>
</tbody>
</table>
## Table 45-2  (Cont.) Loyalty and Stored Value Privileges

<table>
<thead>
<tr>
<th>Section</th>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Select This Option to Allow Employees to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue Functions</td>
<td>106</td>
<td>Authorize/Perform Issue Stored Value Batch Function</td>
<td>Issue a batch of stored value cards</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>107</td>
<td>Authorize/Perform Void Issue Stored Value Batch Entry</td>
<td>Void a batch of stored value cards</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>108</td>
<td>Authorize/Perform Activate Stored Value Function</td>
<td>Activate a stored value card</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>109</td>
<td>Authorize/Perform Void Activate Stored Value Entry</td>
<td>Void the activation of a stored value card</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>110</td>
<td>Authorize/Perform Activate Stored Value Batch Function</td>
<td>Activate a batch of stored value cards</td>
</tr>
<tr>
<td>Issue Functions</td>
<td>111</td>
<td>Authorize/Perform Void Activate Stored Value Batch Entry</td>
<td>Void the activation of a batch of stored value cards</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>112</td>
<td>Authorize/Perform Reload Stored Value Function</td>
<td>Reload (add credit) a dollar amount to an existing stored value card</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>113</td>
<td>Authorize/Perform Void Reload Stored Value Entry</td>
<td>Void a reload transaction</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>114</td>
<td>Authorize/Perform Redeem Authorization Stored Value Function</td>
<td>Perform a redemption authorization</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>115</td>
<td>Authorize/Perform Void Redeem Authorization Stored Value Entry</td>
<td>Void a redemption authorization</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>116</td>
<td>Authorize/Perform Redeem Stored Value Function</td>
<td>Perform a redemption transaction (a customer makes a purchase using a stored value card, and the application deducts a dollar amount from the customer’s account)</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>117</td>
<td>Authorize/Perform Void Redeem Stored Value Entry</td>
<td>Void a redemption transaction</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>118</td>
<td>Authorize/Perform Manual Redemption Stored Value Function</td>
<td>Perform a manual redemption</td>
</tr>
<tr>
<td>Reload and Redeem Functions</td>
<td>119</td>
<td>Authorize/Perform Void Manual Redemption Stored Value Entry</td>
<td>Void a manual redemption transaction</td>
</tr>
<tr>
<td>Section</td>
<td>Option Number</td>
<td>Privilege Name</td>
<td>Select This Option to Allow Employees to</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------</td>
<td>----------------------------------------------------------------</td>
</tr>
<tr>
<td>Point Functions</td>
<td>120</td>
<td>Authorize/Perform Issue Stored Value Points Function</td>
<td>Issue points to a stored value card</td>
</tr>
<tr>
<td>Point Functions</td>
<td>121</td>
<td>Authorize/Perform Void Issue Stored Value Points Entry</td>
<td>Void the issued points on a stored value card</td>
</tr>
<tr>
<td>Point Functions</td>
<td>122</td>
<td>Authorize/Perform Redeem Stored Value Points Function</td>
<td>Perform a points redemption transaction</td>
</tr>
<tr>
<td>Point Functions</td>
<td>123</td>
<td>Authorize/Perform Void Redeem Stored Value Points Entry</td>
<td>Void a points redemption transaction</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>103</td>
<td>Authorize/Perform Manual Entry of Stored Value Card Number</td>
<td>Manually enter the stored value card account number</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>124</td>
<td>Authorize/Perform Stored Value Cash Out Function</td>
<td>Debit some or all of the remaining balance on a stored value card</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>179</td>
<td>Authorize/Perform Void Stored Value Cash Out Function</td>
<td>Void a cash out transaction</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>125</td>
<td>Authorize/Perform Stored Value Balance Inquiry Function</td>
<td>Check a stored value card balance</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>126</td>
<td>Authorize/Perform Stored Value Balance Transfer Function</td>
<td>Transfer the balance from one stored value card to another</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>127</td>
<td>Authorize/Perform Stored Value Point Inquiry Function</td>
<td>Check a stored value card point balance</td>
</tr>
<tr>
<td>Other Stored Value Card Options</td>
<td>128</td>
<td>Authorize/Perform Stored Value Report Generation Function</td>
<td>Generate stored value card reports</td>
</tr>
<tr>
<td>Loyalty Options</td>
<td>166</td>
<td>Authorize/Perform Loyalty Coupon Inquiry</td>
<td>Request a list of coupons that are available for a loyalty account</td>
</tr>
<tr>
<td>Loyalty Options</td>
<td>167</td>
<td>Authorize/Perform Accept Loyalty Coupon Function</td>
<td>Redeem a coupon associated with a loyalty account</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>168</td>
<td>Authorize/Perform Void Accept Loyalty Coupon Entry</td>
<td>Void the coupon redemption</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>169</td>
<td>Authorize/Perform Issue Loyalty Coupon Function</td>
<td>Issue a coupon to a loyalty account</td>
</tr>
<tr>
<td>Loyalty Operations</td>
<td>170</td>
<td>Authorize/Perform Issue Loyalty Points Function</td>
<td>Issue points to a loyalty account</td>
</tr>
</tbody>
</table>
4. Click the Transactions tab.

5. Select the appropriate Stored Value coupon privileges from the Service Charge and Discount Options section:

   - **130 - Authorize/Perform “Accept Coupon” Stored Value Function:** Select this option to allow employees to perform the Accept Coupon stored value function.
131 - Authorize/Perform “Void Accept Coupon” Stored Value Function: Select this option to allow employees to perform the Void Accept Coupon stored value function.

6. Click **Save**.

- **Loyalty and Stored Value Configuration Prerequisites**
- **Setting Loyalty Options**
- **Configuring the Loyalty Driver**
- **Configuring the Loyalty Module**
- **Creating Loyalty and Stored Value Buttons**
- **Voiding Points on a Re-opened Check**
- **XProcessor Extension Application Migration**

**Related Topics**
- **Loyalty Configuration Tasks**
- **Setting Stored Value Options**
- **Configuring the Stored Value Driver**
- **Configuring the Stored Value Module**
- **Creating Loyalty and Stored Value Buttons**
- **XProcessor Extension Application Migration**

**Related Topics**
- **Stored Value Configuration Tasks**

## Setting Loyalty Options

1. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Loyalty**.

2. Insert a record, enter **Loyalty** as the name, and then click **OK**.

3. Double-click the record to open it.

4. Select the appropriate Loyalty Options as described in the following table.

### Table 45-3 Loyalty Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Support Offline Transactions</td>
<td>Select this option to allow offline loyalty transactions.</td>
</tr>
<tr>
<td>2 - Always Print Loyalty Results</td>
<td>Select this option to automatically print a chit after each successful loyalty operation.</td>
</tr>
<tr>
<td>3 - Never Display Loyalty Results</td>
<td>Select this option to require the workstation operator to touch the workstation in order to show loyalty results.</td>
</tr>
<tr>
<td>5 - Remove Loyalty Results Print Button</td>
<td>Select this option to hide the Print button from the loyalty results screen. Select this option in conjunction with the <strong>Always Print Loyalty Results</strong> option.</td>
</tr>
</tbody>
</table>
Table 45-3  (Cont.) Loyalty Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 - Remove Guest Name Lookup Button</td>
<td>Select this option to hide the Guest Name Lookup button from the account number entry screen. This option deactivates the Guest Name Lookup function.</td>
</tr>
<tr>
<td>7 - Remove Phone Number Lookup Button</td>
<td>Select this option to hide the Phone Number Lookup button from the account number entry screen. This option deactivates the Phone Number Lookup function.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

- **Loyalty and Stored Value Configuration Prerequisites**
- **Configuring Loyalty and Stored Value Privileges**
- **Configuring the Loyalty Driver**
- **Configuring the Loyalty Module**
- **Creating Loyalty and Stored Value Buttons**
- **Voiding Points on a Re-opened Check**
- **XProcessor Extension Application Migration**

**Related Topics**
- **Loyalty Configuration Tasks**

### Configuring the Loyalty Driver

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **Loyalty Driver**.

2. Insert a record and enter an appropriate gift and loyalty driver name.

3. Double-click the record to open it.

4. On the **General** tab, click the **Import from a file** link.

5. Browse to `[Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers`, select **LoyaltyCommandModule.dll**, and then click **Open**.

6. Click the **Configuration** tab.

7. From the Assembly/Class section, enter information in the following fields:

Table 45-4  Assembly/Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Enter the module identification (for example, LoyaltyDriver).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name that should appear in Simphony Front of House windows and dialogs (for example, [Provider Name] Loyalty).</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the module (for example, Loyalty Driver). Do not leave this field blank.</td>
</tr>
</tbody>
</table>
8. From the iCareDriver Properties section, enter information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate File</td>
<td>If the property implemented a unique certificate file, specify the location of the certificate file on the local machine.</td>
</tr>
<tr>
<td>Communications Offline Retry Count</td>
<td>This value is the number of transactions that workstation operators can complete offline before attempting an online transaction. You cannot change the value in this field as it is based on the Tender Media or Service Charge records configured for offline use.</td>
</tr>
<tr>
<td>Communications Timeout Seconds</td>
<td>You cannot change the value in this field as it is based on the Tender Media or Service Charge records configured for offline use.</td>
</tr>
<tr>
<td>Log iCare Client Debug Data</td>
<td>If the client is using Gift and Loyalty, indicate whether the application includes debug information in the log file.</td>
</tr>
<tr>
<td>Log iCare Client Message Data</td>
<td>If the client is using Gift and Loyalty, indicate whether the application includes client messages in the log file.</td>
</tr>
<tr>
<td>Login</td>
<td>Leave this field blank at the Enterprise level. This value is set at the property level.</td>
</tr>
<tr>
<td>Password</td>
<td>Leave this field blank at the Enterprise level. This value is set at the property level.</td>
</tr>
<tr>
<td>Web Address</td>
<td>Enter the path to Gift and Loyalty, including location, port number and service path. Use the following format: https://[GiftLoyaltyLocation]:[GiftLoyaltyPortNumber]/ws/services/StoredValueService. If the property is using a third-party payment provider application (rather than Gift and Loyalty), enter the path to the third-party payment provider application. This can be a Web address or a local path.</td>
</tr>
</tbody>
</table>

9. Click **Save**.

- Loyalty and Stored Value Configuration Prerequisites
- Configuring Loyalty and Stored Value Privileges
- Setting Loyalty Options
- Configuring the Loyalty Module
- Creating Loyalty and Stored Value Buttons
- Voiding Points on a Re-opened Check
- XProcessor Extension Application Migration

**Related Topics**

- Loyalty Configuration Tasks

**Configuring the Loyalty Module**

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **Loyalty Module**.
2. Insert a record, enter **LoyaltyModule** as the name, and then click **OK**.

3. Double-click the record to open it.

4. On the **General** tab, click the **Import from a file** link.

5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select **LoyaltyCommandModule.dll**, and then click **Open**.

6. Click the **Configuration** tab.

7. From the Assembly/Class section, enter information in the following fields:
   - **Module ID**: Enter a value that identifies the module.
   - **Display Name**: Enter the name to show in Simphony Front of House windows and dialogs (for example, [Provider Name] Loyalty).
   - **Description**: Enter a description of the loyalty module. Do not leave this field blank.

8. From the Common Properties section, enter information in the following fields:
   - **Currency ISO Code**: Enter the code (three alpha characters) that represents the currency being used (for example, USD).
   - **Language ISO Code**: Enter the code (two alpha characters) that represents the language being used (for example, EN).

     If the currency or language is different at the property, override these values at the property level.

9. From the Loyalty Module Properties section, enter information in the following fields:
   - **Account Number Maximum Length**: Enter the maximum length of a loyalty account number (up to 24 digits).
   - **Account Number Minimum Length**: Enter the minimum length of a loyalty account number (down to 7 digits).
   - **Cash Module Name**: Enter the name of the cash module to use for redemptions (for example, Cash:Cash).

10. Click **Save**.

11. Select the property, click **Setup**, and then click **Loyalty Driver**.

12. Double-click the gift and loyalty driver record to open it.

13. Click the **Override This Record** link, and then click **Yes** to confirm.

14. Click the **Configuration** tab.

15. From the iCare Driver Properties section, enter information in the following fields:
   - **Login**: Enter the login for the property ID or the login for the provider.
   - **Password**: Enter the password for the property ID or the provider.

16. Click **Save**.
Stored Value Configuration Tasks

Complete the following tasks to set up the stored value interface:

- Carry out the configuration prerequisites
- Configure stored value privileges
- Set stored value options
- Configure the Stored Value driver
- Configure the Stored Value module
- Create Front of House stored value buttons
- Allow workstation operators to void loyalty points issued on re-opened checks
- (If applicable) Migrate the XProcessor Extension Application

Related Topics
- Configuring Loyalty and Stored Value Privileges
- Setting Stored Value Options
- Configuring the Stored Value Driver
- Configuring the Stored Value Module
- Creating Loyalty and Stored Value Buttons
- XProcessor Extension Application Migration

Setting Stored Value Options

1. Select the Enterprise, property, or revenue center, click Configuration, and then click Stored Value.
2. Insert a record, enter Stored Value as the name, and then click OK.
3. Double-click the record to open it.
4. Select the appropriate Stored Value Options. The following table describes the options.
Table 45-6  Stored Value Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support Offline Transactions</td>
<td>Select this option to allow offline stored value transactions.</td>
</tr>
<tr>
<td>Always Print Stored Value Results</td>
<td>Select this option to automatically print a chit after each successful stored value operation.</td>
</tr>
<tr>
<td>Never Display Stored Value Results</td>
<td>Select this option to require the workstation operator to tap the workstation to show loyalty results.</td>
</tr>
<tr>
<td>Remove Stored Value Results Print Button</td>
<td>Select this option to hide the Print button from the stored value results screen. Select this option in conjunction with the <strong>Always Print Stored Value Results</strong> option.</td>
</tr>
<tr>
<td>Remove Guest Name Lookup Button</td>
<td>Select this option to hide the <strong>Guest Name Lookup</strong> button from the account number entry screen. This option deactivates the Guest Name Lookup function.</td>
</tr>
<tr>
<td>Remove Phone Number Lookup Button</td>
<td>Select this option to hide the <strong>Phone Number Lookup</strong> button from the account number entry screen. This option deactivates the Phone Number Lookup function.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

- Configuring Loyalty and Stored Value Privileges
- Configuring the Stored Value Driver
- Configuring the Stored Value Module
- Creating Loyalty and Stored Value Buttons
- XProcessor Extension Application Migration

**Related Topics**
- Stored Value Configuration Tasks

**Configuring the Stored Value Driver**

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **Stored Value Driver**.
2. Insert a record, enter an appropriate stored value card driver name, and then click **OK**.
3. Double-click the record to open it.
4. On the **General** tab, click the **Import from a file** link.
5. Browse to [Drive Letter]\MICROS\Simphony2\EgatewayService\handlers, select **StoredValueCommandModule.dll**, and then click **Open**.
6. Click the **Configuration** tab.
7. From the Assembly/Class section, enter information in the following fields:
Table 45-7  Assembly/Class Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module ID</td>
<td>Enter a value that identifies the module (for example, SVCDriver).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the name to appear in Simphony Front of House windows and dialogs (for example, [Provider Name] Stored Value).</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the module (for example, SVC Driver). Do not leave this field blank.</td>
</tr>
</tbody>
</table>

8. From the iCareDriver Properties section, enter information in the following fields:

Table 45-8  iCareDriver Properties Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate File</td>
<td>If the property implemented a unique certificate file, enter the location of the certificate file on the local machine.</td>
</tr>
<tr>
<td>Communications Offline Retry Count</td>
<td>This value is the number of transactions that workstation operators can complete offline before attempting an online transaction. You cannot change the value in this field as it is based on the Tender Media or Service Charge records configured for offline use.</td>
</tr>
<tr>
<td>Communications Timeout Seconds</td>
<td>You cannot change the value in this field as it is based on the Tender Media or Service Charge records configured for offline use.</td>
</tr>
<tr>
<td>Log iCare Client Debug Data</td>
<td>If the client is using Gift and Loyalty, indicate whether the application includes debug information in the log file.</td>
</tr>
<tr>
<td>Log iCare Client Message Data</td>
<td>If the client is using Gift and Loyalty, indicate whether the application includes client messages in the log file.</td>
</tr>
<tr>
<td>Login</td>
<td>Leave this field blank at the Enterprise level. This value is set at the property level.</td>
</tr>
<tr>
<td>Password</td>
<td>Leave this field blank at the Enterprise level. This value is set at the property level.</td>
</tr>
<tr>
<td>Web Address</td>
<td>Enter the path to Gift and Loyalty, including location, port number and service path. Use the following format: https://[GiftLoyaltyLocation]:[GiftLoyaltyPortNumber]/ws/services/StoredValueService. If the property is using a third-party payment provider application (rather than Gift and Loyalty), enter the path to the third-party payment provider application. This can be a Web address or a local path.</td>
</tr>
</tbody>
</table>

9. Click Save.

- Configuring Loyalty and Stored Value Privileges
- Setting Stored Value Options
Configuring the Stored Value Module

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **Stored Value Module**.

2. Insert a record, enter **SVCModule** as the name, and then click **OK**.

3. Double-click the record to open it.

4. On the **General** tab, click the **Import from a file** link.

5. Browse to [Drive Letter]:\MICROS\Simphony2\EgatewayService\handlers, select **StoredValueCommandModule.dll**, and then click **Open**.

6. Click the **Configuration** tab.

7. From the Assembly/Class section, enter information in the following fields:
   - **Module ID**: Enter the module identification.
   - **Display Name**: Enter the name to appear in Simphony Front of House windows and dialogs.
   - **Description**: Enter a description of the stored value module. Do not leave this field blank.

8. From the Common Properties section, enter information in the following fields:
   - **Currency ISO Code**: Enter the code (three alpha characters) that represents the currency being used (for example, USD).
     
   
   - **Language ISO Code**: Enter the code (two alpha characters) that represents the language being used (for example, EN).
     

   If the currency or language is different at the property, override these values at the property level.

9. From the Stored Value Module Properties section, enter information in the following fields:
   - **Account Number Maximum Length**: Enter the maximum length of a stored value account number (up to 24 digits).
   
   - **Account Number Minimum Length**: Enter the minimum length of a stored value account number (down to 7 digits).
   
   - **Cash Module Name**: Enter the name of the cash module to use for redemptions (for example, Cash:Cash).
- **Max Card Activation Quantity**: Enter the maximum number of stored value cards that can be activated with the Activate Multiple card operation.

- **Max Card Issue Quantity**: Enter the maximum number of stored value cards that can be issued with the Activate Multiple card operation.

10. Click **Save**.

11. Select the property, click **Setup**, and then click **Stored Value Driver**.

12. Double-click the stored value card driver record to open it.

13. Click the **Override This Record** link, and then click **Yes** to confirm.

14. Click the **Configuration** tab.

15. From the iCare Driver Properties section, enter information in the following fields:
   - **Login**: Enter the login for the property ID or the login for the provider.
   - **Password**: Enter the password for the property ID or the provider.

16. Click **Save**.

- Configuring Loyalty and Stored Value Privileges
- Setting Stored Value Options
- Configuring the Stored Value Driver
- Creating Loyalty and Stored Value Buttons
- XProcessor Extension Application Migration

**Related Topics**

- **Stored Value Configuration Tasks**

**Creating Loyalty and Stored Value Buttons**

You can create buttons on a page for the loyalty and stored value functions.

1. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Page Design**.

2. Open the page on which to place loyalty and stored value buttons.

3. On the **Edit** tab, select the page area in which to define the loyalty and stored value functions (typically the payment or function area).

4. Click **Button**.

5. On the **General** subtab, select the appropriate function from the **Type** drop-down list.
   - **Loyalty Function**
   - **Stored Value Function**

6. Click the black arrow beneath the **Type** drop-down list.

7. Select either iCare Loyalty or iCare Stored Value, and then click **OK**.
8. From the Loyalty or Stored Value Operation Selection dialog, select the appropriate Module Type (iCareLoyaltyModule or iCareSVCModule), select the appropriate function from the Functions drop-down list, and then click OK.

9. Position and size the button on the page. Use the Style arrow to change the color.

10. In the Legend field, enter the button name, and then click Save. The following tables list the loyalty and stored value button names and functions.

Buttons marked with an asterisk (*) are only available with Gift and Loyalty; these functions are not available with third-party payment providers.

**Table 45-9 Loyalty Buttons**

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balance Inquiry</td>
<td>Request a points balance for a loyalty account.</td>
</tr>
<tr>
<td>Unique Items Inquiry*</td>
<td>Request a list of unique menu items that have been ordered on a program associated with a loyalty account.</td>
</tr>
<tr>
<td>Issue Points</td>
<td>Issue points to a loyalty account.</td>
</tr>
<tr>
<td>Coupon Inquiry</td>
<td>Request a list of coupons that are available for a loyalty account.</td>
</tr>
<tr>
<td>Redeem Coupon</td>
<td>Redeem a coupon to apply towards the balance of a guest check.</td>
</tr>
<tr>
<td>Issue Coupon</td>
<td>Issue an ad hoc coupon from Gift and Loyalty to a guest loyalty account.</td>
</tr>
<tr>
<td>Transfer Loyalty Account</td>
<td>Transfer the points balance and customer personal information associated with one loyalty account number to another loyalty account.</td>
</tr>
</tbody>
</table>
| Apply Card to Check*         | The Apply Card to Check function sends an Apply request to Gift and Loyalty for the account number. Based on Gift and Loyalty configuration, the workstation operator can select the following actions:  
  • Apply Coupon  
  • Redeem Points  
  • Redeem Stored Value Card (SVC)  
  • Apply Coupon and Redeem SVC  
  • Issue Points  

The Apply Card to Check function requires a special configuration to share data between the Loyalty and Stored Value modules. To configure the Apply Card to Check button on the General tab, in the Text field, enter the **SVCModuleName** and **Record Number**. Use the format SVCModuleName:RecordNumber to process SVC actions associated with this function. You can find the Record Number and Module Name in EMC by highlighting the Enterprise, selecting Setup, and then clicking Stored Value Module.

A property can load more than one type of loyalty module, although Oracle does not recommend doing so. If the property uses multiple loyalty modules, manually enter the module name in the Arguments field for the second module.
Table 45-10  Stored Value Buttons

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balance Inquiry</td>
<td>Request the current monetary value for a stored value account or gift card.</td>
</tr>
<tr>
<td>Issue SVC</td>
<td>Issue one stored value account number for a dollar value that is determined at the time of purchase.</td>
</tr>
<tr>
<td>Issue Multiple SVCs*</td>
<td>Issue multiple stored value account numbers for a dollar value that is determined at the time of purchase.</td>
</tr>
<tr>
<td>Activate SVC</td>
<td>Activate one stored value account. The application prompts the workstation operator to enter the pre-defined dollar value for validation.</td>
</tr>
<tr>
<td>Activate Multiple SVCs*</td>
<td>Activate multiple stored value account numbers for a dollar value that is determined at the time of purchase. The application prompts the workstation operator to enter the pre-defined dollar value for validation.</td>
</tr>
<tr>
<td>Reload</td>
<td>Add funds to an existing stored value account.</td>
</tr>
<tr>
<td>Transfer</td>
<td>Transfer the funds and customer personal information (if applicable) associated with one stored value account to another stored value account.</td>
</tr>
<tr>
<td>Authorize</td>
<td>Authorize a gift card for use as payment on a guest check.</td>
</tr>
<tr>
<td>Redeem</td>
<td>Pay a guest check balance using a gift card.</td>
</tr>
<tr>
<td>Cash Out</td>
<td>Obtain a cash payment for any remaining balance on a stored value account.</td>
</tr>
<tr>
<td>Redeem SVC/Issue Points*</td>
<td>The Redeem SVC/Issue Points function combines the Redeem SVC and Loyalty Issue Points functions. The application prompts the workstation operator to redeem a gift card, and then automatically issues points. The Redeem SVC/Issue Points function requires a special configuration to share data between the Loyalty and Stored Value modules. To configure the Redeem SVC/Issue Points button on the General tab, in the Text field, enter the LoyaltyModuleName and Record Number. Use the format LoyaltyModuleName:RecordNumber to process loyalty actions associated with this function. You can find the Record Number and Module Name in EMC by highlighting the Enterprise level, clicking Setup, and then clicking Loyalty Module. For SVC transactions, you can suppress a prompt for entry of the Total Amount Due by enabling Tender/Media option 3 - Assume Paid in Full, and by setting the Text field of the Redeem button in the Page Design module to: RedeemAmountIsTotalDue. A property can load more than one type of stored value module, although Oracle does not recommend doing so. If the property uses multiple stored value modules, manually enter the module name in the Arguments field for the second module.</td>
</tr>
</tbody>
</table>

11. Repeat the preceding steps to create buttons for each of the loyalty and stored value functions listed in the tables.

•  Loyalty and Stored Value Configuration Prerequisites
Voiding Points on a Re-opened Check

To allow workstation operators to void loyalty points issued on re-opened guest checks, the check number must remain the same after reopening a check. By default, a guest check number increments each time a workstation operator re-opens the check, preventing the voiding of points due to check numbering mismatch.

1. Select the revenue center, click **RVC Parameters**, and then click **Options**.
2. Select **37 - Keep The Same Check Number When a Check is Reopened**.
   
   This allows a re-opened guest check to retain its original guest check number. When you deselect this option, Simphony assigns a re-opened guest check to a new check number.

3. Click **Save**.
XProcessor Extension Application Migration

If you are using Simphony version 2.5 MR1 or later, you can install the Loyalty driver for Gift and Loyalty Advanced at the property (in place of the XProcessor Extension Application). Upgrade the POS clients to Simphony version 2.5 MR1 or later before completing the steps in this section.

1. Browse to the CAL server’s Microsoft Windows 32-bit or Microsoft Windows CE subdirectory for Gift and Loyalty Advanced:
   - CAL\Win32\ICareProcessor2.0 directory
   - CAL\WinCE\ICareProcessor2.0 directory
2. Delete the ICareProcessor2.0 directory.
3. From the EMC, select the Enterprise level, click Setup, and then click CAL Packages.
4. Delete the CAL Client package that was used to deploy the ICareProcessor2.0 directory to the workstations.
5. Delete the following files from the disk:
   - Micros.XProcessor.dll
   - Micros.XProcessor.SVC.dll
   - Micros.XProcessor.SVC.ICare.dll
6. Select the Enterprise, property, or revenue center, click Setup, and then click Extension Application.
7. Delete the Extension Application for XProcessor.
8. Select the Enterprise, property, or revenue center, click Setup, and then click Payments.
9. Delete the XProcessor Payment driver.
10. Select the Enterprise or property, click Configuration, and then click Tender/Media.
11. Delete XProcessor Close Check.
12. Delete the iCareSvcProcessor.icare.xml file.
13. Select the Enterprise level, click Configuration, and then click Data Extensions.
14. Delete the data extensions for each property.
15. Select the Enterprise, property, or revenue center, click Configuration, and then click Page Design.
16. Double-click the page record containing Gift and Loyalty buttons to open it.
17. Delete all Gift and Loyalty buttons.
   Depending on the property’s Gift and Loyalty configuration, additional menu items, discounts, service charges, or tenders may have been used. If these items are in use, leave these additional items and do not delete them.
18. If the property was using the Check Reprocessor service, remove the installed check reprocessor files from the Enterprise Service Host as the Gift and Loyalty interface has its own plug-ins.
19. Browse to the Handlers directory where the Check Reprocessor ran and open the ChkReprocSvcHost.DLL.config file.

20. Delete the following tag:

```xml
<pluginAssembly displayname="XProcessor Reprocessor"
    fullname="Micros.XProcessor.SVC.dll, Version=0.0.0.0, Culture=neutral,
    PublicKeyToken=null" />
```

Leave the tags `<pluginAssemblies>` and `</pluginAssemblies>`.

21. Delete the following files from the Handlers directory:

- Micros.XProcessor.Payment.dll
- Micros.Ops.Extensibility.dll
- Micros.XProcessor.dll
- Micros.XProcessor.SVC.dll
- Micros.XProcessor.SVC.icare.dll

Loyalty and Stored Value Configuration Prerequisites

- Configuring Loyalty and Stored Value Privileges
- Setting Loyalty Options
- Configuring the Loyalty Driver
- Configuring the Loyalty Module
- Creating Loyalty and Stored Value Buttons
- Voiding Points on a Re-opened Check

Related Topics

- Loyalty Configuration Tasks
- Configuring Loyalty and Stored Value Privileges
- Setting Stored Value Options
- Configuring the Stored Value Driver
- Configuring the Stored Value Module
- Creating Loyalty and Stored Value Buttons

Related Topics

- Stored Value Configuration Tasks
Events

An event is a group of transactions that occur within a specific date and time range in one or more revenue centers at a property. Examples of events include sporting events and games, banquets, weddings, and receptions. Setting an event allows you to accurately track sales and inventory, particularly when multiple events occur in a single business day (for example, a baseball double header).

You can configure events from the EMC, update event status and associate checks with a specific event at the POS client, view various event reports in Reporting and Analytics, import and export event totals. You initiate events in the following ways:

- Automatically
- On a predefined schedule
- Through a call to an event service
- Using a function key on the workstation

Simphony retains all event information (including changes to events) for use in reporting and auditing.

- Configuring Event Privileges and Permissions
- Specifying Ad Hoc Reports
- Enabling Events
- Configuring Event Types and Sub Types
- Creating an Event
- Configuring an Event Area
- Linking Events
- Breaking Linked Events
- Cancelling an Event
- Configuring Event Information to Print on Checks and Receipts
- Creating Task Schedules
- Configuring the Event Status Bar
- Configuring the Event Buttons
- Event Information in Reporting and Analytics Reports

Configuring Event Privileges and Permissions

You can assign event privileges to employees.

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Double-click the role type, and click the EMC Modules tab.
3. For each of the following event-related items listed in the File column, select the appropriate employee privileges (View, Edit, Add, and Delete):
   • **Event Types**: This file controls the ability to view, change, create, and delete event types and sub types.
   • **Event Areas**: This file controls the ability to view, change, create, and delete event areas.
   • **Event Definitions**: This file controls the ability to view, change, create, and delete events.

   Setting Employee Roles contains more information about setting employee privileges.

4. To set field level permissions, click the **Fields** tab.

5. Select **Event Definitions** from the EMC Modules list.

6. For **Areas** and **Cancel Event**, select the appropriate permissions from the **Access** drop-down list.

7. To set event check privileges, click the **Operations** tab, and then click the **Transactions** subtab.

8. Select the appropriate options for the privileges. The following table summarizes the check privileges associated with event functionality and the recommended roles to have the privilege set.

   **Table 46-1  Event Check Privileges**

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to Authorize or Perform ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>270</td>
<td>Authorize/Perform association of a new check to an ended event</td>
<td>Creating a new check and linking it to a closed or ended event</td>
<td>Manager</td>
</tr>
<tr>
<td>271</td>
<td>Authorize/Perform override of the &quot;Event association to a Check is mandatory&quot; option (Control Parameters)</td>
<td>Beginning a check without linking it to an event</td>
<td>Manager</td>
</tr>
</tbody>
</table>

9. Click the **Miscellaneous** subtab.

10. Select the appropriate options for the privileges. The following table summarizes the workstation privileges associated with event functionality and the recommended roles to have the privilege set.

   **Table 46-2  Event Privileges**

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to Authorize or Perform ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>272</td>
<td>Authorize/Perform Start an Event</td>
<td>Starting an event</td>
<td>Manager</td>
</tr>
</tbody>
</table>
Table 46-2  (Cont.) Event Privileges

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to Authorize or Perform ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>273</td>
<td>Authorize/Perform End an Event</td>
<td>Ending an event</td>
<td>Manager</td>
</tr>
<tr>
<td>276</td>
<td>Authorize/Perform Select an Event</td>
<td>Selecting an active event as the workstation operator's default event</td>
<td>Manager</td>
</tr>
<tr>
<td>277</td>
<td>Allow selection of ‘No Default Area Selected’ when assigning default event</td>
<td>Selecting a default event without selecting a default area.</td>
<td>Manager</td>
</tr>
</tbody>
</table>

11. Click **Save**.

- Specifying Ad Hoc Reports
- Enabling Events
- Configuring Event Types and Sub Types
- Creating an Event
- Configuring an Event Area
- Linking Events
- Breaking Linked Events
- Cancelling an Event
- Configuring Event Information to Print on Checks and Receipts
- Creating Task Schedules
- Configuring the Event Status Bar
- Configuring the Event Buttons

**Related Topics**

- Event Information in Reporting and Analytics Reports

---

**Specifying Ad Hoc Reports**

You must assign privileges to the employee to run event-related reports from a workstation at the property.

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.
2. Select the role type, click **Operations**, and then click **Ad Hoc Reports**.
3. Select the appropriate event report privileges.
### Table 46-3  Event Report Privileges

<table>
<thead>
<tr>
<th>Report Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31068 - Run Property Financial Event Report</td>
<td>Provides information about events for each property, total event and non-event sales for selected dates, and outstanding (open) checks associated with events.</td>
</tr>
<tr>
<td>31069 - Run Employee Financial Event Report</td>
<td>Provides information about individual employee performance for specific events.</td>
</tr>
<tr>
<td>31070 - Run Menu Item Sales Event Report</td>
<td>Provides a summary of the menu item sales by revenue center and by employee for each event.</td>
</tr>
<tr>
<td>31071 - Run Event Financial Report</td>
<td>Provides a summary of the daily financials by event broken down by area.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

- Configuring Event Privileges and Permissions
- Enabling Events
- Configuring Event Types and Sub Types
- Creating an Event
- Configuring an Event Area
- Linking Events
- Breaking Linked Events
- Cancelling an Event
- Configuring Event Information to Print on Checks and Receipts
- Creating Task Schedules
- Configuring the Event Status Bar
- Configuring the Event Buttons

### Related Topics

- Event Information in Reporting and Analytics Reports

---

**Enabling Events**

You need to turn on events to associate transactions with events and to use event reporting.

1. Select the property, click **Setup**, and then click **Property Parameters**.
2. Click the **Options** tab, and then select **51 - Enable Events Reporting**.
3. Click **Save**.

- Configuring Event Privileges and Permissions
- Specifying Ad Hoc Reports
- Configuring Event Types and Sub Types
Configuring Event Types and Sub Types

An employee with the event types privileges can configure event types and sub types.

1. Select the Enterprise level, click **Setup**, and then click **Event Types**.
2. Insert a record for the event (for example, Baseball Double Header or Social), and then click **OK**.
3. Double-click the event record to open it in form view.
4. To create event sub types related to the event type, in the Event Sub-Types section click **Add**, and then enter an event sub type name (for example, Baseball Game 1, Baseball Game 2, or Wedding).
5. To delete an event sub-type, highlight the Event Sub-Type, and then click **Delete** in the Event Sub-Types section.
6. (Optional) Select the **Menu Level Link** and the **Sub Level Link** to associate with the event type. You must select a main menu level before you can set a sub menu level.

When you assign main or sub levels to an event type, the event transactions at the POS client use these menu levels rather than the default levels. This configuration is useful when a venue and customer agree to a specific pricing level for the event type. For example, a Happy Hour menu level can be set for an event type of Social. This configuration allows a wedding event to apply Happy Hour prices at the workstation, overriding default menu levels set at the revenue center level.

7. Click **Save**.
Creating an Event

1. Select the property, click Configuration, and then click Event Definitions.

2. Insert a new record, enter a name for the event definition, and then double-click the new record.

3. From the Event Data section, enter information in the fields as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Code</td>
<td>Enter an alphanumeric event code. The application appends this code with an automatically generated code to make the value unique.</td>
</tr>
<tr>
<td>Type</td>
<td>Select an event type for the event.</td>
</tr>
<tr>
<td>Sub Type</td>
<td>Select an event sub type for the event.</td>
</tr>
<tr>
<td>Event Start and Event End</td>
<td>Select the event start and end dates. Select Auto Start and Auto End to have the event automatically start or end when the Event Start or End date and time are reached. Dates and times are required when selecting the Auto Start and Auto End options. When a workstation is offline and has no connection to the Check and Posting Service (CAPS), events cannot start or end automatically and manually.</td>
</tr>
<tr>
<td>(Optional) Attendance</td>
<td>Enter the number of people attending the event. You can enter this number during or after the event.</td>
</tr>
</tbody>
</table>

4. Click the Revenue Centers tab.

5. Select one or more revenue centers where the event occurs.

To select multiple revenue centers at once, select the revenue center group from the RVC Groups drop-down list, and then click the Add button. All revenue centers included in the revenue center group are automatically selected.

If the RVC Groups field is dimmed, you need to add at least one revenue center group. Configuring a Revenue Center Group contains more information about setting up revenue center groups.
6. Click **Save**.

7. Events are set as optional by default. To set the event as mandatory:
   a. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Control Parameters**.
   b. Select **67 - Association of an Event to every Guest Check is mandatory where Event feature is enabled**.
      Setting option **67** requires workstation operators to select an event when beginning a check.
      You can override this setting for an employee from the Roles module by selecting Transaction Control option **271 - Authorize/Perform override of the "Event association to a Check is mandatory" option (Control Parameters)**. Overriding option **67** allows the workstation operator to post transactions to no event.
   c. Click **Save**.

- Configuring Event Privileges and Permissions
- Specifying Ad Hoc Reports
- Enabling Events
- Configuring Event Types and Sub Types
- Configuring an Event Area
- Linking Events
- Breaking Linked Events
- Cancelling an Event
- Configuring Event Information to Print on Checks and Receipts
- Creating Task Schedules
- Configuring the Event Status Bar
- Configuring the Event Buttons

**Related Topics**
- Event Information in Reporting and Analytics Reports

---

### Configuring an Event Area

An employee with event areas privileges can set the areas within a property where events take place. An area can be part of one or more revenue centers, or independent of revenue centers. For example, a banking conference might be held in the banquet's revenue center, in several rooms (such as banquet bar, banquet restaurant, banquet cocktail, and ballroom). You can associate these room areas with the event. When the workstation operator signs in to an event that has multiple areas, the operator must select the area in which to work. Each transaction is associated with either one area or no area. The event organizer can view information for each area on workstation reports and Reporting and Analytics reports.

1. Select the property, click **Configuration**, and then click **Event Areas**.
2. Insert a new record, and then enter a name for the event area (for example, Ballroom).
3. Click **Save**.

- Configuring Event Privileges and Permissions
- Specifying Ad Hoc Reports
- Enabling Events
- Configuring Event Types and Sub Types
- Creating an Event
- Linking Events
- Breaking Linked Events
- Cancelling an Event
- Configuring Event Information to Print on Checks and Receipts
- Creating Task Schedules
- Configuring the Event Status Bar
- Configuring the Event Buttons

### Related Topics
- Event Information in Reporting and Analytics Reports

---

**Linking Events**

After creating an event, you can link two or more events so that when one finishes, the other starts (for example, a baseball double header). The linked child event (Game 2) inherits the attributes of the parent event (Game 1), including revenue centers, event areas, and menu levels.

1. Select the property, click **Configuration**, and then click **Event Definitions**.
2. Double-click the event record to open it in form view.
3. Click the **Links** tab.
4. To create a subsequent (child) event for the selected event, select **Add Linked Event**, and then click **Yes** at the confirmation.
5. Double-click the linked event record.
6. From the Linked Event Details dialog, enter information as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Code</td>
<td>You cannot enter a value. The application appends the short code with an automatically generated code to make the event code value unique.</td>
</tr>
<tr>
<td>Short Code</td>
<td>Enter the alphanumeric event code for the event.</td>
</tr>
<tr>
<td>Event Name</td>
<td>Enter a descriptive name for the event.</td>
</tr>
</tbody>
</table>
Table 46-5  (Cont.) Linked Event Details Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Optional) Attendance</td>
<td>Enter the number of people attending the event. You can enter this number during or after the event.</td>
</tr>
<tr>
<td>Event End</td>
<td>Enter the end date and time for the event.</td>
</tr>
</tbody>
</table>

7. Click the **Save Changes** button.

Linked events are not available in the event search list and do not appear in full in the Event Definitions module table view.

- Configuring Event Privileges and Permissions
- Specifying Ad Hoc Reports
- Enabling Events
- Configuring Event Types and Sub Types
- Creating an Event
- Configuring an Event Area
- Breaking Linked Events
- Cancelling an Event
- Configuring Event Information to Print on Checks and Receipts
- Creating Task Schedules
- Configuring the Event Status Bar
- Configuring the Event Buttons

**Related Topics**

- Event Information in Reporting and Analytics Reports

### Breaking Linked Events

There are two methods you can use to break the link of events, each producing a different outcome for the events:

- Break the link between the last linked event and its parent, making the last event the parent event
- Change a linked event to become the parent event, with subsequent events as the new parent's linked events

1. Select the property, click **Configuration**, and then click **Event Definitions**.
2. Double-click the event record to open it in form view.
3. Click the **Links** tab.
4. To break the link between the last event and its parent:
   a. Click the **Break Link** link.
   b. Click **Yes** at the confirmation. The last linked event in the list is removed, and it now appears in the Event Definitions module search/table view as a parent event.
5. To change a linked event into a parent event:
   a. On the Links tab, double-click the linked event record (for example, select linked event 3 of 5) to open the Linked Event Details dialog.
   b. Click the **Break Link** button.
   c. Click **Yes** at the confirmation. Linked event 3 becomes a parent event, and linked events 4 and 5 become its child linked events 1 and 2.

   A linked event that has the chain broken from its parent event in the Linked Event Details dialog is available in the Event Definitions module search/table view, and contains any subsequent linked events as its linked events.

- Configuring Event Privileges and Permissions
- Specifying Ad Hoc Reports
- Enabling Events
- Configuring Event Types and Sub Types
- Creating an Event
- Configuring an Event Area
- Linking Events
- Cancelling an Event
- Configuring Event Information to Print on Checks and Receipts
- Creating Task Schedules
- Configuring the Event Status Bar
- Configuring the Event Buttons

**Related Topics**

- Event Information in Reporting and Analytics Reports

**Cancelling an Event**

When cancelling an event, consider the following rules:

- You can only cancel an event that has the Uninitialized status.
- You can cancel a linked event if the parent event has a Started status.
- When you cancel a parent event, all linked child events are also cancelled.
- After cancelling linked events, you cannot add new linked events if you used the Break Link function on all cancelled linked events.

1. Select the property, click **Configuration**, and then click **Event Definitions**.
2. Double-click the event record to open it in form view.
3. To cancel an event with or without linked events, click **Cancel Event**, and then click **Yes** at the confirmation.
4. To cancel one linked event:
   a. Click the **Links** tab.
   b. Double-click the linked event record to open the Linked Event Details.
c. Click Cancel Event, and then click Yes at the confirmation.

5. To cancel multiple linked events:
   a. Click the Links tab.
   b. Double-click the first linked event record to open the Linked Event Details.
   c. Click Cancel Event, and then click Yes at the confirmation. The linked event Status shows Cancelled and Add Linked Event is dimmed. The parent event is not cancelled.

- Configuring Event Privileges and Permissions
- Specifying Ad Hoc Reports
- Enabling Events
- Configuring Event Types and Sub Types
- Creating an Event
- Configuring an Event Area
- Linking Events
- Breaking Linked Events
- Configuring Event Information to Print on Checks and Receipts
- Creating Task Schedules
- Configuring the Event Status Bar
- Configuring the Event Buttons

Related Topics
- Event Information in Reporting and Analytics Reports

Configuring Event Information to Print on Checks and Receipts

You can configure the printing of an event name and code on guest check headers and trailers, customer receipts, and credit card vouchers.

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Format Parameters.
2. Click the Options tab.
3. Select the appropriate printing options:
   - 59 - Print Event Name After Header on Guest Checks and Receipts: Select this option to print the event short code and name after the header on guest checks and customer receipts.
   - 60 - Print Event Name After Trailer on Guest Checks and Receipts: Select this option to print the event short code and name after the trailer on guest checks and customer receipts.
4. Click Save.
Creating Task Schedules

A Task Schedule is a timed task that occurs on a Check and Posting Service Host or on a workstation. These tasks perform database-related functions that increase performance of the device.

1. Select the Enterprise or property, click Configuration, and then click Task Schedules.

2. Insert a new record or double-click an existing task schedule record to open it in form view.

The database includes the following default task schedule records:

- **Purge C&P DB data older than 7 days**: Cleans the Check and Posting database for records older than seven days.
- **Purge WS DB data older than 7 days**: Cleans the workstation database for records older than seven days.
- **Update C&P DB Statistics**: Runs an Update Statistics command on the Check and Posting database.
- **Update WS DB Statistics**: Runs an Update Statistics command on the workstation database.

The purge jobs clear check and totals information, along with message requests that are stored in the local database.

3. From the General Settings section, enter information in the fields as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Type</td>
<td>Select the type of service to receive the task, either 7 - Workstation or 8 - Check and Posting.</td>
</tr>
</tbody>
</table>
Table 46-6  (Cont.) General Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service ID</td>
<td>Select the service identification for which the task runs. You can only change this value at the property level.</td>
</tr>
<tr>
<td>Task Type</td>
<td>Select the type of task.</td>
</tr>
<tr>
<td></td>
<td>When the task schedule is:</td>
</tr>
<tr>
<td></td>
<td>• Database purge, the database for the selected service purges old data. The <strong>Task Data</strong> field should indicate the number of days to keep data in the local database.</td>
</tr>
<tr>
<td></td>
<td>• Update statistics, the local database performs an update statistics job at the scheduled time. The <strong>Task Data</strong> field should contain a semicolon-separated list of database tables on which the Update Statistics command runs.</td>
</tr>
<tr>
<td></td>
<td>• Run script, the <strong>Task Data</strong> field should contain the full path to a script to execute.</td>
</tr>
<tr>
<td>Task Data</td>
<td>This value shows the relevant data for the <strong>Task Type</strong>.</td>
</tr>
<tr>
<td>Duration (seconds)</td>
<td>Enter the duration of the task. The duration time prevents the task from running too long. The duration time does not cause tasks to terminate immediately. For example, the Update Statistics job finishes each database table listed, and then checks the duration of the overall task.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Select the time zone for the task, which determines the time of day when the task runs.</td>
</tr>
<tr>
<td></td>
<td>A common setting for this field is <strong>0 - Local Time Zone</strong>, causing the task to run in each property based on the local time at the property.</td>
</tr>
<tr>
<td>Schedule Type</td>
<td>Select the recurrence frequency for the task schedule (for example, one time, daily, weekly, or monthly).</td>
</tr>
</tbody>
</table>

4. From the Duration section, select **Enabled** to run the task schedule at the set time. Deselect this option if you do not want the task schedule to run.
   a. In the **Start date** field, select the first date for the task schedule to run.
   b. To end the task schedule on a specific date, select **End date**, and then select the date for the task schedule to end. If the task schedule has no end date, select **No end date**.

5. If you selected a recurring frequency in the **Schedule Type** field, click the **Recurrence** tab. The available fields are based on the recurring frequency you selected (daily, weekly, or monthly).

6. Select the appropriate day and time options for the frequency.

7. Click **Save**.
Configuring the Event Status Bar

To allow workstation operators to see the event and check details to which sales are posting, you need to add the event status bar to the transaction page, and configure the event information that appears in the status bar.

1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Design.
2. Open the page on which to place the event status bar (typically the transaction page).
3. Click the Configuration tab.
4. Select one or both of the following placement options:
   - Top Status Bar
   - Bottom Status Bar
5. Click the Add button in the lower area.
6. From the Add Status Bar Element dialog, select Operator Current Event Name for each of the following POS state drop-down lists, and then click OK.
   - Signed Out
   - Signed In
   - In Transaction
7. Repeat Steps 5 and 6, selecting the following elements for each POS client drop-down list:
   - Operator Current Event Shortcode
   - Operator Current Event Actual Start Date Time
   - Operator Current Event End Date Time
• Check Current Event Name
• Check Current Event Shortcode
• Check Current Event Actual Start Date Time
• Check Current Event End Date Time

8. Click **Save**.

• Configuring Event Privileges and Permissions
• Specifying Ad Hoc Reports
• Enabling Events
• Configuring Event Types and Sub Types
• Creating an Event
• Configuring an Event Area
• Linking Events
• Breaking Linked Events
• Cancelling an Event
• Configuring Event Information to Print on Checks and Receipts
• Creating Task Schedules
• Configuring the Event Buttons

Related Topics
• Event Information in Reporting and Analytics Reports

### Configuring the Event Buttons

To allow workstation operators to manually start and end an event, you need to add buttons assigned to the touchscreen page.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.
2. Open the page on which to place the **Start Event** and **End Event** buttons.
3. On the Edit tab, select the page area in which to define the **Start Event** button.
4. Click **Button**.
5. On the General subtab, enter the button name (for example, Start Event) in the **Legend** field.
6. Select **Function** from the **Type** drop-down list.
7. Click the black arrow directly beneath the **Type** drop-down list, select the type **Event Management**, select the results **Start Event**, and then click **OK**.
8. Position and size the button on the page. Use the Style arrow to change the color.
9. Repeat Steps 3 through 9 to create the **End Event** button, selecting **End Event** for the result.
10. Click **Save**.
Event Information in Reporting and Analytics Reports

You can view Simphony event-related reporting information in Reporting and Analytics version 8.5.1 and later. The event information includes event code, name, type, sub type, and area.

Table 46-7    Reporting and Analytics Event Reporting

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
</table>
| Events Summary Reports        | These reports provide summary information for properties with events enabled, and help you identify top level areas that need improvement for subsequent events. The following summary reports include event information:  
  • Events Today’s Operations Report  
  • Events Revenue Center Report  
  Only the Events Today’s Operations Report enables you to drill down to more information or investigate further by running Detail Reports. |
<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail Reports</td>
<td>These reports help you analyze the transaction details for specific events. Parent and child events are shown separately.</td>
</tr>
<tr>
<td></td>
<td>The following detail reports include event information:</td>
</tr>
<tr>
<td></td>
<td>• Events Adjustments Detail Report</td>
</tr>
<tr>
<td></td>
<td>• Events Control Report</td>
</tr>
<tr>
<td></td>
<td>• Events Cost of Goods Sold Summary Report</td>
</tr>
<tr>
<td></td>
<td>• Events Daily Discounts Report</td>
</tr>
<tr>
<td></td>
<td>• Events Sales Mix Summary Report</td>
</tr>
<tr>
<td></td>
<td>• Events Service Charges Report</td>
</tr>
<tr>
<td></td>
<td>• Events Taxes Report</td>
</tr>
<tr>
<td></td>
<td>• Events Tender Media Report</td>
</tr>
<tr>
<td></td>
<td>Most detail reports enable you to drill down to more information.</td>
</tr>
<tr>
<td>Comparison Reports</td>
<td>These reports provide information for comparing key performance indicators used in specific events. Comparison reports help you</td>
</tr>
<tr>
<td></td>
<td>analyze productivity in different revenue centers and plan future events. Parent and child events are shown separately.</td>
</tr>
<tr>
<td></td>
<td>The following comparison reports include event information:</td>
</tr>
<tr>
<td></td>
<td>• Events Daily Operations Comparison by Revenue Center (also includes tax information)</td>
</tr>
<tr>
<td></td>
<td>• Events Store and Date Comparison Report</td>
</tr>
<tr>
<td></td>
<td>These reports do not enable you to drill down to more information.</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Menu Engineering Reports              | These reports provide information to help you analyze the menu mix, prices, and cost of goods for specific events. Menu engineering reports enable you to increase event revenue by planning menus for subsequent events using menu information from past events. Parent and child events are shown separately. The following menu engineering reports include event information:  
  • Events Menu Engineering Items Summary Report  
  • Menu Engineering by Major and Family Group Reports  
  • Events Item Groups Average Pricing Report  
  • Sales Mix Summary Report  
  • Top Items Summary Report  
  Only the Menu Engineering by Major and Family Group and Events Item Groups Average Pricing reports enable you to drill down to more information. |
| Employee Reports                      | These reports provide information about employee performance for specific events. Employee reports help you to select the most productive staff for events and highlight training issues. Parent and child events are shown separately. The following employee reports include event information:  
  • Employee Productivity Report  
  • Events Employee Financial List Report (also includes tax information)  
  • Events Employee Sales Performance Report  
  • Events Tip Track Summary Report  
  • Events Manager Control Report  
  • Events Employee Control Report  
  These reports enable you to drill down to more information. |
| Events Daily Operations Summary Report | This report provides a summary of the daily operations, including tax information, for one or more events.  
  This report enables you to drill down to more information. |
| Events Financial Report               | This report provides a summary of the daily financials by event. The Events Financial Report shows all tenders, service charges, discounts, taxes, and void activity per revenue center during the event.  
  This report enables you to drill down to more information. |
Table 46-7  (Cont.) Reporting and Analytics Event Reporting

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events Consolidated Employee Financial Report by RVC</td>
<td>This report shows a combined view of the employee financials by revenue center for each event. It also shows all tenders, service charges, discounts, taxes, and void activity per revenue center during the event. This report enables you to drill down to more information.</td>
</tr>
<tr>
<td>Events Menu Item Report by RVC by Employee</td>
<td>This report provides a summary of the menu item sales by revenue center and by employee for each event. The report shows the revenue center number and name, the employee, menu item, quantity sold, price, sales less item discounts, taxes, and net sales. This report enables you to drill down to more information.</td>
</tr>
<tr>
<td>Consolidated Events Employee Meal</td>
<td>This report shows a combined view of the employee meals for an event. The report shows the revenue center, the employee consuming the meal, the check number, the time of the transaction, the menu items, the price when the menu item was ordered, taxes associated with the transaction, net sales of the transaction, and the employee adding the sales. This report enables you to drill down to more information.</td>
</tr>
<tr>
<td>Event Consolidated RVC Financial</td>
<td>This report shows a combined view of the revenue center financials by event. The report shows all tenders, service charges, discounts, taxes, net sales, voids, transaction count, and percent of sales per revenue center during the event. This report enables you to drill down to more information.</td>
</tr>
</tbody>
</table>
| KDS Reports                                      | These reports provide information to help you analyze the sales mix and labor for specific events. Parent and child events are shown separately. KDS reports help to identify problems with preparation and service times, and improve these times for subsequent events. The following KDS reports include event information:
  - Events KDS Summary Report
  - Events Today’s KDS Summary Report
  - Speed of Service Report
These reports enable you to drill down to more information. |

Related Topics

- Configuring Event Privileges and Permissions
• Specifying Ad Hoc Reports
• Enabling Events
• Configuring Event Types and Sub Types
• Creating an Event
• Configuring an Event Area
• Linking Events
• Breaking Linked Events
• Cancelling an Event
• Configuring Event Information to Print on Checks and Receipts
• Creating Task Schedules
• Configuring the Event Status Bar
• Configuring the Event Buttons

Related Topics
• Enabling Reports in Enterprise Back Office
You can manage the dining room using Simphony with a standard table management interface, or using the enhanced Table Management System (available with Simphony version 2.6 and later).

- Standard and Enhanced Table Management
- Configuring the Standard Table Management Interface
- Creating Standard Dining Tables
- Configuring the Standard Dining Table Status Set
- Table Management
- Reservation List
- Wait List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Configuring Table Management Privileges
- Configuring Reservation Privileges
- Configuring Wait List Privileges
- Configuring Servers for Table Management
- Configuring Properties for Table Management
- Configuring Custom Images for Table Management
- Configuring KDS or Dining Course Colors and Images for Table Management
- Configuring Dining Course Pacing
- Configuring the Service Total Tender for Table Management
- Enhanced Dining Tables
- Setting Dining Table Classes
- Setting Enhanced Dining Table Attributes
- Configuring Enhanced Dining Tables
- Setting Table Decorator Images
- Configuring Server and Table Availability
- Setting Table Management Options
- Configuring Table Suggestion Factors
- Table Management Alerts
- Configuring Alerts
- Table Management Sections
- Configuring Sections
Creating the Touchscreen Reservation List
Creating the Touchscreen Wait List
Touchscreen Page Table Management Tasks
Host Command Area
Configuring the Host Command Area
Dining Table Status
Configuring the Dining Table Status
Employee Lines
Configuring Employee Lines
Section Layout
Creating a Section Layout
Creating Enhanced Dining Tables
Setting Table Management Functions in Check Detail
Creating the Employee Section Assignment Report Button
Configuring Table Cancellation Reasons
Setting Reservation Timing Parameters
Setting Wait List Timing Parameters
Reservation Periods
Configuring Effectivity
Configuring Acceptance Limits
Configuring Occupancy Limits
Configuring Seating Limits
Configuring Target Turn Times
Table Management Configuration Levels
Reservation Configuration Levels
Wait List Configuration Levels

Standard and Enhanced Table Management

Dining staff can manage tables in Simphony using one of the following methods:
- Standard table management interface
- Enhanced or integrated tables (available with the Table Management System)

The following table outlines the differences between the two table management methods:

<table>
<thead>
<tr>
<th>Function</th>
<th>Standard Tables</th>
<th>Enhanced Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept reservations</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 47-1  (Cont.) Differences Between Standard and Enhanced Table Management

<table>
<thead>
<tr>
<th>Function</th>
<th>Standard Tables</th>
<th>Enhanced Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage a Reservation List</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Manage a Wait List</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Provide wait quotes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Show table status</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Estimate table turn times</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Assign tables to sections and employees</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Join and split tables</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Suggest tables</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Use function keys on the workstation for bussing and transferring tables</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Interface with Oracle Hospitality Gift and Loyalty Advanced Cloud Service</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Related Topics

- Configuring the Standard Table Management Interface
- Creating Standard Dining Tables
- Configuring the Standard Dining Table Status Set

Configuring the Standard Table Management Interface

1. Select the Enterprise level, click **Setup**, and then click **Interfaces**.
2. Insert a record for Standard Table Management, and then open it in form view.
3. From the **Interface Type** drop-down list, select **3 - Table Management**.
4. From the **Communications Type** drop-down list, select **1 - TCP**.
5. In the **Timeout** field, enter the amount of time (in seconds) that Simphony waits for a response from the standard table management interface before showing a communications failure message.
6. In the **Ping Frequency** field, enter the amount of time (in seconds) that Simphony pings the standard table management server (for example, every 5 seconds).
7. Click the **Options** tab, and then select the appropriate options as described in the following table.

Table 47-2  Standard Table Management Interface Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 - Enable Interface Log</td>
<td>Select this option to post debug information to the Interface log file.</td>
</tr>
<tr>
<td>5 - ON = Use 9 digits for Terminal IDs; OFF = Use 2 digits for Terminal IDs</td>
<td>Select this option to transmit the entire nine-digit workstation ID to the standard table management system.</td>
</tr>
</tbody>
</table>
Table 47-2  (Cont.) Standard Table Management Interface Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 - Enable Offline Posting</td>
<td>Select this option to allow offline posting to the Simphony POS client.</td>
</tr>
<tr>
<td>9 - Determine Link Status Using Ping</td>
<td>Select this option to allow the Simphony POS client to ping the standard table management system.</td>
</tr>
<tr>
<td>10 - ON = Use 5-digit RVC #; OFF = Use 3-digit RVC #</td>
<td>Select this option to allow the standard table management system posting message to support a five-digit revenue center number. (Otherwise, the posting is limited to a three-digit revenue center number.)</td>
</tr>
<tr>
<td>11 - ON = Use 8-digit Check #; OFF = Use 4-digit Check #</td>
<td>Select this option to allow the standard table management system posting message to support an eight-digit check number. (Otherwise, the posting is limited to a four-digit check number.)</td>
</tr>
</tbody>
</table>

8. In the TCP Host Name field, enter the name or IP address of the standard table management server for the interface.

9. In the Port Number field, enter 0 (zero).

10. Click the Properties tab, and select each property that uses the standard table management system interface.

11. Click the Service Host tab, and then select the service host that can run the standard table management system interface.

12. Click Save.

13. Select the revenue center, click Setup, and then click RVC Parameters.

14. Click the Interfaces tab.

15. Select the TMS Operator to whom a check that is opened by the standard table management system is assigned, before being picked up by a server.

16. Select the TMS User Workstation to which a check that is opened by the standard table management system is assigned.

17. From the TMS Link drop-down list, select the standard table management interface.

18. Click Save.

- Creating Standard Dining Tables
- Configuring the Standard Dining Table Status Set

Related Topics
- Standard and Enhanced Table Management

Creating Standard Dining Tables

1. Select the Enterprise, property, or revenue center, click Configuration, and then click Page Design.

2. Double-click the Front of House page on which to define standard dining tables.
3. On the **Edit** tab, select the page area on which to place the standard dining tables.

4. Select **Other...**, and then select **Dining Table**.

5. Move and adjust the table size on the page. Leave space between tables on the page layout to ensure visibility of indicators and table state. You can increase the grid configuration on the page from 24 (default) to 48 using the **Change Grid Size** link.

6. Repeat Steps 4 and 5 to create additional standard dining tables.

7. Click **Save**.

### Related Topics
- Configuring the Standard Table Management Interface
- Configuring the Standard Dining Table Status Set

---

### Configuring the Standard Dining Table Status Set

You can configure a dining table status set to allow workstation operators to manually assign a specific table status value from the set. For example, dining tables could be used to begin new takeout orders. Workstation operators can update the status of the table based upon the readiness of the order (such as Preparing, Ready, or Called Running Late).

This feature is only available with standard dining tables (not enhanced or integrated tables).

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **Dining Table Status Set**.

2. Insert a record for the Dining Table Status Set, and then open it in form view.

3. Click **Add**, and then enter or select information for the fields as described in the following table.

#### Table 47-3  Standard Dining Table Status Set Fields and Options

<table>
<thead>
<tr>
<th>Field or Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the dining table status set (for example, waiting or eating).</td>
</tr>
<tr>
<td>Override Background Color</td>
<td>Click the ellipsis point (…) button, select the background color, and then click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Override Text Color</td>
<td>Click the ellipsis point (…) button, select the text color, and then click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Override Image</td>
<td>Click the ellipsis point (…) button, select the image, and then click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
Table Management

Chapter 47

You can integrate dining room management, reservation list, wait list, customer preferences and seating, and staff availability with the Symphonic Table Management System, Reservation List, and Wait List.

The Symphonic Table Management System (TMS) allows you to perform the following actions:

- Make reservations
- Maintain a Wait List
- Seat guests immediately at available tables
- Control the number of reservations allowed during specific time periods
- See an overview of enhanced dining tables and status
- Update the table status based on coursing
- Manage the seating layout with table, section, and server assignments
- Change table seating capacities
- Estimate wait quote times

Table Management, Reservation, and Wait List Configuration Prerequisites
Related Topics

- Table Management Configuration Levels

Reservation List

The Reservation List contains all reservation requests for the revenue center. Hosting staff with access to the Reservation List can create, edit, and cancel reservation requests from the list.

- Table Management, Reservation, and Wait List Configuration Prerequisites

Related Topics

- Configuring Reservation Privileges
- Creating the Touchscreen Reservation List
- Setting Reservation Timing Parameters
- Reservation Configuration Levels

Wait List

Often a guest arrives and asks for a table. When tables are not immediately available for seating, the guest may request a wait time and add their name to a Wait List. The Wait List contains all wait requests for the revenue center. The Wait List also shows reservations prior to the scheduled arrival. Reservations appear on the Wait List a configured number of minutes prior to the schedule seating time. Hosting staff with access to the Wait List can add, change, and abandon wait requests from this list. Hosting staff can manage the Wait List on its own page or as a popup in the host view.

- Table Management, Reservation, and Wait List Configuration Prerequisites

Related Topics

- Configuring Wait List Privileges
- Creating the Touchscreen Wait List
- Setting Wait List Timing Parameters
- Wait List Configuration Levels

Table Management, Reservation, and Wait List Configuration Prerequisites

Before configuring reservations, you must complete the following tasks:

- Configure the Simphony Table Management System (TMS)
- Configure the Simphony Wait List to accept and seat guests with reservations

If the property is using a Wait List, but does not take reservations, you only need to configure the TMS before setting up the Wait List. (A Reservation List is not required with the Wait List.)

The Simphony TMS, Reservations, and Wait List integrate with loyalty applications such as Oracle Hospitality Gift and Loyalty, and third party loyalty applications based
on the loadable loyalty modules. When you use Simphony TMS, Reservations, or Wait List with loyalty applications, workstation operators can associate the loyalty account with the reservation request or walk-in guest. After associating guest loyalty information with the table request, the information follows the guest through the life of the guest check. To use the Simphony TMS, Reservations, or Wait List with a loyalty application, you must configure the loadable loyalty module. Loyalty Configuration Tasks contains more information about configuring the loyalty module.

- Table Management

Related Topics
- Table Management Configuration Levels
- Reservation List

Related Topics
- Configuring Reservation Privileges
- Creating the Touchscreen Reservation List
- Setting Reservation Timing Parameters
- Reservation Configuration Levels
- Wait List

Related Topics
- Configuring Wait List Privileges
- Creating the Touchscreen Wait List
- Setting Wait List Timing Parameters
- Wait List Configuration Levels

Configuring Table Management Privileges

1. Select the Enterprise, click Configuration, and then click Roles.
2. Select the role type, click the Operations tab, and then click the Guest Management subtab.
3. Select the appropriate options for the privileges. The following table summarizes the privileges associated with table management functionality and the recommended roles to have the privilege set.

Table 47-4    Table Management Privileges

<table>
<thead>
<tr>
<th>Tab Location</th>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allows the Employee to ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest Management</td>
<td>32020</td>
<td>Edit Section Layout</td>
<td>Edit a section layout</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32021</td>
<td>Activate Section Layout</td>
<td>Activate a defined section layout as the Active Layout</td>
<td>Host, Manager</td>
</tr>
</tbody>
</table>
Table 47-4  (Cont.) Table Management Privileges

<table>
<thead>
<tr>
<th>Tab Location</th>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allows the Employee to ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest Management</td>
<td>32022</td>
<td>Delete Section Layout</td>
<td>Delete an existing section layout</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32031</td>
<td>Assign Employee to Table</td>
<td>Assign an employee to a table or section in TMS</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32032</td>
<td>Mark Table Clean or Dirty</td>
<td>Mark a table as clean or dirty</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32033</td>
<td>Change Table State</td>
<td>Mark tables as being Available, Closed, Reserved, or Merged</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32034</td>
<td>Seat Unsuggested Table</td>
<td>Seat a table request at a table that is different than the table that was suggested by the TMS Table Suggestion System</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32037</td>
<td>View Legend</td>
<td>View the TMS Legend and use the available functions contained within the form</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32038</td>
<td>Allow Seating Guest Above or Below Table Capacity</td>
<td>Seat a table request at a table that does not support a different seating capacity (other than the cover count on the table seating request)</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32039</td>
<td>Allow Seating Guest at Table that does not Meet all Required Table Preferences</td>
<td>Seat a table request at a table that does not meet all of the seating preferences defined on the table seating request</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Management</td>
<td>32040</td>
<td>Edit Server Availability</td>
<td>Edit the server availability</td>
<td>Host, Manager</td>
</tr>
</tbody>
</table>
Table 47-4  (Cont.) Table Management Privileges

<table>
<thead>
<tr>
<th>Tab Location</th>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allows the Employee to ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ad Hoc Reports</td>
<td>31044</td>
<td>Run Employee Section Assignment Report</td>
<td>Run the Employee Section Assignment Report</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Transactions</td>
<td>22</td>
<td>Post Payment to Checks Belonging to Another Operator</td>
<td>Unseat a table request</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Transactions</td>
<td>37</td>
<td>Authorize/Perform Posting of Payment</td>
<td>Unseat a table request</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Transactions</td>
<td>38</td>
<td>Authorize/Perform Closing of Checks with a Zero Balance</td>
<td>Unseat a table request</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>Guest Checks</td>
<td>18</td>
<td>Authorize/Perform Pickup of a Check Belonging to Another Operator</td>
<td>Unseat a table request</td>
<td>Host, Manager</td>
</tr>
</tbody>
</table>

4. Click **Save**.

Configuring Reservation Privileges

1. Select the Enterprise, click **Configuration**, and then click **Roles**.

2. Select the role type, click the **Operations** tab, and then click the **Guest Management** subtab.

3. Select the appropriate options for the privileges. The following table summarizes the privileges associated with reservation functionality and the recommended roles to have the privilege set:

Table 47-5  Reservation Privileges

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>32006</td>
<td>Greet Wait List Entry</td>
<td>Greet a reservation request if the party arrives earlier than the time at which the reservation automatically moves to the Wait List</td>
<td>Host, Manager</td>
</tr>
</tbody>
</table>
Table 47-5  (Cont.) Reservation Privileges

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>32007</td>
<td>Mark as No Show</td>
<td>Mark a reservation request as a no-show if the guest does not arrive</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32010</td>
<td>Add Reservation Entry</td>
<td>Create a reservation request</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32011</td>
<td>Edit Reservation Entry</td>
<td>Edit an existing reservation request</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32012</td>
<td>Cancel Reservation Entry</td>
<td>Cancel a reservation request</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32013</td>
<td>Approve Reservation Entry</td>
<td>Approve a reservation that is requesting a date or time outside the acceptable or allowable timeframe</td>
<td>Host, Manager</td>
</tr>
</tbody>
</table>

4. Click Save.

- Creating the Touchscreen Reservation List
- Setting Reservation Timing Parameters

Related Topics
- Reservation List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Reservation Configuration Levels

Configuring Wait List Privileges

1. Select the Enterprise, click Configuration, and then click Roles.
2. Select the role type, click the Operations tab, and then click the Guest Management subtab.
3. Select the appropriate options for the privileges.

The following table summarizes the privileges associated with wait list functionality and the recommended roles to have the privilege set:

Table 47-6  Wait List Privileges

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>32001</td>
<td>Add Wait List Entry</td>
<td>Create a new Wait List request</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32002</td>
<td>Edit Wait List Entry</td>
<td>Edit an existing Wait List request</td>
<td>Host, Manager</td>
</tr>
</tbody>
</table>
Table 47-6  (Cont.) Wait List Privileges

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to ...</th>
<th>Recommended Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>32003</td>
<td>Abandon Wait List Entry</td>
<td>Abandon a Wait List request</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32004</td>
<td>Seat Wait List Entry</td>
<td>Seat a Wait List request</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32005</td>
<td>Unseat Wait List Entry</td>
<td>Unseat a Wait List request</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32006</td>
<td>Greet Wait List Entry</td>
<td>Greet a Wait List request</td>
<td>Host, Manager</td>
</tr>
<tr>
<td>32007</td>
<td>Mark as No Show</td>
<td>Mark a reservation request as a no-show if the guest does not arrive</td>
<td>Host, Manager</td>
</tr>
</tbody>
</table>

4. Click Save.

- Creating the Touchscreen Wait List
- Setting Wait List Timing Parameters

Related Topics
- Wait List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Wait List Configuration Levels

Configuring Servers for Table Management

1. Select the Enterprise, property, or revenue center, click Configuration, and then click Employee Maintenance.

2. Search for and select the employee record.

3. In the Check Name field, enter the server’s name as you want it to appear on the workstation. If you do not enter a Check Name, the workstation shows a blank name.

4. Click the Operator Records subtab near the lower area of the screen.

5. In the TMS Color field, select the color to distinguish the server from other servers on the host page, and then click OK.

   Although you can set a different color for each revenue center within a property, Oracle recommends that you use a single color for the server across the property. If you do not set a TMS Color, the workstation shows white.

6. In the Server Efficiency field, enter 0 (zero) if you want the Simphony TMS to ignore the server in the table suggestions.

   The Table Suggestion System (within TMS) sets the Server Efficiency rating to determine the next table recommended for seating. This rating is a value between 0 (zero) and 100, and represents the number of covers that the server can efficiently service at one time.

7. Click Save.
Configuring Properties for Table Management

1. Select the property, click **Setup**, and then click **Properties**.
2. Highlight the property record.
3. In the **Simphony Platform** field, select **2 - Extensible Clients and Architecture**.
4. Click **Save**.

Configuring Custom Images for Table Management

You can load custom images into the Simphony application to represent table seating configuration and statuses. The TMS uses both custom images and images packaged with Simphony. All images are transparent Portable Network Graphics (PNG) files.

Table images show a graphical representation of the table and chairs. These images can be a square or round table surrounded by any number of chairs.

Table decorators show a graphical representation of the table status (for example, dirty, closed, or reserved).

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **Content**.
2. Double-click the content name row to view the image set for that name.
3. Click the **Import from a file** link to import custom images.
4. Browse to the file location, select the image file, and then click **Open**.
5. Repeat Steps 2 through 4 to import each table image and table decorator.
6. Click **Save**.

Configuring KDS or Dining Course Colors and Images for Table Management

You can set a color or image to indicate the KDS or dining course that the table is being serviced under.

1. Select the Enterprise or property, click **Descriptors**, and then click **KDS/Dining Course**.
2. Insert dining course records if they do not exist.
3. In the **Course Color** field, select a color for each dining course name.
   This color appears as the dining course indicator on the table image in the workstation. For example, appetizers can be green, entrées can be yellow, and desserts can be red.
4. (Optional) From the **Course Image Name** field, select a the course decorator image to represent the dining course (in place of a course color). The image you select replaces the default Occupied image on the table. To remove a Course Image that was previously set, select **0 - None**, and then click **OK**.
5. Click **Save**.
Configuring Dining Course Pacing

You can set the pace at which Simphony sends dining courses to the kitchen. This feature only works for menu items that have KDS prep times configured.

1. In the EMC, select the Enterprise, or property, click Descriptors, and then click KDS/Dining Course.
2. Insert a dining course record if it does not exist, and then enter the following information:
   - **Initial Course Min Prep Time**: Enter the target done time for the course. For example, if you enter 10 minutes and an item with a prep time of 6 minutes is sent to the kitchen, it will not fire to Prep Stations until 4 minutes have elapsed. If an item with a prep time of more than 10 minutes or without any prep time is sent to the kitchen, it will fire immediately. The timer for the next course does not start until this time is exceeded.
   - **Min Prep Time**: Enter the minimum amount of time that the KDS Controller should wait before sending the next course to the kitchen after the current course is bumped from all Prep Stations. This option is not applicable to the first dining course.
   - **Max Prep Time**: Enter the maximum amount of time that the KDS Controller should wait before sending the next course to the kitchen after the current course is bumped from all Prep Stations.
3. Click Save.

Configuring the Service Total Tender for Table Management

You can configure a unique service total tender media record to process seating and unseating of guests.

1. Select the Enterprise, click Configuration, and then click Tender/Media.
2. Create a tender media record, and then name it TMS.
3. Double-click the record to open it.
4. From the Key Type drop-down list, select 2 - Service Total.
5. Click Save.

Enhanced Dining Tables

Complete the following tasks to set up enhanced dining tables:

- Set Dining Table Classes
- Set Enhanced Dining Table Attributes
- Configure Enhanced Tables

**Related Topics**

- Setting Dining Table Classes
- Setting Enhanced Dining Table Attributes
Setting Dining Table Classes

You can group and configure similar tables into a dining table class.

1. Select the Enterprise, property, or revenue center, click Setup, and then click Dining Table Class.
2. Insert a dining table class.
3. Select or enter information for the following fields.

<table>
<thead>
<tr>
<th>Table 47-7 Dining Table Class Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>(Optional) Default Background Color</td>
</tr>
<tr>
<td>(Optional) Default Text Color</td>
</tr>
<tr>
<td>(Optional) Default Image</td>
</tr>
<tr>
<td>Minimum Covers</td>
</tr>
<tr>
<td>Maximum Covers</td>
</tr>
<tr>
<td>Options</td>
</tr>
</tbody>
</table>

4. Click Save.

- Setting Enhanced Dining Table Attributes
- Configuring Enhanced Dining Tables

Related Topics
- Enhanced Dining Tables
Setting Enhanced Dining Table Attributes

You can set characteristics of the table for use in the table suggestion process.

1. Select the property, click Setup, and then click TMS Table Attributes.
2. Select or enter information for the following fields.

<table>
<thead>
<tr>
<th>Table 47-8 TMS Table Attributes Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Code</td>
</tr>
<tr>
<td>(Optional) Is Exclusive</td>
</tr>
</tbody>
</table>

3. Click Save.

- Setting Dining Table Classes
- Configuring Enhanced Dining Tables

Related Topics
- Enhanced Dining Tables

Configuring Enhanced Dining Tables

Dining tables represent the physical location where a party can be seated with a Quick Seating operation or from the Wait List.

1. Select the property, click Setup, and then click Tables.
2. Select or enter information for the following fields.

<table>
<thead>
<tr>
<th>Table 47-9 Tables Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>Table Number (# symbol)</td>
</tr>
</tbody>
</table>
Table 47-9  (Cont.) Tables Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name         | Enter a unique table name for all revenue centers within the property. The table name appears on the workstation and represents the local facing name or number used to differentiate the table from others. Values in the Name field can be:  
  - All numeric  
  - All alpha  
  - Alpha and then numeric                                                                                                                                 |

| Class         | Select the dining table class. The dining table class defines the type of table. All instances of this table number use the color, image, and cover configurations defined for the selected dining table class.  
Create only tables that are to be used for seating within a revenue center. Creating non-seatable tables (such as bar tabs) prevents the table suggestion system from properly distributing tables.  
Do not delete tables unless you no longer need them for reports. Oracle Hospitality recommends that you assign tables that are not used to a dining table class named to indicate this status. For example, create a dining table class named NOT IN USE and assign unused tables to this class. Tables assigned to the NOT IN USE class cannot be used for seating, but remain in the Simphony TMS for reporting purposes. |

| Table Attributes | Click the Add link to associate one or more attributes with a table. When you set attributes, the application matches guest preferences with tables. For example, when a guest prefers window seats, tables associated with a window seating attribute move up in the table suggestion process. |

| Mergeable Tables | Click the Add link to add the tables that workstation operators can select for merging with the selected table.  
Click the Delete link to remove tables from the mergeable table assignment.  
Select None in the record or leave the Mergeable Tables section empty to indicate that the selected table has no merge restrictions and it can be merged with any table. |

3. Click Save.

- Setting Dining Table Classes
- Setting Enhanced Dining Table Attributes
Related Topics

- Enhanced Dining Tables

Setting Table Decorator Images

1. Select the Enterprise, property, or revenue center, click Setup, and then click TMS Parameters.

2. (Optional) Click the link next to each Dining Table Decoration Image Name to view a list of images (set as custom images).

Dining table images are optional but useful as part of daily table management operations. Configuring Custom Images for Table Management contains more information about setting custom images.

3. Select an image to represent each of the following statuses:

<table>
<thead>
<tr>
<th>Table Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>The application uses this decorator when a workstation operator selects one or more tables. Table selection is only available on a page with the Host Command Area. Table selection allows the workstation operator to apply a specific action to the selected tables.</td>
</tr>
<tr>
<td>Dirty</td>
<td>The application uses this decorator when a table is in a status of Dirty. Workstation operators can still seat guests at dirty tables.</td>
</tr>
<tr>
<td>Seated</td>
<td>The application uses this decorator when a guest is newly seated at a table. This status remains until the guest places an order. After placing an order, the table status changes to Occupied.</td>
</tr>
<tr>
<td>Occupied</td>
<td>The application uses this decorator after a guest places an order at the table. This status remains until the guest tenders the check. The image associated with the Occupied status is overridden when you set images for dining courses. Configuring KDS or Dining Course Colors and Images for Table Management contains more information about setting dining course images.</td>
</tr>
<tr>
<td>Printed</td>
<td>The application uses this decorator when the workstation operator prints the guest check. The table is considered occupied, and the Printed status appears in addition to the Occupied status.</td>
</tr>
</tbody>
</table>
Table 47-10  (Cont.) Dining Table Decoration Images

<table>
<thead>
<tr>
<th>Table Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paid</td>
<td>The application uses this decorator after a guest completes the dining experience and tenders the check. This status remains for the duration of time set in the Auto Reset Paid Status (Minutes) field. Host staff can seat new guests at tables marked as Paid. After a host seats a guest at a Paid table, the table status resets.</td>
</tr>
<tr>
<td>Parent</td>
<td>The application uses this decorator to identify the table as the parent table in a merged table grouping. This status appears in addition to the other status indicators.</td>
</tr>
<tr>
<td>Child</td>
<td>The application uses this decorator to identify the table as the child table in a merged table grouping. This decorator includes a text overlay that identifies the child's parent table number and name. The application clears both Parent and Child decorators when the workstation operator removes the merged table grouping.</td>
</tr>
<tr>
<td>Closed</td>
<td>The application uses this decorator to indicate a status of Closed. Host staff cannot seat guests at closed tables.</td>
</tr>
<tr>
<td>Reserved</td>
<td>The application uses this decorator to indicate a status of Reserved. The Table Suggestion process does not consider reserved tables for seating.</td>
</tr>
<tr>
<td>User Suggested</td>
<td>The application uses this decorator to identify the table as the host staff recommended seating placement for the highlighted table request on the Wait List.</td>
</tr>
<tr>
<td>System Suggested</td>
<td>The application uses this decorator to identify the table as the system recommended seating placement for the highlighted table request on the Wait List.</td>
</tr>
<tr>
<td>Highlighted</td>
<td>Do not use this decorator.</td>
</tr>
<tr>
<td>Host Area</td>
<td>This image is not a table decorator, but an optional image placement for the Host Command Area. You can use this image to place the restaurant logo on the host page.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

Configuring Server and Table Availability

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **TMS Parameters**.
2. Click the **Configuration** tab, and then click the **Table Suggestion** subtab.
3. In the **Default Server Available Time (Minutes)** field, enter the default number of minutes to use when making a server unavailable in the TMS. You can set this to a duration between 1 and 480 minutes.

4. In the **Auto Reset Paid Status (Minutes)** field, enter the number of minutes that the table decorator shows as paid on the host page before returning to an available status. You can define a buffer of time between when the table service moves from tendered, cleaned, and available for a new seating. Setting a value of 0 (zero) or blank defaults the time to 1 minute.

5. Click **Save**.

---

**Setting Table Management Options**

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **TMS Parameters**.

2. On the **Configuration** tab, select **Enable Table Management** to turn on TMS functions in Simphony.

   Select this option only for properties and revenue centers that use the TMS features. This option increases workstation resources and communications bandwidth for the Enterprise.

3. If you are using a loyalty program to look up and process transactions, select the **Loyalty Module ID** from the drop-down list. If you are not using a loyalty program, select **None**.

4. Select the appropriate TMS Options in the lower area of the screen. The following table describes the options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Unassigned Tables on Section Layout Activation</td>
<td>Select this option to automatically close tables that are not assigned to a section when a workstation operator activates a section layout.</td>
</tr>
<tr>
<td>Allow Multiple Loyalty Accounts per Guest Check</td>
<td>Select this option to allow the workstation operator to associate additional loyalty accounts with the guest check by selecting seats. Deselect this option to limit one loyalty account per guest check. This option determines whether the workstation operator can associate multiple loyalty accounts with a guest check.</td>
</tr>
<tr>
<td>Enable Guest Information Chit Printing</td>
<td>Select this option to print a chit when the host staff seats the table request.</td>
</tr>
</tbody>
</table>
Table 47-11  (Cont.) TMS Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Table On KDS Bump Event</td>
<td>Select this option to update the KDS or dining course on the table image after the workstation operator bumps the menu from the KDS. Deselect this option to update the KDS or dining course on the table image after the workstation operator performs a service total. Select this option only when the property or revenue center uses a Kitchen Display System (KDS). This option determines when the dining course updates on the host page table image.</td>
</tr>
<tr>
<td>Prompt for Employee on Unassigned Table</td>
<td>Select this option to have the workstation operator assign a server during seating. This option determines whether the host staff can seat a table without a server assignment.</td>
</tr>
<tr>
<td>Enable Seating Of Unavailable Tables</td>
<td>Select this option to allow the host staff to seat guests at a table defined as unavailable (including Closed, Dirty, and Reserved).</td>
</tr>
<tr>
<td>Ignore Cover Count</td>
<td>Select this option to maintain a valid cover count for the seating record while incrementing the guest count from 0 (zero) to a number based on the menu items ordered (entree count). This option determines the initial guest count set on the guest check when the host staff seats the table request. Select this option if you do not want the cover count shown on the guest check; instead the application relies on guest check configuration to determine the guest count value. Deselect this option to have the cover count set on the table request and provided to the guest check as the initial guest count. When you select Ignore Cover Count, you must also deselect the option Use Number of Seats for Guest Count from the RVC Parameters module.</td>
</tr>
<tr>
<td>Enable Edit Seating Capacity</td>
<td>Select this option to allow the workstation operator to change the seating capacity of a table from its configured number of seats.</td>
</tr>
<tr>
<td>Set Seating Capacity on Table Merge</td>
<td>Select this option to have the workstation operator enter the new number of seats for a table when merging tables.</td>
</tr>
<tr>
<td>Enable Create and Edit buttons on Wait List and Reservation List Screens</td>
<td>Select this option to show the Create and Edit buttons on the POS client Wait List and Reservation List screens. The workstation operator can click the buttons in the POS client (rather than double-tap the Reservation List or Wait List).</td>
</tr>
</tbody>
</table>
Table 47-11  (Cont.) TMS Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Offline Reservations</td>
<td>Select this option to allow workstation operators to create reservations when connectivity to the Table Management Service is not available. This is primarily used at properties when the host workstations are unable to access the service but want to create reservations. Setting this option does not restrict the workstation operator's ability to add records to the Wait List. When you enable offline reservations, the potential to overbook seating increases as the reservations are not recorded to a single destination. After the application re-establishes connectivity to the service, the application reports offline reservations to the service. If the remaining inventory becomes zero, the offline reservations being reported to the service are removed without notification. In cases where more than one source of reservations are defined (for example, multiple hosting workstations or online reservations), Oracle Hospitality discourages use of this option. Oracle Hospitality recommends that you disable offline reservations.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

Configuring Table Suggestion Factors

The Table Suggestion process uses several optional factors to determine the next parties to seat, and the tables that the TMS suggests for seating. Although the table suggestion factors all work together, Oracle Hospitality recommends that you use only a few factors initially to become accustomed to how the listing and suggestion process works for the property.

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **TMS Parameters**.

2. Click the **Table Suggestion** tab.

3. Use the arrow buttons to move and rank the suggestion factors. The factor order alters the table suggestion calculations.

Table 47-12  Table Suggestion Factors

<table>
<thead>
<tr>
<th>Table Suggestion Factor</th>
<th>Places a Greater Value On ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation Waiting</td>
<td>Reservations that have been waiting longer than other requests in the seating order</td>
</tr>
<tr>
<td>Waiting Past Quote</td>
<td>Reservation or walk-in requests where the request has been waiting longer than their scheduled seating time or quoted wait time</td>
</tr>
</tbody>
</table>
### Table 47-12 (Cont.) Table Suggestion Factors

<table>
<thead>
<tr>
<th>Table Suggestion Factor</th>
<th>Places a Greater Value On ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation Waiting Past Quote</td>
<td>Reservation requests where the request has been waiting longer than the scheduled seating time</td>
</tr>
<tr>
<td>Reservation Greeted</td>
<td>Reservation requests where the party has arrived and hosting staff greeted them</td>
</tr>
<tr>
<td>Reservation</td>
<td>Reservation requests versus non-reservation requests (walk-ins) in the seating order</td>
</tr>
<tr>
<td>VIP Waiting</td>
<td>Reservation requests where the party is designated as a VIP and have been waiting versus non-VIP reservation and walk-in requests that have been waiting in the seating order</td>
</tr>
<tr>
<td>VIP</td>
<td>Reservation and walk-in requests where the party is designated as a VIP in the seating order</td>
</tr>
<tr>
<td>Table Dirty</td>
<td>Any table marked as Dirty</td>
</tr>
<tr>
<td>Table Paid</td>
<td>Any table marked as Paid</td>
</tr>
<tr>
<td>Server Check Count</td>
<td>Any server based on their current service check count (open and closed)</td>
</tr>
<tr>
<td>Server Cover Count</td>
<td>Any server based on their current service cover count</td>
</tr>
<tr>
<td>Server Efficiency</td>
<td>Any server based on their Server Efficiency Rating</td>
</tr>
<tr>
<td>Server Last Assigned</td>
<td>Any table based on the table's current server assignment and the time since the server received a new table seating</td>
</tr>
</tbody>
</table>

4. Click **Save**.

### Table Management Alerts

You can set two optional types of table management alerts: Service Alerts and Check Alerts.

Service Alerts show the duration since the last service interaction (for example, guest ordered a menu item). If you do not set Service Alerts, the table management system does not track service intervals on the guest check.

Check Alerts show how long the guest has been seated at the table. This alert changes as the service interaction passes defined thresholds. If you do not set Check Alerts, the table management system only tracks the duration of time the guest check is open and does not change the Check Alert color.

**Related Topics**

- Configuring Alerts
Configuring Alerts

1. Select the revenue center, click Setup, and then click Service Alert.
2. Enter the name of the service alert as you want it to appear to the workstation operator (for example, Recent Service, No Touch Warning, or Service Warning).
3. Set the Service Alert Time to the number of minutes since the last service total elapses before triggering the service alert.
   To start the alert immediately upon seating of the guest, set the time to 0 (zero). The application resets the timer to 0 when the workstation operator performs a service total with a new menu item on the guest check.
4. Select the Service Alert Color to distinguish one alert from another in the service alert table area on the host page. Only seated tables show a service alert color.
5. Click Save.
6. Select the revenue center, click Setup, and then click Check Alert.
7. Enter the name of the check alert as you want it to appear to the workstation operator (for example, In Service, Turn Waiting, or Turn Alert).
8. Set the Check Alert Time to the number of minutes since the check was opened before triggering the next check alert.
   To start the alert immediately upon seating of the guest, set the time to 0 (zero). The application resets the timer to 0 when the workstation operator performs a service total with a new menu item on the guest check. The check alert remains as the last alert until the workstation operator closes the guest check.
9. Select the Check Alert Color to distinguish one alert from another in the check alert table area on the host page. Only seated tables show a check alert color.
10. Click Save.

Related Topics
- Table Management Alerts

Table Management Sections

You can group tables within an area or station to indicate assignment to a specific server. Optional seating section templates allow you to set predefined table layouts where the application automatically assigns tables to a specific section. You can create seating section layouts at the property level.

Related Topics
- Configuring Sections

Configuring Sections

1. Select the property, click Setup, and then click Section.
2. Enter the name of the section as you want it to appear to the workstation operator and in reports.
3. Select the color used to distinguish one section from another when viewing tables on the host page.

Only tables that are assigned to a section inherit the section color.

4. Click Save.

5. Select the property, click Setup, and then click Seating Section Templates.

6. Enter the name of the section template as you want it to appear to the workstation operator.

7. Select Add to define a table as part of the template.
   a. From the new record, click the build box to view a list of tables defined for the revenue center. Alternatively, you can enter the Table ID, and then press the Tab key.
   b. Select the section from the available list or enter the Section ID.

8. Click Save.

Related Topics

- Table Management Sections

Creating the Touchscreen Reservation List

The Reservation List allows hosting staff to manage all reservation requests. Oracle recommends that you create a Reservations List on a page for the reservation functions. You can use the template provided in Simphony. If a property uses future reservations or multiple dining room layouts, a Tabbed Template provides workstation operators with a smoother means to navigate between wait lists, reservation lists, and table layouts.

The Table Management System (TMS), Wait List, and Reservation functions must reside within the same content area on a page in order to interact.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click Page Design.

2. Double-click the page on which to place the Reservation List.

3. On the Edit tab, select the page area in which to define the reservations.

4. Click Other..., select Table Management, and then select Reservation Area.

The Reservation List contains buttons for creating future reservations. You can place the Reservation List alone or within the Host Command Area, where hosting staff can hide and recall it. Oracle Hospitality recommends placing the Reservation List on its own page. After placing the reservation area, the Reservation List settings appear in two sections:

- Reservation List Columns: The columns section allows you to set Reservation List columns and formats that appear on the POS client. You can configure the content, width, and order in which the columns appear on the Reservation List.

- Summary Area: The summary section allows you to set the reservation details that appear on the POS client when a workstation operator highlights a reservation in the Reservation List.

5. Highlight the reservation area, and then select Reservation List Columns.
6. In the **Header** and **Detail Font Size** fields, select the size of the font used to show the reservation heading and detail.

7. For each Reservation List column, select the **Enable** option if you want the column name to appear in the POS client Reservation List, and then enter the column width for each column.

**Table 47-13  Reservation List Columns**

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel Date</td>
<td>If a reservation is cancelled or the guest does not arrive, this column shows the date and time of cancellation.</td>
</tr>
<tr>
<td>Alert Icon</td>
<td>The alert icon is always enabled and is the first column shown in the Reservation List. This column contains icons to indicate status or properties of the reservation record. Alert icons represent the request method, VIP status, and seating preferences.</td>
</tr>
<tr>
<td>Confirmation Number</td>
<td>Simphony issues a confirmation number after a workstation operator or guest creates a reservation.</td>
</tr>
<tr>
<td>Covers</td>
<td>This column shows the number of covers for the reservation.</td>
</tr>
<tr>
<td>Created</td>
<td>This column shows the date and time the reservation was created.</td>
</tr>
<tr>
<td>Greeted</td>
<td>This column shows the time when the host staff greeted the guest.</td>
</tr>
<tr>
<td>Time</td>
<td>The time is always enabled and is the second column shown in the Reservation List. This column shows the time when the reservation is scheduled to be seated.</td>
</tr>
<tr>
<td>Guest Name</td>
<td>This column shows the name in which the reservation was created.</td>
</tr>
<tr>
<td>Pager Number</td>
<td>Do not use this column.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>This column shows the guest’s phone number.</td>
</tr>
<tr>
<td>Request Method</td>
<td>This column shows an icon representing the source of the reservation (phone or Internet).</td>
</tr>
<tr>
<td>VIP</td>
<td>This column shows an icon representing the VIP flag if the guest has a VIP status.</td>
</tr>
<tr>
<td>Wait Quote</td>
<td>Do not use this column.</td>
</tr>
</tbody>
</table>

8. Click the black up and down arrows in the top portion of the Reservation List Columns section to sort and move each enabled column to the order of appearance in the POS client Reservation List.

9. Select **Summary Area**.

10. Select **Show Summary** to show reservation details in the Reservation List when a workstation operator highlights a reservation.

11. In the **Summary Height** field, enter a static height for the summary information.
When you enter 0 (zero), the height of the summary area appears dynamically, depending on the amount of content and details associated with the highlighted reservation.

12. In the **Label** and **Detail Font Size** fields, select the size of the font used to show the summary label and details.

13. For each Reservation summary field:
   - Select the **Enable** option to show summary content in the POS client Reservation List.
   - Select the **New Line** option to show summary information on a new line in the POS client Reservation List.

The information in the Summary Area is the same as the Reservation List Columns, with the addition of the content listed in the following table.

**Table 47-14 Reservation List Summary**

<table>
<thead>
<tr>
<th>Summary Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>This summary option contains text included in the Notes field of the reservation record. This field holds up to 255 characters of text and automatically wraps in the summary area.</td>
</tr>
<tr>
<td>Referral Notes</td>
<td>This summary option contains text included in the Referral Notes field of the reservation record. This field holds up to 255 characters of text and automatically wraps in the summary area.</td>
</tr>
</tbody>
</table>

14. Click **Save**.

- **Configuring Reservation Privileges**
- **Setting Reservation Timing Parameters**

**Related Topics**
- **Reservation List**
- **Table Management, Reservation, and Wait List Configuration Prerequisites**
- **Reservation Configuration Levels**

**Creating the Touchscreen Wait List**

The Wait List allows hosting staff to manage all table requests (including walk-ins and pending reservations). Oracle Hospitality recommends that you create a Wait List on a page for the table request functions. You can use the templates provided in Simphony. If the property uses future reservations or multiple dining room layouts, a Tabbed Template provides workstation operators with a smoother means to navigate between wait lists, reservation lists, and table layouts.

The Table Management System (TMS), Wait List, and Reservation functions must reside within the same content area on a page in order to interact.
1. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Page Design**.

2. Double-click the page on which to place the Wait List.

3. On the **Edit** tab, select the page area in which to define the Wait List.

4. Click **Other...**, select **Table Management**, and then select **Wait List**.

   The Wait List contains buttons for creating walk-in table requests. You can place the Wait List alone or within the Host Command Area, where hosting staff can hide and recall it. Oracle recommends creating a Wait List on the same page as the tables to simplify the seating process. After placing the wait list, the Wait List settings appear in two sections:

   - **Wait List Columns**: The columns section allows you to set Wait List columns and formats that appear on the POS client. You can configure the content, width, and order in which the columns appear on the Wait List.
   - **Summary Area**: The summary section allows you to set the wait list details that appear on the POS client when a workstation operator highlights a table request in the Wait List.

5. Highlight the **Wait List**, and then select **Wait List Columns**.

6. From the **Header** and the **Detail** fields, select the size of the font used to show the Wait List heading and detail.

7. For each Wait List column, select the **Enable** option to have the column name appear in the workstation Wait List, and then enter the column width for each column.

---

### Table 47-15  Wait List Columns

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandon Time</td>
<td>Do not configure the Wait List to contain this column.</td>
</tr>
<tr>
<td>Alert Icon</td>
<td>The alert icon is always enabled and is the first column shown in the Wait List. This column contains icons to indicate status or properties of the table request record. Alert icons represent the quote status, request method, VIP status, and seating preferences.</td>
</tr>
<tr>
<td>Confirmation Number</td>
<td>The confirmation number appears only for table requests that originate from the Reservation List.</td>
</tr>
<tr>
<td>Covers</td>
<td>This column shows the number of covers for the table request.</td>
</tr>
<tr>
<td>Created</td>
<td>This column shows the date and time the table request was created.</td>
</tr>
<tr>
<td>Greeted</td>
<td>This column shows the time when the host staff greeted the guest.</td>
</tr>
<tr>
<td>Guest Name</td>
<td>This column shows the name for the table request.</td>
</tr>
<tr>
<td>Pager Number</td>
<td>This column shows the pager number for the table request.</td>
</tr>
</tbody>
</table>
Table 47-15  (Cont.) Wait List Columns

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone Number</td>
<td>This column shows the guest's phone number.</td>
</tr>
<tr>
<td>Request Method</td>
<td>This column shows an icon representing the source of the table request (walk-in, phone-in, or Internet).</td>
</tr>
<tr>
<td>VIP</td>
<td>This column shows an icon representing the VIP flag if the guest has a VIP status.</td>
</tr>
<tr>
<td>Wait Quote</td>
<td>This column shows the estimated wait quote time given for the table request.</td>
</tr>
</tbody>
</table>

8. Click the black up and down arrows in the top portion of the Wait List Columns section to sort and move each enabled column to the order of appearance in the POS client Wait List.

9. Select Summary Area.

10. Select Show Summary to show table request details in the Wait List when a workstation operator highlights a table request.

11. In the Summary Height field, enter a static height for the summary information. When you enter 0 (zero), the height of the summary area appears dynamically, depending on the amount of content and details associated with the highlighted table request.

12. From the Label and Detail fields, select the size of the font used to show the summary label and details.

13. For each Wait List summary field:
   - Select the Enable option to have the summary content appear in the POS client Wait List.
   - Select the New Line option to have the summary information appear on a new line in the POS client Wait List.

The information in the Summary Area is the same as the Wait List Columns, with the addition of the content listed in the following table.

Table 47-16  Wait List Summary

<table>
<thead>
<tr>
<th>Summary Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimated Wait Time</td>
<td>This summary option contains the approximate time remaining until a table will be ready for the guest. This value differs from the wait quote, which is a static amount of time that the guest was quoted. The Estimated Wait Time changes as tables are freed up and new table seating requests are made.</td>
</tr>
<tr>
<td>Notes</td>
<td>This summary option contains text included in the Notes field of the table request record. This field holds up to 255 characters of text and automatically wraps in the summary area.</td>
</tr>
</tbody>
</table>
### Table 47-16  (Cont.) Wait List Summary

<table>
<thead>
<tr>
<th>Summary Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Referral Notes</td>
<td>This summary option contains text included in the Referral Notes field of the table request record. This field holds up to 255 characters of text and automatically wraps in the summary area.</td>
</tr>
</tbody>
</table>

14. Click **Save**.

- Configuring Wait List Privileges
- Setting Wait List Timing Parameters

**Related Topics**

- Wait List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Wait List Configuration Levels

## Touchscreen Page Table Management Tasks

Oracle Hospitality recommends that you create table management forms on a page for the enhanced dining table functions. You can use the templates provided in Simphony. If the property uses future reservations or multiple dining room layouts, a Tabbed Template provides workstation operators with a smoother means to navigate between wait lists, reservation lists, and table layouts.

The Table Management System (TMS), Wait List, and Reservation functions must reside within the same content area on a page in order to interact.

Creating table management operations for the touchscreen page consists of completing the following tasks:

- Setting the Host Command Area
- Setting the Dining Table Status
- Setting Employee Lines
- Creating a Section Layout
- Creating Enhanced Dining Tables
- Setting Table Management Functions in the Guest Check Detail Area
- Creating a button for the Employee Section Assignment Report

### Host Command Area

You need to place a Host Command Area on a page for hosting staff to use the Simphony TMS operations. The Host Command Area is the primary mechanism used to manage all hosting related functions in the TMS. This area determines the way hosting staff:

- Enables and disables TMS functions
- Accesses TMS features
• Administers the hosting page

Related Topics
• Configuring the Host Command Area

Configuring the Host Command Area

1. Select the Enterprise, property, or revenue center, click Configuration, and then click Page Design.
2. Double-click the page on which to define the Host Command Area.
3. On the Edit tab, select the page area on which to place the Host Command Area. You must place the Host Command Area in the same content area on the page as the tables in order for the host features to function.
4. Click Other..., select Table Management, and then select Host Command Area. Hosting staff performs a long button press on the Host Command Area to access the TMS functions. As such, carefully consider the Host Command Area sizing and placement to ensure that hosting staff can easily see and press this area on the POS client.

The Host Command Area can optionally show an image in place of the silver portion of the area. You can set the image from the TMS Parameters module as the Dining Table Decoration Image Name. The image you select scales to the size of the Host Command Area.
5. Click Save.

Related Topics
• Host Command Area

Dining Table Status

Dining Table Status contains information about the highlighted table and associated open checks. Hosting staff can hide and recall the optional Dining Table Status from the Host Command Area, as well as move the Dining Table Status on the workstation with a click, hold, and drag motion. The sizing and placement of the Dining Table Status should not prevent hosting staff from accessing the table images. In addition, the Dining Table Status should be large enough so that text is legible to all hosting staff as the text size scales based on the screen sizing.

The following figure shows an example of the Dining Table Status.
Configuring the Dining Table Status

1. Select the Enterprise, property, or revenue center, click Configuration, and then click Page Design.
2. Double-click the Front of House page on which to define the Dining Table Status.
3. On the Edit tab, select the page area on which to place the Dining Table Status. Place the Dining Table Status in the same content area on the page as the Host Command Area and tables so that hosting staff can access the functions and view information.
4. Click Other..., select Table Management, and then select Dining Table Status.
5. Click Save.

Related Topics

• Configuring the Dining Table Status

Figure 47-1 Dining Table Status
Employee Lines

Hosting staff can hide and recall the optional Employee Lines Area from the Host Command Area. This area shows lines from the assigned tables to a text box containing the assigned server’s name. The following figure shows an example of the Employee Lines Area.

**Figure 47-2  Employee Lines Area**

![Employee Lines Area Diagram](image)

Related Topics

- Configuring Employee Lines

**Configuring Employee Lines**

1. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Page Design**.

2. Double-click the page on which to define the Employee Lines Area. (This is the page with enhanced table images.)

3. On the **Edit** tab, select the page area on which to place the Employee Lines Area.
Place the Employee Lines Area in the same content area on the page as the Host Command Area and tables in order for the hosting staff to access the functions and view information.

4. Click Other..., select Table Management, and then select Employee Lines Area.

5. Adjust the size and placement of the Employee Lines Area to ensure that it covers all enhanced tables on the page. Tables that are not covered by the Employee Lines Area do not show server assignment lines.

6. Click Save.

Related Topics

- Employee Lines

Section Layout

The Section Layout contains controls to create and administer Seating Section Layouts for table, section, and server assignments. Hosting staff can hide and recall the optional Section Layout from the Host Command Area or from a separate page. Oracle Hospitality recommends creating a Section Layout on a separate page. Hosting staff can easily assign tables to a section when:

- Tables are present on the same page as the Section Layout.
- Tables are accessible while editing a Section Layout.

The following figure shows an example of the Section Layout.

Figure 47-3   Section Layout
Creating a Section Layout

1. Select the Enterprise, property, or revenue center, click Configuration, and then click Page Design.
2. Create the page on which to define the Section Layout.
3. Click Other..., select Table Management, and then select Section Layout.
4. Adjust the Section Layout size to ensure that the text is visible to hosting staff. The text size scales with the Section Layout size.
5. Click Save.

Creating Enhanced Dining Tables

You can use all functions of the Simphony TMS using enhanced dining tables. You cannot use legacy standard tables with TMS. Enhanced dining tables show overlays on the outer edges of the table that indicate status, coursing, and alerts.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click Page Design.
2. Double-click the page on which to define enhanced dining tables.
3. On the Edit tab, select the page area on which to place the enhanced dining tables.
4. Click Other..., select Table Management, and then select Dining Table (Enhanced).
5. Move and adjust the table size on the page. Leave space between tables on the page layout to ensure visibility of indicators and table state. You can increase the grid configuration on the page from 24 (default) to 48 using the Change Grid Size link.
6. Set the unique properties of the enhanced dining table:
   a. Enter the table number in the Table # field.
      This number must match the Table Number set in the Tables module. See Configuring Enhanced Dining Tables for more information.
   b. From the Next Page/Panel section, click the black Panel arrow, and then select the host page from the list.
   c. (Optional) Enter a table number in the Legend field.
      If the Legend is blank, the table number or name shown on the host page uses the table number or name defined for the Table # field. To use a different name or number for the table, enter an override value in the Legend field.
7. Repeat Steps 4 through 6 to create additional enhanced dining tables.
8. Click Save.
Setting Table Management Functions in Check Detail

1. Select the Enterprise, property, or revenue center, click Configuration, and then click Page Design.
2. Double-click the page that contains the Check Detail area.
3. Select the Check Detail area on the page.
4. Select Show Seat Number to provide the workstation operator with a visual representation of the seat number associated with a menu item or guest on the check detail area.
5. Select Enable Gestures to allow the workstation operator to access a menu of options when long-pressing on the guest check.
   The long-press options include:
   - Change Item Seat
   - Change Item Course
   - View By Item Entry
   - View By Seat
   - View By Course
6. Select the view mode from the Initial View Mode drop-down list.
   This is the view shown when the workstation operator initially sees the guest check. Oracle recommends selecting the View By Seat mode for restaurants that allow multiple loyalty accounts on a single guest check.
7. Click Save.

Creating the Employee Section Assignment Report Button

1. Select the Enterprise, property, or revenue center, click Configuration, and then click Page Design.
2. Open the page on which to place the Employee Section Assignment Report button.
3. On the Edit tab, select the page area in which to define the button.
4. Click Button.
5. Position and size the button on the page. Use the Style arrow to change the color.
6. In the Legend field, enter the button name.
7. Select Ad Hoc Report from the Type drop-down list.
8. Click the black arrow beneath the Type drop-down list, select 44 - Employee Section Assignment Report from the report list, and then click OK.
9. Click Save.
Configuring Table Cancellation Reasons

You can optionally create Reservation and Wait List Reasons to indicate why a guest cancels or abandons a table request.

1. Select the Enterprise, property, or revenue center, click **Descriptors**, and then click **TMS Reasons**.
2. Enter a reason in the **Text** field. You can create a maximum of 32 reasons.
3. Click **Save**.

Setting Reservation Timing Parameters

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **TMS Parameters**.
2. On the **Configuration** tab, enter information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation to Waitlist Delay</td>
<td>Enter the number of minutes that a reservation appears on the Wait List before the scheduled seating time. Reservation records that are visible on the Wait List impact the quote times and table suggestions.</td>
</tr>
<tr>
<td>Maximum Reservation Notice (Days)</td>
<td>Enter how far in advance a reservation can be made. This value includes the current business day. For example, a value of 90 indicates that guests can make reservations no more than 90 days in advance.</td>
</tr>
<tr>
<td>Minimum Reservation Notice (Minutes)</td>
<td>Enter the amount of advanced time when reservations can no longer be made for the same business day. For example, a value of 30 indicates that guests cannot make reservations less than 30 minutes in advance.</td>
</tr>
</tbody>
</table>

3. Select the appropriate options for reservation functions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require Reason Code on Abandon/Cancel</td>
<td>Select this option to have the POS client prompt the workstation operator to enter a cancellation reason for the reservation request.</td>
</tr>
<tr>
<td>Enable Reservation Approval</td>
<td>Select this option to have the workstation operator obtain approval when creating a reservation outside of a date or time available in the TMS inventory.</td>
</tr>
</tbody>
</table>
4. Click **Save**.

- **Configuring Reservation Privileges**
- **Creating the Touchscreen Reservation List**

**Related Topics**
- **Reservation List**
- **Table Management, Reservation, and Wait List Configuration Prerequisites**
- **Reservation Configuration Levels**

### Setting Wait List Timing Parameters

1. Select the Enterprise, property, or revenue center, click **Setup**, and then click **TMS Parameters**.

2. On the **Configuration** tab, enter information in the following fields:

<table>
<thead>
<tr>
<th>Table 47-19</th>
<th>Wait List Timing Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Reservation To Waitlist Delay</td>
<td>Enter the number of minutes that a reservation appears on the Wait List before the scheduled seating time. Reservation records that are visible on the Wait List impact the quote times and table suggestions.</td>
</tr>
<tr>
<td>Wait Quote Interval (Minutes)</td>
<td>Enter the wait quote time increments (for example, every 2 minutes or 5 minutes).</td>
</tr>
<tr>
<td>Auto Abandon Wait List Delay (Minutes)</td>
<td>Enter the number of minutes that a table request record remains on the Wait List before the application automatically updates it as Abandoned (for walk-ins) or No-Show (for reservations). The application removes the record from the Wait List after reaching this time threshold.</td>
</tr>
<tr>
<td>Wait Quote Alert Threshold (Minutes)</td>
<td>Enter the number of minutes to elapse before flagging the table request on the Wait List as Overdue for seating. Enter 0 (zero) to flag the table request as soon as the time quote elapses.</td>
</tr>
</tbody>
</table>

3. Select the appropriate options to enable or disable wait list functions. The following table describes the options.

---

**Table 47-18  (Cont.) Reservation Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Create and Edit Buttons</td>
<td>Select this option to show <strong>Create</strong> and <strong>Edit</strong> buttons following the Reservation List in the POS client. When you enable the buttons, the workstation operator can also double-tap the screen to create or edit reservations.</td>
</tr>
</tbody>
</table>
Table 47-20  Wait List Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require Reason Code on Abandon/Cancel</td>
<td>Select this option to have the POS client prompt the workstation operator to enter a reason for abandoning or cancelling a table request.</td>
</tr>
<tr>
<td>Enable Wait List Chit Printing</td>
<td>Select this option to print a chit when the host staff creates or updates a table request. The chit contains table request information and the estimated wait time.</td>
</tr>
<tr>
<td>Enable Create and Edit Buttons</td>
<td>Select this option to show Create and Edit buttons following the Wait List in the POS client. When you enable the buttons, the workstation operator can also double-tap the screen to create or edit table requests.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

- **Configuring Wait List Privileges**
- **Creating the Touchscreen Wait List**

**Related Topics**
- **Wait List**
- **Table Management, Reservation, and Wait List Configuration Prerequisites**
- **Wait List Configuration Levels**

**Reservation Periods**

Optional Reservation Period settings control reservation inventory and allow walk-in table requests. They also define projected turn times for tables based on time and cover count. If the property does not take reservations, Oracle Hospitality recommends configuring Reservation Periods so that hosting staff can use the Estimate Wait Quote feature on the Wait List.

Setting Reservation Periods consists of completing the following tasks:

- Setting the reservation period timeframe
- Setting reservations intervals and covers
- Setting occupancy
- Setting seating capacity and quantity
- Setting anticipated turn times for tables

**Related Topics**
- **Configuring Effectivity**
- **Configuring Acceptance Limits**
- **Configuring Occupancy Limits**
- **Configuring Seating Limits**
- **Configuring Target Turn Times**
Configuring Effectivity

1. Select the revenue center, click **Setup**, and then click **Reservation Periods**.
2. Insert a record with a name that describes the reservation period (for example, Weekday or Weekend).
3. Double-click the record to open it.
4. On the **Effectivity** tab, select the appropriate options as described in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effectivity Start Date</td>
<td>Select the first calendar day that the reservation period is effective. Deselecting the start date causes the reservation period for the reservation and wait lists to remain in effect indefinitely.</td>
</tr>
<tr>
<td>Effectivity End Date</td>
<td>Select the last calendar day that the reservation period is effective. Deselecting the end date causes the reservation period for the reservation and wait lists to remain in effect indefinitely.</td>
</tr>
<tr>
<td>Recurrence Day Of Week</td>
<td>Select the effective days of the week within the reservation period. You must select at least one day in order to save the reservation period.</td>
</tr>
<tr>
<td>Recurrence Time Of Day</td>
<td>Select the time of day that is effective in the reservation period. Deselecting the <strong>Active Start Time</strong> causes the reservation period for the reservation and wait lists to remain in effect starting at 00:00:00 on the applicable calendar days. Deselecting the <strong>Active End Time</strong> causes the reservation period for the reservation and wait lists to remain in effect until 23:59:59 on the applicable calendar days.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

- Configuring Acceptance Limits
- Configuring Occupancy Limits
- Configuring Seating Limits
- Configuring Target Turn Times

**Related Topics**
- Reservation Periods
Configuring Acceptance Limits

Acceptance Limits define the following reservation period items:

- The interval (in minutes) in which reservations can be made
- The maximum new covers allowed within the interval

1. Select the revenue center, click **Setup**, and then click **Reservation Periods**.
2. Open the reservation period record.
3. Click the **General** tab, and then click the **Acceptance Limits** subtab.
4. Click the **Add** link, and then enter information in the Acceptance Limits fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Time</td>
<td>Enter the time when the defined Acceptance Cycle and Limit begins (for example, 17:00).</td>
</tr>
<tr>
<td>End Time</td>
<td>Enter the time when the defined Acceptance Cycle and Limit ends (for example, 22:00).</td>
</tr>
<tr>
<td>Cycle</td>
<td>Enter the interval in minutes when reservations can be accepted.</td>
</tr>
<tr>
<td></td>
<td>The Cycle defines the frequency with which you offer new reservations (for example, every 15 minutes or every 30 minutes) beginning with the start time.</td>
</tr>
<tr>
<td>Acceptance Limits</td>
<td>Enter a value to limit the potential kitchen workload. Entering 60 prevents new reservations for the defined cycle after the number of covers for all reservations in that cycle reaches or exceeds the limit.</td>
</tr>
</tbody>
</table>
5. Click **Save**.

- Configuring Effectivity
- Configuring Occupancy Limits
- Configuring Seating Limits
- Configuring Target Turn Times

**Related Topics**
- Reservation Periods

---

Configuring Occupancy Limits

Occupancy Limits define the maximum number of covers allowed at any time. Occupancy Limits are typically set by building codes based on available exits.

1. Select the revenue center, click **Setup**, and then click **Reservation Periods**.
2. Open the reservation period record.
3. Click the **General** tab, and then click the **Occupancy Limits** subtab.
4. Click the Add link.

5. Enter information in the Occupancy Limits fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Time</td>
<td>Enter the time when the defined Occupancy Limit begins.</td>
</tr>
<tr>
<td>End Time</td>
<td>Enter the time when the defined Occupancy Limit ends.</td>
</tr>
<tr>
<td>Occupancy Limit</td>
<td>Enter the revenue center occupancy. Entering 250 prevents new reservations for the defined Acceptance Limits cycle after the number of covers for all reservations within that timeframe reaches or exceeds the limit. If you do not create an Occupancy Limit, the application uses the default value of 9999 covers.</td>
</tr>
</tbody>
</table>

6. Click Save.

- Configuring Effectivity
- Configuring Acceptance Limits
- Configuring Seating Limits
- Configuring Target Turn Times

**Related Topics**
- Reservation Periods

## Configuring Seating Limits

Seating Limits define the number of available reservations allocated based on the cycle defined in the Acceptance Limits and Party Size.

1. Select the revenue center, click Setup, and then click Reservation Periods.
2. Open the reservation period record.
3. Click the General tab, and then click the Seating Limits subtab.
4. Click the Add link.
5. Enter information in the Seating Limits fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Time</td>
<td>Enter the time when the defined Seating Limit begins.</td>
</tr>
<tr>
<td>End Time</td>
<td>Enter the time when the defined Seating Limit ends.</td>
</tr>
</tbody>
</table>
### Table 47-24 (Cont.) Seating Limits

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>Enter the number of covers in the party. The <em>Capacity</em> value cascades to lower values if you do not set a lower value. For example, if you set a capacity of 4, the cover includes requests for a party of 1 through 4. However, setting a lower capacity of 2 applies to parties of 1 or 2, and the capacity of 4 applies to parties of 3 or 4.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Enter the number of reservations available for the Cycles within the timeframe. The <em>Quantity</em> determines how many reservations to allocate to accommodate the capacity between the <em>Begin Time</em> and <em>End Time</em> for each Cycle that you set on the <em>Acceptance Limits</em> tab. For example, you can allocate a quantity of 2 reservations every 15 minutes between 5:00 p.m. and 10:00 p.m. that accommodate a cover count of 2 or fewer. This value only defines the number allotted and does not represent the current inventory.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

- **Configuring Effectivity**
- **Configuring Acceptance Limits**
- **Configuring Occupancy Limits**
- **Configuring Target Turn Times**

#### Related Topics
- **Reservation Periods**

---

## Configuring Target Turn Times

Target Turn Times define the target time from seating to request completion for a seated party. Target Turn Times also affect the following seating-related operations:

- Prevent reservation overbooking
- Estimate wait times for walk-in table requests
- Anticipate the tables that will be available in order to distribute the table seating appropriately

1. Select the revenue center, click **Setup**, and then click **Reservation Periods**.
2. Open the reservation period record.
3. Click the **General** tab, and then click the **Target Turn Times** subtab.
4. Click the **Add** link.
5. Enter information in the Target Turn Times fields:
Table 47-25  Target Turn Times

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Time</td>
<td>Enter the time when the defined Cover Count and Target Turn Time begins.</td>
</tr>
<tr>
<td>End Time</td>
<td>Enter the time when the defined Cover Count and Target Turn Time ends.</td>
</tr>
<tr>
<td>Cover Count</td>
<td>Enter the number of covers seated at the table. The Cover Count value cascades to lower values if you do not set a lower value. For example, if you set a cover count of 4, the cover includes requests for a party of 1 through 4. However, setting a lower capacity of 2 applies to parties of 1 or 2, and the capacity of 4 applies to parties of 3 or 4.</td>
</tr>
<tr>
<td>Minutes</td>
<td>Enter the anticipated turn time (in minutes) for a table seating of the defined Cover Count during the specified timeframe. If you do not create a Target Turn Time, the application uses the default value of 60. For example, if you enter 45, table seatings that encompass the defined cover count during the timeframe assume the seating request is 45 minutes in duration.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

- Configuring Effectivity
- Configuring Acceptance Limits
- Configuring Occupancy Limits
- Configuring Seating Limits

**Related Topics**
- Reservation Periods

### Table Management Configuration Levels

The following table shows the hierarchy levels within the EMC that allow you to configure table management operations.

Table 47-26  Table Management Configuration Levels

<table>
<thead>
<tr>
<th>Configuration Module</th>
<th>Enterprise</th>
<th>Property</th>
<th>Revenue Center</th>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Dining Table Classes</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Employee Maintenance</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>
Table 47-26  (Cont.) Table Management Configuration Levels

<table>
<thead>
<tr>
<th>Configuration Module</th>
<th>Enterprise</th>
<th>Property</th>
<th>Revenue Center</th>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>TMS Parameters</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TMS Privileges</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reservation Periods</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS Table Attributes</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>KDS/Dining Course Colors</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Loyalty Module</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Page Design Properties</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Seating Section Templates</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Sections</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Tables</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

Related Topics

- Table Management
- Table Management, Reservation, and Wait List Configuration Prerequisites

Reservation Configuration Levels

The following table shows the hierarchy levels within the EMC that allow you to configure reservation operations.

Table 47-27  Reservation Configuration Levels

<table>
<thead>
<tr>
<th>Configuration Module</th>
<th>Enterprise</th>
<th>Property</th>
<th>Revenue Center</th>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>TMS Parameters</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TMS Reasons</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Reservation Periods</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>TMS Table Attributes</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Loyalty Module</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Page Design</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

Related Topics

- Reservation List
- Table Management, Reservation, and Wait List Configuration Prerequisites
Wait List Configuration Levels

The following table shows the hierarchy levels within the EMC that allow you to configure wait list operations.

Table 47-28  Wait List Configuration Levels

<table>
<thead>
<tr>
<th>Configuration Module</th>
<th>Enterprise</th>
<th>Property</th>
<th>Revenue Center</th>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>TMS Parameters</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>TMS Reasons</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Reservation Periods</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wait Quote Configuration</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS Table Attributes</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Loyalty Module</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Page Design</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Related Topics

- Wait List
- Table Management, Reservation, and Wait List Configuration Prerequisites
- Configuring Wait List Privileges
- Creating the Touchscreen Wait List
- Setting Wait List Timing Parameters
Enterprise Cash Management

You can use the Enterprise Cash Management (ECM) module to track the amount of cash located within a property. You can track the physical currency that is collected and the exact location of funds (for example, in a till, safe, bank deposit, or server bank). ECM follows currency as it progresses through the following phases:

- Enters the building (for example, cash tender, paid-in, or change order received from the bank)
- Moves through the building (for example, from tills to a safe or bank deposit)
- Leaves the building (for example, paid out to a vendor, change given to a guest, or taken to a bank for deposit)

As money flows through the operation, ECM logs all currency actions for reporting and auditing purposes.

- Configuring Data Retention Limits
- Specifying Ad Hoc Reports
- Configuring ECM Privileges and Permissions
- Allowing Users to View Blind Totals
- Allowing Assigned Receptacle Access and Counts
- Configuring Accounting Methods for Users
- Allowing Users to Override Employee Class Options
- Tracking Tender Transaction Items
- Tracking Service Charge Transactions
- Tracking Discount Transactions
- Creating, Editing, and Deleting Cash Management Reasons
- Cash Management Classes
- Adding Transaction Items
- Adding Counting Units
- Cash Pull Threshold Set
- Creating, Editing, and Deleting a Cash Pull Threshold Set
- Cash Count Threshold Set
- Creating, Editing, and Deleting a Cash Count Threshold Set
- PAR Level Set
- Creating, Editing, and Deleting a PAR Level Set
- Count Sheet
- Creating, Editing, and Deleting a Count Sheet
- Creating, Editing, and Deleting an Account
Configuring Data Retention Limits

Database administrators can set the length of time data (for example, ECM and Reporting and Analytics aggregation) remains present in the database at the Enterprise and property levels.

1. Select the Enterprise level, click Setup, and then click Enterprise Parameters.
2. Click the Miscellaneous tab.
3. To set data retention limits, in the Purging section, enter the Days To Keep for the Purge Type.

   This is the number of days from the time a transaction is reported to the enterprise that the application retains it for use in reporting and auditing (for example, from 1 day to 999 days). After the number of days to keep expires, a scheduled event purges the data. By default, the purging jobs purge 1000 records per batch.

   • To set ECM data retention, enter the number of days for ECM Transaction Detail.
   • To change the PC Autosequences data retention, enter the number of days for the Pcasequence Log.

   Oracle recommends that you leave the default value set at 90 days, and that a subject matter expert change this setting if necessary. The Pcasequence Log Purge Type is available in Simphony version 2.10 and later and is compatible with Reporting and Analytics version 9.0 Patch 8 and later.
4. Click Save.
Specifying Ad Hoc Reports

You must assign privileges to the employee to run specific property reports related to active receptacle sessions at the property.

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.
2. Select the role type, click **Operations**, click **Ad Hoc Reports**, and then click **Report Options**.
3. Select the appropriate ECM reports.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Till Report</td>
<td>Provides information about the active till session on the workstation to which the workstation operator running the report is assigned. The printed report shows only values related to the workstation operator's activity.</td>
</tr>
<tr>
<td>Run Cash Pull Report</td>
<td>Provides a list of cash pull transactions that have been performed for the business day.</td>
</tr>
<tr>
<td>Run Till Banking Report</td>
<td>Provides information about all active till sessions for the location.</td>
</tr>
<tr>
<td>Run Safes Report</td>
<td>Provides information about all active safe sessions for the location.</td>
</tr>
<tr>
<td>Run Paid-In/Paid-Out Report</td>
<td>Provides information about all paid-in and paid-out transactions that were recorded for the business day.</td>
</tr>
<tr>
<td>Run Over/Short Detail Report</td>
<td>Provides information about over and short conditions that were recorded for the business day.</td>
</tr>
<tr>
<td>Run Bank Deposits Report</td>
<td>Provides information about all active bank deposit sessions for the location.</td>
</tr>
<tr>
<td>Run Server Bank Report</td>
<td>Provides information about the active server bank session for the user running the report.</td>
</tr>
<tr>
<td>Run Petty Cash Report</td>
<td>Provides information about all active petty cash sessions for the location.</td>
</tr>
<tr>
<td>Run Server Banking Report</td>
<td>Provides information about all active server banking sessions for the location.</td>
</tr>
<tr>
<td>Run Change Order Report</td>
<td>Provides information about open Change Order sessions for the property.</td>
</tr>
</tbody>
</table>

4. Click **Save**.
Configuring ECM Privileges and Permissions

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Select the role type (for example, administrator, manager or server), and then click the EMC Modules tab.
3. In the Cash Management section, select the appropriate Cash Management operation permissions for the user role. You can grant permissions for the following actions:
   - **View**: Open and view a Cash Management module. If you allow a user to Edit, Add, or Delete, you must also grant View access (otherwise the user cannot open the module).
   - **Edit**: Update fields or records within a module.
   - **Add**: Add records to a module. You cannot add records to the Cash Management Class Behavior module.
   - **Delete**: Delete records from a module. You cannot delete records from the Cash Management Class Behavior module.
   - **Add Override**: Override records in a module. You cannot override records in the Cash Management Classes module.
4. Click the Operations tab, and then click the Cash Management subtab.
5. Select the appropriate options for the privileges. The following table summarizes the privileges associated with ECM functionality and the recommended roles to have the privilege set.

<table>
<thead>
<tr>
<th>Section</th>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to Perform or Authorize</th>
<th>Recommended Role(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Operations</td>
<td>249</td>
<td>Change Count Sheet</td>
<td>Changing the count sheet that the receptacle session uses</td>
<td>Manager</td>
</tr>
<tr>
<td>General Operations</td>
<td>250</td>
<td>Pull Cash</td>
<td>A cash pull</td>
<td>Cashier, Manager</td>
</tr>
<tr>
<td>Section</td>
<td>Option Number</td>
<td>Privilege Name</td>
<td>Allow the Employee to Perform or Authorize...</td>
<td>Recommended Role(s)</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------</td>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>General Operations</td>
<td>258</td>
<td>Threshold Level Exception</td>
<td>A Cash Pull Threshold Exception (bypass the threshold notification) when prompted and permitted</td>
<td>Manager</td>
</tr>
<tr>
<td>General Operations</td>
<td>260</td>
<td>View Receptacle Session Status</td>
<td>Viewing of summary information for all active receptacle sessions</td>
<td>Manager</td>
</tr>
<tr>
<td>General Operations</td>
<td>267</td>
<td>Update Balance on Count</td>
<td>Updating the balance on a count when the amount is outside the count threshold values</td>
<td>Manager</td>
</tr>
<tr>
<td>General Operations</td>
<td>301</td>
<td>View Cash Management Dashboard</td>
<td>Viewing the Cash Management Dashboard page</td>
<td>Manager</td>
</tr>
<tr>
<td>General Operations</td>
<td>302</td>
<td>View Cash Management Dashboard</td>
<td>Viewing the till and server bank detail from the Cash Management Dashboard page</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>201</td>
<td>Assign Till to Cash Drawer</td>
<td>Assignment of a till to a cash drawer on a workstation</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>202</td>
<td>Unassign Till from Cash Drawer</td>
<td>Unassignment of a till to a cash drawer on a workstation</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>203</td>
<td>Assign User to Till</td>
<td>Perform or authorize the assignment of an employee to an active till session</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>204</td>
<td>Unassign User from Till</td>
<td>Unassignment of an employee to an active till session</td>
<td>Manager</td>
</tr>
</tbody>
</table>
### Table 48-2  (Cont.) ECM Privileges

<table>
<thead>
<tr>
<th>Section</th>
<th>Option Number</th>
<th>Privilege Name</th>
<th>Allow the Employee to Perform or Authorize...</th>
<th>Recommended Role(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Till Operations</td>
<td>205</td>
<td>Count Till</td>
<td>Counting of a till session</td>
<td>Cash Handler</td>
</tr>
<tr>
<td>Till Operations</td>
<td>206</td>
<td>Adjust Till Count</td>
<td>Adjustment of the last count for a till session</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>207</td>
<td>Paid-In/Paid-Out</td>
<td>Posting of an ECM paid-in or paid-out on a till session. Workstation operators can perform standard paid-in and paid-out transactions based on Tender/Media configuration.</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>209</td>
<td>Transfer Funds</td>
<td>Transfer of items from a till session to another cash receptacle session</td>
<td>Cashier, Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>210</td>
<td>Deposit Funds</td>
<td>Deposit of cash from a till session to a bank deposit session</td>
<td>Cash Handler</td>
</tr>
<tr>
<td>Till Operations</td>
<td>212</td>
<td>Close Till</td>
<td>Closing of a till session</td>
<td>Cash Handler</td>
</tr>
<tr>
<td>Till Operations</td>
<td>213</td>
<td>Reopen Till</td>
<td>Reopening of a till session</td>
<td>Manager</td>
</tr>
<tr>
<td>Till Operations</td>
<td>251</td>
<td>Quick Start Till</td>
<td>Opening of a till session and assignment of the current operator to a workstation cash drawer</td>
<td>Cash Handler</td>
</tr>
<tr>
<td>Till Operations</td>
<td>259</td>
<td>Adjust Till Starting Amount</td>
<td>Adjustment of the till starting amount</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>241</td>
<td>Start Server Bank</td>
<td>Opening of a new server bank session</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>242</td>
<td>Count Server Bank</td>
<td>Counting of a server bank session</td>
<td>Manager</td>
</tr>
<tr>
<td>Section</td>
<td>Option Number</td>
<td>Privilege Name</td>
<td>Allow the Employee to Perform or Authorize...</td>
<td>Recommended Role(s)</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------</td>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>243</td>
<td>Adjust Server Bank Count</td>
<td>Adjustment of the last count for a server bank session</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>244</td>
<td>Paid-In/Paid-Out</td>
<td>Posting of an ECM paid-in or paid-out on a server bank session Workstation operators can perform standard paid-in and paid-out transactions based on Tender/Media configuration.</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>245</td>
<td>Transfer Funds</td>
<td>Transferring of funds from a server bank session to another cash receptacle session</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>246</td>
<td>Deposit Funds</td>
<td>Deposit of cash from a server bank session to a bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>247</td>
<td>Close Server Bank</td>
<td>Closing of a server bank session</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>248</td>
<td>Reopen Server Bank</td>
<td>Reopening a closed server bank</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>265</td>
<td>Adjust Server Bank Starting Amount</td>
<td>Adjustment of the server bank session starting amount</td>
<td>Manager</td>
</tr>
<tr>
<td>Server Bank Operations</td>
<td>269</td>
<td>Consolidate Server Banks</td>
<td>Consolidating two server bank sessions</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>214</td>
<td>Open Safe</td>
<td>Opening of a new safe session</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>215</td>
<td>Count Safe</td>
<td>Counting of a safe session</td>
<td>Manager</td>
</tr>
<tr>
<td>Section</td>
<td>Option Number</td>
<td>Privilege Name</td>
<td>Allow the Employee to Perform or Authorize...</td>
<td>Recommended Role(s)</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------</td>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>216</td>
<td>Adjust Safe Count</td>
<td>Adjustment of the last count for a safe session</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>217</td>
<td>Paid-In/Paid-Out</td>
<td>Posting of an ECM paid-in or paid-out on a safe session Workstation operators can perform standard paid-in and paid-out transactions based on Tender/Media configuration.</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>218</td>
<td>Transfer Funds</td>
<td>Transferring of funds from a safe session to another cash receptacle session</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>219</td>
<td>Deposit Funds</td>
<td>Deposit of cash from a safe session to a bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>220</td>
<td>Close Safe</td>
<td>Closing of a safe session</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>261</td>
<td>Add Funds to Safe</td>
<td>Adding new funds into ECM through a safe receptacle</td>
<td>Manager</td>
</tr>
<tr>
<td>Safe Operations</td>
<td>262</td>
<td>Remove Funds from Safe</td>
<td>Removing funds from ECM through a safe receptacle</td>
<td>Manager</td>
</tr>
<tr>
<td>Petty Cash</td>
<td>222</td>
<td>Open Petty Cash</td>
<td>Opening of a new petty cash session</td>
<td>Manager</td>
</tr>
<tr>
<td>Petty Cash</td>
<td>223</td>
<td>Count Petty Cash</td>
<td>Counting of a petty cash session</td>
<td>Manager</td>
</tr>
<tr>
<td>Petty Cash</td>
<td>224</td>
<td>Adjust Petty Cash Count</td>
<td>Adjustment of the last petty cash session count</td>
<td>Manager</td>
</tr>
<tr>
<td>Section</td>
<td>Option Number</td>
<td>Privilege Name</td>
<td>Allow the Employee to Perform or Authorize...</td>
<td>Recommended Role(s)</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------</td>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Petty Cash Operations</td>
<td>225</td>
<td>Paid-In/Paid-Out</td>
<td>Posting of an ECM paid-in or paid-out on a petty cash session. Workstation operators can perform standard paid-in and paid-out transactions based on Tender/Media configuration.</td>
<td>Manager</td>
</tr>
<tr>
<td>Petty Cash Operations</td>
<td>226</td>
<td>Transfer Funds</td>
<td>Transferring of funds from a petty cash session to another cash receptacle session</td>
<td>Manager</td>
</tr>
<tr>
<td>Petty Cash Operations</td>
<td>227</td>
<td>Deposit Funds</td>
<td>Deposit of cash from a petty cash session to a bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Petty Cash Operations</td>
<td>228</td>
<td>Close Petty Cash</td>
<td>Closing of a petty cash session</td>
<td>Manager</td>
</tr>
<tr>
<td>Bank Deposit Operations</td>
<td>233</td>
<td>Create a Bank Deposit</td>
<td>Opening of a new bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Bank Deposit Operations</td>
<td>234</td>
<td>Transfer Funds</td>
<td>Transferring of funds from a bank deposit to another cash receptacle session</td>
<td>Manager</td>
</tr>
<tr>
<td>Bank Deposit Operations</td>
<td>237</td>
<td>Adjust Cash Deposit</td>
<td>Adjustment of a cash deposit amount in a bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Bank Deposit Operations</td>
<td>239</td>
<td>Reconcile Bank Deposit</td>
<td>Reconciliation of a bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Bank Deposit Operations</td>
<td>264</td>
<td>Adjust Bank Deposit Reference</td>
<td>Adjustment of a reference on a bank deposit session</td>
<td>Manager</td>
</tr>
<tr>
<td>Section</td>
<td>Option Number</td>
<td>Privilege Name</td>
<td>Allow the Employee to Perform or Authorize...</td>
<td>Recommended Role(s)</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------</td>
<td>----------------------</td>
<td>-----------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Change Order Operations</td>
<td>230</td>
<td>Create Change Order</td>
<td>Creation of a new Change Order request from a safe session</td>
<td>Manager</td>
</tr>
<tr>
<td>Change Order Operations</td>
<td>232</td>
<td>Reconcile Change Order</td>
<td>Reconciliation of a Change Order</td>
<td>Manager</td>
</tr>
<tr>
<td>Change Order Operations</td>
<td>252</td>
<td>Submit Change Order</td>
<td>Submission of a new Change Order request from a safe session</td>
<td>Manager</td>
</tr>
<tr>
<td>Change Order Operations</td>
<td>268</td>
<td>Save / Recall Change Order</td>
<td>Saving or recalling a Change Order</td>
<td>Manager</td>
</tr>
</tbody>
</table>

6. Click **Save**.

- Configuring Data Retention Limits
- Allowing Users to View Blind Totals
- Allowing Assigned Receptacle Access and Counts
- Configuring Accounting Methods for Users
- Allowing Users to Override Employee Class Options
- Creating, Editing, and Deleting Cash Management Reasons

**Related Topics**
- ECM Workstation Hardware
- ECM Configuration Levels

### Allowing Users to View Blind Totals

In some cases, you can require that workstation operators view the difference between the amount entered during a count and the amount expected by application transaction activity. Selecting **View Blind Totals** allows workstation operators within the Employee Class to view application expected values and the difference on the count sheet. When an over or short condition exists, the workstation operator can select the reason for the variance.

1. Select the property, click **Configuration**, and then click **Employee Classes**.
2. Select the role type, and then click **Operator Options**.
3. Select **25 - View Blind Totals**.
4. Click **Save**.

- Configuring Data Retention Limits
Allowing Assigned Receptacle Access and Counts

ECM requires that you assign a workstation operator to a till or server bank receptacle session to perform transactions against the session. Managers need access to work within these receptacle sessions without being assigned to the sessions. You can create an Employee Class for management workstation operators with a configuration set that allows them to perform transactions against the till or server banking session without prior assignment.

1. Select the property, click Configuration, and then click Employee Classes.
2. Select the role type, and then click Operator Options.
3. Select 26 - Allow Assigned Receptacle Access to:
   - Allow workstation operators to view and perform transactions for till receptacles when the operator is not the owner or an assigned user.
   - Show a list of employees with closed server bank sessions that can be reopened.
4. To prevent the workstation operator from counting a till session more than once, select 27 - Prevent Multiple Receptacle Counts.
   If the till session was already counted, the workstation operator cannot count it again immediately afterwards.
5. Click Save.
Configuring Accounting Methods for Users

You can specify the type of accounting method a workstation operator uses to track cash management activities. The method you select determines the type of Front of House receptacles the workstation operator can access.

1. Select the property, click Configuration, and then click Employee Classes.
2. Select the role type.
3. On the General tab, select the appropriate Cash Management Accounting Method:
   - None: Select this option to prevent the workstation operator from executing till or server banking transactions.
   - Till Banking: Select this option for workstation operators that maintain and work from a till that is assigned to a workstation (for example, bartenders and cashiers).
   - Server Banking: Select this option for workstation operators who maintain and work from an individual server bank on their person (for example, servers who are responsible for accepting payment on guest checks). This accounting method does not allow workstation operators to perform transaction activity on a till session when the operator is an assigned user.
4. Click Save.

- Configuring Data Retention Limits
- Configuring ECM Privileges and Permissions
- Allowing Users to View Blind Totals
- Allowing Assigned Receptacle Access and Counts
- Allowing Users to Override Employee Class Options
- Creating, Editing, and Deleting Cash Management Reasons

Related Topics
- ECM Workstation Hardware
- ECM Configuration Levels

Allowing Users to Override Employee Class Options

You can optionally override Employee Class configuration options for individual workstation operators.

1. Select the Enterprise, zone, property, or revenue center, click Configuration, and then click Employee Maintenance.
2. Select a property and revenue center, and then click Search.
4. Select Override Class Options for an employee.
5. Select the override options.
Table 48-3 Override Employee Class Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>When you select Override Class Options, the application automatically selects the Operator Options for the employee’s revenue center. You can override option 25 - View Blind Totals here.</td>
</tr>
<tr>
<td>Cash Management Accounting Method</td>
<td>When you select a Cash Management accounting method here for an employee, you override the accounting method set in the Employee Class module.</td>
</tr>
<tr>
<td>Cash Drawer</td>
<td>This option indicates the cash drawer that is defined for the workstation operator within the revenue center: 0 (no cash drawer assignment, user prompted), 1, or 2. The Quick Start till operation uses the defined cash drawer.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

- Configuring Data Retention Limits
- Configuring ECM Privileges and Permissions
- Allowing Users to View Blind Totals
- Allowing Assigned Receptacle Access and Counts
- Configuring Accounting Methods for Users
- Creating, Editing, and Deleting Cash Management Reasons

Related Topics
- ECM Workstation Hardware
- ECM Configuration Levels

Tracking Tender Transaction Items

You can identify tender media transaction items (for example, cash, check, and other currency based tenders) that you want ECM to track.

1. Select the Enterprise, zone, or property, click **Configuration**, and then click **Tender/Media**.
2. Double-click the tender media record.
3. Click the **Options** tab, and then click the **Ops Behavior** subtab.
4. Select the appropriate Tender Media options, and then click **OK**.
   - **4 - Use with Currency Conversion**: Select this option for the foreign currency class payment tender.
   - **91 - Cash Management Transaction Item**: Select this option to include the tender record in ECM tracking and reporting.
   - **(Optional) 92 - Affects Cash Pull Threshold**: Select this option to have transactions performed for this tender record affect the Cash Pull Threshold.
Set balance. Select this option for tender records that represent a loss if they are lost or stolen (for example, cash and checks). You must select option 91 to use option 92.

5. Click **Save**.

- Tracking Service Charge Transactions
- Tracking Discount Transactions

### Tracking Service Charge Transactions

You can identify service charge transactions (for example, gift card sales) that you want ECM to track.

1. Select the Enterprise, zone, or property, click **Configuration**, and then click **Service Charges**.
2. Double-click the service charge.
3. Select **28 - Cash Management Transaction Item** to include the service charge record in ECM tracking and reporting.
4. Click **Save**.

- Tracking Tender Transaction Items
- Tracking Discount Transactions

### Tracking Discount Transactions

You can identify discount transactions (for example, coupons and promotional vouchers) that you want ECM to track.

1. Select the Enterprise, zone, or property, click **Configuration**, and then click **Discounts**.
2. Double-click the discount.
3. Select the appropriate discount options on the **General** tab:
   - **33 - Cash Management Transaction Item**: Select this option to include the discount record in ECM tracking and reporting.
   - (Optional) **34 - Affects Cash Pull Threshold**: Select this option to have transactions performed for this discount record increase the value in a receptacle. You must select option 33 to use option 34.
4. Click **Save**.

- Tracking Tender Transaction Items
- Tracking Service Charge Transactions

### Creating, Editing, and Deleting Cash Management Reasons

Certain ECM operations allow (and sometimes require) the workstation operator to enter a reason for performing the operation. For example, workstation operators must provide a reason for adjusting transactions.
1. Select the Enterprise, zone, property, or revenue center, click **Descriptors**, and then click **Cash Management Reasons**.

2. Highlight the Cash Management transaction, and then select **Add Reason**.

3. Enter the reason name, based on the following guidelines:
   - You can define multiple reasons for each transaction.
   - You can use each reason name only once per transaction type.

   When you enter a No Sale Reason, the cash drawer opens only after the workstation operator enters a reason when performing a No Sale transaction. You can set and use No Sale reason codes without activating ECM. You can also access No Sale reason codes through extensibility or a System Interface Module (SIM)-based event.

4. Click **Save**.

5. To edit a reason, highlight the reason record, change the reason name, and then click **Save**.

   After you change a reason, the new reason appears when viewing historical reporting activity.

6. To delete a reason, highlight the reason record, and then select **Delete Reason**.

   The application allows you to delete only reasons that are not referenced in historical reporting activity.

- **Configuring Data Retention Limits**
- **Configuring ECM Privileges and Permissions**
- **Allowing Users to View Blind Totals**
- **Allowing Assigned Receptacle Access and Counts**
- **Configuring Accounting Methods for Users**
- **Allowing Users to Override Employee Class Options**

**Related Topics**

- **ECM Workstation Hardware**
- **ECM Configuration Levels**

**Cash Management Classes**

Beginning with Simphony version 18.1, the ECM supports multiple classes (currency and non-currency based). Non-currency items include credit card vouchers, gift cards, and coupons. Classes can be based on primary or alternate currencies. The Engagement console shows multiple classes in widgets.

Reporting and Analytics version 18.1 Enterprise reports and workstation property reports support the tracking of multiple classes. If you upgrade to Simphony version 18.1, but do not upgrade to Reporting and Analytics version 9.0 (for example, Reporting and Analytics remains at version 8.5.0), Enterprise reports do not show information for multiple classes, nor do they show the correct base class.
Adding Transaction Items

You must map transaction items (for example, tenders) to the Cash Management currency class to measure their impact (increase or decrease) on the balance of all transactions. ECM tracks only transaction items that are mapped to the class.

1. Select the Enterprise, zone, or property, click **Setup**, and then click **Cash Management Classes**.

2. Insert a Cash Management class record, and then double-click it.

3. Click the **Transaction Items** tab.

4. Enter the name of the class to track in ECM (for example, Cash US Dollars, Cash Canadian Dollars, Vouchers, and so on).

5. Select an available **Currency** from the list to associate with the Cash Management class.
   
   You can only associate the currency with a single class. Select **0 - None** for non-currency tracking (for example, vouchers and stored value cards) as these items are always based on the property’s local currency.

6. Click **Save**.

7. Select the Enterprise, zone, property, or revenue center, click **Setup**, and then click **Cash Management Class Behavior**.

   Records are automatically created and removed in the Cash Management Class Behavior module based on the creation and deletion of records in the Cash Management Classes module. If you have the appropriate permission, you can use the Cash Management Class Behavior module to customize and override the class configuration. **Configuring ECM Privileges and Permissions** contains more information about the **Add Override** permission.

8. Right-click a record, select **Override Record**, and then select one of the following:
   
   - **Use Existing Record**
   - **Create Blank Record**

9. Select **Display on Status** to show the currency class on the POS client workstation when viewing the receptacle status.

   The **Oracle Hospitality Simphony Manager User Guide** contains information on Viewing Receptacle Status.

10. Select **Add Transaction Item**.

11. Select the **Transaction Item Type** (for example, Tender).

12. Select the **Transaction Item** (for example, Euro Cash).

   The **Cash Management Transaction Item** options in the tender, service charge, or discount determine the items that appear in the **Transaction Item** list. You can use each transaction item only once per currency class.

13. Click **Save**.

   - **Adding Counting Units**
Adding Counting Units

After you add a denomination unit to a Cash Management class, ECM includes the unit when building Count Sheets and PAR Level Sets. The following figure shows an example of the units mapping setup.

**Figure 48-1   Counting Units**

1. Select the Enterprise, zone, property, or revenue center, click **Setup**, and then click **Cash Management Classes**.
2. Double-click a Cash Management class record.
3. Click the **Counting Units** tab.
4. Select **Add Unit**.
5. Enter the name of the unit (for example, Pennies, Fives, Twenties, Travelers Checks, and so on).
6. If the unit has a consistent cash value (for example, notes and coins), select **Denominated**. Do not select this option for transaction items that have inconsistent cash values (for example, personal checks, credit cards, and gift cards).
7. If the unit is denominated, enter the units value relative to the base currency unit in the **Numerator** field. For example, when the base currency is US dollars, the base currency unit is 1 ($1.00).
8. If the unit is denominated, enter the number of units relative to the base currency unit in the **Denominator** field. For example, when the base currency is US dollars, the base currency unit is 1 ($1.00).
9. After you enter the numerator and denominator, the **Value** field shows the calculated value per unit.
10. Click **Save**.

- Adding Transaction Items
Cash Pull Threshold Set

The optional Cash Pull Threshold Set provides a group of balance-based levels to compare against a till or server banking session during a transaction. The Cash Pull Threshold Set indicates when notifications occur for cash pulls. These notifications minimize risk by limiting the amount of cash circulating in the Front of House. You can add one or more threshold levels to a Cash Pull Threshold Set. If you create a threshold based on one or more currency classes, a cash pull notification occurs when a till or server banking session meets or exceeds the amount of a specific currency class.

Related Topics
• Creating, Editing, and Deleting a Cash Pull Threshold Set

Creating, Editing, and Deleting a Cash Pull Threshold Set

1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click Cash Pull Threshold Sets.
2. Insert a record, enter the name of the Cash Pull Threshold Set, and then click OK.
3. Double-click the record to open it.
4. Enter the Chit Quantity.
   This is the number of chits that print when a workstation operator performs a cash pull. A cash pull chit represents the funds that are removed from the till or server bank.
5. Select Add, and then enter the name of the threshold set.
   The name is part of the notification that appears in the application.
6. Enter the Amount.
   This is the amount-based threshold (for example, 100 dollars) that elevates the cash pull notification to the threshold level. If you configure more than one threshold level, subsequent amounts cannot be equal to or lower than the previous cash pull amount in the same set.
7. Select Approval to allow a workstation operator with the Threshold Level Exception privilege to authorize the operator to ignore the exception and to process transactions against the receptacle without performing a cash pull.
8. Click Save.
9. To edit a cash pull threshold set, highlight the record, change the values, and then click Save.
   The last (final) threshold level does not allow a threshold exception (bypass). This requires the workstation operator to perform a cash pull first to execute additional activities against the till or server bank later.
10. To delete a cash pull threshold set, highlight the record, and then select Delete.
    You cannot delete a Cash Pull Threshold Set associated with one or more templates.
Related Topics

• Cash Pull Threshold Set

Cash Count Threshold Set

The optional Cash Count Threshold Set provides an allowable variance threshold for countable receptacles. This threshold is the difference between counted totals and expected totals. The threshold indicates the overage and shortage amounts allowed to complete a receptacle count. You can add one or more cash count threshold sets to a count sheet. You can also configure multiple currency classes for a cash count threshold set, and allow workstation operators to set varying thresholds against the classes.

Related Topics

• Creating, Editing, and Deleting a Cash Count Threshold Set

Creating, Editing, and Deleting a Cash Count Threshold Set

1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click Cash Count Threshold Sets.

2. Add a Cash Count Threshold Set, enter the name, and then click OK.

3. Enter the Short amount.
   This value is the minimum variance amount allowed to complete the receptacle count.

4. Enter the Over amount.
   This value is the maximum variance amount allowed to complete the receptacle count.

5. Enter the number of Max Count Attempts.
   This value limits the number of times a workstation operator can attempt to submit a count when the count is over or short beyond the defined threshold.

6. To define additional over or short amounts for each currency class, click the Add Class link.
   You cannot define multiple over or short amounts for the same primary class within a Cash Count Threshold Set.
   a. Select the Class from the drop-down list.
   b. (Optional) In the Over field, enter the approved over variance amount for workstation operators to enter for the count.
   c. (Optional) In the Short field, enter the approved short variance amount for workstation operators to enter for the count.

7. Click Save.

8. To edit a cash count threshold set, highlight the record, change the values, and then click Save.

9. To delete a cash count threshold set, highlight the record, and then select Delete.
   You cannot delete a Cash Count Threshold Set associated with one or more templates.
PAR Level Set

Periodic Automatic Replenishment (PAR) Level Sets specify the suggested quantity to maintain of each currency denomination kept in a safe (for example, rolls of coins or quantity of a denominated note). PAR Level Sets are comprised of count units drawn from the list of denominated items in a Cash Management class. The PAR determines the values required when issuing a Change Order request to return the receptacle back to the PAR based on the last known count of the receptacle. The use of a PAR Level Set is optional.

Creating, Editing, and Deleting a PAR Level Set

1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click PAR Level Sets.
2. Insert a record, and enter the PAR Level Set name.
3. Double-click the record to open it.
4. Select the CM Class.
   The CM Class list includes all Cash Management classes that you created. These Cash Management classes contain the units that are allowed within the PAR Level Set.
5. Add a Counting Unit using one of the following methods:
   • Select Add All Units to have ECM add all defined units for the Cash Management class to the PAR Level.
   • Select Add Unit to manually add specific units.
6. For each of the defined units, enter the quantity of units to maintain as part of the PAR Level Set for each day of the week.
   The Totals row beneath the Units table shows the cash value required for each unit quantity and day of the week.
7. Click Save.
8. To edit a PAR Level Set, highlight the record, change the values, and then click Save.
9. To delete a PAR Level Set, highlight the record, and then select Delete.
   You cannot delete a PAR Level Set that is associated with one or more templates.

Related Topics
• Cash Count Threshold Set
Count Sheet

A Count Sheet is a custom form used to audit the contents of a safe, till, server bank, or petty cash receptacle. A workstation operator uses a Count Sheet during the physical counting of a receptacle session. You can configure the count to include one of the following:

- Expected funds where variances are recorded
- A simple counting of funds where no variance is tracked (blind count)

You can create unique Count Sheets for each receptacle session to determine the items and order in which a count is performed, as well as the format for the printed Count Sheet results. Creating a Count Sheet is similar to building a report. You can associate multiple classes with a Count Sheet. When you create a Count Sheet, you define Pages, Groups, and Units.

Pages

A Count Sheet Page is similar to a chapter in a report. Pages allow you to see totals for all values counted within the page. For example, you can create a page for each currency class (US Dollars, Euros, and Pounds Sterling).

Groups

Transaction Items are reported in Count Sheet groups. Groups allow you to see totals for all values counted within the group. For example, you can create separate groups for Notes (paper money) and Coins. Within the Notes group, you can assign the currency class (such as Euros).

Units

A unit is optional but recommended for groups that report based on counting units. If you do not add a unit, a Total entry appears for the group. Units define the denominations associated with a currency. Notes, coins, traveler's checks, and gift certificates are examples of denominated items. Personal checks and credit cards are not denominated items, because the amount of money associated with them varies with the transaction.

The currency is used as a tender in most cases, but not always. Some tenders indicate whether the unit has a consistent cash value. A twenty dollar bill is always worth $20.00 US. If the unit is denominated, you must define a value relative to the base currency. For example, if the base currency is US Dollars (US$), the following ratios can be defined:

- Twenties = 20:1 (twenty US$ per unit)
- Tens = 10:1 (ten US$ per unit)
- Quarters = 1:4 (1/4 of a US$ per unit)
- Dime Roll = 5:1 (five US$ per unit)

Related Topics

- Creating, Editing, and Deleting a Count Sheet
Creating, Editing, and Deleting a Count Sheet

1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click Count Sheets.

2. Insert a record, enter a unique name for the Count Sheet, and then click OK.

3. To add or delete a Count Sheet Page:
   a. In the Pages section, click the Add link.
   b. Enter a name for each page in the Name column (for example, Cash and Vouchers).
   c. To delete a page, highlight the page name record, and then click the Delete link. The application deletes all units associated with a group for the selected page, along with the page.

4. To add or delete a Count Sheet Group:
   a. In the Pages section, highlight a page.
   b. In the Groups section, click the Add link.
   c. Enter a name for each group in the Name column. For example, you can have a Cash page with the groups Notes (paper currency) and Coins.
   d. Select the Cash Management currency class for each group from the Class drop-down list.

5. Too add or delete Count Sheet Units:
   a. In the Groups section, highlight a group.
   b. In the Units section, click the Add link to add all units to count as part of the group.
   c. Select the Units for each group from the Units drop-down list.
Only the Unit Types associated with the Cash Management Class for the group are available in the **Units** drop-down list. When you select a **Units** value, the **Name** column shows the name of the unit selected. Change the **Name** value to show its representation on the Count Sheet POS client view and chit printout. You can use each Unit Type only once on a page.

d. To delete a unit, highlight a unit record, and then click the **Delete** link.

6. Click **Save**.

7. To sort and alter the order in which pages, groups on a page, and units within a group appear on the Count Sheet at the POS client, use the up and down arrows. All units that are part of the selected group remain with the group as it moves. Units that are part of groups for the selected page remain with the page as it moves. Groups that are part of the selected page remain with the page as it moves.

8. To edit a Count Sheet, highlight the count sheet record, change the values, and then click **Save**.

    When you change a Count Sheet, the application removes all units associated with the group.

9. To delete a Count Sheet, highlight the record, and then select **Delete**.

    You cannot delete a Count Sheet associated with one or more templates.

**Related Topics**

- **Count Sheet**

---

### Creating, Editing, and Deleting an Account

You can use accounts to report general ledger accounting information for ECM paid-in and paid-out transactions (for example, produce, meat, bakery, or flower shop).

1. Select the Enterprise, zone, property, or revenue center, click **Setup**, and then click **Accounts**.

2. Insert a record, enter a unique name for the account, and then click **OK**.

3. Click the ellipsis point (...) button in the Options column.
   
   a. Select **1 - Deactivate Account** to deactivate or suspend an account that is no longer being used. A newly created account is active by default.

   b. Select **2 - Exclude on Paid In** to exclude the account and associated vendors from being used when a workstation operator performs a paid-in transaction.

   c. Select **3 - Exclude on Paid Out** to exclude the account and associated vendors from being used when a workstation operator performs a paid-out transaction.

4. To edit an account, highlight the record, change the values, and then click **Save**.

5. To delete an account, highlight the record, and then click **Delete** on the toolbar.

    The application only allows you to delete accounts that are not referenced in historical reporting activity. When an account is assigned to a vendor, you cannot delete it. You can unassign the account from the vendor.

6. Click **Save**.
Creating, Editing, and Deleting a Vendor

You can use a vendor to associate companies with ECM paid-in and paid-out transactions for reporting purposes.

1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click Vendors.
2. Insert a record, enter a unique name for the vendor, and then click OK.
3. (Optional) Select an account from the Account drop-down list to associate with the vendor.
   The vendor always uses the selected account for ECM paid-in and paid-out transactions.
4. Click the ellipsis point (...) button from the Options column and select the appropriate vendor options:
   • 1 - Deactivate Vendor: Select this option to prevent further selection of the vendor when performing transactions. For example, you can place a credit hold. A newly created vendor is active by default.
   • (Optional) 2 - Invoice Data Required: Select this option to require the workstation operator to enter invoice information (for example, Date, Invoice Number, and Description) when performing a transaction for the vendor that can collect invoice data (for example, paid-out).
   • 3 - Require Reference on Use: Select this option to require the workstation operator to enter a reference when performing a transaction that requires a vendor.
5. To edit a vendor, highlight the record, change the values, and then click Save.
6. To delete a vendor, highlight the record, and then click Delete on the toolbar.
   The application only allows you to delete vendors that are not referenced in historical reporting activity.
7. Click Save.

Creating and Editing a Template

You need to use a template to set the initial configuration and operating values for all new receptacle tracking sessions. This includes setting the amount, assigning a count sheet, and specifying how the application handles the opening balance after the workstation operator closes the receptacle. A template allows additional configuration for specified classes or class exclusions (till and server bank receptacles only) based on the receptacle type.

1. Select the Enterprise, zone, property, or revenue center, click Setup, and then click Templates.
2. Insert a template record with a unique name, and then click OK.
3. Double-click the template record to open it.
4. On the **General** tab, enter or select information in the following fields:

- **(Optional) Description**: A description provides further understanding of the template that might not be distinguishable by looking at the template name. The Description is not shown as part of the receptacle when the workstation operator opens the receptacle from a template.

- **Receptacle Type**: Depending on the type of receptacle you select, additional fields become active. The following table describes the fields and receptacle types.

<table>
<thead>
<tr>
<th>Field or Option</th>
<th>Safe</th>
<th>Till</th>
<th>Server Bank</th>
<th>Bank Deposit</th>
<th>Petty Cash</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Amount</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Starting Amount Source</td>
<td>Required</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prompt for Starting Amount</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cash Pull Threshold</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cash Pull Destination</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count Sheet</td>
<td>Required</td>
<td>Required</td>
<td>Required</td>
<td></td>
<td>Required</td>
</tr>
<tr>
<td>Cash Count Threshold</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td>Close on Count Completion</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PAR Level</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum</td>
<td>Required</td>
<td>Required</td>
<td>Required</td>
<td></td>
<td>Required</td>
</tr>
<tr>
<td>Minimum</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Required</td>
</tr>
<tr>
<td>Cash Deposit Routing</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Start Amount**: The starting amount determines the initial currency value of the session upon opening.

- **Starting Amount Source**: The starting amount source determines where the starting amount for the session originates. You can specify different starting amount source configurations for the General and Class Detail tabs (for example, if the source is a different safe that holds only foreign currencies).

The source for a server bank session must be either an internal (House supplied) or external (server supplied) starting amount for all defined ECM classes (not internal and external). If you select **None** for a server bank, the starting amount is considered to be part of the receptacle and funds are not
transferred from a source receptacle session. For example, a server who self funds a bank does not receive a funds transfer from the safe when opening the bank. Selecting a defined safe transfers the starting amount from the safe session to the receptacle session upon opening.

- **Prompt for Starting Amount**: Select this option to prompt the workstation operator to enter the starting amount for the receptacle session upon opening. When you select this option, the application ignores the value in the starting amount field. This option is typically used for server banks where the server self-funds the bank.

- **Cash Pull Threshold**: This field defines the Cash Pull Threshold Set that a receptacle session uses. If you set cash pull values, select a threshold set from the drop-down list to be used for the template.

- **Cash Pull Destination**: Select a destination receptacle into which funds from cash pull operations will transfer; if you select None, funds do not transfer and ownership remains with the receptacle session.

- **Count Sheet**: The Count Sheet value in a template determines the Count Sheet that is used to count the receptacle.

- **Cash Count Threshold**: This field defines the Cash Count Threshold Set that a receptacle session uses. If you set cash count values, select a Threshold Set from the drop-down list to be used for the template.

- **Close on Count Completion**: Select this option to have the application attempt to automatically reconcile the receptacle session upon completion of the count. This process transfers funds from the receptacle session to the sessions designated under Starting Amount Source and Cash Deposit Routing to bring the session to zero. Deselect this option to leave the session open after the count completes. The workstation operator must then manually reconcile all funds and close the receptacle.

- **PAR Level**: The PAR Level defines the PAR Level Set (quantity to maintain of each currency denomination) to use for the safe session.

- **Minimum**: The minimum balance determines the lowest amount of funds permitted as part of a receptacle session. The application prevents workstation operators from processing most activity that takes the session balance below this amount. If you do not set a minimum balance, the application defaults to 0 (no minimum).

- **Maximum**: The maximum balance determines the largest amount of funds permitted as part of a receptacle session. The application prevents workstation operators from processing most activity that takes the session balance beyond this amount. If you do not set a maximum balance, it defaults to 0 (no maximum).

- **Cash Deposit Routing**: Select the destination receptacle (safe or bank deposit) session to receive funds that transfer from a receptacle session as part of a cash deposit operation. When you select None, the application prompts the workstation operator to select a location to deposit cash.

5. Click the **Class Details** tab.
   a. To create additional currency classes (alternate currency such as Dollar, Peso, Euro, or Pounds, or non-currency such as gift cards) for a receptacle session or operation, click the **Add Class** link.

   When you configure the base currency in the **Class Details** tab, these settings override the configuration set in the **General** tab. Use the **Add Class** link for
receptacle sessions and operations that have multiple cash management classes. You can add alternate classes for bank deposit, till, server bank, and petty cash receptacle templates only. You cannot add a duplicate class entry.

b. To remove a class, click the **Delete Class** link, select the class, and then click **OK**.

c. To add additional PAR Levels, click the **Add PAR Level** link.

You can add a PAR Level for safe receptacle templates only.

d. To remove a PAR Level, click the **Delete PAR Level** link, select the PAR Level, and then click **OK**.

6. Click the **Class Exclusions** tab.

a. To specify currency classes that cannot be used in till and server bank receptacles created with the receptacle template, click the **Add Class** link, and then select the class.

For example, if a till uses the template which excludes the Euros currency class, the Count Sheet does not show the Euro page. You can exclude classes for the till and server bank receptacle templates only. A till and server bank receptacle accepts any currency class unless you exclude it here.

b. To remove classes from the class exclusion list, click the **Delete Class** link, select the class, and then click **OK**.

7. To edit a template, highlight the template record, change the values, and then click **Save**.

Creating, Editing, and Deactivating Receptacles

A receptacle represents a physical or virtual location used to store funds and draw transactions.

1. Select the Enterprise, zone, property, or revenue center, click **Setup**, and then click **Receptacles**.

2. Insert a record, enter a unique name for the receptacle, and then click **OK**.

3. Double-click the receptacle record to open it.

4. Enter or select information in the receptacle fields.

   • **Receptacle Type**: Select the type of receptacle.

   • **Template Name**: Select the template to use for this receptacle.

   • **Location**: Select the location where the receptacle is defined.

   You can define a receptacle type that is commonly used across an Enterprise or region without uniquely defining it at each property or revenue center. The location allows you to specify a receptacle name and configuration to be used in multiple locations. When you select **2 - Property**, a receptacle is defined for each property based on the values entered. When you select **3 - Revenue Center**, a receptacle is defined within each revenue center.

   For example, each property might have one safe to maintain all cash transactions for the entire property. Create a safe receptacle from the Enterprise level or zone, and then specify the property in the **Location** field. The safe receptacle is defined at all properties under the selected level.
• **Options**: Select **Deactivate Receptacle** to prevent workstation operators from performing further activity against the receptacle.

5. To edit a receptacle, highlight the record, change the values, and then click **Save**.

6. To deactivate a receptacle, highlight the record, and then select **Deactivate Receptacle**.

   Deleting a receptacle is not permitted.

7. Click **Save**.

### Setting Cash Management Parameters

1. Select the Enterprise, zone, property, or revenue center, click **Setup**, and then click **Cash Management Parameters**.

2. Click the **Configuration** tab.

3. Enter or select the appropriate information.

### Table 48-5  Cash Management Parameters Configuration Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash Pull Notification Frequency</td>
<td>Specify when the application notifies workstation operators of the cash pull threshold levels being reached or exceeded.</td>
</tr>
<tr>
<td></td>
<td>• <strong>0 - None</strong>: Select this option to disable cash pull notifications (default). Workstation operators can use the manual process for cash pulls.</td>
</tr>
<tr>
<td></td>
<td>• <strong>1 - On Threshold Level Only</strong>: Select this option to notify the workstation operator once upon reaching or exceeding a defined threshold level in the Threshold Level Set.</td>
</tr>
<tr>
<td></td>
<td>• <strong>2 - On Each Transaction</strong>: Select this option to notify the workstation operator with each new check access attempt upon reaching or exceeding a defined threshold level in the Threshold Level Set.</td>
</tr>
<tr>
<td>Receptacle Balancing Class</td>
<td>Select the class that is based on the currency in which the property operates. All transaction items included in the Cash Management Class selection determine the appearance of the receptacle balance on views and reports.</td>
</tr>
<tr>
<td>Change Order Report Count</td>
<td>Enter the number of reports to print when a workstation operator creates a new Change Order request.</td>
</tr>
</tbody>
</table>
Table 48-5  (Cont.) Cash Management Parameters Configuration Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Counting Method</td>
<td>Select the method in which the workstation operator must enter counting units when performing a count or change order.</td>
</tr>
<tr>
<td></td>
<td>• 1 - Quantity: Select this option to require the workstation operator to enter the quantity of the counting units. The application calculates the value based on the quantity entered for the associated counting unit.</td>
</tr>
<tr>
<td></td>
<td>• 2 - Value: Select this option to require the workstation operator to enter the value of the counting units. The application calculates the quantity based on the value entered for the associated counting unit.</td>
</tr>
<tr>
<td>Paid-In/Paid-Out Chit Count</td>
<td>Enter the number of chits to print when the workstation operator performs an ECM paid-in or paid-out transaction.</td>
</tr>
<tr>
<td>Server Banking Template</td>
<td>Select the default template to use when a workstation operator opens a new server banking session. You can override this setting from the Employee Classes module.</td>
</tr>
</tbody>
</table>

4. Click the Options tab.
5. Select the appropriate Cash Management Parameter options.

Table 48-6  Cash Management Parameter Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Enable Cash Management</td>
<td>Select this option to activate all ECM features and functions in the application. Selecting <strong>Enable Cash Management</strong> increases both required workstation resources and bandwidth for communications with the Enterprise. You can define all ECM configurations without selecting this option. This allows you to configure ECM beforehand and activate ECM with a single option.</td>
</tr>
<tr>
<td>11 - Require Reason on Adjust Starting Amount</td>
<td>Select this option to require the workstation operator to select a reason code when adjusting a starting amount.</td>
</tr>
<tr>
<td>12 - Require Reason on Adjust Count</td>
<td>Select this option to require the workstation operator to select a reason code when adjusting a previously entered count.</td>
</tr>
<tr>
<td>13 - Require Reason on Adjust Cash Deposit</td>
<td>Select this option to require the workstation operator to select a reason code when adjusting a cash deposit transaction.</td>
</tr>
<tr>
<td>14 - Require Reason on Paid-In</td>
<td>Select this option to require the workstation operator to select a reason code when performing a paid-in transaction.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>15 - Require Reason on Paid-Out</td>
<td>Select this option to require the workstation operator to select a reason code when performing a paid-out transaction.</td>
</tr>
<tr>
<td>16 - Require Reason on Transfer</td>
<td>Select this option to require the workstation operator to select a reason code when transferring funds from one receptacle to another.</td>
</tr>
<tr>
<td>17 - Require Reason on Adjust Bank Deposit Reference</td>
<td>Select this option to require the workstation operator to select a reason code when adjusting a bank deposit reference.</td>
</tr>
<tr>
<td>20 - Require Deposit Reference</td>
<td>Select this option to prompt the workstation operator to enter a reference when creating a new bank deposit. The workstation operator is not obligated to enter a reference at the prompt.</td>
</tr>
<tr>
<td>21 - Require Reference for Receptacle Counts</td>
<td>Select this option to prompt the workstation operator to enter a reference when counting a receptacle. The workstation operator is not obligated to enter a reference at the prompt.</td>
</tr>
<tr>
<td>24 - Require Reference for Cash Pull</td>
<td>Select this option to prompt the workstation operator to enter a reference when performing a cash pull. The workstation operator is not obligated to enter a reference at the prompt.</td>
</tr>
<tr>
<td>25 - Require Reason on Over/Short</td>
<td>Select this option to require the workstation operator to enter a reason code when posting an operation that finds a variance in values.</td>
</tr>
<tr>
<td>26 - Allow Count of Assigned Till</td>
<td>Select this option to allow the workstation operator to count a till that is assigned to a workstation. When you deselect it, you unassign the till from the workstations to count. After upgrading to Simphony version 2.7 MR2, existing customers who want to continue to count assigned tills need to set this option.</td>
</tr>
<tr>
<td>27 - Require Check Closed Before Receptacle Close</td>
<td>Select this option to allow the workstation operator to close a till or server banking session only after all checks with assigned users as the check owner are closed. The workstation operator must close all open checks before closing the till or server banking session. Setting this option ensures that a receptacle is available to settle cash tenders to open checks for workstation operators assigned to the receptacle.</td>
</tr>
</tbody>
</table>

Table 48-6  (Cont.) Cash Management Parameter Options
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>28 - Restrict a Single User per Till</td>
<td>Select this option to restrict a till session to only allow one user. When the workstation operator has option 26 - Allow Assigned Receptacle Access set from the Employee Class, the Allow All button is available on the POS client during the assignment operation.</td>
</tr>
<tr>
<td>29 - Save Count Progress</td>
<td>Select this option to allow the workstation operator to save an incomplete count sheet when counting a receptacle session.</td>
</tr>
<tr>
<td>30 - Enable Change Order Tracking</td>
<td>Select this option to track change order transactions, save, and recall change order requests.</td>
</tr>
<tr>
<td>31 - Require Reference for Change Order</td>
<td>Select this option to prompt the workstation operator to enter a reference when submitting a change order request. The workstation operator is not obligated to enter a reference at the prompt.</td>
</tr>
<tr>
<td>32 - Cash Pull Threshold Notification on Transaction Close</td>
<td>Select this option to prompt the workstation operator after completing an active transaction that exceeds the cash pull threshold level.</td>
</tr>
<tr>
<td>33 - Prompt for Business Date on Open Bank Deposit</td>
<td>Select this option to prompt the workstation operator to select a business date when opening a bank deposit receptacle. The operator can select the current business date or up to seven dates in the past.</td>
</tr>
<tr>
<td>34 - Hide Bank Deposits on Dashboard</td>
<td>Select this option to hide the Bank Deposits tab on the Cash Management Dashboard.</td>
</tr>
<tr>
<td>35 - Hide Petty Cash on Dashboard</td>
<td>Select this option to hide the Petty Cash tab on the Cash Management Dashboard.</td>
</tr>
<tr>
<td>36 - Hide Safes on Dashboard</td>
<td>Select this option to hide the Safes tab on the Cash Management Dashboard.</td>
</tr>
<tr>
<td>37 - Hide Server Banks on Dashboard</td>
<td>Select this option to hide the Server Banks tab on the Cash Management Dashboard.</td>
</tr>
<tr>
<td>38 - Hide Tills on Dashboard</td>
<td>Select this option to hide the Tills tab on the Cash Management Dashboard.</td>
</tr>
<tr>
<td>39 - Display Employee First for Tills on Dashboard</td>
<td>Select this option to show the Employee column first in the Tills tab on the Cash Management Dashboard. Additionally, when this option is enabled, the Tills Counted column appears in the Bank Deposit tab on the Cash Management Dashboard. When disabled, the Expected column appears in the Bank Deposit tab on the Cash Management Dashboard.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>41 - Require Reference for Paid-In when vendor not defined</td>
<td>Select this option to prompt the workstation operator to enter a reference when performing a paid-in transaction without a vendor defined. The workstation operator is not obligated to enter a reference at the prompt. If a vendor is defined, the paid-in transaction follows the configuration of 3 - Require Reference on Use in the Vendors module. When option 3 is enabled, the workstation operator is required to enter a reference when performing a transaction (such as paid-in to till, safe, or server bank) that requires a vendor.</td>
</tr>
<tr>
<td>42 - Require Reference for Paid-Out when vendor not defined</td>
<td>Select this option to prompt the workstation operator to enter a reference when performing a paid-out transaction without a vendor defined. The workstation operator is not obligated to enter a reference at the prompt. If a vendor is defined, the paid-out transaction follows the configuration of 3 - Require Reference on Use in the Vendors module. When option 3 is enabled, the workstation operator is required to enter a reference when performing a transaction (such as paid-out to till, safe, or server bank) that requires a vendor.</td>
</tr>
<tr>
<td>43 - Prompt to Confirm Transfer During Close on Count</td>
<td>Select this option to prompt the workstation operator with a confirmation when closing a count and transferring the cash from a till or server bank receptacle to a deposit.</td>
</tr>
<tr>
<td>44 - Enforce Close Till and Deposit Till Roles</td>
<td>Select this option to override Role privilege options 210 - Deposit Funds and 212 - Close Till. If this option is enabled, Role option 205 - Count Till is enabled, and 210 and 212 are disabled, the till receptacle does not close after the user performs a count. Configuring ECM Privileges and Permissions contains information on options 210 and 212.</td>
</tr>
</tbody>
</table>
Table 48-6  (Cont.) Cash Management Parameter Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>45 - Prompt for Drawer on Quick Start Till</td>
<td>Select this option to prompt the workstation operator to select the cash drawer on workstations with more than one drawer when performing the Quick Start Till function. When 45 is enabled, the Quick Start Till function ignores the cash drawer configuration of the workstation operator. On a workstation with a single drawer, the selected till session is automatically assigned to that drawer (if it does not have one already assigned). On a workstation with two drawers, the operator is prompted for a cash drawer when both are available, or auto assigned to the available drawer when one is in use.</td>
</tr>
<tr>
<td>46 - Prevent Assignment of Tills with Active Sessions to Cash Drawers</td>
<td>Select this option to show only till receptacles that do not have an active session and are not assigned to a cash drawer when the workstation operator performs either the Assign Till To Cash Drawer or the Quick Start Till function. When 46 is enabled, a workstation operator cannot assign a till session that has been counted to a cash drawer. The till session needs to be closed and a new one started. You must also select option 28 - Restrict a Single User per Till.</td>
</tr>
</tbody>
</table>

6. Click Save.

7. Select the Enterprise, zone, property, or revenue center, click Setup, and then click Control Parameters.

8. Click the Options tab.

9. Select 68 - Require Reason on No Sale to require the workstation operator to select a reason code when performing a No Sale operation.

10. Click Save.

Creating Cash Management Touchscreens and Dashboard

Oracle Hospitality recommends that you create a page with tabs on which to place the cash management functions. Create and configure tabs to show operations by receptacle type. Create buttons on the page for the required cash management functions listed. The following figure shows an example of a page with cash management functions created in the Page Design module.
You can also add the Cash Management Dashboard to page layouts using the Page Design module. The Dashboard lets managers view:

- The number of each type of open receptacle
- A summary level and detail view of each type of open receptacle

The Dashboard also includes one-button navigation to open, count, adjust, transfer, and finalize receptacles.

Option **1 - Enable Cash Management** must be set in the Cash management Parameters module to use the Cash Management Dashboard.

1. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Page Design**.
2. Open the page on which to place cash management buttons.
3. On the **Edit** tab, select the page area in which to define the cash management functions.
5. On each tab, create buttons for each of the functions listed in the following table.

**Table 48-7   Cash Management Tabs and Buttons**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safe</td>
<td>Add Funds</td>
<td>Add money to the safe.</td>
</tr>
<tr>
<td></td>
<td>Adjust Count</td>
<td>Correct values from the previous count.</td>
</tr>
<tr>
<td></td>
<td>Change Count Sheet</td>
<td>Adjust the count sheet that workstations operators use to perform a count.</td>
</tr>
</tbody>
</table>
## Table 48-7  (Cont.) Cash Management Tabs and Buttons

<table>
<thead>
<tr>
<th>Tab</th>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Receptacle</td>
<td>Close the safe’s tracking session.</td>
<td></td>
</tr>
<tr>
<td>Count Receptacle</td>
<td>Count the money in the safe.</td>
<td></td>
</tr>
<tr>
<td>Deposit Cash</td>
<td>Deposit cash from the safe to a bank deposit.</td>
<td></td>
</tr>
<tr>
<td>Open New Change Order Request</td>
<td>Open a Change Order when a safe is low on a particular denomination or to stock up for an event.</td>
<td></td>
</tr>
<tr>
<td>Open New Receptacle</td>
<td>Open a new safe tracking session.</td>
<td></td>
</tr>
<tr>
<td>Paid-In</td>
<td>Accept funds for the safe outside of a guest check.</td>
<td></td>
</tr>
<tr>
<td>Paid-Out</td>
<td>Distribute funds from the safe outside of a guest check.</td>
<td></td>
</tr>
<tr>
<td>Remove Funds</td>
<td>Remove money from a safe session and from tracking.</td>
<td></td>
</tr>
<tr>
<td>Transfer Funds</td>
<td>Transfer money from the safe to another receptacle.</td>
<td></td>
</tr>
<tr>
<td>Bank Deposit</td>
<td>Adjunct Bank Deposit Reference</td>
<td>Change the reference of a bank deposit session.</td>
</tr>
<tr>
<td></td>
<td>Adjunct Cash Deposit</td>
<td>Change the amount of a cash deposit that was placed into the bank deposit session.</td>
</tr>
<tr>
<td></td>
<td>Open New Receptacle</td>
<td>Open a new bank deposit tracking session.</td>
</tr>
<tr>
<td></td>
<td>Reconcile Bank Deposit</td>
<td>Close the bank deposit.</td>
</tr>
<tr>
<td></td>
<td>Transfer Funds</td>
<td>Transfer money from the bank deposit to another receptacle.</td>
</tr>
<tr>
<td>Till</td>
<td>Adjust Count</td>
<td>Correct values from the previous count.</td>
</tr>
<tr>
<td></td>
<td>Adjust Till Starting Amount</td>
<td>Change the starting amount of a till session after opening it.</td>
</tr>
<tr>
<td></td>
<td>Assign Till to Cash Drawer</td>
<td>Assign a till to a cash drawer.</td>
</tr>
<tr>
<td></td>
<td>Assign User(s) to Till</td>
<td>Assign one or more operators to the till session on the workstation.</td>
</tr>
<tr>
<td></td>
<td>Audit Receptacle (Till)</td>
<td>Perform a count without closing the till session irrespective of the Close on Count Completion option.</td>
</tr>
<tr>
<td>Tab</td>
<td>Button Name</td>
<td>Function</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change Count Sheet</td>
<td>Adjust Count Sheet</td>
<td>Adjust the count sheet that workstations operators use to perform a count.</td>
</tr>
<tr>
<td></td>
<td>Close Receptacle</td>
<td>Close the till's tracking session.</td>
</tr>
<tr>
<td></td>
<td>Count Receptacle</td>
<td>Count the money in the till.</td>
</tr>
<tr>
<td></td>
<td>Deposit Cash</td>
<td>Deposit cash from the till to a bank deposit.</td>
</tr>
<tr>
<td></td>
<td>Paid-In</td>
<td>Accept funds for the till outside of a guest check.</td>
</tr>
<tr>
<td></td>
<td>Paid-Out</td>
<td>Distribute funds from the till outside of a guest check.</td>
</tr>
<tr>
<td></td>
<td>Pull Cash</td>
<td>Remove cash from the till session.</td>
</tr>
<tr>
<td></td>
<td>Quick Start Till</td>
<td>Quickly assign a workstation operator and till to a cash drawer on the workstation.</td>
</tr>
<tr>
<td></td>
<td>Transfer Funds</td>
<td>Transfer money from the till to another receptacle.</td>
</tr>
<tr>
<td></td>
<td>Unassign Till from Cash</td>
<td>Restrict the till to a limited number of operations. This function does not close the till.</td>
</tr>
<tr>
<td></td>
<td>Drawer from Till Unassign</td>
<td>Prevent the workstation operator from performing transactions on the till. This function does not close the till.</td>
</tr>
<tr>
<td></td>
<td>User(s) from Till Unassign</td>
<td></td>
</tr>
<tr>
<td>Server Bank</td>
<td>Adjust Count</td>
<td>Correct values from the previous count.</td>
</tr>
<tr>
<td></td>
<td>Adjust Server Bank Starting</td>
<td>Change the starting amount of a till session after opening it.</td>
</tr>
<tr>
<td></td>
<td>Amount</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Close Receptacle</td>
<td>Close the server bank's tracking session.</td>
</tr>
<tr>
<td></td>
<td>Count Receptacle</td>
<td>Count the money in the server bank.</td>
</tr>
<tr>
<td></td>
<td>Deposit Cash</td>
<td>Deposit cash from the server bank to a bank deposit.</td>
</tr>
<tr>
<td></td>
<td>Paid-In</td>
<td>Accept funds for the server bank outside of a guest check.</td>
</tr>
<tr>
<td></td>
<td>Paid-Out</td>
<td>Distribute funds from the server bank outside of a guest check.</td>
</tr>
<tr>
<td></td>
<td>Pull Cash</td>
<td>Remove cash from the server bank session.</td>
</tr>
</tbody>
</table>
### Table 48-7 (Cont.) Cash Management Tabs and Buttons

<table>
<thead>
<tr>
<th>Tab</th>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Petty Cash</td>
<td>Transfer Funds</td>
<td>Transfer money from the server bank to another receptacle.</td>
</tr>
<tr>
<td></td>
<td>Adjust Count</td>
<td>Correct values from the previous count.</td>
</tr>
<tr>
<td></td>
<td>Close Receptacle</td>
<td>Close the petty cash tracking session.</td>
</tr>
<tr>
<td></td>
<td>Count Receptacle</td>
<td>Count the money in petty cash.</td>
</tr>
<tr>
<td></td>
<td>Deposit Cash</td>
<td>Deposit cash from the petty cash to a bank deposit.</td>
</tr>
<tr>
<td></td>
<td>Open New Receptacle</td>
<td>Open a new petty cash tracking session.</td>
</tr>
<tr>
<td></td>
<td>Paid-In</td>
<td>Accept funds for petty cash outside of a guest check.</td>
</tr>
<tr>
<td></td>
<td>Paid-Out</td>
<td>Distribute funds from petty cash outside of a guest check.</td>
</tr>
<tr>
<td></td>
<td>Transfer Funds</td>
<td>Transfer money from petty cash to another receptacle.</td>
</tr>
<tr>
<td>General</td>
<td>Cash Management Dashboard</td>
<td>View the number of each type of open receptacle session, see summary level and detail of each type of open receptacle session, and open, count, adjust, transfer, and finalize receptacle sessions using a button.</td>
</tr>
<tr>
<td></td>
<td>View Receptacle Status</td>
<td>Look at summary information for all receptacle sessions.</td>
</tr>
<tr>
<td></td>
<td>Till Assignment Status</td>
<td>Determine whether a till is assigned to a cash drawer on the workstation.</td>
</tr>
<tr>
<td></td>
<td>(Smart Key)</td>
<td></td>
</tr>
<tr>
<td>Payments</td>
<td>Payment Types</td>
<td>Receive payment by type of currency.</td>
</tr>
<tr>
<td></td>
<td>for example, separate buttons for USD, Euro, and Peso</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Currency Conversion</td>
<td>Convert one currency to another.</td>
</tr>
</tbody>
</table>

6. To add the Cash Management Dashboard:
   a. Click **Button**.
   b. On the **General** subtab, select **Function** from the **Type** drop-down list.
   c. Click the black arrow beneath the **Type** drop-down list.
   d. Select **Cash Management Dashboard**, and then click the **OK** button.
   e. Enter a **Legend** for the button.
f. Position and size the button on the page. Use the Style arrow to change the color.

g. Click Save.

Configuring a Smart Key on a Workstation

A smart key prevents the use of a workstation until you assign a till session to a cash drawer on the workstation. After assignment, the key permits the workstation operator to sign on to the workstation. Follow these steps to implement the optional smart key.

1. Select the Enterprise, zone, property, or revenue center, click Configuration, and then click Page Design.

2. Select the Sign In page.

3. On the Edit tab, click Button.

4. Enter information in the Page Design fields.

Table 48-8 Page Design Edit Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend</td>
<td>Enter the name of the button (for example, Till Status).</td>
</tr>
<tr>
<td>Type</td>
<td>Select Function from the drop-down list.</td>
</tr>
<tr>
<td>Sub Type</td>
<td>Click the black arrow, and then select Smart Key.</td>
</tr>
<tr>
<td>Auto Active</td>
<td>Select this option to make the button automatically active.</td>
</tr>
</tbody>
</table>

5. Click the Edit Smart Keys button.

6. Click Add.

7. Enter information in the fields as described in the following table for Smart Key entry number 1.

Table 48-9 Smart Key 1 Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Select Till Assigned from the drop-down list.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter 1.</td>
</tr>
<tr>
<td>Legend</td>
<td>Enter the name of the button (for example, Sign In).</td>
</tr>
<tr>
<td>Type</td>
<td>Select Function from the drop-down list.</td>
</tr>
<tr>
<td>Sub Type</td>
<td>Click the black arrow, and then select Sign-In.</td>
</tr>
</tbody>
</table>

8. Click Add.

9. Enter information in the fields as described in the following table for Smart Key entry number 2.
### Table 48-10  Smart Key 2 Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Select <strong>Default</strong> from the drop-down list.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter 2.</td>
</tr>
<tr>
<td>Legend</td>
<td>Enter the name of the button (for example, Assign Till).</td>
</tr>
<tr>
<td>Type</td>
<td>Select <strong>Function</strong> from the drop-down list.</td>
</tr>
<tr>
<td>Sub Type</td>
<td>Click the black arrow, and then select <strong>Assign Till To Cash Drawer</strong>.</td>
</tr>
</tbody>
</table>

10. Click **Close**.

11. Click **Save**.

## Configuring a Till Through Extensibility

ECM provides the **Designate till number during assignment** capability through extensibility. When you set the InitiatingCommand.Arguments to a valid receptacle object number, the application attempts to use that till when assigning a till to a workstation. If the till is not found or is assigned to another workstation, the application prompts the workstation operator for the till to assign.

- Configuring a Bank Deposit Reference Through Extensibility

## Configuring a Bank Deposit Reference Through Extensibility

ECM allows you to define a bank deposit reference through extensibility using the GetReference entry. Transaction and location information is exposed to extensibility to set values that you can use (if required) in the bank deposit reference. The bank deposit reference entry is based on the following transaction and location information:

- Property Number and Name
- Revenue Center (RVC) Number and Name
- Business Date
- Workstation Number

The extensibility application automatically generates the bank deposit reference. When you set the bank deposit reference value through extensibility, the workstation operator cannot enter or edit the reference value.

- Configuring a Till Through Extensibility

## ECM Reporting

ECM reporting for receptacles and activity is available at the Enterprise and property hierarchy levels.

**Related Topics**

- Enabling Reports in Enterprise Back Office
Enabling Reports in Enterprise Back Office

Enterprise reports must be assigned to an employee role in Oracle Hospitality Reporting and Analytics before authorized employees can run them. An administrator typically assigns the reports to a role.

1. In Reporting and Analytics, click Admin, click Warehouse, click Reports, and then click Report Roles.
2. Highlight a role, and then click Select.
3. On the Role Reports screen, click Add.
4. Select the report names from the list, and then click Save.
5. Create a report category:
   a. Click Admin, click Warehouse, click Reports, and then click Report Categories.
   b. Click Add.
   c. On the Report Categories screen, enter the Name of the new report category, a Description, and specify a Sort Order.
   d. Click Save.

• Specifying Ad Hoc Reports

Related Topics
• ECM Reporting
• ECM Enterprise Information in Reporting and Analytics Reports
• ECM Property Reports

ECM Enterprise Information in Reporting and Analytics Reports

Enterprise reports provide information about active and completed receptacle sessions for the Enterprise in Oracle Hospitality Reporting and Analytics, including the reports listed in the following table. These reports contain drill-down options to allow simple auditing for all receptacle tracking sessions related to the report. You can filter the results by date, organization, property, revenue center, receptacle type, receptacle, receptacle session, status, and class. (Class information is available only if using Reporting and Analytics version 18.1.)

The Oracle Hospitality Reporting and Analytics User Guide contains detailed information about each report.
### Table 48-11  Reporting and Analytics ECM Enterprise Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safe Report</td>
<td>This report contains information about all safe sessions (regardless of their state) for the selected location and business date.</td>
</tr>
<tr>
<td>Petty Cash Report</td>
<td>This report contains information about all petty cash sessions (regardless of their state) for the selected location and business date.</td>
</tr>
<tr>
<td>Till Report</td>
<td>This report contains information about all till sessions (regardless of their state) for the selected location and business date.</td>
</tr>
<tr>
<td>Bank Deposit Report</td>
<td>This report contains information about all bank deposit sessions (regardless of their state) for the selected location and business date.</td>
</tr>
<tr>
<td>Bank Deposit Adjustment Report</td>
<td>This report contains information about bank deposit adjustments (amount and references) that were performed for bank deposit receptacles for the selected location and business date.</td>
</tr>
<tr>
<td>Server Bank Report</td>
<td>This report contains information about all server bank sessions (regardless of their state) for the selected location and business date.</td>
</tr>
<tr>
<td>Count Adjustment Report</td>
<td>This report contains information about count adjustments that were performed for all receptacle tracking sessions for the selected properties.</td>
</tr>
<tr>
<td>Starting Amount Adjustment Report</td>
<td>This report contains information about adjustments to starting amounts that were defined for all receptacle sessions for the selected location and business date.</td>
</tr>
<tr>
<td>Over/Short Detail Report</td>
<td>This report contains information about over and short conditions that were reported for all receptacle sessions for the selected location and business date.</td>
</tr>
<tr>
<td>Paid-In/Paid-Out Report</td>
<td>This report contains information about paid-in and paid-out transactions that were reported for all receptacle tracking sessions for the selected properties.</td>
</tr>
<tr>
<td>Activity Report</td>
<td>This report contains information about all transactions and operations that were performed for receptacle sessions for the selected business date. Transactions and operations are listed chronologically, allowing an auditor to view an exact account of all activities performed from open to close for the receptacle session. The Activity Report includes Cash Count Threshold Level and Cash Pull Bypass/Threshold Level notifications for Till, Safe, Server Bank, and Petty Cash receptacles. This report is available through a drill-down from another report and shows only the filter selected from the parent report. For example, the Activity Report shows only the date and time range selected in the parent report. The Class filter is also available and functions when selected within the Activity Report.</td>
</tr>
<tr>
<td>Change Order Report</td>
<td>This report contains information about all Change Orders submitted (open) and reconciled (closed) for the selected business date. Saved Change Orders are not shown.</td>
</tr>
</tbody>
</table>
Table 48-11  (Cont.) Reporting and Analytics ECM Enterprise Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count Entry Details Report</td>
<td>This report contains information about details entered by the workstation operator during a receptacle count, including all denominated, non-denominated, and reference entries. This report is available through a drill-down from the Activity Report for a receptacle count. This report shows only the filter selected from the parent report. For example, the Count Entry Details Report shows only the date and time range selected in the parent report.</td>
</tr>
</tbody>
</table>

- ECM Property Reports

Related Topics

- ECM Reporting
- Enabling Reports in Enterprise Back Office
- Specifying Ad Hoc Reports

ECM Property Reports

Property level reporting at the workstation provides information on active receptacle sessions and transactions to assist in daily operations management. The reports include multiple classes showing additional currency and class details. The summary section for each report shows the currency name, abbreviation, and values (using symbol and separator). You can print these reports to a local printer for the workstation.

Filtering a property report by revenue center is based on the employee operator assignment record, reporting privileges (for each report), and the receptacle location.

You can create front of house buttons for each property report listed in the following table. Workstation Touchscreen Pages contains more information on configuring front of house buttons.

Table 48-12  ECM Property Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank Deposit Report</td>
<td>This report contains information about active bank deposit sessions for the location.</td>
</tr>
<tr>
<td>Cash Pull Report</td>
<td>This report contains information about cash pull transactions posted for the current business date.</td>
</tr>
<tr>
<td>Change Order Report</td>
<td>This report contains information about open Change Order sessions and transactions for the location.</td>
</tr>
</tbody>
</table>
Table 48-12  (Cont.) ECM Property Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count Sheet</td>
<td>This report is not selectable, and it prints automatically after completion of a receptacle count. The details shown are for counts entered during a receptacle count, including class totals and over/short values (if applicable).</td>
</tr>
<tr>
<td>Over/Short Detail Report</td>
<td>This report contains information about over and short conditions recorded for the current business date.</td>
</tr>
<tr>
<td>Paid-In/Paid-Out Report</td>
<td>This report contains information about paid-in and paid-out transactions recorded for the current business date. It is based on the revenue center in which the paid-in/paid-out activity occurred.</td>
</tr>
<tr>
<td>Petty Cash Report</td>
<td>This report contains information about active petty cash sessions for the location.</td>
</tr>
<tr>
<td>Safes Report</td>
<td>This report contains information about active safe sessions for the location.</td>
</tr>
<tr>
<td>Server Bank Report</td>
<td>This report contains information about the active server bank session for the operator signed on to the workstation.</td>
</tr>
<tr>
<td>Server Banking Report</td>
<td>This report contains information about active server banking sessions for the location.</td>
</tr>
<tr>
<td>Till Banking Report</td>
<td>This report contains information about active till sessions for the location.</td>
</tr>
<tr>
<td>Till Report</td>
<td>This report contains information about active till sessions assigned on the workstation.</td>
</tr>
</tbody>
</table>

- ECM Enterprise Information in Reporting and Analytics Reports

Related Topics
- ECM Reporting
- Enabling Reports in Enterprise Back Office
- Specifying Ad Hoc Reports

ECM Workstation Hardware

The following table lists the workstation hardware models and operating systems supported for ECM receptacle operations and functions. Some functionality related to the operation of tills is limited with tablets, handhelds, and other mobile devices. These devices are indicated in the table with an asterisk (*).

The receptacle’s tracking session includes ECM tracked transactions that are processed as part of normal guest check operations, regardless of the hardware model or supported operating system from which they originated.
### Table 48-13  Workstation Hardware

<table>
<thead>
<tr>
<th>Model</th>
<th>Operating System</th>
<th>ECM Features Supported?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle MICROS Workstation 6 Series</td>
<td>Microsoft Windows 8.1</td>
<td>Yes</td>
</tr>
<tr>
<td>Oracle MICROS Tablet E-Series (8-inch and 11-inch)</td>
<td>Microsoft Windows 8.1</td>
<td>Yes*</td>
</tr>
<tr>
<td>Oracle MICROS Workstation 5a</td>
<td>Microsoft Win32</td>
<td>Yes</td>
</tr>
<tr>
<td>Oracle MICROS PC Workstation 2015</td>
<td>Microsoft Win32</td>
<td>Yes</td>
</tr>
<tr>
<td>Oracle MICROS PC Workstation 2010</td>
<td>Microsoft Win32</td>
<td>Yes</td>
</tr>
<tr>
<td>DT Research 362</td>
<td>Microsoft POSReady 7</td>
<td>Yes*</td>
</tr>
<tr>
<td>DT Research 365</td>
<td>Microsoft Windows 7</td>
<td>Yes*</td>
</tr>
<tr>
<td>Zebra MC40 (formerly the Motorola MC40)</td>
<td>Android 4.1</td>
<td>Yes*</td>
</tr>
<tr>
<td>Apple iPad (all models)</td>
<td>Apple iOS 8</td>
<td>No</td>
</tr>
<tr>
<td>Certified Consumer Devices (Android)</td>
<td>Android 4.4</td>
<td>Yes*</td>
</tr>
</tbody>
</table>

### Related Topics

- Configuring Data Retention Limits
- Configuring ECM Privileges and Permissions
- Allowing Users to View Blind Totals
- Allowing Assigned Receptacle Access and Counts
- Configuring Accounting Methods for Users
- Allowing Users to Override Employee Class Options
- Creating, Editing, and Deleting Cash Management Reasons

### ECM Configuration Levels

The following table lists the hierarchy levels within the EMC that allow configuration of ECM operations.

### Table 48-14  EMC Configuration Levels

<table>
<thead>
<tr>
<th>EMC Configuration Name</th>
<th>Enterprise</th>
<th>Property</th>
<th>RVC</th>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cash Count Threshold Sets</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
Table 48-14  (Cont.) EMC Configuration Levels

<table>
<thead>
<tr>
<th>EMC Configuration Name</th>
<th>Enterprise</th>
<th>Property</th>
<th>RVC</th>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash Management Classes</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Cash Management Parameters</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cash Management Reasons</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cash Pull Threshold Sets</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count Sheets</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Employee Classes</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Employee Maintenance</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Page Design</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PAR Level Sets</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendors</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Templates</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Receptacles</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roles</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Related Topics
- Configuring Data Retention Limits
- Configuring ECM Privileges and Permissions
- Allowing Users to View Blind Totals
- Allowing Assigned Receptacle Access and Counts
- Configuring Accounting Methods for Users
- Allowing Users to Override Employee Class Options
- Creating, Editing, and Deleting Cash Management Reasons
Engagement Cloud Service

The Engagement Cloud Service is Simphony’s web-based user interface for the Oracle MICROS Tablet E-Series and Workstation 6 Series. The Engagement Cloud Service is deployed and automatically enabled with Simphony installation.

There are two types of pages in the Engagement UI:

• Welcome Page: Initial page that appears on tablet devices. You can assign different Welcome pages to workstations.
• Hub Pages: Pages that appear on the tablet after workstation operators sign on and press the Hub button. You can assign different Hub pages to each employee.

Pages can contain widgets that allow you to enhance workstation functionality. For example, you can have daily specials, image slideshows, a Twitter feed, and Oracle Hospitality Reporting and Analytics reports appear on the tablet’s touchscreen.

The Engagement UI runs on POS operations and allows you to:

• Configure Welcome and Hub pages
• Assign pages to properties, employees or workstations, or both
• Perform Manager Procedures

For more information, see the following:

• System Requirements and Supported Devices
• Security Precautions
• Assigning Privileges for Engagement Administrative Users
• Language Translation Tasks
• Adding a New Language to Hub and Welcome Pages
• Adding a Language to the EMCWeb File
• Adding a Language File to the Engagement Configuration Application Server
• Setting Multiple Languages
• Engagement Manager Procedures
• Adding Engagement Manager Procedure Tiles to the Hub Page
• Editing the Check Header and Trailer
• Editing Bulk Menu Item Prices
• Adding an Employee From a Template
• Deactivating an Employee
• Adding a New Menu Item Using an Existing Menu Item as a Template
• Adding Images to Menu Items
• Adding or Changing an Employee’s Profile Image
System Requirements and Supported Devices

The Engagement module included in Oracle Hospitality Simphony version 18.2 works with Oracle Hospitality Enterprise Back Office version 9.0 (or later).

The Engagement service is supported on workstations running the Microsoft Windows 8.1 and 10 operating systems.

You can use Engagement on the following devices:
- Oracle MICROS Tablet E-Series 8-inch and 11-inch models
- Oracle MICROS Tablet 700 series
- Oracle MICROS Workstation 6 Series
- Oracle MICROS Compact Workstation 310

Security Precautions

Related Topics
- Assigning Privileges for Engagement Administrative Users

Security Precautions

The Engagement feature allows you to configure live tiles and content that appear on a POS client device. Ensure that any external data sources or URLs provided through Engagement are secure and derive from a trusted source.

The URL widget, which shows web content from the configured location, contains built-in security precautions. By default, the URL widget locks the workstation operator into the domain of the link provided. That is, all links on a page that are outside of the domain are disabled to prevent workstation operators from navigating to these links. For example, if you configure a URL widget for http://www.oracle.com, all links outside of *.oracle.com are automatically disabled for the workstation operator.

Consider the following best practices when configuring the URL widget and POS client device on which it runs.
Internet Security Settings

The browser security settings within the Engagement feature are defined by the settings of Microsoft Internet Explorer. When you change Microsoft Internet Explorer options, (for example, Do not allow cookies) you also change the settings for the Engagement browser.

Do not move security levels below Medium-high with Enable Protected Mode on for Internet and Medium-low with Enable Protected Mode off for Local intranet. These are the minimum Engagement security settings. You may increase the security levels if desired.

Trusted Source

Only enter URLs for the widget from a secure and trusted source. Creating links to unverified sources and untrusted websites increases the security risk for your POS client device.

• System Requirements and Supported Devices

Related Topics

• Assigning Privileges for Engagement Administrative Users

Assigning Privileges for Engagement Administrative Users

You need to assign privileges for Engagement administrative users to access, add, and change new pages or page assignments in the EMC.

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Insert a record for the role (for example, host, bartender, server, manager, or administrator), and then click OK.
3. Double-click the role type.
4. Click the EMC Modules tab.
5. For the Engagement Page Design and Engagement Page Assignment modules listed in the File column, select one or more of the following privileges:
   • View: Grants access to view a module. You must select View so that employees in the role can open the module.
   • Edit: Allows employees in the role to edit Welcome and Hub pages.
   • Add: Allows employees in the role to add Welcome and Hub pages.
   • Delete: Allows employees in the role to delete Welcome and Hub pages.
6. Click Save.

Related Topics

• System Requirements and Supported Devices
• Security Precautions
Language Translation Tasks

Configuring language translation for Engagement consists of completing the following tasks:

• Adding a language to Hub and Welcome pages
• Adding a language to the EMCWeb file
• Adding a language file to the Engagement Configuration application server
• Enabling multi-languages

Related Topics

• Adding a New Language to Hub and Welcome Pages
• Adding a Language to the EMCWeb File
• Adding a Language File to the Engagement Configuration Application Server
• Setting Multiple Languages

Adding a New Language to Hub and Welcome Pages

1. Browse to the Engagement Language File directory on the workstation.
   The default installation path is [Drive Letter]:\Micros\Simphony\WebServer\Engagement\LanguageFile\Resources.xml.
2. Copy the Resources.xml file.
3. Rename the file to Resource.CULTURE-CODE.xml, where CULTURE-CODE is the code of the new language you are adding (for example, Resources.fr-FR.xml for French or Resources.es-ES.xml for Spanish).
4. Change the values of the <string> elements of each language entry to the target language.
   Do not change the values of other elements or attributes.
   You can move the number parameters ({0} or {1}) in the language string (left or right of the string text), but do not delete them.
5. Save the changes.

• Adding a Language to the EMCWeb File
• Adding a Language File to the Engagement Configuration Application Server
• Setting Multiple Languages

Related Topics

• Language Translation Tasks
• Setting Multiple Languages

Adding a Language to the EMCWeb File

1. Browse to the Engagement Language File directory on the Simphony application server.
The default installation path is [Drive Letter]\MICROS\Install\InstallTools\Text.

2. Copy the EMCWebLanguageStringsEN-US.xml file.

3. Rename the file to EMCWebLanguageStrings.CULTURE-CODE.xml, where CULTURE-CODE is the code of the new language you are adding.

   The file name must include the correct CULTURE-CODE naming convention (for example, EMCWebLanguageStrings.fr-FR.xml for French or EMCWebLanguageStrings.es-ES.xml for Spanish).

4. Change the values of the Text language attribute for each language entry to the target language.

   Do not change the values of the key or screen attributes.

   You can move the number parameters ({} or {1}) in the language string (left or right of the string text), but do not delete them.

5. Save the changes.

6. To upload translation files to the database, browse to [Drive Letter]\MICROS\Simphony2\Tools\UploadEMCWebLanguageStrings, and run UploadEMCWebLanguageStrings.exe.

   You can also run the executable file from a cmd prompt by entering
   UploadEMCWebLanguageStrings.exe -f:UploadedFilesPath -db:DbSettingsFile [-alias:DbAlias].

• Adding a New Language to Hub and Welcome Pages
• Adding a Language File to the Engagement Configuration Application Server
• Setting Multiple Languages

Related Topics
• Language Translation Tasks

Adding a Language File to the Engagement Configuration Application Server

1. Browse to the Engagement Language File folder on the Simphony application server.

   The default installation path is [Drive Letter]\Micros\Simphony2\Engagement\EngagementConfig\Languages.

2. Copy the en-US.xml file.

3. Rename the file to CULTURE-CODE.xml, where CULTURE-CODE is the code of the new language you are adding (for example, fr-FR.xml for French or es-ES.xml for Spanish).

4. Change the values of the Text language attribute for each language entry to the target language.

   Do not change the value of the record key attribute.

   You can move the number parameters ({0} or {1}) in the language string (left or right of the string text), but do not delete them.
5. Change the values of the name and code attributes on the second line to the Culture code of the target language (&lt;Language version="32" name="English (US)" code="en-US">).

6. Save the changes.

- Adding a New Language to Hub and Welcome Pages
- Adding a Language to the EMCWeb File
- Setting Multiple Languages

Related Topics
- Language Translation Tasks

Setting Multiple Languages

1. Select the Enterprise level, click Setup, and then click Languages.
2. Double-click a language record.
3. In the Language Culture field, enter the abbreviated language code. For example, the code for English - United States is en-US.
4. Repeat Steps 2 and 3 for each language record.
5. Click Save.

- Adding a New Language to Hub and Welcome Pages
- Adding a Language to the EMCWeb File
- Adding a Language File to the Engagement Configuration Application Server

Related Topics
- Language Translation Tasks

Engagement Manager Procedures

The Web EMC or Web Configuration Console (WCC) widget enables you to assign one of the following manager procedures to a tile:

**Table 49-1   WCC Widget Manager Procedures**

<table>
<thead>
<tr>
<th>Manager Procedure</th>
<th>Allows You To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Header/Trailer</td>
<td>Edit check headers and trailers for a property or revenue center. If a logo image is available at the Enterprise level from the EMC, you can also add that image to the check header.</td>
</tr>
<tr>
<td>Bulk Edit MI Prices</td>
<td>Filter and edit menu item prices by revenue center, major group, family group, screen look up (SLU), menu item class, and a keyword entry.</td>
</tr>
</tbody>
</table>
Table 49-1  (Cont.) WCC Widget Manager Procedures

<table>
<thead>
<tr>
<th>Manager Procedure</th>
<th>Allows You To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Menu Item</td>
<td>Add images to menu items. Add new menu items using existing menu item records as a template.</td>
</tr>
<tr>
<td>Copy Employee</td>
<td>Add new employees using existing employee records as a template. Add or change an image in an existing employee’s profile.</td>
</tr>
</tbody>
</table>

Related Topics

- Adding Engagement Manager Procedure Tiles to the Hub Page
- Editing the Check Header and Trailer
- Editing Bulk Menu Item Prices
- Adding an Employee From a Template
- Deactivating an Employee
- Adding a New Menu Item Using an Existing Menu Item as a Template
- Adding Images to Menu Items
- Adding or Changing an Employee’s Profile Image

Adding Engagement Manager Procedure Tiles to the Hub Page

1. Log in to the Engagement dashboard, go to the Hub Pages section, and then add a new WCC widget.
2. From the EMC - Properties dialog, select Copy Employee as the Command Type.
3. (Optional) Enter the Primary Text and Secondary Text to appear on the widget.
4. (Optional) Select the widget Size, and then add a Tile Image for the widget.
5. Click Save.
6. Repeat Steps 1 through 5 to add tiles to the Hub page for the Edit Header/Trailer, Bulk Edit MI Prices, and Copy Menu Item manager procedures.
Related Topics

- Engagement Manager Procedures

Editing the Check Header and Trailer

1. Sign on to the POS client device, and then tap the Hub function.
2. Tap the tile configured for the Edit Header/Trailer manager procedure.
3. Select a property or revenue center.
4. To edit the header and trailer for guest checks, tap Guest Check.
5. To edit the header for a customer receipt, tap Customer Receipt.
6. Enter the details to print on the header in the Header text fields, and then enter the details to print on the trailer in the Trailer text fields.
7. To insert a logo for the header:
   a. Select a Header text field, and then tap Insert Image.
   b. Select a logo from the preview.
8. Click Save.

Editing Bulk Menu Item Prices

1. Sign on to the POS client device, and then tap the Hub function.
2. Tap the tile configured for the Bulk Edit MI Prices manager procedure.
3. To edit the price of one menu item:
   a. Enter the menu item's name in the search field, and then tap Search.
   b. Tap the Price field of the menu item, enter the new menu item price, and then tap Enter.
4. To edit the prices of several menu items:
   a. Tap Filter Menu Item, and then select one or more of the following filter criteria:
      - Major Group
      - RVC
b. Tap the Price field of the first menu item on the search results, enter the new menu item price, and then tap Enter. The focus moves to the price of the next menu item.

5. Tap Save, and then tap OK to confirm the changes.

Related Topics
- Adding Engagement Manager Procedure Tiles to the Hub Page
- Editing the Check Header and Trailer
- Adding an Employee From a Template
- Deactivating an Employee
- Adding a New Menu Item Using an Existing Menu Item as a Template
- Adding Images to Menu Items
- Adding or Changing an Employee’s Profile Image

Adding an Employee From a Template

1. Sign on to the POS client device, and then tap the Hub function.
2. Tap the tile configured for the Copy Employee manager procedure.
3. Tap Filter Employees, select the revenue center, the employee role, and the employee class to assign to the new employee.
4. Select an employee from the search results, and then tap Copy Employee.
5. Configure the following information for the new employee:

<table>
<thead>
<tr>
<th>Field or Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Enter the employee’s first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Enter the employee’s last name.</td>
</tr>
<tr>
<td>DOB</td>
<td>Select the employee’s date of birth.</td>
</tr>
<tr>
<td>Hire Date</td>
<td>Enter the date the employee was hired.</td>
</tr>
<tr>
<td>(Optional) MagCard ID</td>
<td>Enter the magnetic card number assigned to the employee or swipe the card to enter the card number into the application.</td>
</tr>
<tr>
<td>(Optional) Finger Print</td>
<td>If a fingerprint scanner is connected, you can scan the employee’s fingerprints into the application.</td>
</tr>
</tbody>
</table>
### Table 49-2  (Cont.) Configuration Fields for Adding New Employees From a Template

<table>
<thead>
<tr>
<th>Field or Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RVCs</td>
<td>Select the employee’s revenue center. You cannot change the primary revenue center of the employee.</td>
</tr>
<tr>
<td>Enable Reporting</td>
<td>Select this option to grant the employee access to Oracle Hospitality Reporting and Analytics.</td>
</tr>
<tr>
<td>Is Salaried</td>
<td>Select this option if the employee is paid a flat amount.</td>
</tr>
<tr>
<td>Pay Rate</td>
<td>Enter the employee's pay rate.</td>
</tr>
<tr>
<td>Logon Name</td>
<td>Enter the username to use to sign on to the workstation. If you selected Enable Reporting, the employee can use the same username to sign on to Reporting and Analytics.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password to use to sign on to the workstation. If you selected Enable Reporting, the employee can use the same username to sign on to Reporting and Analytics.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Re-enter the password.</td>
</tr>
</tbody>
</table>

6. To add an image to the employee’s profile:
   a. Tap **Change Picture**, and then tap **Browse Image**.
   b. Select the employee's image, and then tap **Open**.

7. Tap **Add Employee**, and then tap **Yes** to confirm the insertion.

- Adding Engagement Manager Procedure Tiles to the Hub Page
- Editing the Check Header and Trailer
- Editing Bulk Menu Item Prices
- Deactivating an Employee
- Adding a New Menu Item Using an Existing Menu Item as a Template
- Adding Images to Menu Items
- Adding or Changing an Employee’s Profile Image

**Related Topics**
- Engagement Manager Procedures

### Deactivating an Employee

Deactivating an employee removes the employee’s access to Simphony and the Enterprise Back Office Suite. When an employee is deactivated:
- The employee is clocked out immediately when outside of a transaction.
The employee can no longer sign on to the Simphony POS client, EMC, Reporting and Analytics, or the Engagement configuration website.

Labor Management shows the deactivated employee’s status as Terminated. Use the Labor Management portal to re-hire a deactivated employee.

1. Sign on to the POS client device, and then tap the **Hub** function.
2. Tap the tile configured for the **Copy Employee** manager procedure.
3. Search for and select the employee you want to deactivate.
4. Tap **Deactivate Employee**, and then tap **OK** to confirm.

The Simphony EMC shows the deactivated employee’s status as Is Deleted. The Is Deleted option from the Employee Maintenance module is automatically set for the deactivated employee.

Adding Engagement Manager Procedure Tiles to the Hub Page
• Editing the Check Header and Trailer
• Editing Bulk Menu Item Prices
• Adding an Employee From a Template
• Adding a New Menu Item Using an Existing Menu Item as a Template
• Adding Images to Menu Items
• Adding or Changing an Employee’s Profile Image

**Related Topics**
• Engagement Manager Procedures

**Adding a New Menu Item Using an Existing Menu Item as a Template**

1. Sign on to the POS client device, and then tap the **Hub** function.
2. Tap the tile configured for the **Copy Menu Item** manager function.
3. Select a menu item that belongs to the same menu item class and print class that you want to assign to the new menu item, and then tap **Copy Menu**.
4. Configure the following details for the new menu item:

**Table 49-3  Configuration Fields for Adding New Menu Items From a Template**

<table>
<thead>
<tr>
<th>Field or Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Item Master Name</td>
<td>Enter the new menu item name.</td>
</tr>
<tr>
<td>Definition</td>
<td>Select the appropriate menu item definition.</td>
</tr>
<tr>
<td></td>
<td>Select the appropriate menu item definition.</td>
</tr>
<tr>
<td></td>
<td>If the menu item that you are using as the template has several definitions,</td>
</tr>
<tr>
<td></td>
<td>all definitions appear in the list.</td>
</tr>
<tr>
<td>Menu Item Definition Name</td>
<td>Enter the name for the new menu item definition.</td>
</tr>
</tbody>
</table>

Chapter 49
Adding a New Menu Item Using an Existing Menu Item as a Template
49-11
Table 49-3  (Cont.) Configuration Fields for Adding New Menu Items From a Template

<table>
<thead>
<tr>
<th>Field or Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price</td>
<td>Enter the menu item price.</td>
</tr>
</tbody>
</table>

5. To change the image for the menu item:
   a. Tap Change Picture, and then tap Browse Image.
   b. Select the new image, and then tap Open.

6. Click Add Menu, and then tap OK to confirm the insertion.

- Adding Engagement Manager Procedure Tiles to the Hub Page
- Editing the Check Header and Trailer
- Editing Bulk Menu Item Prices
- Adding an Employee From a Template
- Deactivating an Employee
- Adding Images to Menu Items
- Adding or Changing an Employee’s Profile Image

Related Topics
- Engagement Manager Procedures

Adding Images to Menu Items

1. Sign on to the POS client device, and then tap the Hub function.
2. Tap the tile configured for the Copy Menu Item manager function.
3. Select the menu item, and then tap Update Image.
4. Tap Browse Image, select the menu item image, and then tap Open.

- Adding Engagement Manager Procedure Tiles to the Hub Page
- Editing the Check Header and Trailer
- Editing Bulk Menu Item Prices
- Adding an Employee From a Template
- Deactivating an Employee
- Adding a New Menu Item Using an Existing Menu Item as a Template
- Adding or Changing an Employee’s Profile Image

Related Topics
- Engagement Manager Procedures

Adding or Changing an Employee’s Profile Image

1. Copy images to the POS client device using a flash drive or download the images through the Internet.
2. Sign on to the POS client device, and then tap the **Hub** function.

3. Tap the tile configured for the **Copy Employee** manager procedure.

4. Select an employee, and then tap **Preview**.

5. Tap **Change Picture**, and then tap **Browse Image**.

6. Browse to and select the employee’s image, and then tap **Open**.

   Image files cannot exceed 50 KB in size. The following image file type formats are supported:
   - .bmp
   - .jpeg
   - .png
   - .gif

7. Close the Employee Summary dialog.

- Adding Engagement Manager Procedure Tiles to the Hub Page
- Editing the Check Header and Trailer
- Editing Bulk Menu Item Prices
- Adding an Employee From a Template
- Deactivating an Employee
- Adding a New Menu Item Using an Existing Menu Item as a Template
- Adding Images to Menu Items

**Related Topics**
- Engagement Manager Procedures

---

**Creating Pages for Engagement Users**

You can create Engagement pages at the Enterprise level. These pages cannot be overridden at lower levels in the hierarchy.

1. From the dashboard, go to the Pages section, and then tap **View All**.

2. To add a new page from either the Welcome Pages or Hub Pages section, tap **Create New Page** in the appropriate section.

   You can define Welcome Pages for the following EMC modules:
   - Workstation
   - Workstation Class

   You can override the Welcome Page assignment at any level in the hierarchy below the Enterprise.

   The Manager Hub Page is based on the Employee Class of the users.

3. Type the name of the page in the text box, and then tap **OK**.

   - Modifying Pages for Engagement Users
   - Assigning Logos and Colors to Pages
Assigning Default Welcome and Hub Pages

Modifying Pages for Engagement Users

You can modify pages using the controls that appear when you select a page.

1. To make changes to a page, select the page, and then tap **Edit**.
2. To duplicate a page, select the page, and then tap **Clone**.
3. To remove a page, select the page, tap **Delete**, and then tap **OK** to confirm.

Assigning Logos and Colors to Pages

You can define a logo and color palette on Welcome pages. You can add only a logo to Hub pages because the color palette can be inherited from the Enterprise, property, or revenue center level based on the Theme Assignment module configuration.

Image files cannot exceed 1 MB in size. The following image file type formats are supported:

- .bmp
- .jpeg
- .png
- .gif

Copy logo images to the POS client device using a flash drive or download the images through the Internet.

1. Open the page, and then tap anywhere within the grid.
2. Select the color from the **Palette** drop-down list.
3. To add a company logo to the page:
   a. Tap **Open**.
   b. Browse to the logo image file and select it. The directory path appears in the **Logo** field.
4. Tap **Save**.

Assigning Default Welcome and Hub Pages

You can specify the default Welcome and Hub pages in the EMC.
1. Select the Enterprise, property, revenue center, or zone, click Configuration, and then click Page Assignment.

2. Click the Configuration tab, and then select the following pages from the drop-down lists:
   - Default Welcome Page
   - Default Hub Page

3. (Optional) To configure the Welcome Page conditions, click the Welcome tab.
   a. Select a Condition from the drop-down list.
   b. Select a Page to appear for the condition selected.
      The Page options appear in sequence, regardless of your selection in the Condition drop-down list.

4. (Optional) To configure the Hub Page conditions, click the Hub tab.
   a. Select a Condition from the drop-down list.
   b. Select a Page to appear for the condition selected.
      The Page options appear in sequence, regardless of your selection in the Condition drop-down list.

5. Click Save.

- Creating Pages for Engagement Users
- Modifying Pages for Engagement Users
- Assigning Logos and Colors to Pages

**Widgets**

Widgets are tiles that you create to show on Simphony Engagement Cloud Service POS client screens. Widgets allow workstation operators to perform optional tasks and procedures based on the assigned privilege level.

You can assign timing values to three widgets. Timing values affect the duration of time that widgets appear on an idle Engagement POS client device screen. You can assign custom timing values to the following widgets:

- URL Launcher
- Image Slideshow
- Today's Special

Engagement widget timing settings are overridden by Log Off User When Idle settings that are configured in the Simphony application, with the exception of the Web Configuration Console (WCC) widget. The WCC widget ignores the Simphony idle client timeout settings; the allowed idle time can be configured in MM:SS. The default timing value setting for the Engagement widgets is twenty seconds.

- The IP Camera Widget
- Viewing the Maximum Data Limit for Hosted Engagement Server

**Related Topics**
- Adding and Moving Widgets
The IP Camera Widget

The Engagement Internet Protocol (IP) Camera widget is used to display a camera feed on the user interface (UI) screen as a widget. It allows users to view live video from an IP camera configured using the Engagement Widget designer. The IP Camera widget uses the Motion-JPEG (MJPEG) video compression format. MJPEG is a video format in which each frame of video is sent as a separate and compressed JPEG image. The viewer displays the JPEG images as quickly as they are received and that creates the video.

The IP Camera widget is implemented using an image control to render the camera feeds received as images on the UI screen. A separate media player is not used. The IP Camera widget uses an open source library named MJPEG Decoder available in CodePlex.

The widget initializes the MJPEG decoder by passing an IP camera feed URL, which is configured using the Engagement widget designer. The widget receives the appropriate events whenever a new image is available and draws it on the container image control. The widget works with all resolutions supported by the IP Camera. The image is resized to fit within the widget's dimensions, while it preserves its native aspect ratio in the detail view, regardless of the resolution of the images received. The widget does not save or store images.

The MJPEG Decoder library initiates an asynchronous request to the MJPEG URL provided by the viewer. It then streams the multi-part response data received into separate images as they are received. The library passes each JPEG image to the viewer using an event whenever they are available.

The IP Camera widget supports all network and IP cameras capable of sending a direct MJPEG stream. This does not include cameras that are embedded within a web page. The camera must provide a direct stream of only the MJPEG for the IP Camera widget to successfully display the feed.

The IP Camera widget does not require additional security measures when displaying the IP Camera feed. Administrators should implement security restrictions on the network to explicitly allow workstations to connect to the camera feed. Additionally, the IP camera feed should be configured in a secure manner to ensure that the username and password are included in the URL, if possible.

Related Topics

- Adding and Moving Widgets
- Creating Tiles (Adding Widgets to a Page)
- Adding Command Buttons
- Configuring Widget Timing Values

The IP Camera Widget
Adding and Moving Widgets

1. From the Widget list, tap the widget to add.
2. To move the widget to a new grid location:
   a. Tap the widget. A move icon appears.
   b. Tap the move icon, and then tap the new grid location.

   Widgets move based on tapping the left corner (upper left corner on large widgets) and automatically resize when moved to a smaller section of the grid.

Creating Tiles (Adding Widgets to a Page)

1. From the dashboard, tap a page, and then add a widget.
2. (Optional) Enter the **Primary Text**, **Secondary Text**, or both to appear on the widget.

   The secondary text appears beneath the primary text in a smaller font.

3. Select the size for the tile:
   - **Small**: One tile (small square)
   - **Wide**: Two tiles (rectangle)
   - **Large**: Four tiles (square)
   - **Extra Large**: Nine tiles (large square) (Only Today’s Special widget supports this size)

4. (Optional) To add a background image to the tile:
   a. Tap **Open**.
   b. Tap **Upload images(s)**, browse to the location of the image file or type the image URL, and then tap **OK**.
   c. If images were previously uploaded, tap **View Album Contents**, and then select the image.
   d. Tap **Select** to save an existing image or **Crop** to modify the image, and then tap **Done**.

5. To add the URL Launcher widget:
Enter the URL for the website.

To show the keyboard icon on the tile’s top toolbar, tap **Show Keyboard**. This allows workstation operators to tap the keyboard icon to see the tablet keyboard on the tile.

To add an Image widget, tap **Open**.

When adding the Image widget, you configure both the tile image and the image that appears after the workstation operator selects the tile. If you do not add an image, the assigned tile image appears by default.

To add an IP Camera Feed widget, enter the web address (URL) of the IP camera’s video stream in the **Video URL** field.

Include the end query that defines the user and password of the camera (for example, `http://CAMERAIPADDRESS/videostream.cgi?user=USERNAME&pwd=PASSWORD&resolution=32&rate=0`).

To add a PDF Viewer widget, enter the directory path to access the PDF document in the **URL** field.

You must install a PDF reader application, such as Adobe Acrobat Reader, on the POS client device to use this widget.

To add a Twitter widget, add a hashtag or account in the **Query text** field (for example, `#oracle` or `@oracle`).

To add an InMotion Chart widget, select the **Report** and the data to appear by default from the **Chart** drop-down list.

To add a Slideshow Item widget:

a. Tap **Slideshow Item**, and then tap **Open**.

b. Enter the primary and secondary text that appears on the image during the slideshow.

c. To add images to the slideshow, tap **Add More**.

d. To remove an image from the slideshow, tap **Delete Item**.

To add a Today’s Special widget:

a. Enter the name of the tile in the **Header Text** field, and then select a **Template**.
  
  • Template1 shows each menu item individually during image rotation.
  
  • Template2 shows each menu item and a preview pane of other menu items during image rotation.

b. Tap **Menu Item** to add an image, enter the menu item name in the **Title** field, and then enter a **Description** of the menu item.
  
  • The Oracle MICROS Tablet E-Series 8-inch supports up to 823 characters, including spaces.
  
  • The Oracle MICROS Tablet E-Series 11-inch supports up to 627 characters, including spaces.

c. Enter the **Price** and additional text or pricing information in the **Extra** field.

d. To assign a time range to show specials for different meal periods:
  
  i. Tap **Add Group**, expand the **Group** panel, and then tap **Recurrence**.
ii. Enter a time range in 24-hour format during which the group of menu items appear, and then select either Daily or the days of the week when the group of menu items appear.

e. Add as many menu items and groups as needed, and then tap OK.

13. To add supported commands, assign one of the available commands to the tile. The Command widget does not support adding a tile image.

14. To add a Weather widget for weather updates:
   a. To use the default service provider, select wunderground from the Provider drop-down list.
   b. To use a different service provider, enter the API URL, and then enter the API Key to authorize running the weather application programming interface (API).
   c. Enter a city name or postal code in the Location/Zip Code field for specific forecasts, and then select the desired temperature scale from the Scale drop-down list.

15. To add an EMC widget, select the EMC task from the Command drop-down list.
   EMC widgets allow you to assign procedures, functions, and POS client commands to a tile. The EMC tasks are:
   - Clock In
   - Clock Out
   - Update Database
   - Close Application
   - Employee Training
   - Redirect Order Device
   - Edit Menu Item
   - Menu Item Availability
   - Minimize Application
   - Sign In RVC Prompt

16. Tap Save.

   - Adding and Moving Widgets
   - Adding Command Buttons
   - Configuring Widget Timing Values

Related Topics
   - Widgets
   - The IP Camera Widget
   - Viewing the Maximum Data Limit for Hosted Engagement Server
   - List of Widgets
Adding Command Buttons

You can add command buttons that provide additional ways to perform common POS functions such as clocking in or out, editing menu items, or updating the workstation database. These buttons remain hidden and appear only when a workstation operator swipes the upper or lower area of the tablet touchscreen.

1. From the dashboard, tap either the upper or lower directional arrow, depending on where you want to add the buttons.
   The upper or lower command bars work independently of each other.
2. Tap the plus sign (+) in the upper corner.
3. Enter Primary Text, select the Command to assign the button, and then tap Save.

Related Topics
• Adding and Moving Widgets
• Creating Tiles (Adding Widgets to a Page)
• Configuring Widget Timing Values

Configuring Widget Timing Values

The following widgets support timing values:
• EMC (WCC)
  – Edit Header/Trailer
  – Bulk Edit MI Prices
  – Copy Menu Item
  – Copy Employee
• Image Slideshow
• Today’s Special
• URL Launcher

1. Sign on to the POS client device, and then select a page from the dashboard.
2. Select the widget, and then tap Edit.
3. Enter a value in the Allowed Idle Time field.
4. Tap Save.
List of Widgets

You can add the following widgets to a Welcome or Home page. Welcome and Home pages do not support Hub page widgets.

Table 49-4  Welcome and Home Page Widgets

<table>
<thead>
<tr>
<th>Widgets for Welcome and Home Pages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL Launcher</td>
<td>The URL Launcher enables you to assign an image and a web address or URL to a tile. Tapping this tile takes you to the website.</td>
</tr>
<tr>
<td><img src="image" alt="URL Launcher" /></td>
<td></td>
</tr>
<tr>
<td>Image</td>
<td>The Image widget enables you to assign an image or picture to a tile. Tapping this tile increases the image size and shows more detail.</td>
</tr>
<tr>
<td><img src="image" alt="Image" /></td>
<td></td>
</tr>
<tr>
<td>IP Camera Feed</td>
<td>The IP Camera Feed enables you to directly assign an IP camera feed to a tile. Tapping this tile increases the camera feed screen size. You do not need to assign an image to the tile. You can connect a maximum of three cameras.</td>
</tr>
<tr>
<td><img src="image" alt="IP Camera Feed" /></td>
<td></td>
</tr>
<tr>
<td>Creating Tiles (Adding Widgets to a Page) contains more information about the IP Camera Feed widget.</td>
<td></td>
</tr>
<tr>
<td>PDF Viewer</td>
<td>The PDF Viewer widget enables you to assign a PDF to a tile. Tapping this tile opens the PDF document. Install a PDF reader application on the POS client device to use this widget.</td>
</tr>
<tr>
<td><img src="image" alt="PDF Viewer" /></td>
<td></td>
</tr>
</tbody>
</table>
## Table 49-4  (Cont.) Welcome and Home Page Widgets

<table>
<thead>
<tr>
<th>Widgets for Welcome and Home Pages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Twitter</td>
<td>The Twitter widget enables you to assign a Twitter feed to a tile. Tapping this tile increases the size of the Twitter feed view.</td>
</tr>
<tr>
<td><img src="image" alt="Twitter" /></td>
<td></td>
</tr>
<tr>
<td>Image Slideshow</td>
<td>The Image Slideshow widget enables you to assign multiple images that rotate for viewing at five-second intervals.</td>
</tr>
<tr>
<td><img src="image" alt="Image Slideshow" /></td>
<td></td>
</tr>
<tr>
<td>Today's Special</td>
<td>The Today's Special widget enables you to assign one or more menu items, graphics, descriptions, and prices to a tile. When more than one menu item is configured, the items rotate for viewing at five-second intervals. You can assign a time range to this widget so that different specials cycle based on the times they are being served.</td>
</tr>
<tr>
<td><img src="image" alt="Today's Special" /></td>
<td></td>
</tr>
</tbody>
</table>
| Command Widget                     | The Command widget enables you to assign procedures, functions, and POS client commands to a tile. The available commands are:  
  - Clock In  
  - Clock Out  
  - Update Database  
  - Close Application  
  - Employee Training  
  - Redirect Order Device  
  - Edit Menu Item  
  - Menu Item Availability  
  - Minimize Application  
  - Sign In RVC Prompt |
| ![Command Widget](image)          |             |
| Weather                            | The Weather widget enables you to assign a weather forecast provider and location to a tile. Purchase an application program interface (API) key to use this widget. |
| ![Weather](image)                 |             |

You can add the following widgets to a Hub page.
### Table 49-5  Hub Page Widgets

<table>
<thead>
<tr>
<th>Widgets for Hub Pages</th>
<th>Description</th>
</tr>
</thead>
</table>
| ECM Alert             | The ECM alert widget enables you to view ECM alerts based on cash pull thresholds for till and server bank receptacles. This widget is supported for multiple cash management classes. The ECM alert widget shows:  
  - Receptacle name  
  - Alert type  
  - Alert level (if applicable)  
  - Variance (threshold value – actual receptacle session amount)  
  The ECM alert widget also indicates when there are no active alerts. |
| ECM Summary           | The ECM summary widget enables you to view summary information for active ECM receptacles. This widget is supported for multiple cash management classes. The ECM summary widget shows:  
  - Receptacle name  
  - Number of open receptacle sessions for each receptacle type  
  - Current total in base class amount  
  The ECM summary widget also indicates:  
  - Active alerts for a session  
  - Offline open receptacle sessions  
  - Multiple classes |
| inMotion Charts       | The inMotion Charts widget enables you to assign Oracle Hospitality Enterprise Back Office reports to a tile. When you select this tile, the assigned report generates first, but all other reports are also accessible. Select each report to view more information.  
  The following reports are available:  
  - Sales  
  - Labor Cost  
  - Discount  
  - Sales Per Labor Hour  
  - Check Count  
  - Guest Count  
  - Average Ticket Time |
| inMotion Stores       | The inMotion Stores widget enables you to view cumulative sales report information from all available outlets, or you can select an individual store from a list that appears when selecting this tile. |
Table 49-5  (Cont.) Hub Page Widgets

<table>
<thead>
<tr>
<th>Widgets for Hub Pages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labor Cost</td>
<td>The Labor Cost widget enables you to view potential employee overtime labor costs. When you select this tile, alerts inform the supervisor about employees approaching overtime for a particular pay cycle.</td>
</tr>
</tbody>
</table>
| WCC (Web Configuration Console)             | The WCC widget enables you to assign one of the following available manager procedures to a tile:  
  • Edit Header/Trailer  
  • Bulk Edit MI Prices  
  • Copy Menu Item |

Related Topics

• Widgets  
• The IP Camera Widget  
• Viewing the Maximum Data Limit for Hosted Engagement Server  
• Adding and Moving Widgets  
• Creating Tiles (Adding Widgets to a Page)  
• Adding Command Buttons  
• Configuring Widget Timing Values

Viewing the Maximum Data Limit for Hosted Engagement Server

You can view the maximum allowable amount and remaining space for uploading widget images to your hosted Engagement server. When adding images for widgets, the data limit (2 GB total) appears on the image upload screen, along with the remaining amount of available space for adding more image content.

• Widgets  
• The IP Camera Widget

Related Topics

• Adding and Moving Widgets  
• Creating Tiles (Adding Widgets to a Page)  
• Adding Command Buttons  
• Configuring Widget Timing Values  
• List of Widgets
A POS Client .NET Extension Application is a .NET class library that adds new operations or event handlers to the Simphony POS client.

An Extension Application adds new operations by defining extension methods that are invoked using buttons created in the Page Designer module. Existing operations are extended by implementing event handlers for POS client events. Extension methods and event handlers are able to interact with the POS client using the Extension Application API.

The POS Client Extension Application API is the set of data types used by the Extension Application to interact with the POS client; this interaction includes the ability to add items to a guest check, prompt the user for information, invoke existing operations, evaluate configuration elements (such as employee options), and more.

- Configuring Extension Application Privileges
- Enabling Extension Applications

### Configuring Extension Application Privileges

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.
2. Select the role type (for example, administrator), and then click the **EMC Modules** tab.
3. In the Touchscreens section, select the appropriate **Extension Application Posting** permissions for the user role. You can grant permissions for the following actions:
   - **View**: Open and view the Extension Application module. If you allow a user to Edit, you must also grant View access (otherwise the user cannot open the module).
   - **Edit**: Update fields or records within the module.
4. Click **Save**.

### Enabling Extension Applications

1. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Extension Application**.
2. Highlight the record for the extension application.
3. Click the ellipsis point (…) button in the **Options** column.
4. To enable the extension application, ensure that **1 - Disable Application** is deselected. To disable the extension application, select **1 - Disable Application**.
5. To configure the extension application to post check data to the Reporting and Analytics database without manual intervention, select **5 - Post extension application data to Reporting and Analytics**.
6. Click **OK** to close the Extension Application Options dialog.

7. Enter information in the following columns:

   - **Type**: The value in this field indicates how extensibility information appears in Reporting and Analytics.
     - Enter 0 if extensibility information is needed only at the POS. Extensibility information does not appear in Reporting and Analytics reports.
     - Enter 1 to have extensibility information appear in the standard Check Detail Report in Reporting and Analytics.
     - Enter 2 to hide the extensibility information in the standard Check Detail Report, but show it in the Check Detail with Extension Data report in Reporting and Analytics.

     If you selected option 5 in Step 5, you must enter 2 as the **Type**. Checks for extension applications with **Type 2** will appear in Reporting and Analytics reports.

   - **Data Level**: The default value is 2.
     - Enter 0 to post nothing (no check header nor detail information) to the Reporting and Analytics database.
     - Enter 1 to post only the check header information to the Reporting and Analytics database.
     - Enter 2 to post both the check header and detail information to the Reporting and Analytics database.

   - **Max Chars**: Enter the maximum characters to appear (from 1 to 2000) for each extension item. The default value is 200.

     If the data entered through the POS client exceeds the maximum character limit, the data will be truncated and posted to the Reporting and Analytics database; the Direct Posting Service (DPS) log will indicate the exceeded character limit for each entry with a line item message stating Truncating extensibility detail - no data.

   - **Max Items**: Enter the maximum extension items to appear (from 1 to 100). The default value is 1.

     If the data entered through the POS client exceeds the maximum item limit, the data will be skipped and a message posted to the Reporting and Analytics database; the Direct Posting Service (DPS) log will indicate the exceeded item limit for each entry with a line item message stating Skipping extensibility detail - max detail reached.

8. Click **Save**.
Transaction Services

Transaction Services is a web service that allows Simphony to interface with third-party applications (for example, hotel self-service kiosks or room service devices, menu boards, and Enterprise online ordering). Transaction Services is commonly installed in stadiums that use self-ordering devices. Guests can place orders using a third-party application that interfaces with a Transaction Services client. The client then sends the guest checks to Simphony.

• Configuring the Transaction Services Workstation Client
• Configuring the Transaction Services Default Employee
• Order Information Service
• Activating the Extension Application for Order Information Service
• Configuring Touchscreen Order Information Service Buttons
• Order Information Service Functions and Extensibility Arguments

Configuring the Transaction Services Workstation Client

You can configure Transaction Services to run on the same hardware device as a Simphony client. Kiosks are usually configured as Transaction Services clients. Obtain the following information before you begin the configuration:

• Transaction Services workstation name
• Number of revenue centers using Transaction Services

1. Select the property, click Setup, and then click Workstations.
2. Insert a record, enter the workstation name, and then click OK.
3. Double-click the workstation record.
4. From the Type drop-down list, select 3 - POSAPI Client.
5. Select the Service Host ID where the workstation runs.
   To host Transaction Services on a separate workstation, select the default Service Host ID.
6. In the Address / Host Name field, enter the machine where Transaction Services is installed.
7. Enter the Subnet Mask and the Default Gateway of the workstation to configure.
8. Click the Service Host tab.
9. To host Transaction Services and the POS client on a single workstation, select the corresponding Service Host name from the Service Host drop-down list.
10. Click the Transactions tab.
11. Enter the Minimum Check Number and the Maximum Check Number to use.
12. From the **Default Order Type** drop-down list, select the order type that the Transaction Services client uses.

13. Ensure that the **Cash Drawer Settings** show 0 (zero).

14. Click the **Order Devices** tab.

15. Select all order devices that use the Transaction Services client for the revenue center shown in the list. If multiple revenue centers use Transaction Services, select the appropriate order devices for each revenue center.

16. Click the **Printers** tab.

17. For each printer, click the **Select** link, and then select the printer to use for each print job.

18. Click the **Revenue Centers** tab.

19. Select the revenue centers in which this instance of Transaction Services operates.

20. Click the **Devices** tab, and then ensure that no peripheral devices appear.

21. Click **Save**.

22. Repeat Steps 1 through 21 for each Transaction Services workstation client.

---

### Configuring the Transaction Services Default Employee

Transactions that are created and altered by the Transaction Services client must be associated with a default transaction employee in Simphony. You need to create an employee record that is not associated with a member of the staff, and is solely used for the Transaction Services client to post records to Simphony.

1. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Employee Maintenance**.

2. Click the **Insert Record** button to add an employee.

3. From the Add Employee dialog box, select **Add Employee From Template**.

4. If you created employees previously, click **Employee to Copy**, and then select an existing employee to copy.

5. Enter the first name and the last name of the employee.

6. Assign the employee with an operator record in the revenue center in which Transaction Services operates. Take note of the employee record number.

7. Select the **Property** and the **Revenue Center**, and then click **OK**.

8. Click **Save**.

9. Go to the POS client workstation, and run the CAL, selecting the workstation you configured through Configuring the Transaction Services Workstation Client.

10. After the CAL installation is complete, navigate to the EGatewayService directory from the workstation, open the web.config file, and then verify that the file contains the correct Api_WorkstationID value.

---

• **Configuring the Transaction Services Workstation Client**
Order Information Service

The Order Information Service allows third-party solutions to offer mobile ordering for delivery and pickup (for example, in seat ordering at a stadium) with status updates to the guest. The Order Information Service includes the latest view of the order content, such as order ID, items purchased, payment, employee delivering the order, and so on.

Third-party integrators can obtain order detail and status from Simphony in environments where orders enter the Simphony system through the Transaction Services application program interface (API). Third-party applications can query check status (for example, open, assigned, or closed), and the Order Information Service returns all checks that meet the request criteria. The Oracle Hospitality Simphony Transaction Services API Document contains information for software engineers developing applications that interface with Simphony using Transaction Services.

Related Topics

• Activating the Extension Application for Order Information Service
• Configuring Touchscreen Order Information Service Buttons
• Order Information Service Functions and Extensibility Arguments

Activating the Extension Application for Order Information Service

You need to enable the Order Information Service as an extensibility application. No interface is needed.

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Extension Application.
2. Highlight the record for the Order Information Service Client, click the ellipsis point (...) button in the Options column, and then verify that 1 - Disable Application is deselected.
3. Ensure that the Interface column value shows 0 - None.
4. Click Save.

• Configuring Touchscreen Order Information Service Buttons

Related Topics

• Order Information Service
• Order Information Service Functions and Extensibility Arguments

Configuring Touchscreen Order Information Service Buttons

You can create buttons on a page for the Order Information Service functions. You can create multiple buttons with slightly different functions (for example, Delivered All, Delivered Nothing, Delivered Without Alcohol, Delivered Without Food, Delivered Without Retail, and so on).
1. Select the Enterprise, property, or revenue center, click **Configuration** and **Page Design**.

2. Open the page on which to place Order Information Service buttons.

3. From the Edit tab, select the page area in which to define the Order Information Service functions.

4. Click **Button**.

5. From the General subtab, in the **Legend** field, enter the button name (for example, **Assign Multiple Checks**).

6. Select **Function** from the **Type** drop-down list.

7. Click the arrow beneath the **Type** drop-down list.

8. Select **Run Extensibility App**, and then click **OK**.

9. Click the arrow next to the **Arguments** field. The Edit Extensibility Arguments dialog appears.

10. Enter the appropriate extensibility arguments:

    a. Select **dll** from the **Type** drop-down.

    b. In the **apppname** field, enter the name of the extension application you created for the Order Information Service (for example, **OISClient**).

    c. In the **filename** field, enter **OISClient.dll**.

    d. In the **function** field, enter one of the following:

       - **Assign**
       - **Close**
       - **CloseAllChecks**

    e. Enter the argument value in the **arg** field, and then click **OK**.

    *Order Information Service Functions and Extensibility Arguments* contains detailed information about the Assign, Close, and CloseAllChecks functions and the arguments required for each function.

11. Position and size the button on the page. Use the Style arrow to change the color.

12. Click **Save**.

13. Repeat Steps 4 through 12 to create each button. The following table lists the recommended Order Information Service buttons.

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign Check</td>
<td>Assign</td>
<td>Assign a single check to a delivery agent.</td>
</tr>
<tr>
<td>Assign Multiple Checks</td>
<td>Assign</td>
<td>Assign more than one check to a delivery agent.</td>
</tr>
<tr>
<td>Delivered</td>
<td>Close</td>
<td>Close a check after all items are delivered successfully.</td>
</tr>
<tr>
<td>Delivery Failed</td>
<td>Close</td>
<td>Close a check, voiding all items and returning them to inventory. Use this button when the delivery agent cannot find the guest to deliver the prepared items.</td>
</tr>
</tbody>
</table>
Table 51-1  (Cont.) Order Information Service Buttons and Functions

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivered Without Alcohol</td>
<td>Close</td>
<td>Close a check, voiding the alcohol items and returning them to inventory.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>Close</td>
<td>Void all items and close the check to a zero dollar amount. Use this button when the order is canceled prior to being prepared and delivered.</td>
</tr>
<tr>
<td>Close All Open Checks</td>
<td>CloseAllChecks</td>
<td>Void all items on every open check and close the checks to a zero dollar amount.</td>
</tr>
<tr>
<td>Close All Open Checks by Order Type</td>
<td>CloseAllChecks</td>
<td>Void all items on every open check created for a specific Order Type and close the checks to a zero dollar amount.</td>
</tr>
<tr>
<td>Close All Open Checks by Employee</td>
<td>CloseAllChecks</td>
<td>Void all items on every open check created by a specific employee and close the checks to a zero dollar amount.</td>
</tr>
</tbody>
</table>

• Activating the Extension Application for Order Information Service

Related Topics

• Order Information Service
• Order Information Service Functions and Extensibility Arguments

Order Information Service Functions and Extensibility Arguments

The Order Information Service supports three functions:

• Assign
• Close
• CloseAllChecks

Each function must contain a set of arguments. The following tables describe the extensibility arguments that you must include for each function. Each argument is required unless otherwise indicated.

Table 51-2  Assign Function Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID=</td>
<td>Enter anything here (for example, Assigned, AssignedToRunner, TransferredToRunner). This text is visible when Transaction Services queries the check.</td>
<td>ID=Assigned</td>
</tr>
</tbody>
</table>
### Table 51-2  (Cont.) Assign Function Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Optional) MultipleChecks=</td>
<td>To include this argument, set the value to <strong>true</strong>, and the function refers to Assign Multiple Checks. To exclude this argument, set the value to <strong>false</strong>, and the function refers to Assign Single Check.</td>
<td>MultipleChecks=true</td>
</tr>
<tr>
<td>ServiceTotalNumber=</td>
<td>Enter the object number of the Tender/Media record used when performing the operation (such as the tender used for Service Total).</td>
<td>ServiceTotalNumber=51</td>
</tr>
</tbody>
</table>

An example of the **arg** value for the Assign function is

ID=Assigned,MultipleChecks=true,ServiceTotalNumber=51

### Table 51-3  Close Function Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason=</td>
<td>Enter anything here. This text is visible when Transaction Services queries the check.</td>
<td>Reason=Delivered</td>
</tr>
<tr>
<td>PaymentNumber=</td>
<td>Enter the object number of the Tender/Media record used when performing the operation.</td>
<td>PaymentNumber=3</td>
</tr>
<tr>
<td>(Optional) VoidParams=</td>
<td>Use this argument to indicate which items to remove from the check before closing it. For example, to delete all items in family groups 1, 2 and 5, set the value to <strong>FG:1:2:5</strong>. <strong>FG</strong> indicates Family Group. (This is the only recognized value type.) Use **FG=*/ to void all items. If you exclude this argument, the function does not allow voids.</td>
<td>VoidParams=FG:10:11:15:16:30:31:32</td>
</tr>
<tr>
<td>(Optional) OrderTypeFilter=</td>
<td>Use this filter to close checks for the tender set in the payment argument and by a specific order type. If you exclude this argument, the function includes all order types that can use the payment tender.</td>
<td>OrderTypeFilter=2</td>
</tr>
</tbody>
</table>
An example of the arg value for the Close function is
Reason=Delivered, PaymentNumber=3, VoidParams=FG: 10:11:15:16:30:31:32, OrderTypeFilter=2

Table 51-4  CloseAllChecks Function Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason=</td>
<td>Enter anything here. This text is visible when Transaction Services queries the check.</td>
<td>Reason=Delivered</td>
</tr>
<tr>
<td>PaymentNumber=</td>
<td>Enter the object number of the Tender/Media record used when performing the operation.</td>
<td>PaymentNumber=3</td>
</tr>
<tr>
<td>(Optional) OrderTypeFilter=</td>
<td>Use this filter to close checks for the tender set in the payment argument and by a specific order type. If you exclude this argument, the function includes all order types that can use the payment tender.</td>
<td>OrderTypeFilter=2</td>
</tr>
<tr>
<td>(Optional) EmployeeFilter=</td>
<td>Use this filter to close checks for the tender set in the payment argument and by a specific employee. For example, a Transaction Services user creates the checks, so including this employee in the argument closes only the Transaction Services checks. If you exclude this argument, the function closes all employees’ checks.</td>
<td>EmployeeFilter=2</td>
</tr>
</tbody>
</table>

An example of the arg value for the CloseAllChecks function is
Reason=Delivered, PaymentNumber=3, EmployeeFilter=2

Related Topics

- Order Information Service
- Activating the Extension Application for Order Information Service
- Configuring Touchscreen Order Information Service Buttons
Cruise Ship Time Zone and Business Day Settings

A cruise ship is a constantly moving property. As a ship moves around the world, the time zone settings for the shipboard systems need to change daily to align with the time zone in which the ship is sailing.

There are two methods of changing the time zone:

- A ship’s master clock communicates the current time zone settings. When someone changes the master clock’s time zone, all shipboard systems (for example, property management system (PMS) and Simphony) automatically update their settings to ensure consistent date and time stamp posting across all applications.
- A system administrator manually sets the ship’s time zone within the PMS and Simphony.

Oracle recommends that you perform the following tasks:

- Close all checks before changing the time zone.
- Change the time zone once per day during a slow period of operations (for example, between 2:00 a.m. and 5:00 a.m.).
- Changing the Time Zone
  - Start of Business Day
  - Configuring Start of Day
  - Workstation Control Privileges
  - Configuring Workstation Control Privileges

Changing the Time Zone

1. Close all checks in the workstations.
2. From the EMC, select the Enterprise level, click Setup, and then click Properties.
3. Select the new time zone for the ship from the Time Zone drop-down list.
4. Click Save. The CAL client deploys the new time zone to the property and automatically updates the time zones of the workstations connected to the property.

   Time zones do not update on workstation tablet devices running generic Android operating systems when the property time zone changes. You must manually update the time zone on these devices.
Start of Business Day

In food service and hotel environments, a business day refers to the beginning and end times of a day of business. A business day can have any begin time, but typically a business day starts in the early morning hours during a slow or closed period of operations (for example, 3:00 a.m. or 4:00 a.m.). In contrast, a calendar day always begins at 12:00 a.m.

In a cruise ship environment the PMS controls the business date. Simphony posts cabin charges in the PMS. Simphony and the PMS must be in sync to communicate and balance these transactions. When initializing the Start of Day (SOD) on a ship, change the PMS date before changing the Simphony date.

On cruise ships, Simphony allows a manual SOD to run twice in one calendar day. For example, the cabins empty at approximately the same time on a cruise ship, and the financial information resets. The ship's PMS and Simphony are closed out after the last guest leaves the ship, which is typically between 12:00 p.m. and 1:00 p.m. The SOD changes in the PMS and in Simphony at that time, and the next cruise begins. Both the PMS and Simphony change the SOD again at about 3:00 a.m. the following day when the cruise is under way.

Related Topics
- Configuring Start of Day

Configuring Start of Day

A system administrator on a ship must take the workstations offline and then manually set the daily start and end times.

1. Select the Enterprise level, click Configuration, and then click Roles.
2. Select the appropriate role type (such as manager), click the Operations tab, and then click the PMC Procedures subtab.
3. Select the appropriate privileges as described in the following table:

<table>
<thead>
<tr>
<th>Privilege Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>30058 - Run Start of Day from OPS</td>
<td>Select this option to allow all employees with the role to increment the business date from the property's Check and Posting Service (CAPS) workstation.</td>
</tr>
<tr>
<td>30059 - Prevent Running SOD from OPS with Open Checks</td>
<td>Select this option so that Start of Day cannot run when open checks exist.</td>
</tr>
</tbody>
</table>

4. Click Save.
5. Select the Enterprise, property, or revenue center, click Configuration, and then click Page Design.
6. Select the page on which to place the Start of Day button.
7. Add a Start of Day button:
   a. In the Legend field, enter Run Start of Day.
b. From the **Type** drop-down list, select **Function**.

c. Click the arrow beneath the **Type** drop-down list, and then select **Start of Day**.

d. Position and size the new button on the page.

8. Click **Save**.

9. Select the property, click **Setup**, and then click **Property Parameters**.

10. Click the **Options** tab, and the select **48 - Run Start of Day from OPS**.

11. Click the **Calendar** tab, and then select **Run Manually** for each day of the week.

12. In the **Manual SOD Safety catch time** field, set the time when the application automatically increments the business date if someone forgets to manually run SOD.

   The application checks to see whether SOD occurred within a 24-hour period for the selected property. This time is based on the time zone of the property.

13. Click **Save**.

14. Select the Enterprise level, click **Configuration**, and then click **PC Autosequences**.

15. Insert a PC Autosequence record, name it **Increment Business Day**, and then click **OK**.

16. Open the record and select the **Allowed Properties** to view the autosequence.

17. (Optional) From the Parameters section, click the **Add** link to add parameters. For example, you can enter a property number and exclude a revenue center number.

   a. From the Select Autosequence Parameter dialog, select the **Parameter** from the drop-down list.

   b. Enter a **Value**, and then click **OK**.

18. Click the **Steps** tab.

19. Click the **Add** link to add a step.

20. From the **Step Type** drop-down list, select **3 - Increment Business Date**.

21. Click **Save**.

**Related Topics**

- **Start of Business Day**

---

**Workstation Control Privileges**

You can configure the control of workstation operations during critical events, such as:

- Running Start of Day
- Locking and unlocking workstations
- Locking and unlocking revenue centers
- Updating workstations
- Reloading workstations

You can set the workstation control privileges for each employee role type (for example, manager, server, and host).
Configuring Workstation Control Privileges

To set the control of workstation operations during critical events:

1. Select the Enterprise level, click **Configuration**, and then click **Roles**.

2. Select the role type (such as manager), click the **Operations** tab, and then click the **Miscellaneous** subtab.

3. Select the appropriate privileges:
   - **10019 - Unlock UWS or Revenue Center**: Select this option to allow employees in the role to unlock a workstation or revenue center from the locked dialog.
   - **10020 - Use Workstation Control**: Select this option to allow employees in the role to use the Workstation Control key to access various workstation functions (for example, locking and unlocking workstations and revenue centers, and updating the database). Selecting this option also allows employees to unlock a workstation or revenue center from the locked dialog.

4. Click **Save**.

5. Select the Enterprise, property, or revenue center, click **Configuration**, and then click **Page Design**.

6. Select the page on which to place the Workstation Control button.

7. Add a Workstation Control button:
   a. In the **Legend** field, enter **Workstation Control**.
   b. From the **Type** drop-down list, select **Function**.
   c. Click the arrow beneath the **Type** drop-down list, and then select **Workstation Control**.
   d. Position and size the new button on the page.

8. Click **Save**.

Related Topics

• Workstation Control Privileges
Interfaces with Simphony

Simphony includes the ability to interface with third-party software, such as Property Management Systems (PMS).

- Configuring the OPERA PMS Enhanced Interface
- Inserting the Extension Application Files for OPERA
- Configuring OPERA Content Information
- Content Text Settings for the OPERA PMS
- Configuring the OPERA PMS Interface
- Enabling the OPERA PMS Interface for a Revenue Center
- Adding the Tender/Media Data Extension for OPERA
- Configuring the Tender Media for OPERA
- Configuring the Room Charge Buttons for the OPERA PMS
- Updating the SIM OPERA Interface to a Newer Version

Configuring the OPERA PMS Enhanced Interface

Follow these steps to configure and install the SIM OPERA Interface.

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Extension Application.
2. Click the Insert icon to add a record (using a record number of your choice).
3. Enter a record name in the Name field (for example, OPERA), and then click OK.
4. Double-click the record to open it in form view.
5. Click the Insert Application Content button. You must insert four application content records.
6. Enter the text reflecting the file names within the ZoneableKey and Description fields, and then click OK.
7. Select **19 - SimScript** as the **Content Type**, and then click the **Import from a file** link.

8. Select the SIM file **MF_ENH.isl (*.isl)**, and then click **Open**.

9. Set the target to **WIN32**.

10. Insert new application content for the second SIM file named **MF_ENH_Android.isl**.
    a. In the **Content Type** drop-down list, select **19 - Sim Script**.
    b. Enter **MF_ENH_ANDROID** in the **ZoneableKey** and **Description** fields, and then click **OK**.
    c. Set the target to the **Android** platforms.

11. Insert a new application content for the DLL file named **McrsExtDialogsML.dll**.
    a. In the **Content Type** drop-down list, select **3 - DLL**.
    b. Enter **McrsExtDialogsML** in the **ZoneableKey** and **Description** fields, and then click **OK**.

12. Insert new application content for the Android form file named **android.htm**.
    a. In the **Content Type** drop-down list, select **23 - Text**.
b. Enter html in the ZoneableKey and Description fields, and then click OK.

13. For the SIM file records MF_ENH.isl and MF_ENH_ANDROID.isl, click the ellipsis (…) button under the Options Bits column, select 2 - Main SIM Content, and then click OK.

14. For each file, enter the entire file name under the Disk File Name column, and then click Save.
   • Disk File Name entries must exactly match the name of their associated SIM scripts and DLL file names. These entries are case-sensitive.
   • The ZoneableKey entry for the Android.htm file must match html, and it is case-sensitive.
   • The Version column is not required.

Figure 53-4  Extension Application Content Record Details

15. Set the related target for each file:
   • MF_ENH.isl target: WIN32
   • MF_ENH_ANDROID.isl target: Android
   • McrsExtDialogsML.dll target: WIN32
   • Android.htm target: Android

For multi-tenant environments using releases earlier than Simphony release 2.9, you are required to configure the content information (outlined in the following section under Content Information) as Extension Application content, as the content feature cannot be used in these environments.

• Create new Application Content for the enhanced interface, selecting the Insert Application Content button. The ZoneableKey and Description fields must be set to EnhIFC_Config. These entries are case-sensitive.

• Select the Content Type 23 - Text, and insert the content information as outlined in the following section under Content Information. Apply the configuration settings as required.

Content Information

Select the Enterprise, property, revenue center, or zone, click Setup, and then click Content. Insert a record for the Property Management System (PMS) configuration. The name of the new entry must be EnhIFC_Config (which is case-sensitive), and enter STRING. Enter the strings as shown in the following figure (the content text file is delivered with the other files), and change the options as needed.
Posting Related Configuration Settings

Table 53-1  Posting Related Configurations

<table>
<thead>
<tr>
<th>Configuration String</th>
<th>Configuration Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAGCARDONLY</td>
<td>Set to 1 (one) if you want to limit the entries in the Room-Charge event to magnetic cards, or set to 0 (zero) to allow both magnetic cards and keyboard as input.</td>
</tr>
<tr>
<td>MAGCARDOVRWRT</td>
<td>When MAGCARDONLY is enabled, the setting can be overwritten for certain RVC’s by entering a list of RVC numbers (separated by a comma).</td>
</tr>
<tr>
<td>SUPPRESSGSTMSG</td>
<td>When set to 1 (one), this suppresses the message indicator during the posting. For high-volume sites this should be enabled.</td>
</tr>
<tr>
<td>SUPPRESSNFOREF</td>
<td>For Non-Room-Charge tenders, this shows the Department Code they were posted to. When set to 1 (one), this suppresses this reference.</td>
</tr>
</tbody>
</table>
Table 53-1  (Cont.) Posting Related Configurations

<table>
<thead>
<tr>
<th>Configuration String</th>
<th>Configuration Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>REVERSEGST</td>
<td>Set to 1 (one) if the guest count should be negative in case the payment is negative (i.e., the payment is voided). Note that this feature requires specific setup on the Front-Office interface to work correctly.</td>
</tr>
<tr>
<td>FULL_DSVC</td>
<td>If set to 1 (one), a full breakdown of discounts are sent. This requires a specific version of the Front-Office interface. An additional full breakdown of service charges requires this to be set to 2 (two), this setting also includes a full breakdown of discounts.</td>
</tr>
<tr>
<td>NO_CONFIRM_GST</td>
<td>Set to 1 (one) if the guest name should not be confirmed when posting. Unless magnetic cards are used to identify the guest, this option should be disabled and set to 0 (zero).</td>
</tr>
<tr>
<td>POST_64TAXES</td>
<td>If set to 1 (one), up to 63 Tax Itemizers are sent to the Front-Office interface. Note that this requires IFC8 V.8.7.1.2 or higher, as well as a certain version of the Front-Office itself. If set to 0 (zero), only 8 (eight) Tax Itemizers are sent to the Front-Office interface.</td>
</tr>
</tbody>
</table>
| POSTING_ADD_INFO     | This setting determines which information value is to be used for any posting. Currently, the following values are supported:  
|                      | • 0 = Serving Period Number (Default)  
|                      | • 1 = Transaction Cashier  
|                      | • 2 = Order-Type Number  
|                      | • 3 = Custom value for Philippines ONLY |
| SendAllDtls          | When set to 0 (zero), only check details of Room-Charges are sent to the Front-Office interface. If set to 1 (one), the check details of non-Room-Charges are also sent. |
### Table 53-1  (Cont.) Posting Related Configurations

<table>
<thead>
<tr>
<th>Configuration String</th>
<th>Configuration Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESTRICTED_POSTING</td>
<td>Select if you want to restrict responses returned from the Front-Office Interface in the Room-Charge event. Note that this only works in combination with, and if the RESTR_POSTING_EMPL option is configured correctly. Currently there are two supported values :</td>
</tr>
<tr>
<td></td>
<td>• Setting this to 1 (one): Both the Room# and at least 3 (three) characters of the Surname (last-name field) need to be provided in order to post the Room-charge. If less than 3 characters are provided, an error is shown. If the response from the PMS contains more than one record, an error is shown and the operator needs to enter additional characters to provide a unique identifier.</td>
</tr>
<tr>
<td></td>
<td>• Setting this to 3 (three): This assumes that an external device provides the input as keyboard data. There is no touchscreen keyboard shown when this option is used, so the operator (or guest) only has the option to abort the input. If the response from the PMS contains more than one record, an error is shown and the posting is aborted. There is no confirmation of the guest-name shown, irrelevant of the setting in NOCONFIRM_GST. Note that this does not work if input is restricted to magnetic cards, so either the restriction must be disabled, or the RVC in question must be added to the excluded RVC’s.</td>
</tr>
<tr>
<td>RESTR_POSTING_EMPL</td>
<td>Specify the ISL Option that should be used with the above option (see EMC, Employee Maintenance, Employee Class, ISL Options). As such, the valid value for this configuration is between 1 (one) and 8 (eight).</td>
</tr>
</tbody>
</table>

### Guest-Locator and Guest-Message Related Configurations

### Table 53-2  Guest-Locator and Guest-Message Configurations

<table>
<thead>
<tr>
<th>Configuration String</th>
<th>Configuration Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RVCNAMELOC</td>
<td>If set to 1 (one), the first line of the locator contains the RVC name, otherwise it is blank. The operator can overwrite this value when entering the locator information.</td>
</tr>
<tr>
<td>LOCVALIDMIN</td>
<td>Each new locator is only valid for a certain amount of time. Enter the default time in minutes here. The server can overwrite this value when entering the locator information.</td>
</tr>
</tbody>
</table>
The Content can be overridden by property, zone, or revenue center. If overridden, ensure that you select the **Use Existing Record** option.

**Figure 53-6  Override Record Controls**

<table>
<thead>
<tr>
<th>Undo/Reload</th>
<th>Override Record</th>
<th>Use Existing Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Add</td>
<td>Create Blank Record</td>
<td></td>
</tr>
</tbody>
</table>

**Configuring Interfaces**

Select the Enterprise, click **Setup**, click **Interfaces**, and then insert a record for the OPERA PMS interface.

**Figure 53-7  Interface Module**

The following is an example. Use a System Name that reflects the property using the interface.

To avoid double posting, the PING Frequency setting must be 0 (zero), and is required to create an interface for each property. Click the **Options** tab and enable the desired options. Enter the Opera PMS application server’s connection information within the **TCP Communications** section and **Save** all changes.
Only options 1, 2, 3, and 5 must be enabled. Do NOT enable option 8, as that causes double posting.

Click the Properties tab and enable the Opera PMS interface for each desired property and Save all changes.

Click the Service Host tab and select the desired Service Host for the Opera PMS interface. Click OK and Save all changes.

Extension Application Interface Configuration

Select the Enterprise, click Setup, and then click Extension Application. Select the PMS interface in the Interface column to associate it with the Opera Extension Application record, and Save.

This configuration typically occurs at the property level (when the PMS Interface is on-premise).
Revenue Center Configuration

Select the revenue center, click Setup, click RVC Parameters, and then click the Interfaces tab. Select the PMS interface to enable the interface for the revenue centers. Perform this step for every desired revenue center (using the same PMS link for each revenue center) and Save all changes throughout the process.

Data Extensions – Add the Tender Media Extra Column

Click the Configuration tab, and then click the Data Extensions module. Select the Insert icon and add a record.

Enter the following information:

- **Table**: 71 - Tender Media
- **Extra Column name**: RoomCharge
- **Type**: 4 - Boolean
• Data Constraints: N/A
• Sort Priority: N/A
• Display Width: 150
• Translatable Name: Enh.IFC – Room Charge (translatable)
• Translatable Help: Enable this for Room-Charge Payments (translatable)

Figure 53-12  Data Extensions Module

- Enable all three access check-boxes.

Figure 53-13  Data Extensions Translatable Settings

<table>
<thead>
<tr>
<th>Sort Priority</th>
<th>Display Width</th>
<th>Translatable Name</th>
<th>Translatable Help</th>
<th>Is Editable</th>
<th>Is Viewable</th>
<th>Is Downloadable</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>150</td>
<td>Enh.IFC – Room Charge</td>
<td>Enable this for Room-Charge Payments</td>
<td>[x]</td>
<td>[x]</td>
<td>[x]</td>
</tr>
</tbody>
</table>

Tender Media Setup

Select the property, click **Configuration**, and then click **Tender/Media**. Create a **Room Charge** tender media record. Configure the generic options as required.

Figure 53-14  Tender/Media Room Charge Configuration
Click the Tender/Media Options tab, click the Interface Options tab, and then select PMS from the Interface Link drop-down list. The name of the interface link and the View Interface Names for RVC option are only available if the Tender/Media configuration has been performed at the Property level.

Enable the following options:

- **29 - ON=Post 0.00 Transactions to PMS; OFF=Do Not Post**
- **31 - ON=PMS and Credit Cards Use 19 Digit Acct Number; OFF=16 Digits**
- **38 - Use ISL TMED Procedure Instead of PMS Interface**

Click the Ops Behavior tab and under the General Options section, ensure that the 5 - Reference Entry Required option is NOT enabled. Save all changes.

The Interface Link must be set for all payments that need to be auto-balanced (for example, cash, credit cards, and so on).

Figure 53-15  Tender/Media Room Charge Options

Enable the Room Charge Data Extensions Option

Click the Data Extensions tab, and then select the check box in the Value column for the Enh.IFC – Room Charge.

Figure 53-16  Tender/Media Room Charge Data Extensions Tab
The **Value** check-box must be selected for the room charge tender media(s) (see above). Deselect the check-box for all of the other tender medias, but it should NOT be greyed out, as shown in the following example image.

**Figure 53-17  Undesired Tender/Media Data Extensions Example**

<table>
<thead>
<tr>
<th>Column</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>erp_IFC - RoomCharge</td>
<td>✔</td>
</tr>
</tbody>
</table>

**Page Design**

Select the **Configuration** tab, and then click **Page Design**. Ensure that the previously reviewed Room Charge tender media is configured correctly on the payment tab/page (see the following example).

**Figure 53-18  Page Design Module - Room Charge Payment Button**

Add the inquiry buttons on required pages and tabs. Typically, the inquire buttons are created on the payment and/or function page/tab.

**Figure 53-19  Page Design Module - Room Charge Inquire Button**
Inquiry Button Definitions
Configure potential room inquiry buttons using the definitions listed here:

- **Type:** Function
- **Sim Inquire**
- **Argument:** `<EXTENSION APPLICATION NAME>;<INQUIRY NUMBER>`

After the button configurations are complete, perform a full reload of all of the workstations and restart the service hosts.

Table 53-3  Inquire Names and Numbers for Room Inquire Buttons

<table>
<thead>
<tr>
<th>Inquire</th>
<th>Inquire Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Inquire</td>
<td>1</td>
</tr>
<tr>
<td>Info Room Inquire</td>
<td>2</td>
</tr>
<tr>
<td>Short Inquire</td>
<td>5</td>
</tr>
<tr>
<td>Info Line Inquire</td>
<td>6</td>
</tr>
<tr>
<td>View Reservation Inquire</td>
<td>7</td>
</tr>
<tr>
<td>Extended Inquire</td>
<td>8</td>
</tr>
<tr>
<td>PMS Interface Information Inquire</td>
<td>911</td>
</tr>
</tbody>
</table>

Features and Revisions since the Release of Simphony 2.7 and Later

<table>
<thead>
<tr>
<th>Itemizer</th>
<th>Service-Charge based on SVC Itemizer</th>
<th>See remark (1) below</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Service-Charge based on SVC Itemizer 1</td>
<td>See remark (1) below</td>
</tr>
<tr>
<td>2</td>
<td>Service-Charge based on SVC Itemizer 2</td>
<td>See remark (1) below</td>
</tr>
<tr>
<td>3</td>
<td>Service-Charge based on SVC Itemizer 3</td>
<td>See remark (1) below</td>
</tr>
<tr>
<td>4</td>
<td>Service-Charge based on SVC Itemizer 4</td>
<td>See remark (1) below</td>
</tr>
<tr>
<td>5</td>
<td>Service-Charge based on SVC Itemizer 5</td>
<td>See remark (1) below</td>
</tr>
<tr>
<td>6</td>
<td>Service-Charge based on SVC Itemizer 6</td>
<td>See remark (1) below</td>
</tr>
<tr>
<td>7</td>
<td>Service-Charge based on SVC Itemizer 7</td>
<td>See remark (1) below</td>
</tr>
<tr>
<td>8</td>
<td>Service-Charge based on SVC Itemizer 8</td>
<td>See remark (1) below</td>
</tr>
<tr>
<td>9</td>
<td>OPEN Amount Service-Charge with no SVC Itemizer enabled</td>
<td>See remark (2) below</td>
</tr>
<tr>
<td>10</td>
<td>PRESET Amount Service-Charge with no SVC Itemizer enabled</td>
<td>See remark (2) below</td>
</tr>
<tr>
<td>11</td>
<td>Stored Value Transaction Service Charge</td>
<td>Enable SVC Option 14 to ON</td>
</tr>
</tbody>
</table>
Itemizer

<table>
<thead>
<tr>
<th></th>
<th>Non-Revenue Service Charge</th>
<th>Enable SVC Option 7 to ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Charged Tip</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Auto Service-Charge</td>
<td></td>
</tr>
</tbody>
</table>

**Remark 1**: Amount of any PERCENTAGE based Service-Charges based on the SVC Itemizer (1-8) and the Menu-Items present on the check. For AMOUNT based Service-Charge based on the FIRST active SVC Itemizer found (if any).

**Remark 2**: Only used with AMOUNT based Service-Charges with no SVC Itemizer enabled.

Enabling a more detailed breakdown of Service-Charges requires related changes on the PMS/IFC8 side. As such, coordinate any changes with the PMS team.

### Inserting the Extension Application Files for OPERA

This procedure explains how to install and configure the SIM OPERA Property Maintenance System (PMS) interface. The configuration requires:

- Simphony release 2.8 or later
- OPERA Interface release 8.7.3.7 or later

1. Run the `SIMPH2_ENH_IFC[version number].exe` setup application on the Simphony application server.

   This application verifies the Simphony installation and copies the following files to the `[Drive letter]:\MICROS\Custom\EnhancedInterface` folder:
   - CONTENT_EnhIFC_Config.txt
   - McrsExtDialogsML.dll
   - MF_ENH.isl
   - MF_ENH_Android.isl
   - android.htm

2. If you cannot start the setup application on the Simphony application server because of access or user right limitations, but have access to EMC from your local PC, use the `/LOCAL` parameter to start the application.

   This method only works for version 270. That is, `SIMPH2_ENH_IFC270.exe`. Running the application through this method does not verify the Simphony installation, and it is your responsibility to ensure that the Simphony requirements are met. This method copies the required files into the sub-folder `Custom \EnhancedInterface` beneath the folder you selected in the setup application.

3. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Extension Application**.

4. Click the **Insert** icon to add a record.

5. Enter the record name in the **Name** field (for example, OPERA), and then click **OK**.

6. Double-click the record to open it in form view.

7. On the **General** tab, click the **Insert Application Content** button.
8. Enter `MF_ENH` for both the `ZonenableKey` and `Description` fields, and then click `OK`.

![Extension Application Insert Application Content Button](image1)

**Figure 53-20**  Extension Application Insert Application Content Button

**Figure 53-21**  Inserting Application Content Records

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Content Type</th>
<th>Disk File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Text</td>
<td>19 - Sim Script</td>
<td><code>MF_ENH.isl</code></td>
</tr>
<tr>
<td>2</td>
<td>Opera</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

![Inserting Application Content Records](image2)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Content Type</th>
<th>Disk File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Text</td>
<td></td>
<td><code>MF_ENH.isl</code></td>
</tr>
<tr>
<td>2</td>
<td>Opera</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 53-22**  Importing Content From File

<table>
<thead>
<tr>
<th>Name</th>
<th>Date modified</th>
<th>Type</th>
<th>Size</th>
<th>File version</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>MF_ENH.isl</code></td>
<td>2/10/2014</td>
<td>68 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>MF_ENH.isl</code></td>
<td>2/10/2014</td>
<td>68 KB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

a. On the `Designer` tab, select `19 - Sim Script` as the `Content Type`.

b. Click the `Import from a file` link.

c. Browse to and select the `MF_ENH.isl` file, and then click `Open`.

d. On the `General` tab, enter `MF_ENH.isl` in the `Disk File Name` column.
Disk File Name entries must exactly match the name of their associated SIM scripts and DLL file names. These entries are case-sensitive.

e. In the Option Bits column, click the ellipsis point (...) button, and then select 2 - Main SIM Content.

f. In the Target column, click the ellipsis point (...) button, and then select 1 - Win32.

9. Repeat Steps 7 through 9 to insert a new application content and import the MF_ENH_Android.isl file with the following settings:
   • ZonenableKey: Enter MF_ENHANDROID.
   • Description: Enter MF_ENHANDROID.
   • Content Type: Select 19 - Sim Script.
   • Option Bits: Select 2 - Main SIM Content
   • Disk File Name: Enter MF_ENH_ANDROID.isl.
   • Target: Select 10 - Android.

10. Repeat Steps 7 through 9 to insert a new application content and import the McrsExtDialogsML.dll file with the following settings:
    • ZonenableKey: Enter McrsExtDialogsML.
    • Description: Enter McrsExtDialogsML.
    • Content Type: Select 3 - DLL.
    • Disk File Name: Enter McrsExtDialogsML.dll
    • Target: Select 1 - Win32.

11. Repeat Steps 7 through 9 to insert a new application content and import the android.htm file with the following settings:
    • ZonenableKey: Enter html. The ZoneableKey entry for the android.htm file must match html, and it is case-sensitive.
    • Description: Enter html.
    • Content Type: Select 23 - Text.
    • Target: Select 10 - Android.

12. Click Save.

13. For multi-tenant environments, you must configure the content information as Extension Application content. In these environments the content feature cannot be used.

   a. Insert a new application content for the enhanced interface by clicking the Insert Application Content button.

   b. Configure the following fields:
      • ZonenableKey: Enter EnhIFC_Config (case sensitive).
      • Description: Enter EnhIFC_Config (case sensitive).
      • Content Type: Select 23 - Text.
      • Target: Select 10 - Android.

   c. Click Save.
d. Insert the content information as outlined in Configuring OPERA Content Information.

Configuring OPERA Content Information

For multi-tenant environments using releases earlier than Simphony release 2.9, you are required to configure the content information as Extension Application content. The content feature cannot be used in these environments.

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click Content.
2. Insert a record for the PMS content, named PMS.
3. Double-click the new record to open it.
4. Select 4 - String as the Content Type.
5. Enter the following string in the Content tab and make the necessary modifications, as shown in the following figure (the content text file is delivered with the other files).

See Content Text Settings for the OPERA PMS for more information on the configuration strings.

```
# Posting related settings

# Magnetic Card required for Posting (0 or 1)
MAGCARDONLY=0
# If above enabled, excl. RVC Numbers (separated by comma)
MAGCARDVWRWT=
# Suppress Guest-Messages during Postings
SUPPRESSGSTMSG=1
# Suppress References of non-Roomcharge Tenders
SUPPRESSINFREF=0
# Do not display Guest Confirmation during Postings
NO_CONFIRM_GST=0
# Send negative Guest Count if payment is negative
REVERSEGST=1
# Full Discount and Service Charge breakdown
FULL_DISVC=1
# Use 64 Taxes for posting (0 or 1) or just 8 Taxes
POST_64TAXES=1
# Determines which information to be posted, 0 = Serving Period, 1 = Trans.Cashier,
# 2 = Order-Type, 3 = Custom for Philippines ONLY. Default = Serving Period
POSTING_ADD_INFO=0
# Send all CheckDetails on non-Roomcharge Tenders
SENDALLDTL=0

# Locator related settings

# Use RVC Name as Locator Line 
RVCNAMELOC=1
# Default Locator Validity in Minutes
LOCVALIDMIN=30

# Guest Message related settings

# Populate first line of Message using Date/Time, RVC# and Trans.Employee#
EMPLINFO_IN_MSG=1

# Restricted Posting for Kiosk Environment

# Must match the ISL Employee Option in Employee Class
RESTRICT_POSTINGEMPL=1
```
6. (Optional) For debugging purposes, add the line "DEBUG_ON=10". This increases the verbosity, adding additional messages in the Egateway.log file.

7. To override the Content, select the **Use Existing Record** option. The Content can be overridden by property, zone, or revenue center.

8. Click **Save**.

9. Restart the Service Hosts.

## Content Text Settings for the OPERA PMS

The following tables list the string names and values to be used in the Content module for the OPERA content text file.

### Posting Related Settings

**Table 53-4 Posting Related Settings**

<table>
<thead>
<tr>
<th>Configuration String</th>
<th>Configuration Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAGCARDONLY</td>
<td>Set to 0 to allow both magnetic cards and keyboard inputs.</td>
</tr>
<tr>
<td></td>
<td>Set to 1 to limit the entries in the Room Charge event to magnetic cards.</td>
</tr>
<tr>
<td>MAGCARDOVRWRT</td>
<td><strong>When</strong> <strong>MAGCARDONLY</strong> is enabled, you can overwrite the setting for certain revenue centers by entering a list of revenue center numbers (separated by comma).</td>
</tr>
<tr>
<td>SUPPRESSGSTMSG</td>
<td>Set to 1 to suppress the message indicator during posting. Enable this setting for high-volume sites.</td>
</tr>
<tr>
<td>SUPPRESSNFOREF</td>
<td>Non-Room Charge tenders show the Department Code for which they were posted. Set to 1 to suppress this reference.</td>
</tr>
<tr>
<td>REVERSEGST</td>
<td>Set to 1 to make the guest count negative when the payment is negative (that is, the payment is voided). This feature requires specific configuration on the Front-Office interface to work correctly.</td>
</tr>
</tbody>
</table>
Table 53-4  (Cont.) Posting Related Settings

<table>
<thead>
<tr>
<th>Configuration String</th>
<th>Configuration Value</th>
</tr>
</thead>
</table>
| FULL_DSVC            | Set to 1 to send the full breakdown of the discounts. This requires a specific version of the Front-Office interface.  
Set to 2 for an additional full breakdown of the service charges. This includes the full breakdown of discounts. |
| NO_CONFIRM_GST       | Set to 0 if magnetic cards are used to identify guests.  
Set to 1 to prevent confirmation of the guest name when posting. |
| POST_64TAXES         | Set to 1 to send up to 63 Tax Itemizers to the Front-Office interface. This feature requires IFC8 V.8.7.1.2 or later as well as a certain version of the Front-Office itself.  
Set to 0 to send only 8 Tax Itemizers to the Front-Office interface. |
| SendAllDtls          | Set to 0 to send only the check details of Room Charges the Front-Office interface.  
Set to 1 to send also the check details of non-Room Charges. |
| RESTRICTED_POSTING   | Select to restrict the response returned from the Front-Office Interface in the Room Charge event. Note that this only works in combination with the option RESTRICTED_POSTING in the configuration. There are two values supported:  
• Set to 1 to require both the room number and at least three characters of the surname (last name) to post the room charge. If less than three characters are provided an error appears. If the response from the PMS contains more than one record, an error appears and the workstation operator must enter additional characters to provide a unique identifier.  
• Set to 3 to assume that an external device will provide the input as keyboard data. There is no touchscreen keyboard shown when this option is used. The workstation operator (or guest) has only the option to abort the input. If the response from the PMS contains more than one record an error appears and the posting is aborted. There is no confirmation of the guest-name shown, irrelevant of the setting in NO_CONFIRM_GST. Note that this feature does not work if the input is restricted to magnetic cards. Therefore, you must either disable the restriction or add the relevant revenue center to the excluded list of revenue centers. |
Table 53-4 (Cont.) Posting Related Settings

<table>
<thead>
<tr>
<th>Configuration String</th>
<th>Configuration Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESTR_POSTING_EMPL</td>
<td>Specify the ISL Option to use with the above option (see ISL Options in the Employee Maintenance module). The valid value for this configuration is between 1 and 8.</td>
</tr>
</tbody>
</table>

Locator and Message Settings

Table 53-5 Guest-Locator and Guest-Message Settings

<table>
<thead>
<tr>
<th>Configuration String</th>
<th>Configuration Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RVCNAMELOC</td>
<td>Set to 1 to have the first line of the locator contain the revenue center name, otherwise the locator name is blank. Workstations operator can overwrite this value when entering the locator information.</td>
</tr>
<tr>
<td>LOCVALIDMIN</td>
<td>Each new locator is only valid for a certain time. Enter the default time in minutes for which the locator is valid. Workstation operators can overwrite this value when entering the locator information.</td>
</tr>
</tbody>
</table>

Configuring the OPERA PMS Interface

1. Select the Enterprise level, click **Setup**, and then click **Interfaces**
2. Insert a record for the OPERA PMS interface. Enter a **System Name** that reflects the property using the interface.
3. Double-click the new interface record to open it.
4. On the **General** tab, configure the settings as follows:
   - **Communication Name**: Enter the name to use when communicating with the interface.
   - **Interface Type**: Select **0 - PMS/SIM**.
   - **Communication Type**: Select the communication type that the interface uses.
   - **Timeout**: Enter 30.
   - **Ping Frequency**: Set to 0 (zero) to avoid double posting.
5. Click the **Options** tab, and then select the options 1 - **Use 19 Digit Reference Entry for PMS Inquiries**, 2 - **Enable Interface Log**, 3 - **Allow Inquiry without Sign-In**, and 5 - **ON = Use 9 digits for Terminal IDs; OFF = Use 2 digits for Terminal IDs**.

Do not enable option 8, as it causes double posting.

---

**Figure 53-25 Interface Module**

**Figure 53-26 Interface Module’s Options Tab**
6. In the TCP Communications section, enter the following details:
   • **TCP Host Name**: Enter the OPERA PMS application server's IP address or server name (if DNS is enabled).
   • **Port Number**: Enter the port number for the OPERA PMS server.

7. Click the **Properties** tab, and then select the properties that can use this interface.

**Figure 53-27 Interface Module’s Properties Tab**

8. Click the **Service Host** tab, click **Select** adjacent to the **Service Host** field, select the service host to run the OPERA PMS interface, and then click **OK**.
   You can assign any workstation that has enough power to handle the incoming queries as the service host.

9. Click **Save**.

10. Select the Enterprise, property, revenue center, or zone, click **Setup**, and then click **Extension Application**.
    This configuration typically occurs at the property level when the PMS interface is on-premises.

11. In the Interface column corresponding to the OPERA extension application record, click the ellipsis point (...) button, and then select the **PMS** interface to associate it with the OPERA Extension Application record.

**Figure 53-28 Extension Application PMS Interface Assignment**

12. Click **Save**.

---

**Enabling the OPERA PMS Interface for a Revenue Center**

You must enable the OPERA PMS interface for each revenue center that uses OPERA.
1. Select the revenue center, click **Setup**, and then click **RVC Parameters**

2. Click the **Interfaces** tab.

3. Select the **PMS** interface to enable the OPERA PMS interface for the revenue center.

![Figure 53-29  Revenue Center Parameters Interfaces Tab](image)

4. Click **Save**.

5. Repeat Steps 1 through 4 for each revenue center that uses the OPERA PMS interface.

**Adding the Tender/Media Data Extension for OPERA**

1. Select the Enterprise level, click **Configuration**, and then click **Data Extensions**.

2. Click the **Insert** icon on the toolbar to add a record, and then click **OK**.

3. Enter information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select 71 - Tender Media.</td>
</tr>
<tr>
<td>Extra Column Name</td>
<td>Enter Room Charge.</td>
</tr>
<tr>
<td>Type</td>
<td>Select 4 - Boolean.</td>
</tr>
<tr>
<td>Data Constraints</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Sort Priority</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Display Width</td>
<td>Enter 150</td>
</tr>
</tbody>
</table>

![Table 53-6  Data Extension Fields](image)
Table 53-6  (Cont.) Data Extension Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translatable Name</td>
<td>Enter Enh.IFC – Room Charge (translatable).</td>
</tr>
<tr>
<td>Translatable Help</td>
<td>Enter Enable this for Room-Charge Payments (translatable).</td>
</tr>
</tbody>
</table>

Figure 53-30  Data Extensions Module

4. Select the following options:
   - Is Editable
   - Is Viewable
   - Is Downloadable

5. Click Save.

Configuring the Tender Media for OPERA

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.
2. Click the Insert icon on the toolbar to add a record, enter Room Charge as the name, and then click OK.
3. Double-click the Room Charge record to open it.
4. On the General tab, select 1 - Payment from the Key Type drop-down list.
5. Click the Options tab, and then click the Interface Options subtab.

6. In the View Interface Names for RVC drop-down list, select the revenue center for which the OPERA PMS interface was assigned, and then select PMS from the Interface Link drop-down list.

   The Interface Link and the View Interface Names for RVC fields are only active if the Tender/Media configuration is being performed at the property level.

   Assign the PMS Interface Link to all payments that must be auto balanced (for example, Cash, Credit Cards, and so on).

7. Select the following options:
   - 29 - ON=Post 0.00 Transactions to PMS; OFF=Do Not Post
   - 31 - ON=PMS and Credit Cards Use 19 Digit Acct Number; OFF=16 Digits
   - 38 - Use ISL TMED Procedure Instead of PMS Interface
Figure 53-32  Tender/Media Room Charge Options

8. Click the **Ops Behavior** subtab and in the General Options section, ensure that **5 - Reference Entry Required** is not enabled.

9. Click the **Data Extensions** tab, and then select the check box in the **Value** column for the **Enh.IFC – Room Charge**.

   The **Value** check-box must be selected for the room charge tender media(s). Deselect the check-box for all other tender medias.

Figure 53-33  Tender/Media Room Charge Data Extensions Tab

10. Click **Save**.

**Configuring the Room Charge Buttons for the OPERA PMS**

Oracle recommends that you create payment card buttons on a page for the PMS room charge function.

1. Select the Enterprise, property, revenue center, or zone, click **Configuration**, and then click **Page Design**.

2. Open the page on which to place the room charge button.

3. On the **Edit** tab, select the page area in which to define the room charge function (typically the payment area).

4. Click **Button**.
5. On the **General** subtab, enter the button name in the **Legend** field.
6. Select **Payment Tenders** from the **Type** drop-down list.
7. In the Select Tender/Media Payment dialog, select the OPERA PMS room charge payment tender, and then click **OK**.
8. In the Select Payment Type area, select **Other1:LoadablePms** from the **Payment Type** drop-down list.
9. Click the **Edit...** link in the Command column.
10. In the Payment Configuration dialog, select the **Opera** payment method from the **Functions** drop-down list.
11. Position and size the button on the page. Use the Style arrow to change the color.

**Figure 53-34  Room Charge Payment Button**

12. Click **Save**.

13. Add the room inquiry buttons on any required page. Typically, the room inquiry buttons are created on the payment or function page.
   a. Open the page on which to place the Room Charge Inquiry buttons, and then on the **Edit** tab, select the page area in which to define the buttons.
   b. Click **Button**, and then on the **General** subtab, select **Function** from the **Type** drop-down list.
   c. Click the black arrow directly beneath the **Type** drop-down list, and then select **Extensibility** from the **Type** pane.
   d. Select **SIM Inquire**, and then click **OK**.
   e. In the **Argument** field, enter `<EXTENSION APPLICATION NAME>:<INQUIRY NUMBER>`.

      Enter the inquiry number corresponding to the PMS SIM inquiry. For example, enter OPERA:1 to configure a Room Inquire button.
Table 53-7  Inquire Names and Numbers for Room Inquiry Buttons

<table>
<thead>
<tr>
<th>Inquire</th>
<th>Inquire Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Inquire</td>
<td>1</td>
</tr>
<tr>
<td>Info Room Inquire</td>
<td>2</td>
</tr>
<tr>
<td>Short Inquire</td>
<td>5</td>
</tr>
<tr>
<td>Info Line Inquire</td>
<td>6</td>
</tr>
<tr>
<td>View Reservation Inquire</td>
<td>7</td>
</tr>
<tr>
<td>Extended Inquire</td>
<td>8</td>
</tr>
<tr>
<td>PMS Interface Information Inquire</td>
<td>911</td>
</tr>
</tbody>
</table>

Figure 53-35  Room Charge Inquiry Button

f. Enter a **Legend**.

g. Repeat Steps 13b through 13f to configure buttons for the remaining PMS SIM inquire buttons listed in Step 13e.

a. Click **Save**.

14. After the room charge button configurations are complete, perform a full reload of all workstations and restart the service hosts.

**Updating the SIM OPERA Interface to a Newer Version**

To update an available installation:

1. Run the `SIMPH2_ENH_IFC[version number].exe` setup application on the Simphony application server to update the [Drive letter]:MICROS\Custom folder.

2. Re-import the ISL and DLL files into the Extension Application.

3. Create any additional Data Extensions, if required.

4. Perform a database reload on the workstations and restart the service hosts.
Accessibility

This chapter describes the accessibility feature in the EMC and its configuration. Accessibility features aim to make using the product easier for persons with disabilities. Simphony currently supports the high-contrast settings that are provided by the Microsoft Windows operating systems.

- Enabling High Contrast Visibility Settings
- Navigating the Home Page Using Keystrokes
- Keyboard Shortcuts

Enabling High Contrast Visibility Settings

Enable High Contrast visibility settings based on the operating system that you are running on your computer.

1. To enable high contrast visibility settings with Microsoft Windows 8.x or Microsoft Windows 10:
   a. Click the **Start** button from your computer’s Desktop.
   b. Type **high contrast settings** in the **Search** box, and then select **High Contrast** from the list.
   c. Select a high contrast theme from the **Choose a Theme** drop-down list.
   d. Click **Apply**.

2. To enable high contrast visibility settings with Microsoft Windows 7:
   a. Click the **Start** button from your computer’s Desktop, and then select the **Control Panel**.
   b. Click **Appearance and Personalization**, and then click **Personalization**.
   c. Click the high-contrast theme that you want to use under **Basic and High Contrast Themes**.

Navigating the Home Page Using Keystrokes

1. To place focus on the Location panel on the left, press **Ctrl+H**.
2. To expand a level (Enterprise or property) to show the locations beneath, press the right arrow key.
3. To move between the locations in the hierarchy, press the up arrow key and the down arrow key.
4. To open a module:
   a. Press **Ctrl+T** to move focus to the tabs on the right, and then press the up arrow key and the down arrow key to move between the tabs.
   b. Press **Tab** to navigate to the first focusable element in the tab.
c. Continue to press **Tab** to navigate through the modules in the tab.

d. Press **Enter** to open the module.

## Keyboard Shortcuts

EMC supports standard keyboard shortcuts that are used in Microsoft Windows operating systems. Additionally, EMC offers shortcuts to perform tasks that are specific to the application. The following table describes keyboard shortcuts for use with EMC.

### Table 54-1   General Keystrokes

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tab</strong></td>
<td>Navigates to the next focusable field or element from top to bottom and left to right.</td>
</tr>
</tbody>
</table>
| **Down Arrow** | Varies based on context:  
  • When moving through the location hierarchy in the Home Page, moves one item downward through the list.  
  • In a table, moves to the next row.  
  • When the focus is on a drop-down list, moves to the next item in the list. |
| **Up Arrow** | Varies based on context:  
  • When moving through the location hierarchy in the Home Page, moves one item upwards through the list.  
  • In a table, moves to the previous row.  
  • When the focus is on a drop-down list, moves to the previous item in the list. |
| **Right Arrow** | Varies based on context:  
  • In a table, navigates to the next column on the right.  
  • When moving through the location hierarchy in the Home Page, expands the location to show the properties or revenue centers beneath. |
| **Left Arrow** | Varies based on context:  
  • In a table, navigates to the next column on the left.  
  • When moving through the location hierarchy in the Home Page, collapses the list and sets the focus on the parent location. |
| **Delete** | Deletes the record selected. |
| **Enter** | Triggers the activity, when the focus is on a link or a button. |
| **Insert** | Adds a new record. |
| **Alt+E** | Accesses the Edit menu on the toolbar. |
| **Alt+F** | Accesses the File menu on the toolbar. |
| **Alt+H** | Access the Help menu on the toolbar. |
| **Alt+V** | Accesses the (Table or Form) view menu (where applicable) on the toolbar. |
| **Ctrl+C** | In Table view, copies the record or records that are selected. |
### Table 54-1  (Cont.) General Keystrokes

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+F</td>
<td>Opens the Find dialog which allows you to search for records by entering a search criteria.</td>
</tr>
<tr>
<td>Ctrl+G</td>
<td>Opens the Go to Record dialog which allows you to go to a record by entering the record's object number.</td>
</tr>
<tr>
<td>Ctrl+H</td>
<td>In the Home page, moves focus to the location hierarchy.</td>
</tr>
<tr>
<td>Ctrl+K</td>
<td>Closes all open modules, including the Home Page, and disconnects the user from the EMC.</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Opens the EMC Login page when disconnected from the EMC.</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Print records while in Table view.</td>
</tr>
<tr>
<td>Ctrl+Q</td>
<td>Closes the module that is active.</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Saves the changes.</td>
</tr>
</tbody>
</table>
| Ctrl+T           | Varies based on context:  
|                  | • In the Home page, moves focus to the main tabs.  
|                  | • In Table view, shows or hides the record filters. |
| Ctrl+V           | In Table view, pastes the copied records. |
| Shift+F10        | In Table view, opens the right-click menu when the focus is on a record. |
| F3/F4            | In Table view, allows copy and paste of fields.  
|                  | F3 copies the content in the cell and moves to the cell in the next row. F4 pastes the contents and moves to cell in the next row. This allows you to continually press F4 (or hold it down) and paste the same information to multiple cells in the same column. |
| F8               | Opens the EMC Record Translation dialog. |
The following documentation videos supplement the Simphony documentation. Make sure to check this page often for new videos.

**Properties**

- Adding a Property
- Adding a Revenue Center

**Employees and Privileges**

- Creating Employee Roles
- Creating Employee Classes
- Adding an Employee
- Deleting an Employee